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Những "tuyệt chiêu" trong Excel 
 

 
Nguồn : http://www.giaiphapexcel.com/forum/showthread.php?t=14768 
 

 
 
Lời nói đầu: 

 
Trong quá trình thực hiện một bảng tính, chúng ta có thể mắc phải vô số lỗi, hoặc có thể mắc 
phải những sai lầm ngớ ngẩn, và thƣờng không để ý tới những cái có thể giúp chúng ta xử lý 
bảng tính nhanh hơn, gọn gàng hơn... Xin hân hạnh giới thiệu đến các bạn cuốn sách "Một ngày 
một tuyệt chiêu", lƣợc dịch từ cuốn Excel Hacks, của hai tác giả David và Raina Hawley. 
Những "tuyệt chiêu" này sẽ giúp bạn tránh đƣợc những lỗi, và làm việc với bảng tính một cách có 
hiệu quả hơn.  
 
Trƣớc khi nói đến các "tuyệt chiêu" của Excel, xin nói sơ qua một chút về một số thủ thuật và quy 
tắc cơ bản, những điều sẽ giúp các bạn thực hiện những "tuyệt chiêu" đƣợc nói đến trong các 
phần sau cách dễ dàng hơn. Excel là một phần mềm bảng tính rất mạnh, và bạn có thể làm đƣợc 
những điều không thể tin nổi với nó. Nhƣng không may, có nhiều ngƣời thiết kế bảng tính của 
mình với quá nhiều sự "lo xa", cẩn thận quá mức cần thiết, và làm cho nó trở nên phức tạp hơn là 
nó đáng bị nhƣ vậy. Phần mở đầu này sẽ mách cho bạn một số thủ thuật và quy tắc mà nếu bạn 
làm theo, bạn sẽ thấy chúng rất hiệu quả. 
 
Xin nói thêm, tất cả các "chiêu" đƣợc trình bày sau đây, đa phần là viết cho Excel 2007. Nếu nó 
cũng có thể áp dụng cho các phiên bản trƣớc, chúng tôi sẽ chú thích ở ngay bên cạnh: (Với Excel 
2003 trở về trƣớc, thì...) 
 

 
Quy tắc 80/20 

 
Có lẽ việc quan trọng nhất khi thực hiện một bảng tính là dành một thời gian để nghiên cứu, xem 
xét cách bố trí dữ liệu, tính trƣớc những việc mình cần làm. Và đừng bao giờ nghĩ rằng sau khi 

hoàn thành, tôi sẽ không cần phải thêm vào đó các dữ liệu hoặc các công thức khác, vì bạn sẽ 
luôn làm ngƣợc lại. Điều này có nghĩa rằng, bạn nên dành khoảng 80% thời gian để lên kế 
hoạch cho một bảng tính và khoảng 20% thời gian để thực hiện bảng tính đó. 

 
Cho dù rằng, việc này có vẻ không cần thiết với những bảng tính nhỏ, nhƣng bảo đảm rằng, nếu 
bạn quan tâm đến điều tôi vừa nói ở trên, thì về lâu về dài, bạn sẽ tránh đƣợc những cực nhọc 

khi phải cứ phải sửa đi sửa lại bảng tính của mình, và dễ dàng thực hiện đƣợc những bảng tính 
lớn sau khi đã dành cho nó một thời gian để lên kế hoạch thực hiện. Nên nhớ rằng, các bảng tính 
phải luôn mang lại cho ngƣời dùng những thông tin chính xác, chứ không phải là thông tin chỉ 

chính xác trong một trƣờng hợp nào đó. 
 
Những mẹo nhỏ về cấu trúc một bảng tính 

http://www.giaiphapexcel.com/forum/showthread.php?t=14768
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Một trong những lỗi mà chúng ta hay mắc phải khi tạo một bảng tính, là chúng ta không thiết lập 
và trình bày dữ liệu "theo cái cách mà Excel và các tính năng của nó mong đợi". Sau đây là một 

số lỗi phổ biến chúng ta hay mắc phải khi thiết lập một bảng tính: 
 Bố trí dữ liệu trong nhiều bảng tính (WorkBook) khác nhau 
 Bố trí dữ liệu trong nhiều trang tính (WorkSheet) khác nhau 

 Bố trí dữ liệu trong nhiều bảng (Table) khác nhau 
 Có những hàng trống và cột trống trong khối dữ liệu (database) 
 Bỏ trống những ô có dữ liệu giống nhau (cùng chung một ngày, cùng chung một đơn vị 

tính, v.v...) 
 

Ba điểm đầu tiên trên đây chỉ muốn nói đến một điều: Bạn nên luôn luôn cố gắng để giữ các 
mối liên quan giữa các dữ liệu được liên tục trong cùng một bảng dữ liệu. Tôi đã thấy rất 
nhiều các bảng tính không đƣợc trình bày theo cái quy tắc rất đơn giản này, và chính vì vậy, các 

bảng tính đó không thể tận dụng đƣợc tối đa các tính năng mạnh mẽ của Excel nhƣ PivotTable, 
SubTotal... Bạn chỉ có thể sử dụng các tính năng này khi bạn gom hết dữ liệu của bạn vào trong 
một bảng thật đơn giản. 

 
Không phải ngẫu nhiên mà Excel có 1.048.567 hàng (65.536 hàng trong Excel 2003 trở về trƣớc) 
mà lại chỉ có 16.384 cột (256 cột trong Excel 2003 trở về trƣớc). Điều này có ý nói rằng, bạn nên 

thiết lập dữ liệu của mình với các tiêu đề cột nằm ở hàng trên cùng, và các dữ liệu có 
liên quan thì nằm liên tục ở bên dưới tiêu đề của nó. Nếu nhƣ bạn có những dữ liệu đƣợc 
lặp lại hai lần hoặc nhiều lần trong các hàng của cùng một cột (các ngày tháng, các loại đơn vị 

tính chẳng hạn), bạn hãy chống lại sự cám dỗ bỏ trống các ô đó. 
 
Hãy cố gắng sắp xếp (sort) dữ liệu của bạn bất cứ khi nào có thể. Excel có rất nhiều những 

công cụ để tìm kiếm và tham chiếu công thức, và một số không nhỏ trong đó, đòi hỏi dữ liệu phải 
đƣợc sắp xếp theo một thứ tự hợp lý. Việc phân loại cũng sẽ giúp ích đáng kể cho tốc độ xử lý 
của một số các hàm. 

 
Những mẹo nhỏ khi định dạng 

Ngoài việc thiết kế cấu trúc của bảng tính cho hợp lý, việc định dạng cho nó cũng là một vấn đề 
cần bàn đến. Mặc dù một bảng tính nên đƣợc định dạng sao cho dễ đọc và dễ theo dõi, nhƣng 
chúng ta ít khi nghĩ đến việc sử dụng thời gian cho có hiệu quả. Hãy luôn luôn định dạng thật 

đơn giản. Rất nhiều ngƣời lãng phí thời gian vào việc định dạng một bảng tính mặc dù không 
nhất thiết phải làm nhƣ vậy, và chính điều này làm ảnh hƣởng đến hiệu quả công việc. Việc 
thƣờng xuyên áp dụng những định dạng phức tạp cho bảng tính còn làm cho nó tăng kích thƣớc, 

và cho dù bảng tính của bạn có thể trông giống nhƣ một tác phẩm nghệ thuật, nhƣng nó lại có 
thể là một nỗi sợ hãi cho ngƣời khác. Một trong những kiểu phối màu tốt nhất mà bạn nên 
áp dụng cho một bảng tính, là màu đen, màu trắng và màu xám. 

 
Một gợi ý nữa, là nên bỏ trống vài hàng đầu tiên ở trên cùng (ít nhất là 3 hàng). Những hàng 
này sẽ đƣợc dùng cho những tính năng nâng cao hơn về sau, chẳng hạn nhƣ Advanced Filter, 

hoặc dùng làm vùng điều kiện cho các công thức xử lý dữ liệu (DSUM, DMAX, v.v...) 
 
Cũng đừng quan tâm đến việc canh lề cho dữ liệu. Theo mặc định, Excel canh phải cho những dữ 

liệu kiểu số, và canh trái cho những dữ liệu kiểu text. Và đó là điều tốt nhất rồi, đừng thay 
đổi nó. Nếu bạn thay đổi kiểu canh lề, bạn sẽ có thể không xác định đƣợc ngay tức khắc rằng đó 

là dữ liệu kiểu số hay dữ liệu kiểu text; và nó còn có thể gây nhầm lẫn cho ngƣời khác khi tham 
chiếu đến một ô, vì nhiều khi họ sẽ tƣởng rằng dữ liệu trong ô đó là số, nhƣng thật ra nó là text. 
Nếu bạn thay đổi kiểu canh lề mặc định, bạn sẽ bị nhức đầu với nó sau này. Chỉ có tiêu đề của 

bảng tính là đƣợc hƣởng ngoại lệ mà thôi. 
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Chỉ định dạng các ô theo kiểu text khi thật sự cần thiết. Bởi vì tất cả những dữ liệu nhập 
vào trong các ô đã đƣợc định dạng trƣớc theo kiểu text sẽ bị chuyển thành dữ liệu kiểu text, ngay 

cả khi bạn nghĩ rằng cái bạn nhập vào là dữ liệu kiểu số hay dữ liệu kiểu ngày tháng. Và tồi tệ 
hơn nữa, bất kỳ ô nào chứa công thức tham chiếu đến một ô đã được định dạng theo 
kiểu text, cũng sẽ bị định dạng thành kiểu text. Nói chung, bạn đâu có muốn những ô chứa 

công thức lại bị định dạng theo kiểu text, phải không. 
 
Trộn các ô (merge cells) cũng là một vấn đề. Có một số công thức hoặc macro không thể chạy 

đƣợc với những ô đã đƣợc trộn. Cho nên, thay vì trộn ô, bạn hãy dùng chức năng "Center 
across selection", nằm trong Home ➝ nhóm Alignment. Nhấn vào cái mũi tên ở dƣới cùng 

bên phải, sẽ mở ra hộp thoại Format với tab Alignment đƣợc chọn sẵn. Bạn sử dụng thanh 
trƣợt dọc của khung Horizontal để chọn Center Across Selection. Hoặc bạn cũng có thể right-

click rồi chọn Format Cells từ shortcut menu. Với Excel 2003 trở về trƣớc, bạn mở hộp thoại này 
từ menu Format ➝ Cells (Ctrl+1). 

 

 
Nên sử dụng Center Across Selection thay cho Merge Cells 

 
Những mẹo nhỏ khi dùng công thức 

Một sai lầm rất lớn khi sử dụng công thức là cho nó tham chiếu đến toàn bộ các cột trong 
mảng dữ liệu. Điều này làm cho Excel phải kiểm tra hàng ngàn ô, nếu không nói là hàng triệu, 
để chắc chắn không bỏ sót một dữ liệu nào. 

 
Ví dụ, giả sử bạn có một mảng dữ liệu từ A1 đến H1000, và bạn quyết định sẽ dùng những hàm 
tìm kiếm của Excel để trích ra những dữ liệu cần thiết. Bởi vì bạn còn phải bổ sung thêm dữ liệu 

vào mảng này, nên để chắc ăn, bạn tạo tham chiếu trong công thức đến toàn bộ các hàng của 
các cột trong mảng này. Khi đó, tham chiếu của bạn có thể sẽ là A:H, hoặc cụ thể hơn, là 
A1:H65536. Bạn nghĩ rằng làm nhƣ vậy thì bạn sẽ không lo lắng gì khi thêm dữ liệu vào trong 

mảng.  
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Đó là một thói quen vô cùng tai hại mà bạn phải luôn tránh xa nó. Bởi nó sẽ làm cho bảng 

tính trở nên ì ạch, thậm chí là không chạy nổi. Bạn vẫn có thể loại bỏ những phần không cần 
tham chiếu ra khỏi công thức, mà lại bảo đảm đƣợc những dữ liệu mới thêm vào sẽ tự động đƣợc 
cập nhật trong tham chiếu của công thức, bằng cách dùng Table (List trong Excel 2003 trở về 

trƣớc) hoặc sử dụng các Name động. 
 
Một vấn đề nữa thƣờng xảy ra với những bảng tính lớn, mà cấu hình máy lại nhỏ, là Excel tính 

toán rất chậm khi dữ liệu đƣợc cập nhật. Để giải quyết vấn đề này, bạn thƣờng đƣợc khuyên là 
hãy chuyển đổi chế độ tính toán của Excel thành dạng Manual: Nhấn vào nút Office ở góc trái 
phía trên của bảng tính, rồi chọn Excel Options ➝ Formulas (với Excel 2003 trở về trƣớc, chọn 

menu Tools ➝ Options ➝ Calculations), rồi chọn Manual : 

 

 
Chọn Manual Caculation với Excel 2007 

 

 
Chọn Manual Caculation với Excel 2003 

 
Tuy nhiên, lời khuyên đó thì không hay cho lắm, mà chỉ là mang tính đối phó. Một bảng tính thì 
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bao giờ cũng có những công thức tính toán, nếu bạn đang chạy một bảng tính trong chế độ tính 
toán Manual, có thể bạn sẽ chỉ có đƣợc những thông tin cũ mèm, chƣa hề đƣợc cập nhật. Nếu 

muốn có đƣợc thông tin chính xác, bạn phải nhấn F9. Nhƣng, chắc chắn là không phải lúc nào 
bạn cũng nhớ điều này! Vậy bạn thử cân nhắc xem: Nếu nhƣ cần thắng chân bị kẹt và làm cho 
chiếc xe hơi của bạn chạy chậm lại, bạn sẽ sửa lại cần thắng chân, hay là gỡ bỏ cái thắng chân rồi 

tin tƣởng hoàn toàn vào cái thắng tay? Nghĩa là, khi bảng tính của bạn chạy chậm, bạn sẽ sửa lại 
công thức cho nó chạy nhanh hơn, hay là đặt nó vào chế độ tính toán bằng tay rồi cứ thế mà làm 
tiếp? Hầu nhƣ chúng tôi không bao giờ làm điều này, nhƣng rất nhiều ngƣời đã không ngần ngại 

đặt bảng tính của họ trong chế độ tính toán Manual. Nếu nhƣ bạn thấy rằng cần phải đặt bảng 
tính của mình trong chế độ tính toán Manual thì mới làm việc đƣợc, bạn nên suy nghĩ đến việc 

thiết kế lại bảng tính. 
 
Công thức mảng là một trong những nguyên nhân của vấn đề trên. Chúng là một lựa chọn tốt khi 

tham chiếu đến những ô riêng lẻ. Nhƣng nếu bạn dùng chúng để tham chiếu đến những dãy dữ 
liệu lớn, thì hãy sử dụng chúng càng ít càng tốt. Khi có một số lƣợng lớn các mảng tham 
chiếu đến một dãy dữ liệu lớn, hiệu suất của bảng tính sẽ bị ảnh hƣởng, đôi khi nó dừng hẳn 

luôn, và bạn bắt buộc phải dùng chế độ tính toán bằng tay. 
 
Excel có nhiều hàm chuyên xử lý những dữ liệu lớn thay cho công thức mảng, mà sẽ đƣợc đề cập 

đến trong chiêu thứ 79: Tránh lỗi #VALUE! khi tính tổng (SUM) hoặc đếm (COUNT) các ô. Ngoài 
ra, trong Excel Help có một số ví dụ rất hay sẽ giúp bạn cách để dùng công thức trên những 
bảng dữ liệu lớn để trích ra kết quả dựa theo những tiêu chuẩn. Hoặc bạn có thể sử dụng Pivot 

Table, sẽ đƣợc đề cập đến trong phần thứ 4 của loạt bài này. Mặc dù PivotTable thì có vẻ phức 
tạp khi bạn sử dụng nó lần đầu tiên, nhƣng chúng tôi thành thật khuyên bạn hãy học cách sử 
dụng nó. Một khi bạn đã làm chủ đƣợc PivotTable, ngày nào đó bạn sẽ tự hỏi rằng làm sao tôi có 

thể sống mà không có PivotTable! 
 
Trƣớc khi kết thúc phần mở đầu, xin nói điều này: Nếu bạn chẳng nhớ đƣợc gì (vì tôi nói nhiều 
quá), bạn chỉ cần nhớ một chuyện thôi: Excel sẽ chạy tốt hơn nếu tất cả các dữ liệu của 
bạn được xếp liên tục với nhau trong cùng một bảng. Nó sẽ giúp cho bạn thực hành các 
chiêu sau đây một cách dễ dàng hơn. 
 
------------------------------------------------------------ 

 
Trong các chiêu sau đây, sẽ có một số biểu tượng nằm ở đầu mỗi chiêu: 

 Áp dụng cho tất cả các phiên bản của Excel 

 Chỉ áp dụng cho Excel 2007 

 Chỉ áp dụng cho những phiên bản trƣớc Excel 2007 

 Chỉ áp dụng cho Excel 2003 và Excel XP 

 Chỉ áp dụng cho Excel 2000 

 
 

Nội dung : 
1. Tùy biến cửa sổ làm việc của bảng tính 
2. Nhập dữ liệu đồng thời vào nhiều sheet 

3. Ngăn chận ngƣời sử dụng thực hiện một số hành động nào đó nhất định 
4. Ngăn chặn các nhắc nhở không cần thiết 

5. Ẩn sheet sao cho ngƣời dùng không thể dùng lệnh unhide để hiện ra 
6. Tự thiết kế một bảng tính mẫu (template) 
7. Tạo chỉ mục cho các Sheet trong Workbook 

8. Giới hạn vùng cuộn của bảng tính 

http://www.giaiphapexcel.com/forum/showthread.php?p=105407#post105407
http://www.giaiphapexcel.com/forum/showthread.php?p=105714#post105714
http://www.giaiphapexcel.com/forum/showthread.php?p=105979#post105979
http://www.giaiphapexcel.com/forum/showthread.php?p=106262#post106262
http://www.giaiphapexcel.com/forum/showthread.php?p=106535#post106535
http://www.giaiphapexcel.com/forum/showthread.php?p=106989#post106989
http://www.giaiphapexcel.com/forum/showthread.php?p=107320#post107320
http://www.giaiphapexcel.com/forum/showthread.php?p=107512#post107512
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9. Khóa và bảo vệ những ô có chứa công thức 
10. Sử dụng định dạng theo điều kiện để tìm dữ liệu trùng 

11. Tìm dữ liệu xuất hiện 2 hoặc nhiều lần bằng công cụ Conditional Formating 
12. Tạo riêng một thanh công cụ cho riêng một bảng tính cụ thể 
13. Sao chép công thức giữ nguyên tham chiếu tƣơng đối (giống nhƣ sao chép tham 

chiếu tuyệt đối) 
14. Gỡ bỏ những liên kết ma 
15. Giảm kích thƣớc file Excel bị phình to bất thƣờng 

16. Cứu dữ liệu từ một bảng tính bị lỗi 
17. Sử dụng Data-Validation khi danh sách nguồn nằm trong một Sheet khác 

18. Điều khiển Conditional Formating bằng checkbox 
19. Đánh dấu những ô chứa công thức bằng Conditional Formatting 
20. Đếm hoặc cộng những ô đã đƣợc định dạng có điều kiện 

21. Tô màu dòng xen kẽ 
22. Tạo hiệu ứng 3D trong các bảng tính hay các ô 
23. Bật, tắt chức năng Conditional Formatting bằng 1 checkbox 

24. Dùng nhiều List cho 1 Combobox 
25. Tạo một danh sách xác thực thay đổi theo sự lựa chọn từ một danh sách khác 
26. Sử dụng chức năng thay thế (Replace) để gỡ bỏ các ký tự không mong muốn 

27. Chuyển đổi con số dạng văn bản sang số thực 
28. Trích xuất dữ liệu số trong 1 chuỗi bằng VBA 
29. Tùy biến chú thích của ô bảng tính 

30. Sort thứ tự dựa trên nhiều hơn ba cột 
31. Sắp xếp ngẫu nhiên 
32. Thao tác trên dữ liệu với Advanced Filter 

33. Tạo các định dạng số cho riêng bạn 
34. Tăng thêm số lần Undo cho Excel 
35. Tự tạo danh sách để fill 

36. Làm nổi các Subtotal của Excel 
37. Chuyển đổi các hàm và công thức trong Excel thành giá trị 

38. Thêm dữ liệu vào danh sách Validation một cách tự động 
39. Ngày tháng trong Excel 
40. Cho phép sử dụng tính năng Group and Outline trên bảng tính bị khoá 

41. Bẫy lỗi để trống dữ liệu"]Bẫy lỗi để trống dữ liệu 
42. Giảm danh sách xổ xuống của Validation, sau khi chọn 1 
43. Thêm các danh sách có sẵn và cả danh sách tự tạo vào menu chuột phải 

 
Mời các bạn tham gia thảo luận các tuyệt chiêu tại đây 
 

Tra cứu hàm Excel | 
Công thức và Hàm trong Excel 2007 |  

 
Các hàm của Analysis Toolpak Addin | Những tuyệt chiêu trong Excel 
Thay thái độ, đổi cuộc đời | Nên đọc trước khi gửi một câu hỏi hoặc tạo 

mới môt đề tài |  
PivotTable & PivotChart 2007 - Từ căn bản đến nâng cao | Góp ý với các 

bài viết của BNTT  
 
 

 

http://www.giaiphapexcel.com/forum/showthread.php?p=107700#post107700
http://www.giaiphapexcel.com/forum/showthread.php?p=107960#post107960
http://www.giaiphapexcel.com/forum/showthread.php?p=108323#post108323
http://www.giaiphapexcel.com/forum/showthread.php?p=108525#post108525
http://www.giaiphapexcel.com/forum/showthread.php?p=108967#post108967
http://www.giaiphapexcel.com/forum/showthread.php?p=109323#post109323
http://www.giaiphapexcel.com/forum/showthread.php?p=109446#post109446
http://www.giaiphapexcel.com/forum/showthread.php?p=109545#post109545
http://www.giaiphapexcel.com/forum/showthread.php?p=110265#post110265
http://www.giaiphapexcel.com/forum/showthread.php?p=110339#post110339
http://www.giaiphapexcel.com/forum/showthread.php?p=110808#post110808
http://www.giaiphapexcel.com/forum/showthread.php?p=110983#post110983
http://www.giaiphapexcel.com/forum/showthread.php?p=111252#post111252
http://www.giaiphapexcel.com/forum/showthread.php?p=112543#post112543
http://www.giaiphapexcel.com/forum/showthread.php?p=112965#post112965
http://www.giaiphapexcel.com/forum/showthread.php?p=113006#post113006
http://www.giaiphapexcel.com/forum/showthread.php?p=113537#post113537
http://www.giaiphapexcel.com/forum/showthread.php?p=113706#post113706
http://www.giaiphapexcel.com/forum/showthread.php?p=114025#post114025
http://www.giaiphapexcel.com/forum/showthread.php?p=114335#post114335
http://www.giaiphapexcel.com/forum/showthread.php?p=114464#post114464
http://www.giaiphapexcel.com/forum/showthread.php?p=114931#post114931
http://www.giaiphapexcel.com/forum/showthread.php?p=114998#post114998
http://www.giaiphapexcel.com/forum/showthread.php?p=115830#post115830
http://www.giaiphapexcel.com/forum/showthread.php?p=116079#post116079
http://www.giaiphapexcel.com/forum/showthread.php?p=116094#post116094
http://www.giaiphapexcel.com/forum/showthread.php?p=116354#post116354
http://www.giaiphapexcel.com/forum/showthread.php?p=117091#post117091
http://www.giaiphapexcel.com/forum/showthread.php?p=117519#post117519
http://www.giaiphapexcel.com/forum/showthread.php?p=118149#post118149
http://www.giaiphapexcel.com/forum/showthread.php?p=119389#post119389
http://www.giaiphapexcel.com/forum/showthread.php?p=119515#post119515
http://www.giaiphapexcel.com/forum/showpost.php?p=120185&postcount=49
http://www.giaiphapexcel.com/forum/showpost.php?p=120759&postcount=50
http://www.giaiphapexcel.com/forum/showthread.php?p=120922#post120922
http://www.giaiphapexcel.com/forum/showthread.php?t=17203
http://www.giaiphapexcel.com/forum/showthread.php?t=7971
http://www.giaiphapexcel.com/forum/showthread.php?t=10810
http://www.giaiphapexcel.com/forum/showthread.php?t=30596
http://www.giaiphapexcel.com/forum/showthread.php?t=14768
http://www.giaiphapexcel.com/forum/showthread.php?t=5783
http://www.giaiphapexcel.com/forum/showthread.php?t=14547
http://www.giaiphapexcel.com/forum/showthread.php?t=14547
http://www.giaiphapexcel.com/forum/showthread.php?t=14547
http://www.giaiphapexcel.com/forum/showthread.php?t=14797
http://www.giaiphapexcel.com/forum/showthread.php?t=8509
http://www.giaiphapexcel.com/forum/showthread.php?t=8509
http://www.giaiphapexcel.com/forum/showthread.php?t=8509
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Giáo Trình Microsoft Excel 2007 Toàn tập - SSDG 

Nội dung : 

 

Chương 1: Làm Quen Với Microsoft Excel 

Chương 2: Các Khái Niệm Cơ Bản Và Xử Lý Dữ 

Liệu Trong Bảng Tính 

Chương 3: Các Thao Tác Dữ Liệu Đặc Biệt Trong 

Excel 

Chương 4: Giới Thiệu Và Sử Dụng Các Hàm 

Chương 5: Khai Thác Cơ Sở Dữ Liệu 

Chương 6: Đồ Thị Trong Excel 

Chương 7: Định Dạng Trang Và In Bảng Tính 

Chương 8: Làm Việc Với Nhiều Bảng Tính - 

Macro, Templates 

Chương 9: Phím Tắt Và Thủ Thuật 

Chương 10: Gồm 50 bài tập có phim minh họa: 

Bài tập cơ bản: 30 bài 

Bài tập nâng cao: 10 bài 

Bài tập mở rộng: 10 bài 

 

HƯỚNG DẪN CÀI ĐẶT CHƯƠNG TRÌNH 
 

Chương trình sẽ tự động cài đặt. Bạn chỉ cần click chuột vào nút "Tiếp Tục" để hoàn tất quá trình cài đặt. 

Nếu máy tính của Bạn không tự động cài đặt được. Bạn sẽ phải tự cài đặt bằng cách mở chương trình 

Windows Explorer lên. 

Sau đó, Bạn vào thư mục SETUP và chọn tập tin SetUp.exe để cài đặt. 

Trong lúc sử dụng chương trình, có thể do tốc độ của ổ đĩa CD Rom hơi chậm, nên Bạn vui lòng chờ trong 

giây lát ! 

Nếu chương trình cài đặt bị lỗi bạn hãy vào thư mục CDRom\Setup và chạy tập tin ISScript10.MSI 

Chúc Bạn cài đặt và sử dụng tốt chương trình ! 

 

Download : 

 
http://www.mediafire.com/download.php?kxyz1kcxcwb 

http://www.mediafire.com/download.php?m9monnj4mzj 

http://www.mediafire.com/download.php?dv9hmlp3tsi 

http://www.mediafire.com/download.php?ukclx12m23j 

http://www.mediafire.com/download.php?jv0otz65tn0 

http://www.mediafire.com/download.php?zevgtwmzwzl 

http://www.mediafire.com/download.php?jj9hymdyhwj 

 

Giáo Trình Microsoft Word 2007  : 

 
http://www.mediafire.com/?efgmbe4wlnj    

http://www.mediafire.com/?jyyiujxo1ga    

http://www.mediafire.com/?jj4jn419voy    

http://www.mediafire.com/?menedkz95z9    
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MICROSOFT OFFICE  
EXCEL 2007 
 

 
 : http://www.microsoft.com/vietnam/products/office/training/howto_excel2007.aspx 

 

: 
(*) Do tốc độ đường truyền nên có thể bạn sẽ nhìn thấy một trang trắng trước khi 

đoạn phim tải xong. 

Tổng quan giao diện Excel : 
 

 Bài 1: Tổng quan giao diện Excel 

  Bài 2: Chèn thêm và xoá bớt bảng tính  

  Bài 3: Đổi tên, sao chép và di chuyển bảng tính  

  Bài 4: Đổi màu SheetTab và ẩn hiện bảng tính  

  Bài 5: Bảo vệ bảng tính  

 Bài 6: Chọn hình ảnh làm nền cho bảng tính  

 

Cách nhập dữ liệu kiểu công thức : 
 

http://www.microsoft.com/vietnam/products/office/training/howto_excel2007.aspx
javascript:popUp('Movie/1.swf')
javascript:popUp('Movie/1.swf')
javascript:popUp('Movie/5.swf')
javascript:popUp('Movie/5.swf')
javascript:popUp('Movie/6.swf')
javascript:popUp('Movie/6.swf')
javascript:popUp('Movie/7.swf')
javascript:popUp('Movie/7.swf')
javascript:popUp('Movie/9.swf')
javascript:popUp('Movie/9.swf')
javascript:popUp('Movie/10.swf')
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  Bài 7: Cách nhập dữ liệu kiểu công thức  

  Bài 8: Thao tác với khối trong Excel  

 Bài 9: Xử lý ô, cột, hàng trong bảng tính  

 Bài 10: Định dạng dữ liệu  

  Bài 11: Đặt tên, ghi chú và bảo vệ ô  

  

Chèn đối tượng hình ảnh  : 

 
 Bài 12: Chèn đối tượng hình ảnh  

  Bài 13: Chèn đối tượng ClipArt  

 Bài 14: Chèn đối tượng SmartArt  

 Bài 15: Chèn đối tượng WordArt  

  Bài 16: Chèn đối tượng TextBox  

 Bài 17: Chèn các ký tự đặc biệt vào bảng tính  

 Bài 18: Hiệu chỉnh ClipArt & hình ảnh  

  

Các bước tạo đồ thị  : 
 

  Bài 19: Các bước tạo đồ thị  

  Bài 20: Thiết lập lại biểu đồ  

 Bài 21: Hiệu chỉnh tiêu đề  

  Bài 22: Hiện/ ẩn các nhãn dữ liệu  

 Bài 23: Sửa đổi các trục  

 Bài 24: Hiện/ẩn các đường kẻ lưới  

  Bài 25: Xoay đồ thị dạng 3D  

  

Sắp xếp cơ sở dữ liệu  : 
 

  Bài 26: Sắp xếp cơ sở dữ liệu  

  Bài 27: Lọc tự động  

  Bài 28: Lọc nâng cao  

  Bài 29: Tổng hợp dữ liệu theo nhóm  

  

javascript:popUp('Movie/23.swf')
javascript:popUp('Movie/24.swf')
javascript:popUp('Movie/25.swf')
javascript:popUp('Movie/26.swf')
javascript:popUp('Movie/27.swf')
javascript:popUp('Movie/12.swf')
javascript:popUp('Movie/13.swf')
http://www.microsoft.com/vietnam/products/office/training/edit.htm
javascript:popUp('Movie/15.swf')
javascript:popUp('Movie/16.swf')
javascript:popUp('Movie/17.swf')
javascript:popUp('Movie/121.swf')
javascript:popUp('Movie/36.swf')
javascript:popUp('Movie/37.swf')
javascript:popUp('Movie/38.swf')
javascript:popUp('Movie/39.swf')
javascript:popUp('Movie/40.swf')
javascript:popUp('Movie/41.swf')
javascript:popUp('Movie/42.swf')
javascript:popUp('Movie/44.swf')
javascript:popUp('Movie/45.swf')
javascript:popUp('Movie/46.swf')
javascript:popUp('Movie/47.swf')
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Đặt lề trang in  : 
 

  Bài 30: Đặt lề trang in  

  Bài 31: Tạo tiêu đề đầu trang và cuối trang  

  Bài 32: Lặp lại tiêu đề bảng tính khi sang trang  

  Bài 33: Thực hiện in ấn  

  Bài 34: Chèn và hiệu chỉnh lưu đồ  

  Bài 35: Chèn và hiệu chỉnh biểu đồ  

  Bài 36: Chèn và hiệu chỉnh Wordart  

  Bài 37: Tạo và hiệu chỉnh Textbox  

  Bài 38: Lập và hiệu chỉnh biểu thức toán học  

  

Thao tác tạo bảng  : 
 

  Bài 39: Thao tác tạo bảng  

  Bài 40: Các thao tác trên bảng  

  Bài 41: Thao tác chỉnh sửa bảng biểu  

  Bài 42: Định dạng đường viền và nền cho bảng  

  

Thiết lập chức năng AutoCorrect  : 
 

  Bài 43: Thiết lập chức năng AutoCorrect  

  Bài 44: Tạo ghi chú cho tài liệu  

  Bài 45: Sử dụng chức năng tìm kiếm và thay thế  

 

Bài tập thực hành : 
 

 Bài 46: Bảng kê tiền thuê máy vi tính  

  Bài 47: Bảng kê chí phí khách sạn  

  Bài 48: Bảng giá NoteBook  

  Bài 49: Bảng thống kê xuất hàng  

  Bài 50: Bảng tính lương  

 
 

javascript:popUp('Movie/49.swf')
javascript:popUp('Movie/50.swf')
javascript:popUp('Movie/52.swf')
javascript:popUp('edit.htm')
javascript:popUp('edit.htm')
javascript:popUp('edit.htm')
javascript:popUp('edit.htm')
javascript:popUp('Movie/36.swf')
javascript:popUp('Movie/37.swf')
javascript:popUp('Movie/38.swf')
javascript:popUp('Movie/39.swf')
javascript:popUp('Movie/40.swf')
javascript:popUp('Movie/41.swf')
javascript:popUp('edit.htm')
javascript:popUp('Movie/52.swf')
javascript:popUp('edit.htm')
javascript:popUp('Movie/55.swf')
javascript:popUp('Movie/56.swf')
javascript:popUp('Movie/57.swf')
javascript:popUp('Movie/58.swf')
javascript:popUp('Movie/59.swf')
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MICROSOFT OFFICE : EXCEL  
( Nh ) . 

 
http://www.quantrimang.com.vn/timkiem/excel/index.aspx?verify=OosEPZWzXE0%3d 

 
MS Excel - Bài 1: Bắt đầu Microsoft Excel 2007  

MS Excel - Bài 2: Tùy chỉnh trong Excel  
MS Excel - Bài 3: Làm việc với Workbook   

MS Excel - Bài 4: Thao tác với dữ liệu   

MS Excel - Bài 5: Chỉnh sửa Worksheet   

MS Excel - Bài 6: Tính toán trong Excel   

MS Excel - Bài 7: Tạo Macros trong Excel 2007   

MS Excel - Bài 8: Sort and Filter  

MS Excel - Bài 9: Graphics  
MS Excel - Bài 10: Biểu đồ trong Excel 2007  
MS Excel - Bài 11: Định dạng bảng tính  

MS Excel - Bài 12: Phát triển Workbook  
MS Excel - Bài 13: Định dạng trang tính và in  

MS Excel - Bài 14: Layout  
 

Những "tuyệt chiêu" trong Excel 
 
1.Tùy biến cửa sổ làm việc của bảng tính 
2.Nhập dữ liệu đồng thời vào nhiều sheet 

3.Ngăn chận người sử dụng thực hiện một số hành động nào đó nhất định 
4.Ngăn chặn các nhắc nhở không cần thiết 

5.Ẩn sheet sao cho người dùng không thể dùng lệnh unhide để hiện ra 

6.Tự thiết kế một bảng tính mẫu (template) 
7.Tạo chỉ mục cho các Sheet trong Workbook 

8.Giới hạn vùng cuộn của bảng tính 

9.Khóa và bảo vệ những ô có chứa công thức 
10.Sử dụng định dạng theo điều kiện để tìm dữ liệu trùng 

11.Tìm dữ liệu xuất hiện 2 hoặc nhiều lần bằng công cụ Conditional Formating 
12.Tạo riêng một thanh công cụ cho riêng một bảng tính cụ thể 

13.Sao chép công thức giữ nguyên tham chiếu tương đối (giống như sao chép tham 

chiếu tuyệt đối) 
14.Gỡ bỏ những liên kết ma 

15.Giảm kích thước file Excel bị phình to bất thường 
16.Cứu dữ liệu từ một bảng tính bị lỗi 

17.Sử dụng Data-Validation khi danh sách nguồn nằm trong một Sheet khác 
18.Điều khiển Conditional Formating bằng checkbox 

19.Đánh dấu những ô chứa công thức bằng Conditional Formatting 

20.Đếm hoặc cộng những ô đã được định dạng có điều kiện 
21.Tô màu dòng xen kẽ 

22.Tạo hiệu ứng 3D trong các bảng tính hay các ô 

23.Bật, tắt chức năng Conditional Formatting bằng 1 checkbox 

http://www.quantrimang.com.vn/timkiem/excel/index.aspx?verify=OosEPZWzXE0%3d
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61331_MS-Excel-Bai-1-Bat-dau-Microsoft-Excel-2007.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61420_MS-Excel-Bai-2-Tuy-chinh-trong-Excel.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61437_MS-Excel-Bai-3-Lam-viec-voi-Workbook.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61475_MS-Excel-Bai-4-Thao-tac-voi-du-lieu.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61526_MS-Excel-Bai-5-Chinh-sua-Worksheet.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61560_MS-Excel-Bai-6-Tinh-toan-trong-Excel.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61596_MS-Excel-Bai-7-Tao-Macros-trong-Excel-2007.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61641_MS-Excel-Bai-8-Sort-and-Filter.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61677_MS-Excel-Bai-9-Graphics.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61749_MS-Excel-Bai-10-Bieu-do-trong-Excel-2007.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61799_MS-Excel-Bai-11-Dinh-dang-bang-tinh.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61841_MS-Excel-Bai-12-Phat-trien-Workbook.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61888_MS-Excel-Bai-13-Dinh-dang-trang-tinh-va-in.aspx
http://www.quantrimang.com.vn/kienthuc/tin-hoc-van-phong/ms-excel/61967_MS-Excel-Bai-14-Layout.aspx
http://www.giaiphapexcel.com/forum/showthread.php?p=105407#post105407
http://www.giaiphapexcel.com/forum/showthread.php?p=105714#post105714
http://www.giaiphapexcel.com/forum/showthread.php?p=105979#post105979
http://www.giaiphapexcel.com/forum/showthread.php?p=106262#post106262
http://www.giaiphapexcel.com/forum/showthread.php?p=106535#post106535
http://www.giaiphapexcel.com/forum/showthread.php?p=106989#post106989
http://www.giaiphapexcel.com/forum/showthread.php?p=107320#post107320
http://www.giaiphapexcel.com/forum/showthread.php?p=107512#post107512
http://www.giaiphapexcel.com/forum/showthread.php?p=107700#post107700
http://www.giaiphapexcel.com/forum/showthread.php?p=107960#post107960
http://www.giaiphapexcel.com/forum/showthread.php?p=108323#post108323
http://www.giaiphapexcel.com/forum/showthread.php?p=108525#post108525
http://www.giaiphapexcel.com/forum/showthread.php?p=108967#post108967
http://www.giaiphapexcel.com/forum/showthread.php?p=109323#post109323
http://www.giaiphapexcel.com/forum/showthread.php?p=109446#post109446
http://www.giaiphapexcel.com/forum/showthread.php?p=109545#post109545
http://www.giaiphapexcel.com/forum/showthread.php?p=110265#post110265
http://www.giaiphapexcel.com/forum/showthread.php?p=110339#post110339
http://www.giaiphapexcel.com/forum/showthread.php?p=110808#post110808
http://www.giaiphapexcel.com/forum/showthread.php?p=110983#post110983
http://www.giaiphapexcel.com/forum/showthread.php?p=111252#post111252
http://www.giaiphapexcel.com/forum/showthread.php?p=112543#post112543
http://www.giaiphapexcel.com/forum/showthread.php?p=112965#post112965
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24.Dùng nhiều List cho 1 Combobox 
25.Tạo một danh sách xác thực thay đổi theo sự lựa chọn từ một danh sách khác 

26.Sử dụng chức năng thay thế (Replace) để gỡ bỏ các ký tự không mong muốn 
27.Chuyển đổi con số dạng văn bản sang số thực 

28.Trích xuất dữ liệu số trong 1 chuỗi bằng VBA 

29.Tùy biến chú thích của ô bảng tính 
30.Sort thứ tự dựa trên nhiều hơn ba cột 

31.Sắp xếp ngẫu nhiên 

32.Thao tác trên dữ liệu với Advanced Filter 
33.Tạo các định dạng số cho riêng bạn 

34.Tăng thêm số lần Undo cho Excel 
35.Tự tạo danh sách để fill 

36.Làm nổi các Subtotal của Excel 

37.Chuyển đổi các hàm và công thức trong Excel thành giá trị 
38.Thêm dữ liệu vào danh sách Validation một cách tự động 

39.Ngày tháng trong Excel 

40.Cho phép sử dụng tính năng Group and Outline trên bảng tính bị khoá 
41.Bẫy lỗi để trống dữ liệu"]Bẫy lỗi để trống dữ liệu 

42.Giảm danh sách xổ xuống của Validation, sau khi chọn 1 
43.Thêm các danh sách có sẵn và cả danh sách tự tạo vào menu chuột phải 
 

 

Những điểm mới trong Excel 2007  

 
  

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
Với một giao diện ngƣời dùng hƣớng kết quả mới. Microsoft Office Excel 2007 cung cấp các công 
cụ phong phú, có nhiều đặc tính giúp các bạn có thể sử dụng để phân tích, chia sẻ và quản lý dữ 

liệu một cách dễ dàng. 
 

1.Giao diện người dùng hướng kết quả 
 
Giao diện ngƣời dùng hƣớng kết quả làm cho bạn dễ dàng làm việc trong Microsoft Office Excel. 

Nhiều lệnh và đặc tính thông thƣờng vẫn đƣợc dấu trong các menu phức tạp và thanh công cụ thì 
bây giờ trở lên dễ dàng hơn khi tìm trên các tab hƣớng nhiệm vụ, chúng gồm có các nhóm logic 
lệnh và nhiều tính năng. Các hộp thoại đƣợc thay thế với menu thả xuống hiển thị các tùy chọn có 

sẵn, chú thích chỉ dẫn hoặc phần duyệt mẫu xem trƣớc đƣợc cung cấp để giúp bạn chọn tùy chọn 

http://www.giaiphapexcel.com/forum/showthread.php?p=113006#post113006
http://www.giaiphapexcel.com/forum/showthread.php?p=113537#post113537
http://www.giaiphapexcel.com/forum/showthread.php?p=113706#post113706
http://www.giaiphapexcel.com/forum/showthread.php?p=114025#post114025
http://www.giaiphapexcel.com/forum/showthread.php?p=114335#post114335
http://www.giaiphapexcel.com/forum/showthread.php?p=114464#post114464
http://www.giaiphapexcel.com/forum/showthread.php?p=114931#post114931
http://www.giaiphapexcel.com/forum/showthread.php?p=114998#post114998
http://www.giaiphapexcel.com/forum/showthread.php?p=115830#post115830
http://www.giaiphapexcel.com/forum/showthread.php?p=116079#post116079
http://www.giaiphapexcel.com/forum/showthread.php?p=116094#post116094
http://www.giaiphapexcel.com/forum/showthread.php?p=116354#post116354
http://www.giaiphapexcel.com/forum/showthread.php?p=117091#post117091
http://www.giaiphapexcel.com/forum/showthread.php?p=117519#post117519
http://www.giaiphapexcel.com/forum/showthread.php?p=118149#post118149
http://www.giaiphapexcel.com/forum/showthread.php?p=119389#post119389
http://www.giaiphapexcel.com/forum/showthread.php?p=119515#post119515
http://www.giaiphapexcel.com/forum/showpost.php?p=120185&postcount=49
http://www.giaiphapexcel.com/forum/showpost.php?p=120759&postcount=50
http://www.giaiphapexcel.com/forum/showthread.php?p=120922#post120922
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hợp lý. 
Dù bạn đang làm gì trong giao diện ngƣời dùng đi chăng nữa – dù nó đang định dạng hay phân 

tích dữ liệu – thì Excel cũng thể hiện cho bạn các công cụ hữu ích nhất để có thể thực hiện thành 
công nhiệm vụ đó.  
 

 
Mọi công cụ đều đƣợc đƣa ra trong các tab nhiệm vụ 
 

2.Nhiều hàng, cột hơn và nhiều giới hạn mới 
 
Để bạn có thể khai thác số lƣợng lớn dữ liệu trong bảng tính, Office Excel 2007 hỗ trợ lên đến 1 

triệu hàng và 16 nghìn cột trên mỗi bảng tính. Đặc biệt, hệ thống dòng kẻ Office Excel 2007 là 
1.048.576 hàng và 16.384 cột, chúng thực sự đã cung cấp cho bạn hơn đến 1500% số hàng và 
6300% số cột so với Microsoft Office Excel 2003.  

 
 

]  
 

Bảng tính rộng hơn - Thay vì 4 nghìn loại định dạng, bây giờ bạn có thể sử dụng số lƣợng không 
giới hạn trong cùng một workbook và số ô tham chiếu trên từng ô tăng từ 8 nghìn đến giới hạn 

cho phép bởi bộ nhớ. 
- Để cải thiện hiệu suất của Excel, quản lý bộ nhớ đƣợc tăng từ 1GB trong Microsoft Office Excel 
2003 đến 2GB đối với Office Excel 2007. 

- Bạn cũng sẽ cảm thấy tính toán nhanh hơn trong các bảng tính lớn nhiều công thức bởi vì  
- Office Excel 2007 hỗ trợ bộ bộ vi xử lý kép và nhiều chipset. 
- Office Excel 2007 cũng hỗ trợ lên đến 16 triệu màu.  

 
3.Office themes và Excel styles 



14 
 

 
Trong Office Excel 2007, bạn có thể định dạng dữ liệu một cách nhanh chóng bằng việc áp dụng 

Office theme hoặc style đặc biệt. Các Office theme có thể đƣợc chia sẻ qua chƣơng trình khác của 
Office 2007 nhƣ Microsoft Office Word và Microsoft Office PowerPoint, trong khi đó style đƣợc 
thiết kế để thay đổi định dạng của các mục Excel đặc biệt nhƣ bảng, biểu đồ, PivotTable, hình hay 

sơ đồ. 
Việc áp dụng Office theme: Office theme là thiết lập ban đầu gồm màu, phông chữ, dòng và 
các hiệu ứng tô màu có thể đƣợc áp dụng cho toàn bộ workbook hoặc các mục đặc biệt nhƣ biểu 

đồ hay bảng biểu. Chúng có thể giúp bạn tạo các tài liệu trông rất tuyệt vời. Công ty của bạn có 
thể đang cung cấp một Office theme tập thể và bạn có thể sử dụng nó hoặc chọn từ Office theme 

định nghĩa sẵn trong Excel. Bạn cũng có thể dễ dàng tạo các Office theme riêng và áp dụng với 
tất cả các workbook của Excel hay tài liệu khác trong bộ Office 2007. Khi tạo một theme, màu, 
phông chữ và các hiệu ứng tô màu đều thay đổi đƣợc riêng rẽ để bạn có thể thay đổi một phần 

hoặc toàn bộ tùy chọn này. 
Sử dụng style: style là một định dạng dựa trên theme, đƣợc định nghĩa trƣớc mà bạn có thể áo 
dụng để thay đổi hình ảnh của bảng biểu, biểu đồ sơ đồ, hình và PivotTable. Nếu các style đƣợc 

định nghĩa trƣớc không thỏa mãn với những cần thiết thì bạn có thể tùy chỉnh lại. Với các biểu đồ, 
bạn có thể chọn từ nhiều style đƣợc định nghĩa trƣớc nhƣng không thể tạo các style biểu đồ của 
riêng bạn. 

Cũng nhƣ trong Excel 2003, các kiểu ô đƣợc sử dụng để định dạng các ô đã chọn nhƣng bạn có 
thể áp dụng nhanh chóng với kiểu ô đƣợc định nghĩa trƣớc. Hầu hết các kiểu ô không dựa trên 
theme đƣợc áp dụng cho workbook của bạn, tuy nhiên cũng có thể tạo chúng một cách dễ dàng. 

 
 
4. Định dạng có điều kiện phong phú hơn 

 
Với bộ Office 2007, bạn có thể sử dụng định dạng điều kiện để diễn giải dữ liệu trong khi quan sát 
cho cả trình diễn và phân tích. Để dễ dàng tìm ngoại lệ và phát hiện ra các xu hƣớng quan trọng 

trong dữ liệu, bạn có thể bổ sung và quản lý nhiều nguyên tắc định dạng điều kiện có áp dụng 
định dạng ảo phong phú trong form của gradient màu, các thanh dữ liệu và các tập biểu tƣợng 

cho dữ liệu cần đến nguyên tắc đó. Định dạng điều kiện cũng dễ dàng áp dụng – chỉ trong vài 
kích chuột, bạn có thể nhìn thấy mối quan hệ có thể sử dụng cho mục đích phân tích trong dữ liệu 
của bạn.  
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5. Viết công thức dễ dàng 

 
Những bổ sung cho việc viết công thức trở lên dễ dàng hơn trong Office Excel 2007.  
 

Thanh công thức (Formula bar) có thể điều chỉnh kích thước: Thanh công thức tự động 
thay đổi kích thƣớc để trợ giúp cho các công thức dài, phức tạp, điều đó tránh cho công thức bao 
trùm lên dữ liệu khác trong bảng tính. Bạn cũng có thể viết công thức dài hơn với nhiều mức lồng 

nhau hơn so với những gì bạn có thể làm trong các phiên bản Excel trƣớc.  
 

Function AutoComplete: Với Function AutoComplete, bạn có thể viết cú pháp công thức đúng 
một cách nhanh chóng. Từ việc phát hiện dễ dàng các hàm mà bạn muốn sử dụng để hoàn thành 
đối số công thức, bạn sẽ có đƣợc công thức đúng.  

 

 
 

Tham chiếu cấu trúc (Structured references) 
: Với các tham chiếu ô nhƣ A1 và R1C1, Office Excel 2007 cung cấp các tham chiếu cấu trúc để 
tham chiếu đến các dãy tên và bảng trong một công thức.  

 
Dễ dàng truy cập vào các dãy tên: Bằng việc sử dụng bộ quản lý tên của Office Excel 2007, 
bạn có thể tổ chức, nâng cấp và quản lý nhiều dãy tên trong các vị trí trung tâm, điều đó giúp bất 

cứ ai cần làm việc trên bảng tính của bạn phải giải thích các công thức và dữ liệu của nó. 
 
6. Nhiều hàm lũy thừa và công thức OLAP mới 

 
Khi bạn làm việc với các cơ sở dữ liệu nhiều kích thƣớc (nhƣ SQL Server Analysis Services) trong 

Office Excel 2007, bạn có thể sử dụng công thức OLAP để xây dựng các báo cáo phức tạp, giới 
hạn dữ liệu OLAP và form miễn phí. Các hàm lũy thừa mới đƣợc sử dụng để trích dữ liệu OLAP 
(các tập và giá trị) từ Analysis Services và hiển thị nó trong một ô. Công thức OLAP có thể đƣợc 

tạo ra khi bạn biến đổi công thức PivotTable thành công thức ô hoặc khi bạn sử dụng 
AutoComplete cho các đối số của hàm lũy thừa khi đánh công thức.  
 

7. Cải tiến việc phân loại và lọc 
 
Với Office Excel 2007, bạn có thể sắp xếp dữ liệu bảng tính một cách nhanh chóng bằng việc sử 

dụng tính năng lọc và phân loại nâng cao. Ví dụ: bạn có thể phân loại bởi mầu sắc và hơn 3 mức 
(lên đến 64). Bạn cũng có thể lọc dữ liệu bởi màu hoặc bởi ngày, hiển thị trên 1000 mục trong 
danh sách AutoFilter drop-down, chọn nhiều mục chọn để lọc và lọc dữ liệu trong PivotTables.  

 
8. Các cải tiến về bảng biểu 
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Với Office Excel 2007, bạn có thể sử dụng giao diện ngƣời dùng mới để làm việc dễ dàng hơn - 

giao diện dùng để tạo, định dạng và mở rộng bảng Excel (đƣợc biết đến nhƣ một danh sách Excel 
trong Excel 2003) một cách nhanh chóng để tổ chức dữ liệu trên bảng tính. Các chức năng mới 
hoặc đƣợc cải thiện bao gồm: 

 
Các dòng header của bảng: Các dòng table header có thể đƣợc bật hoặc tắt. Khi table header 
hiển thị, chúng cho ta thấy dữ liệu trong cột bằng việc thay thế header của bảng tính khi bạn 

chuyển xung quanh trong một bảng dài. 
 

Các cột tính Calculated columns: Các cột tính sử dụng một công thức đơn để điều chỉnh cho 
mỗi hàng. Nó tự động mở rộng khi bạn thêm các cột vào để công thức đƣợc mở rộng đến các cột 
đó ngay lập tức. Tất cả những gì bạn phải làm là nhập một lần công thức – bạn không cần sử 

dụng các lệnh Fill hoặc Copy. 
 
Bộ lọc tự động (Automatic AutoFiltering): Bộ lọc tự động đƣợc bật mặc định trong một bảng 

để cho phép phân loại mạnh mẽ và việc lọc bảng dữ liệu. 
 
Tham chiếu cấu trúc (Structured references): Loại tham chiếu này cho phép bạn sử dụng 

tên của table column header trong công thức thay vì tham chiếu ô nhƣ A1 hoặc R1C1. 
 
Dòng tổng (Tatal rows): Trong dòng tổng, bạn có thể sử dụng các công thức thông dụng và 

mục văn bản.  
 
Table styles: Bạn có thể áp dụng một table style để nhanh chóng thêm định dạng chuyên 

nghiệp, chất lƣợng cao vào bảng, Excel duy trì nguyên tắc luân phiên thông qua các hành động 
phá vỡ layout truyền thống này nhƣ là việc lọc, ẩn hàng hoặc sắp xếp lại một cách thủ công các 
hàng và cột.  

 
9. Các biểu đồ mới 

Với Office Excel 2007, bạn có thể sử dụng công cụ lập biểu đồ mới để tạo các biểu đồ trông 
chuyên nghiệp hơn và cho phép truyền thông thông tin hiệu quả. Dựa vào chủ đề đƣợc áp dụng 
cho workbook, các biểu đồ mới đƣợc nâng cấp gồm có các hiệu ứng đặc biệt nhƣ 3-D, chiếu, và 

bóng.  
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Giao diện ngƣời dùng mới giúp cho phần mềm trở nên dễ dàng hơn trong việc khai thác các loại 
biểu đồ có sẵn, để bạn có thể tạo đƣợc biểu đồ thích hợp cho dữ liệu của bạn. Nhiều biểu đồ 

đƣợc định nghĩa trƣớc và các layout đƣợc cung cấp để bạn có thể áp dụng định dạng đẹp mắt 
một cách nhanh chóng và chứa các chi tiết mà bạn muốn trong biểu đồ. 
 

Hộp các thành phần biểu đồ ảo: Bên cạnh các layout và định dạng nhanh, bạn cũng có thể sử 
dụng một giao diện mới để thay đổi nhanh chóng phần tử của biểu đồ. Chỉ cần vài kích chuột bạn 
có thể thêm hoặc gỡ bỏ nhiều tiêu đề, chú giải, nhãn dữ liệu và các thành phần khác của biểu đồ.  

Một OfficeArt mới Bởi vì các biểu đồ trong Office Excel 2007 đƣợc vẽ với OfficeArt, hầu hết những 
thứ bạn có thể thực hiện trong OfficeArt cũng có thể mang ra thực hiện cho biểu đồ và các thành 

phần của nó. Ví dụ, bạn có thể thêm một loại bóng hoặc hiệu ứng cạnh xiên để tạo thành phần 
nổi bật, hoặc dụng tính trong suốt để tạo các thành phần có thể nhìn thấy bị mờ một phần nào 
đó. Bạn cũng có thể sử dụng các hiệu ứng 3-D hiện thực. 

 
Các dòng và phông chữ rõ ràng: Các dòng trong các biểu đồ xuất hiện mịn hơn và các phông 
chữ ClearType đƣợc sử dụng cho văn bản cũng đƣợc cải thiện. 

 
Nhiều màu sắc: Bạn cũng có thể chọn từ các màu định sẵn và thay đổi mật độ màu của chúng. 
Với sự điều khiển tốt hơn, bạn có thể thêm các màu của chính bạn bằng việc chọn từ 16 triệu 

màu trong hộp màu.  
 
Các mẫu biểu đồ: Việc lƣu các biểu đồ ƣa thích của bạn nhƣ các template trở nên dễ dàng hơn 

trong một giao diện mới.  
 
10. Biểu đồ chia sẻ 

 
Sử dụng biểu đồ Excel trong các chương trình khác: Trong bộ Office 2007, việc lập biểu đồ 
đƣợc chia sẻ giữa Excel, Word và PowerPoint. Đúng hơn là sử dụng các tính năng lập biểu đồ 

đƣợc cung cấp bởi Microsoft Graph, Word và PowerPoint đã kết hợp chặt chẽ các tính năng vẽ 
biểu đồ của Excel. Bởi vì bảng tính Excel đƣợc sử dụng nhƣ bảng dữ liệu biểu đồ cho các biểu đồ 

của Word và PowerPoint nên có thể chia sẻ các tính năng lập biểu đồ phong phú của Excel trong 
đó gồm có sử dụng các công thức, lọc, phân loại, và khả năng liên kết một biểu đồ với các nguồn 
dữ liệu mở rộng nhƣ Microsoft SQL Server và Analysis Services (OLAP) để cập nhật thông tin 

trong biểu đồ. Bảng tính Excel gồm có dữ liệu của biểu đồ có thể đƣợc lƣu trong tài liệu Word, 
trình diễn PowerPoint hoặc trong file phân biệt để giảm kích thƣớc tài liệu của bạn. 
 

Việc sao các biểu đồ sang các chương trình khác: Các biểu đồ có thể đƣợc sao chép một 
cách dễ dàng giữa các tài liệu hoặc từ chƣơng trình này sang chƣơng trình khác. Khi sao chép một 
biểu đồ từ Excel sang Word hoặc PowerPoint, nó sẽ tự động thay đổi để hợp với trình diễn của 

Powerpoint và tài liệu Word nhƣng vẫn giữ lại đƣợc định dạng của biểu đồ Excel. Bảng tính dữ 
liệu Excel có thể đƣợc nhúng vào trong tài liệu Word và các trình diễn của PowerPoint nhƣng cũng 
có thể để nó lại trong file nguồn của Excel. 

 
Các biểu đồ hoạt ảnh trong PowerPoint: PowerPointcó thể dễ dàng sử dụng hoạt ảnh để 
nhấn mạnh dữ liệu trong biểu đồ dựa trên Excel. Bạn có thể tạo hoạt ảnh toàn bộ biểu đồ hoặc 

mục chú thích và nhãn trục. Với biểu đồ cột, bạn có thể hoạt ảnh các cột riêng biệt để minh họa 
cho một điểm cụ thể nào đó rõ hơn. Tính năng hoạt ảnh là một tính năng dễ dàng tìm kiếm và 

bạn có nhiều điều khiển trên nó. Ví dụ: bạn có thể thay đổi các bƣớc hoạt ảnh riêng rẽ và sử 
dụng nhiều hiệu ứng hoạt ảnh.  
 

11. Dễ dàng sử dụng PivotTables 
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Với Office Excel 2007, PivotTables trở lên dễ dàng sử dụng hơn so với các phiên bản trƣớc đây 

của Excel. Bằng việc sử dụng giao diện PivotTable mới, thông tin mà bạn muốn quan sát về dữ 
liệu chỉ cần vài kích chuột – bạn không phải mất thời gian để kéo dữ liệu và thả vào các vùng, 
thông thƣờng chúng không phải là một việc dễ dàng. Thay vì đó bạn chỉ cần chọn các trƣờng mà 

bạn muốn xem trong một danh sách trƣờng PivotTable. 
Sau khi bạn tạo một PivotTable, bạn có thể có nhiều thuận lợi trong những cái mới của Excel hoặc 
những thứ đƣợc cải thiện để tổng kết, phân tích và định dạng dữ liệu PivotTable. 

 
Sử dụng Undo trong PivotTables: Bạn có thể undo hầu hết các hành động mà bạn đã cần đến 

để tạo và sắp xếp lại một PivotTable. 
 
Các chỉ thị drill-down cộng và trừ: Các chỉ thị này đƣợc sử dụng để chỉ thị xem bạn có thể mở 

rộng hay thu hẹp các phần của PivotTable để xem nhiều hoặc ít thông tin hơn. 
 
Phân loại và lọc: Việc phân loại đơn giản nhƣ việc chọn một mục trong cột mà bạn muốn phân 

loại và sử dụng các nút phân loại. Bạn có thể lọc dữ liệu bằng việc sử dụng các bộ lọc PivotTable 
nhƣ Greater than, Equals hoặc Contains. 
 

Định dạng điều kiện: Bạn có thể áp dụng việc định dạng điều kiện cho Office Excel 2007 Pivot 
Table bằng ô hoặc đƣờng giao các ô. 
 

Kiểu bảng PivotTable và layout: Giống nhƣ những gì bạn có thể thực hiện với các bảng Excel, 
bạn cũng có thể áp dụng nhanh chóng một loại quen thuộc hoặc đƣợc định nghĩa trƣớc cho 
PivotTable. Và việc thay đổi layout của một PivotTable dễ dàng hơn nhiều đối với giao diện mới 

này. 
 
PivotCharts: Giống nhƣ PivotTables, PivotCharts cũng đƣợc thực hiện một cách dễ dàng trong 

giao diện mới này. Tất cả những cải thiện mới về việc lọc đƣợc cung cấp cho PivotCharts. Khi bạn 
tạo một PivotChart, các công cụ PivotChart đặc biệt và các menu nội dung đƣợc cung cấp để bạn 

có thể phân tích dữ liệu trong biểu đồ. Bạn cũng có thể thay đổi layout, style và định dạng của 
biểu đồ hoặc các thành phần khác của nó theo cùng một cách mà bạn có thể thực hiện cho các 
biểu đồ thông thƣờng. Trong Office Excel 2007, việc định dạng biểu đồ mà bạn áp dụng đƣợc duy 

trì khi thay đổi sang PivotChart, điều này là một bổ sung nâng cấp để theo cách mà nó đã làm 
việc trong các phiên bản Excel trƣớc đây.  
 

12. Kết nối nhanh với dữ liệu mở rộng 
 
Với Office Excel 2007, bạn sẽ nhanh chóng biết đƣợc tên của cơ sở dữ liệu và máy chủ của dữ liệu 

nguồn trong công ty của bạn. Thay vì bạn có thể sử dụng Quicklaunch để chọn từ một danh sách 
dữ liệu nguồn mà quản trị viên hoặc các nhóm chuyên gia đã làm sẵn cho bạn. Một bộ quản lý kết 
nối trong Excel cho phép quan sát đƣợc tất cả các kết nối trong workbook và dễ dàng hơn trong 

việc chỉnh sửa kết nối. 
 
13. Định dạng file mới 

 
Định dạng file dựa trên XML: Trong hệ thống Microsoft Office 2007, Microsoft giới thiệu các định 

dạng file mới của Word, Excel và PowerPoint đƣợc biết đến nhƣ các định dạng Office Open XML. 
Những định dạng file mới này làm thuận tiện việc tích hợp với các dữ liệu nguồn và cũng cho 
phép giảm kích thƣớc file và tăng khả năng khôi phục dữ liệu. Trong Office Excel 2007, định dạng 

mặc định cho một workbook Excel là định dạng file dựa trên XML của Office Excel 2007. Các định 
dạng khác là định dạng file macro-enabled và dựa trên XML của Office Excel 2007(.xlsm), định 
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dạng file của Office Excel 2007 cho một Excel template (.xltx), và định dạng Office Excel 2007 
macro-enabled cho một Excel template (.xltm).  

 
 
Định dạng file nhị phân của Office Excel 2007: Thêm vào các định dạng file mới dựa trên XML, 

Office Excel 2007 cũng giới thiệu một phiên bản nhị phân của định dạng file nén đƣợc phân đoạn 
cho các workbook lớn hay phức tạp. Định dạng file này, định dạng file nhị phân Office Excel 2007 
(hoặc BIFF12)(.xls), có thể đƣợc sử dụng để tùy chọn hiệu suất tối ƣu và các tƣơng thích về sau.  

 
Tƣơng thích giữa các phiên bản Excel: Bạn có thể kiểm tra workbook Office Excel 2007 để xem nó 

có chứa các tính năng hoặc định dạng mà không tƣơng thích với phiên bản cũ của Excel hay 
không để có thể thực hiện những thay đổi cần thiết cho tƣơng thích tốt hơn. Trong phiên bản 
Excel trƣớc đây, bạn có thể cài đặt nâng cấp các bộ chuyển đổi để giúp bạn mở một tài liệu Office 

Excel 2007 mà không mất bất kỳ chức năng hoặc tính năng đặc biệt nào của Office Excel 2007.  
 
14. In tốt hơn 

 
Page Layout View Ngoài chức năng quan sát Normal và Page Break Preview, Office Excel 2007 
còn cung cấp một chức năng quan sát Page Layout. Bạn có thể sử dụng quan sát này để tạo một 

bảng tính trong khi vẫn quan sát đƣợc trông nó nhƣ thế nào khi đƣợc in. Trong quan sát này, bạn 
có thể làm việc với các header và footer của trang, các thiết lập dòng lề trong bảng tính và định vị 
đối tƣợng nhƣ biểu đồ, hình khối một cách chính xác. Bạn cũng có thể chỉ định các tùy chọn một 

cách nhanh chóng nhƣ định hƣớng trang. Dễ dàng qua sát những gì sẽ đƣợc in trong mỗi trang, 
điều này sẽ giúp bạn tránh đƣợc việc phải in thử nhiều lần và phải cắt xén dữ liệu in ra từ máy. 
Lưu trữ trong định dạng PDF và XPS: Bạn có thể lƣu nhƣ một định dạng file PDF hoặc XPS từ 

một chƣơng trình của bộ Office 2007 chỉ sau khi bạn cài đặt một gói add-in mở rộng.  
 
15. Nhiều phương pháp mới chia sẻ công việc 

 
Sử dụng các dịch vụ của Excel để chia sẻ công việc của bạn: Nếu truy cập đến các dịch vụ của 

Excel, bạn có thể sử dụng nó để chia sẻ dữ liệu bảng tính Office Excel 2007 của bạn với mọi ngƣời 
những ngƣời quản trị và các cổ đông khác trong tổ chức). Trong Office Excel 2007, bạn có thể 
chia sẻ một workbook cho các dịch vụ Excel và chỉ định dữ liệu bảng tính mà bạn muốn ngƣời 

khác có thể xem đƣợc. Trong một trình duyệt họ có thể sử dụng Microsoft Office Excel Web 
Access để quan sát, phân tích, in và trích dữ liệu bảng tính này. Office Excel Web Access có nhiều 
tính để dễ dàng thực hiện các công việc nhƣ cuộn, lọc, phân loại, quan sát biểu đồ và sử dụng 

drill-down trong PivotTable. Bạn cũng có thể kết nối Excel Web Access Web Part đến các Web Part 
khác để hiển thị dữ liệu theo nhiều cách khác nhau. Với nhiều sự cho phép hợp lý, ngƣời dùng 
Excel Web Access có thể mở một workbook trong Office Excel 2007 để họ có thể sử dụng đầy đủ 

các chức năng của Excel để phân tích và làm việc với dữ liệu trên máy tính của chính họ nếu họ 
đã cài Excel. 
Sử dụng phƣơng pháp này để chia sẻ công việc bảo đảm cho nhiều ngƣời cùng truy cập vào một 

phiên bản dữ liệu tại một vị trí, nhờ đó dữ liệu luôn là mới nhất cho ngƣời truy cập cùng. Nếu bạn 
muốn mọi ngƣời (nhƣ các thành viên nhóm) đƣa ra các comment và cập nhật thông tin thì bạn 
nên chia sẻ workbook theo cùng một cách mà bạn đã tiến hành với nó trong các phiên bản Excel 

trƣớc đây để chọn thông tin mà bạn cần trƣớc khi lƣu nó vào các dịch vụ Excel. 
Sử dụng máy chủ quản lý tài liệu: Các dịch vụ Excel có thể đƣợc tích hợp với máy chủ quản lý tài 

liệu để tạo một quy trình hợp lệ xung quanh các báo cáo Excel mới và hành động công việc tính 
toán trong workbook nhƣ thông báo dựa trên ô hoặc một quy trình luồng công việc dựa trên sự 
tính toán Excel phức tạp.  
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16. Truy cập nhanh với nhiều template 

 
Với Office Excel 2007, bạn có thể dựa vào một workbook mới với nhiều mẫu khác nhau đã đƣợc 
cài đặt với Excel hoặc có thể truy cập nhanh chóng và tải các mẫu về từ website trực tuyến của 

Microsoft Office.  

 
Định dạng có điều kiện  

trong Excel 2007 
 

Các mẫu định dạng có điều kiện trong Excel 2007 

 
Với thao tác định dạng (Format/Cells) thông thƣờng thì tất cả những ô trong vùng đƣợc chọn sẽ 
chịu chung một kiểu định dạng. Nhƣng nếu bạn có nhu cầu định dạng một cách tự động các giá 

trị trong vùng đƣợc chọn theo một quy tắc (điều kiện) nào đó thì tính năng Conditional Formatting 
của Excel chính là cái mà bạn đang cần tìm. 
 

Điểm đột phá của Excel 2007 so với các phiên bản trƣớc là tính năng định dạng có điều kiện cho 
phép ngƣời sử dụng có thể định dạng phân loại giá trị của các ô theo màu sắc, theo dạng đồ thị 
hoặc theo ký hiệu. Sau này, chỉ cần nhìn qua kiểu định dạng là ngƣời dùng có thể nhận biết đƣợc 

tƣơng đối hoặc chính xác đƣợc giá trị của ô đó. 
 

Để bắt đầu, ngƣời dùng bôi đen vùng cần định dạng rồi chọn Home/Conditional Formatting. Máy 
sẽ hiện ra một danh sách các chế độ lựa chọn: 
- Highlight Cells Rules: đánh dấu màu cho ô theo giá trị của ô. 

+ Greater than (>): định dạng một màu cho các ô có giá trị lớn hơn giá trị đặt tại điều kiện này. 
+ Less than (<): định dạng một màu cho các ô có giá trị nhỏ hơn giá trị đặt tại điều kiện này. 
+ Between: định dạng một màu cho các ô có giá trị trong khoảng giá trị đặt tại điều kiện này. 

+ Equal to (=): định dạng một màu cho các ô có giá trị chính xác bằng giá trị đặt tại điều kiện 
này. 
+ Text contains that: định dạng một màu cho các ô có chuỗi ký tự chứa chuỗi ký tự đặt tại điều 

kiện này. 
+ A date occurring: định dạng một màu cho các ô có giá trị dạng ngày tháng bằng giá trị đặt tại 
điều kiện này. 

+ Duplicate Values: định dạng một màu cho các ô có giá trị giống nhau trong vùng đƣợc chọn. 
- Top/Bottom Rules: đặt điều kiện định dạng theo giá trị lớn nhất hoặc nhỏ nhất. 
+ Top 10 Items: định dạng cho 10 giá trị lớn nhất theo giá trị tuyệt đối (10 giá trị lớn nhất trong 

một số lƣợng nào đó). 
 
+ Top 10%: định dạng cho 10 giá trị lớn nhất theo giá trị tƣơng đối (10% của một mẫu số nào 

đó) 
+ Bottom 10 Items: định dạng cho 10 giá trị nhỏ nhất theo giá trị tuyệt đối. (10 giá trị lớn nhất 

trong một số lƣợng nào đó) 
+ Bottom 10%: định dạng cho 10 giá trị nhỏ nhất theo giá trịtƣơng đối (10% của một mẫu số nào 
đó). 

+ Above average: định dạng cho giá trị lớn trên trung bình. 
+ Below average: định dạng cho giá trị nhỏ hơn trung bình. 
- Data Bars: định dạng thêm kiểu biểu đồ dạng thanh ngang cho giá trị của ô theo các mức giá trị 
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từ nhỏ đến lớn. Excel tự phân giải màu theo dải giá trị của các ô đƣợc chọn 
- Color Scales: định dạng theo kiểu dải màu biến đổi theo giá trị ô từ nhỏ đến lớn. Tối đa 03 điều 

kiện. 
- Icon Sets: định dạng theo kiểu biểu tƣợng biến đổi theo giá trị ô từ nhỏ đến lớn. Chế độ này cho 
phép đặt tối đa 5 điều kiện. 

Ví dụ có thể phân loại điểm học sinh theo 5 mức: >=9 là xuất sắc, >=8 và <9 là giỏi, >=6,5 và 
<8 là khá, >=5 và <6,5 là trung bình, <5 là yếu. (xem hình dƣới) 
 

 

 
 

- New Rule…: lập điều kiện định dạng mới. Ở chế độ này, khi ngƣời dùng chọn Format all cells 
base on their values là một chế độ tổng hợp, cho phép ngƣời dùng tùy chọn trong các chế độ mặc 
định trên. 

- Clear Rule: xóa định dạng có điều kiện 
- Manage Rules: quản lý, thay đổi, chỉnh sửa các điều kiện định dạng đã thiết lập. 
Quốc Long (dantri.com.vn) 

Posted on September 26, 2008 by 123zo  
 

 
 

Làm việc với Excel 2007 
 
 

Bài viết này  hƣớng dẫn mẹo nhỏ về ứng dụng văn phòng 
Microsoft Excel 2007.  
 

 
LỜI KHUYÊN 
 

Dữ liệu in hoàn hảo 
 

Nếu các dữ liệu in ra không phù hợp với hình dáng của trang 
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dữ liệu Excel 2007, hãy kiểm tra page layout (bên dƣới tab View) để xem xem chính xác những 
gì máy in sẽ in ra. Bạn cũng có thể dễ dàng add thêm các header hay footer vào dữ liệu in. 

 
Tạo danh sách chọn “drop-down” 
 

Trong Excel có công cụ tạo một danh sách lựa chọn có sẵn. Để tạo nó trƣớc tiên bạn phải có một 
danh sách, chọn các ô theo hàng hoặc cột mà bạn sẽ không sử dụng đến; nhập nội dung danh 
sách vào từng ô trong hàng hoặc cột đó. Chọn các ô sẽ có danh sách drop-down chọn sẽ xuất 

hiện (các ô không cần tiếp giáp nhau). Chọn Data | Validation… Dƣới Allow chọn List. Tích 
In-cell dropdown, kích chuột trái vào Source: hộp, đánh dấu các cell đã nhập danh sách ban 

đầu của bạn, sau đó chọn OK. 
HƯỚNG DẪN 
 

Tạo phím tắt chèn ngày hiện tại 
 
Bạn có thể chèn ngày hiện hành vào bất kỳ cell nào bằng cách nhấn Ctrl và dấu chấm phẩy (;); 

còn Ctrl + Shift + ; sẽ chèn vào thời gian hiện hành. 
 
Lặp lại văn bản trong nhiều cell 
 
Chọn một dãy các ô trống, đánh vào nội dung văn bản (văn bản sẽ xuất hiện trong ô đầu tiên), 
nhấn Ctrl+Enter, khi đó văn bản sẽ điền vào trong các ô đã đánh dấu. 

 
Paste văn bản plain text vào Excel 
 

Nếu bạn muốn paste văn bản từ Word hoặc IE vào Excel mà 
không muốn có định dạng theo nguồn lấy (lấy theo dạng plain 
text). Hãy nhấn F2 để vào chế độ chỉnh sửa trƣớc khi paste. 

Sau đó chỉ paste văn bản đã copy vào, phần định dạng sẽ đƣợc 
bỏ đi. 

Paste vào các ô không liên tục 
 
Việc Paste công thức từ một ô nào đó vào một loạt các ô không 

liên tục không có nghĩa là thực hiện nhiều lần cut và paste. Hãy copy công thức từ ô nguồn, giữ 
phím Ctrl và kích vào mỗi ô nơi bạn muốn paste công thức vào. Sau đó nhấn Ctrl-V để paste công 
thức vào tất cả các cell. Thao tác này cũng cũng có thể áp dụng cùng với thao tác nhập lặp lại dữ 

liệu trong nhiều ô (chọn một vùng cần nhập công thức, gõ công thức vào và nhấn Ctrl + Enter) 
 
Sang phải – không xuống dòng 
 
Thông thƣờng việc nhấn phím Enter sẽ chuyển con trỏ của Excel xuống ô bên dƣới. Nếu bạn thích 
nó chuyển sang phải trong Excel 2007, hãy vào nút Office ở góc trên bên trái màn hình, chọn 

Excel Options, và chọn Advanced. Dƣới Editing options, lựa chọn đầu tiên là ―After 
pressing Enter, move selection‖ – có nghĩa là chọn hƣớng, ở đây nếu là sang phải thì bạn hãy 
chọn ―right‖. 

 
Tạo một hằng số 
 
Bạn muốn có một số nào đó có thể sử dụng nhiều lần trong trang bảng tính? Hãy tạo nó thành 
một hằng số. Trên tab Formulas, kích vào Define Name, và đặt tên cho ô đƣợc chọn – chính là 

tên hằng số (ví dụ nhƣ ―taxrate‖). Đặt một số trong ô đó. Lúc này bạn có thể sử dụng tên hằng số 
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đó trong một công thức (ví dụ nhƣ =(b4*taxrate) thay cho việc đánh vào một tập hợp các số 
phức tạp). Bạn có thể thiết lập nhiều ô đặt tên nếu muốn. 

 
Định dạng nhanh một bảng Excel 
 

Lấy danh sách dữ liệu và định dạng nhanh chúng thành các bảng Excel, sử dụng gallery của các 
kiểu trong lệnh Format as Table—nó là một ribbon nằm trong tab Home. Tích vào hộp chọn 
―My table has headers‖ (nếu bảng có các header) và bạn có thể nhanh chóng phân loại hoặc 

lọc các cột bên trong trang bảng tính bằng cách sử dụng menu drop-down đƣợc tích hợp của 
header. 

 
Bổ sung thêm cột 
 

Việc bổ sung thêm một cột mới vào bảng Excel là quá dễ dàng. Đặt một công thức (ví dụ là SUM) 
trong ô đầu tiên của cột dữ liệu mới đó. Công thức đó sẽ tự động đƣợc áp dụng cho tất cả các ô 
trong cột này, nó cũng có thể đƣợc phân loại hoặc lọc. Thêm một cột khác và sử dụng công thức 

khác (nhƣ AVERAGE) nếu thấy cần thiết. 
 
Thêm một hàng tính tổng 
 
Trong cùng với bảng đƣợc định dạng đó, bạn có thể muốn xem tổng tất cả các số hiển thị tại 
hàng dƣới cùng. Kích vào bất cứ nơi nào trong bảng để xuất hiện tab Table Tools | Design. Kích 

vào nó và bạn sẽ tích vào các hộp kiểm trong Table Style Options. Tích Total Row để bổ sung 
thêm hàng tính tổng ngay lập tức. Sau đó kích mỗi ô trong toàn bộ hàng để chọn ra một hàm 
(SUM, AVERAGE,…) từ mũi tên sổ xuống. 

 
Bố sung thêm hàng mới vào phía trên hàng tổng 
 

Nếu bạn muốn bổ sung thêm các hàng mới vào cuối bảng đã có hàng tính tổng, hãy đƣa trỏ 
chuột vào viền dƣới phải của bảng cho đến khi xuất hiện biểu tƣợng mũi tên hai chiều. Giữ chuột 

và kéo bảng xuống (hoặc kéo sang nếu muốn tạo thêm cột) cho đến khi đủ số dòng cần thiết và 
nhả chuột. Các hàng mới sẽ đƣợc thêm ngay phía trên dòng tổng và định dạng các ô trong hàng 
đó phù hợp với định dạng đã có trong bảng. 

 
Chuyển đổi các bảng sang dữ liệu thông thường 
 

Các bảng của Excel, có thể thực hiện cập nhật một cách dễ dàng các cột của nó thông qua menu 
lọc và phân loại trong header, có thể đƣợc chuyển đổi thành dải dữ liệu thông thƣờng khi giữ 
cùng định dạng và công thức. Trong tab TableTools | Design, kích Convert to Range. Nhƣng 

bạn nên cẩn thận! chỉ có cách để có thể hoàn lại thao tác này là sử dụng Undo ngay lập tức, bằng 
không bạn phải bắt đầu lại mọi việc từ lệnh Format as Tables (xóa toàn bộ định dạng). 
 

Mã màu cho các clue trực quan 
 
Áp dụng Conditional Formatting (từ phần Styles trên tab Home của ribbon) để tạo mã màu, 

biểu tƣợng và các biểu đồ thanh dữ liệu đƣợc tích hợp (hoặc trộn lẫn) trên mỗi ô. Các clue trực 
quan này cho phép bạn có thể quan sát ngay lập tức các số cao nhất và thấp nhất trong cột hoặc 

hàng đó kể cả khi nó không đƣợc phân loại. 
 
Tìm ra các giá trị nhân bản 
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Conditional Formatting có thể nhận dạng ra các giá trị nhân bản. Khi bạn đánh dấu một danh 
sách và kích Conditional Formatting, chọn Highlight Cell Rules và chỉ định Duplicate 

Values. Các giá trị nhân bản sẽ bị đánh dấu. 
 
Sử dụng các tùy chọn paste 
 
Khi paste dữ liệu đƣợc copy từ Excel 2007 vào Word hoặc PowerPoint, bạn thƣờng sử dụng Ctrl-V, 
tuy nhiên hãy tìm biểu tƣợng clipboard/paper trong phần góc phải bên dƣới của bảng. Nó sẽ xuất 

hiện Paste options, trong đó có một số tùy chọn: sử dụng các định dạng của tài liệu cục bộ cho 
các bảng trong PowerPoint hoặcWord, chúng có thể cho phép bạn paste dữ liệu nhƣ một ảnh 

hoặc làm nổi nó với các bảng đang tồn tại. 
 
Paste như một đối tượng 
 
Dữ liệu từ Excel có thể đƣợc paste nhƣ một đối tƣợng. Trong PowerPoint hoặc Word, vào tab 
Home, kích vào mũi tên dƣới Paste, chọn Paste Special. Trong menu, chọn Microsoft Office 

Excel 2003 Spreadsheet Object. Nếu nút radio bên trái chỉ có Paste thì dữ liệu sẽ đƣợc chèn 
khi bạn kích nó và có khả năng soạn thảo nhƣ bạn có thể thực hiện trong Excel. Nếu bạn chọn 
Paste Link thì bất kỳ một nâng cấp nào xảy ra với dữ liệu của bạn trong trang bảng tính đều 

hiện trong biểu mẫu của Word hoặc PowerPoint. 

 

13 phím tắt trong Excel 2007  
 

Nhiệm vụ 
Thao tác 

phím 

Sử dụng outline border cho các ô đã đƣợc chọn Ctrl-Shift-& 

Sử dụng định dạng ngày với ngày, tháng, và năm Ctrl-Shift-# 

Sử dụng định dạng thời gian với giờ, phút và AM hoặc PM Ctrl-Shift-@ 

Chèn vào thời gian hiện hành Ctrl-Shift-: 

Chèn vào ngày hiện hành Ctrl-; 

Ẩn hàng đã đƣợc chọn Ctrl-9 

Ẩn các cột đã đƣợc chọn Ctrl-0 

Thay đổi giữa việc hiển thị các giá trị ô và hiển thị các công 

thức trong trang bảng tính 
Ctrl-` 

Hiển thị hộp thoại Find and Replace với tab Replace đã chọn Ctrl-H 

Hiển thị hộp thoại Insert Hyperlink cho hyperlink mới Ctrl-K 

Hiển thị cửa sổ Print Preview Ctrl-F2 

Chuyển qua cửa sổ workbook tiếp theo Ctrl-F6 

Hiển thị hộp thoại Macro để tạo, chạy, soạn thảo hoặc xóa một 
macro 

Alt-F8 

 

Theo PC Mag 
 
Posted on September 29, 2008 by 123zo  



25 
 

 
Các bảng tính trông quá đơn điệu với các hàng, cột, đôi khi bạn cũng cần tạo nên những phong 

cách mới trong cách nhìn. Thủ thuật này hƣớng dẫn bạn tạo ảnh nền cho bảng tính trong Excel 
2003 và Excell 2007. 
 

Thủ thuật tạo ảnh nền 
 
Excel 2003: Vào Format >> Sheet >> Background >> Chọn ảnh muốn chèn làm ảnh nền >> 
OK 

 

 

 
 
 

Tạo ảnh nền 
Kết quả: 

 

 
 
Muốn xóa ảnh nền đã tạo, bạn vào Format >> Sheet >> Delete background 
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Xóa ảnh nền 
 
Excel 2007: 

 
Trên thanh Ribbon, chọn Page Layout >> Background >> Chọn ảnh nền >> Insert 

 
 

Tạo ảnh nền 
Kết quả: 

 
Filed under: Ms Office 

 

 
Microsoft Excel là một phần mềm dạng bảng số tính toán có tính năng vô cùng phong phú. Theo 
ƣớc lƣợng của nhiều chuyên gia, ngƣời làm việc văn phòng bình thƣờng chỉ sử dụng tới 10% tính 

năng và công suất của Excel đã là nhiều. Trên thực tế, Excel thƣờng đƣợc sử dụng trong các công 
việc: 

 Lên các bảng tính toán nhanh, nhƣ bảng lƣơng, tính công, tính toán chi phí; 

 Xây dựng các biểu đồ, nhập dữ liệu, sản xuất ra các minh họa hình ảnh; 
 Các mô hình tính toán tài chính có qui mô ở mức trung bình; 
 Các tính toán toán học sử dụng nhiều hàm (số lƣợng hàm toán học có sẵn trong Excel sau 

khi bổ sung add-in và analysis tăng lên đáng kể); 

http://en.wordpress.com/tag/ms-office-2003/
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 Tìm kiếm các nghiệm theo các phƣơng pháp lặp Newton-Ralphson, tìm kiếm nghiệm có 
điều kiện dạng Goalseek, Solver; 

 Tiến hành các hồi qui đơn giản hoặc smoothing bằng hình ảnh và không quá kỹ lƣỡng các 
chi tiết toán học (làm trơn các điểm dữ liệu rời rạc); 

 và rất nhiều tính năng khác 

 
Excel cũng thƣờng xuyên đƣợc nâng cấp, ta nhận thấy rõ nhất là hình ảnh và giao diện đẹp hơn. 
Ở mức thông dụng, hi vọng các thông tin dƣới đây có ích cho ngƣời sử dụng. 

Excel là một bảng chứa các cột và dòng. Ta có thể nhập vào từng ô trong đó chữ, số hay công 
thức, tùy vào nhu cầu sử dụng. Sự khác biệt đầu tiên ta có thể dễ dàng nhận của Excel 2007 là 

giao diện đã đƣợc đổi mới bắt mắt và thân thiện với ngƣời sử dụng hơn. Không chỉ vậy mà còn có 
đôi chút thay đổi khá thú vị. 
 

1. Số hàng và số cột: 
Excel 2003: 65.636 hàng, 265 cột. 
Excel 2007: 1.048.576 hàng (gấp 14 lần), 16.384 cột (gấp 84 lần). Điều này có nghĩa là nếu mỗi 

ngày chúng ta có khoảng 2.800 records thì một sheet chúng ta có thể lƣu trữ cho một năm dữ 
liệu. Về số cột thì có thể nói chúng ta tha hồ. 
 

2. Menu trong Excel 2007 gồm có các menu sau: 
 
Home: Đây là các thao tác thông dụng nhất các bạn thƣờng dùng nhƣ: Clipboard, Font 

(Ctrl+Shift+F), Alignment, Number, Styles, Cells, Editing. 
Insert: Gồm các tác vụ sau: Tables, Illustrations, Charts, Links, Text. 
Page layout: Themes, Page setup, Scale To Fit, Sheet Options, Arrange. 

Formulas: Function Library, Defined Names, Formula Auditing, Calculation. 
Data: Get External Data, Connection, Sort& Filter, Data, Tools, Outline. 
Review: Proofing, Comments, Changes. 

View: Workbook Views, Show/Hide, Zoom, Window, Macros. 
 

 
 

Nếu các bạn đã quá quen  với Excel 2003 và các phiên bản trƣớc, thì với phiên bản này hệ thống 
Menu sẽ làm cho các bạn cảm thấy khó chịu. Trƣớc đây việc vào Tools/Options để chỉnh các thiết 

lập thì nay không còn nữa. Các bạn sẽ chỉnh trực tiếp khi di chuyển qua các Menu đã giới thiệu ở 
trên. Bạn sẽ cảm thấy màn hình hơi bị ―chật chội‖ bởi việc bố trí hệ thống Menu. 
Các thao tác về tập tin (giống nhƣ trong Menu File trong Excel 2003) thì các bạn phải Click vào 

biểu tƣợng Microsoft Office  ở góc trên cùng bên trái. 
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3. Việc trợ giúp khi lập công thức: 
Hẳn các bạn sẽ rất hài lòng với việc trợ giúp khi các bạn gõ công thức. 

Bạn chỉ việc gõ vào một ô ―=v‖ thì lập tức các công thức sẽ đƣợc liệt kê nhƣ hình dƣới đây: 
 

 
 
4. Sự khác biệt khi bạn Click phải chuột: 
 

Xem hình minh họa là các bạn hiểu ngay. 
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5. Conditional Formatting: 

 

 
 
Các bạn có thể định dạng theo 64 điều kiện. Trong khi Excel 2003 chỉ có tối đa 3 điều kiện. 
Excel 2007 cung cấp các điều kiện các kiểu định dạng mới sau (chú ý rằng các định dạng này sẽ 

không có trong Excel 2003) 
Color Scales: màu các bạn có thể cho chuyển từ đậm đến nhạt hơn. 
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Data bars: các giá trị ô cao hơn sẽ  đƣợc định dạng bởi các màu dài hơn. 

 
Icon sets: định dạng bởi các biểu tƣợng. 

 
Top or Bottom ranked values: chỉ những giá trị ở trong những vị trí trên cao hay dƣới sẽ đƣợc 
định dạng thì tùy theo bạn xác định. 

 
Above or below average values. 

Unique or duplicate values. 
Table column comparision to determine which cells to format. 
 

6. Lọc dữ liệu: 
 
Với phiên bản này các bạn có thể lọc theo giá trị của ô, theo màu tô nền, theo màu font, the Icon. 

 

 
 
7. Việc nhập dữ liệu từ bên ngoài: 
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Chúng ta thử vào Menu Data và From Access để nhập một bảng từ Access vào. Sau khi thực hiện 
một số thao tác đơn giản bạn sẽ mở ra đƣợc một bản nhƣ hình trên. 

Bạn có thể dùng Refresh để cập nhật lại bảng dữ liệu này khi có sự thay đổi. Bạn có thể thực hiện 
các lệnh trên Menu. Ví dụ nhƣ lệnh Remove Duplicates, xóa đi các dữ liệu trùng. Bạn có thể định 
nghĩa các dữ liệu trùng này. Trong hình trên  các bạn để ý thấy Menu Table Tools xuất hiện 

không? Nó sẽ xuất hiện một khi thao tác các bạn cần. 
 

 
 
8. Lưu Workbook: 

 
Khi lƣu một Workbook các bạn có thể lƣu dƣới các dạng nhƣ sau: 
Excel Workbook khi lƣu dƣới dạng này các code của bạn trong VBE sẽ bị mất. 

Excel Macro Enabled Workbook: lƣu dƣới dạng này sẽ cho phép bạn sử dụng các đoạn code lƣu 
trong VBE của Workbook. 
Excel Binary Workbook 

Excel 97-2003 Workbook 

 
Việc cập nhật thủ công văn bản Word dễ nhầm lẫn và tốn công khi có nhiều số liệu. Có một cách 

giúp liên kết tự động dữ liệu từ Excel với văn bản Word để bạn chỉ cần làm công việc mở văn bản 
Word để cập nhật kết quả tính từ Exel một lần, sau đó mỗi khi bạn thực hiện công việc nhập số 
liệu vào bảng Exel để tính xong thì Word tự động cập nhật những thay đổi và bạn chỉ việc in báo 

cáo ra mà không phải thực hiện công việc một lần nữa.  
Khi làm báo cáo bằng Word có sử dụng số liệu từ bảng tính Excel, thƣờng ngƣời ta thực hiện 2 
công việc: 

- Công việc A: Nhập số liệu vào bảng Excel để tính. 
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- Công việc B: Mở văn bản Word để cập nhật kết quả tính toán từ Excel (lời văn của báo cáo nói 
chung không thay đổi là mấy). 

Việc cập nhật thủ công văn bản Word dễ nhầm lẫn và tốn công khi có nhiều 
số liệu. Có một cách giúp liên kết tự động dữ liệu từ Excel với văn bản Word 

để bạn chỉ cần làm công việc B một lần, sau đó mỗi khi bạn thực hiện công việc A xong thì Word 

tự động cập nhật những thay đổi và bạn chỉ việc in báo cáo ra mà không phải thực hiện công việc 
B nữa. 
Ví dụ, chúng ta xem xét báo cáo vận chuyển hành khách của 4 hãng xe HTX, TNHH, QD và CT. 

Báo cáo mỗi tháng bạn cần đƣa vào số liệu của tháng hiện tại và tháng trƣớc đó để so sánh sự 
tăng giảm. Hiện tại ta cần làm phân tích số liệu tháng 08/2005. 

 
Bước 1 (công việc A): Ở H.1 ta đã có sẵn bảng tính Excel với số liệu của kỳ trƣớc (tháng 
07/2005) với các công thức để tính tổng số hành khách, tỉ lệ hành khách tăng giảm so với tháng 

trƣớc… ta chỉ cần nhập vào các số liệu của tháng cần báo cáo, Excel sẽ tự động tính ra các số còn 
lại. Sau khi nhập xong ta đƣợc bảng tính với các số liệu của kỳ hiện tại  
 

(tháng 08/2005) nhƣ H.2. 
Bước 2: Ở H.3 là phân tích số liệu có đƣợc trong H.1. Điều cần làm là phải  
 

sửa số liệu của kỳ trƣớc thành số liệu của kỳ này trong bảng phân tích đó 
(tức là sửa từ H.3 thành H.4). Bây giờ chúng ta sẽ liên kết dữ liệu từ Excel 
sang Word để các kỳ về sau chỉ cần sửa trong Excel rồi ra lệnh cho Word tự 

động cập nhật dữ liệu từ Excel sang. 
Đầu tiên bạn vào bảng tính Excel, copy ô số liệu cần là ô C2 ở H.2 (ô đƣợc tô 
đỏ ở H.2) rồi vào Word đặt con trỏ vào chỗ cần sửa dữ liệu thích hợp (ngay trƣớc con số 272.601 

ở H.3). Xóa giá trị 272.601 ở H.3 đi rồi nhấn vào menu Edit > Paste special, bảng Paste 
special xuất hiện. Bạn chọn Paste link > Unformated Text rồi OK (các thao tác này tạm gọi là 
Paste link), phần mới đƣợc paste vào có giá trị là 273.780 nhƣ trong H.4 nhƣng phần nền của số 

273.780 này có màu xám. Thực hiện giống nhƣ vậy ở những số liệu khác cần sửa đổi. (Chú ý khi 
copy từ Excel phải copy nguyên cả ô chứ không phải chỉ tô đen phần số rồi copy). 

Chú ý, nếu vùng đƣợc Paste link không có màu xám, bạn làm nhƣ sau: vào 
menu Tools > Options, chọn tab View, phần Field shadding chọn Always 

rồi OK. 

Riêng đối với những số liệu có thể có giá trị âm hoặc dƣơng và giá trị này ảnh hƣởng đến phần lời 
văn trong văn bản Word cần làm phức tạp hơn một chút. Nhƣ phần giảm 44,44% ở H.3: tháng 
trƣớc giảm 44,44% vì giá trị trong Excel tƣơng ứng là -44,44 (ở H.1). Tháng này giá trị trong 

bảng tính Excel là 16,39 (ở H.2), ta phải hiển thị lời văn là tăng 16,39% trong Word. Cách làm 
nhƣ sau: đầu tiên bạn mở bảng tính Excel (H.2), đối với những cột nào thể hiện sự tăng giảm (ở 
ví dụ này là cột D và cột E) ta phải tạo thêm 2 cột phụ dùng để thể hiện lời văn cho mỗi cột. Ta 

làm cho cột D nhƣ sau (cột E làm tƣơng tự): 
- Chèn thêm 2 cột F và G để bổ sung cho cột D nhƣ H.5. Trong đó cột F thể 
hiện dấu của cột D và cột G thể hiện giá trị tuyệt đối của cột D. 

- Nhập vào ô F2 công thức: 
=IF(D2=0;‖không tăng giảm‖;IF(D2>0;‖tăng ―;‖giảm ―))  
 

Hàm này xét giá trị của ô D2, nếu =0 thì hiển thị ―không tăng giảm‖, nếu >0 thì hiển thị ―tăng ―, 
nếu <0 thì hiển thị ―giảm ―. 

Copy công thức trên cho các ô F3, F4, F5, F6. 
- Nhập vào ô G2 công thức: 
=IF(D2<>0;ABS(D2);‖")  

 
Hàm này lấy giá trị tuyệt đối của ô D2. 

 

Hình 2: Excel, số 

liệu kỳ hiện tại 
dùng cho các báo c 
áo tháng 08/2005 
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Copy công thức trên cho các ô G3, G4, G5, G6. Bạn sẽ đƣợc các chi tiết giống với H.5. 
Bây giờ bạn trở lại Word ở H.3: 

- Xóa chữ ―giảm‖, qua Excel copy ô F5 ở H.5 rồi Paste link vào Word. 
- Xóa ―44,44″, qua Excel copy ô G5 ở H.5 rồi Paste link vào Word. 

Thực hiện tƣơng tự cho các phần khác cần sửa đổi. 

Nếu thực hiện chính xác bạn sẽ có đƣợc bản báo cáo của tháng 08/2005 nhƣ H.4. 
Kể từ tháng sau, bạn chỉ cần nhập số liệu trong bảng tính Excel xong, mở văn bản Word lên, nhấn 
menu Edit > Select All rồi lại nhấn menu Edit > Links > Update Now, lập tức dữ liệu đƣợc 

cập nhật từ Excel vào Word. 
Chú ý, để Word không tự động cập nhật dữ liệu khi mở file: vào menu Tools > Options > 
General, bỏ chọn ở mục ―Update automatic links at Open―. Nếu không, mỗi khi bạn mở file 
Word nào có dữ liệu dạng liên kết thì Word sẽ luôn hỏi có cập nhật dữ liệu hay không rất phiền 
phức. 

 
Định dạng bảng tính trong Excel 2007 
Có thể nói điều khác biệt đáng kể nhất của Excel 2007 so với các phiên bản trƣớc của nó là sự 

phong phú và tiện lợi trong việc định dạng bảng tính. Không chỉ là những định dạng mang tính 
mỹ thuật còn có rất nhiều kiểu định dạng mang tính thống kê, sàng lọc dữ liệu giúp cho nhà quản 
lý nhanh chóng nắm bắt đƣợc ý nghĩa của những con số. 

Excel 2007 là một chƣơng trình trong bộ Microsoft Office 2007, đƣợc cải tiến về giao diện lẫn các 
chức năng sử dụng so với phiên bản trƣớc. Đến với Excel 2007, bạn sẽ không ngạc nhiên lắm với 
các nút công cụ, bởi chúng khá giống các phiên bản Excel trƣớc, nhƣng có một số chức năng mới 

rất hay đƣợc bổ sung trong Excel 2007, nổi bật là chức năng định dạng bảng. 
  
Chức năng định dạng bảng của Excel 2007 đƣợc đặt ngay trong thẻ công cụ đầu tiên rất dễ nhận 

thấy là thẻ Home. Để bắt đầu sử dụng nhóm công cụ này, bạn chú ý đến nhóm Styles trong thẻ 
Home của Excel. Nhóm công cụ này gói gọn trong 3 công cụ định dạng chính. Theo tôi, để có một 
bảng tính đƣợc trình bày đẹp và dễ nhìn, có thể tính toán tự động, lại thực hiện nhanh chóng, bạn 

nên sử dụng các công cụ theo các bƣớc sau: 
  

1. Định dạng một bảng đang xử lý 
  
Khi sử dụng Excel, trong một sheet, bạn có thể đặt nhiều bảng (table), và có thể trang trí bảng 

này để chúng trở nên đẹp hơn và dễ phân biệt với các bảng khác. Lƣu ý là kiểu ―bảng‖ này hoàn 
toàn khác với một ―vùng‖ (range) mà chúng ta quen dùng trong Excel, bởi chỉ có bảng mới hỗ trợ 
việc định dạng và tính toán tự động, còn với range bạn phải thực hiện thủ công tất cả.  

  
Bạn thực hiện tạo bảng nhƣ sau: quét vùng cần định dạng thành bảng, trong thẻ Home, bấm nút 
công cụ Format as Table, một menu chứa rất nhiều kiểu table đƣợc thiết kế sẵn rất bắt mắt sẽ 

hiện ra để bạn chọn, bạn cũng có thể tạo kiểu định dạng khác cho riêng mình bằng cách bấm nút 
New Table Style ở cuối menu. Sau khi chọn một kiểu ƣng ý, hộp thoại Format As Table xuất hiện, 
bạn bấm OK để đồng ý với vùng tham chiếu đã chọn. 

  
Lúc này, bạn để ý trên các thẻ công cụ sẽ xuất hiện thẻ Design của công cụ Table Tools. Bạn có 
thể vào thẻ này để tinh chỉnh thêm cho bảng của mình. Tuy nhiên, chú ý nhóm Table Style 
Options trong thẻ này, bạn có thể đánh dấu chọn thêm: 
  

- First/Last Column: làm nổi bật cột đầu tiên hay cuối cùng của bảng. 
- Banded Columns/Rows: làm phân biệt giữa hai cột hoặc hai dòng liên tiếp bằng hai màu 
tƣơng phản. 
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 Total Row: đây là nút chọn đáng chú ý nhất, bởi khi chọn mục này, ở cuối bảng của bạn sẽ xuất 
hiện một dòng thống kê có thể giúp thực hiện tự động một số thao tác tính toán rất nhanh chóng 

mà không cần nhập hàm thủ công. 
  
Trong thẻ Design, bạn cũng lƣu ý thêm bảng Table Styles cho phép chọn lại kiểu dạng của bảng 

tính, nút Convert to Range trong bảng Tools cho phép bạn chuyển đổi cả bảng tính về dạng vùng 
tính thông thƣờng của Excel truyền thống. Khi bấm nút này, bạn không thể chỉnh sửa nhanh 
chóng kiểu của bảng tính mà phải làm lại từ đầu nếu muốn thay đổi, và không thể sử dụng chức 

năng Total Row (tính tự động) đƣợc. 
  

Một số thao tác nhập liệu, tinh chỉnh và tính toán tự động trên bảng: 
  
- Tăng kích thước bảng: ở góc cuối của bảng có nút tam giác màu đen nhỏ, bạn bấm nút này 

để kéo rộng bảng. 
- Sửa tiêu đề: mặc định là Column1/2/3..., bạn nên sửa lại cho phù hợp với nội dung bảng tính 
của bạn. 

  
- Sắp xếp: 
bạn để ý trên tiêu đề của mỗi cột trong bảng có một nút tam giác 

cho phép thực hiện sắp xếp lại dữ liệu một cách nhanh chóng. Bạn 
bấm nút tam giác đó, có thể chọn Sort A to Z hoặc Sort Z to A (đối 
với chữ), Sort Smallest to Largest hoặc Sort Largest to Smallest 
(đối với số).  
  
- Thống kê: nếu chọn Total Row nhƣ đã nói ở trên, thì ô đầu tiên 

của dòng cuối sẽ xuất hiện tiêu đề ―Total‖, bạn có thể tùy ý sửa lại 
tiêu đề này. Ở những ô kế trong dòng cuối của bảng sẽ xuất hiện 
nút hình tam giác khi bạn bấm chuột vào. 

  
Bấm nút này, sẽ xuất hiện một menu các lệnh thông dụng nhƣ 

Sum, Average, Count, Count Numbers, Min, Max, Var... hoặc bạn có thể thêm hàm nâng cao bằng 
cách chọn More Functions. Với cách này, bạn có thể thống kê nhanh số liệu bằng các hàm của 
Excel mà không cần nhập công thức, lại có thể thay đổi nhanh chóng hàm tính chỉ bằng một cú 

bấm chuột. 
  
2. Định dạng một ô: 

  
Chức năng này không quan trọng lắm, bạn chỉ cần bấm nút Cell Styles trong thẻ Home, chọn một 
kiểu định dạng cho ô. Bạn chỉ nên sử dụng chức năng này khi muốn đánh dấu một ô chứa số liệu 

quan trọng nào đó trong bảng tính. 
  
3. Định dạng dữ liệu có điều kiện: 

  
Đây là chức năng rất hay trong Excel 2007. Nếu bạn có một bảng với nhiều số liệu khác nhau, 
thông thƣờng để đánh giá dữ liệu, chúng ta thƣờng dùng các hàm rút trích và lọc dữ liệu. Tuy 

nhiên, với chức năng này, bạn không cần dùng hàm, càng không cần lấy dữ liệu ra khỏi bảng mà 
vẫn có thể đánh giá chính xác dữ liệu qua cách làm nổi bật các ô theo một điều kiện định sẵn. 

Thực hiện nhƣ sau: quét chọn một cột hoặc dòng dữ liệu cần đánh giá, sau đó bấm nút 
Conditional Formatting, một menu hiện ra với các tùy chọn: 
  

Kiểu đánh giá sàng lọc: 
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Kiểu đánh giá này sẽ sàng lọc dữ liệu của bạn ngay tại trong bảng chứ không phải trích riêng ra 
ngoài nhƣ các phiên bản Excel trƣớc đây. Chƣơng trình thực hiện ―sàng lọc tại chỗ‖ bằng cách làm 

nổi bật lên những ô đúng với điều kiện hoặc quy luật do bạn quy định. Sau đây là hai nhóm quy 
luật chính: 
  

- Highlight Cells Rules: làm nổi bật các ô theo một trong các điều kiện: Greater Than... (lớn 
hơn), Less Than... (nhỏ hơn), Equal To (bằng) một giá trị so sánh nào đó, Between (giữa 2 giá 
trị), Text that Contains (ô chữ có chứa chuỗi ký tự quy định), A Date Occurring (theo quãng thời 

gian), Duplicate Values (ô dữ liệu trùng nhau).  
  

Khi bạn chọn xong một điều kiện làm nổi bật, sẽ xuất hiện một hộp thoại yêu cầu bạn nhập giá trị 
cần so sánh và màu tô nổi bật cho ô phù hợp với điều kiện so sánh đó. Xong, bạn bấm OK để 
chƣơng trình thực thi trong bảng tính. 

  
- Top/Bottom Rules: quy luật này gồm các điều kiện: Top 10 Items (đánh dấu 10 ô có giá trị 
lớn nhất), Top 10% (đánh dấu 10% số ô có giá trị lớn nhất), tƣơng tự với Bottom 10 Items 
và Bottom 10%, Above Average (ô có giá trị lớn hơn giá trị trung bình của cột/hàng), Below 
Average (ô có giá trị nhỏ hơn giá trị trung bình của cột/hàng). Khi bạn chọn đánh giá theo 
dữ liệu hàng Top hoặc Bottom, một hộp thoại yêu cầu bạn nhập số ô cần làm nổi, chẳng hạn nhƣ 

Top 10 hay 20, Top 10% hay 20%... là tùy bạn tinh chỉnh, sau đó bấm OK để hoàn tất. 
  
Kiểu đánh giá hiển thị mức độ: 

  
- Data Bars: bạn bấm chọn kiểu đánh giá này, chọn một màu ƣng ý trong menu hiện ra. Khi đó, 
trong vùng dữ liệu của bạn sẽ xuất hiện cột màu đánh giá mức độ dữ liệu giúp bạn dễ dàng so 

sánh cũng nhƣ nhận ra sự tăng giảm của số liệu nhập vào. Cột màu càng dài thì số liệu của bạn 
càng có giá trị cao, ngƣợc lại là những ô giá trị thấp. 
  

- Color Scales: kiểu đánh giá này sẽ tô màu cho các ô dữ liệu theo 3 màu khác nhau, ứng với 
mỗi màu là mức độ thấp, trung bình và mức độ cao. Khi chọn nhóm Color Scales, bạn hãy chọn 

một nhóm màu bạn thích trong menu hiện ra và sẽ thấy 
chƣơng trình áp dụng lên vùng chọn của bạn. Bạn cũng có thể 
tạo quy luật màu theo ý mình bằng cách chọn Color Scales > 
More Rules. 
  
- Icon Sets: bấm chọn Icon Sets, chọn một nhóm biểu tƣợng 

mong muốn, chƣơng trình sẽ tự động đặt các biểu tƣợng trƣớc 
ô dữ liệu của bạn, giúp bạn có cái nhìn trực quan về bảng tính.  
Ví dụ dấu  biểu thị số liệu ở mức độ cao nhất, dấu  biểu thị số 

liệu ở mức trung bình, và dấu  biểu thị số liệu thấp dƣới cả mức trung bình, đáng báo động. Mỗi 
biểu tƣợng ứng với một mức độ, chƣơng trình sẽ tự động tính toán giá trị trung bình của toàn cột 
hoặc dòng đang so sánh và tiến hành đặt biểu tƣợng thích hợp vào từng ô theo giá trị phần trăm 

mà ô đó đạt đƣợc so với mức độ chung của cả cột hoặc dòng.  
  
Bạn có thể định lại quy luật đánh giá này bằng cách chọn More Rules trong nhóm Icon Sets. 
Ngoài những kiểu định dạng có điều kiện trên, bạn có thể tạo riêng cho mình những quy luật 
đánh giá khác bằng cách bấm nút Conditional Formatting > New Rule, tuy nhiên việc này rất mất 

thời gian. Tốt nhất bạn nên sử dụng những quy luật có sẵn mà Excel đã cung cấp rất đầy đủ cho 
bạn. Khi bạn không vừa ý với các định dạng đã chọn, để xóa chúng mà không mất dữ liệu, bạn 
bấm Conditional Formatting > Clear Rules, chọn một trong các kiểu xóa nhƣ Clear Rules from: 

Selected Cells (chỉ xóa trong cột chọn), Entire Sheet (xóa trong cả sheet), This Table (chỉ xóa 
trong bảng đang xử lý). 
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Có thể nói nhóm công cụ định dạng này của Excel 2007 rất thú vị, nó cho phép chúng ta tạo ra 

những bảng tính đƣợc trình bày rất khoa học và bắt mắt. Đặc biệt nhất là tính tự động cao, giao 
diện bảng tính đẹp và khả năng đánh giá, sàng lọc dữ liệu chuẩn xác và độc đáo. Chắc chắn khi 
sử dụng chức năng này, bạn sẽ thấy hứng thú hơn rất nhiều khi xử lý dữ liệu và tính toán trong 

Excel. 
  
Theo LBVMT 

 

10 cách khôi phục tập tin Excel bị lỗi 
 
TTO - Các tập tin bảng tính Excel, cũng nhƣ Word, một khi bị lỗi sẽ gây ra hàng loạt rắc rối cho 
ngƣời dùng văn phòng.  

Bạn có thể tham khảo 10 cách khôi phục tập tin bảng tính dƣới đây trƣớc khi tính tới chuyện... 
ngồi khóc hay làm lại từ đầu. 

 

 

Excel - ứng dụng xử lý bảng tính không thể thiếu trong các 
công sở 

1. Thử khôi phục bằng phương án thủ công 

 
Nếu tính năng tự động khôi phục lỗi của Excel tậm tịt, bạn có thể thực hiện công việc này bằng 
tay: 

1. Mở tập tin từ menu File. Đối với Excel 2007, hãy click vào nút Office và chọn Open. 
2. Sử dụng bảng điều khiển Look In, tìm và xác định workbook bị lỗi. 
3. Từ danh sách sổ xuống của nút Open, chọn Open And Repair. 

4. Nếu đây là nỗ lực đầu tiên cố gắng khôi phục workbook, bạn hãy click vào Repair. 
Nếu may mắn, Excel sẽ sửa chữa tập tin. Tuy nhiên, tính năng khôi phục tập tin không phải lúc 
nào cũng hiệu quả. Lúc này, bạn hãy chọn giải pháp thứ hai là khôi phục dữ liệu. Hãy nhấp vào 

Extract Data ở bƣớc 4. 
 
2. Nếu lỗi xảy ra khi tập tin bảng tính đang mở 
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Khi có lỗi xảy ra mà tập tin workbook vẫn đang mở, bạn nhất thiết không đƣợc lƣu lại phiên làm 
việc hiện tại. Thay vào đó, bạn hãy trở ngƣợc lại phiên bản lƣu trữ trƣớc đó. Bằng cách này, bạn 

sẽ tránh đƣợc lỗi xảy ra vừa rồi mà không mất dữ liệu, cho dù khả năng này là rất nhỏ. 
Để trở lại phiên làm việc lần trƣớc đã lƣu lại, bạn hãy thực hiện theo các bƣớc sau: 

1. Chọn Open từ menu File menu. Đối với Excel 2007, click vào nút Office và chọn Open. 

2. Sử dụng bảng điều khiển Look In để xác định tập tin bị lỗi. 
3. Click vào Open. 
Lúc này bạn sẽ mở lại workbook nhƣ cũ. 

 
3. Tắt chế độ tính toán tự động 

Nếu Excel không thể mở đƣợc tập tin bảng tính, hay kể cả lựa chọn Open And Repair cũng bó 
tay, bạn hãy đặt lại chế độ tính toán sang phƣơng án xử lý thủ công và thử lại. Các bƣớc thực 
hiện: 

1. Mở một tập tin bảng tính mới với nội dung rỗng. 
2. Từ menu Tools chọn Options và click vào tab Calculation. Trên Excel 2007, bạn hãy click vào 
nút Office, tiếp đến là Excel Options và chọn Formulas trên bảng điều khiển ở phía trái. 

3. Trong phần cài đặt thông số cho Calculation (Calculation Options trên Excel 2007), chọn 
Manual. 
4. Click vào OK. 

 
Lúc này, bạn hãy mở lại tập tin bị lỗi. Có thể Excel sẽ ―bắt lỗi‖ và mở đƣợc tập tin trục trặc. 
 

4. Sử dụng công cụ Microsoft Office Tools 
 

 

Microsoft Office Tools - một trong những tiện ích hữu dụng ít 
ngƣời dùng biết tới có trên bộ Office 

Nếu Excel không thể mở đƣợc tập tin workbook lỗi, bạn hãy dành cơ hội cho Microsoft Office 

Tools: 
1. Từ menu Start, chọn All Programs (trên Windows XP). 
2. Chọn Microsoft Office. 

3. Chọn Microsoft Office Tools. 
4. Chọn Microsoft Office Application Recovery. 

5. Chọn Microsoft Office Excel ở hộp thoại. 
6. Nhấp vào Recover Application. Quá trình xử lý có thể mất một vài phút. 
Công cụ khôi phục này sẽ tắt Excel và sau đó khởi động lại, hiển thị danh sách các tập tin bảng 

tính đã khôi phục đƣợc. Nếu may mắn, tập tin Excel quý giá của bạn sẽ nằm trong danh sách này. 
Chỉ cần mở ra và tiếp tục sử dụng! 
 

5. Thử chuyển tập tin sang nơi khác 
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Đôi khi một tập tin bảng tính bị lỗi không hẳn do những nguyên nhân từ phần mềm hay sai lầm 
khi sử dụng của ngƣời dùng. Rất có thể nó đang tạm không truy cập đƣợc nữa, các hệ thống 

mạng và máy chủ thƣờng vẫn đánh dấu chúng là những tập tin lỗi. Trong trƣờng hợp gặp phải lỗi 
đƣợc xác định có nguyên nhân tƣơng tự và Excel không thể sửa đƣợc, bạn hãy chuyển tập tin 
sang một thƣ mục, ổ đĩa hoặc máy chủ khác. 

 
6. Hãy để OpenOffice “ra tay” 
 

Một số ngƣời khẳng định cảm thấy hoàn toàn bất ngờ với kết quả mỹ mãn khi sử dụng bộ ứng 
dụng OpenOffice để sửa chữa tập tin lỗi của Excel. Đây là công cụ mã nguồn mở miễn phí lừng 

danh. Nếu không thể xử lý đƣợc tập tin bảng tính bị lỗi trên Excel, hãy dùng tới Calc của 
OpenOffice. Tất nhiên, việc này thƣờng kỳ công và phức tạp hơn bạn tƣởng. 
 

7. Mở tập tin lỗi trên WordPad hoặc Word 
 
Nếu bạn không thể sửa đƣợc tập tin bảng tính bị lỗi, hãy thử mở bằng WordPad. Nếu thành công, 

WordPad sẽ chuyển đổi tất cả mọi thứ sang dạng văn bản. Tất nhiên, điều này không hẳn đã làm 
bạn hoàn toàn hài lòng ngoài niềm vui có thể lấy lại đƣợc dữ liệu. Phƣơng án này sẽ không thể 
khôi phục đƣợc các định dạng font, bảng... Tuy nhiên, không giống nhƣ một số phƣơng án khôi 

phục dữ liệu khác, WordPad sẽ giúp bạn phục hồi các macro. Hãy sử dụng lệnh tìm kiếm Sub và 
Function trên khối dữ liệu đã khôi phục đƣợc để tìm chúng. 
Bạn cũng có thể mở tập tin .xls bị lỗi trên Word, nhƣng kết quả thƣờng khá giới hạn. Với phƣơng 

án này, bạn phải cài đặt công cụ chuyển đổi Microsoft Office Excel. Không nhƣ WordPad, Word 
không khôi phục đƣợc các macro. 
 

8. Xử lý các cell bị lỗi để khôi phục dữ liệu 
 
Đôi khi bạn có thể khôi phục dữ liệu bằng cách xử lý các cell trên tập tin lỗi. Bạn sẽ không thể lấy 

lại đƣợc định dạng, biểu đồ, macro... nhƣng khôi phục đƣợc dữ liệu cũng đã là quá may rồi. Quy 
trình thực hiện nhƣ sau: 

1. Mở một workbook mới, nhập vào cell A1 công thức sau đây để dẫn tới cell A1 trong tập tin lỗi: 
tên của tập tin lỗi!A1. (Bạn không cần phải thêm .xls). 
2. Nhấp Enter. 

3. Nếu tập tin lỗi không ở cùng thƣ mục, Excel sẽ hiển thị hộp thoại Update Values: tên của tập 
tin bị lỗi. Bạn hãy sử dụng bảng điều khiển Look In để xác định tập tin bị lỗi. Chọn tập tin này và 
click OK. 

4. Nếu hộp thoại Select Sheet xuất hiện, bạn hãy chọn sheet phù hợp và click OK. Excel sẽ hiển 
thị giá trị cell A1 của tập tin lỗi. 
5. Chọn cell A1 và kéo ngang qua các cột mà bạn cảm thấy cần để có thể khôi phục dữ liệu. Nếu 

Excel hiển thị hộp thoại Update Values - tên tập tin bị lỗi, bạn hãy chọn tập tin lỗi và click OK. 
6. Lặp lại bƣớc 5, nhân bản hàng A theo số lƣợng hàng bạn cảm thấy đủ để khôi phục tập tin lỗi. 
7. Chọn dữ liệu và nhấp Copy từ menu Edit. 

8. Chọn Paste Special từ menu Edit, chọn Values. 
9. Click OK. 
 

9. Thử định dạng SYLK để khôi phục dữ liệu 
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Chuyển sang định dạng khác là phƣơng án xử lý khá hiệu quả 
khi Excel bị lỗi 

Microsoft khuyến cáo sử đụng định dạng SYLK để tránh khỏi bị lỗi khi dùng Excel, nhất là các lỗi 

liên quan đến máy in. Bạn có thể mở tập tin Excel bị lỗi bằng cách này: 
1. Từ menu File, chọn Save As. Trên Excel 2007, click vào nút Office. 
2. Từ bảng điều khiển Save As Type, chọn SYLK(Symbolic Link) (*.slk). 

3. Đặt tên. Nếu tập tin lỗi có một sheet, việc này là không cần thiết. 
4. Click vào Save. 
5. Nếu tập tin workbook có nhiều sheet, Excel sẽ hỏi bạn có tiếp tục sử dụng định dạng không hỗ 

trợ nhiều sheet cùng lúc hay không. Click vào OK. 
6. Nếu Excel cảnh báo bạn có thể workbook gồm một số định dạng không tƣơng thích với SYLK, 
bạn hãy chọn Yes. 

Lƣu ý là định dạng SYLK chỉ lƣu lại những sheet đang sử dụng. Để khôi phục dữ liệu, bạn cần mở 
lại tập tin Excel và lƣu lại từng sheet một. Đó là lý do vì sao ở bƣớc 3 bạn cần đặt tên cho từng 

sheet trên workbook để tránh nhầm lẫn sau này.  
Sau khi đã lƣu lại tất cả các sheet theo dạng mới, bạn hãy mở tập tin .slk và sửa thành .xls. Cẩn 
thận, không sử dụng tên của tập tin workbook bị lỗi. Nếu thành công, bạn có thể lƣu lại đƣợc các 

giá trị từ công thức đã nhập nhƣng các công thức thì không. 
 
10. Khôi phục các macro 

 
Nếu có thể khôi phục dữ liệu nhƣng vẫn bó tay trƣớc các macro, bạn có thể lƣu lại đƣợc chúng 
theo cách sau đây: 

1. Mở Excel, đừng mở những workbook lỗi. 
2. Đặt chế độ tính toán sang dạng thủ công (thủ thuật 3 ở trên). 
3. Chọn Macro từ menu Tools, chọn Security và sau đó chọn High. Trên Excel 2007, hãy nhấp vào 

nút Office --> Excel Options, và chọn Trust Center phía trái bảng. Sau đó, click vào nút Trust 
Center Settings, chọn Macro Settings, sau đó chọn Disable All Macros Without Notification 
trên vùng cài đặt Macro Settings. Cuối cùng nhấp OK hai lần. 

4. Mở tập tin bị lỗi. Nếu Excel mở đƣợc, bạn sẽ thấy một thông báo cho biết hiện macro đang 
đƣợc tắt. Nếu Excel tắt đi, phƣơng pháp này coi nhƣ thất bại. 
5. Nhấp tổ hợp [Alt]+[F11] để mở Visual Basic Editor (VBE). 

6. Sử dụng Project Explorer (nhấp [Ctrl]+R), click chuột phải vào module và chọn Export File) 
7. Nhập tên và thƣ mục của module. 

8. Lặp lại bƣớc 6 và 7 theo ƣớc chừng của bạn, đủ để trích xuất tất cả các module. 
9. Đóng VBE và thoát Excel. 
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10. Mở một workbook trống (hoặc workbook mới chứa dữ liệu mới khôi phục đƣợc) và nhập các 
module. 

 
NHẬT VƢƠNG (Theo Techrepublic) 
 

25 người có ảnh hưởng lớn nhất thế giới ảo năm 2008 
 
Posted on October 19, 2008 by 123zo  
 

Tạp chí uy tín BusinessWeek vừa công bố danh sách 25 người có ảnh hưởng lớn 
nhất thế giới ảo năm 2008. Đây là những nhân vật được xem là có ảnh hưởng lớn 
nhất đối với sự tiến bộ của thế giới web trong năm nay. 

 
1. “Kẻ mở đường” Steve Ballmer (Microsoft.com) 
Steve Ballmer có một công việc không giống ai. Đó là tìm ra đƣợc con đƣờng đƣa Microsoft trở 

thành một tên tuổi trên thế giới mạng Internet mà không làm phƣơng hại đến vị thế thống trị của 
hãng trong lĩnh vực phần mềm dành cho PC để bàn. Bên cạnh đó, ông phải khôi phục lại lòng tin 
của khách hàng vào hệ điều hành Windows vốn đã bị Vista ―vét cạn‖ và dẫn dắt cả công ty trở lại 

đúng con đƣờng cần đi sau ―thất bại cay đắng‖ trong việc ―đuổi bắt‖ Yahoo. 
Hiện doanh thu bình quân mỗi tháng của Microsoft khoảng 1,8 tỉ USD. Song Microsoft có vẻ nhƣ 
đang yếu thế hơn Google về mặt chiến lƣợc kinh doanh, nhất là trong tình hình phần mềm cho PC 

để bàn đang có xu hƣớng chuyển dịch mạnh mẽ lên web. Bộ phận kinh doanh dịch vụ quảng cáo 
của công ty này liên tục thua lỗ. Dịch vụ tìm kiếm chỉ chiếm đƣợc 8,3% tổng yêu cầu tìm kiếm 
của riêng thị trƣờng Mỹ trong tháng tám vừa qua. Theo đuổi Yahoo cũng chỉ vì Microsoft muốn bù 

đắp những điểm yếu này. Nhƣng đáng tiếc chuyện này đã không thành. Và Ballmer giờ đây phải 
tự mình tìm hƣớng đi riêng mà không có sự trợ giúp của vị chủ tịch danh tiếng Bill Gates – ngƣời 
đã chính thức về hƣu hồi tháng sáu vừa qua. 

 

Thông tin cá nhân: Steven Anthony Ballmer (sinh ngày 24/3/1956 tại Detroit, Michigan) là một 

doanh nhân ngƣời Mỹ và là Giám đốc điều hành của Tập đoàn Microsoft từ tháng 1/2000. Ballmer 
là ngƣời đầu tiên trở thành tỷ phú (đô la) theo giá trị cổ phiếu thu đƣợc với vai trò là nhân viên 

của một tập đoàn mà ông không phải là ngƣời sáng lập hay có quan hệ họ hàng của ngƣời sáng 
lập. Trong Bảng xếp hạng những ngƣời giàu nhất thế giới năm 2007 của Tạp chí Forbes, Steve 
Ballmer đƣợc xếp là ngƣời giàu thứ 31 trên thế giới, với tài sản ƣớc tính trị giá 15 tỉ USD. 

2. “Thống soái” Mitchell Baker (Mozilla.org) 
Bốn năm trƣớc đây khi khai sinh ra Firefox, Mitchell Baker – ngƣời đƣợc biết đến nhiều nhất bằng 
cái tên ―Lizard Wrangler‖ trong nội bộ Mozilla Foundation – đã coi trình duyệt mã nguồn mở này là 

con bài chiến lƣợc để hạ gục Internet Explorer (IE). Tôn chỉ mà bà Baker theo đuổi là hƣớng tới 
một thế giới web mở. 
Cho đến nay tổng thị phần của Firefox trên thị trƣờng trình duyệt toàn cầu đã lên tới con số gần 

20%. Còn Internet Explorer từ chỗ chiếm tới 95% thị phần đến nay chỉ còn trong tay khoảng gần 
72%. Và mọi website đều chấp nhận cả hai loại trình duyệt, không hề có bất kỳ sự phân biệt đối 
xử nào. Nhƣng nay Firefox lại đang phải đối mặt với một thách thức mới. Đó là trình duyệt 

Chrome của ―gã khổng lồ tìm kiếm‖ Google chính thức ra mắt công chúng ngày 01/9 vừa qua. Bà 
Baker tuyên bố ―thách thức mới sẽ là động lực buộc Mozilla phải nỗ lực hết sức mình‖. Không 
những thế Mozilla còn đang muốn xâm nhập sang thị trƣờng trình duyệt di động. 
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Thông tin cá nhân: Winifred Mitchell Baker, thƣờng đƣợc biết đến với cái tên Mitchell Baker, là 

chủ tịch của tập đoàn Mozilla Foundation đồng thời là chủ tịch và cựu tổng giám đốc điều hành 
của Mozilla Corporation, một công ty con thuộc Mozilla Foundation. Tập đoàn này tập trung phát 

triển mã nguồn mở những ứng dụng Mozilla trên Internet bao gồm trình duyệt web Mozilla Firefox 
và hệ thống email Mozilla Thunderbird. Năm 2005, tạp chí Time bầu chọn bà Baker vào danh sách 
100 ngƣời quyền lực nhất thế giới. 

3. “Kẻ cách tân” Jeff Bezos (Amazon.com) 
Bằng cách giữ giá cổ phiếu Amazon.com lên mức cao nhất từ trƣớc đến nay trong cả năm 2007, 
Jeff Bezos đã có cái cớ để đập tan mọi chỉ trích cho rằng hãng đang đầu tƣ quá mạnh tay vào 

công nghệ và giảm mức phí chuyển hàng. Nhờ đó mà cái công ty Bezos sáng lập nên 14 năm 
trƣớc giờ đây mới có thể tập trung đầu tƣ hết sức vào những lĩnh vực nằm trong ―sở thích‖ của 
ông. 

Cho dù đó là nền tảng sách điện tử (e-book) Kindle hay dịch vụ điện toán đám mây dành riêng 
cho doanh nghiệp muốn lƣu trữ dữ liệu trên hệ thống máy chủ khổng lồ của Amazon, hay một cái 
gì khác nữa thì mục tiêu cuối cùng mà Bezos cam kết thực hiện vẫn là mang lại một dòng doanh 

thu mới cho Amazon. 

 

Thông tin cá nhân: Jeffrey Preston Bezos (sinh ngày 12/1/1964) là ngƣời sáng lập, chủ tịch hội 
đồng quản trị kiêm tổng giám đốc điều hành của Amazon.com. Trƣớc khi sáng lập Amazon vào 

năm 1994, ông là một nhà phân tích tài chính cho hãng D. E. Shaw & Co. Bezos từng là Nhân vật 
của năm do tạp chí Time bình chọn vào năm 1999. 
4. “Những ông trùm tìm kiếm” Sergey Brin, Larry Page, và Eric Schmidt (Google.com) 

Bộ ba lãnh đạo điều hành Google – gồm giám đốc điều hành (CEO) Eric Schmidt, chủ tịch phụ 
trách sản phẩm Larry Page và chủ tịch phụ trách công nghệ Sergey Brin – có thể nói là nhóm làm 
việc ăn ý với nhau nhất ở Google. 

Nhiệm vụ của những con ngƣời này là làm thế nào có thể kiểm soát đƣợc tốc độ phát triển tƣởng 
chừng không thể phanh lại của một công ty với hơn 18.000 nhân viên và mức doanh thu dự kiến 

cho năm nay lên tới 16,2 tỉ USD – tăng 53% so với năm ngoái. Tình trạng suy thoái mạnh của nền 
kinh tế hiện nay dƣờng nhƣ cũng không thể làm chậm bƣớc chân của Google tiến lên đoạt lấy vị 
trí ―thống soái‖ trên thị trƣờng tìm kiếm web và quảng cáo tìm kiếm toàn cầu. 

Nhƣng thành công lớn và nhanh chóng cũng mang lại cho họ không ít thách thức. Có thể kể đến 
ở đây là sự phản đối của các đối thủ cạnh tranh, các nhà quảng cáo trực tuyến và thậm chí là cả 
các cơ quan chính phủ đối với ―sức mạnh ngày một bành trƣớng‖ này của Google. Chính vì thế, 

nhiệm vụ của bộ ba Brin, Page và Schmidt là phải làm thế nào để cả thế giới hiểu đƣợc câu khẩu 
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hiệu của hãng ―Don’t be evil‖ (Chúng tôi không phải là những con quỷ khát máu. Chúng tôi không 
làm hại ai). 

 

Thông tin cá nhân: Sergey Brin (sinh ngày 21/08/1973 tại Moskva, Nga), là một doanh nhân 
ngƣời Mỹ và là ngƣời đồng sáng lập Google cùng với Larry Page. Brin hiện giờ là Giám đốc Kỹ 
thuật phụ trách công nghệ của Google. Trị giá tài sản ƣớc tính khoảng 16,16 tỉ USD vào năm 2007 

giúp anh đứng vị trí thứ 26 trong danh sách những ngƣời giàu nhất thế giới. Anh cũng là tỉ phú 
trẻ thứ 4 ở Hoa Kỳ. 
Lawrence Edward ―Larry‖ Page (sinh ngày 26/3/1973 tại Lansing, Michigan) là một nhà doanh 

nghiệp Mỹ, ngƣời đồng sáng lập ra công cụ tìm kiếm Google cùng với Sergey Brin. Page hiện đang 
là Giám đốc Sản phẩm tại Google và có tài sản ƣớc tính là 16,6 tỉ USD. Anh chia sẻ vị trí 26 trong 
danh sách những ngƣời giàu nhất thế giới của tạp chí Forbes năm 2007 cùng với Sergey Brin. 

Eric Emerson Schmidt (sinh ngày 27/4/1955 tại Washington, D.C.) là chủ tịch kiêm giám đốc điều 
hành của Google Inc. và là thành viên hội đồng quản trị của hãng Apple. 

5. “Nhà đầu tư” Jeff Clavier (softtechvc.com)  
Là ngƣời từng có kinh nghiệm đầu tƣ vào không ít các công ty web 2.0 nên năm ngoái Jeff Clavier 
đã quyết định đứng ra thành lập một công ty quản lý quỹ đầu tƣ riêng có tên là SoftTech VC đặt 

trụ sở ở Palo Alto (California, Mỹ). 
Mặc dù không nổi tiếng trên mặt báo nhƣ ngƣời đồng nghiệp Michael Moritz ở Sequoia Capital hay 
John Doerr của Kleiner Perkins Caufield & Byers nhƣng Jeff Clavier lại là một ngƣời mà hầu nhƣ 

tất cả các công ty trong lĩnh vực web 2.0 đều tìm đến. Lý do rất đơn giản bởi Clavier có con mắt 
rất tinh tƣờng, có thể nhận diện đƣợc tiềm năng phát triển của các doanh nghiệp mới thành lập. 
Năm trong số những công ty của Clavier đã giành đƣợc rất nhiều thành công và ngày nay đã trở 

thành một phần trong những tên tuổi lớn nhƣ Yahoo, AOL… thông qua các vụ sáp nhập. 
 
 

 

Thông tin cá nhân: Jeff sinh ra và lớn lên tại Pháp. Ông đƣợc hƣởng nền giáo dục tân tiến tại 

quốc gia này trong lĩnh vực Khoa học máy tính. Kể từ năm 2000, ông tận hƣởng một cuộc sống 
vừa hiện đại vừa yên bình cùng với vợ và hai con tại thung lũng Silicon.  
6. “Gấu bố” Paul Graham (Ycombinator.com) 

Đƣợc đào tạo để trở thành một lập trình viên nhƣng Paul Graham lại không nổi tiếng trong giới 
công nghệ với nghề nghiệp đã chọn mà lại nổi tiếng nhờ vào bài viết ―Phƣơng pháp xây dựng một 
doanh nghiệp thành công‖. Vài năm sau đó, Graham đã đầu tƣ thành lập Y Combinator theo đúng 

nhƣ những gì ông đã trình bày trong bài viết nói trên. Y Combinator là một công ty đầu tƣ tài 
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chính chuyên hỗ trợ nguồn lực cho công ty công nghệ. Một năm hai lần Y Combinator lại chọn ra 
một số doanh nghiệp trẻ để trao tặng nguồn vốn khoảng 20.000 USD nhằm giúp những doanh 

nghiệp này có thể biến ý tƣởng của họ trở thành hiện thực. Trang web tin xã hội Reddit là một 
trong những thành công nhất đƣợc Y Combinator đầu tƣ theo phƣơng thức này. Năm 2006, 
Reddit đƣợc Condé Nast Publications mua lại. 

 

Thông tin cá nhân: Paul Graham (sinh năm 1964) là nhà đầu tƣ mạo hiểm, lập trình viên kiêm 

nhà văn tiểu luận. Ông là tác giả của các cuốn On Lisp (1993), ANSI Common Lisp (1995), và 
Hackers & Painters (2004). 
7. “Blogger chính trị” Arianna Huffington (Huffingtonpost.com) 

Khi cuộc bầu cử tổng thống Mỹ đang ngày một đến gần hơn thì trang blog chuyên về vấn trị của 
Arianma Huffington càng thu hút đƣợc nhiều ngƣời đọc. Đây đã trở thành một địa chỉ không thể 
bỏ qua của giới truyền thông Washington cũng nhƣ những cử tri cánh tả. 

Mỗi tháng trang blog của Huffington đón tới hơn 8 triệu lƣợt ngƣời truy cập đọc tin, bình luận, 
thảo luận về các tin tức mới cũng nhƣ các vấn đề chính trị. Có thể nói Huffington đã lái mọi cuộc 
tranh luận trên các phƣơng tiện truyền thông phải tập trung vào những vấn đề mà bà đã trình 

bày trên trang blog cá nhân hoặc đã từng đề cập đến trong những lần xuất hiện trƣớc công 
chúng. 

Tháng sáu vừa qua, bà Huffington cho biết đang lên kế hoạch xây dựng một website tin tức địa 
phƣơng dành riêng cho ngƣời dùng ở khu vực thành thị. 
 

 

 
 

Thông tin cá nhân: Arianna Huffington (tên khai sinh là Arianna Stassinopoulos, sinh ngày 
15/7/1950) là một nhà văn, một ngƣời hoạt động trong lĩnh vực truyền thông nổi tiếng tại Mỹ. Bà 

là nhà sáng lập ra tờ The Huffington Post, một trang tin điện tử trực tuyến có tính tƣơng tác cao 
với độc giả. 
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8. “Ông cố vấn” Joi Ito (Joi.ito.com) 
Ai có thể ngờ đƣợc rằng một cậu sinh viên bỏ học Joi Ito và đã từng là một DJ làm việc trong các 

hộp đêm lại trở thành một trong những nhà tƣ tƣởng hàng đầu trong thế giới web với rất nhiều 
bài viết sắc sảo về các công nghệ mới nhất hiện nay nhƣ game online trực tuyến đa ngƣời chơi 
World of Warcraft hay mạng xã hội ảo. 

Không những thế ngƣời đàn ông gốc Nhật này còn là một doanh nhân, một cổ đông chiến lƣợc 
trong hàng loạt các công ty nhƣ Flickr hay Six Apart, cũng nhƣ là thành viên hội đồng quản trị của 
nhiều doanh nghiệp nhƣ Socialtext và Technorati. 

Bên cạnh những công việc nói trên, Joi Ito còn là giám đốc điều hành tổ chức phi lợi nhuận 
Creative Commons lấy mục tiêu trợ giúp các nhà văn, nghệ sĩ… trình bày suy nghĩ về việc các tác 

phẩm của họ sẽ đƣợc sử dụng nhƣ thế nào trên thế giới mạng Internet. 
 

 

Thông tin cá nhân: Joichi Ito (sinh ngày 19/6/1966) thƣờng đƣợc biết đến dƣới cái tên Joi Ito, 

là một nhà hoạt động xã hội, doanh nhân và nhà đầu tƣ mạo hiểm. Ông nổi danh trong làng công 
nghệ thông tin và Internet với vai trò là ngƣời sáng lập ra các công ty nhƣ PSINet Nhật Bản, 
Digital Garage và Infoseek Nhật Bản. Bên cạnh đó, Ito còn là tổng giám đốc điều hành của công 

ty Creative Commons. 
9. “Quân sư” Steve Jobs ( Apple.com) 
Không chỉ thành công trong việc kéo Apple thoát khỏi ―một cái chết yểu‖ sau khi trở lại nắm giữ vị 

trí giám đốc điều hành hồi năm 1996, Steve Jobs còn châm ngòi cho một cuộc cách mạng về 
phƣơng thức thƣởng thức âm nhạc, phim ảnh, chƣơng trình truyền hình… của chúng ta ngày hôm 
nay. 

Có thể nói iTunes hiện đang là dịch vụ bán lẻ nhạc số lớn nhất tại trị trƣờng Mỹ – tính trên cả 
phƣơng diện quy mô sản phẩm lẫn doanh thu hữu hình. Chỉ tính riêng từ tháng 6/2008 đến nay 
iTunes đã bán đƣợc tổng cộng 5 tỉ bản nhạc số khác nhau. Năm 2007, Jobs còn trở thành tâm 

điểm của cả thế giới không dây với việc tung ra chiếc điện thoại di động iPhone đình đám, thách 
thức cả những ―tên tuổi già cỗi‖ nhƣ Motorola hay RIM. 
 

 

 

 

 

Thông tin cá nhân: Steven Paul Jobs (sinh ngày 24/2/1955) là tổng giám đốc điều hành của 

hãng máy tính Apple, ông là một trong những ngƣời có ảnh hƣởng lớn nhất ở ngành công nghiệp 
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vi tính. Sáng lập Apple năm 1976 (cùng Steve Wozniak), ông đã phổ biến máy vi tính vào đời sống 
hàng ngày với chiếc máy Apple II. Sau này, ông là một trong những ngƣời đầu tiên trông thấy 

tiềm năng thƣơng mại của GUI và chuột đƣợc phát triển tại Trung tâm Nghiên cứu Palo Alto của 
Xerox, và những công nghệ này đã đƣợc kết hợp chặt chẽ với dòng máy huyền thoại Apple 
Macintosh. Jobs còn là chủ tịch Pixar Animation Studios, một hãng phim hoạt hình nổi tiếng thế 

giới. 
10. “Nhà làm phim” Jonathan Kaplan (Theflip.com) 
Thay đổi một thói quen không phải là chuyện dễ. Nhƣng vị giám đốc điều hành Pure Digital 

Technologies Jonathan Kaplan đã làm đƣợc điều đó khi cho ra đời chiếc máy quay video gia đình 
tác động mạnh đến các dịch vụ chia sẻ video số trực tuyến. Cái giá mà ông phải trả là một quãng 

thời gian kéo dài bảy năm. 
Chiếc máy quay Flip giá 130 USD đã thật sự mang đến cho ngƣời dùng sự tiện lợi tối đa trong việc 
quay video. Chỉ cần đƣa đối tƣợng muốn quay vào trong khung màn hình nhỏ của Flip và bấm nút 

là bạn đã có đƣợc những hình ảnh cần thiết. Không những thế, với chiếc máy quay này ngƣời 
dùng còn có thể dễ dàng tải những đoạn video đã quay sang PC hoặc lên mạng YouTube. Sự 
thành công của Flip đã có tác động to lớn đến dịch vụ chia sẻ video số trực tuyến, đồng thời buộc 

các đối thủ nhƣ Sony và Samsung cũng phải tung ra các sản phẩm tƣơng tự để cạnh tranh nhằm 
tránh để mất thị trƣờng. 
 

 

 
 

Thông tin cá nhân: Jonathan Kaplan sinh ngày 25/11/1947 tại thủ đô Paris, nƣớc Pháp. Ông là 
nhà làm phim ngƣời Mỹ nổi tiếng với tác phẩm The Accused (1988), trong đó có cảnh cƣỡng hiếp 

gây xôn xao dƣ luận một thời. 
11. “Kẻ truyền tin” Loic Le Meur (Leweb3.com, seesmic.com) 
Giỏi giao tiếp là yếu tố đã giúp Le Meur có đƣợc những thành công vang dội. Không chỉ sáng lập 

nên hội nghị Le Web – một diễn đàn quy tụ giới blogger toàn cầu đƣợc tổ chức thƣờng niên tại 
Paris – mà Le Meur còn là ngƣời đã xây dựng một trong những diễn đàn nổi tiếng nhất ở Pháp và 
nắm vị trí điều hành một loạt các công ty khác nhau. 

Hiện hiếm ngƣời nào hiểu và quan tâm đến Twitter (*) cũng nhƣ các hình thái dịch vụ giao tiếp 
trực tuyến ngắn gọn hơn Le Meur. Và Le Meur đã đặt cƣợc những hiểu biết đó vào công ty có tên 
Seesmic. Sản phẩm chủ chốt của công ty này là một biến thể của Twitter. Dịch vụ này cho phép 

ngƣời dùng có thể đƣa lên mạng những đoạn video ngắn gọn để đáp lại nội dung video của một 
ngƣời khác. 
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Thông tin cá nhân: Loïc Le Meur (sinh ngày 14/7/1972) là một doanh nhân kiêm blogger ngƣời 

Pháp. Cuối năm 2006, Le Meur trở thành một ngƣời ủng hộ ứng cử viên tổng thống Pháp Nicolas 
Sarkozy và tham gia vào đội quân phục vụ chiến dịch tranh cử của ông này nhƣ một chuyên viên 
tƣ vấn đối với các chủ đề đƣợc công bố trên mạng Internet. 

12. “Thương nhân” Jack Ma (Alibaba.com) 
Jack Ma (43 tuổi) là một điển hình trong giới thƣơng nhân Trung Quốc. Ngƣời vốn trƣớc đây chỉ là 
một giáo viên trung học nhƣng đã sáng lập và đƣa Alibaba Group trở thành một hãng thƣơng mại 

điện tử hàng đầu Trung Quốc. ―Con bài then chốt‖ của Alibaba Group chính là website 
Alibaba.com – một dịch vụ thƣơng mại điện tử B2B (Business-to-Business) – kết nối các nhà xuất 
– nhập khẩu vừa và nhỏ của Trung Quốc với đối tác trên toàn thế giới. Bên cạnh đó, Alibaba 

Group còn nắm trong tay quyền kiểm soát website Yahoo China và Taobao – website hàng đầu 
Trung Quốc dành cho ngƣời tiêu dùng. 
Tháng mƣời một năm ngoái Jack Ma đã dẫn dắt Alibaba Group thực hiện thành công việc phát 

hành cổ phiếu cá nhân cho các nhà đầu tƣ chiến lƣợc, thu về tới 1,5 tỉ USD để tài trợ cho các dự 
án mở rộng sang thị trƣờng Nhật Bản, Hàn Quốc và Ấn Độ của hãng. 
 

 

 
 

Thông tin cá nhân: Jack Ma (sinh tháng 11/1964) là ngƣời sáng lập kiêm giám đốc điều hành 
của tập đoàn thƣơng mại điện tử Alibaba. Ông đƣợc mệnh danh là ―ông trùm thƣơng mại điện tử 

Trung Quốc‖ có tầm nhìn xa trông rộng. 
13. “Nhà xuất bản” Matt Mullenweg (WordPress.org) 
Các hình thái truyền thông xã hội ngày càng đƣợc coi trọng chính là yếu tố làm nên những thành 

công vang dội cho WordPress – dịch vụ blog nổi tiếng nhất trong giới blogger toàn cầu hiện nay. 
Ngoài ra mã nguồn mở là một yếu tố khác giúp mang lại tên tuổi cho WordPress. Năm 2001, khi 
bắt đầu ―sự nghiệp viết blog‖ Matt Mullenweg đã sử dụng một phần mềm nguồn mở để phát triển 

nên những công cụ web cho riêng mình. Đây chính là nền tảng đầu tiên cho WordPress. 
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Năm ngoái lƣợng ngƣời truy cập WordPress đã đạt tới con số 103 triệu, tăng gấp hai lần so với 

cùng kỳ năm trƣớc đó và gấp hơn năm lần lƣợng truy cập của đối thủ cạnh tranh Typepad (20 
triệu). Đến nay, WordPress vẫn đang tiếp tục đà phát triển rất mạnh. 
Thông tin cá nhân: Matthew Charles Mullenweg (sinh ngày 11/1/1984 tại Houston, Texas) là 

nhà phát triển phần mềm mã nguồn mở dành cho blog nổi tiếng WordPress, đồng thời là tác giả 
của blog Photo Matt. Sau khi nghỉ việc tại CNET, anh đầu tƣ phần lớn thời gian của mình vào việc 
phát triển nhiều dự án mã nguồn mở và tham gia thƣờng xuyên các hội nghị công nghệ thông tin. 

Cuối năm 2005, Mullenweg khởi dựng Automattic, một dự án thƣơng mại sau WordPress. 
14. “Ông trùm truyền thông” Rupert Murdoch (Myspace.com) 
Sự nghiệp của Rupert Murdoch có thể nói là gắn liền với sự phát triển của lĩnh vực truyền thông. 

Murdoch đã biến mọi phƣơng tiện truyền thông có trong tay trở thành ―con gà đẻ trứng vàng‖ 
mang lại cho ông hàng tỉ USD lợi nhuận. Mục tiêu của Murdoch hiện nay là lặp lại những thành 
công đã giành đƣợc với MySpace – mạng xã hội ảo mà News Corp đã mua lại năm 2005 với giá 

khoảng 580 triệu USD. 
Và từ đó đến nay, MySpace đã ―thay da đổi thịt‖ từ một website chỉ cho phép ngƣời dùng gửi tin 
nhắn cho bạn bè và nghe nhạc không có bản quyền trở thành một công cụ web giải trí đúng 

nghĩa với 117 triệu ngƣời dùng toàn cầu và doanh thu hằng năm lên tới 800 triệu USD. Ngoài ra 
MySpace đã ký đƣợc hàng loạt hợp đồng phát lại các chƣơng trình truyền hình và liên doanh với 
hãng thu âm lớn cho ra đời dịch vụ âm nhạc MySpace Music. Thách thức lớn nhất hiện nay của 

Murdoch là biến khối thông tin dữ liệu khổng lồ có đƣợc sau bao nhiêu năm thành doanh thu cho 
quảng cáo, hòng cạnh tranh với các đối thủ trong đó có Yahoo. 

 

 

 
 

Thông tin cá nhân: Keith Rupert Murdoch (sinh 11/3/1931 tại Melbourne), thƣờng đƣợc biết 
đến với cái tên Rupert Murdoch, là một ông trùm truyền thông toàn cầu ngƣời Úc-Mỹ. Ông là cổ 

đông, chủ tịch, giám đốc điều hành của News Corporation. Bắt đầu sự nghiệp với báo giấy, tạp 
chí, và những kênh truyền hình tại quê nhà Úc, Murdoch đã phát triển News Corp tới thị trƣờng 
truyền thông Anh, Mỹ và châu Á. Những năm gần đây ông trở thành nhà đầu tƣ hàng đầu trong 

lĩnh vực truyền hình vệ tinh cũng nhƣ ngành công nghiệp điện ảnh, Internet và truyền thông. 
Theo tạp chí Forbes, Murdoch là ngƣời giàu thứ 32 tại Mỹ với số tài sản lên đến 7,7 tỉ USD. 
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15. “Người kết nối cộng đồng” Craig Newmark (Craigslist.com) 
Năm 2004, Craig Newmark – cựu chuyên gia tƣ vấn của Charles Schwab – khai trƣơng website 

Craigslist với mục tiêu giúp kết nối cộng đồng và quảng bá sự kiện. Và kể từ đó bằng hình thức 
quảng cáo và đăng tin rao bán miễn phí, Craigslist đã góp phần tạo nên những thay đổi lớn trong 
dịch vụ quảng cáo và mô hình kinh doanh của báo in. 

 

 

 

 

Song có một điều là đừng bao giờ hỏi Newmark về tầm ảnh hƣởng của Craigslist bởi Newmark sẽ 

nói rằng anh đầu tƣ vào website này không phải để kiếm tiền. Bằng chứng rõ rệt là sau sự kiện 
một nhân viên của Craigslist đã bán 25% cổ phần hãng thuộc sở hữu của anh ta cho eBay, 
Newmark đã đâm đơn khởi kiện, cáo buộc ―ngƣời khổng lồ‖ trong lĩnh vực thƣơng mại điện tử này 

đang có âm mƣu biến Craigslist trở thành một bộ phận kinh doanh của hãng này. 
Thông tin cá nhân: Craig Alexander Newmark (sinh ngày 6/12/1952 tại Morristown, New Jersey) 
nổi tiếng trong thế giới mạng nhờ sáng lập ra website Craigslist, chủ yếu liên quan đến spammer 

và scammer. 
16. “Tài xế chuyên nghiệp” Gabe Rivera – (Techmeme.com) 
Bằng cách tập hợp tin tức nổi bật về lĩnh vực công nghệ từ hơn 1.000 trang blog và hãng thông 

tấn chính thống, Techmeme của Gabe Rivera đã nhanh chóng trở thành địa chỉ không thể bỏ qua 
của những ngƣời đam mê công nghệ. 

 

 
 

Không giống Digg và một số website cộng đồng khác, Techmeme hoạt động trên cơ chế tự động 
hoàn toàn. Rivera đã cố gắng nghiên cứu thay đổi thuật toán cần thiết nhƣng tin tức trên 
Techmeme vẫn đƣợc đánh giá theo liên kết và mức độ đƣợc quan tâm trên các trang blog. Năm 

2007, Techmeme có thêm một vùng giúp hiển thị đầy đủ nguồn tin của những tin tức đƣợc bạn 
đọc quan tâm nhất đã đƣợc đƣa lên trang. 
Thông tin cá nhân: Gabe là ngƣời sáng lập TechMeme, một dịch vụ tin tức công nghệ phổ biến 

nhất trênthế giới mạng hiện nay. 
17. “Cậu bé poster” Kevin Rose (Digg.com) 
Đang theo học ngành khoa học máy tính ở Trƣờng ĐH Nevada, Las Vegas nhƣng Kevin Rose bỏ 

dở giữa chừng để sáng lập Digg.com và nhờ đó trở thành một trong những gƣơng mặt nổi bật 
nhất trong số những ngƣời mới nổi trên thế giới mạng. 
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Nhờ tận dụng tối đa ƣu thế của ứng dụng chỉnh sửa văn bản trực tuyến công với việc cung cấp 
khả năng đƣợc đƣa lên mạng và bầu chọn tin tức nổi bật, Digg đã thay đổi hoàn toàn cách thức 

ngƣời dùng ngày nay tiếp cận với thông tin. Hiện mỗi tháng có 10-22 triệu lƣợt ngƣời dùng truy 
cập vào Digg. Website này hiện cũng đang nằm trong ―tầm ngắm‖ của Google và Microsoft. 
Thông tin cá nhân: Robert Kevin Rose (sinh ngày 21/2/1977 tại California) là một doanh nhân 

có công sáng lập ra Revision3, Pownce, và nổi danh nhất hiện nay là Digg. 
(Ảnh 18) 
18. “Người khổng lồ” Sheryl Sandberg (Facebook.com) 

Trƣớc khi Sheryl Sandberg về với Facebook, mạng xã hội ảo trực tuyến mang đậm nét văn hóa tự 
do phóng khoáng, đặc trƣng những kỹ sƣ công nghệ thông tin trẻ tuổi. Nét đặc trƣng mà 

Facebook đã mang theo mình khi đƣợc Mark Zuckerberg sinh ra trong một căn phòng ký túc xá tại 
ĐH Havard (Mỹ). 
Mọi sự bắt đầu thay đổi kể từ tháng 4/2008 khi ngƣời phụ nữ từng là giám đốc điều hành ―gã 

khổng lồ tìm kiếm‖ Google trở thành giám đốc hoạt động (COO) của Facebook. Ngƣời phụ nữ 38 
tuổi này thật sự đã mang đến ―tƣ tƣởng ngƣời lớn‖ giúp Facebook nhanh chóng trƣởng thành. 
Nếu có ai muốn biết làm thế nào kiếm đƣợc tiền từ thế giới web 2.0 thì hãy đến hỏi Sandberg. 

 

 

 
 

Trách nhiệm chính của Sandberg hiện nay là phải giúp Facebook mở rộng hoạt động và xây dựng 
mô hình quảng cáo trực tuyến cho riêng mình. 

Thông tin cá nhân: Sheryl Sandberg là tổng giám đốc điều hành của Facebook Inc. Bà tốt 
nghiệp trƣờng đại học Harvard chuyên ngành kinh doanh. Trƣớc khi đầu quân cho Facebook, bà 

là nhân sự cốt cán tại Google với nhiều thành tựu nhƣ mở rộng những sản phẩm quảng cáo của 
Google trong đó có Google AdWords. Năm 2007, ở tuổi 38, bà lọt vào danh sách 50 ngƣời phụ nữ 
quyền lực nhất của tạp chí Fortune 50. 

19. “Nhà giáo dục và giải trí” Jon Stewart (Thedailyshow.com) 
Có thể nói tầm ảnh hƣởng trên thế giới mạng trực tuyến của Jon Stewart đã tăng theo cấp số 
nhân tỉ lệ thuận với độ nóng của cuộc bầu cử tổng thống Mỹ. Chính những tranh chấp với 

YouTube về việc website này cho đăng tải một số video vi phạm bản quyền của mình đã giúp 
Comedy Central đi đến quyết định cung cấp miễn phí và cho phép ngƣời dùng thoải mái chia sẻ 
những nội dung video đó thông qua một website chính thức riêng của hãng này – website The 

Daily Show. Và đến nay, The Daily Show đã trở thành một địa chỉ mà ở đó ngƣời dùng Internet sẽ 
có đƣợc một cái nhìn toàn cảnh tốt nhất về cuộc bầu cử tổng thống ở Mỹ. 
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Thông tin cá nhân: Jon Stewart (tên khai sinh là Jonathan Stuart Leibowitz; sinh ngày 

28/11/1962) là nhân vật hoạt động tích cực trong lĩnh vực giải trí và có một vị thế chính trị vững 
chắc. Ông là nhà hài kịch, diễn viên, nhà văn và nhà sản xuất điện ảnh nổi tiếng với chƣơng trình 
The Daily Show. 

20. “Người đàn ông tiền bạc” Peter Thiel (Clariumcapital.com, thefoundersfund.com) 
Không chỉ là một thành viên sáng giá nhất trong đội ngũ nhân viên của nhà cung cấp dịch vụ 
thanh toán trực tuyến PayPal, Peter Thiel còn là nhà đầu tƣ danh tiếng. Thông qua Founders 

Fund, Thiel đã đầu tƣ vào hàng loạt công ty mới nổi có tiếng nhất ở Thung lung Silicon nhƣ 
Facebook, Slide hay Yammer. 
Ngoài ra ngƣời đàn ông này còn đứng ra thành lập một quỹ quản lý đầu tƣ riêng chuyên giúp đỡ 

các doanh nhân trong lĩnh vực Web 2.0, đặc biệt là những ngƣời không cần phải có quá nhiều vốn 
mới có thể biến ý tƣởng của họ thành hiện thực và không muốn đánh đổi nguồn hỗ trợ đầu tƣ 
bằng một số cổ phần quá lớn trong doanh nghiệp do họ làm chủ. Sau khi bán lại PayPal cho eBay, 

Thiel rời hãng và đứng ra thành lập quỹ quản lý đầu tƣ Clarium Capital Management. Hiện công ty 
này quản lý một nguồn vốn đầu tƣ lên đến 7 tỉ USD. 

 

Thông tin cá nhân: Peter Andreas Thiel (sinh năm 1967) là thƣơng nhân ngƣời Mỹ kiêm nhà 

đầu tƣ mạo hiểm. Cùng với Max Levchin, Thiel sáng lập nên PayPal và trở thành CEO của công ty 
này. Ông là một trong những nhà đầu tƣ bỏ tiền cho Facebook và hiện đang nằm trong thành 
phần ban giám đốc của công ty này. Tạp chí Forbes xếp ông ở vị trí 377 trong danh sách những 

ngƣời giàu nhất thế giới với tổng tài sản trị giá 1,3 tỉ USD. 
21. “Thợ thủ công” Maria Thomas (etsy.com) 
Etsy.com chỉ là một công ty nhỏ nhƣng lại có tiềm năng rất lớn. Là một địa chỉ cho phép ngƣời 

dùng Internet có thể mua hoặc bán các sản phẩm thủ công, doanh thu năm 2007 của website 
mới chỉ 3 tuổi đời này đã lên tới 27 triệu USD. Điều đáng nói ở đây là Etsy kiếm đƣợc khoản 

doanh thu nhƣ thế mà chỉ phải đầu tƣ rất ít cho công tác quảng bá (marketing). 
Bí mật thành công của Etsy là gì? Đó là đánh trúng tâm lý cảm thấy nhàm chán đối với những sự 
việc bình thƣờng và thƣờng xuyên lặp đi lặp lại quá nhiều của ngƣời tiêu dùng. Nhiệm vụ của 

Maria Thomas là phải làm thế nào để ngƣời tiêu dùng biết đến Etsy và biết đó là một giải pháp 
thay thế tất cả những gì đã trở nên quá quen thuộc với họ. Có thể nói Thomas là ngƣời rất có 
kinh nghiệm trong những việc nhƣ thế này – xây dựng một mô hình mới dựa trên những thói 

quen cũ. 
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Thông tin cá nhân: Trƣớc khi gia nhập Etsy vào tháng 5/2008 với trọng trách nâng công ty này 
lên một tầm cao mới trên toàn cầu, Maria Thomas có 6 năm rƣỡi là Phó giám đốc cấp cao kiêm 

giám đốc điều hành của NPR Digital Media. Bà từng là nhân sự cốt cán tại Amazon.com với vai trò 
là nhà quản lý cao cấp. 
22. “Thuyết khách” Anssi Vanjoki (nokia.com) 

Anssi Vanjoki là ngƣời ủng hộ mạnh mẽ nhất cho chiến lƣợc biến Nokia từ một nhà sản xuất phần 
cứng thành một nhà cung cấp dịch vụ Internet di động. Ở cƣơng vị phó chủ tịch điều hành phụ 

trách phát triển thị trƣờng, nhiệm vụ của Vanjoki là làm thế nào thuyết phục khách hàng và đối 
tác kinh doanh của Nokia rằng sản phẩm của Nokia không chỉ dành để thực hiện cuộc gọi thông 
thƣờng hoặc chỉ để chụp ảnh. 

 

 

―Máy tính đa phƣơng tiện‖ – thuật ngữ đƣợc Vanjoki dùng để gọi sản phẩm ―điện thoại thông 
minh‖ của Nokia – ngày nay đang từng bƣớc trở thành một cổng kết nối đến Internet, dịch vụ 

trực tuyến, mạng xã hội ảo, tải nhạc, định vị toàn cầu… 
Tất cả những gì Nokia cần hiện nay là sự quyết tâm theo đuổi đến cùng những gì Vanjoki đã vạch 
ra, quyết tâm ―tuyên chiến‖ với những đối thủ cũ có nhƣ Research in Motion và mới có nhƣ Apple, 

Google. 
Thông tin cá nhân: Anssi Vanjoki gia nhập tập đoàn Nokia vào năm 1991. Chỉ 7 năm sau đó, bà 
trở thành Phó chủ tịch hội đồng quản trị, thành viên ban giám đốc cấp cao của công ty này. 

Vanjoki đồng thời là chủ tịch hội đồng quản trị tập đoàn Amer Group Plc.  
23. “Người của cộng đồng” Jimmy Wales (wikia-inc.com/wiki/wikia) 
Jimmy Wales đƣợc biết đến nhiều nhất trong vai trò là ―cha đẻ‖ Wikipedia. Nếu nhƣ năm 2001 

Wikipedia mới chỉ là một website nhỏ hầu nhƣ chƣa đƣợc biết đến, thì nay đã trở thành một cuốn 
đại từ điển bách khoa toàn thƣ trực tuyến cung cấp cho ngƣời dùng Internet mọi thông tin liên 
quan đến các nét văn hóa phổ biến. Wikipedia đƣợc Alexa xếp hạng vào một trong 10 website 

phổ biến nhất thế giới. 
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Nhƣng giờ đây, Wales còn đƣợc biết đến nhƣ ―ngƣời đứng đầu lực lƣợng chống đối gã khổng lồ 

tìm kiếm Google‖. Wales đã đứng ra thành lập Wikia Inc nhắm đến việc phát triển công cụ tìm 
kiếm nguồn mở Wikia Search. Hiện dự án này đã nhận đƣợc 4 triệu USD nguồn vốn đầu tƣ từ 
Bessemer Venture Partners và Omidyar Network. 

Thông tin cá nhân: Jimmy Donal Wales (tên hiệu là Jimbo; sinh vào tháng 8/1966) là nhà sáng 
lập và Chủ tịch Quỹ Hỗ trợ Wikimedia, một định chế phi lợi nhuận điều hành bách khoa toàn thƣ 
mở Wikipedia cùng các đề án wiki khác. 

24. Blogger Evan Williams (Twitter.com) 
Evan Williams có sở trƣởng trong việc khám phá những phƣơng thức giữ liên lạc ƣa thích của 
chúng ta – thậm trí là trƣớc cả khi chúng ta biết về nó. Năm 1999 Williams khai trƣơng dịch vụ 

Blogger hƣớng đến việc cho phép ngƣời dùng thoải mái bày tỏ suy nghĩ cá nhân trên mạng 
Internet. Blogger đã giúp biến bất kỳ ai đƣợc trang bị một chiếc PC có kết nối mạng Internet trở 
thành một nhà xuất bản. 

Sau khi nhƣợng Blogger lại cho Google, Williams tiếp tục sáng lập dịch vụ cung cấp nội dung nhạc 
số và video trực tuyến Odeo. Song dịch vụ này lại không mấy thành công nhƣ Williams mong đợi. 
Tuy nhiên, trong thời gian này Jack Dorsey – một nhân viên trong công ty của Williams – đã nảy 

sinh ý tƣởng về Twitter. Chỉ trong hai năm sau đó Twitter đã bùng nổ mạnh mẽ và trở thành một 
phƣơng thức giữ liên lạc trực tuyến mới. 

 

 
 

Thông tin cá nhân: Evan Williams (sinh ngày 31/3/1972 tại Nebraska) là một doanh nhân ngƣời 
Mỹ sáng lập khá nhiều công ty Internet. Williams và một ngƣời bạn tên Meg Hourihan đã đồng 
sáng lập ra Pyra Labs – một phần mềm quản lý dự án mà sau này đƣợc phát triển dƣới cái tên 

Blogger, một trong những ứng dụng web đầu tiên trong việc tạo lập và quản lý blogs. Ngày 17 
tháng 2 năm 2003, Google đã mua lại Pyra. Sau hơn 1 năm làm việc tại Google, Williams quyết 
định tách khỏi công ty này và đồng sáng lập nên một số công ty Internet khác nhƣ Odeo, chuyên 

podcasting; Obvious Corp và Twitter. Tạp chí PC đã chọn Evan Williams là Nhân vật của năm 
2004. 
25. “Chiến binh hiếu thắng” Jerry Yang (Yahoo.com) 

Mặc dù lời đề nghị đƣợc mua lại với giá 47,5 tỉ USD đã đƣợc rút lại nhƣng có lẽ chiến dịch ―chống 
Microsoft‖ ở Yahoo vẫn chƣa thể chấm dứt. Nhiệm vụ của Jerry Yang – ngƣời đồng sáng lập kiêm 
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giám đốc điều hành Yahoo – là phải tìm đƣợc cách khôi phục sự tăng trƣởng cho ―cây đại thụ 
Internet‖. Hiện Yang đặt cƣợc tất cả vào những dịch vụ mới nhƣ hệ thống quảng cáo hiển thị. 

Ở phía bên kia mặt trận, Carl Icahn cùng hai đồng nhiệm khác trong ban lãnh đạo Yahoo và rất 
nhiều cổ đông khác của hãng đều vẫn mong muốn bản hợp đồng sáp nhập với Microsoft. Cùng 
lúc đó, các cơ quan quản lý của Mỹ cũng đang xem xét bản hợp đồng hợp tác quảng cáo giữa 

Yahoo và Google. Trong điều kiện sự suy thoái của nền kinh tế Mỹ đã ảnh hƣởng không ít đến 
doanh thu quảng cáo của Yahoo, những nỗ lực duy trì sự độc lập cho Yahoo của Jang sẽ phải đối 
mặt với không ít thách thức. 

 

 

 

 

Thông tin cá nhân: Jerry Yang (Dƣơng Trí Viễn, sinh ngày 6/11/1968) là một thƣơng nhân quốc 

tịch Mỹ. Jerry Yang là ngƣời Hoa sinh năm 1968 tại Đài Bắc, thủ phủ của Đài Loan. Đến năm 10 
tuổi, Jerry Yang cùng gia đình di cƣ sang San Jose thuộc bang California của Mỹ. Anh là nhà đồng 
sáng lập kiêm giám đốc điều hành Yahoo! Inc. Mặc dù mới 30 tuổi, Jerry Yang đã là chủ nhân của 

công cụ tìm kiếm nổi tiếng và đã có trong tay một tài sản khổng lồ lên tới 2,3 tỉ USD (năm 2008) 
khiến anh lọt vào danh sách những ngƣời giàu có nhất thế giới do tạp chí Forbes xếp hạng. 

 
 

 

 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Excel 2007 toàn tập 



 Excel 2007 toàn tập - Kỳ 2 - Thế nào là WorkBook, Thế nào là 

WorkSheet 

 

Thế nào là WorkBook 

 

WorkBook là tập tin của Excel mà trên đó có nhiều WorkSheet, trên 

một WorkBook bạn được mở tối đa 255 Sheet. Bạn có thể mở 

nhiều WorkBook cùng lúc và mỗi WorkBook là một cửa sổ Excel 

riêng biệt (bạn không nên mở quá nhiều WorkBook vì như vậy sẽ 

chiếm bộ nhớ và máy chạy chậm). 

 

Các tập tin WorkBook có phần mở rộng XLS (Excel 2003) 

và XLSX (Excel 2007). 

 

Khi mở Excel thì số lượng Sheet mặc định trên WorkBook là 3 

Sheet (bạn có thể thay đổi số lượng Sheet mặc định (xem *)) 

 

 



 

(*) Thay đổi số lượng Sheet mặc định: 

o Chọn biểu tượng logo Office 2007 trên góc trái cửa 

sổ Excel 2007. 

 

 

o Một menu lệnh hiển thị, bạn chọn Excel Options. 

o Hộp thoại Excel Options hiển thị: 

 

o Bạn chọn lớp Popular. 



o Thay đổi giá trị trong ô Include this many sheets , giá 

trị mặc định là 3. 

Thực hiện xong, nhấn OK để áp dụng và lần mở Excel sau, số 

lượng Sheet được mở sẽ bằng số giá trị bạn thay đổi trong ô Include 

this many sheets 

Thế nào là WorkSheet 

o WorkSheet (bảng tính) là tập hợp gồm các cột (Column), dòng 

(Row), ô (Cell). 

o Thứ tự các cột trong Sheet được đánh theo thứ tự bảng chữ cái 

(A, B, C, . . .) và giới hạn số cột trong Excel 2007 là 16.384 cột. 

o Thứ tự các dòng trong Sheet được đánh theo số thứ tự (1 , 2 , 3, 

. . .) và giới hạn số các dòng trong  Excel 2007 là 1.048.576 

dòng. 

o Ô (Cell) trong Excel 2007 cho phép nhập văn bản dài hơn, cho 

phép tạo các công thức nhiều lớp hơn và có thể phân chia việc 

tính toán giữa các nhân của bộ xử lý đa nhân (nếu có) để thực 

hiện những phép tính phức tạp nhanh hơn. 

Sheet hiện hành là Sheet đang được chọn hoặc bạn đang thao tác 

thay đổi dữ liệu. 

 



 

 Excel 2007 toàn tập - Kỳ 3 - Mở - Đóng - Lưu bảng tính 

. Mở một bảng tính: 

o Chọn biểu tượng logo Office 2007 trên góc trái cửa sổ Excel 

2007. 

o Một menu lệnh hiển thị, bạn chọn lệnh Open. 

   

Hộp thoại Open hiển thị, bạn lựa chọn tập tin Excel cần mở và 

nhấn Open thực hiện mở tập tin Excel đã chọn. 



 

2. Lưu một bảng tính: 

    Một bảng tính, sau khi đã thực hiện chỉnh sửa, muốn lưu lại bạn 

thao tác: 

o Nhấn tổ hợp phím Ctrl + S 

o Hoặc chọn biểu tượng logo Office 2007 

o Một menu lệnh hiển thị, chọn lệnh Save. 

 

o Muốn lưu tập tin với một tên khác, chọn lệnh Save As. Hộp 

thoại Save As hiển thị, hãy đặt tên trong ô File name và 

nhấn Save để thực hiện lưu. 

 

3. Thay đổi thời gian tự động lưu trong Excel 2007:         

Trong quá trình thao tác trên Excel, Excel sẽ tự động lưu lại những 

thao tác bạn thực hiện trong khoảng thời gian tự chọn (mặc định sẽ là 

10 phút). 

o Chọn biểu tượng logo Office 2007 



o Một menu lệnh hiển thị, bạn chọn lệnh Excel Options 

 

 

o Hộp thoại Excel Options hiển thị, bạn chọn lớp lệnh Save. 

 

Hình ảnh này đã bị thu nhỏ. Nhấp vào hình để xem 

kính thước thật (638x303). 

 

o Lựa chọn định dạng lưu tập tin mặc định trong Save files in this 

format (mặc định sẽ sử dụng định dạng XLSX (Excel 2007). 

o Thay đổi thời gian tự động lưu trong ô Save AutoRecover 

information every minutes. 

o Lựa chọn ổ đĩa hoặc thư mục để lưu tập tin mặc định 

trong Default file location. 

o Thực hiện xong, nhấn OK để áp dụng. 



Excel 2007 toàn tập – Kỳ 4 – Chèn thêm – Xóa bớt bảng tính 

. Chèn thêm bảng tính: 

Cách 1: 

Để thực hiện chèn thêm bảng tính (WorkSheet), bạn thao tác: 

 

Nhấn chuột phải lệnh Sheet Tab. 

Một menu lệnh hiển thị, bạn chọn lệnh Insert. 

o Hộp thoại Insert hiển thị: 



 

Bạn chọn lớp General, chọn biểu tượng Worksheet, nhấn OK để 

áp dụng. Một Worksheet mới được tạo nằm trước Worksheet đang 

hiện hành. 

Cách 2: 

o Chọn nhóm thẻ lệnh Home, chọn lệnh Insert. Một menu lệnh 

hiển thị, bạn chọn lệnh Insert Sheet. 

 

 

2. Xóa bớt bảng tính: 

o Nhấn chuột phải lên Worksheet cần xóa trong Sheet Tab. 



 

Một menu lệnh hiển thị, bạn chọn lệnh Delete. Sheet chọn xóa sẽ 

được xóa khỏi WorkBook. 

Hoặc chọn nhóm thẻ lệnh Home, chọn lệnh Delete. Một menu lệnh 

hiển thị, bạn chọn lệnh Delete Sheet. 

 

Excel 2007 toàn tập – Kỳ 5 – Đổi tên, sao chép và di chuyển 

bảng tính  

Đổi tên, sao chép và di chuyển bảng tính 

1. Đổi tên bảng tính: 

o Nhấn chuột phải lên Worksheet cần đổi tên 



 

Một menu lệnh hiển thị, bạn chọn lệnh Rename. Lúc này, tên 

của Worksheet trong Sheet Tab sẽ được tô 

đen , bạn hãy nhập tên mới 

cho Worksheet. Nhập xong, nhấn Enter để kết thúc. 

 

2. Sao chép bảng tính: 

o Chọn bảng tính cần sao chép, nhấn chuột phải lên bảng tính 

trong Sheet Tab. 

o Một menu lệnh hiển thị, bạn chọn lệnh Move or Copy. 

Hộp thoại Move or Copy hiển thị (*): 



 

 

o Chọn vị trí cần sao chép đến trong Before sheet (trong ví dụ, 

bảng tính sao chép đến sẽ nằm trước bảng tính By Product-

Customer và nằm sau By Product). Nếu muốn nằm ở vị trí cuối 

cùng của các bảng tính có trong Workbook, bạn chọn (move to 

end). 

o Đánh dấu tùy chọn Create a copy (nếu không đánh dấu nghĩa là 

bạn chỉ di chuyển bản tính) 

o Nhấn OK để áp dụng. 



o Hoặc bạn cũng có thể nhấn chuột lên tên bảng tính trong Sheet 

Tab, nhấn kèm thêm phím Ctrl và kéo chuột di chuyển đến vị trí 

cần sao chép trongSheet Tab và thả chuột ra. (nếu không nhấn 

kèm phím Ctrl nghĩa là bạn di chuyển đến vị trí mới). 

 

 

3. Di chuyển bảng tính:  

Việc di chuyển bảng tính cũng thao tác tương tự như sao chép bảng 

tính nhưng bạn không đánh dấu tùy chọn Create a copy trong hộp 

thoại Move or Copy. (xem *) 

Excel 2007 toàn tập – Kỳ 6 – Đổi màu Sheet Tab và ẩn hiện 

bảng tính 

Đổi màu Sheet Tab và ẩn hiện bảng tính 

1. Đổi màu Sheet Tab: 

o Chọn Sheet Tab cần thực hiện đổi màu (việc đổi màu giúp bạn 

dễ dàng phân biệt các Sheet với nhau) 

o Nhấn chuột phải lên Sheet Tab cần thực hiện. 



 

Một menu lệnh hiển thị, bạn chọn lệnh Tab Color. Một bảng màu hiển 

thị giúp bạn lựa chọn màu để thay đổi. 

 

2. Ẩn hiện Sheet Tab: 

Ẩn Sheet: 

o Chọn Sheet cần ẩn 

o Nhấn chuột phải lên lên tên Sheet trong Sheet Tab. 

o Một menu lệnh hiển thị, bạn chọn lệnh Hide. 

 

Sheet bạn chọn sẽ ẩn ngay lập tức, bạn có thể ẩn 

nhiều Sheet trong Workbook. 

Hiện Sheet: 



o Nhấn chuột phải lên Sheet Tab. 

o Một menu lệnh hiển thị, bạn chọn lệnh Unhide. 

 

Hộp thoại Unhide hiển thị: 

 

Một danh sách các Sheet ẩn hiển thị trong ô Unhide sheet. Bạn 

chọn Sheet cần hiện trở lại và nhấn OK để áp dụng. 

Excel 2007 toàn tập – Kỳ 7 – Chọn nhiều bảng tính & Bảo vệ 

bảng tính 

Chọn nhiều bảng tính 

Chọn nhiều bảng tính liền kề nhau: 

o Nhấn chuột lên tên của Sheet đầu cần chọn trong Sheet Tab, 

nhấn giữ phím Shift, nhấn chuột lên tên của Sheet cuối cần 



chọn. Thả chuột ra, bạn sẽ thấy một dãy các Sheet kề nhau 

được chọn. 

 

Chọn nhiều bảng tính cách nhau: 

o Nhấn giữ phím Ctrl và nhấn chuột lên tên Sheet cần chọn 

trong Sheet Tab. 

Để bỏ chọn một bảng tính nào, bạn nhấn giữ phím Ctrl và nhấn chuột 

lên tên bảng tính cần loại bỏ trong Sheet Tab. 

Bảo vệ bảng tính 

1. Thao tác thiết lập mật khẩu:    

Thực hiện việc thiết lập mật khẩu, bảo vệ bảng tính bạn thao tác: 

o Nhấn chuột phải lên Sheet cần bảo vệ trong Sheet Tab. 

o Một menu lệnh hiển thị, bạn chọn lệnh Protect Sheet 



 

o Hộp thoại Protect Sheet hiển thị: 

 

o Tuỳ chọn Protect worksheet and contents of locked 

cells phải luôn được chọn. 

o Các tùy chọn trong khung Allow all users of this worksheet 

to cho phép người sử dụng được sử dụng các thành phần do bạn 

chỉ định: 



o Select loked cells: được quét khối chọn các ô đã được bảo vệ. 

o Select unlocked cell: không được quét khối chọn. 

o Format cells: được phép định dạng ô 

o Format columns: được phép định dạng cột 

o Format rows: được phép định dạng hàng 

o Insert columns: được phép chèn thêm cột 

o Insert rows: được phép chèn thêm hàng 

o Insert hyperlinks: được phép tạo liên kết. 

o Delete columns: được phép xóa cột 

o Delete rows: được phép xóa hàng 

o Sort: được phép sắp xếp bảng tính 

o Use AutoFilter: được phép sử dụng chức năng lọc bảng tính. 

o Use Pivot Table reports: được phép sử dụng chức năng Use 

Pivot Table reports 

o Khi đã lựa chọn xong các tính năng khóa bảng tính, bạn nhập 

mật khẩu bảo vệ vào ô Password to unprotect sheet. 

o Nhấn OK để áp dụng, hộp thoại Confirm Password hiển thị yêu 

cầu bạn xác nhận lại mật khẩu đã nhập trong ô Reenter 

Password to proceed. 



 

o Nhấn OK để áp dụng (nếu lần thứ hai bạn nhập mật khẩu sai so 

với lần trước, Excel sẽ đưa ra thông báo yêu cầu bạn nhập lại 

cho đến khi đúng) 

 

2. Ngoài thao tác trên, bạn cũng có thể chọn lệnh để bảo vệ 

bảng tính trên thanh thẻ lệnh. 

o Chọn nhóm lệnh Review, chọn tiếp lệnh Protect Sheet và lập 

lại các thao tác tương tự như các bước trên. 

 

 

3. Loại bỏ thiết lập bảo vệ bảng tính: 

o Chọn Sheet cần loại bỏ bảo vệ. 

o Nhấn chuột phải lên tên Sheet trong Sheet Tab, một menu lệnh 

hiển thị, bạn chọn lệnh Unprotect Sheet. 



 

o Hộp thoại Unprotect Sheet hiển thị: 

 

Bạn nhập mật khẩu đã áp dụng bảo vệ cho bảng tính vào 

ô Password. Nhấn OK để áp dụng. 

 

Ngoài ra, bạn cũng có thể loại bỏ bảo vệ bảng tính bằng lệnh trên 

thanh thẻ lệnh. 

o Chọn bảng tính cần loại bỏ bảo vệ. 

o Chọn nhóm thẻ lệnh Review, chọn tiếp lệnh Unprotect Sheet. 

 



 Excel 2007 toàn tập – Kỳ 8 – Chọn hình ảnh làm nền cho bảng 

tính  

Chọn hình ảnh làm nền cho bảng tính 

o Chọn thẻ lệnh Page Layout trên thanh thẻ lệnh. 

 

o Chọn lệnh Background. 

o Hộp thoại Sheet Background hiển thị: 

 

Bạn lựa chọn hình ảnh để làm nền cho bảng tính và nhấn Insert để 

chèn hình ảnh. 



 

 Excel 2007 toàn tập – Kỳ 9 – Định dạng Font và nhập tiếng Việt 

trong bảng tính 

 

Định dạng Font và nhập tiếng Việt trong bảng tính 

Trước khi nhập tiếng Việt trong ô, bạn cần phải định dạng ký tự cho ô. 

o Chọn kiểu font thích hợp cho ô trong hộp Font (hoặc nhấn tổ hợp 

phím Ctrl + Shift + F). 



  

 

Các font tiếng Việt theo bảng mã Vni Windows thường bắt đầu bằng 

VNI (VNI-Times, VNI-TOP, . . .)  

Các font tiếng Việt theo bảng mã TCVN3 – ABC thường bắt đầu bằng 

.VN (VNTime, VNArial, . . .)  

Các font tiếng Việt theo bảng mã Unicode thường là Times New 

Roman, Tahoma, Arial, . .  

Để gõ được tiếng Việt, bạn phải sử dụng các chương trình gõ như 

Vietkey, Unikey, . . .  

Chú ý:  

Bạn phải chọn đúng bảng mã và Font tiếng Việt theo bảng mã thì mới 



gõ được tiếng Việt. Chọn kích cỡ chữ trong hộp Font Size. Thông 

thường kích cỡ chữ là 11 (point).              

 

Thay đổi Font mặc định trong Excel:  

Khi mở Excel, thông thường Font mặc định sẽ hiển thị trong hộp Font, 

bạn có thể thiết lập lại Font mặc định theo thao tác: 

o Chọn biểu tượng logo Office 2007 trên góc trái cửa sổ 

Excel. 

o Một menu lệnh hiển thị, bạn chọn lệnh Excel Options 

  

 

o Hộp thoại Excel Options hiển thị: 

 



o Bạn chọn lớp Popular. 

o Di chuyển chuột đến dòng When creating new workbooks. 

o Thay đổi Font chữ mặc định trong Use this font. 

o Thay đổi cỡ chữ mặc định trong Font size. 

o Thực hiện xong, nhấn OK để áp dụng. 

xcel 2007 toàn tập – Kỳ 10 – Chèn các đối tượng vào bảng tính 

– Chèn đối tượng hình ảnh & Hiệu chỉnh hình ảnh 

Chèn đối tượng hình ảnh 

Để thực hiện chèn hình ảnh vào bảng tính bạn thao tác:   

o Bạn chọn nhóm thẻ lệnh Insert 

o Chọn tiếp lệnh Picture 

 

Hộp thoại Insert Picture hiển thị: 



 

o Look in: chọn ổ đĩa và thư mục chứa hình ảnh cần chèn. 

o Insert: chọn xong hình ảnh, bạn nhấn Insert để chèn hình. 

Bạn hãy xem phim minh họa để nắm vững thao tác. 

Hiệu chỉnh hình ảnh 

Sau khi thực hiện chèn hình ảnh vào Slide, bạn cần thực hiện hiệu 

chỉnh lại các thông số:  

1. Xoay và di chuyển hình ảnh:  

Chọn hình ảnh cần thực hiện xoay hoặc di chuyển. 

o Xoay hình ảnh: 

 



o Chọn vào biểu tượng hình tròn màu xanh . 

o Con trỏ chuột sẽ hiển thị thành biểu tượng  

o Bạn nhấn giữ chuột và kéo để xoay ảnh. 

o Thay đổi kích thước hình ảnh: 

 

o Bạn chọn vào các biểu tượng hình tròn hoặc hình vuông 

quanh ảnh. 

o Con trỏ chuột sẽ hiển thị thành biểu tượng  

o Bạn nhấn giữ chuột và kéo để thay đổi kích thước hình ảnh. 

o Di chuyển hình ảnh đến vị trí mới: 

 

o Di chuyển chuột lên trên hình ảnh. 

o Con trỏ chuột sẽ hiển thị thành biểu tượng  

o Bạn nhấn giữ chuột lên hình ảnh và kéo đến vị trí mới. 



 

2. Hiệu chỉnh độ sáng, độ tương phản, tông màu, nén hình ảnh:  

Hiệu chỉnh độ sáng:  

Khi chọn vào hình ảnh cần chỉnh sửa trên Slide, bạn sẽ thấy xuất hiện 

nhóm lệnh Format 

 

Để hiệu chỉnh độ sáng bạn chọn lệnh Brightness: 

 

Một danh sách các thông số hiệu chỉnh độ sáng hiển thị, bạn lựa chọn 

thông số độ sáng thích hợp cho hình ảnh. 



o Thông số dương (ví dụ: + 40%, + 30%, . . .): tăng độ sáng. 

o Thông số âm (ví dụ: – 10%, – 20% . . .): giảm độ sáng. 

o 0% (Normal): đưa độ sáng trở về mặc định ban đầu. 

o Picture Corrections Options: mở hộp thoại hiệu chỉnh nếu bạn 

không muốn sử dụng các thông số được thiết lập sẵn. Khi bạn 

nhấn chọn, hộp thoạiFormat Picture (*)hiển thị: 

 

o Recolor: đổi tông màu cho ảnh. 

o Brightness: kéo thanh trượt để tăng giảm độ sáng. 

o Contrast: kéo thanh trượt để tăng giảm độ tương phản. 

o Reset picture: quay về mặc định ban đầu của hình ảnh. 

o Thay đổi xong các giá trị, bạn nhấn Close để áp dụng và thoát 

khỏi hộp thoại Format Picture. 

Hiệu chỉnh độ tương phản:  

    Để hiệu chỉnh độ tương phản bạn chọn lệnh Contrast trong nhóm 

lệnh Format. 



 

  

một danh sách các thông số cho độ tương phản được thiết lập sẵn cho 

bạn lựa chọn, bạn lựa chọn thông số độ tương phản thích hợp cho hình 

ảnh. 

o Thông số dương (ví dụ: + 40%, + 30%, . . .): tăng độ tương 

phản. 

o Thông số âm (ví dụ: – 10%, – 20% . . .): giảm độ tương 

phản. 

o 0% (Normal): đưa độ tương phản trở về mặc định ban đầu. 



o Picture Corrections Options: mở hộp thoại hiệu chỉnh nếu bạn 

không muốn sử dụng các thông số được thiết lập sẵn. (xem giải 

nghĩa thông số hộp thoại Format Picture *) 

Thay đổi tông màu: 

  

Thực hiện thay đổi tông màu cho hình ảnh bạn chọn 

lệnh Recolor trong nhóm lệnh Format. 

 

Một danh sách các kiểu tông màu thiết lập sẵn hiển thị, bạn chọn một 

kiểu tông thích hợp cho hình ảnh. 

o No Recolor: không áp dụng chuyển tông, trở về tông mặc định 

ban đầu của  hình ảnh. 

o Color Modes: kiểu tông màu thời trang. 



o Dark Variations: kiểu tông màu tối. 

o Light Variations: kiểu tông màu sáng. 

o More Variations: chọn thêm các màu khác để thực hiện phối 

tông. 

o Set Transparent Color: chọn vùng màu trên  ảnh để trở nên 

trong suốt. Khi bạn nhấn chọn, chon trỏ chuột sẽ hiển thị thành 

biểu tượng . Bạn nhấn chuột chọn vào vùng màu cần trong 

suốt trong  hình ảnh. 

Ví dụ: với hình minh họa bên dưới, chúng tôi muốn làm trong suốt 

vùng màu xanh (nơi vòng tròn đỏ). Chúng tôi nhấn chọn lệnh Set 

Transparent Color. 

  

Nhấn chuột lên vùng màu xanh 

  

Ngay lập tức vùng màu xanh trở nên trong suốt 



Nén  hình ảnh:  

PowerPoint 2007 cung cấp cho bạn chức năng nén hình ảnh tuyệt vời 

giúp bạn giảm bớt dung lượng tập tin trình diễn để có thể truyền tải 

nhẹ nhàng qua email. Để thực hiện, bạn chọn lệnh Compress 

Picture trong nhóm lệnh Format. 

 

Hộp thoại Compress Picture hiển thị: 

 

Chọn Options 

 

o Automatically perform basic compression on save: tự động 

nén hình ảnh khi lưu văn bản PowerPoint. 

o Delete cropped areas of pictures: bỏ các vùng chưa nén trên 

hình ảnh khi nén. 



o Print (220 ppi): nén ở chế độ in. 

o Screen (150 ppi): nén ở chế độ tải lên trang Web. 

o E-mail (96ppi): nén ở chế độ tải qua email. 

Bạn nhấn OK khi thực hiện xong lựa chọn. 

Nhấn OK để thực hiện nén và đóng hộp thoại Compress Picture. 

 

3.  l**ng khung và hiệu ứng hình ảnh:  

Thực hiện l**ng khung  hình ảnh:  

Để thực hiện l**ng khung cho  hình ảnh bạn thao tác: 

o Chọn  hình ảnh cần thực hiện l**ng khung, lúc này nhìn trên 

nhóm thẻ lệnh bạn thấy xuất hiện nhóm lệnh Format. 

 

Bạn chọn biểu tượng More trong khung Picture Styles. 

 



 

Một danh sách các mẫu l**ng khung cho hình ảnh hiển thị, bạn chọn 

một mẫu thích hợp. Khi bạn di chuyển chuột lên các mẫu bạn sẽ thấy  

hình ảnh bạn l**ng khung sẽ hiển thị cho bạn xem trước trên Slide. 

    

Minh họa một số mẫu l**ng khung cho hình ảnh 

l**ng  hình vào các biểu tượng vẽ:  

Trước đây, thao tác l**ng  hình ảnh vào các biểu tượng vẽ chỉ thực 

hiện trên các phần mềm đồ họa như Photoshop, CorelDRAW . . .Nay 

bạn sẽ dễ dàng thực hiện trên PowerPoint 2007.  

Chọn  hình ảnh cần thực hiện l**ng vào biểu tượng vẽ.  

Bạn chọn biểu tượng lệnh Picture Shape trong nhóm lệnh Format. 



 

 

Một danh sách các mẫu biểu tượng vẽ hiển thị, bạn chọn một mẫu 

thích hợp để thực hiện việc l**ng  hình ảnh vào biểu tượng vẽ đó. 

   

Một số các mẫu l**ng hình ảnh vào biểu tượng vẽ 



Tạo khung viền cho  hình ảnh:  

Để viền khung cho  hình ảnh, bạn chọn biểu tượng lệnh Picture 

Border trong nhóm lệnh Format. 

 

 

Một danh sách các ô màu và lệnh hiển thị, bạn chọn vào ô màu để vừa 

tạo khung viền và màu khung viền cho  hình ảnh. Khi bạn di chuyển 

chuột lên các ô màu, bạn sẽ thấy  hình ảnh cần tạo khung viền sẽ hiển 

thị cho bạn xem trước trong Slide. 

o No Outline: loại bỏ khung viền cho  hình ảnh. 

o More Outline Colors: lựa chọn thêm các màu khác cho khung 

viền  hình ảnh. 

o Weight: lựa chọn độ dày nét viền cho khung. (xem giải 

nghĩa **) 

o Dashes: lựa chọn nét viền cho khung. 



** khi bạn nhấn chọn Weight, một danh sách hiển thị: 

 

Gồm nhiều các thông số mẫu độ dày nét khung viền cho bạn lựa chọn. 

Bạn lựa chọn mẫu độ dày nét viền thích hợp với  hình ảnh bạn đang 

chọn. 

o More Lines: lựa chọn thêm các độ dày nét. Khi nhấn chọn, hộp 

thoại Format Picture hiển thị: 

 

o Width: lựa chọn thông số cho độ dày nét viền. 

o Compound type: kiểu độ dày nét liền. 

o Dash type: kiểu độ dày nét đứt. 



Tạo hiệu ứng cho  hình ảnh:  

Thực hiện tạo hiệu ứng cho  hình ảnh bạn thao tác: 

o Chọn  hình ảnh cần tạo hiệu ứng. 

o Nhóm lệnh Format hiển  thị, bạn chọn lệnh Picture Effects. 

 

Một danh sách các nhóm hiệu ứng hiển thị: 

 

Bạn nhấn chọn một nhóm lệnh, một danh sách các hiệu ứng của nhóm 

lệnh đó hiển thị. Bạn di chuyển chuột lên mẫu hiệu ứng, PowerPoint sẽ 

hiển thị cho bạn xem trước thay đổi hiệu ứng  hình ảnh ngay trên 

Slide.  

Tùy thuộc vào từng nhóm hiệu ứng mà bạn sẽ có thêm các lựa chọn để 

hiệu chỉnh thông số riêng cho từng mẫu hiệu ứng lựa chọn. 



o Preset: chọn lệnh 3-D Options để lựa chọn thêm thông số. 

o Shadow: chọn lệnh Shadow Options để lựa chọn thêm thông 

số. 

o Reflection: không có lệnh hiệu chỉnh thông số. 

o Glow: chọn lệnh More Glow Colos để lựa chọn thêm thông số. 

o Soft Edges: không có lệnh hiệu chỉnh thông số. 

o Bevel: chọn lệnh 3-D Options để lựa chọn thêm thông số. 

o 3-D Rotation: chọn lệnh 3-D Rotation Options để lựa chọn 

thêm thông số. 

Các hộp thoại thay đổi thông số trên khi hiển thị, bạn thay đổi bất kỳ 

thuộc tính nào trong hộp thoại thì  hình ảnh sẽ thay đổi cho bạn xem 

trước trong Slide. 

  

 

 Excel 2007 toàn tập – Kỳ 11 – Chèn các đối tượng vào bảng 

tính – Chèn đối tượng ClipArt 

 

Để thực hiện chèn ClipArt vào Slide bạn thao tác:    



o Bạn chọn nhóm lệnh Insert 

o Chọn tiếp lệnh Clip Art 

 

Hộp thoại ClipArt hiển thị (nằm cạnh phải của cửa sổ PowerPoint): 

 

o Search for:  nhập chủ đề ClipArt cần tìm và nhấn lệnh Go. 

o Danh sách các hình ClipArt ứng với chủ đề bạn chọn sẽ hiển thị. 

o Bạn Double click chuột vào ClipArt bạn cần để thực hiện chèn 

vào Slide. 



o Organize clips: nhấn để xem tất cả chủ đề ClipArt. 

    Khi nhấn chọn Organize clips, hộp thoại Microsoft Clip 

Organizer hiển thị: 

 

Bạn chọn chủ đề và chọn ClipArt cần chèn, bạn nhấn giữ và kéo hình 

ClipArt vào Slide hoặc nhấn phải chuột lên hình ClipArt đã chọn và 

nhấn lệnh Copy. Thoát khỏi hộp thoại Microsoft Clip Organizer và 

trở lại trang văn bản, bạn nhấn lệnh Paste để chèn hình vừa Copy vào 

Slide. 

Với một Clip Art khi được chèn vào Slide, bạn thực hiện hiệu chỉnh đối 

tượng Clip Art tương tự như đối tượng hình vẽ trong bài "Chèn và vẽ 

các hình trên Slide"  

Bạn hãy xem phim minh họa để nắm vững thao tác. 

 Excel 2007 toàn tập – Kỳ 12 – Chèn các đối tượng vào bảng 

tính – Chèn đối tượng SmartArt 



 

Trước đây, bạn thường rất khó khăn trong việc vẽ lưu đồ với các phiên 

bản trước của Excel, giờ đây với Excel 2007 thì thao tác sẽ thật dễ dàng 

với lệnh SmartArt. 

  

minh họa một dạng lưu đồ. 

1. Thao tác vẽ: 

o Bạn chọn nhóm lệnh Insert 

o Chọn lệnh SmartArt 

 

o Hộp thoại Choose a SamrtArt Graphic hiển thị cung cấp cho bạn 

danh sách các mẫu lưu đồ: 



 

Bạn lựa chọn một mẫu lưu đồ thích hợp với việc soạn thảo văn bản của 

bạn. Chọn xong, bạn nhấn OK để chấp nhận. Mẫu lưu đồ bạn chọn sẽ 

được thể hiện trên bảng tính như minh họa dưới. 

 

Bạn Double Click chuột vào các ô để nhập nội dung từng ô cho 

lưu đồ.  

hoặc bạn cũng có thể nhấn chuột vào , một hộp thoại hiển thị và bạn 

chọn một dòng Text để nhập nội dung. 



 

2. Chỉnh sửa mẫu lưu đồ đang áp dụng: 

o Chọn mẫu lưu đồ đang áp dụng cần sửa chữa. 

o Chọn nhóm lệnh Design trên thanh thẻ lệnh. 

 

o Add Shape: chèn thêm ô nội dung vào lưu đồ. 

o Add Bullet: chèn nút  Bullet vào ô nội dung. 

o Right to Left: nhấn sẽ di chuyển đến ô nội dung phía trái của ô 

nội dung đang chọn. 

o Promote: di chuyển ô nội dung đang chọn lên trên một vị trí. 

o Demote: di chyển ô nội dung đang chọn xuống dưới một vị trí. 

o Text Pane: hiển thị hộp thoại văn bản các ô nội dung của lưu đồ. 

o Layouts: nếu bạn không muốn sử dụng mẫu lưu đồ đang chọn, 

thay thế bằng mẫu lưu đồ khác mà không làm mất các ô nội dung 

trong lưu đồ bạn chọn vào biểu tượng More trong 

lớp Layouts của nhóm lệnh Design. Một danh sách các mẫu lưu đồ 

hiển thị, bạn lựa chọn một mẫu thích hợp để thay thế. 

o Change Colors: lựa chọn thay đổi màu sắc cho lưu đồ. Khi 

nhấn chọn, một danh sách các mẫu màu cho lưu đồ hiển thị, bạn 

lựa chọn một mẫu thích hợp. 



o Bạn có thể chọn kiểu mẫu cho ô nội dung trong SmartArt 

Styles , bạn nhấn chọn biểu tượng 

More thì một ô các mẫu áp dụng cho ô nội dung hiển thị. 

o Reset Graphic: quay lại định dạng ban đầu của lưu đồ đang 

áp dụng. 

 

3. Hiệu chỉnh nội dung và ô nội dung của lưu đồ: 

Di chuyển ô nội dung:  

    Khi bạn chọn vào ô nội dung, một khung viền bao quanh ô nội dung 

bằng các biểu tượng , ,  

 

o Để xoay ô nội dung bạn nhấn giữ chuột vào biểu tượng và kéo để 

xoay. 

o Thay đổi kích thước ô nội dung, bạn nhấn giữ chuột vào các biểu 

tượng , và kéo để thay đổi kích thước. 

o Bạn chọn ô nội dung cần hiệu chỉnh trong lưu đồ. 

o Chọn nhóm lệnh Format trên thanh thẻ lệnh. 



  

Nhóm Shapes: 

o Change Shape: thay đổi ô nội dung bằng các đối tượng vẽ. Khi 

bạn chọn, một danh sách các mẫu đối tượng vẽ hiển thị bạn chọn 

một mẫu để áp dụng cho ô nội dung trong lưu đồ. 

o Larger: khi nhấn chọn thì ô nội dung bạn đang chọn trong lưu 

đồ sẽ lớn lên một đơn vị. 

o Smaller: khi nhấn chọn thì ô nội dung bạn đang chọn trong lưu 

đồ sẽ nhỏ đi một đơn vị. 

Nhóm Shape Styles: 

o Ô chứa các mẫu hiệu ứng cho ô nội dung, bạn 

chọn biểu tượng More thì một danh sách các mẫu hiển thị. Bạn 

chọn một mẫu thích hợp cho ô nội dung (bạn nhớ là nếu muốn thay 

đổi cho ô nào thì chọn ô đó trong lưu đồ). 

o Shape Fill: lựa chọn thay đổi màu nền cho ô nội dung. 

o Shape Outline: lựa chọn thay đổi màu nét viền cho ô nội dung. 

o Shape Effects: lựa chọn hiệu ứng cho ô nội dung. Khi bạn nhấn 

chọn, các mẫu hiệu ứng hiển thị bạn áp dụng một mẫu thích hợp. 

Nhóm WordArt Styles: 



o Ô giúp bạn lựa chọn mẫu hiệu ứng kiểu chữ 

cho nội dung chữ trong ô nội dung. Khi nhấn vào biểu tượng 

More, một danh sách các mẫu hiển thị cho bạn lựa chọn. 

o Text Fill: màu nền cho nội dung chữ. 

o Text Outline: màu viền cho nội dung chữ. 

o Text Effects: hiệu ứng nội dung chữ. 

Excel 2007 toàn tập – Kỳ 13 – Chèn các đối tượng vào bảng tính 

– Chèn đối tượng WordArt 

 

1. Tạo WordArt:  

Thực hiện thêm các WordArt vào Slide, bạn thao tác: 

o Chọn nhóm lệnh Insert trên thanh thẻ lệnh. 

 

o Tiếp theo, bạn chọn lệnh WordArt. Khi bạn nhấn chọn, một 

danh sách các mẫu WordArt hiển thị: 



  

    Bạn lựa chọn một mẫu thích hợp. 

o Lập tức, trên Slide sẽ xuất hiện một text box chứa 

mẫu WordArt bạn đã chọn. 

 

Bạn thực hiện việc nhập liệu bình thường như việc nhập nội dung văn 

bản trong text box kể cả việc định dạng font chữ. 

 

 

2. Hiệu chỉnh WordArt:  

WordArt sau khi đã tạo, nếu không vừa ý bạn có thể thực hiện hiệu 

chỉnh với thao tác: 

o Chọn WordArt cần thực hiện hiệu chỉnh. 

o Lúc này, trên thanh thẻ lệnh sẽ xuất hiện nhóm lệnh Format. 

Bạn hãy chọn nhóm lệnh Format. 



  

    Mọi sự thực hiện hiệu chỉnh WordArt đều thực hiện trong 

nhóm WordArt Styles. 

o Quick Styles: lựa chọn thay đổi nhanh các mẫu hiệu ứng 

WordArt. 

o Fill text: thay đổi màu cho WordArt. 

o Text outline: lựa chọn màu nét viền cho WordArt. 

o Text Effects: các hiệu ứng khác đặc biệt áp dụng cho 

WordArt. 

Ngoài ra, bạn cũng có thể thực hiện một số thông số hiệu chỉnh 

WordArt trên hộp thoại Format Text Effects bằng cách nhấn chọn 

vào biểu tượng Format Text Effects trong nhóm các lệnh WordArt 

Styles. 



  

 

Để tạo bóng đổ cho WordArt, bạn chọn lớp Shadow. Các thông số 

hiệu chỉnh bóng đổ cho WordArt hiển thị: 

o Presets: lựa chọn các kiểu bóng đổ cho WordArt. 

o Color: lựa chọn màu sắc cho bóng đổ. 

o Transparency: tăng giảm giá trị trong suốt cho bóng đổ. 

o Size: tăng giảm kích thước bóng đổ. 

o Blur: tăng giảm độ nhoè bóng đổ. 

o Angle: thay đổi góc hiển thị bóng đổ so với WordArt. 

o Distance: thay đổi khoảng cách bóng đổ so với WordArt. 

o Thực hiện xong các giá trị hiệu chỉnh, nhấn Close để áp dụng và 

đóng hộp thoại Format Text Effects. 



 

Nếu bạn muốn tạo các hiệu ứng nổi 3 chiều, trong hộp thoại Format 

Text Effects bạn chọn lớp 3-D Format. 

 

o Bevel: lựa chọn hiệu ứng nổi. Bạn chọn trong hai 

ô Top và Bottom, ngoài các thông số lựa chọn được thiết lập 

sẵn, bạn có thể hiệu chỉnh thông số nổi theo ý muốn qua các 

ô Width và Height. 

o Depth: hiệu chỉnh thông số chiều sâu của WordArt. 

o Color: thay đổi màu. 



o Depth: thay đổi giá trị. 

o Contour: tạo các viền đồng tâm cho WordArt. 

o Color: màu sắc viền đồng tâm. 

o Size: kích thước viền đồng tâm. 

o Surface: tạo lớp mặt nạ bề mặt cho WordArt. 

o Material: lựa chọn chất liệu bề mặt cho WordArt. 

o Lighting: lựa chọn độ sáng cho vật liệu bề mặt WordArt. 

o Angle: lựa chọn góc chiếu sáng vật liệu WordArt. 

o Reset: quay lại các thông số mặc định ban đầu của WordArt. 

Lựa chọn xong các thông số, bạn nhấn Close để đóng hộp 

thoại Format Text Effects.  

 

Khi cần xoay góc các hiệu ứng 3 chiều cho WordArt, bạn chọn lớp 3-

D Rotation. 



 

o Presets: lựa chọn các mẫu hiệu ứng 3 chiều xoay. 

o Rotation: thay đổi giá trị các trục 

quay X, Y, Z, Perspective (giá trị trục nghiêng phẳng). Bạn 

nhấn chuột vào các biểu tượng lệnh , , 

, để thực hiện thay đổi giá trị. 

o Keep text flat: nếu ô tùy chọn này được chọn, WordArt sẽ 

không áp dụng hiệu ứng xoay 3 chiều mà trở về 

kiểu WordArt phẳng thông thường. 

  

 



Việc tạo WordArt trong môi trường PowerPoint 2007 hoàn toàn 

khác với PowerPoint 2003, có thể bạn hơi ngỡ ngàng khi bắt đầu làm 

quen. Nhưng khi bạn dã nắm vững thao tác thì sẽ trở nên dễ dàng và 

còn tạo được thêm nhiều kiểu hiệu ứng WordArt sáng tạo khác theo ý 

riêng của bạn tốt hơn so vớiPowerPoint 2003. 

 Excel 2007 toàn tập – Kỳ 14 – Chèn các đối tượng vào bảng 

tính – Chèn đối tượng Textbox  

 

1. Thao tác chèn Text Box: 

o Chọn thẻ lệnh Insert trên thanh thẻ lệnh 

 

o Chọn lệnh Text Box 

o Trên bảng tính, con trỏ chuột sẽ hiển thị thành biểu tượng   

o Bạn nhấn giữ chuột lên bảng tính và kéo để vẽ một khung Text 

Box 

 

Thả chuột ra, bạn sẽ được một Text Box 



 

o Tiếp theo bạn thực hiện nhập nội dung trong Text Box tương tự 

như thực hiện nhập nội dung trong trình soạn thảo văn 

bản Word. 

 

2. Hiệu chỉnh Text Box: 

Di chuyển, xoay và thay đổi kích thước: 

o Bạn nhấn giữ chuột vào các biểu tượng , ở các cạnh của Text 

Box để thực hiện thay đổi kích thước. 

o Nhấn giữ chuột lên biểu tượng và kéo để xoay Text Box. 

o Di chuyển chuột đến cạnh của Text Box, con trỏ chuột sẽ hiển 

thị thành biểu tượng , bạn nhấn giữ và kéo di chuyển đến vị 

trí mới. 

Thiết lập hiệu ứng, màu sắc và thay đổi hình dạng:  

Khi nhấn chuột chọn vào đối tượng Text Box, bạn sẽ thấy hiển thị 

nhóm lệnh Format trên thanh thẻ lệnh 

 



Thiết lập hiệu ứng: 

o Mọi thay đổi hiệu ứng cho đối tượng Text Box đều thực hiện 

trong nhóm lệnh Shape Styles 

 

o Bạn chọn các mẫu hiệu ứng trong ô , nhấn 

chọn biểu tượng More để xem và lựa chọn các hiệu ứng khác. 

 

 

  

Excel sẽ cung cấp cho bạn nhiều mẫu hiệu ứng Text Box rất đẹp. Nếu 

không muốn áp dụng các mẫu hiệu ứng phối sẵn, bạn có thể sử dụng 

các lệnh: 

o Shape Fill: thay đổi màu nền cho đối tượng vẽ. 

o Shape Outline: lựa chọn thay đổi màu cho nét viền đối tượng 

hình vẽ. 



o Shape Effects: lựa chọn và áp dụng thêm các hiệu ứng như: 

bóng đổ, 3 chiều nổi, . . . 

để tạo riêng cho bạn những hiệu ứng sáng tạo áp dụng cho Text Box.  

Thay đổi hình dáng: 

o Để thực hiện thay đổi hình dáng đối Text Box, bạn chọn đối 

tượng  Text Box cần thay đổi. 

o Chọn nhóm lệnh Format trên thanh thẻ lệnh. 

o Bạn chọn biểu tượng lệnh Edit Shape 

 

o Một menu lệnh hiển thị, bạn chọn lệnh Change Shape. 

 

Một danh sách các đối tượng hình vẽ hiển thị, bạn lựa chọn đối tượng 

hình thích hợp để thay thế dáng cho Text Box. 

 

 



 

Thao tác thực hiện hiệu chỉnh rất đơn giản, mọi thông số đều thể hiện 

cho bạn xem trước khi thay đổi. 

 Excel 2007 toàn tập – Kỳ 15 – Chèn các đối tượng vào bảng 

tính – Chèn ký tự đặc biệt vào bảng tính 

 

Để thực hiện chèn các ký tự đặc biệt vào bảng tính, bạn thao tác: 

o Chọn vị trí ô cần chèn trên bảng tính. 

o Chọn thẻ lệnh Insert trên thanh thẻ lệnh. 

 

o Chọn lệnh Symbol 

o Hộp thoại Symbol hiển thị: 



 

o Trong hộp thoại Symbols, bạn chọn ký tự cần chèn. Có thể chọn 

nhiều bảng ký tự khác nhau trong 

hộp Font . 

o Bạn Double click vào ký tự, hoặc click vào nút Insert . 

o Tương tự như vậy, bạn có thể chọn để chèn nhiều ký tự khác 

nhau vào ô của bảng tính. 

o Sau khi thực hiện chèn xong, click nút Cancel để đóng 

hộp thoại Symbols. 

Sau khi chèn các ký tự xong, bạn có thể thực hiện việc định dạng kích 

cỡ, màu sắc ký tự thể hiện trên ô bảng tính giống như bạn thực hiện 

đối với các ký tự chữ khác có trong ô. 
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I. khëi ®éng vµ mµn h×nh Excel  

1. Khëi ®éng  

Sau khi khëi ®éng WINdows lµm theo mét trong c¸c c¸ch sau  

- Nh¸y chuét vµo biÓu t−îng Microsoft Excel ë gãc trªn bªn ph¶i mµn h×nh. 

 

 

- NÕu dïng Win 3.1x, trong cöa sæ Microsoft Office ®· më chän biÓu t−îng 
Microsoft Excel råi nh¸y ®óp chuét. 

- NÕu dïng Win 95, nh¸y vµo Start / Program / Microsoft Excel  

 

2. Mµn h×nh 

a - C¸c thµnh phÇn cña mµn h×nh Excel 

Mµn h×nh cña Excel lµ mét cöa sæ ®· ®−îc phãng to vµ tr«ng gÇn gièng 
mµn h×nh cña Word, bao gåm c¸c thµnh phÇn sau :  

 - Thanh tiªu ®Ò (Title bar) : ë dßng trªn cïng cña mµn h×nh, khi  míi khëi 
®éng Excel t¹i ®©y ghi Microsoft Excel - Book1, khi ta ®Æt tªn cho b¶ng 
tÝnh, tªn nµy kÌm theo phÇn më réng . XLS sÏ thay thÕ tõ Book1. 

- C¸c thanh Menu, C«ng cô, §Þnh d¹ng gièng nh− cña Word. PhÇn lín c¸c 
biÓu t−îng trªn c¸c thanh nµy cã c«ng dông ý nghÜa nh− trong Word, ý 
nghÜa cña mét sè biÓu t−îng dïng riªng cho Excel ®−îc ghi trªn trang 3. 

- Thanh C«ng thøc (Formula Bar) : lµ dßng thø n¨m cña mµn h×nh hiÓn thÞ 
to¹ ®é (®Þa chØ hoÆc tªn) «, nót huû bá , nót lùa chän , néi dung d÷ 
liÖu trong « hiÖn t¹i (« cã khung viÒn chung quanh) 

- Thanh Tr¹ng th¸i (Status bar) : lµ dßng cuèi cïng hiÓn thÞ c¸c chÕ ®é ho¹t 
®éng cña Excel : 

Ready : §ang s½n sµng lµm viÖc. 
Enter : §ang nhËp d÷ liÖu hay c«ng thøc. 
Pointer : §ang ghi c«ng thøc tham chiÕu ®Õn mét ®Þa chØ. 
Edit : §ang ®iÒu chØnh d÷ liÖu hay c«ng thøc trong « hiÖn t¹i 

- Thanh thÎ tªn b¶ng tÝnh (Sheet tabs) : lµ dßng ngay trªn thanh Tr¹ng th¸i, 
hiÓn thÞ tªn cña c¸c b¶ng tÝnh (khi chóng ch−a ®−îc ®Æt tªn, t¹i ®©y ghi 
Sheet1, Sheet2, ..., Sheet16). Bªn tr¸i lµ c¸c nót chuyÓn tíi c¸c b¶ng tÝnh. 
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- Thanh cuén Däc (Vertical Scroll Bar), cuén Ngang (Horizontal Scroll Bar) 

gièng nh− trong Word. 

- Cöa sæ B¶ng tÝnh (Worksheet Window) lµ phÇn lín nhÊt dïng ®Ó nhËp d÷ 
liÖu, tÝnh to¸n, vÏ ®å thÞ nh− sau : 

 

b - C¸c thµnh phÇn cña cöa sæ B¶ng tÝnh : 
- Cét (Column) : Lµ tËp hîp c¸c « trong b¶ng tÝnh theo chiÒu däc ®−îc ®¸nh 

thø tù b»ng ch÷ c¸i (tõ tr¸i sang ph¶i b¾t ®Çu tõ A, B, C, ... 
AA, AB ®Õn IV, tæng sè cã 256 cét). Ngoµi cïng bªn tr¸i 
lµ nót chän (®¸nh dÊu khèi) toµn bé b¶ng tÝnh. 

- Hµng (Row) : Lµ tËp hîp c¸c « trong b¶ng tÝnh theo chiÒu ngang ®−îc 
®¸nh thø tù b»ng sè tõ 1 ®Õn 16.384).  

- « (Cell) :  Lµ giao cña mét cét vµ mét hµng. §Þa chØ cña « ®−îc x¸c 
®Þnh b»ng cét tr−íc, hµng sau, vÝ dô C4, AB25. 

« hiÖn t¹i : Lµ « cã khung viÒn chung quanh víi mét chÊm vu«ng nhá 
ë gãc ph¶i d−íi (Mèc ®iÒn) hay cßn gäi lµ Con trá « (sau 
®©y gäi t¾t lµ con trá). To¹ ®é cña « nµy ®−îc hiÓn thÞ trªn 
thanh C«ng thøc.  

- Con trá bµn phÝm :  Lµ v¹ch ®øng | nhÊp nh¸y ®Ó biÓu thÞ vÞ trÝ ký tù sÏ 
®−îc chÌn vµo. 

- Con trá chuét cã c¸c d¹ng sau :  
DÊu  ⎜ : dïng ®Ó ®−a con trá « vÒ vÞ trÝ nµo ®ã. 
DÊu   : dïng ®Ó chän lÖnh, biÓu t−îng hoÆc cuén b¶ng tÝnh. 

Hép Tªn (§Þa chØ) 
Nót chän toµn bé b¶ng tÝnh 

Mèc ®iÒn

Con trá «

Tªn cét

Sè thø tù hµng 

B¶ng tÝnh hiÖn t¹i 

ThÎ tªn b¶ng tÝnh

Thanh thÎ tªn b¶ng tÝnh

Nót chuyÓn tíi b¶ng tÝnh 
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ý nghÜa c¸c biÓu t−îng trªn thanh ®Þnh d¹ng 

(Formating) 
 

Font Color : MÇu ch÷ 

Color : MÇu nÒn 

Borders : §−êng viÒn 

Decrease Decimal : Bít ®i 1sâ thËp ph©n 

Increase Decimal : T¨ng thªm 1sâ th.p. 
 

 

 

Comma Style : DÊu ţ ch ngh×n, triÖu, tû 

Percent Style: Nh©n víi 100 vµ ®iÒn dÊu % 

Currency Style : §iÒn dÊu tiÒn tÖ 

Center Accross Columns : C¨n vµo gi÷a cña nhiÒu « 
 

ý nghÜa c¸c thµnh phÇn cña thanh c«ng thøc 

(FormULA BAR) 
 

Hép Tªn (§Þa chØ ) « hiÖn t¹i Néi dung « hiÖn t¹i 
 

 

Nót gäi hµm  
Nót huû bá néi dung võa gâ Nót ®iÒn néi dung võa gâ 
 
 

II. c¸c thao t¸c víi b¶ng tÝnh 

1. L−u (ghi) b¶ng tÝnh lªn ®Üa 
Chän biÓu t−îng Save hoÆc môc File, Save. NÕu ®©y lµ lÇn ®Çu tiªn 

thùc hiÖn thao t¸c nµy víi b¶ng tÝnh, ta ph¶i gâ vµo tªn cho b¶ng tÝnh trong 
« File Name theo quy t¾c ®Æt tªn tÖp cña DOS, Excel sÏ tù g¸n kiÓu .XLS 
cho nã. Tªn b¶ng tÝnh sÏ xuÊt hiÖn trªn thanh tiªu ®Ò cña cöa sæ. 

Sau ®ã trong qu¸ tr×nh lµm viÖc, ta th−êng xuyªn ghi b¶ng tÝnh lªn ®Üa 
b»ng c¸ch trªn mµ kh«ng cÇn ®Æt tªn cho nã.  

NÕu ta cÇn l−u gi÷ b¶ng tÝnh víi tªn kh¸c, chän môc File, Save As vµ 
®Æt tªn míi cho nã. 
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2. Më b¶ng tÝnh ®∙ cã trªn ®Üa 
Chän biÓu t−îng Open hoÆc môc File, Open. XuÊt hiÖn hép tho¹i Open 

víi danh s¸ch c¸c b¶ng tÝnh trong khung File Name ®−îc xÕp theo thø tù 
A,B,C. Ta chän tÖp cÇn thiÕt råi chän OK. NÕu b¶ng tÝnh ta cÇn l¹i ë trªn 
®Üa kh¸c hoÆc th− môc kh¸c, ta chän ®Üa tõ « Drives, nh¸y ®óp t¹i th− môc 
cÇn thiÕt cña khung Directories 

Excel cßn cã c¸ch më b¶ng tÝnh kh¸c: chän môc File, xuÊt hiÖn Menu 
däc víi danh s¸ch 4* b¶ng tÝnh míi lµm gÇn nhÊt ë phÝa d−íi. Ta chän tÖp 
cÇn thiÕt tõ danh s¸ch nµy. Danh s¸ch c¸c b¶ng tÝnh nµy cã thÓ nhiÒu h¬n 
tuú thuéc vµo ng−êi cµi ®Æt.   

3. §ãng b¶ng tÝnh 
Tr−íc khi chuyÓn sang b¶ng tÝnh kh¸c hoÆc lµm viÖc kh¸c, ph¶i ghi tÖp 

lªn ®Üa sau ®ã míi ®ãng nã b»ng c¸ch chän môc File, Close. NÕu  quªn 
ch−a ghi tÖp lªn ®Üa, Excel sÏ hái : 

Do you want to save change to <FileName>. XLS ? 
Chän Yes ®Ó ghi l¹i, No ®Ó kh«ng ghi nh÷ng thay ®æi võa t¹o ra cho 

b¶ng tÝnh. 

4. ChÌn thªm 1 b¶ng tÝnh 
- Insert / Worksheet, hoÆc  
- Nh¸y nót ph¶i chuét trªn thanh thÎ tªn b¶ng tÝnh ®Ó gäi Menu t¾t (sau ®©y 

chóng ta quy −íc gäi thao t¸c nµy lµ [Menu t¾t], chän Insert Worksheet 

5. Xo¸ bít 1 b¶ng tÝnh 

- Edit, Delete Sheet, hoÆc  
- [Menu t¾t], Delete sheet 

6. §æi tªn b¶ng tÝnh 
- Nh¸y ®óp vµo thÎ tªn (tøc lµ vµo tªn b¶ng tÝnh, sau  ®©y chóng ta quy −íc 

gäi  lµ thÎ tªn) trªn thanh thÎ tªn hoÆc Format / Sheet / Rename hoÆc 
[Menu t¾t], Rename 

- Gâ vµo tªn míi,  ↵ hoÆc OK 

7. Sao chÐp / ChuyÓn 1 b¶ng tÝnh 
C¸ch 1: Gi÷ Ctrl trong khi kÐo th¶ thÎ tªn t¹i mét thÎ tªn kh¸c (Sheet 

kh¸c).  NÕu kh«ng gi÷ Ctrl b¶ng tÝnh sÏ ®−îc chuyÓn ®i. 
C¸ch 2: Edit, Move or Copy Sheet. Chän vÞ trÝ ®Æt b¶ng tÝnh hiÖn t¹i tr−íc 

b¶ng tÝnh nµo trong khung Before Sheet. NÕu ®¸nh dÊu chän vµo 
Creat a Copy, Excel sÏ sao chÐp b¶ng tÝnh chø kh«ng chuyÓn nã. 

                                           
* Con sè nµy cã thÓ kh¸c, tuú thuéc vµo viÖc chän Tools, Options, Recently Used Files 

List  
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ChØ dïng c¸ch 2 nÕu b¶ng tÝnh nguån vµ ®Ých c¸ch xa nhau (kh«ng 
thÊy thÎ tªn cña chóng cïng mét lóc). 

8. T¸ch b¶ng tÝnh 

Cã 3 c¸ch gióp ta ®ång thêi thÊy nh÷ng phÇn kh¸c nhau cña b¶ng tÝnh 
C¸ch 1: Trá chuét vµo thanh t¸ch cho xuÊt hiÖn mòi tªn 2 ®Çu, kÐo th¶ nã 

t¹i vÞ trÝ cÇn t¸ch. 
C¸ch 2: §−a con trá « vÒ vÞ trÝ cÇn t¸ch, chän môc Window / Split. Sau ®ã 

®Ó bá t¸ch chän Window / Remove Split 
C¸ch 3: §−a con trá « vÒ vÞ trÝ cÇn t¸ch, chän môc Window / Freeze Panes. 

Sau ®ã ®Ó bá t¸ch chän Window / Unfreeze Panes 

9. Èn vµ hiÖn l¹i 1 b¶ng tÝnh 

- Chän Format, Sheet, Hide ®Ó ¶n b¶ng tÝnh 
- §Ó hiÖn l¹i b¶ng tÝnh Format, Sheet, Unhide 

10. B¶o vÖ b¶ng tÝnh 
§Ó nh÷ng thiÕt lËp vÒ B¶o vÖ vµ che giÊu « (xem trang 26) cã t¸c dông, 

cÇn b¶o vÖ b¶ng tÝnh. C¸ch lµm nh− sau : 
- Tool / Protection 
- Chän Protect Sheet ®Ó b¶o vÖ b¶ng tÝnh, chän Protect Workbook ®Ó b¶o vÖ 

tËp b¶ng tÝnh. 
- NÕu cÇn thiÕt gâ mËt khÈu vµo vïng Password. 2 lÇn gâ ph¶i gièng nhau 

vµ l−u ý r»ng mËt khÈu trong Excel ph©n biÖt ch÷ hoa víi ch÷ th−êng ! 
- §Ó bá t×nh tr¹ng b¶o vÖ : chän Tool / Protection / Unprotect Sheet hay 

Unprotect Workbook. NÕu cã mËt khÈu, ph¶i gâ vµo, nÕu ®óng ta míi cËp 
nhËt ®−îc b¶ng tÝnh.  

11. Chän nhiÒu b¶ng tÝnh 

a. LiÒn kÒ :  Nh¸y chuét vµo thÎ tªn ®Çu, gi÷ Shift  trong khi nh¸y chuét 
vµo thÎ tªn cuèi 

b. C¸ch nhau : Gi÷ Ctrl trong khi lÇn l−ît nh¸y chuét vµo c¸c thÎ tªn 
c. §Ó bá viÖc chän mét b¶ng tÝnh nµo : gi÷ Ctrl trong khi  nh¸y chuét vµo 

thÎ tªn cña b¶ng tÝnh ®ã 

IIi. Xö lý d÷ liÖu trong b¶ng tÝnh 

1. C¸c kiÓu d÷ liÖu 
Trong mçi « chØ cã thÓ chøa mét kiÓu d÷ liÖu. KiÓu  d÷ liÖu cña « phô 

thuéc vµo ký tù ®Çu tiªn gâ vµo. C¸c kiÓu d÷ liÖu trong mét « ®−îc ph©n ra 
nh− sau : 

a - D¹ng chuçi (Text) 
- B¾t ®Çu bëi c¸c ch÷ c¸i a ®Õn z  hoÆc A ®Õn Z 
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- Nh÷ng d÷ liÖu chuçi d¹ng sè nh− : sè ®iÖn tho¹i, sè nhµ, m· sè, .v.v. 
khi nhËp vµo ph¶i b¾t ®Çu b»ng dÊu nh¸y ®¬n (') vµ kh«ng cã gi¸ trÞ tÝnh 
to¸n. 

- Theo mÆc ®Þnh, d÷ liÖu d¹ng chuçi  ®−îc c¨n sang tr¸i «. 

b - D¹ng sè (Number)  
B¾t ®Çu bëi : - C¸c sè tõ 0 ®Õn 9. 

- C¸c dÊu  +, - , (, *,  $ (hoÆc mét dÊu ®¬n vÞ tiÒn kh¸c tuú 
thuéc vµo viÖc ®Æt c¸c th«ng sè quèc tÕ cña Windows). 

- Theo mÆc ®Þnh, d÷ liÖu d¹ng sè  ®−îc c¨n sang ph¶i «. 

c - D¹ng c«ng thøc (Formulas) 

B¾t ®Çu bëi c¸c dÊu = hoÆc +. Sau khi Ên ↵ c«ng thøc nhËp vµo chØ 
thÓ hiÖn trªn thanh c«ng thøc cßn kÕt qu¶ cña nã ®−îc thÓ hiÖn trong «. 

NÕu thÊy : Cã thÓ lµ do : 
##### :  Cét qu¸ hÑp 
#DIV/0! :  Chia cho 0 
#NAME? :  Thùc hiÖn phÐp tÝnh víi mét biÕn kh«ng x¸c ®Þnh 

(tªn kh«ng g¾n víi mét « hay mét vïng nµo c¶) 
#N/A :  Tham chiÕu ®Õn mét « rçng hoÆc kh«ng cã trong 

danh s¸ch 
#VALUE! :  Sai vÒ kiÓu cña to¸n h¹ng (vÝ dô : lÊy sè chia cho ký 

tù hoÆc ngµy th¸ng) 

d - D¹ng Ngµy (Date), giê (Time) 

Trong c¸ch tr×nh bµy d−íi ®©y : 
DD lµ 2 con sè chØ Ngµy 
MM lµ 2 con sè chØ Th¸ng 
YY lµ 2 con sè chØ  N¨m 

NhËp theo d¹ng MM/DD/YY hoÆc DD/MM/YY tuú thuéc vµo viÖc 
®Æt c¸c th«ng sè quèc tÕ cña Windows, vÝ dô nÕu ®Æt th«ng sè quèc tÕ 
kiÓu Ph¸p, ta gâ vµo 27/09/04, tr−êng hîp dïng kiÓu Mü (ngÇm ®Þnh) ta 
gâ vµo 09/27/04. Khi nhËp sai d¹ng thøc, Excel tù ®éng chuyÓn sang 
d¹ng chuçi (c¨n sang tr¸i «) vµ ta kh«ng thÓ dïng d÷ liÖu kiÓu nµy ®Ó 
tÝnh to¸n. 

Cã thÓ nhËp ngµy b»ng c¸ch : 
- nhËp hµm =DATE(YY,MM,DD), ®©y lµ c¸ch nhËp ngµy tèt nhÊt. 
- sau ®ã chän Format, Cells, Number, Date vµ chän d¹ng thÓ hiÖn 

ngµy ë khung bªn ph¶i. 

§Æc biÖt : Ctrl + ; (dÊu chÊm phÈy)  cho Ngµy hÖ thèng 
 Ctrl + Shift + ;  cho Giê hÖ thèng 

- Theo mÆc ®Þnh, d÷ liÖu d¹ng ngµy th¸ng ®−îc c¨n sang ph¶i «. 
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2. C¸c to¸n tö trong c«ng thøc 

a - To¸n tö sè 
+ céng -  trõ 

* nh©n (vÝ dô = 10*50 cho kÕt qu¶   500) 

/ chia = 126/3 42 

^ luü thõa = 5^2 25 

% phÇn tr¨m = 50%*600 300 

Thø tù −u tiªn cña c¸c phÐp to¸n nh− sau : luü thõa tr−íc råi ®Õn nh©n 
chia vµ sau cïng míi ®Õn céng trõ. C¸c phÐp to¸n cïng møc −u tiªn (nh− 
nh©n chia hoÆc céng trõ) thùc hiÖn tõ tr¸i sang ph¶i. Muèn thay ®æi thø tù −u 
tiªn, dïng c¸c cÆp ngoÆc trßn, to¸n tö trong cÆp ngoÆc ë s©u nhÊt sÏ ®−îc 
thùc hiÖn tr−íc. VÝ dô:  c¸c « A1, B1, C1 chøa c¸c sè 2,3, 4, nÕu trong « D1 gâ 
=A1+B1*C1 sÏ ®−îc kÕt qu¶ 14, gâ =(A1+B1)*C1 sÏ ®−îc kÕt qu¶ 20.    

b - To¸n tö chuçi 
& Nèi chuçi ="Tin "&"hoc" Tin häc 

c - To¸n tö so s¸nh  
>  lín h¬n >= lín h¬n hoÆc b»ng < > kh¸c 
<  nhá h¬n <= nhá h¬n hoÆc b»ng 

C¸c to¸n tö so s¸nh cho kÕt qu¶ lµ True (§óng) hoÆc False (Sai). VÝ dô, 
trong « A1 ®ang cã sè 26, « B1 cã sè -125. NÕu t¹i « C1 gâ c«ng thøc 

= A1>B1 sÏ nhËn ®−îc kÕt qu¶ TRUE 

= A1<=B1 sÏ nhËn ®−îc kÕt qu¶ FALSE, v.v.. 

3. NhËp d÷ liÖu 

a - D÷ liÖu bÊt kú 
- §−a con trá « vÒ « cÇn thiÕt. 
- NhËp d÷ liÖu theo lo¹i d¹ng thøc. 
- §Ó kÕt thóc viÖc nhËp d÷ liÖu, lµm theo mét trong c¸c c¸ch sau : 

• Ên phÝm Enter, con trá « sÏ xuèng « d−íi. 

• Ên mét phÝm mòi tªn ®Ó ®−a con trá « sang « cÇn thiÕt, vÝ dô Ên phÝm 
→ sÏ ®−a con trá « sang bªn ph¶i. 

• Chän nót  (mµu xanh l¸ c©y) trªn thanh c«ng thøc. 
• Trá chuét vµo « cÇn tíi, Ên nót tr¸i. 
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Cã thÓ dïng miÒn nhËp d÷ liÖu sau ®©y: 
Gi¶ sö cÇn nhËp 2 cét : 

Dòng 200   
V©n 300 
Khoa 150 
TuÊn 180 
Hµ 250 

vµo c¸c « A1: B5. Ta lµm theo c¸c b−íc 
sau : 

- §¸nh dÊu khèi miÒn A1:B5 (xem trang 13 vÒ c¸ch ®¸nh dÊu khèi)  
- §Ó nhËp theo tõng hµng, Ên phÝm Tab sau mçi lÇn gâ d÷ liÖu vµo mét «. 
- §Ó nhËp theo tõng cét, Ên phÝm ↵ sau mçi lÇn gâ d÷ liÖu vµo mét «. 

H−íng dÞch chuyÓn cña « nhËp d÷ liÖu khi Ên Tab hoÆc ↵ : 

 A B   A B 

1    1   

2    2   

3    3   

4    4   

5    5   

Ên Tab   Ên ↵ 

b. D÷ liÖu trong c¸c « gièng nhau :  
- §¸nh dÊu khèi miÒn cÇn ®iÒn d÷ liÖu (vÝ dô A1:B5) 
- Gâ vµo d÷ liÖu (vÝ dô sè 2000) 

- KÕt thóc viÖc nhËp b»ng c¸ch Ên phÝm Ctrl + ↵. 
KÕt qu¶ lµ : miÒn A1:B5 sÏ ®−îc ®iÒn kÝn bëi sè 2000 

c. D÷ liÖu trong c¸c « tu©n theo mét quy luËt 

• Chuçi sè víi b−íc nh¶y lµ 1: 
- §−a con trá vÒ « ®Çu tiªn cña miÒn, gâ vµo sè b¾t ®Çu, vÝ dô ®Ó 

®¸nh sè thø tù cho mét sè « b¾t ®Çu tõ 1, ta gâ 1. 
- Trá chuét vµo mèc ®iÒn cho xuÊt hiÖn dÊu + mµu ®en, gi÷ phÝm Ctrl 

trong khi kÐo vµ th¶ chuét t¹i « cuèi cña miÒn (tõ ®©y vÒ sau ta gäi 
thao t¸c nµy lµ ®iÒn tù ®éng (AutoFill)). KÕt qu¶ ta ®−îc chuçi sè 1, 
2, 3, ... 

• Chuçi sè víi b−íc nh¶y bÊt kú: 
- §−a con trá vÒ « ®Çu tiªn cña miÒn, gâ vµo sè b¾t ®Çu, vÝ dô ®Ó cã 

chuçi sè ch½n ta gâ 2 vµo mét « nµo ®ã. 
- VÒ « d−íi (hoÆc bªn ph¶i) cña miÒn, gâ vµo sè tiÕp theo, vÝ dô 4. 
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- §¸nh dÊu khèi 2 « nµy, trá chuét vµo mèc ®iÒn cho xuÊt hiÖn dÊu + 
mµu ®en, kÐo vµ th¶ chuét t¹i « cuèi cña miÒn. 

 A B  
1 2   
2 4   
3    
4    
5    
6    
7    

• Chuçi Ngµy th¸ng t¨ng : 
- §−a con trá vÒ « ®Çu tiªn cña miÒn, gâ vµo ngµy th¸ng n¨m b¾t ®Çu. 
-  Trá chuét vµo mèc ®iÒn cho xuÊt hiÖn dÊu +, bÊm gi÷ nót ph¶i, kÐo 

th¶ t¹i « cuèi miÒn. 
- Trong menu t¾t chän : 

Fill Days : ®Ó t¨ng 1 ngµy (vÝ dô : 15/04/1999, 16/04/1999, 17/04/1999) 
Fill Months : ®Ó t¨ng 1 th¸ng (vÝ dô : 15/04/1999, 15/05/1999, 15/06/1999) 
Fill Years : ®Ó t¨ng 1 n¨m(vÝ dô : 15/04/1999, 15/05/2000, 15/06/2001) 

• §iÒn mét danh s¸ch tù  t¹o : 
- NÕu danh s¸ch nµy ch−a cã th× ph¶i t¹o b»ng c¸ch : 

- Tools / Option / Custom List 
- Trong khung List Entries lÇn l−ît nhËp c¸c gi¸ trÞ cho danh s¸ch, hÕt 

mçi gi¸ trÞ bÊm ↵ ®Ó xuèng dßng. VÝ dô : Thø Hai ↵ Thø Ba ↵. Cuèi 
cïng ta ®−îc nh− h×nh sau :  

 
- OK  

- §Ó sö dông :  
- nhËp mét gi¸ trÞ cã trong danh s¸ch tù t¹o vµo « ®Çu 
- ®iÒn tù ®éng tíi « cuèi miÒn (xem c¸ch ®iÒn  tù ®éng ë trang 9). 

KÐo dÊu + vµ th¶ t¹i « 
A7, ta sÏ ®−îc chuçi 
sè 2,4,6,8,10,12,14 tai 
miÒn A1:A7 
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d. D÷ liÖu kiÓu c«ng thøc 
- Ph¶i b¾t ®Çu bëi dÊu = hoÆc c¸c dÊu +, − 
- Khi cÇn lÊy sè liÖu ë « nµo nh¸y chuét vµo « ®ã hoÆc gâ vµo ®Þa chØ « 

VÝ dô : ®Ó tÝnh L−¬ng theo c«ng thøc : L−¬ng = Sè NC x TiÒn 1 Ngµy 
lµm theo c¸c b−íc sau : 

1. Chän miÒn E2:E7 (v× c«ng thøc tÝnh trong miÒn gièng nhau : ®Òu lÊy sè ë 
cét C nh©n víi sè ë cét D- xem phÇn b. ë trªn) 

2. Gâ vµo dÊu = 
3. Trá chuét vµo « C2, Ên nót tr¸i (hoÆc gâ C2) 
4. Gâ dÊu * 
5. Trá chuét vµo « D2, Ên nót tr¸i (hoÆc gâ D2). T¹i « E2 vµ thanh c«ng 

thøc xuÊt hiÖn = C2*D2 

6. Ên  Ctrl + ↵. T¹i c¸c « tõ E2 ®Õn E7, Excel cho kÕt qu¶ tÝnh L−¬ng cña tõng 
ng−êi. 

Ta còng cã thÓ lµm nh− sau : 

- Bá qua b−íc 1 
- Thùc hiÖn c¸c b−íc tõ 2 ®Õn 5, sau b−íc 5 chän nót  trªn thanh c«ng 

thøc (hoÆc Ên ↵) 
- §Ó tÝnh L−¬ng cho nh÷ng ng−êi cßn l¹i, ®−a con trá vÒ « E2, ®iÒn tù ®éng 

cho tíi « E7. 

 A B C D E F 

1 STT Tªn Sè NC TiÒn 
1 Ngµy

L−¬ng Tû lÖ 

2 1 LuËn 20 50 = C2*D2 =E2/$E$8 

3 2 Uyªn 26 40   

4 3 H¶i 18 35   

5 4 Minh 22 45   

6 5 TuÊn 15 20   

7 6 H»ng 16 25   

8  Céng   =SUM(E2:E7)  

•  TÝnh tû lÖ phÇn tr¨m L−¬ng cña tõng ng−êi so víi Tæng L−¬ng : 
1. §−a con trá vÒ « F2 
2. Gâ vµo dÊu =, dïng chuét chän « E2 (hoÆc gâ E2), gâ dÊu /, nh¸y chuét 

vµo « E8 (hoÆc gâ E8). Chän nót  trªn thanh c«ng thøc (hoÆc Ên ↵) 
3. §Ó tÝnh Tû lÖ cho nh÷ng ng−êi cßn l¹i, ®−a con trá vÒ « F2, sao chÐp 

c«ng thøc tÝnh b»ng c¸ch ®iÒn tù ®éng cho tíi « F7. 

T¹i c¸c « F3:F7 xuÊt hiÖn #DIV/0! (chia cho 0). Khi ®−a con trá vÒ « 
F3, ta thÊy trªn thanh c«ng thøc ghi = E3/E9, Excel ®· lÊy sè ë « bªn tr¸i 
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(E3) chia cho sè ë c¸ch ®ã 6 « (E9), ... tøc lµ ®· sö dông ®Þa chØ t−¬ng ®èi. 
§Ó b¸o cho Excel lÊy lÇn l−ît c¸c sè tõ E2 ®Õn E7 chia cho sè cè ®Þnh ë « 
E8 (« nµy lµ ®Þa chØ tuyÖt ®èi), ta lµm nh− sau :  

- §−a con trá « vÒ E2, nh¸y ®óp nót chuét, sau ®ã ®−a con trá bµn phÝm vÒ 
ngay tr−íc ký hiÖu E8, Ên phÝm F4, dÊu $ ®−îc ®iÒn vµo tr−íc vµ gi÷a ký 
hiÖu ®ã, Ên ↵ råi copy c«ng thøc nµy xuèn « E7.  

- §¸nh dÊu khèi c¸c « tõ E2 ®Õn E7 (xem phÇn 5a d−íi ®©y), chän biÓu 
t−îng % (Percent Style) trªn thanh ®Þnh d¹ng, Excel ®æi ra d¹ng phÇn 
tr¨m vµ ®iÒn dÊu % cho c¸c sè. §Ó lÊy chÝnh x¸c h¬n, ta chän c¸c « nµy 
råi chän biÓu t−îng Increase Decimal, mçi lÇn Ên chuét t¹i biÓu t−îng 
nµy, c¸c con sè l¹i ®−îc thªm mét sè thËp ph©n. 

• TÝnh Tæng L−¬ng vµ ghi vµo « E8: 

- §−a con trá vÒ « E8 
- Gâ vµo dÊu =, trá chuét vµo biÓu t−îng ∑ (AutoSum), nh¸y ®óp. NÕu dïng 

bµn phÝm, gâ vµo c«ng thøc =SUM(E2:E7) 

e. C«ng thøc m¶ng 
Ngoµi viÖc sao chÐp c«ng thøc t−¬ng ®èi nh− trªn, Excel cßn cung cÊp 

mét ph−¬ng tiÖn kh¸c gän gµng h¬, ®ã lµ m¶ng (array) 
M¶ng ®−îc dïng khi ta gÆp ph¶i mét l−îng tÝnh to¸n nhiÒu vµ phøc t¹p 

trªn mét vÞ trÝ nhá hÑp, hoÆc dïng ®Ó thay thÕ c¸c c«ng thøc cÇn lÆp l¹i 
nhiÒu lÇn, m¶ng gióp tiÕt kiÖm ®−îc bé nhí (thay v× ph¶i cã 100 c«ng thøc 
sao chÐp vµo 100 «, chØ cÇn mét c«ng thøc m¶ng lµ ®ñ). 

• NhËp mét c«ng thøc m¶ng (array formula): 
- VÒ « cÇn thiÕt, nÕu lµ d·y «, ph¶i ®¸nh dÊu khèi chóng (xem trang 13). ë 

vÝ dô trªn b«i ®en miÒn E2:E7. 
- Kh¸c víi lo¹i c«ng thøc t−¬ng ®èi (trong vÝ dô trªn lµ = C2*D2), ë ®©y 

ph¶i nhËp toµn bé d·y « : =C2:C7*D2:D7. 
- KÕt thóc ph¶i Ên Ctrl + Shift + ↵ (gi÷ ®ång thêi 2 phÝm Ctrl vµ Shift 

trong khi Ên ↵). Excel sÏ bao c«ng thøc m¶ng nµy trong cÆp ngoÆc nhän : 
{=C2:C7*D2:D7)]} 

• Söa mét c«ng thøc m¶ng : 
- VÒ « bÊt kú ®· ¸p dông c«ng thøc m¶ng cÇn söa 
- Nh¸y chuét lªn thanh c«ng thøc. C¸c dÊu ngoÆc { } biÕn mÊt. 

- TiÕn hµnh söa c«ng thøc. Söa xong bÊm Ctrl + Shift + ↵ 
• ChØ ®Þnh (b«i ®en) mét d·y m¶ng :  
VÒ « bÊt kú cña d·y m¶ng lµm theo mét trong hai c¸ch sau : 
C¸ch 1 : BÊm Ctrl + /  (gi÷ phÝm Ctrl trong khi Ên phÝm sæ chÐo xu«i) 
C¸ch 2 : BÊm F5, chän Special sau ®ã chän Current Array 
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- Ên gi÷ phÝm Ctrl vµ chän miÒn liªn tôc E4:G7 
- Gi÷ nguyªn phÝm Ctrl vµ chän miÒn liªn tôc C9:F11 

 

b - Copy, xo¸, d¸n khèi dïng bé nhí ®Öm (th−êng dïng khi miÒn ®Ých vµ 
miÒn nguån c¸ch nhau  hoÆc ®Ó d¸n mét khèi vµo nhiÒu chç kh¸c 
nhau). Tr−íc khi thùc hiÖn c¸c thao t¸c sau, ta ph¶i chän khèi cÇn thiÕt. 

+ Copy : Chän biÓu t−îng Copy, hoÆc Ên Ctrl+C, hoÆc chän môc Edit, Copy. 

+ Xo¸ : Chän biÓu t−îng Cut, hoÆc Ên Ctrl+X, hoÆc chän môc Edit, Cut. 

+ LÊy khèi tõ bé nhí ®Öm ra d¸n vµo b¶ng tÝnh 

- §−a con trá « tíi gãc tr¸i trªn cña miÒn ®Ých. 

- Chän biÓu t−îng Paste, hoÆc Ên Ctrl+V, hoÆc chän môc Edit, Past. 

c - Copy, chuyÓn khèi dïng chuét  
- Chän khèi cÇn thiÕt 
- Trá chuét vµo biªn cña khèi sao cho xuÊt hiÖn . Sau ®ã thùc hiÖn 

mét trong c¸c thao t¸c sau : 
+ Gi÷ Ctrl ®ång thêi kÐo vµ th¶ khèi t¹i vÞ trÝ ®Ých ®Ó Copy khèi. 

NÕu trong b−íc nµy kh«ng dïng phÝm Ctrl th× khèi sÏ ®−îc 
chuyÓn tíi vÞ trÝ ®Ých, hoÆc  

+ BÊm gi÷ nót ph¶i chuét, kÐo vµ th¶ khèi t¹i vÞ trÝ ®Ých. XuÊt hiÖn 
thùc ®¬n cho phÐp chän mét trong c¸c ph−¬ng ¸n. 

Copy : Copy toµn bé, bao gåm c¶ d÷ liÖu vµ khu«n dang. 
Move : ChuyÓn d÷ liÖu. 
Copy Value : ChØ copy d÷ liÖu. 
Copy Format : ChØ copy khu«n d¹ng. 

Chó ý : Khi copy d÷ liÖu  
- NÕu miÒn nguån chøa d÷ liÖu sè hoÆc chuçi, kÕt qu¶ miÒn ®Ých sÏ gièng 

miÒn nguån. 
- NÕu miÒn nguån chøa c«ng thøc, kÕt qu¶ miÒn ®Ých sÏ thay ®æi hay 

kh«ng tuú thuéc vµo c«ng thøc trong miÒn nguån tham chiÕu ®Õn ®Þa 
chØ t−¬ng ®èi hay ®Þa chØ tuyÖt ®èi. 
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6. Xö lý «, cét, hµng trong b¶ng tÝnh  

a - Thay ®æi kÝch th−íc cét, hµng 

• Mét cét / mét hµng : 
- Cét : Trá chuét vµo v¹ch ®øng ë bªn ph¶i tªn cét sao cho xuÊt hiÖn   

╫  , kÐo vµ th¶ v¹ch ®ã t¹i vÞ trÝ míi. 
- Hµng : Trá chuét vµo v¹ch ngang d−íi sè thø tù hµng sao cho xuÊt 

hiÖn   ╪  , kÐo vµ th¶ v¹ch 
®ã t¹i vÞ trÝ míi. 

 
 
 

 

 

 

 

 

 

 

• NhiÒu cét / NhiÒu hµng : 

- Cét : - Chän mét sè « cña c¸c cét. 
 - Format, Colum, Width. 
 - Gâ vµo ®é réng míi cho c¸c cét 
 - OK hoÆc ↵  

- Hµng : - Chän mét sè « cña c¸c hµng. 
 - Format, Row, Height. 
 - Gâ vµo chiÒu cao míi cho c¸c hµng 
 - OK hoÆc ↵  

b - ChÌn thªm cét, hµng, « 

• Cét : 

- Chän khèi lµ tªn c¸c cét (c¸c ch÷ A, B, ...) t¹i vÞ trÝ cÇn chÌn, cÇn thªm 
bao nhiªu cét ta chän bÊy nhiªu. 

- Chän Insert, Columns. Excel sÏ chÌn thªm c¸c cét trèng vµ ®Èy c¸c 
cét ®−îc chän sang ph¶i 

• Hµng : 
- Chän khèi lµ sè thø tù cña c¸c hµng (c¸c sè 1, 2, ...) t¹i vÞ trÝ cÇn chÌn, 

cÇn thªm bao nhiªu hµng ta chän bÊy nhiªu. 
- Chän Insert, Rows. Excel sÏ chÌn thªm c¸c hµng trèng vµ ®Èy c¸c 

hµng ®−îc chän xuèng d−íi. 

KÐo vµ th¶ v¹ch nµy t¹i vÞ trÝ míi 
®Ó thay ®æi ®é réng cét C 

KÐo vµ th¶ v¹ch nµy t¹i vÞ trÝ míi ®Ó 
thay ®æi chiÒu cao hµng 4 
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• é : 
- Chän khèi lµ c¸c « t¹i vÞ trÝ cÇn chÌn (nh− ë vÝ dô d−íi ®©y lµ c¸c « 

C3:D4), cÇn thªm bao nhiªu « ta chän bÊy nhiªu. 
- Chän Insert, Cells. xuÊt hiÖn hép tho¹i Insert 

 
Chän §Ó 
- Shift Cells Right  : ®Èy c¸c « ®−îc chän sang ph¶i 
- Shift Cells Left  : ®Èy c¸c « ®−îc chän xuèng d−íi 
- OK hoÆc ↵  : thùc hiÖn lÖnh 

c - Xo¸ cét, hµng, « 

Cét : - Chän khèi lµ tªn c¸c cét (c¸c ch÷ A, B, ...) t¹i vÞ trÝ cÇn xo¸, 
cÇn xo¸ bao nhiªu cét ta chän bÊy nhiªu. 

 - Chän Edit, Delete. 
Hµng : - Chän khèi lµ sè thø tù c¸c hµng (c¸c sè 1, 2, ...) t¹i vÞ trÝ cÇn 

xo¸, cÇn xo¸ bao nhiªu cét ta chän bÊy nhiªu. 
 - Chän Edit, Delete. 

« :  - Chän khèi lµ c¸c « cÇn xo .̧ 

  - Chän Edit, Delete.   

XuÊt hiÖn hép tho¹i Delete 

Chän §Ó 
- Shift Cells Left  : chuyÓn d÷ liÖu cña c¸c « 

bªn ph¶i sang vïng bÞ xo¸ 
- Shift Cells Up  : chuyÓn d÷ liÖu cña c¸c « 
phÝa d−íi lªn vïng bÞ xo¸. 
- Entire Row  : xo¸ toµn bé c¸c hµng chøa vïng ®−îc chän. 
- Entire Column  : xo¸ toµn bé c¸c cét chøa vïng ®−îc chän. 

- OK hoÆc ↵  : thùc hiÖn lÖnh 

d - ChuyÓn hµng thµnh cét vµ ng−îc l¹i 

Gi¶ sö cÇn chuyÓn d÷ liÖu ®ang ®−îc xÕp thµnh cét trong c¸c « A2:A6 
thµnh hµng t¹i c¸c « C3:F3, ta lµm nh− sau : 
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 A B C D E F G 
1        
2 STT       
3 Tªn  STT Tªn To¸n Tin Anh 
4 To¸n       
5 Tin       
6 Anh       

        

- Chän c¸c « muèn cho ®æi chç hay cßn gäi lµ miÒn nguån (A2:A6)  
- Chän biÓu t−îng Copy hoÆc Ctrl+C 
- §−a con trá vÒ « ®Çu tiªn cña miÒn d¸n (C3). 
- Chän môc Edit, Past Special, ®¸nh dÊu chän « Transpose 
- OK 

 Chó ý : MiÒn nguån vµ miÒn d¸n kh«ng ®−îc giao nhau (kh«ng ®−îc cã 
« chung) 

 f - Èn/ hiÖn  cét, hµng 
§Ó tiÖn cho thao t¸c, trªn c¸c b¶ng tÝnh, nhÊt lµ c¸c b¶ng tÝnh lín, ng−êi 

ta th−êng cho Èn c¸c cét (hoÆc hµng) kh«ng cÇn thiÕt. Khi nµo cÇn l¹i cho 
chóng hiÖn trë l¹i. C¸ch lµm nh− sau : 

- Chän c¸c cét (hoÆc c¸c hµng) cÇn Èn ®i. 
- Chän Format, Column (hoÆc Row). 
- Chän Hide. 
T¹i vÞ trÝ c¸c cét (hoÆc hµng) Èn, xuÊt hiÖn ®−êng kÎ däc (hoÆc ngang) 

®Ëm, c¸c cét (hoÆc hµng) bÞ Èn vÉn cã t¸c dông (vÉn sö dung ®Ó tÝnh to¸n). 
§Ó cho chóng hiÖn trë l¹i, ta lµm nh− : 

- Chän c¸c cét (hoÆc c¸c hµng) liÒn kÒ víi chóng. VÝ dô cÇn cho c¸c cét 
C, D, E hiÖn trë l¹i, ta chän c¸c cét ®øng ngay tr−íc vµ sau chóng : B, 
F; cÇn cho c¸c hµng 4, 5, 6 hiÖn trë l¹i, ta chän c¸c hµng ë ngay trªn 
vµ ngay d−íi chóng : 3, 7.   

- Chän Format, Column (hoÆc Row), Unhide 

g - Cè ®Þnh cét, hµng tiªu ®Ò 

ë c¸c b¶ng tÝnh lín, khi cuén xem hoÆc nhËp d÷ liÖu ë phÇn d−íi th× 
kh«ng cßn thÊy tiªu ®Ò cét cña chóng ë hµng trªn cïng, do ®ã rÊt dÔ bÞ 
nhÇm lÉn gi÷a cét nä víi cét kia. T−¬ng tù nh− vËy, khi cuén xem hoÆc 
nhËp d÷ liÖu ë bªn ph¶i th× kh«ng cßn thÊy c¸c cét tr¸i nhÊt (nh− c¸c cét Hä 
tªn, MÆt hµng, ... ), rÊt dÔ bÞ nhÇm lÉn hµng nä víi hµng kia, Excel gióp ta 
cè ®Þnh cét, hµng tiªu ®Ò, c¸ch lµm nh− sau : 

- §−a con trá vÒ « chuÈn ®Ó cè ®Þnh. « nµy ph¶i n»m ngay d−íi hµng vµ 
ngay bªn ph¶i cét cÇn cè ®Þnh. VÝ dô, cÇn cè ®Þnh c¸c cét A, B vµ c¸c 
hµng 1, 2, ta ®−a con trá vÒ « C3 

- Chän Window, Freeze Pane. T¹i « chuÈn xuÊt hiÖn 2 ®−êng kÎ däc vµ 
ngang. 
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- §Ó huû bá viÖc cè ®Þnh cét, hµng tiªu ®Ò, chän Window, Unfreeze 
Pane 

7. §Þnh d¹ng d÷ liÖu 

a - §Þnh d¹ng ký tù 
- Chän miÒn d÷ liÖu cÇn ®Þnh d¹ng, sau ®ã  

• Dïng chuét 

   
 
 

- Chän mét kiÓu ch÷ tõ hép Font 
- Chän mét cì ch÷ tõ hép Size 
- Chän Bold ®Ó (hoÆc bá) in ®Ëm, chän Italic ®Ó (hoÆc bá) in nghiªng, 

chän Underline ®Ó (hoÆc bá) g¹ch ch©n 
- Chän Color ®Ó ®Æt mÇu nÒn. 
- Chän Font Color ®Ó ®Æt mÇu ch÷. 

• Dïng Menu (®Ó cã thÓ chän nhiÒu môc ®ång thêi) 

- Format, Cells, Font 
- Chän  Color ®Ó ®Æt mÇu ch÷. 
- Chän mét kiÓu ch÷ tõ hép Font 

 
- Chän mét cì ch÷ tõ hép Size 
- Trong Font Style chän Italic ®Ó in nghiªng, chän Bold ®Ó in ®Ëm, 

chän Bold Italic ®Ó in võa nghiªng võa ®Ëm, chän Regular ®Ó ký tù trë 
l¹i b×nh th−êng. 

- Trong Underline chän mét kiÓu g¹ch ch©n : None (bá g¹ch ch©n), 
Single (g¹ch b»ng nÐt ®¬n),  Double (g¹ch b»ng nÐt ®«i), Single 
Accounting (g¹ch b»ng nÐt ®¬n kiÓu tµi chÝnh ®Õn cuèi mÐp ph¶i cña 

Font Font Size Color Font Color
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«), Double Accounting (g¹ch b»ng nÐt ®«i kiÓu tµi chÝnh ®Õn cuèi mÐp 
ph¶i cña «) 

- Chän Color ®Ó ®Æt mÇu ch÷. 
- Trong « Effect : chän Strikerthough (g¹ch ngang), Superscript (sè 

mò), Subscript (chØ sè) 
- Chän Normal Font nÕu muèn bá mäi tr×nh bÇy vµ lÊy l¹i kiÓu ngÇm 

®Þnh. 

• Dïng bµn phÝm 
Dïng tæ hîp phÝm §Ó 
Ctrl + B In ®Ëm 
Ctrl + I In nghiªng 
Ctrl + U G¹ch ch©n 
Ctrl + 5 G¹ch ngang 
Ctrl + Shift + F Më danh s¸ch Font ch÷ 
Ctrl + Shift + P Më danh s¸ch cì ch÷ 

b - §Þnh d¹ng sè 
- Chän miÒn d÷ liÖu cÇn ®Þnh d¹ng, sau ®ã chän c¸c biÓu t−îng t−¬ng 

øng trªn thanh ®Þnh d¹ng (xem ý nghÜa cña chóng trªn trang 4) 

Sè Dïng biÓu t−îng  §æi thµnh 
123 Currency Style (§iÒn dÊu tiÒn tÖ) $ 123.00 
123456 Comma Style (DÊu t¸ch ngh×n, triÖu, tû) 123,456.00 
0.156 Percent Style (Nh©n víi 100 vµ ®iÒn dÊu %) 15.6 % 
12.346 Increase Decimal (lÊy thªm 1 sè thËp ph©n) 12.3460 
12.346 Decrease Decimal (gi¶m ®i 1 sè thËp ph©n) 12.35 

Trong c¸c vÝ dô trªn, c¸c th«ng sè quèc tÕ (dÊu tiÒn tÖ; dÊu t¸ch ngh×n, 
triÖu, tû; dÊu thËp ph©n) lµ kiÓu Mü (ngÇm ®Þnh). Cã thÓ ®Æt l¹i c¸c th«ng sè 
nµy cho phï hîp.  

§Ó Èn (che ®i) c¸c sè kh«ng (0) 
- Chän c¸c « cÇn thiÕt 
- Chän Format, Cells 
- Chän Number 
- Trong « Code gâ vµo 0;0; 
- OK 

c - Canh biªn (dãng hµng) 
- Chän vïng d÷ liÖu cÇn canh biªn 

• Dïng biÓu t−îng (chØ c¨n ®−îc theo chiÒu ngang) 
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VÝ dô : §Ó cã tiªu ®Ò nh− d−íi ®©y, ta lµm nh− sau : 

 A B C D E F G H I K L M 

1 ®¹i häc më hn céng hoµ x∙ héi chñ nghÜa viÖt nam 

2 khoa cntt §éc lËp - Tù do - H¹nh phóc 

3             

T¹i « A1 gâ ®¹i häc më hn 
T¹i « A2 gâ khoa cntt 

Chän miÒn A1:D2, chän biÓu t−îng  (c¨n vµo gi÷a nhiÒu «) 

T¹i « E1 gâ céng hoµ x∙ héi chñ nghÜa viÖt nam 
T¹i « E2 gâ §éc lËp - Tù do - H¹nh phóc 
Chän miÒn E1:K2, chän biÓu t−îng C¨n vµo gi÷a nhiÒu « 

• Dïng Menu c¨n ®−îc theo c¶ chiÒu ngang lÉn chiÒu däc 

- Format, Cells. XuÊt hiÖn hép tho¹i Format Cells 

 
- Chän Aligment 

C¸c th«ng sè dãng hµng cña d÷ liÖu trong « bao gåm : 
Horizontal : theo chiÒu ngang 
General: Ký tù ®−îc c¨n vÒ bªn tr¸i, sè ®−îc c¨n sang ph¶i, c¸c gi¸ trÞ 

logic vµ lçi ®−îc c¨n vµo gi÷a. 

C¨n th¼ng tr¸i 

C¨n vµo gi÷a 

C¨n th¼ng ph¶i

C¨n mét tiªu ®Ò vµo 
gi÷a nhiÒu « 
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Left,Center,Right : C¨n sang tr¸i, vµo gi÷a, sang ph¶i. 
Fill :  Tù ®iÒn ®Çy « (trong « chØ cÇn gâ 1 nhãm ký tù sau ®ã 

chän môc nµy, Excel sÏ ®iÒn ®Çy miÒn b»ng nhãm nµy) 

Justify :  C¨n th¼ng 2 bªn. Tr−êng hîp ®é réng cña cét nhá h¬n néi 
dung bªn trong nã, Excel tù ®éng t¨ng chiÒu cao cña hµng. 

Center Across :  C¨n vµo gi÷a miÒn ®· chän (t−¬ng  tù nh− viÖc chän  
Selection  biÓu t−îng ← a → ) 
Orientation :  H−íng ph©n bè 
Wrap Text :  NÕu chän sÏ cho xuèng dßng trong c¸c « khi néi dung 

v−ît qu¸ chiÒu ngang « (nh− cét Trung b×nh) 

d - KÎ khung 

- Chän vïng d÷ liÖu cÇn kÎ 
khung 

• Dïng chuét 
- Chän  cña biÓu t−îng 

Borders. 
- Chän tiÕp lo¹i ®−êng kÎ cÇn 

thiÕt. 

• Dïng Menu 

- Chän Format, Cells, Border. 
- Chän tiÕp ®−êng cÇn kÎ trong khung Border : 

 

Outline  : ViÒn xung quanh khèi « 
Left, Right, Top, Bottom : ViÒn tr¸i, ph¶i, trªn, d−íi mçi «  
Color  : MÇu cña ®−êng kÎ  
- Chän kiÓu ®−êng kÎ trong khung Style 
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e - T« mÇu 
- Format, Cells, Patterns 
- Chän  Patterns ®Ó ®Æt mÇu nÒn. 
- Chän  Color ®Ó ®Æt mÇu t«. 

f - §Þnh d¹ng tù ®éng 

Excel  cã s½n mét sè khu«n mÉu ®−îc sö dông ®Ó ®Þnh d¹ng. C¸c b−íc 
nh− sau : 

- Chän vïng d÷ liÖu cÇn ®Þnh d¹ng 
- Format,  AutoFormat 

 

- Chän kiÓu t¹o khu«n trong danh s¸ch Table Format 
- Nót Option cho phÐp thùc hiÖn viÖc t¹o khu«n tù ®éng h¹n chÕ trªn 

c¸c c¸c kiÓu d÷ liÖu nhÊt ®Þnh. 
- Vïng Sample lµ mÉu cña khu«n ®−îc minh ho¹ trªn mét vÝ dô gi¶ 

®Þnh. 

8. §Æt tªn cho « 
§Æt tªn cho « hay nhãm « cã t¸c dông sau : 

- Tªn dÔ ®äc, dÔ nhí. Nh− ë vÝ dô trªn trang 11, tªn "TongLuong" dÔ hiÓu 
vµ dÔ nhí h¬n c«ng thøc =SUM(E2:E7). 

- Khi ®· g¸n tªn cã thÓ tham chiÕu tíi « hay nhãm « b»ng tªn, vÝ dô trong « 
F2 ta cã thÓ thay ®Þa chØ $E$8 b»ng tªn TongLuong. 

- ViÖc di chuyÓn vÒ mét « (hay miÒn) ®· ®−îc ®Æt tªn trë nªn nhanh chãng 
vµ thuËn tiÖn. 

Tªn ph¶i b¾t ®Çu bëi ch÷ c¸i hoÆc dÊu _ (nèi d−íi), \ (sæ chÐo ng−îc),  
cã ®é dµi nhiÒu nhÊt lµ 255 ký tù vµ kh«ng ®−îc chøa dÊu c¸ch. §Ó dÔ 
®äc, c¸c ch÷ c¸i ®Çu mçi tõ trong tªn nªn viÕt hoa, vÝ dô TongLuong hay 
nèi c¸c tõ b»ng dÊu _ (nèi d−íi), vÝ dô Bang_Tra_Cuu. Kh«ng nªn gâ dÊu 
tiÕng ViÖt trong tªn. 
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a - §Æt tªn cho « hay nhãm « b»ng tay 
Sau khi chän « hay nhãm « cÇn ®Æt tªn lµm theo mét trong hai c¸ch sau: 

C¸ch 1 : - Nh¸y chuét t¹i  cña hép Tªn trªn thanh c«ng thøc, ®Þa chØ cña 
« ®æi sang mÇu xanh.  

 - Xo¸ ®Þa chØ ®ã ®i, gâ vµo tªn råi Ên ↵ 
C¸ch 2 : - Chän môc Insert, Name, Define (hoÆc Ctrl + F3) 

 - Trong khung Names in Workbook gâ vµo tªn cho « hay nhãm «.  
 - OK  

 

b - §Æt tªn theo tiªu ®Ò cña cét hay hµng (tù ®éng) 
C¸c b−íc nh− sau : 

- Chän « hay nhãm « cÇn ®Æt tªn gåm c¶ c¸c tiªu ®Ò cét hoÆc hµng, nh− vÝ 
dô trªn trang 11 ®Þnh ®Æt tªn cho d·y « ghi sè ngµy c«ng, ta chän C1:C7. 

- Chän Insert, Name, Create (hoÆc Ctrl+Shift+F3). 

- ý nghÜa c¸c môc trong hép Create Name nh− sau : 
Top Row : LÊy « ë hµng ®Çu (cña khèi ®· chän) lµm tªn 
Bottom Row : LÊy « ë hµng cuèi (cña khèi ®· chän) lµm tªn 
Left Column : LÊy « ë cét bªn tr¸i (cña khèi ®· chän) lµm tªn 
Right Column : LÊy « ë cét bªn ph¶i (cña khèi ®· chän) lµm tªn 

- OK. 
KÕt qu¶ lµ ë vÝ dô trªn, miÒn C2:C7 ®−îc ®Æt tªn lµ Sè_NC  

c - D¸n tªn vµo c«ng thøc 
 Khi nhËp hay söa c«ng thøc, thay v× ®iÒn vµo ®Þa chØ cña « (hay miÒn) 

®· ®−îc ®Æt tªn, ta 

- Ên F3 (hoÆc nh¸y chuét t¹i  cña Hép Tªn trªn thanh c«ng thøc, hoÆc 
chän môc Insert, Name, Paste ) 

- Chän tªn cÇn thiÕt tõ danh s¸ch råi OK 
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c - VÒ nhanh mét « (hay miÒn) ®∙ ®−îc ®Æt tªn 
Cã thÓ ®−a con trá vÒ nhanh mét « (hay miÒn) ®· ®−îc ®Æt tªn b»ng mét 

trong 2 c¸ch sau : 
C¸ch 1 : 

- Nh¸y chuét t¹i  cña Hép tªn trªn thanh c«ng thøc vµ chän tªn cÇn thiÕt 
tõ danh s¸ch (hoÆc gâ ®Þa chØ cña «). 

C¸ch 2 : 

- Ên F5 
- Chän tªn cÇn thiÕt tõ danh s¸ch 
- OK 

§©y còng lµ ph−¬ng ph¸p kiÓm tra xem Tªn ®· ®−îc ®Æt cho mét « 
(hay miÒn) nµo. 

d - Xo¸ tªn 
- Chän Insert, Name, Define. 
- Chän tªn cÇn xo¸ tõ danh s¸ch 
- Chän Delete 
- Chän OK hoÆc Close. 

e - Chó ý 
- NÕu muèn lÊy tªn cña nhãm « nµy ®Ó ®Æt cho nhãm « kh¸c, tr−íc hÕt ph¶i 

xo¸ tªn ®ã ®i. 

9. Ghi chó cho « 
Cã thÓ thªm phÇn ghi chó cho tõng « riªng rÏ. Nh÷ng ghi chó nµy gióp 

ta gi¶i thÝch b¶ng tÝnh cña m×nh mét c¸ch râ rµng h¬n (t¹i sao l¹i dïng hµm 
nµy hay ®¹t ®Þa chØ kia lµ tuyÖt ®èi .v.v..). 

a - T¹o ghi chó 
- VÒ « cÇn t¹o ghi chó.  
- Më hép tho¹i CellNote theo mét trong hai c¸c sau : 

C¸ch 1 : - Shift + F2 
C¸ch 2 : - Chän môc Insert / Note 

- Gâ vµo lêi ghi chó trong khung Text Note 
- OK ®Ó ®ãng hép tho¹i. 

Nh¸y chuét t¹i 
®©y ®Ó chän tªn 
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Mét chÊm vu«ng mÇu ®á ë gãc ph¶i trªn cña « chØ ra r»ng « ®ã ®· ®−îc 
ghi chó. NÕu kh«ng thÊy chÊm vu«ng nµy h·y lµm nh− sau : 
- Tools / Options / View 
- §¸nh dÊu chän vµo « Note Indicator 

H×nh d−íi ®©y cho thÊy c¸c « H7 vµ I7 cã ghi chó. NÕu ®ang dïng 
Excel 7 hoÆc Excel 97 th× khi rµ chuét vµo « I7, néi dung ghi chó ®−îc hiÓn 
thÞ 
 

 
 

b - Xem / Söa / Xo¸ c¸c ghi chó 
- NÕu cÇn xem ghi chó cña mét « : chØ viÖc rµ chuét vµo « ®ã, mét khung 

víi néi dung ghi chó xuÊt hiÖn. §Ó t¾t khung nµy : rµ chuét sang « kh¸c. 
- §Ó söa hay xo¸ mét ghi chó : më hép tho¹i CellNote 
- Chän ghi chó cÇn thiÕt trong khung Note In Sheet 
- TiÕn hµnh söa néi dung cña ghi chó trong khung Text Note. §Ó xo¸ ghi 

chó : chän Delete 
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ë ®©y, SQRT lµ hµm khai c¨n bËc 2, SUM lµ hµm tÝnh tæng (b×nh ph−¬ng cña 
2 c¹nh gãc vu«ng), ta thÊy tr−íc hµm nµy kh«ng cã dÊu = v×  nã ®−îc dïng lµm 
tham biÕn (®èi sè) cho hµm SQRT. 

2. NhËp hµm vµo b¶ng tÝnh  
Cã 3 c¸ch nhËp hµm vµo b¶ng tÝnh : 

 - Gâ vµo tõ bµn phÝm 

 - Dïng biÓu t−îng  (Function Wizard) 
 - Dïng menu 

§Ó nhËp hµm : ®−a con trá « vÒ « cÇn thiÕt råi chän mét trong c¸c c¸ch 
sau : 

a - Gâ vµo tõ bµn phÝm: 
- Gâ dÊu = 
- Gâ vµo tªn hµm, dÊu (, c¸c tham biÕn theo ®óng d¹ng thøc quy ®Þnh, 

dÊu ) 

b - Dïng biÓu t−îng Function Wizard. C¸c b−íc nh− sau : 

1 -Chän biÓu t−îng  trªn thanh c«ng cô. XuÊt hiÖn hép tho¹i Function 
Wizard nh− sau : 

 

ý nghÜa cña c¸c nhãm hµm trong khung Function Category nh− sau : 
Most Recently Used : C¸c hµm sö dông gÇn ®©y nhÊt 
All : TÊt c¶ c¸c hµm 
Financial : Hµm tµi chÝnh 
Date & Time : Hµm Ngµy vµ Giê 
Math & Trig : Hµm To¸n vµ L−îng gi¸c 
Statistical  : Hµm thèng kª 
Lookup & Reference : Hµm T×m kiÕm vµ Tham chiÕu 
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Database : Hµm C¬ së d÷ liÖu 
Text : Hµm xö lý ký tù 
Logical : Hµm Logic 
Information : C¸c hµm Th«ng tin vÒ «, vÒ b¶ng tÝnh .v.v.  

2 -Chän nhãm hµm trong khung Function Category. Khi di chuyÓn thanh 
s¸ng ®Õn nhãm nµo, Excel sÏ liÖt kª c¸c hµm cña nhãm ®ã theo thø tù 
ch÷ c¸i trong khung Function Name. 

3 -Chän nhãm hµm trong khung Function Name 
4 -Chän Next. XuÊt hiÖn hép tho¹i Function Wizard liÖt kª c«ng dông, 

khung c¸c tham biÕn cÇn nhËp, khung chøa gi¸ trÞ kÕt qu¶ cña hµm ...  

 

§iÒn c¸c tham biÕn cña hµm b»ng c¸ch Ên nót chuét vµo khung cÇn 
thiÕt, sau ®ã nhËp tõ bµn phÝm hoÆc rª chuét trªn miÒn d÷ liÖu (ë h×nh 
trªn lµ chän miÒn A3:C3). Tr−êng hîp cÇn gäi hµm kh¸c, chän nót fx 
bªn tr¸i cña khung. 

5 - Chän Finish. Excel t¾t hép tho¹i vµ ghi kÕt qu¶ cña hµm vµo «. 
6 -L−u ý :  

+ ý nghÜa c¸c nót lÖnh kh¸c : 
- Next : chuyÓn sang b−íc tiÕp theo : Function Wizard step 2 of  2 
- Back : lïi vÒ b−íc tr−íc : Function Wizard step 1 of  2 
- Cancel : huû bá lÖnh 

+ Khi con trá « ë t¹i « ®ang chøa hµm, nÕu chän Function Wizard 
Excel sÏ chuyÓn sang viÖc chØnh söa hµm, xuÊt hiÖn hép tho¹i 
Editing Function 1 of 1 sau : 
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c - Dïng Menu 
- Chän môc Insert, Function. XuÊt hiÖn hép tho¹i Function Wizard  
- C¸c b−íc cßn l¹i gièng nh− khi chän biÓu t−îng fx (trang ) 

3. Mét sè hµm th−êng dïng 

3.1. Hµm ngµy th¸ng 

DATE(year,month,day) 
ChØ ra ngµy d¹ng sè øng víi ngµy th¸ng n¨m.  

VÝ dô :  =DATE(04,09,27) tr¶ vÒ 27-09-04 

DAY(date) 
Sè ngµy trong th¸ng cña biÕn ngµy th¸ng date. 

VÝ dô :  =DAY(27-09-04) tr¶ vÒ 27 
=DAY("27-Sep") tr¶ vÒ 27 

MONTH(date) 
Sè th¸ng trong n¨m cña biÕn ngµy th¸ng date. 

VÝ dô : =MONTH(27-09-04) tr¶ vÒ 9 
=MONTH("27-Sep") tr¶ vÒ 9 

Time(hour, minute, second) 
ChØ ra thêi gian d¹ng sè. 

VÝ dô : =TIME(19,5,14) tr¶ vÒ 19:05:14 hoÆc 7:05 PM 

WEEKDAY(date) 
ChØ ra sè thø tù cña ngµy trong tuÇn cña biÕn ngµy th¸ng date (Thø Hai 

lµ ngµy thø 1, Thø Ba lµ ngµy thø 2, ..., Chñ NhËt lµ ngµy thø 7) 
VÝ dô : =WEEKDAY(27-09-04) tr¶ vÒ 6 

YEAR(date)  
Sè n¨m cña biÕn ngµy th¸ng date. 
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VÝ dô : =YEAR(27-09-04) tr¶ vÒ 2004 

3.2. Hµm ký tù 

EXACT(text1, text2) 
NhËn gi¸ trÞ  TRUE hay FALSE phô thuéc vµo hai chuçi text1 vµ text2 

cã gièng hÖt nhau hay kh«ng. 
VÝ dô : =EXACT("EXCEL","EXCEL") tr¶ vÒ TRUE 

=EXACT("EXCEL","Excel") tr¶ vÒ FALSE 

FIND(find_text, text, atnum)  
VÞ trÝ cña chuçi con (Find_text) trong chuçi lín (text ) b¾t ®Çu tõ vÞ trÝ 

atnum, nÕu bá qua atnum nã ®−îc cho b»ng 1. Hµm nµy ph©n biÖt ch÷ HOA 
vµ th−êng 

VÝ dô : =FIND("e","Excel 5.0") tr¶ vÒ 4 
 =FIND("E","Excel 5.0") tr¶ vÒ 1 

 =FIND("A","Excel 5.0") tr¶ vÒ #VALUE! (lçi) 

FIXED(number, decimal, no_commas) 
ChuyÓn sè (number) thµnh chuçi d¹ng cè ®Þnh víi decimal sè thËp 

ph©n. NÕu kh«ng ghi decimal sÏ cho 2 ch÷ sè thËp ph©n. NÕu no_commas 
lµ FALSE (hoÆc kh«ng ghi), chuçi in ra sÏ cã dÊu ng¨n c¸ch ngh×n triÖu 
nh− vÝ dô 1, nÕu no_commas lµ TRUE, chuçi in ra sÏ kh«ng cã dÊu ng¨n 
c¸ch ngµn triÖu nh− vÝ dô 2 (chó ý ë vÝ dô nµy cã 2 dÊu phÈy) 

VÝ dô : « A1 chøa sè 12345.6789, khi ®ã 
 =FIXED(A1,3) tr¶ vÒ 12 345.679 

 =FIXED(A1, ,TRUE) tr¶ vÒ 12345.68 

LEFT(text, number) 
LÊy number ký tù bªn tr¸i cña text. 

VÝ dô : =LEFT("Excel  5.0", 5) tr¶ vÒ Excel 

LEN(text) 
§é dµi cña chuçi ký tù text. 

VÝ dô : =LEN("Excel  5.0", 5) tr¶ vÒ 9 

LOWER(text) 
ChuyÓn text thµnh ch÷ th−êng. 

VÝ dô : =LOWER("EXCEL") tr¶ vÒ excel 

MID(text, numstart, numchar) 
Tr¶ l¹i numchar ký tù cña text b¾t ®Çu tõ vÞ trÝ numstart. 

VÝ dô : =MID("Excel for Windows",11,3) tr¶ vÒ Win 

PROPER(text) 
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ChuyÓn c¸c ch÷ c¸i ®Çu tõ cña text thµnh ch÷ viÕt hoa. 
VÝ dô : =PROPER("excel for windows") tr¶ vÒ Excel For Windows 

Chó ý :  nÕu text  lµ tiÕng ViÖt, hµm nµy sÏ cho kÕt qu¶ sai. 
VÝ dô : = PROPER("viÖt") tr¶ vÒ Viöt 

REPLACE(oldtext, numstart, numchar, newtext)  
Thay newtext  vµo oldtext b¾t ®Çu tõ vÞ trÝ numstart vµ cã ®é dµi numchar. 

VÝ dô : =REPLACE("T«i häc Quattro 5.0",9,7,"Excel") 
 tr¶ vÒ  T«i häc Excel 5.0 

REPT(text,number) 
LÆp l¹i text liªn tiÕp number lÇn. 

VÝ dô : =REPT("Tin häc ",3) tr¶ vÒ  Tin häc Tin häc Tin häc 

RIGHT(text, number) 
LÊy ra number ký tù bªn ph¶i cña text. 

VÝ dô : =RIGHT("Excel  5.0", 3) tr¶ vÒ 5.0 

SEARCH(find_text, text, atnum) 
T−¬ng tù hµm Find nh−ng kh«ng ph©n biÖt ch÷ in hoa hay ch÷ in 
th−êng. 

SUBSTITUTE(text, oldtext, newtext, instance) 
Thay thÕ newtext vµo vÞ trÝ oldtext trong text ë lÇn xuÊt hiÖn instance 
(NÕu kh«ng cã ®èi sè nµy sÏ thay thÕ ë mäi vÞ trÝ). 

VÝ dô : =SUBSTITUTE("H·y xem  xem", "xem", "nh×n",1) 
 tr¶ vÒ H·y nh×n xem 
 =SUBSTITUTE("H·y xem  xem", "xem", "®©y",2) 
 tr¶ vÒ H·y xem ®©y 

TRIM(text) 
C¾t bá c¸c ký tù trèng v« nghÜa trong text. 
VÝ dô : =TRIM("  MS    Excel    5.0  ") tr¶ vÒ MS Excel 5.0   

UPPER(text) 
ChuyÓn text thµnh ch÷ in hoa toµn bé. 
VÝ dô : =UPPER("excel") tr¶ vÒ EXCEL 

VALUE(text) 
ChuyÓn text sang sè. 
VÝ dô : =VALUE(RIGHT("Tel. 533332",6)) tr¶ vÒ 533332 

3.3. Hµm to¸n häc   

ABS(x) :  Gi¸ trÞ tuyÖt ®èi cña sè x. 
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ACOS(x) :  Hµm arccos cña x, x n»m trong kho¶ng tõ -1 ®Õn 1. Gi¸ trÞ gãc 
tr¶ vÒ theo radian tõ 0 ®Õn π. NÕu muèn chuyÓn kÕt qu¶ sang ®é, 
nh©n nã víi 180/PI( ) 

ASIN(x) :  Hµm arcsin cña x, x n»m trong kho¶ng tõ -1 ®Õn 1. Gi¸ trÞ gãc 
tr¶ vÒ theo radian tõ -π/2 ®Õn π/2.  

ATAN(x) :  Hµm arctangent cña x. T−¬ng tù nh− ASIN(x) 

COS(x) :  Hµm cos cña gãc x, x  lµ gãc theo radian, nÕu lµ ®é, ph¶i nh©n 
nã víi PI( )/180. 

VÝ dô : = COS(0.785398) tr¶ vÒ 0.707107 (cos cña π/4) 
 = COS(45*PI( )/180) tr¶ vÒ 0.707107 (cos cña 45o) 

COSH(x) :  Hµm Cos Hyperbolic cña gãc x. 

COuntif(range, criteria) : §Õm sè « kh«ng rçng tho¶ tiªu chuÈn cho tr−íc 
Range Lµ tËp hîp c¸c « mµ ta muèn ®Õm 
Criteria Tiªu chuÈn, cã thÓ lµ sè, ch÷ hoÆc biÓu thøc, x¸c ®Þnh xem sÏ 

®Õm « nµo.  
XÐt b¶ng trªn trang 55, ®Ó ®Õm sè ng−êi  
+ Cã L−¬ng b»ng 50, dïng c«ng thøc : 
C«ng thøc =COUNTIF(D2:D10,50) cho kÕt qu¶ lµ 3 
+  Tuæi tõ 30 trë lªn dïng c«ng thøc : 

=COUNTIF(D2:D10,”>=30”) (ph¶i ®Ó biÓu thøc trong dÊu nh¸y kÐp ”) 
+ Tªn b¾t ®Çu b»ng ch÷ H dïng c«ng thøc : 

=COUNTIF(A2:A10,”H*”) (ph¶i ®Ó ch÷ vµ dÊu * trong dÊu nh¸y kÐp ”) 
Hµm COUNTIF chØ ®Õm theo 1 ®iÒu kiÖn, vÝ dô chØ ®Õm sè N÷ hoÆc chØ 

®Õm sè Tuæi tõ 30 trë lªn. NÕu cÇn ®Õm sè N÷ cã tuæi tõ 30 trë lªn (kÕt hîp 2 
®iÒu kiÖn) ph¶i dïng hµm DCOUNT (xem trang 57) 

DEGREES(x) : §æi radian sang ®é 
VÝ dô :  = DEGREES(PI( )/4) tr¶ vÒ 45 (®é) 

EXP(x) :  Hµm mò ex (tr¶ vÒ luü thõa cña e). 
VÝ dô :  = EXP(1) tr¶ vÒ 2.718281 

INT(x) : Sè nguyªn lín nhÊt kh«ng v−ît qu¸ (nhá h¬n) x. 
VÝ dô :  = INT(2.789) tr¶ vÒ 2 

 = INT(-2.4) tr¶ vÒ -3 (v× -3 nhá h¬n -2.4) 

LN(x) : logarit tù nhiªn cña x. 

LOG(number, base) : Logarit c¬ sè base cña number 

LOG10(number) : Logarit c¬ sè 10 cña number (log10x) 

MDETERM(DC) : §Þnh thøc ma trËn cho bëi ®Þa chØ vïng DC. 
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MINVERSE(DC) : Ma trËn ng−îc cña DC. 

MMULT(M1,M2) : TÝch hai ma trËn M1,M2. 

MOD(n,t) : Sè d− cña phÐp chia nguyªn n/t. 
VÝ dô : =MOD(11,3) tr¶ vÒ 2 

PI( ) : Tr¶ vÒ sè π b»ng 3.141592654 

RAND( ) : Sè ngÉu nhiªn gi÷a 0 vµ 1. 

RANDBETWEEN(n1, n2) 
Sè nguyªn ngÉu nhiªn gi÷a hai sè nguyªn n1 vµ n2. 

ROUND(x,n) 
Lµm trßn sè x víi ®é chÝnh x¸c ®Õn con sè thø n  

- NÕu n < 0 th× x ®−îc lµm trßn ®Õn ch÷ sè thËp ph©n thø n 
- NÕu n > 0 th×  x ®−îc lµm trßn ®Õn ch÷ sè bªn tŗ i thø  n cña dÊu (chÊm)  thËp ph©n 

VÝ dô : « A1 chøa sè 347 645.146, khi ®ã c«ng thøc 
  =ROUND(A1,2)  tr¶ vÒ 347 645.15 
 =ROUND(A1,1)  tr¶ vÒ 347 645.10 
 =ROUND(A1,-3) tr¶ vÒ 348 000 (lµm trßn ®Õn hµng ngh×n) 

SIGN(x) : X¸c ®Þnh dÊu cña mét sè. Tr¶ vÒ 1 nÕu x > 0, 0 nÕu x = 0, -1 nÕu x<0. 
VÝ dô : = SIGN(10) tr¶ vÒ 1 
 = SIGN(4-4) tr¶ vÒ 0 
 = SIGN(7-25) tr¶ vÒ -1 

SIN(x) :  hµm Sin cña x. 

SINH(x) :  hµm Sin Hyperbolic cña x. 

SQRT(x) :  hµm c¨n bËc hai cña x. 

SUM(n1, n2, ..) : tæng cña c¸c sè n1, n2,.. 

SUMif(range,criteria,sum_range) : Céng nh÷ng « tho¶ ®iÒu kiÖn nµo ®ã. 
Range Lµ vïng « ®Ó so s¸nh víi Criteria 
Criteria Lµ ®iÒu kiÖn céng, cã thÓ lµ sè, ch÷ hoÆc biÓu thøc.  
 Quyªt ®Þnh « nµo trong vïng Sum_Range sÏ ®−îc céng 
Sum_Range Lµ vïng « sÏ ®−îc céng 
 C¸c « trong Sum_range chØ ®−îc céng nÕu c¸c « t−¬ng 

øng víi nã trong Range tho¶ m·n Criteria 
XÐt b¶ng trªn trang 55, ®Ó tÝnh tæng l−¬ng cña nh÷ng ng−êi  
+ lµ N÷, dïng c«ng thøc : 

 = SUMIF(C2 : C10, “N÷”,D2 : D10) cho kÕt qu¶ 280  
+  cña nh÷ng ng−êi cã L−¬ng tõ 50 trë lªn, dïng c«ng thøc : 
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= SUMIF(D2 : D10,">50",D2 : D10) (chó ý dÊu nh¸y kÐp ” ) 
+ Tªn b¾t ®Çu b»ng ch÷ H dïng c«ng thøc : 

= SUMIF(A2 : A10,”H*”,D2 :  D10) (chó ý dÊu nh¸y kÐp ” vµ dÊu * ) 
Hµm SUMIF chØ tÝnh tæng theo 1 ®iÒu kiÖn. NÕu cÇn tÝnh tæng theo 2 ®iÒu 

kiÖn trë lªn ph¶i dïng c«ng thøc m¶ng hoÆc hµm DSMUM (xem trang 57) 

TAN(x) :  hµm Tang cña gãc x. 

TANH(x) :  hµm Tang Hyperbolic cña x. 

TRUNC(x) 
C¾t bá phÇn thËp ph©n cña sè x ®Ó chØ lÊy phÇn nguyªn. 

VÝ dô : = TRUNC(2.789) tr¶ vÒ 2 
 = TRUNC(-2.4) tr¶ vÒ -2, trong khi  ®ã = INT(-2.4) tr¶ vÒ -3 

3.4. Hµm Logic  

AND(logic1,logic2,..) 
NhËn gi¸ trÞ TRUE (§óng) nÕu tÊt c¶ c¸c biÓu thøc logic1, logic2,... ®Òu 

lµ TRUE, nhËn gi¸ trÞ FALSE (Sai) nÕu cã Ýt nhÊt mét ®èi sè lµ FALSE 
VÝ dô :  =AND(5>3,6>4) tr¶ vÒ TRUE 

 =AND(5>3,6<=4) tr¶ vÒ FALSE 

FALSE( ) 
Cho gi¸ trÞ logic FALSE. 

IF(logical_test,value_if_true,value_if_false) 
Tr¶ l¹i gi¸ trÞ ghi trong value_if_true nÕu logical_test lµ TRUE vµ gi¸ trÞ 

ghi trong value_if_false trong tr−êng hîp ng−îc l¹i. Hµm IF cã thÓ lång 
nhau ®Õn 7 cÊp. 

VÝ dô :  Gi¶ sö trong « B4 ghi tuæi cña mét ng−êi, khi ®ã c«ng thøc 
 = IF(B4>=16,"Ng−êi lín","TrÎ em") cho kÕt qu¶ lµ Ng−êi lín 

nÕu tuæi tõ 16 trë lªn, lµ TrÎ em nÕu tuæi d−íi 16 
§Ó kiÓm tra xem « D2 chøa sè nµo dïng  

 = IF(D2>0,"Sè d−¬ng", IF(D2=0,"Sè kh«ng",Sè ©m")) 

NOT(logic) : hµm phñ ®Þnh. 
VÝ dô :  = NOT(1+1>2) tr¶ vÒ TRUE 

 = NOT(1+1=2) tr¶ vÒ FALSE 

OR(logic1,logic2,...) 
NhËn gi¸ trÞ TRUE nÕu mét trong c¸c biÓu thøc logic1,logic2,.. lµ 

TRUE, nhËn gi¸ trÞ FALSE nÕu tÊt c¶ c¸c biÓu thøc ®ã lµ FALSE. 
VÝ dô : =OR(5>3,6<=4) tr¶ vÒ TRUE 

 =OR(5<3,6<=4) tr¶ vÒ FALSE 
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TRUE( ) : nhËn gi¸ trÞ logic TRUE. 

3.5. Hµm thèng kª 

AVERAGE(num1, num2,..) 
TÝnh trung b×nh céng cña c¸c sè num1, num2,... 

VÝ dô : =AVERAGE(10,8,9,3) tr¶ vÒ 7.5 

COUNT(§Þa chØ) : tÝnh sè c¸c « d÷ liÖu kiÓu sè trong miÒn §Þa chØ 
VÝ dô : C¸c « tõ A1 ®Õn E5 chøa c¸c gi¸ trÞ sau : 

 A B C D E 
1 STT Tªn s¸ch Sè l−îng §¬n gi¸ Thµnh tiÒn 
2 1 Excel 5.0 10 15000 150000 
3 2 Word 6.0 15 14000 210000 
4 3 Access 5 12000 60000 
5  Céng 30  420000 

khi ®ã, c«ng thøc 

= COUNT(A1:E5) tr¶ vÒ 14 

COUNTA(DC) 
TÝnh sè c¸c « kh«ng rçng trong vïng DC. 
VÝ dô : = COUNTA(A1:E5) tr¶ vÒ 23 
     (cã 2 « rçng lµ A5 vµ D5) 

LARGE(DC,k) : PhÇn tö lín thø k trong vïng DC.  
VÝ dô : = LARGE(E1:E5,1) tr¶ vÒ 420000 
 = LARGE(E1:E5,3) tr¶ vÒ 150000 

MAX(num1,num2,..) : gi¸ trÞ lín nhÊt cña c¸c sè num1,num2,.. 
VÝ dô : = MAX(E1:E5) tr¶ vÒ 420000 

MIN(num1,num2,..) : gi¸ trÞ nhá nhÊt cña c¸c sè num1,num2,.. 
VÝ dô : = MIN(E1:E5) tr¶ vÒ 60000 

MODE(DC) : tr¶ l¹i gi¸ trÞ hay gÆp nhÊt trong vïng DC. 
VÝ dô : = MODE(1,2,4,5,2) tr¶ vÒ 2 

RANK(sè, Danh s¸ch, Tuú chän) : x¸c ®Þnh thø h¹ng cña sè so víi chuçi 
c¸c sè trong danh s¸ch, tøc lµ xem sè ®ã ®øng thø mÊy trong chuçi sè 

- xÕp gi¶m dÇn nÕu kh«ng cã Tuú chän hoÆc Tuú chän b»ng 0 (VÝ dô 1).  

- xÕp t¨ng dÇn nÕu Tuú chän lµ mét sè lín h¬n 0 (VÝ dô 2). 

§Þa chØ cña Danh s¸ch ph¶i lµ tuyÖt ®èi. 
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VÝ dô : 1. Gi¶ sö ë c¸c « E3:E12 ghi ®iÓm trung b×nh cña c¸c thÝ sinh, 
®Ó xÕp thø c¨n cø vµo ®iÓm trung b×nh, t¹i « F3 nhËp 
=RANK(E3,$E$3:$E$12) hoÆc =RANK(E3,$E$3:$E$12,0), 
sau ®ã copy c«ng thøc nµy xuèng c¸c « tõ E4 ®Õn E12. 

VÝ dô : 2. Gi¶ sö ë c¸c « B3:B12 ghi thêi gian ch¹y 100 m cña c¸c vËn 
®äng viªn, ®Ó xÕp thø c¨n cø vµo thêi gian, t¹i « C3 nhËp 
=RANK(B3,$B$3:$B$12,1), sau ®ã copy c«ng thøc nµy 
xuèng c¸c « tõ C4 ®Õn C12. Cã thÓ thay sè tham sè thø 3 
b»ng mét sè bÊt kú kh¸c 1. 

SMALL(DC,k) : phÇn tö nhá thø k trong vïng DC.  
VÝ dô : = SMALL(E1:E5,1) tr¶ vÒ 60000 

 = SMALL(E1:E5,3) tr¶ vÒ 210000 

3.6. Hµm T×m kiÕm vµ Tham chiÕu 

vlookup(lookup_value, table_array, col_index_num, range_lookup) 
Lookup_value Gi¸ trÞ ®−îc t×m kiÕm trªn cét bªn tr¸i cña Table_array 
Table_array Vïng t×m kiÕm hay cßn gäi lµ b¶ng tra cøu, ®Þa chØ ph¶i lµ 

tuyÖt ®èi, nªn ®Æt tªn cho vïng (xem trang 11 vÒ c¸ch ®Æt 
tªn). 

Col_index_num Sè thø tù cét trong table_array, n¬i VLOOKUP sÏ lÊy gi¸ 
trÞ tr¶ vÒ 

Range_lookup Gi¸ trÞ logic x¸c ®Þnh viÖc t×m kiÕm lµ chÝnh x¸c hay gÇn 
®óng, nÕu lµ: 

True hay 1 Cét ®Çu tiªn ph¶i ®−îc s¾p xÕp t¨ng dÇn (khi ®ã cã 
thÓ bá qua tham sè thø 4 nµy). 

 Khi kh«ng thÊy sÏ lÊy kÕt qu¶ gÇn ®óng, v× thÕ cßn gäi 
lµ dß t×m kh«ng chÝnh x¸c. 

False hay 0 Cét ®Çu tiªn kh«ng cÇn s¾p xÕp .T×m chÝnh x¸c, tr¶ vÒ 
#N/A nÕu kh«ng thÊy.  (Xem vÝ dô ë trang 72) 

VÝ dô : B¶ng sau lµ kÕt qu¶ thi cña häc sinh, dùa vµo ®iÓm Trung b×nh 
h·y xÕp lo¹i häc sinh theo thang ®iÓm : 

     
KÐm 5 Trung b×nh 7 Kh¸ 8 Giái 9.5 XuÊt s¾c 

§Ó  dïng hµm VLOOKUP, ta cÇn thùc hiÖn c¸c b−íc sau : 
- Trong miÒn C15:D19 gâ vµo thang ®iÓm trªn d−íi d¹ng cét. V× ®©y lµ 

c¸ch dß t×m kh«ng chÝnh x¸c (trong mét kho¶ng) nªn chØ gâ vµo cËn d−íi 
(theo chiÒu t¨ng) cña mçi lo¹i.  

Nh− vËy : 
lookup_value  lµ E3 (®iÓm Trung b×nh cña häc sinh thø nhÊt) 
table_array  lµ miÒn $C$15: $D$19 (miÒn ®Þa chØ tuyÖt ®èi, kh«ng ®−a 

hµng tiªu ®Ò C14: D14 vµo) 
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col_index_num  lµ 2 v× cÇn lÊy gi¸ trÞ cña cét Lo¹i, cét nµy cã sè thø tù lµ 

2 trong miÒn $C$14: $D$19. 
range_lookup lµ 1 hoÆc TRUE ®Òu ®−îc, cã thÓ bá qua tham biÕn nµy 
- T¹i « G3 ®iÒn vµo c«ng thøc = VLOOKUP(E3,$C$14: $D$19,2) ta nhËn 

®−îc Trung b×nh 
- Copy c«ng thøc ë « G3 xuèng c¸c « tõ G4 ®Õn G12, Excel sÏ xÕp lo¹i cho 

c¸c häc sinh cßn l¹i. 

 A B C D E F G 
2 TT Tªn To¸n Tin Trung b×nh XÕp thø XÕp lo¹i 
3 1 Hïng 4 7 5.5   
4 2 B×nh 6 8 7.0  Kh¸ 
5 3 V©n 8 9 8.5  Giái 
6 4 B×nh 9 10 9.5  XuÊt s¾c 
7 5 Doanh 5 8 6.5  Trung b×nh
8 6 Loan 5 4 4.5  KÐm 
9 7 Anh 9 6 7.5  Kh¸ 

10 8 Thu 3 5 4.0  KÐm 
11 9 Kh¸nh 6 7 6.5  Trung b×nh
12 10 Ng©n 10 8 9.0  Giái 
13      
14   §iÓm Lo¹i    
15   0 KÐm    
16   5 Trung b×nh    
17   7 Kh¸    
18   8.5 Giái    
19   9.5 XuÊt s¾c    
20        
21 §iÓm 0 5 7 8.5 9.5  
22 Lo¹i KÐm Trung b×nh Kh¸ Giái XuÊt s¾c  

      

hlookup(lookup_value, table_array, 
row_index_num,range_lookup) 

Hµm nµy ho¹t ®éng gièng nh− hµm VLOOKUP, ®iÓm kh¸c lµ : 
Lookup_value Gi¸ trÞ ®−îc t×m kiÕm trªn hµng ®Çu tiªn cña Table_array 
Table_array Vïng t×m kiÕm viÕt thµnh hµng 
Row_index_num Sè thø tù hµng trong table_array, n¬i HLOOKUP sÏ lÊy 

gi¸ trÞ tr¶ vÒ 
- Trong miÒn A21: F22 ta gâ vµo thang ®iÓm trªn d−íi d¹ng hµng, chó ý 

chØ gâ vµo cËn d−íi (theo chiÒu t¨ng) cña mçi lo¹i. 
Nh− vËy : 

lookup_value  lµ E3 (®iÓm Trung b×nh cña häc sinh thø 1) 

= VLOOKUP(E3,$C$14: $D$19,2) 
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table_array  lµ miÒn $B$21: $F$22 (miÒn ®Þa chØ tuyÖt ®èi, kh«ng ®−a 

cét tiªu ®Ò A21: A22 vµo) 
row_index_num  lµ 2 v× cÇn lÊy gi¸ trÞ cña hµng Lo¹i, hµng nµy cã sè thø tù 

lµ 2 trong miÒn B21: F22.  
- T¹i « F3 ®iÒn vµo c«ng thøc = HLOOKUP(E3,$B$21: $F$22,2), ta nhËn 

®−îc Trung b×nh 
- Copy c«ng thøc ë « G3 xuèng c¸c « tõ G4 ®Õn G12, Excel sÏ xÕp lo¹i cho 
c¸c häc sinh cßn l¹i. 

3.7. Hµm C¬ së d÷ liÖu 

Xem môc IX. 4. C¸c hµm CSDL (trang 55) 

 

v. ®å thÞ 
Kh¶ n¨ng biÓu diÔn sè liÖu b»ng ®å thÞ cña Excel rÊt phong phó. C¸c 

biÓu ®å ®−îc cµi ®Æt trªn b¶ng tÝnh t¨ng thªm søc hÊp dÉn vµ thuyÕt phôc 
cña sè liÖu.  

1. C¸c b−íc t¹o ®å thÞ míi 
1 - Chän miÒn d÷ liÖu cÇn ®−a vµo vÏ ®å thÞ, vÝ dô B2:F6, chó ý chän c¶ 

hµng tiªu ®Ò 1992, 1993,... vµ cét tªn c¸c b¶ng tÝnh ®Ó lµm nh·n cho 
®å thÞ. 

 

1 -Chän biÓu t−îng  (ChartWizard), con trá chuét trë thµnh dÊu + 

2 -X¸c ®Þnh miÒn h×nh ch÷ nhËt t¹i vïng trèng cña b¶ng tÝnh ®Ó ®−a ®å thÞ 
vµo b»ng c¸ch trá chuét vµo ®Ønh tr¸i trªn cña nã, Ên vµ gi÷ nót tr¸i ®ång 
thêi kÐo chuét vÒ ®Ønh ph¶i d−íi, th¶ nót chuét, xuÊt hiÖn hép tho¹i 
ChartWizard - Step 1 of 5  

3 -NÕu cÇn, söa l¹i ®Þa chØ cña miÒn d÷ liÖu ®−a vµo vÏ ®å thÞ trong 
khung Range b»ng c¸ch gâ trùc tiÕp hoÆc dïng chuét chän miÒn d÷ 
liÖu cÇn thiÕt (xem trang 13) 
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ý nghÜa c¸c nót trong hép tho¹i nh− sau : 

Cancel : huû bá viÖc vÏ ®å thÞ 
Next : chuyÓn sang b−íc tiÕp theo 
Back : quay trë l¹i b−íc tr−íc 
Finish : tù ®éng thùc hiÖn tÊt c¶ c¸c b−íc cho ®Õn kÕt thóc 

NÕu chän Next, xuÊt hiÖn hép tho¹i ChartWizard - Step 2 of 5 víi 
15 kiÓu ®å thÞ cña Excel (9 nhãm lo¹i hai chiÒu vµ 6 nhãm lo¹i 3 
chiÒu).  

5 -Chän mét kiÓu ®å thÞ (vÝ dô 3-D Column), cã thÓ gâ ký tù cã g¹ch 
ch©n cña kiÓu cÇn thiÕt råi Ên ↵ .Chó ý r»ng lo¹i Pie chØ ¸p dông cho 
mét d·y sè, vµ th−êng dïng ®Ó so s¸nh mét víi tÊt c¶ c¸c yÕu tè, vÝ 
dô so s¸nh sè hµng b¸n ®−îc cña 1 quý víi c¶ n¨m. 

 

Chän Next, xuÊt hiÖn hép tho¹i ChartWizard - Step 3 of 5 víi c¸c 
d¹ng cña kiÓu ®å thÞ ®−îc chän.  
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Chart Titles  : Tiªu ®Ò chung cña ®å thÞ 
Axis Titles  : Tiªu ®Ò cña c¸c trôc 
Category [X]  : Tiªu ®Ò cho trôc X 
Value [Z]  : Tiªu ®Ò cho trôc Z (trong kh«ng gian 3 chiÒu) 

Sau c¸c b−íc trªn, mét ®å thÞ sÏ ®−îc ®−a vµo b¶ng tÝnh t¹i vÞ trÝ ®· ®Þnh. 

2. ThiÕt lËp l¹i ®å thÞ 
1 -Chän ®å thÞ b»ng c¸ch trá chuét vµo trong lßng nã vµ bÊm nót tr¸i. 

XuÊt hiÖn khung bao quanh ®å thÞ víi c¸c chÊm vu«ng ë c¸c gãc vµ 
gi÷a c¸c c¹nh. 

  
2 -Chän biÓu t−îng ChartWizard, Excel lÇn l−ît ®−a ta trë l¹i c¸c b−íc 

®· nªu trªn. 
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3. ChØnh söa ®å thÞ 

a - ChØnh söa c¸c ®èi t−îng : 
1 -Trá chuét vµo trong lßng ®å thÞ vµ nh¸y ®óp, xuÊt hiÖn khung ch÷ 

nhËt cã c¹nh lµ c¸c säc chÐo víi chÊm vu«ng hoÆc mét cöa sæ riªng. 

2 -§Ó söa kiÓu ®å thÞ chän Format, Chart Type 
§Ó söa c¸c ®èi t−îng kh¸c, nh¸y ®óp t¹i ®èi t−îng cÇn thiÕt  (vÝ dô tiªu 

®Ò chung cña ®å thÞ), xuÊt hiÖn khung ch÷ nhËt víi chÊm vu«ng t¹i 
c¸c gãc vµ gi÷a c¸c c¹nh. Chän Format. Néi dung môc ®Çu tiªn cña 
menu däc tuú thuéc viÖc tr−íc ®ã ®èi t−îng nµo ®−îc chän, nh− 
trong vÝ dô nµy lµ Select Chart Title (tiªu ®Ò cña ®å thÞ). Chän môc 
nµy vµ tiÕn hµnh c¸c chØnh söa cÇn thiÕt.  

§Ó CÇn 

Thay ®æi kÝch th−íc  Trá chuét vµo chÊm vu«ng sao cho xuÊt hiÖn 
mòi tªn 2 ®Çu, kÐo vµ th¶ nã t¹i vÞ trÝ míi.  

ChuyÓn ®èi t−îng Trá chuét vµo mét c¹nh sao cho xuÊt hiÖn , 
kÐo vµ th¶ nã t¹i vÞ trÝ míi.  

Xo¸ mét ®èi t−îng Ên phÝm Delete 

KÕt thóc söa  Trá chuét vµo vïng ngoµi ®å thÞ bÊm nót tr¸i. 

 
b - Bæ sung / bá ®−êng kÎ l−íi : 

1 -Trá chuét vµo trong lßng ®å thÞ vµ nh¸y ®óp, xuÊt hiÖn khung ch÷ 
nhËt cã c¹nh lµ c¸c säc chÐo víi chÊm vu«ng. 

2 -Chän Insert, Gridlines. §¸nh dÊu chän vµo c¸c « cÇn thiÕt ®Ó bæ sung 
c¸c ®−êng kÎ l−íi, bá dÊu chän ®Ó huû bá c¸c ®−êng nµy: 

Major Gridlines §−êng kÎ chÝnh 
Minor Gridlines §−êng kÎ phô 
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c - Bæ sung thªm ®−êng biÓu diÔn : 

VÝ dô : ®Ó bæ sung thªm ®−êng biÓu diÔn sè liÖu cña n¨m 1996 vµo ®å thÞ : 
- Chän miÒn d÷ liÖu cÇn bæ sung (miÒn G2:G6) 
- KÐo vµ th¶ miÒn nµy vµo ®å thÞ. 

4. §å thÞ kiÓu ®Ìn chiÕu (Slideshow) 

Cã thÓ t¹o nhiÒu d¹ng ®å thÞ cho mét hoÆc nhiÒu b¶ng tÝnh sau ®ã 
cho tr×nh chiÕu ra mµn h×nh nh− phim ®Ìn chiÕu víi c¸c kiÓu mµn 
h×nh, thêi gian chuyÓn vµ ©m thanh ph¸t ra tr−íc mçi lÇn chuyÓn.  

a - T¹o ®å thÞ kiÓu ®Ìn chiÕu theo c¸c b−íc sau : 
1. Më mét hoÆc nhiÒu b¶ng tÝnh ®· t¹o ®å thÞ. 
2. Chän File, New. Hép tho¹i New xuÊt hiÖn (*)  

 
3.  Chän Sildes 

4. Chän OK (hoÆc Ên ↵ ). XuÊt hiÖn mµn h×nh Slides1 

 

5. Tõ menu chÝnh chän môc Windows, chän b¶ng tÝnh cã c¸c ®å thÞ ®· vÏ. 
6. Chän ®å thÞ cÇn ®−a vµo ®Ìn chiÕu. 

                                           
* NÕu kh«ng xuÊt hiÖn hép tho¹i nµy, ta chän môc Tools, Add-In, sau ®ã ®¸nh dÊu chän 

vµo môc Slideshow Template (nÕu môc nµy cã, nÕu kh«ng, ph¶i cµi bæ sung tÝnh n¨ng 
nµy cho Excel). 
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7. Tõ menu chÝnh chän môc Edit, Copy hoÆc Ên Ctrl + V, xuÊt hiÖn ®−êng 

®øt nÐt ch¹y xung quanh ®å thÞ. 
8. Chän Windows, chän tiÕp Slides1. XuÊt hiÖn mµn h×nh Slides1 nh− trªn. 
9. Chän nót Paste Slide. XuÊt hiÖn hép tho¹i Edit Slide : 

Effect : Chän c¸c kiÓu mµn h×nh chuyÓn tiÕp gi÷a hai ®å thÞ : 
Cut throught black : Mµu ®en 
Fade : S¸ng (tèi) dÇn 
Vertical blinds : Mµnh cuèn theo chiÒu ®øng 
 Horizontal blinds : Mµnh cuèn theo chiÒu ngang ... 

Test : Xem thö kiÓu mµn h×nh chuyÓn tiÕp.  
Advance : §Æt mét trong hai tuú chän sau : 

Manual : NÕu chän, sÏ t¾t chÕ ®é tù ®éng chuyÓn tiÕp tõ ®å thÞ nµy 
sang ®å thÞ kh¸c. Khi tr×nh chiÕu ta ph¶i Ên phÝm dÊu c¸ch 
hoÆc nót chuét th× Excel míi chuyÓn sang ®å thÞ sau. 

Time : Tù ®éng chuyÓn tiÕp tõ ®å thÞ nµy sang ®å thÞ kh¸c sau 
thêi gian bao nhiªu gi©y (ph¶i cung cÊp con sè t¹i « nµy). 

 
Sound : §Æt ©m thanh cho kiÓu ®Ìn chiÕu. 

Choose : Chän file ©m thanh (cã tªn *.WAV) trong th− môc Windows 
Test Sound : Nghe thö ©m thanh 
Clear : Xo¸ bá viÖc cµi ®Æt ©m thanh 

10. Chän OK ®Ó kÕt thóc viÖc t¹o kiÓu ®å thÞ ®Ìn chiÕu. Mµn h×nh Slides1 
xuÊt hiÖn. 

11. LÆp l¹i c¸c b−íc tõ 5 ®Õn 10 ®Ó t¹o kiÓu ®å thÞ ®Ìn chiÕu kh¸c. 
12. §Ó tr×nh diÔn c¸c kiÓu ®å thÞ ®Ìn chiÕu, chän nót Start Show cña mµn 

h×nh Slide1. Hép tho¹i Start Show xuÊt hiÖn 
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- NÕu ®¸nh dÊu chän vµo « Repeat show until 'Esc' is pressed th× ®Ó 

ngõng viÖc tr×nh diÔn ta ph¶i Ên phÝm Esc 

- Trong hép Initial Slide : ChØ ®Þnh tr×nh diÔn ®å thÞ ®Ìn chiÕu thø 
mÊy. 

13. §Ó ghi l¹i tÖp c¸c kiÓu ®å thÞ ®Ìn chiÕu, chän nót File, chän tiÕp : 
- Save : ChÊp nhËn tªn file mÆc ®Þnh lµ SLIDE1.XLS 
- Save As : §Æt tªn kh¸c cho file 
b - Söa ®å thÞ kiÓu ®Ìn chiÕu : 

1. Më file ®Ìn chiÕu cÇn chØnh söa. Cöa sæ mµn h×nh cña ®Ìn chiÕu 
xuÊt hiÖn.  

2. Thùc hiÖn c¸c thao t¸c chØnh söa : 
- Bæ sung thªm ®å thÞ ®Ìn chiÕu : më b¶ng tÝnh cã c¸c ®å thÞ ®· vÏ 

råi thùc hiÖn c¸c b−íc tõ 5 - 10 cña môc a ë trªn. 
- ChØnh söa c¸c th«ng sè cña mét kiÓu ®å thÞ : 

+ Chän ®å thÞ (Slide Image) cÇn chØnh söa 
+ Chän nót Edit Slide 
+ Söa c¸c th«ng sè theo ý muèn 

- Xo¸ mét kiÓu ®å thÞ : 
+ Chän ®å thÞ (Slide Image) cÇn xo¸ 
+ Chän nót Delete Row 

3. KÕt thóc viÖc söa, chän biÓu t−îng Save 

c - Tr×nh diÔn ®å thÞ kiÓu ®Ìn chiÕu : 
1. Më file ®Ìn chiÕu cÇn thiÕt.  
2. Chän nót Start Show (b−íc 12 cña môc a ë trªn) 

 

vIi. kiÓu tr×nh bµy 
Gièng trong Word, c¸c kiÓu tr×nh bµy (Style) gióp ®Þnh d¹ng c¸c « cña 

b¶ng tÝnh mét c¸ch nhanh chãng vµ thèng nhÊt. 
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1. T¹o mét kiÓu tr×nh bµy míi 
- §−a con trá vÒ « (hoÆc chän miÒn) cÇn t¹o, nÕu lµ b¶ng tÝnh míi ®−a con 

trá vÒ « A1. 
- Chän môc Format, Style. XuÊt hiÖn hép tho¹i Style 

 
- Trong khung Style Name chän kiÓu tr×nh bµy ®· t¹o hoÆc gâ vµo tªn cho 

kiÓu tr×nh bµy míi. 
- Chän nót Modify. XuÊt hiÖn hép tho¹i Format Cells (xem trang 18) 

Number : §Þnh d¹ng sè 
Aligment : Canh biªn  (dãng hµng) 
Font : §Þnh d¹ng ký tù 
Border : KÎ khung 
Pattern : §Æt mÇu nÒn 
Protection : B¶o vÖ « 

- TiÕn hµnh ®Þnh d¹ng d÷ liÖu. 
- Chän Add ®Ó bæ sung kiÓu tr×nh bµy míi. 
- Chän OK ®Ó kÕt thóc. 

2. ¸p dông mét kiÓu tr×nh bµy 

a. Dïng Menu 
- §−a con trá vÒ « (hoÆc chän miÒn) cÇn ¸p dông 
- Chän Format, Style 
- Chän kiÓu tr×nh bµy t−¬ng øng tõ danh s¸ch Style Name 
- OK 

b. Dïng thanh c«ng cô (gièng thao t¸c copy ®Þnh d¹ng cña Word) 
1 - §−a con trá vÒ « (hoÆc chän miÒn) cÇn ¸p dông 
2 - Chän biÓu t−îng Format Painter (chæi s¬n). Con trá chuét lóc nµy cã 

kÌm theo chæi s¬n. 
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♦ NÕu ®¸nh dÊu chän vµo môc Menu Item on Tools Menu, ph¶i gâ vµo 

tªn cña môc.  Sau nµy nÕu chän môc Tools tõ menu chÝnh, ta sÏ thÊy 
môc nµy ®−îc xÕp vµo cuèi cña menu däc. 

♦ NÕu ®¸nh dÊu chän vµo môc Shortcut Key, Excel ®Ò nghÞ mét ký tù b¾t 
®Çu b»ng ch÷ e, nÕu muèn ta cã thÓ xo¸ ch÷ e vµ gâ vµo ký tù kh¸c. 
Sau nµy ®Ó ch¹y Macro Ên tæ hîp phÝm Ctrl+phÝm nµy. L−u ý r»ng 
phÝm t¾t trong Excel ph©n biÖt ch÷ hoa víi ch÷ th−êng. VÝ dô khi gâ 
vµo ch÷ E lµm phÝm t¾t, lóc thùc hiÖn macro ph¶i bÊm Ctrl+Shift+e. 

5 - Trong khung Store in, chän Personal Macro Workbook ®Ó cã thÓ dïng 
Macro nµy trong c¸c b¶ng tÝnh kh¸c, nÕu kh«ng Macro chØ cã t¸c dông 
t¹i tËp b¶ng tÝnh hiÖn thêi (This WorkBook) hoÆc trong b¶ng tÝnh míi 
(New WorkBook). 

6 - Chän Visual Basic ®Ó c¸c thao t¸c mµ ta thu ®−îc thÓ hiÖn b»ng ng«n 
ng÷ nµy trong mét ®¬n thÓ (Module) 

7 - Chän OK ®Ó bÊt ®Çu ghi l¹i c¸c thao t¸c. Nh− ë vÝ dô nµy, ta cÇn chän 
c¸c biÓu t−îng %, lÊy thªm sè lÎ, in ®Ëm, g¹ch ch©n. 

8 - Chän nót Stop ®Ó kÕt thóc viÖc ghi Macro. NÕu kh«ng thÊy nót nµy, 
chän môc Tools, Record Macro, Stop Recording.  

2. G¸n Macro cho thanh c«ng cô 
- Chän View, Tools. XuÊt hiÖn hép tho¹i Toolbars 
- Chän nót Customize. 
- Trong khung Categories chän Custom. 
- KÐo mét biÓu t−îng Ýt dïng nµo ®ã trªn thanh c«ng cô vµ th¶ trªn b¶ng tÝnh 

®Ó cã chç. KÐo mét nót cña hép tho¹i Customize vµ th¶ trªn thanh c«ng cô. 
XuÊt hiÖn hép tho¹i Assign Macro. 

Stop Macro 
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- Chän tªn cña Macro cÇn thiÕt (nÕu cã) tõ danh s¸ch. Cã thÓ chän nót 

Record vµ thùc hiÖn c¸c b−íc tõ 2 ®Õn 8 cña môc 1. ë trªn ®Ó t¹o vµ g¸n 
mét Macro míi cho thanh c«ng cô. 

- Chän OK 
- Chän Close 

3. Ch¹y Macro 
a - §−a con trá vÒ chç cÇn ¸p dông Macro. 
b - Chän biÓu t−îng cña Macro, hoÆc tõ Menu chÝnh chän Tools, sau ®ã 

chän tiÕp môc cÇn thiÕt, hoÆc Ên tæ hîp phÝm nãng tuú theo tr−íc ®ã ta 
®· g¸n Macro cho thanh c«ng cô, Menu hoÆc Ên tæ hîp phÝm nãng. 

Còng cã thÓ ch¹y mét Macro theo c¸ch sau : 
- Chän Tools, Macro. Hép tho¹i Macro hiÖn ra. 
- Chän Macro cÇn thiÕt tõ danh s¸ch Macro Name. 
- Chän nót Run. 

4. Xo¸ Macro 
- Chän Tools, Macro. Hép tho¹i Macro hiÖn ra. 
- Chän Macro cÇn xo¸ tõ danh s¸ch Macro Name. 
- Chän Delete, Yes 

 
 

Ix. qu¶n trÞ d÷ liÖu 

1. Kh¸i niÖm c¬ b¶n 

C¬ së d÷ liÖu (CSDL) lµ tËp hîp c¸c d÷ liÖu ®−îc s¾p xÕp trªn mét vïng 
ch÷ nhËt (gåm Ýt nhÊt 2 hµng) cña b¶ng tÝnh theo quy ®Þnh sau : 
− Hµng ®Çu tiªn ghi c¸c tiªu ®Ò cña d÷ liÖu, mçi tiªu ®Ò trªn mét cét. C¸c 

tiªu ®Ò nµy ®−îc gäi lµ tr−êng (field) 
− Tõ hµng thø hai trë ®i chøa d÷ liÖu, mçi hµng lµ mét b¶n ghi (record) 
- Chó ý : + Tªn c¸c tr−êng ph¶i lµ d¹ng ký tù, kh«ng ®−îc dïng sè, c«ng 

thøc, to¹ ®é «...).Nªn ®Æt tªn tr−êng ng¾n gän, kh«ng trïng l¾p. 
+ Kh«ng nªn cã miÒn rçng trong CSDL 

2. S¾p xÕp d÷ liÖu 

- NÕu ®Þnh s¾p xÕp cho toµn bé CSDL: vÒ « bÊt kú cña nã. NÕu chØ ®Þnh s¾p 
xÕp cho mét sè b¶n ghi : chän miÒn d÷ liÖu cÇn ®−a vµo s¾p xÕp. XuÊt 
hiÖn hép tho¹i Sort. Excel cã thÓ s¾p xÕp theo 3 kho¸ (®iÒu kiÖn). Chän 
(bÊm nót chuét t¹i)  cña khung nµy. XuÊt hiÖn danh s¸ch tr¶i xuèng ghi 
tªn hoÆc thø tù c¸c tr−êng. Chän tr−êng cÇn thiÕt. 
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Sau ®©y lµ ý nghÜa c¸c môc : 
- Sort by  : cét −u tiªn nhÊt trong kho¸ s¾p xÕp.  
- Then by  : cét −u tiªn thø hai vµ thø ba trong kho¸ s¾p xÕp  
- Ascending  : s¾p xÕp t¨ng dÇn 
- Desending : s¾p xÕp gi¶m dÇn 
- My List Has : Header Row (hoÆc No Header Row): miÒn d÷ liÖu 

chøa (hoÆc kh«ng chøa) hµng tiªu ®Ò 
Nót Option 

- Case Sensitive : ph©n biÖt ch÷ hoa víi ch÷ th−êng 
- Orientation  : 

Sort Top To Bottom : s¾p xÕp c¸c dßng trong CSDL 
Sort Left  To Right : s¾p xÕp c¸c cét trong CSDL 

Chän OK ®Ó b¾t ®Çu s¾p xÕp. 
H×nh trªn lµ hép tho¹i Sort víi c¸c th«ng sè ®Ó danh s¸ch ®−îc xÕp theo 

vÇn A, B, C cña Tªn, nh÷ng b¶n ghi trïng tªn xÕp ng−êi cã ®iÓm Trung 
b×nh cao lªn trªn, nh÷ng b¶n ghi trïng ®iÓm Trung b×nh xÕp ng−êi cã 
®iÓm Tin cao lªn trªn. 

3. Läc d÷ liÖu 

a - C¸c yÕu tè c¬ b¶n 

§Ó thùc hiÖn läc d÷ liÖu, ph¶i x¸c ®Þnh c¸c yÕu tè c¬ b¶n sau trªn b¶ng tÝnh : 

- MiÒn d÷ liÖu (Database) : chøa toµn bé d÷ liÖu cÇn xö lý, kÓ c¶ hµng tiªu ®Ò. 

- MiÒn tiªu chuÈn (Criteria) : lµ miÒn bÊt kú trªn b¶ng tÝnh ngoµi vïng 
CSDL, chøa c¸c tiªu chuÈn (®iÒu kiÖn mµ c¸c b¶n ghi ph¶i th¶i m·n). 
MiÒn tiªu chuÈn gåm tèi thiÓu 2 hµng : hµng ®Çu chøa tiªu ®Ò cña miÒn 
tiªu chuÈn. C¸c tiªu ®Ò nµy hoÆc lµ tªn tr−êng hoÆc lµ tªn bÊt kú phô thuéc 
vµo ph−¬ng ph¸p thiÕt lËp tiªu chuÈn trùc tiÕp hay gi¸n tiÕp). Tõ hµng thø 
hai trë ®i lµ tiªu chuÈn cña CSDL. 
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MiÒn tiªu chuÈn so s¸nh trùc tiÕp (TCSSTT): cho phÐp ®−a vµo c¸c 
tiªu chuÈn ®Ó so s¸nh d÷ liÖu trong mét tr−êng víi mét gi¸ trÞ nµo ®ã.  
TCSSTT ®−îc t¹o ra theo nguyªn t¾c sau :  

− Hµng ®Çu ghi tiªu ®Ò cho c¸c tiªu chuÈn, lÊy tªn tr−êng lµm tiªu ®Ò. 

− Hµng thø hai trë ®i ®Ó ghi c¸c tiªu chuÈn so s¸nh, tr−íc c¸c gi¸ trÞ ®ã cã 
thÓ thªm c¸c to¸n tö so s¸nh nh− >, >=,<, <=. C¸c tiªu chuÈn trªn cïng 
hµng (th−êng ®−îc gäi lµ ®iÒu kiÖn vµ - and) ®−îc thùc hiÖn ®ång thêi. 
C¸c tiªu chuÈn trªn c¸c hµng kh¸c nhau (th−êng ®−îc gäi lµ ®iÒu kiÖn 
hoÆc lµ - or) ®−îc thùc hiÖn kh«ng ®ång thêi.  

VÝ dô vÒ c¸ch viÕt  TCSSTT : 

Tªn Läc ra nh÷ng ng−êi tªn lµ B×nh 

B×nh  
 

Trung b×nh Läc ra nh÷ng ng−êi ®¹t ®iÓm  

> = 5 Trung b×nh tõ 5 trë lªn 
 

Tuæi Läc ra nh÷ng ng−êi 18 tuæi 

18  

§Ó läc ra nh÷ng ng−êi ®¹t ®iÓm Trung b×nh tõ 5 ®Õn 8 (trong kho¶ng) 
lµm nh− sau : 

Trªn hµng tiªu ®Ò cña tiªu chuÈn ph¶i cã 2 « ®Òu ghi tr−êng Trung b×nh, 
ngay phÝa d−íi ghi ®iÒu kiÖn (trªn cïng mét hµng) :  

Trung b×nh Trung b×nh  

>=5 <8  

§Ó läc ra nh÷ng ng−êi XÕp lo¹i KÐm hoÆc Giái, XuÊt s¾c (tøc lµ ®iÓm 
Trung b×nh d−íi 5 hoÆc trªn 8 (ngoµi kho¶ng) lµm nh− sau: 

Ngay phÝa d−íi ghi ®iÒu kiÖn (trªn hai hµng) :  

Trung b×nh  

< 5  

> 8  

§Ó läc ra danh s¸ch Nam hoÆc Tuæi trªn 21 : 
§iÒu kiÖn ghi trªn hai hµng :  

Tuæi GT  

 Nam  

> 21   
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MiÒn tiªu chuÈn so s¸nh gi¸n tiÕp (TCSSGT) hay cßn gäi lµ tiªu chuÈn 
c«ng thøc: cho phÐp ®−a vµo c¸c tiªu chuÈn ®Ó so s¸nh d÷ liÖu hoÆc mét 
phÇn d÷ liÖu trong mét tr−êng víi mét gi¸ trÞ nµo ®ã.  TCSSGT ®−îc t¹o 
ra theo nguyªn t¾c sau :  

− Hµng ®Çu ghi tiªu ®Ò cho c¸c tiªu chuÈn. Tiªu ®Ò nµy cã thÓ ®Æt bÊt kú 
nh−ng kh«ng ®−îc trïng víi tªn tr−êng nµo. 

− Tõ hµng thø hai trë ®i ghi c¸c tiªu chuÈn so s¸nh, mçi tiªu chuÈn lµ mét c«ng 
thøc. C«ng thøc nµy ph¶i chøa ®Þa chØ cña b¶n ghi ®Çu tiªn. KÕt qu¶ thùc hiÖn 
c«ng thøc nµy lµ mét gi¸ trÞ Logic : TRUE (§óng) hoÆc FALSE (Sai) 

N¨m sinh  

=YEAR(C3) < 1975 Sinh tr−íc 1975 

Khi Ên ↵ , t¹i « tiªu chuÈn nµy sÏ xuÊt hiÖn FALSE (v× N¨m sinh cña 
Hïng lµ 1978) 

Ngµy sinh ch½n  

=MOD(DATE(C3),2) =0 Sinh vµo Ngµy ch½n 

Khi Ên ↵ , t¹i « tiªu chuÈn nµy sÏ xuÊt hiÖn TRUE (v× Ngµy sinh cña 
Hïng lµ 30) 

- MiÒn ®Ých (Copy to) : miÒn trèng trªn b¶ng tÝnh, dïng ®Ó chøa c¸c b¶n 
ghi ®¹t tiªu chuÈn.  

b - Läc tù ®éng (AutoFilter) 
- Chän miÒn d÷ liÖu ®Þnh läc (kÓ c¶ hµng tiªu ®Ò). 
- Data, Filter 
- Chän AutoFilter, Excel tù ®éng chÌn nh÷ng mòi tªn vµo bªn ph¶i cña c¸c 

tªn tr−êng. 
- Chän  t¹i cét chøa d÷ liÖu dïng lµm tiªu chuÈn ®Ó läc (vÝ dô t¹i cét XÕp lo¹i). 
- Chän mét trong c¸c môc t¹i Menu : 

[All] : HiÖn toµn bé c¸c b¶n ghi 
[Blanks] : ChØ hiÖn c¸c b¶n ghi trèng 
[Nonblanks] : ChØ hiÖn c¸c b¶n ghi kh«ng trèng 
[Custom ...]  : Dïng c¸c to¸n tö so s¸nh (sÏ ®−îc tr×nh bµy chi tiÕt 

trong phÇn tiÕp theo) 
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- Chän OK 

H×nh trªn ®Æt tiªu chuÈn läc danh s¸ch häc sinh KÐm, Giái, XuÊt s¾c 
(®iÓm Trung b×nh <=5.5 hoÆc >=8.5) 

Huû läc d÷ liÖu : 
- Huû läc trong 1 cét  : BÊm nót chuét t¹i  cña cét ®ã, chän [All] 
- Huû läc toµn bé  : - Data, Filter, chän AutoFilter ®Ó xo¸ dÊu  
- HiÖn l¹i tÊt c¶ c¸c hµng trong danh s¸ch ®−îc läc : 
  - Data, Filter, Show All 

c - Läc n©ng cao (Advanced Filter) 
Advanced Filter dïng ®Ó t×m c¸c b¶n ghi tho¶ m·n c¸c ®iÒu kiÖn phøc 

t¹p h¬n. Chøc n¨ng läc n©ng cao nµy øng víi víi c¸c tiªu chuÈn so s¸nh 
gi¸n tiÕp, b¾t buéc ph¶i dïng miÒn tiªu chuÈn.  C¸c b−íc nh− sau : 

- T¹o miÒn tiªu chuÈn. 
- Chän miÒn d÷ liÖu ®Þnh läc 
- Data, Filter 
- Chän Advanced Filter, ý nghÜa c¸c môc trong hép tho¹i Advanced 

Filter nh− sau : 
Action : 

Filter the List, in place  : Läc t¹i chç (ngay t¹i vÞ trÝ cña CSDL chØ 
hiÖn c¸c b¶n ghi tho¶ m·n tiªu chuÈn läc) 

Copy to Another Location  : TrÝch c¸c b¶n ghi ®¹t tiªu chuÈn läc sang 
miÒn kh¸c cña b¶ng tÝnh, ®Þa chØ cña miÒn 
nµy ®−îc x¸c ®Þnh t¹i khung Copy to 

List Range  : §Þa chØ miÒn d÷ liÖu nguån ®em läc  
Criteria Range  : §Þa chØ miÒn tiªu chuÈn 
Copy to  : §Þa chØ miÒn ®Ých ®Ó chøa c¸c b¶n ghi ®¹t tiªu chuÈn läc) 
Unique Record Only : ChØ hiÖn 1 b¶n ghi trong sè c¸c b¶n ghi trïng nhau. 

VÝ dô :  §Ó läc ra danh s¸ch c¸c häc sinh N÷ ®¹t ®iÓm Trung b×nh tõ 7 
trë lªn (XÕp lo¹i tõ Kh¸ trë lªn) cña danh s¸ch trªn trang 55 ta ®iÒn vµo c¸c 
môc trong hép tho¹i Advanced Filter nh− h×nh sau.  
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DSUM (database, field, criteria) 

TÝnh tæng trªn mét cét (field) cña CSDL (database) tho¶ m·n ®iÒu 
kiÖn ghi trong miÒn tiªu chuÈn (criteria) 

VÝ dô : ®Ó tÝnh tæng l−¬ng cña N÷, t¹i mét « trèng nµo ®ã cña b¶ng tÝnh, 
sau khi nhËp c«ng thøc  

= DSUM(A1:D10, 4 ,C12:C13) 
ta nhËn ®−îc gi¸ trÞ 280. 

Trong c«ng thøc nµy :   
A1:D10 lµ ®Þa chØ CSDL (database) 
C12:C13lµ ®Þa chØ miÒn tiªu chuÈn (criteria) 
4 lµ sè thø tù cña cét l−¬ng (cét cÇn tÝnh tæng) tÝnh tõ cét thø nhÊt cña 
CSDL (cét Tªn), cã thÓ thay con sè nµy b»ng "L−¬ng"(bao trong dÊu 
nh¸y kÐp) hoÆc D1 (« cã tr−êng L−¬ng) 

Khi chØ tÝnh theo 1 ®iÒu kiÖn th× cã thÓ thay hµm DSUM b»ng SUMIF. 
C«ng thøc trªn cã thÓ thay b»ng =SUMIF(C2:C10,”N÷”,D2:D10). Nh−ng 
khi tÝnh theo tõ 2 ®iÒu kiÖn trë lªn hµm DSUM thÓ ®−îc thay b»ng c«ng 
thøc m¶ng (xem trang 12). VÝ dô ®Ó tÝnh tæng L−¬ng cña nh÷ng ng−êi lµ 
N÷ cã L−¬ng tõ 50 trë lªn, c«ng thøc sau : 

=DSUM(A1:D10,D1,C12:D13) 
sÏ ®−îc thay b»ng c«ng thøc m¶ng : 

={SUM(IF(C2:C10=”N÷”,1,0)*IF(D2:D10>=50,1,0)* D2:D10)} 

DAVERAGE (database, field, criteria) 
TÝnh gi¸ trÞ trung b×nh céng trªn mét cét (field) cña CSDL (database) 

tho¶ m·n ®iÒu kiÖn ghi trong miÒn tiªu chuÈn (criteria) 

VÝ dô : ®Ó tÝnh tuæi trung b×nh cña N÷, sau khi nhËp c«ng thøc  
= DAVERAGE(A1:D10,2,C12:C13) 

ta nhËn ®−îc gi¸ trÞ 30.4 (Tuæi lµ cét thø 2 tÝnh tõ tr¸i sang, v× vËy 
trong c«ng thøc trªn cã thÓ thay con sè nµy b»ng "Tuæi") 

DMAX (database, field, criteria) 
TÝnh gi¸ trÞ lín nhÊt trªn mét cét (field) cña CSDL (database) tho¶ m·n 

®iÒu kiÖn ghi trong miÒn tiªu chuÈn (criteria) 

VÝ dô : ®Ó tÝnh L−¬ng cao nhÊt cña nh÷ng ng−êi 28 tuæi, sau khi nhËp 
c«ng thøc  

= DMAX(A1:D10,4,B12:B13) 
ta nhËn ®−îc gi¸ trÞ 80 

DMIN (database, field, criteria) 
TÝnh gi¸ trÞ nhá nhÊt trªn mét cét (field) cña CSDL (database) tho¶ m·n 

®iÒu kiÖn ghi trong miÒn tiªu chuÈn (criteria) 
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− At Each Change in : Chän tr−êng mµ theo tr−êng nµy, t¹i mçi vÞ trÝ thay 

®æi, Excel sÏ chÌn vµo mét dßng Tæng kÕt - tøc lµ dßng thùc hiÖn c¸c phÐp 
tÝnh (ë vÝ dô  trªn lµ tr−êng XÕp lo¹i, cø mçi khi chuyÓn sang lo¹i häc sinh 
kh¸c Excel l¹i chÌn dßng kÕt qu¶ tÝnh vµo t¹i c¸c dßng 5,8,12, 15,17). 

− Use Function : Chän hµm ®Ó tÝnh to¸n tæng kÕt d÷ liÖu. Hµm ngÇm ®Þnh 
lµ SUM. ë vÝ dô trªn dïng hµm Average ®Ó tÝnh gi¸ trÞ trung b×nh cña 
mét sè tr−êng. 

− Add SubTotal to : Chän c¸c tr−êng cÇn tÝnh to¸n (ë vÝ dô  trªn lµ tÝnh 
Trung b×nh c¸c tr−êng Tuæi, To¸n, Tin, Trung b×nh). 

 
C¸c tuú chän kh¸c : 

− Replace Current SubTotal : Khi t¹o dßng tæng kÕt míi dßng nµy sÏ thay 
thÕ dßng tæng kÕt cò. Theo ngÇm ®Þnh c¸c dßng tæng kÕt sÏ nèi tiÕp nhau. 

− Page Break Between Group : ChÌn dÊu ng¾t trang t¹i mçi vÞ trÝ cã dßng 
SubTotal (tøc lµ ®−a mçi nhãm sang mét trang riªng biÖt). 

− Summary Below Data : §Æt dßng tæng kÕt ë cuèi mçi nhãm. NÕu bá dÊu 
 dßng nµy sÏ ®−îc ®−a lªn tr−íc mçi nhãm. 

− Remove All : Huû bá mäi SubTotal ®· thùc hiÖn. 

3/ Chän Ok ®Ó b¾t ®Çu t¹o. 

b - Tæng kÕt theo nhiÒu lo¹i nhãm (PivotTable - B¶ng Tæng hîp) : 

Chøc n¨ng nµy cña Excel cho phÐp tù ®éng ho¸ qu¸ tr×nh tæng kÕt theo 
nhiÒu lo¹i nhãm, ph©n tÝch vµ ®¸nh gi¸ sè liÖu mµ sau ®©y chóng t«i gäi lµ 



Khoa CNTT - V§H Më Excel   59 
 
B¶ng Tæng hîp. 

B¶ng sau lµ mét CSDL vÒ doanh thu cña mét c¬ quan kinh doanh gåm 
2 cöa hµng ký hiÖu lµ Sè 1 vµ Sè 2. 

 A B C D E 
1 Ngµy Nh©n viªn Cöa hµng S¶n phÈm TiÒn 
2 29-08-97 H−¬ng Sè 1 KÑo 20 
3 29-08-97 Lan Sè 1 B¸nh 10 
4 30-08-97 Chi Sè 1 B¸nh 40 
5 30-08-97 Nga Sè 2 Møt 15 
6 30-08-97 V©n Sè 2 KÑo 25 
7 03-09-97 Chi Sè 1 B¸nh 30 
8 03-09-97 Lan Sè 1 KÑo 45 
9 03-09-97 Nga Sè 2 KÑo 20 
10 04-09-97 Chi Sè 1 Møt 10 
11 04-09-97 V©n Sè 2 B¸nh 35 

Tõ CSDL trªn, tæng hîp theo tõng cöa hµng, tõng nh©n viªn vµ tõng ngµy 
cho b¶ng Tæng hîp sau : 

Cöa hµng (All)           
  

Sum of TiÒn S¶n phÈm 
Nh©n viªn Ngµy B¸nh KÑo Møt Grand Total

Chi 03-09-97 30 0 0 30 
04-09-97 0 0 10 10 
30-08-97 40 0 0 40 

Chi Total  70 0 10 80 

H−¬ng 29-08-97 0 20 0 20 

H−¬ng Total 0 20 0 20 

Lan 03-09-97 0 45 0 45 
29-08-97 10 0 0 10 

Lan Total  10 45 0 55 

Nga 03-09-97 0 20 0 20 
30-08-97 0 0 15 15 

Nga Total  0 20 15 35 

V©n 04-09-97 35 0 0 35 
30-08-97 0 25 0 25 

V©n Total  35 25 0 60 

Grand Total 115 110 25   250 
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 C¸c kh¸i niÖm c¬ b¶n 

ë b¶ng CSDL trªn, tiªu ®Ò cña c¸c cét lµ c¸c "tr−êng" (field): Ngµy, 
Nh©n viªn, Cöa hµng, S¶n phÈm vµ TiÒn. C¸c tr−êng nµy sÏ tham gia vµo 
viÖc x©y dùng b¶ng Tæng hîp nµy. 

B¶ng Tæng hîp ®−îc chia lµm 4 vïng : 
Page Field : Toµn bé d÷ liÖu ®−îc tæng kÕt theo tõng nhãm (Item) cña 

tr−êng nµy. Page Field lu«n n»m ë phÝa trªn cña b¶ng Tæng hîp. Trong vÝ 
dô nµy, Page Field lµ Cöa hµng gåm 2 nhãm Sè 1 vµ Sè 2. 

Row Field : Mçi nhãm d÷ liÖu cña tr−êng nµy ®−îc tæng kÕt trªn mét 
dßng, v× vËy ®−îc gäi lµ "Row". NÕu sè Row Field nhiÒu h¬n 1, PivotTable 
sÏ tæng kÕt c¸c tr−êng nµy theo kiÓu lång nhau theo thø tù tõ trªn xuèng 
d−íi. Trong vÝ dô nµy, cã 2 Row Field lµ Nh©n viªn vµ Ngµy, tr−êng Nh©n 
viªn ®−îc tæng kÕt tr−íc råi míi ®Õn tr−êng Ngµy. 

Column Field : Mçi nhãm d÷ liÖu cña tr−êng nµy ®−îc tæng kÕt trªn 
mét cét, v× vËy ®−îc gäi lµ "Column". NÕu sè Nhãm nµy nhiÒu h¬n 1, 
PivotTable sÏ tæng kÕt c¸c nhãm nµy theo thø tù tõ tr¸i qua ph¶i. Trong vÝ 
dô nµy, c¸c Nhãm ®−îc tæng kÕt thµnh c¸c cét (tr−êng) theo thø tù ABC cña 
tªn nhãm : B¸nh, KÑo Møt. 

Data Field : vïng chÝnh cña B¶ng Tæng hîp ghi kÕt qu¶ cña mét phÐp 
to¸n. Trong vÝ dô nµy, sè liÖu cu¶ tr−êng TiÒn ®−îc ®−a vµo vµ phÐp to¸n 
tæng kÕt lµ lÊy tæng (SUM). 

 T¹o míi mét B¶ng Tæng hîp 
- Chän miÒn d÷ liÖu kÓ c¶ tiªu ®Ò cña c¸c cét (vÝ dô A1:E11) 
- Chän môc Data, PivotTable 

Hép tho¹i PivotTable Wizard step 1 of 4 xuÊt hiÖn. 
- Chän Microsoft Excel List of Database 
- Chän Next 

Hép tho¹i PivotTable Wizard step 2 of 4 xuÊt hiÖn. NÕu cÇn, söa l¹i 
®Þa chØ cña miÒn d÷ liÖu b»ng c¸ch gâ trùc tiÕp hoÆc dïng chuét chän l¹i. 

- Chän Next. XuÊt hiÖn hép tho¹i PivotTable Wizard Step 3 of 4. 
- Chän c¸c tr−êng ®Ó ®−a vµo c¸c vïng cña b¶ng b»ng c¸ch kÐo vµ th¶ 

tªn tr−êng ë bªn ph¶i hép tho¹i tíi c¸c vïng ®−îc Ên ®Þnh trong b¶ng. 

ë vÝ dô nµy chóng t«i ®−a vµo c¸c mòi tªn (chØ h−íng kÐo th¶) ®Ó ta ®äc 
tiÖn thao t¸c. Cô thÓ, ta  

KÐo tr−êng th¶ t¹i vïng 
Cöa hµng PAGE 
Nh©n viªn ROW 
Ngµy ROW 
S¶n phÈm COLUMN 
TiÒn DATA 
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Sau thao t¸c trªn, hép tho¹i cã d¹ng : 

 

Chän Next ®Ó chuyÓn sang b−íc tiÕp theo. XuÊt hiÖn hép tho¹i 
PivotTable Wizard Step 4 of 4. 

Trong hép PivotTable Starting Cell ta chØ ra ®Þa chØ cña « ®Çu tiªn 
(gãc tr¸i trªn) cña b¶ng Tæng hîp (vÝ dô : nÕu ta chän « A13, Excel sÏ tù 
®iÒn vµo Sheet1!$A$13). NÕu kh«ng, b¶ng Tæng hîp sÏ ®−îc ®Ó ë Sheet 
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míi (tiÕp ngay sau Sheet hiÖn t¹i). 

 
Trong hép PivotTable Name ta gâ vµo tªn cña b¶ng Tæng hîp (tr−êng 

hîp cÇn t¹o nhiÒu b¶ng Tæng hîp cho mét CSDL), vÝ dô Tæng kÕt B¸n hµng. 

ý nghÜa c¸c lùa chän kh¸c nh− sau : 
Grand Total For Columns  : T¹o thªm cét tæng cho mçi sè liÖu cña 

Column Field. 
Grand Total For Rows  : T¹o thªm hµng tæng cho mçi sè liÖu cña 

Row Field. 
Save Data With Table Layout  : B¶ng Tæng hîp ®−îc l−u tr÷ cïng víi 

Format ®−îc t¹o. 
AutoFormat Table : Tù ®éng t¹o khu«n cho B¶ng Tæng hîp 

 §iÒu chØnh B¶ng Tæng hîp 
Thay ®æi vÞ trÝ c¸c tr−êng : Trong B¶ng Tæng hîp kÐo vµ th¶ tªn tr−êng 

t¹i vÞ trÝ mong muèn. ë vÝ dô trªn, cã thÓ ®æi chç cho hai tr−êng Nh©n viªn 
vµ Ngµy b»ng c¸ch kÐo tr−êng Nh©n viªn vÒ bªn ph¶i tr−êng Ngµy vµ th¶ 
t¹i ®ã. 

Bæ sung c¸c tr−êng :  
- Chän « bÊt kú cña B¶ng Tæng hîp 
- Chän môc Data, PivotTable 
- Thùc hiÖn l¹i c¸c b−íc nh− khi t¹o míi b¶ng Tæng hîp ®Ó bæ sung 

tr−êng vµo c¸c vÞ trÝ mong muèn. 
Xo¸ tr−êng : Trong B¶ng Tæng hîp kÐo tªn tr−êng cÇn xo¸ ra khái b¶ng. 
Söa tªn tr−êng : §−a con trá « vÒ tr−êng cÇn thiÕt trong B¶ng Tæng hîp 

vµ tiÕn hµnh söa tªn nh− söa d÷ liÖu cña b¶ng tÝnh 
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 Thay ®æi hµm sè tÝnh to¸n 

ë chÕ ®é mÆc ®Þnh sè liÖu cña vïng DATA ®−îc lÊy tæng vµ c¸c cét 
hoÆc hµng Total còng ®−îc lÊy tæng. Cã thÓ thay ®æi c¸c c¸ch tÝnh nµy b»ng 
c¸c hµm sè kh¸c nh− ®Õm (Count), tÝnh trung b×nh (Average), t×m cùc ®¹i 
(Max), t×m cùc tiÓu (Min),... C¸c b−íc nh− sau : 

-  Trong B¶ng Tæng hîp chän tr−êng tr−íc ®ã ta ®· ®−a vµo vïng 
DATA (nh− ë vÝ dô trªn trang 59, chän « Grand Total)  

- Chän môc Data, PivotTable Field, xuÊt hiÖn hép tho¹i sau : 

 

- Chän hµm t−¬ng øng danh s¸ch Summarize by 
- Chän OK 

 Tù ®éng ®iÒu chØnh B¶ng Tæng hîp khi d÷ liÖu gèc thay ®æi  
Sau khi söa sè liÖu cña CSDL 
- Chän « bÊt kú cña B¶ng Tæng hîp 
- Chän môc Data, Refresh Data 
 
 

X. tr×nh bµy trang 

1. Chän cì giÊy, h−íng in 

- Chän File, Page Setup. XuÊt hiÖn hép tho¹i Page Setup 
- Chän Page 
- Chän cì giÊy trong khung Paper Size 
- Chän Landscape ®Ó in ngang giÊy, Portait ®Ó in däc 
- OK 
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2. §Æt lÒ 

- Chän File, Page Setup 
- Chän Margins 

Chän §Ó ®Æt kho¶ng c¸ch cho 

Top LÒ trªn (1)   
Bottom LÒ d−íi (2) 
Left  LÒ tr¸i (3) 
Right LÒ ph¶i (4) 
Header LÒ cña tiªu ®Ò ®Çu trang (5) 
Footer LÒ cña tiªu ®Ò cuèi trang (6) 

- §Æt l¹i kho¶ng c¸ch c¸c lÒ cho phï hîp, cÇn chó ý r»ng c¸c kho¶ng 
c¸ch nµy ®−îc tÝnh b»ng cm hoÆc inch. 

3. T¹o tiªu ®Ò ®Çu / cuèi trang 

a - Chän tiªu ®Ò ®Çu / cuèi trang theo mÉu : 
- Chän File, Page Setup 
- Chän Header /Footer 
- Chän Header hoÆc Footer, xuÊt hiÖn danh s¸ch c¸c mÉu, ý nghÜa cña 

chóng nh− sau:  
(none) §Ó trèng phÇn tiªu ®Ò ®Çu/ cuèi trang 
Page 1 In ch÷ Page kÌm theo sè trang 
Page 1 of ? In ch÷ Page kÌm theo sè trang cña tæng sè trang 

Mét mÉu (sample) xuÊt hiÖn cho ta thÊy kÕt qu¶ cña viÖc chän 
- Chän OK 

(1)

(2)

(3) (4) 

(5)

(6)
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b - Tù t¹o tiªu ®Ò ®Çu / cuèi trang: 

- Chän File, Page Setup 
- Chän Header /Footer 
- Chän Custom Header hoÆc Custom Footer, xuÊt hiÖn hép tho¹i sau : 

 
 
- CÇn t¹o cho phÇn nµo cña tiªu ®Ò ®−a con trá ®Õn phÇn ®ã vµ gâ v¨n b¶n 
vµo hoÆc chän c¸c nót t−¬ng øng. VÝ dô ®Ó t¹o tiªu ®Ò nh− c¸c trang lÎ cña 
tµi liÖu nµy, ta gâ vµo Khoa CNTT t¹i « Left Section vµ nh¸y chuét t¹i nót 
Chän Font ch÷ ®Ó tr×nh bµy kiÓu, cì ch÷. Lµm t−¬ng tù nh− vËy víi tõ 
Excel ë « Center Section. §Ó cã sè trang ë gãc ph¶i tiªu ®Ò, ta ®−a con trá 
vÒ « Right Section vµ chän nót §¸nh sè trang 

- OK 

4. ChÌn / xo¸ dÊu ng¾t trang 

a - ChÌn dÊu ng¾t trang däc vµ ngang : 
- Chän « n¬i ta muèn b¾t ®Çu trang míi. 
- Insert, Page Break 

Excel chÌn dÊu ng¾t trang (lµ c¸c ®−êng kÎ nÐt ®øt) ë trªn vµ bªn tr¸i « 
®−îc chØ ®Þnh. 

 b - ChØ chÌn mét dÊu ng¾t trang ngang : 

- Chän hµng n¬i ta muèn b¾t ®Çu trang míi. 
- Insert, Page Break 

Excel chÌn dÊu ng¾t trang ë trªn hµng ®−îc chØ ®Þnh. 

 c - ChØ chÌn mét dÊu ng¾t trang däc : 
- Chän cét n¬i ta muèn b¾t ®Çu trang míi. 
- Insert, Page Break 

Excel chÌn dÊu ng¾t trang ë bªn tr¸i cét ®−îc chØ ®Þnh. 

 d - Xo¸ mét dÊu ng¾t trang: 
- Chän « bÊt kú ngay phÝa d−íi dÊu ng¾t trang ngang hoÆc ngay bªn ph¶i 

dÊu ng¾t trang däc. 

Chän Font ch÷ 

ChÌn Ngµy, giê 
§¸nh sè trang 

ChÌn tªn File 

PhÇn bªn tr¸i 
cña tiªu ®Ò 

PhÇn gi÷a 
cña tiªu ®Ò 

PhÇn bªn ph¶i 
cña tiªu ®Ò 



Khoa CNTT - V§H Më Excel   66 
 

- Insert, Remove Page Break 

 e - Xo¸ tÊt c¶ c¸c dÊu ng¾t trang: 
- Chän toµn bé b¶ng tÝnh. 
- Insert, Remove Page Break 

5. LÆp l¹i tiªu ®Ò cña b¶ng tÝnh khi sang trang 

ë c¸c b¶ng tÝnh lín, mçi khi sang trang, ®Ó tr¸nh ph¶i gâ l¹i c¸c tiªu ®Ò, 
ta lµm nh− sau : 

- Chän File, Page Setup 
- Chän Sheet, xuÊt hiÖn hép tho¹i sau : 

 
- NÕu cÇn lÆp l¹i c¸c hµng tiªu ®Ò, trong khung Rows to Repeat at Top 

®iÒn vµo sè thø tù cña chóng. VÝ dô, ë bµi tËp 3 trang 72, ®Ó mçi khi 
sang trang, tiªu ®Ò TT  Hä vµ tªn  CV ... t¹i hµng 2 cña b¶ng tÝnh ®−îc 
lÆp l¹i, ta ®iÒn vµo $2:$2 (b»ng c¸ch gâ trùc tiÕp hoÆc dïng chuét chän 
1 « bÊt kú nµo cña hµng ®ã). 

- NÕu cÇn lÆp l¹i c¸c cét bªn tr¸i b¶ng tÝnh trong khung Columns to 
Repeat at Left ®iÒn vµo sè thø tù cña chóng. VÝ dô, ë bµi tËp 3 trang sau 
khi chÌn dÊu ng¾t trang däc t¹i cét K, ta muèn ë trang ®Çu in c¸c cét tõ 
TT  Hä vµ tªn  ®Õn T¹m øng (tõ cét A ®Õn cét I ), cßn ë trang sau in 
c¸c cét TT  Hä vµ tªn vµ cét Cßn l¹i, ta ®iÒn vµo $A:$B (v× cÇn lÆp l¹i 
2 cét TT  Hä vµ tªn) b»ng c¸ch gâ trùc tiÕp hoÆc dïng chuét chän 2 « 
bÊt kú nµo trªn cïng hµng cña 2 cét ®ã. 

- Chän OK. 

Ta chØ thÊy tiªu ®Ò lÆp l¹i khi chän biÓu t−îng Print Preview (kÝnh 
lóp) hoÆc khi in ra giÊy.  
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6. Kh«ng in l−íi cã s½n cña b¶ng tÝnh 
§Ó Excel chØ in khung cho c¸c « do ta kÎ mµ kh«ng in l−íi cã s½n cho 

c¸c « kh¸c cña b¶ng tÝnh, ta lµm nh− sau : 
- Chän File, Page Setup 
- Chän Sheet 

- Bá dÊu chän x t¹i « Grid 
- OK 

 

xi. in 

Tr−íc khi in nªn : 
- Chän môc File, Print Preview (hoÆc biÓu t−îng Print Preview) ®Ó xem bè 

côc (h×nh thï) b¶ng tÝnh 
- KiÓm tra xem m¸y in ®· s½n sµng ch−a (®· nèi víi m¸y tÝnh ch−a, ®· bËt 

ch−a, ®· n¹p giÊy ch−a v.v..). 
§Ó in toµn bé b¶ng tÝnh, chän biÓu t−îng Print trªn thanh c«ng cô. 
§Ó in tõng phÇn b¶ng tÝnh : 

- Chän môc File, Print. xuÊt hiÖn hép tho¹i sau : 

 

Selections  : In mét khèi ®· ®−îc chän tr−íc ®ã. 
Selected Sheet(s)  : In mét hoÆc nhãm b¶ng tÝnh 
Entire Workbook  : In toµn bé tËp b¶ng tÝnh 
Pages  : In mét d·y c¸c trang : ®iÒn vµo sè thø tù cña trang 

®Çu d·y trong « From, sè thø tù cña trang cuèi 
trong « To 

- Chän OK. 
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xII. lµm viÖc víi nhiÒu b¶ng tÝnh 
- LÇn l−ît më c¸c b¶ng tÝnh. 

Trªn mµn h×nh lµ b¶ng tÝnh ®−îc më sau cïng. §Ó chuyÓn sang lµm viÖc 
víi b¶ng tÝnh kh¸c : 

- Chän Window, Excel liÖt kª c¸c b¶ng tÝnh ®ang më víi sè thø tù cña 
chóng, tªn b¶ng tÝnh chøa con trá cã dÊu √  ë bªn tr¸i 

 - Chän b¶ng tÝnh mµ ta cÇn chuyÓn tíi (hoÆc gâ sè thø tù cña b¶ng tÝnh 
®ã) 

Muèn cho hiÖn ra tÊt c¶ c¸c b¶ng tÝnh trªn mµn h×nh : 

- Chän Window, Arrange. XuÊt hiÖn hép tho¹i Arrange Windows 

Chän môc §Ó s¾p xÕp c¸c cöa sæ b¶ng tÝnh 
Title Phñ kÝn mµn h×nh 

Horizontal Theo chiÒu ngang 

Vertical Theo chiÒu däc 

Cascade So le 

- §Ó chuyÓn sang b¶ng tÝnh nµo, kÝch chuét t¹i cöa sæ cña b¶ng tÝnh ®ã 
hoÆc Ên Ctrl+F6. Ta cã thÓ thùc hiÖn c¸c thao t¸c víi c¸c cöa sæ nµy 
nh− : s¾p xÕp l¹i, thay ®æi kÝch th−íc, ®ãng v.v.. 

Cã thÓ copy, chuyÓn khèi tõ b¶ng tÝnh nµy sang b¶ng tÝnh kh¸c (xem 
c¸c thao t¸c víi khèi ë trang 13).  

Khi kh«ng cÇn b¶ng tÝnh nµo ta nªn ®ãng nã l¹i (®Ó gi¶i phãng bít bé 
nhí) b»ng c¸ch chuyÓn vÒ b¶ng tÝnh ®ã, chän File, Close hoÆc ®ãng cöa sæ 
cña b¶ng tÝnh ®ã l¹i 



Khoa CNTT - V§H Më Excel   69 
 

xiii. trao ®æi th«ng tin víi word 

1. ChuyÓn c¸c kÕt qu¶ cña Excel cho Word 

 Theo c¸c b−íc sau : 

- Chän miÒn d÷ liÖu cña b¶ng tÝnh cÇn chuyÓn cho Word (xem c¸ch ®¸nh 
dÊu khèi ë trang 13). NÕu lµ ®å thÞ chØ cÇn trá chuét vµo trong lßng nã, Ên 
nót tr¸i, xuÊt hiÖn chÊm vu«ng t¹i c¸c c¹nh vµ gãc cña khung. 

- Chän biÓu t−îng Copy trªn thanh c«ng cô hoÆc môc Edit, Copy. NÕu 
kh«ng cÇn lµm viÖc víi Excel n÷a, tho¸t khái ch−¬ng tr×nh nµy (xem trang 
4). NÕu ta ®−a vµo bé nhí mét khèi lín, h·y tr¶ lêi Yes cho c©u hái Save 
Large Clipboard From ... ? 

- Khëi ®éng Word (nÕu cÇn), trong Word ta më tµi liÖu vµ ®−a con trá vÒ vÞ trÝ 
cÇn thiÕt, sau ®ã lµm theo mét trong hai c¸ch sau : 
C¸ch 1 : Chän biÓu t−îng Paste trªn thanh c«ng cô hoÆc môc Edit, Paste. 
C¸ch 2 : Chän môc Edit, Paste Special, Paste Link. 

Sù kh¸c nhau gi÷a 2 c¸ch d¸n :  

B»ng c¸ch 2, mäi thay ®æi cña ®èi t−îng trong Excel sÏ ®−îc ph¶n ¶nh trong 
Word. Trong khi ®ã ë c¸ch 1 sù söa ®æi kh«ng ®−îc ph¶n ¶nh. 

Chó ý : Kh«ng thÓ ®−a ®ång thêi mét lóc b¶ng tÝnh vµ ®å thÞ sang cho 
Word ®−îc. Ta ph¶i thùc hiÖn c¸c thao t¸c trªn lÇn l−ît cho tõng 
lo¹i mét. 

2. ChuyÓn b¶ng ®∙ gâ b»ng Word cho Excel  

Kh¶ n¨ng tÝnh to¸n trong b¶ng cña Word rÊt yÕu. Nªó cÇn tÝnh to¸n trong 
c¸c b¶ng ®· ®−îc gâ b»ng Word, nªn chuyÓn chóng cho Excel theo c¸c 
b−íc sau : 

- Trong Word, chän c¸c « hay toµn bé b¶ng ®· gâ. 

- Chän biÓu t−îng Copy trªn thanh c«ng cô hoÆc môc Edit, Copy. NÕu 
kh«ng cÇn lµm viÖc víi Word n÷a, ta ra khái ch−¬ng tr×nh nµy. NÕu ta 
®−a vµo bé nhí mét khèi lín, h·y tr¶ lêi Yes cho c©u hái Save Large 
Clipboard From ... ? 

- Khëi ®éng Excel (nÕu cÇn), trong Excel më b¶ng tÝnh vµ ®−a con trá vÒ vÞ 
trÝ cÇn thiÕt, , sau ®ã lµm theo mét trong hai c¸ch sau : 
C¸ch 1 : Chän biÓu t−îng Paste trªn thanh c«ng cô hoÆc môc Edit, Paste. 
C¸ch 2 : Chän môc Edit, Paste Special, Paste Link. 

B»ng c¸ch 2, mäi thay ®æi cña ®èi t−îng trong Word sÏ ®−îc ph¶n ¶nh trong 
Excel. Trong khi ®ã ë c¸ch 1 sù söa ®æi kh«ng ®−îc ph¶n ¶nh. 
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bµi thùc hµnh 
Bµi 1.  LËp b¶ng doanh thu sau : 

 A B C D E F G 
1 Dù  tÝnh thu nhËp n¨m 1997 c«ng ty X 
2 H¹ng môc Qóy I Qóy II   Qóy III Qóy IV C¶ n¨m VN§ 

3 B¸n :  14000 15000 16000 24000  69000  
4 Chi phi :    
5 L−¬ng  2000  2000 2000 2000 8000   
6 Tr¶ l·i  1200  1400  1500 1600 5700  
7 Nhµ  600 600   600  600 2400  
8 Qu¶ng c¸o 900 2000 1700 4000 8600  
9 VËt t−  4000 4200 4500 5000 17700  
10 Tæng chi : 8700 10200 10300 13200 42400  
11 Thu nhËp:    
12 Qóy  5300 4800 5700 10800   
13 Tíi qóy  5300  10100 15800 26600 Tû gi¸  11.000 

- Kh«ng gâ d÷ liÖu ë c¸c cét F, G vµ c¸c hµng 10,12,13.  

C¸ch tÝnh nh− sau : 

C¶ n¨m  = Σ C¸c quý, t¹i « F3 gâ = SUM(B3:E3) 

Tæng chi = Σ C¸c môc chi, t¹i « B10 gâ = SUM(B5:B9) 
Thu nhËp Quý  = B¸n - Tæng chi, t¹i « B12 gâ = B3-B10 
Thu nhËp tíi quý = Luü kÕ c¸c quý tr−íc, 

t¹i « B13 gâ = B12 
t¹i « C13 gâ = B13+C12 
copy c«ng thøc tõ « C13 sang D13:E13 

- ChÌn thªm 1 hµng vµo gi÷a c¸c hµng 3 vµ 4 ®Ó tÝnh % tiÒn b¸n ®−îc cña 
tõng quý so víi c¶ n¨m. 

- Trong cét G tÝnh tiÒn b¸n ®−îc vµ tiÒn chi phÝ quy ra tiÒn ViÖt theo tû gi¸ 
ghi ë « cuèi b¶ng (« G13) 

- VÏ ®å thÞ : tiÒn b¸n ®−îc cña c¸c quý 
 sè liÖu c¸c môc chi 
 tiÒn b¸n ®−îc vµ tæng chi cña c¸c quý 
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Bµi 2. LËp b¶ng kÕt qu¶ thi sau : 

 A B C D E F G H I J 

1 kÕt qu¶ thi cuèi kú - líp tin häc c¬ së 

2 TT Tªn Ngµy sinh Tuæi Gt To¸n Tin Trung 
b×nh

XÕp 
thø 

XÕp lo¹i

3 1 Hïng 30/01/78  Nam 4 7 5.5 8 Trung b×nh
4 2 B×nh 21/08/74  N÷ 7 7 7.0 5 Kh¸ 
5 3 V©n 12/11/70  N÷ 8 9 8.5 3 Giái 
6 4 B×nh 15/06/77  N÷ 9 10 9.5 1 XuÊt s¾c 
7 5 Doanh 05/12/76  Nam 5 8 6.5 7 Trung b×nh
8 6 Loan 18/09/77  N÷ 5 4 4.5 9 KÐm 
9 7 Anh 23/04/68  Nam 9 6 7.5 4 Kh¸ 
10 8 Thu 01/05/73  N÷ 3 5 4.0 10 KÐm 
11 9 B×nh 26/02/71  Nam 6 8 7.0 5 Kh¸ 
12 10 Ng©n 12/05/75  N÷ 10 8 9.0 2 Giái 
13   Cao nhÊt   10 10 9.5   
14   Trung b×nh   6.6 7.2 6.9   
15   ThÊp nhÊt   3.0 4.0 4.5   

- Kh«ng gâ d÷ liÖu ë c¸c cét A, D, H, I, J vµ c¸c hµng 13, 14, 15 
- §¸nh sè Thø tù 
- TÝnh Tuæi : =YEAR(TODAY( ))-YEAR(C3) 
- TÝnh §iÓm Trung b×nh = AVERAGE(F3:G3) 
- TÝnh c¸c gi¸ trÞ cao nhÊt (MAX), trung b×nh (AVERAGE), thÊp nhÊt 

(MIN) cña c¸c cét Tuæi, ®iÓm To¸n, Tin, Trung b×nh 
- XÕp thø = RANK(H3,$H$3:$H$12) 
- XÕp lo¹i theo §iÓm trung b×nh theo thang ®iÓm sau : 

     
KÐm 5 Trung b×nh 7 Kh¸ 8 Giái 9.5 XuÊt s¾c

b»ng 2 c¸ch : 

+ dïng hµm IF 

= IF(H3>=9.5,"XuÊt s¾c",IF(H3>=8,"Giái",IF(H3>=7,"Kh¸", 

IF(H3>=5,"Trung b×nh", "KÐm")))) 

+ dïng hµm HLOOKUP hoÆc VLOOKUP (trang 37) 

- §¸nh l¹i thø tù xÕp thø  
- S¾p xÕp danh s¸ch theo ABC cña Tªn häc viªn, nh÷ng ng−êi trïng tªn xÕp 

ng−êi cã ®iÓm Trung b×nh cao lªn trªn. 
- §−a ra 4 nhãm danh s¸ch xÕp lo¹i (Giái, Kh¸, Trung b×nh, KÐm) vµ sè häc viªn 

cña mçi lo¹i. TÝnh xem mçi lo¹i chiÕm bao nhiªu phÇn tr¨m cña tæng sè. 
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BÀI 4: CÁC HÀM CƠ BẢN TRONG EXCEL 

4.1. Nhóm hàm số 

  

ABS(number) Trả lại trị tuyệt đối của tham số number 
ABS(-5) ->5 

INT(number) Làm tròn một số tới số nguyên gần nhất;  

INT(3.2)->3, 

INT(-3.2)->-4 

MOD(number,divisor) Trả lại số dư của phép chia number cho số 
chia divisor 
MOD(10,3) ->1 
MOD(11,3)->2 

ROUND(number,num_digits) Làm tròn tham số number đến vị trí thứ 
num_digits của phần thập phân;  
ROUND(123.456,2) -> 123.46 
ROUND(123.456,1)->123.5 
ROUND(123.456,0)->123 
ROUND(123.456,-1)->120 

SQRT(number) Tính căn hai của number 
SQRT(25)->5 
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SUMIF(range,criteria,sum_range) Cộng các ô thoả mãn một tiêu chuẩn nào đó. 

- Range là vùng các ô cần ước lượng.  

- Criteria là tiêu chuẩn dưới dạng số, biểu 
thức, hay văn bản xác định các ô sẽ được 
cộng. Ví dụ về tiêu chuẩn là 32, "32", ">32", 
"apples".  

- Sum_range là các ô đợc cộng. Các ô trong 
vùng sum_range chỉ được cộng nếu các ô tư-
ơng ứng trong vùng range phù hợp với tiêu 
chuẩn criteria. Nếu bỏ qua sum_range thì 
chính các ô trong vùng range được cộng  

Ví dụ : Giả sử các ô từ A1:A4 lần lượt chứa 

các giá bất động sản sau: $100,000, 

$200,000, $300,000, $400,000. Còn các ô 

B1:B4 chứa tiền hoa hồng lần lượt ứng với 

mỗi giá bất động sản: $7,000, $14,000, 

$21,000, $28,000. 

SUMIF(A1:A4,">160000",B1:B4)bằng 

63,000 
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4.2. Nhóm hàm thống kê 

AVERAGE(number1,number2,...) Tính trung bình cộng của các tham số 
number1, number2,.... 

Ví dụ Trong các ô B1,B2,B3 chứa lần 
lợt 4, 8, 3; thì khi đó 
AVERAGE(B1:B3)->5 

COUNT(value1,value2,...) Đếm các ô kiểu số trong danh sách đối 
value1, value2,..  

Countif(range,criteria) Đếm các ô trên vùng range thoả mãn 
tiêu chuẩn criteria 

- Range là vùng các ô cần đếm.
-    Criteria là tiêu chuẩn dưới dạng số, 
biểu thức, hay chuỗi văn bản chỉ định ô 
được đếm. Ví dụ tiêu chuẩn có thể viết 
dưới dạng sau 32, "32", ">32", 
"apples" 

Ví dụ: Giả sử A3:A6 chứa tương ứng: 
"apples", "oranges", "peaches", 
"apples". Khi đó 
COUNTIF(A3:A6,"apples") bằng 2  

Giả sử B3:B6 chứa 32, 54, 75, 86. Khi 
đó COUNTIF(B3:B6,">55") bằng 2  

MAX(number1,number2,...) Trả lại trị lớn nhất trong các tham biến 

Ví dụ: Dữ liệu trong các ô D1,D2,D3 
lần lợt là 5,7,9; trong ô D4 nhập công 
thức =MAX(D1:D3) khi đó D4 bằng 9 
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MIN(number1,number2,...) Trả lại trị bé nhất trong các tham biến 

Ví dụ: Dữ liệu trong các ô D1,D2,D3 
lần lợt là 5,7,9; trong ô D4 nhập công 
thức =MIN(D1:D3) khi đó D4 bằng 5 

SUM(number1,number2,..) Tính tổng các số trong danh sách tham 
số 

Ví dụ: Dữ liệu trong các ô D1,D2,D3 
lần lợt là 5,7,9; trong ô D4 nhập công 
thức =SUM(D1:D3) khi đó D4 bằng 
21 
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4.3. Nhóm hàm chuỗi 

 

LEFT(text,num_char) Kết quả là chuỗi con được trích ra từ bên trái của 
chuỗi text đủ num_char ký tự 

Ví dụ LEFT("Lê Thị Minh Nguyệt",6) bằng "Lê 
Thị" 

RIGHT(text,num_char) Kết quả là chuỗi con được trích ra từ bên phải của 
chuỗi text đủ num_char ký tự 

Ví dụ RIGHT("Lê Thị Minh Nguyệt",11) bằng 
"Minh Nguyệt" 

MID(text,start_num,num_char) Kết quả là chuỗi con được trích từ vị trí 
start_num, đủ num_char ký tự 

Ví dụ MID("Lê Thị Minh Nguyệt",8,4) bằng 
"Minh" 

LEN(text) Trả lại chiều dài của chuỗi text 

Ví dụ LEN("Lê Thị Minh Nguyệt") bằng 18 

UPPER(text) Đổi chuỗi text thành chữ hoa (không chính xác 
khi dùng với Font tiếng Việt) 

Ví dụ UPPER("Thomas Edison") bằng THOMAS 
EDISON 
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LOWER(text) Đổi chuỗi text thành chữ thờng (không chính xác 
khi dùng với Font tiếng Việt) 

Ví dụ UPPER("Thomas Edison") bằng thomas 
edison 

PROPER(text) Đổi chữ cái đầu tiên của các từ thành chữ hoa, còn 
lại là chữ thường (không chính xác khi dùng với 
Font tiếng Việt) 

Ví dụ PROPER("bill gates") bằng Bill Gates 

TRIM(text) Cắt bỏ các ký tự trắng ở đầu và cuối chuỗi text. 

Ví dụ TRIM(" Lê Quốc Minh ") bằng Lê Quốc 

Minh 

TEXT(value,format_text) Đổi số value thành chuỗi theo khuôn dạng chỉ 

định trong format_text 

Ví dụ TEXT(1234.56,"##,###.###") bằng 

1,234.56 

VALUE(text) Đổi chuỗi có kiểu số thành số 

Ví dụ VALUE("123") bằng 123 

4.4. Nhóm hàm có điều kiện 

 

IF(logical_test,value_if_true, 
  value_if_false) 

Hàm IF cho kết quả: 

value_if_true nếu logical_test là TRUE  
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value_if_false nếu logical_test là FALSE  

 Ví dụ nhập công thức =IF(D2>5,"Trên TB","Dưới 

TB") trong ô D3

Nếu nhập 6 trong D2 ta có "Trên TB" trog D3

Nếu nhập 4 trong D2 ta có "Dưới TB" trog D3 

 

4.5. Nhóm hàm ngày tháng 

 

DATE(year,month,day) Trả về ngày ứng với ngày, tháng, năm cung cấp trong 
tham số. 

Ví dụ Date(2000,08,22) bằng 22/08/2000 

DAY(serial_number) Trả lại ngày của tham số serial_number kiểu ngày tháng 

Ví dụ DAY("24-12-2000") bằng 24 

Chú ý: Tham số kiểu ngày có trật tự ngày - tháng - năm 
tuân theo thiết lập trong Control Panel trong máy của 
bạn. Trớc khi sử dụng các hàm có liên quan đến kiểu 
ngày hãy kiểm tra xem máy đang đặt trật tự ngày - tháng 
- năm hay tháng - ngày - năm, hay một trật tự khác. 

NOW() Trả lại giờ hiện hành 

TODAY() Trả lại ngày hôm nay 

MONTH(serial_number) Trả lại tháng của tham số serial_number kiểu ngày tháng

Ví dụ MONTH("8-3-2000") bằng 3 (giả sử máy đang 
đặt ngày theo trật tự ngày-tháng-năm) 
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YEAR(serial_number) Trả lại năm của tham số serial_number kiểu ngày tháng 

Ví dụ YEAR("8-3-2000") bằng 2000 (giả sử máy đang 
đặt ngày theo trật tự ngày-tháng-năm) 

 

4.6. Nhóm hàm logic 

 

AND(logical1,logical2,...) Cho kết quả là phép Và của các biểu thức logíc. Hàm 
AND cho kết quả TRUE nếu tất cả các biểu thức logíc 
là TRUE, ngợc lại hàm AND cho kết quả FALSE 

Ví dụ AND(1000>900,LEFT("excel",2)="ex") bằng 
TRUE 

OR(logical1,logical2,...) Cho kết quả là phép hoặc của các biểu thức logíc. Hàm 
OR cho kết quả TRUE nếu có một trong các biểu thức 
logíc là TRUE, ngợc lại nếu tất cả biểu thức logíc là 
FALSE thì hàm OR cho kết quả FALSE. 

Ví dụ OR(1000>9000,LEFT("excel",2)="ex") bằng 
TRUE 
OR(2>3,5>8) bằng FALSE 

NOT(logical) Cho kết quả là phép phủ định của biểu thức logíc. 
Hàm NOT cho kết quả TRUE nếu biểu thức logíc là 
FALSE và ngược lại. 

Ví dụ NOT(3>2) bằng FALSE

NOT(AND(1000>900,LEFT("excel",2)="ex")) bằng 

FALSE 
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4.7. Nhóm hàm tìm kiếm 

1) Tìm kiếm dọc Vertical Lookup 

Cú pháp: =VLOOKUP(lookup_value,table_array, col_index_num,range_lookup) 

Hàm VLOOKUP tìm trên cột tận cùng bên trái của vùng table_array cho 

đến khi thấy lookup_value, sau đó dò sang ngang hàng tới cột được chỉ ra bởi 

col_index_num. Cột đầu có thể chứa văn bản, số, hay các trị logíc và được sắp xếp 

tăng dần. Không phân biệt chữ hoa chữ thường. Range_lookup là một trị logical 

(TRUE hay FALSE). Nếu là TRUE hay bỏ qua thì VLOOKUP trả lại kết quả gần 

đúng; nếu FALSE, VLOOKUP trả lại kết quả chính xác hoặc #N/A khi không tìm 

thấy. Nếu không thấy lookup_value, VLOOKUP sẽ tìm giá trị lớn nhất nhỏ hơn 

lookup_value.  

Tham số: lookup_value là một trị, địa chỉ hay chuỗi; table_array là địa chỉ 

vùng bảng tìm kiếm; col_index_num là cột trong bảng có chứa trị tìm kiếm; và 

range_lookup (tuỳ chọn) là giá trị lôgíc TRUE hay FALSE (1 hoặc 0). 

Kết quả: Trị trong ô cùng hàng với lookup_value trong bảng, ở cột chỉ định; hoặc 

#N/A nếu không tìm thấy.  

2) Tìm kiếm ngang (Horizontal Lookup) 

Cú pháp: =HLOOKUP(lookup_value,table_array, 

row_index_num,range_lookup)  
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Hàm HLOOKUP tìm trên hàng đầu của vùng table_array cho đến khi gặp 

lookup_value thì dò xuống theo cột đến hàng chỉ ra bởi row_index_num. 

Range_lookup là một giá trị kiểu logíc (TRUE hay FALSE). Nếu là TRUE hay bỏ 

qua, HLOOKUP trả lại kết quả gần đúng. Nếu là FALSE, HLOOKUP trả lại kết 

quả chính xác hay #N/A nếu không tìm thấy. Hàng đầu của table_array phải đ-

ợc sắp xếp tăng dần, theo chữ cài hay số . Trị tìm kiếm lookup_value và các giá trị 

trong hàng đầu của table_array có cùng kiểu và có thể là văn bản, số hay trị lôgíc. 

row_index_num bắt đầu từ 1. Để trả lại một trị nằm trong hàng đầu - nhập 

1, hàng hai - nhập 2, và tiếp tục. Nếu row_index_num bé hơn 1, HLOOKUP sinh 

lỗi #VALUE!. Nếu row_index_num lớn hơn số hàng có trong bảng hàm sinh lỗi 

#REF!. 

Tham số: lookup_value là trị, địa chỉ, hay chuỗi văn bản phụ thuộc vào hàng đầu 

của bảng; table_array là địa chỉ của bảng; row_index_num là số thứ tự của hàng 

trong bảng có chứa trị cần tìm; range_lookup (tuỳ chọn) có giá trị TRUE hay 

FALSE (1 hoặc 0). 

Kết quả: Giá trị trong ô cùng cột với lookup_value, hàng chỉ định; #N/A nếu 
không thấy

3) Hàm Lookup 

a) Lookup dạng mảng 

Cú pháp: =LOOKUP(lookup_value,array)  

Hàm LOOKUP hoạt động tương tự như HLOOKUP và VLOOKUP. 

LOOKUP tìm kiếm lookup_value trên hàng đầu hay cột đầu của bảng array, tuỳ 
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thuộc vào hình dạng của bảng array. Nếu bảng array có hình vuông hoặc rộng 

hơn cao, LOOKUP tìm lookup_value trên hàng đầu. Nếu bảng cao hơn rộng, tìm 

kiếm thực hiện trên cột đầu. Nếu LOOKUP không tìm thấy lookup_value, nó sẽ 

lấy giá trị lớn nhất dới lookup_value. Nếu lookup_value nhỏ hơn giá trị bé nhất 

trong hàng hay cột được tìm hàm trả về lỗi #N/A. Giá trị trả về đợc lấy ở hàng 

cuối hay cột cuối của bảng lookup_value. Cột hay hàng tìm kiếm phải đợc sắp xếp 

theo trật tự tăng dần.  

Tham số: lookup_value dới dạng số, chuỗi hay giá trị lôgíc; array là địa chỉ vùng 

tìm kiếm. 

Kết quả: Giá trị của của một ô ở hàng cuối hay cột cuối của bảng tìm kiếm.  

b) Tìm kiếm dạng véc tơ 

Cú pháp: LOOKUP(lookup_value,lookup_vector,result_vector) 

Tìm kiếm trị lookup_value trên hàng hay cột chỉ ra bởi lookup_vector cho 

đến khi thấy trị cần tìm thì sẽ dò sang ô tương ứng trong result_vector và trả về trị 

trong ô đó. 

Tham số: Lookup_value là giá trị mà LOOKUP tìm kiếm trên véc-tơ thứ nhất. 

Lookup_value có thể là số, văn bản, giá trị logíc, tên hay địa chỉ. Lookup_vector là 

cột hay hàng chứa văn bản, số hay kiểu logíc và đợc sắp xếp tăng dần. 

Result_vector là hàng hay cột chứa trị trả về có cùng kích thước nh lookup_vector  

4.8. Cặp hàm INDEX và MATCH 

1) Hàm Index  
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Cho tham chiếu tới hay trị của một ô hay một mảng  

Cú pháp: hai dạng 

=INDEX(array,row_num,column_num) 

=INDEX(reference,row_num,column_num, area_num) 

Dạng đầu trả về trị của một ô hay mảng các trị của các ô. Dạng hai trả về tham 

chiếu tới một ô hay mảng các ô. 

Tham số: Array là địa chỉ mảng. Row_num số thứ tự của hàng, Column_num số tứ 

tự của cột. Reference là địa chỉ vùng lớn, area_num là số thứ tự của vùng con 

trong vùng lớn. 

Kết quả:Trị của ô, mảng trị cho dạng 1; tham chiếu ô, mảng tham chiếu cho dạng 

2 

Ví dụ: 

Hàm sau cho kết quả là 10: 

=INDEX({2,3,4;10,11,12},2,1) 

Công thức sau trả về tham chiếu tới ô C5, nằm ở hàng thứ hai và cột thứ ba trong 

vùng thứ nhất: 

=INDEX((A4:D7,F10:J15),2,3,1)  

2) Hàm Match  
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Cú pháp: =MATCH(lookup_value,lookup_array, match_type)  

Hàm MATCH trả về vị trí tương đối của lookup_value trong lookup_array. Kiểu 

tìm do match_type chi phối. Trị lookup_value có thể là số, chuỗi, giá trị logíc hay 

địa chỉ ô. MATCH trả lại vị trí của hàng hay cột trong mảng có chứa trị tìm thấy. 

Thường được sử dụng kết hợp với hàm INDEX để tra một trị trong mảng.  

Các dạng so khớp 

Match_type Tìm kiếm 

1,hay bỏ qua 
Trị lớn nhất nhỏ hơn hoặc bằng lookup_value. Lookup_array 

phải được sắp xếp tăng  

0 Tìm chính xác. 

-1 
Trị bé nhất nhất lớn hơn hoặc bằng lookup_value. 

Lookup_array phải được sắp xếp giảm. 

Tham số: lookup_value là trị cần tìm trên mảng; lookup_array là mảng chứa các 

trị; và match_type (tuỳ chọn) là một trong các số 1, 0, hay -1, chi phối cách tìm 

kiếm. 

Kết quả: Vị trí tương đối lookup_value trong lookup_array.  

4.9. Trợ giúp sử dụng hàm. 
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Hình 4.1 Trợ giúp sử dụng hàm 

 Để sử dụng trợ giúp về hàm ta thực hiện như sau:  

 Click biểu tượng Paste Function  trên thanh công cụ để lựa chọn hàm 
muốn sử dụng hoặc chọn Insert / Function 

 Trong hộp thoại Insert Function, Click chọn tên nhóm hàm trong khung Or 
select category như: 

- Most Recently Used: Các hàm đã sử dụng 

- All: Tất cả các hàm. 

- Financial: Nhóm hàm tài chính 

- Date & Time: Ngày và giờ 

- Statistical: Nhóm hàm thống kê 

- Lookup . . .:Nhóm hàm tìm kiếm 

- Text: Nhóm hàm chuỗi 
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Tên các hàm trong nhóm sẽ hiển thị trong nhóm Select a Function,cú pháp 
của hàm và hướng dẫn sử dụng sẽ hiển thị bên dưới. 

Sau khi chọn tên hàm cần dùng click nút OK và nhập thông số tham biến cần thiết 

4.10. Bài tập về hàm cơ bản 

1. Nhập và tính Bảng điểm sau 

Họ Tên Windows Winword Excel Trung Bình Xếp hạng 

An 6 7 8 ? ? 

Chiến 5 5 7 ? ? 

Minh 6 9 7 ? ? 

Quân 4 5 5 ? ? 

Hoa 5 5 6 ? ? 

Nam 6 5 9 ? ? 

Hải 7 7 6 ? ? 

Yến 5 7 5 ? ? 

 Tính trung bình dùng hàm AVERAGE, làm tròn kết quả bằng hàm Round  

 Cột xếp hạng điền Đỗ/ Không đỗ theo điểm trung bình  

 Xếp lại cột xếp hạn theo Yếu, Trung bình, Khá và Giỏi  

2. Tính bảng bán hàng sau 

Ngày Nhân viên Cửa hàng Mặt hàng Tiền nhập Phụ phí Tiền bán 

20-08-98 Hơng Số 1 Kẹo 200 ? ? 
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03-09-98 Nga Số 2 Kẹo 100 ? ? 

29-08-98 Lan Số 1 Bánh 400 ? ? 

04-09-98 Vân Số 2 Bánh 500 ? ? 

30-08-98 Chi Số 1 Bánh 100 ? ? 

30-08-98 Nga Số 2 Mứt 200 ? ? 

30-08-98 Vân Số 2 Kẹo 500 ? ? 

10-08-98 Chi số 1 Bánh 300 ? ? 

03-09-98 Lan Số 1 Kẹo 600 ? ? 

04-09-98 Chi Số 1 Mứt 100 ? ? 

 Phụ phí của các mặt hàng như sau: 
- Bánh : 2% Tiền nhập 
- Mứt : 1% Tiền nhập 
- Kẹo : 3% Tiền nhập 
(Dùng hàm IF lồng)  

 Tiền bán = Tiền nhập + Phụ phí  

3. Bảng chấm công (BT: Làm bình thường, CT: Công tác, NP: Nghỉ phép) 

Bảng chấm công tuần   Thống kê chấm 

công 

N. 

Viên 

20/09 21/09 22/09 23/09 24/09 25/09 26/09     BT CT NP

An BT CT BT BT CT BT NP   An ? ? ? 

Thu BT BT BT BT NP BT BT => Thu ? ? ? 
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Minh BT NP BT CT BT NP BT   Minh ? ? ? 

Hải BT CT BT BT BT BT BT   Hải ? ? ? 

Lệ BT BT BT BT BT CT BT   Lệ ? ? ? 

Thuỷ NP BT BT CT BT BT BT   Thuỷ ? ? ? 

4. Nhật ký chứng từ (dùng hàm Sumif để tính toán tra từ sổ nhật ký sang sổ cái 

tổng hợp) 

General Journal 

  Account Titles and Account     
Date Explanation Number Debit Credit 

01/06/1994 Office equipment 22 $686.24   

01/06/1994 Accounts payable 30   $686.24 

  Purchase of inkjet printer       

         

03/06/1994 Office lease 21$1,187.43   

03/06/1994 Cash 1   $1,187.43 

  Monthly office rent       

         

07/06/1994 Accounts receivable 40 $716.54   

07/06/1994 Sales 60   $716.54 

  Sold 1 Model VM3262       
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09/06/1994 Telephone expense 23 $85.26   

09/06/1994 Accounts payable 30   $85.26 

  May phone bill       

         

10/06/1994 Salaries 50$3,457.90   

10/06/1994 Cash 1   $3,457.90 

  Jones and Smith for May       

         

13/06/1994 Subscriptions 29 10.39   

13/06/1994 Cash 1   10.39 

  Courier, 3 months       

General Ledger 

  Account Account Debit Credit 

  Name Number     

          
1 Cash 1 0 4655.72 

2 Office lease 211187.43 0 

3 Office equipment 22 686.24 0 

4 
Telephone 

expense 
23 85.26 0 
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5 Subscriptions 29 10.39 0 

6 Accounts payable 30 0 771.5 

7 
Accounts 

receivable 
40 716.54 0 

8 Salaries 50 3457.9 0 

9 Sales 60 0 716.54 

 

4.11. Bài tập (Nhóm hàm tìm kiếm). 

1. Điền và tính bảng sau 

STT Tên Khách 
Ngày 

đến 
Ngày đi 

Số 

ngày

Loại 

phòng
Giá

Tiền 

thuê 

Phí 

Phục 

vụ 

Chiết 

Khấu

Tổng 

cộng 

1 Mr. Brown 12-09-95 31-12-95 ? A1 ? ? ? ? ? 

2 Mr. Green 31-10-95 12-12-95 ? B1 ? ? ? ? ? 

3 Miss Alice 31-10-95 24-12-95 ? A1 ? ? ? ? ? 

4 Mrs. Forster 31-10-95 24-12-95 ? A1 ? ? ? ? ? 

5 Mr. Robert 31-10-95 24-12-95 ? A2 ? ? ? ? ? 

6 Mr. Janathan 31-10-95 24-12-95 ? A1 ? ? ? ? ? 

7 Mr. Gullit 01-11-95 22-12-95 ? C1 ? ? ? ? ? 

8 Mr. Lee Yuan 01-11-95 31-12-95 ? B2 ? ? ? ? ? 

9 Mr. Lam 01-11-95 25-12-95 ? A1 ? ? ? ? ? 
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10 Mr. Mohamed 15-11-95 20-12-95 ? A1 ? ? ? ? ? 

11 Mr. John 10-10-95 12-12-95 ? B1 ? ? ? ? ? 

12 Mr. Verny 01-11-95 30-11-95 ? A2 ? ? ? ? ? 

13 Miss. Susan 31-10-95 12-12-95 ? C1 ? ? ? ? ? 

14 Mr. Tom 11-11-95 30-11-95 ? A1 ? ? ? ? ? 

15 Miss. Helen 31-12-95 31-12-95 ? C1 ? ? ? ? ? 

 Số ngày= Ngày đi - ngày đến  

 Dùng hàm VLOOKUP để điền cột giá và phí phục vụ theo bảng giá dới đây  

 Tiền thuê=số ngày*giá  

 Chiết khấu 5% tiền thuê cho những ngời ở trên 30 ngày  

Loại Giá Phí PV

A1 $ 200.00 10% 

A2 $ 150.00 8% 

B1 $ 100.00 5% 

B2 $ 80.00 5% 

C1 $ 60.00 4% 

2. Tính thuế thu nhập cho bảng sau 

A B C D E F I J K L 

MaN
V 

Ho Ten GT Ngay 
Sinh 

Que 
Qua
n 

So 
CMND 

AnhVa
n 

Luon
g 

Thu
e 
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1002 Le Thi Hanh Nu 10/1/19
74 

Ha 
Noi 

116696
80 

4 160   

1004 Nguye
n Van 

Hun
g 

Nu 3/9/197
3 

Ha 
Tay 

111435
79 

4 201.8   

1008 Dao 
Thi 

Lan Nu 13-10-
56 

Ha 
Noi 

111902
74 

1 125.2   

1010 Chu 
Thi 

Mai Nu 25-02-
68 

Ha 
Noi 

117396
44 

4 240   

1011 Le Anh Nam Nu 29-05-
68 

Ha 
Don
g 

113180
62 

4 230   

1012 Nguye
n Thi 

Van Nu 18-08-
73 

Ha 
Noi 

118975
44 

3 190.4   

2003 Hoang 
Thu 

Ha Nu 24-02-
59 

Ha 
Noi 

227589
96 

0 100   

2004 Nguye
n Thuy 

Dun
g 

Nu 5/2/197
3 

Ha 
Noi 

116519
90 

4 189   

3003 Ngo 
Thi 

Ngoc Nu 15-09-
76 

Ha 
Noi 

117968
05 

0 110.7   

3004 Dang 
Thi 

Hue Nu 15-11-
73 

Ha 
Tay 

118290
98 

0 117   

4002 Bui 
Thanh 

Thuy Nu 29-03-
75 

Ha 
Noi 

119491
23 

2 153.2   

6003 Nguye
n Thi 

Cuc Nu 11/4/19
60 

Thai 
Binh 

113106
13 

0 100   
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6004 Dinh 
Van 

Hoa Na
m 

11/7/19
73 

Ha 
Noi 

116201
92 

4 230   

6005 Le Thi Hon
g 

Nu 19-09-
75 

Ha 
Noi 

116204
96 

4 201.8   

6006 Do 
Hoang 

Kien Na
m 

1/9/196
5 

Thai 
Binh 

113510
91 

2 137   

7001 Nguye
n Thi 

Than
g 

Na
m 

22-07-
62 

Ha 
Noi 

101101
38 

4 155   

7002 Hoang 
Thi 

Hanh Nu 13-01-
62 

Ha 
Noi 

101597
13 

1 150   

7003 Le 
Xuan 

Anh Nu 11/1/19
75 

Ha 
Noi 

117398
36 

3 160   

Biểu thuế thu nhập 

Thu nhập Thuế 

suất 

Khấu 

trừ 

0.0000 0 0

2.000.001 10% 200

3.000.001 20% 500

4.000.001 30% 900

6.000.001 40% 1500

8.000.001 50% 2300

10.000.001 60% 3300
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3. Tra tỷ giá ngoại tệ 

Có bảng tỷ giá tra chéo như sau 

  USD EUR GBP JPY 

USD 1 1.06211.6126 0.00840

EUR   1 1.51830.00790

GBP     1 0.00520

JPY       1 

Hãy dùng công thức để tra tỷ giá cho bảng sau 

Khách 

hàng 

Số 

tiền 

Từ loại Sang 

loại 

Tỷ giá Thành 

tiền 

A 50 USD JPY     
B 100 GBP EUR     
C 2000 JPY GBP     
... ... ... ... ... ... 

4. Tiền thuê khách sạn 

Số 
TT 

Tên 
khách 

Mã 
phòng 

Ngày đến Ngày đi 
Số 
tuần 
ở 

Đgiá 
tuần 

Đgiá 
ngày 

Sngày 
ở 

Tiền 
trả 

1 Long C1 7/12/1998 17-12-98 ? ? ? ? ? 

2 Chi B3 1/12/1998 29-12-98 ? ? ? ? ? 
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3 Tuấn A2 20-11-98  25-11-98 ? ? ? ? ? 

4 Hà B1 30-07-98  30-08-98 ? ? ? ? ? 

5 Minh A1 30-07-98  30-08-98 ? ? ? ? ? 

6 Bích B2 30-07-98  30-08-98 ? ? ? ? ? 
Đơn giá tuần Đơn giá ngày  

Phòng Tầng 1 Tầng 2 Tầng 3 Tầng 1 Tầng 2 Tầng 3 

Loại 14  A:  100 90 80 20 16

Loại B 10 :  75 70 65 15 12

Loại A 6 :  50 45 40 10 8

5. Tính giá thành 

TT Mã Tên hàng Ngày nhập Ngày bán
Số 

Lượng 

Đơn 

giá 

Thành 

tiền 
Thuế Thởng 

Giá 

thành

1 B2 Giấy 12-05-98 15-05-98 100 5 ? ? ? ? 

? A1 Vải 07-01-98 17-04-98 200 10 ? ? ? ? 

? D3 Xi măng 30-07-98 28-09-98 300 20 ? ? ? ? 

? C2 Gạch 01-02-98 01-12-98 120 15 ? ? ? ? 

    Cộng         ? ? ? ? 

1/ Thuế : mã A là 1%, B là 5 %, C là 7 %, D là 10 % Thành tiền 

2/ Thưởng cho nhân viên bán hàng theo thời gian lu kho nh sau : 

- dưới 30 ngày thởng 2% Thành tiền 
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- từ 30 ngày đến 89 ngày thởng 1% Thành tiền 

- các trờng hợp khác không đợc thởng 

3/ Giá thành bằng Thành tiền + Thuế + Thưởng 
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BÀI 1: BẮT ĐẦU VỚI MICROSOFT OFFICE EXCEL 

I. LÀM QUEN VỚI MICROSOFT OFFICE EXCEL 

Microsoft Office Excel là chương trình thuộc bộ phần mềm Microsoft 

Office được sử dụng trong hầu hết tất cả các văn phòng trên toàn thế giới. Excel 

là chương trình bảng tính có thể ứng dụng cho các công việc quản lý, kế toán, 

thống kê ...  

 1. Khởi động 

Cách 1: Nhấn nút Start, Chọn Programs, chọn Microsoft Office, chọn 

Microsoft Office Excel 2003. 

 

Hình 1. Khởi động chương trình Excel 

Cách 2: Nhấn chuột vào biểu tượng  Microsoft Office Excel 2003 

trên màn hình nền.  

 2. Giới thiệu bảng tính Excel 

- Sau khi khởi 

động chương trình 

Excel, chúng ta có một 

sổ bảng tính 

(Workbook). Trong 

một sổ bảng tính có rất 

nhiều trang bảng tính.  

- Một bảng tính 

gồm có 256 cột được 

đánh chỉ số theo chữ 

cái A, B, C…Z, AA, 

AB, AC… và 65536 

dòng được đánh chỉ số 

theo số thứ tự 1,2,3…65536 Hình 2. Cửa sổ chương trình Excel 
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Thanh thực đơn lệnh 

Thanh tiêu đề 

Thanh công cụ 

Thanh công thức 

Thanh trạng thái 

Thanh cuộn dọc 

Thanh cuộn ngang 

Đường viền dọc 

Đường viền ngang 

Trang tính Sheet1, … 

Nhập dữ liệu vào đây 

- Theo mặc định, mỗi lần tạo bảng tính mới thì Excel tạo 3 trang bảng tính 

trắng đặt tên là Sheet1, Sheet2, Sheet3. Sau này chúng ta có thể chèn thêm các 

trang mới và chúng được đặt tên là Sheet4, Sheet5,… 

 

 

- Ô (Cell): Ô của trang tính là giao của một cột và một dòng. Ô trên trang 

bảng tính có địa chỉ viết theo trật tự xác định gồm chữ cái tên cột đứng trước và 

số thứ tự dòng đứng sau.  

 

 

VD: Địa chỉ ô đầu tiên là A1 và địa chỉ ô cuối cùng trên trang bảng tính là 

IV65536 

 - Cửa sổ bảng tính: Cửa sổ bảng tính Excel có các thành phần chính sau: 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

+ Thanh tiêu đề: Cho biết tên chương trình ứng dụng, tên tệp tin. 

 + Thanh thực đơn lệnh: Cung cấp các nhóm lệnh làm việc với bảng tính. 

 + Thanh công cụ: Cung cấp các nút thao tác nhanh. 

 + Thanh công thức (Formula Bar): Gồm ô Name Box hiển thị tọa độ ô 

soạn thảo và nội dung dữ liệu của ô. 

Hình 3. Ba trang bảng tính có tên là Sheet1, Sheet2, Sheet3 

Hình 4. Địa chỉ ô là A1 

Hình 5. Giao diện chương trình Excel 
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 + Đường viền ngang: Ghi tên cột từ trái sang phải theo chữ cái A, B…Y, 

Z, AA, AB,…IV. Mỗi cột có chứa 65536 ô. 

 + Đường viền dọc: Ghi số thứ tự dòng từ 1 đến 65536. Mỗi dòng chứa 

256 ô. 

 + Thanh trượt ngang, dọc: Cho phép hiển thị những ô bị che khuất. 

 + Thanh trạng thái: Ở dưới đáy cửa sổ Excel cho biết thông tin về bảng 

tính, về trạng thái soạn thảo, kết quả cộng đơn giản. 

 Ready: Đang sẵn sàng làm việc. 

 Enter: Đang nhập dữ liệu hay công thức. 

 Pointer: Đang ghi công thức tham chiếu đến một địa chỉ. 

 Edit: Đang điều chỉnh dữ liệu hay công thức trong ô hiện tại. 

+ Cửa sổ Bảng tính (Worksheet Window) là phần lớn nhất dùng để nhập 

dữ liệu, tính toán, vẽ đồ thị… 

II. CÁC THAO TÁC CƠ BẢN 

1. Mở bảng tính mới 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + N 

- Chọn menu File -> New 

 2. Lưu bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + S 

- Chọn menu File -> Save 

3. Đóng bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + W 

- Chọn menu File -> Close 

 4. Mở bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + O 

- Chọn menu File -> Open 

5. Trang hiện hành, ô hiện hành 

 - Trên một bảng tính hiện hành, tại một thời điểm chúng ta chỉ có thể thao 

tác với các ô trên một trang của bảng tính và đó gọi là trang hiện hành. 

 

Hình 6.Bảng tính Sheet1 đang là trang hiện hành 
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 Để chuyển trạng thái hiện hành đến trang khác, chúng ta chỉ cần thao tác 

đơn giản là nhắp chuột vào phần chứa tên của trang bảng tính. 

 - Trên trang hiện hành, tại một thời điểm chúng ta chỉ thao tác được với 

một ô, gọi là ô hiện hành. 

 
 

6. Nhận dạng con trỏ 

 Trên trang hiện hành, chúng ta sẽ thấy các loại con trỏ sau: 

 - Con trỏ ô: Xác định ô nào là ô hiện hành trên trang. Một đường bao 

đậm xuất hiện trên ô hiện hành. 

 - Con trỏ soạn thảo: Có hình│màu đen, nhấp nháy, xác định vị trí nhập 

dữ liệu cho ô. 

 - Con trỏ chuột: Thay đổi hình dạng tùy thuộc vị trí của nó trên trang 

bảng tính. 

 Con trỏ chuột dạng chữ thập trắng khi ở trên các ô. 

 Con trỏ chuột có dạng chữ I khi ở phía trong ô đang soạn 

thảo. 

7. Cách nhập và chỉnh sửa dữ liệu trên ô hiện hành 

 - Các phím thường dùng 

 + Phím Tab: Di chuyển con trỏ ô sang phải một cột 

 + Phím Enter: Di chuyển con trỏ ô xuống dòng dưới và kết thúc việc 

nhập/chỉnh sửa dữ liệu. 

 + Các phím mũi tên : Di chuyển con trỏ ô đến các địa chỉ bất kỳ 

trên trang. 

 - Nhập dữ liệu: 

 + Nhắp chuột vào ô cần nhập hoặc sử dụng các phím mũi tên để chuyển 

trạng thái hiện hành về ô. 

 + Gõ phím để nhập kí tự vào ô, nếu sai thì sử dụng phím Delete hoặc 

Backspace để xóa kí tự, sử dụng phím Home/End để di chuyển nhanh trên dòng 

nhập 

 + Nhấn phím ESC nếu muốn kêt thúc nhập nhưng không lấy dữ liệu đã 

nhập. Nhấn phím Enter để đưa dữ liệu cho ô và kết thúc nhập. 

 - Chỉnh sửa dữ liệu: 

Hình 7. Ô A1 là ô hiện hành 
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 Để chỉnh sửa dữ liệu đã nhập trên một ô, chúng ta nhắp đúp chuột vào ô 

đó rồi chỉnh sửa dữ liệu. Nhấn phím Enter để kết thúc chỉnh sửa. 

BÀI 2: SOẠN THẢO NỘI DUNG BẢNG TÍNH 

1. Nhập dữ liệu kiểu số và văn bản 

 - Dữ liệu một ô của bảng tính sau khi nhập sẽ được chương trình tự động 

phân loại và đưa về một trong các kiểu dữ liệu sau: Kiểu số (Number), kiểu văn 

bản (Text), kiểu logic, kiểu mã lỗi (Error) 

 + Kiểu số: Khi nhập dữ liệu số vào ô -> số được canh sang phải. 

Dữ liệu kiểu số được tạo bởi các kí tự cho phép đó là: 0 1 2 3 4 5 6 7 8 9 ( 

) , / $ + - .  

 Nếu muốn nhập số âm, đánh dấu “-” vào trước số đó hoặc nhập số vào 

giữa cặp dấu ngoặc đơn ( ). Để nhập số có phần thập phân, sử dụng dấu “,” ngăn 

cách với phần nguyên. 

 + Dữ liệu kiểu ngày tháng trong Excel được xem là kiểu số. Kiểu nhập 

ngày tháng được hệ điều hành qui định trong mục Regional Setting đặt trong cửa 

sổ Control Panel của hệ điều hành. Khi nhập kiểu ngày phải chú ý là máy của 

bạn đang đặt hệ ngày là ngày/tháng/năm (mm/dd/yyyy hay là dd/mm/yyyy). 

 

  

Kiểu ngày: khi nhập dữ liệu vào ô -> dữ liệu được canh sang phải. 

 Khi nhập số mà canh sang trái thì phải xoá bỏ định dạng hoặc định dạng 

lại. 

 - Chương trình Excel tự động điều chỉnh độ rộng hàng, cột để hiển thị hết 

dữ liệu trong một ô nhưng nếu một ô đã cố định độ rộng làm cho dữ liệu số 

không thể hiện được hết thì chúng ta sẽ nhìn thấy dạng thông báo “#########”. 

 Lưu ý: Giá trị của dữ liệu số sau khi nhập là không thay đổi khi chúng ta 

thay đổi khuôn dạng hiển thị dữ liệu trên màn hình. 

 Ví dụ: Chúng ta nhập giá trị vào ô D4, D6, D7 đều là 20000000. Sau đó 

thay đổi khuôn dạng ô D6 và D7 chúng ta có được các dạng thể hiện số khác 

nhau nhưng giá trị dữ liệu vẫn không thay đổi, ở ô D7 vẫn là 20000000 được 

hiển thị rõ ràng trên thanh công thức. 

 

 

 

 

 

Hình 8. Giá trị kiểu số mặc định được căn lề phải 
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Hình 9. Thay đổi khuôn dạng số nhưng không làm thay dổi giá trị 

 

 

 

 + Kiểu văn bản: Khi nhập dữ liệu vào ô -> dữ liệu được canh sang trái. 

Dữ liệu kiểu văn bản được tạo bởi các kí tự, kí tự số hoặc là khoảng trống 

và các kí tự không phải là số. 

Khi kí tự nhập vượt quá độ dài ô và ô bên phải còn trống thì Excel tiếp tục 

hiển thị phần kí tự còn lại của ô đó sang bên phải.  

Khi kí tự nhập vào vượt quá độ dài ô mà ô bên phải đã có dữ liệu thì 

Excel che dấu các kí tự vượt quá ô nhưng điều đó không làm thay đổi giá trị dữ 

liệu nhập của ô. 

2. Chỉnh sửa dữ liệu trong ô 

Có 3 cách để chỉnh sửa dữ liệu trong ô 

Cách 1: Nhắp đúp chuột vào ô mốn chỉnh sửa để chuyển ô sang trạng thái 

soạn thảo khi đó có thể chỉnh sửa dữ liệu. Nhấn phím Enter để kết thúc. 

Cách 2: Chọn ô muốn chỉnh sửa sau đó nhấn phím F2 khi đó ta sẽ thấy 

con trỏ chuột nhấp nháy, chỉnh sửa dữ liệu rồi nhấn phím Enter để kết thúc. 

Cách 3: Di chuyển chuột lên thanh Formula Bar sau đó nháy chuột vào 

vị trí cần chỉnh sửa, nhấn phím Enter để kết thúc. 

3. Thao tác chọn/hủy chọn ô, dòng, cột 

3.1 Chọn một ô 

Để chọn một ô, chúng ta chỉ cần nhắp chuột vào ô đó. 

3.2 Chọn vùng ô liên tục hình chữ nhật 

- Nhắp chuột vào ô trên cùng bên trái 

- Giữ phím Shift và nhắp chuột vào ô dưới cùng bên phải 

- Thả phím Shift để kết thúc việc chọn 

Trong trường hợp này địa chỉ vùng ô được viết theo khuôn dạng (địa chỉ ô 

trên cùng bên trái:địa chỉ ô dưới cùng bên phải), tách nhau bởi dấu hai chấm “:” 

VD: Chọn vùng ô (A1:D6). Nhắp chuột vào ô A1 sau đó nhấn và giữ 

phím Shift rồi nhắp chuột vào ô D6 ta chọn được một vùng ô như hình. 

 

 

3.3 Chọn vùng ô rời rạc 

- Đầu tiên chọn một ô hoặc một vùng ô liên tục hình chữ nhật 

Hình 10. Chọn vùng ô liên tục 
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- Giữ phím Ctrl trong khi chọn một hoặc một vùng ô liên tục hình chữ 

nhật tiếp theo. 

Lưu ý: Chúng ta có thể nhanh chóng thay đổi vùng chọn bằng cách nhắp 

chuột một lần nữa trên các ô đã chọn để hủy chọn mà không cần phải làm lại từ 

đầu. 

- Chỉ thả phím Ctrl khi kết thúc. 

3.4 Chọn một cột, dãy cột liền nhau, dãy cột rời rạc 

 Chọn một cột: Để chọn một cột, chúng ta nhắp chuột vào tên cột có 

trên đường viền ngang. 

 Chọn dãy cột liền kề nhau 

- Nhắp chuột vào tên cột đầu tiên (bên trái hoặc bên phải của dãy) trên 

đường viền ngang 

- Giữ phím Shift và nhắp chuột vào tên cột cuối cùng cùng của dãy 

- Sau khi lựa chọn xong thì thả phím Shift ra. 

 Chọn dãy cột rời rạc 

- Trước tiên chúng ta chọn cột hoặc dãy cột liền nhau 

- Giữ phím Ctrl trong khi chúng ta nhắp chuột chọn dãy cột tiếp theo. 

- Sau khi lựa chọn xong thì thả phím Ctrl. 

 

 

3.5 Chọn một dòng, dãy dòng liền kề nhau, dãy dòng rời rạc 

 Chọn một dòng 

- Để chọn một dòng, chúng ta nhắp chuột vào số thứ tự dòng có trên 

đường viền dọc. 

 Chọn dãy dòng liền kề nhau 

- Nhắp chuột vào số thứ tự dòng đầu tiên (trên cùng hoặc dưới cùng của 

dãy) trền đường viền dọc. 

- Giữ phím Shift và nhắp chuột vào số thứ tự dòng sau cùng của dãy. 

- Thả phím Shift ra. 

 

 

 Chọn dãy dòng rời rạc 

Hình 11. Chọn dãy cột rời rạc A, C, D, E, G 

Hình 12. Chọn dãy dòng liền kề 21, 22, 23 
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- Trước tiên chúng ta chọn dòng hoặc dãy dòng liền nhau 

- Giữ phím Ctrl trong khi chúng ta nhắp chuột chọn số thứ tự dòng tiếp 

theo, thả phím Ctrl khi kết thúc việc chọn dòng. 

3.6 Chọn toàn bộ bảng tính 

Cách 1: Chỉ cần nhắp chuột vào ô giao nhau của đường viền ngang và 

đường viền dọc. 

 

Cách 2: Bấm tổ hợp phím Ctrl + A 

3.7 Hủy chọn 

Để hủy chọn các ô, chúng ta chỉ cần nhắp đúp chuột vào ô bất kỳ trên 

trang bảng tính. 

4. Điền số thứ tự tự động 

- Nhập một số vào một ô bất kỳ 

- Nhấn và giữ phím Ctrl 

- Trỏ chuột vào hình vuông nhỏ ở góc dưới, bên phải ô đó, con trỏ chuyển 

thành hình dấu cộng có mũ. 

 

 

- Nhấn và kéo chuột xuống theo chiều dọc, chúng ta sẽ thấy số thứ tự 

được điền tự động vào các ô tiếp theo, tăng dần. 

5. Sao chép, di chuyển, xóa, chèn các ô 

5.1 Sao chép các ô 

Thao tác sao chép một ô trong Excel không chỉ bao gồm sao chép nội 

dung, định dạng của ô đó. Chúng ta có thể nhìn thấy trong bảng dưới đây nhiều 

mục lựa chọn khi dán một ô đã sao chép. 

Hình 13. Con trỏ chuột chuyển đổi thành dấu chữ thập đen 



 MICROSOFT EXCEL                                                                           Giảng viên : Dương Thành   

 

 

Trang 10 TRUNG TÂM TIN HOC H2C 

Tel: 039. 516616 - 0985730786  
Website: http://hatinh-news.net - Email: mr.phonglinh@gmail.com 
 

 All – Sao chép tất cả (nội dung, định dạng…) 

 Formulas – Sao chép công thức 

 Values – Sao chép giá trị 

 Formats – Sao chép định dạng 

 Comments – Sao chép chú thích 

 All except borders – Sao chép tất cả trừ đường viền 

 Column widths – Sao chép độ rộng cột 

 Formulas and number formats – Sao chép công thức và định dạng 

số 

 Values and number formats – Sao chép giá trị và định dạng số 

 

 

- Thao tác sao chép giữa các ô trên cùng trang bảng tính. 

+ Chọn ô cần sao chép (ô này có thể là một ô hoặc một vùng ô). 

+ Nhấn nút Copy hoặc bấm tổ hợp phím Ctrl + C để sao chép. 

+ Chuyển con trỏ đến vị trí muốn dán. 

+ Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô. 

- Thao tác sao chép giữa các ô khác trang bảng tính 

+ Trên trang bảng tính hiện hành, chọn các ô cần sao chép 

+ Nhấn vào nút lệnh Copy hoặc sử dụng tổ hợp phím Ctrl + C 

+ Chuyển trạng thái hiện hành đến trang bảng tính khác hay mở tệp bảng 

tính khác. 

+ Đặt con vào vị trí mốn dán 

+ Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô 

5.2 Di chuyển các ô 

- Chọn các ô cần di chuyển 

- Nhấn nút Cut hoặc bấm tổ hợp phím Ctrl + X 

- Chuyển con trỏ đến vị trí muốn dán 

- Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô 

Hình 14. Lựa chọn khi dán một ô đã sao chép 
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5.3 Xóa nội dung các ô 

- Chọn các ô muốn xóa 

- Nhắp chọn thực đơn lệnh Edit -> Clear -> Contents hoặc nhấn phím 

Delete 

6. Thêm/xóa dòng, cột 

- Thêm dòng 

+ Chọn vị trí mốn thêm dòng, bôi đen một hoặc một số dòng muốn thêm. 

+ Nhắp chọn thực đơn lệnh Insert -> Rows để tạo một dòng trống nằm 

giữa hai dòng. Dòng mới sẽ có định dạng giống như dòng được lựa chọn. 

VD: Muốn thêm 3 dòng vào vị trí dưới dòng số 6 trong danh sách, ta bôi 

đen 3 dòng số 7, 8, 9 sau đó nhắp chọn menu Insert chọn Rows, ta sẽ có được 3 

dòng mới vào vị trí dưới dòng số 6. 

 

 

- Xóa dòng 

+ Chọn một hoặc nhiều dòng muốn xóa. 

+ Vào thực đơn lệnh Edit -> Delete. 

- Thêm cột 

+ Chọn vị trí muốn thêm cột, bôi đen một hoặc một số cột muốn thêm. 

+ Nhắp chọn thực đơn lệnh Insert -> Columns, một cột mới xuất hiện. 

- Xóa cột 

+ Chọn một hoặc nhiều cột muốn xóa. 

+ Vào thực đơn lệnh Edit -> Delete. 

7. Thao tác với bảng tính 

7.1 Chèn một trang vào bảng tính 

Khi tạo bảng tính thì mặc định có 3 trang bảng tính (Sheet), tuy nhiên 

người dùng có thể chèn thêm nhiều trang bảng tính mới.  

Cách 1: Nhắp chọn thực đơn lệnh Insert -> Worksheet. 

Cách 2: Nhấn phải chuột lên trang bảng tính bất kỳ, chọn mục Insert… 

sau đó lựa chọn Worksheet và nhấn vào nút OK. Một bảng tính mới xuất hiện. 

7.2 Đổi tên trang bảng tính 

Để dễ quản lý nội dung có trên các trang bảng tính, chúng ta nên đổi tên 

các trang bảng tính cho phù hợp với nội dung chứa trong trang. Tên trang bảng 

tính có thể chứa dấu cách, chữ cái, chữ số, dấu gạch dưới. 

Hình 15. Bôi den số dòng muốn thêm 
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Thực hiện các bước sau để đổi tên trang bảng tính: 

- Nhấn phải chuột vào tên trang bảng tính muốn thay đổi 

- Chọn Rename 

- Gõ tên mới rồi nhấn Enter 

     

7.3 Xóa một trang bảng tính 

- Nhắp chọn thực đơn lệnh Edit -> Delete Sheet hoặc nhắp phải chuột 

vào tên của trang muốn xóa làm xuất hiện hộp lệnh, chọn lệnh Delete. 

 

 

Trong trường hợp trang bảng tính đang chứa dữ liệu Excel sẽ hiển thị hộp 

thoại yêu cầu người dùng khẳng định việc hủy bỏ. Nhấn nút Delete để thực hiện 

việc xóa hoặc nhấn nút Cancel để bỏ qua thôi không xóa. 

 

7.4 Sao chép bảng tính 

Có thể sao chép một hoặc nhiều trang bảng tính sang vị trí mới hoặc sang 

bảng tính khác.  

- Để sao chép một trang bảng tính chúng ta thực hiện các bước sau: 

+ Nhắp chọn tên trang bảng tính cần sao chép. 

+ Giữ phím Ctrl rồi kéo - thả tên trang bảng tính đó sang vị trí mới. 

- Sao chép nhiều trang từ bảng tính này sang bảng tính khác 

+ Chọn các trang bảng tính cần sao chép. Có thể sử dụng phím Shift hỗ 

trợ để thao tác chọn nhiều trang liền kề hoặc sử dụng phím Ctrl hỗ trợ để chọn 

các trang rời rạc. 

+ Nhắp chọn thực đơn lệnh Edit -> Move or Copy Sheet… hoặc nhắp 

phải chuột vào vùng trang được chọn làm xuất hiện hộp chọn lệnh và sau đó 

chọn lệnh Move or Copy…  

+ Trong hộp thoại Move or Copy: 

Hình 16. Thao tác xóa bảng tính Sheet1 
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 Trong phần To book hãy chọn bảng tính nhận bảng sao chép 

 Trong phần Before sheet vị trí đặt trang sao chép là trước trang nào 

hoặc để về cuối dãy trang có trên bảng tính (tiếng Anh là move to 

end) 

 Tích chọn vào ô Create a copy (nếu là di chuyển trang bảng tính 

thì không tích vào ô Create a copy) 

 Nhấn nút OK để hoàn thành việc sao chép 

BÀI 3: THAO TÁC ĐỊNH DẠNG 

1. Thao tác định dạng ô 

Chúng ta có thể thay đổi cách hiển thị dữ liệu một ô bằng thao tác định 

dạng. Thao tác định dạng không làm thay đổi giá trị của dữ liệu chứa trong ô. 

Excel cung cấp nhiều dạng biểu diễn dữ liệu trong ô gồm: 

 General: Dạng chung do Excel qui định sau khi nhập dữ liệu vào 

ô. 

 Number: Dạng số. 

 Currency: Dạng tiền tệ. 

 Date: Dạng ngày tháng. 

 Time: Dạng thời gian. 

 Text: Dạng văn bản. 

Custom: Dạng do người dùng tự định nghĩa theo các qui định mà Excel 

hỗ trợ. 

1.1 Định dạng dữ liệu số thực 

- Chọn ô có chứa dữ liệu số 

- Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

- Chọn thẻ Number 

- Chọn mục Number trong nhóm định dạng Category tích chọn vào ô 

Use 1000 Separator (.) (sử dụng dấu chấm để ngăn cách phần nghìn). Chúng ta 

có thể thấy giá trị của ô được định dạng sẽ hiển thị ở mục Sample. 

- Nhấn nút OK 

để kết thúc.  
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1.2 Định dạng dữ liệu theo dạng ngày tháng 

Khuôn dạng mặc định của Excel khi nhập dữ liệu kiểu ngày tháng vào 

bảng tính là tháng/ngày/năm (mm/dd/yy hoặc mm/dd/yyyy). Chúng ta có thể 

thay đổi cách biểu diễn dữ liệu theo ngày/tháng/năm như sau: 

- Ta lựa chọn những ô chứa dữ liệu ngày tháng. 

- Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

- Chọn thẻ Number 

- Trong hộp danh sách Category nhắp chọn mục Custom 

- Ở ô Type nhập chuỗi kí tự dd/mm/yyyy 

- Nhấn nút OK để kết thúc. 

 

 

1.3 Định dạng dữ liệu dạng tiền tệ 

- Chọn những ô có chứa dữ liệu dạng tiền tệ 

Hình 17. Định dạng dữ liệu kiểu số thực 

Hình 18. Định dạng dữ liệu kiểu ngày tháng 
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- Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

- Chọn thẻ Number 

- Trong hộp danh sách Category nhắp chọn mục Custom 

- Ở ô Type nhập dãy kí tự  #.##0 [$VND] 

- Nhấn nút OK để kết thúc. 

 
 
 

1.4 Định dạng dữ liệu theo kiểu phần trăm 

Trong một vài trường hợp, người sử dụng muốn biểu diễn một số dưới 

dạng phần trăm. Ví dụ: 0,98 sẽ được hiển thị 98% thì chúng ta thực hiện như 

sau: 

- Chọn ô có chứa dữ liệu muốn hiển thị dưới dạng phần trăm. 

- Nhấn chuột vào nút   trên thanh công cụ. 

2. Định dạng ô chứa văn bản 

2.1 Thay đổi kiểu chữ, cỡ chữ, dạng chữ 

Trong Excel việc thay đổi kiểu chữ, cỡ chữ, dạng chữ đậm/nghiêng/gạch 

chân được thao tác giống như trong Word. 

2.2 Thay đổi màu chữ và màu nền 

- Thay đổi màu chữ 

+ Chọn chữ muốn thay đổi màu 

+ Nhấn chuột vào mũi tên trỏ xuống trên thanh định dạng Font Color 

, chọn màu theo ý thích. 

- Thay đổi màu nền 

Hình 19. Định dạng dữ liệu kiểu tiền tệ 
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+ Chọn các ô muốn thay đổi màu nền 

Cách 1: Nhấn chuột vào mũi tên trỏ xuống trên thanh định dạng Fill 

Color , chọn màu theo ý thích. 

Cách 2: 

+ Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

+ Chọn thẻ Patterns  

 Lựa chọn màu nền trong bảng màu Color. Thao tác này tương tự 

như thao tác tô màu nền ô bằng cách nhấn vào mũi tên trỏ xuống 

trong hộp Fill Color trên thanh định dạng rồi chọn màu muốn tô. 

 Lựa chọn mẫu họa tiết trang trí cho ô trong bảng mẫu Patterns 

 

 

2.3 Sao chép định dạng ô 

- Chọn ô đã được định dạng trước. Nếu chọn cả vùng ô thì 

vùng ô đó phải có cùng kiểu (kiểu chữ, màu chữ…) 

- Nhấn nút Format Painter , di chuyển con trỏ 

chuột tới vị trí muốn sao chép định dạng khi đó bên phải con trỏ 

xuất hiện thêm một chổi quét sơn nhỏ. 

- Quét lên ô hoặc vùng ô để áp dụng sao chép định dạng. 

 2.4 Đặt thuộc tính Wrap Text cho ô 

 Đây là một công cụ cho phép tự động xuống dòng trong 

một ô nếu như dữ liệu nhập vào vượt quá độ rộng ô. 

 - Chọn ô muốn áp dụng đặt thuộc tính 

Hình 20. Thay đổi màu nền và họa tiết trang trí 
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+ Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

+ Chọn thẻ Alignment 

 

+ Trong phần chọn Text Control, tích chọn ô Wrap Text để đặt thuộc 

tính tự động đưa nội dung ô xuống dòng làm cho nội dung được hiện đầy đủ. 

Lưu ý: Để xóa bỏ định dạng ô ta lựa chọn ô cần gỡ bỏ định dạng sau đó 

nhắp chọn thực đơn lệnh Edit -> Clear -> Format. 

3. Căn lề, vẽ đường viền ô 

3.1 Căn vị trí chữ trong ô: Giữa, trái, phải, trên, dưới 

Khi nhập dữ liệu vào bảng tính, Excel sẽ phân tích xem nếu dữ liệu dạng 

văn bản thì tự động căn lề bên trái, nếu dữ liệu dạng số thì căn lề bên phải. Tuy 

nhiên, chúng ta có thể chọn cách căn lề khác cho phù hợp với mục đích trình bày 

bảng tính. Cách thực hiện như sau: 

- Chọn ô muốn áp dụng định dạng. 

Cách 1: Nếu căn nội dung ô đó theo chiều ngang thì nhắp chuột vào một 

trong ba nút căn trái, căn phải, căn giữa trên thanh công cụ. 

Cách 2: Nếu muốn căn nội dụng ô đó theo cả chiêu ngang và chiều dọc 

thì ta nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

+ Chọn thẻ Alignment 

Trong phần Text alignment có 2 hướng căn chỉnh lề 

 Horizontal (theo chiều ngang): Dùng để căn chỉnh theo lề trái và lề 

phải của ô. 

 Vertical (theo chiều dọc): Dùng để căn chỉnh theo lề trên và lề dưới 

của ô. 

+ Nhấn nút OK để kết thúc 

3.2 Hòa nhập dãy ô để tạo tiêu đề bảng biểu 

Có thể hòa nhập nhiều ô liền nhau thành một ô.  

 

Cách thực hiện như sau: 

- Chọn các ô cần hòa nhập 

Cách 1:  

+ Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại Format 

Cells. 

+ Chọn thẻ Alignment 

+ Trong phần chọn Text Control, tích chọn Merge cells để hòa nhập các 

ô. 

+ Nhấn nút OK để kết thúc 

Hình 21. Nhắp chọn Wrap text trong mục Text control 
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Cách 2: Nhấn nút Merge and Center  trên thanh công cụ. 

3.3 Thay đổi hướng chữ trong ô 

Muốn thay đổi hướng chữ trong ô thì thực hiện các thao tác sau: 

- Chọn vùng ô muốn thay đổi hướng chữ 

- Nhắp chọn thực đơn lệnh Format -> Cells -> chọn thẻ Alignment. 

- Trong phần Orientation, nhắp chuột vào mũi tên màu đỏ, kéo quay trên 

đường cung tròn đến độ nghiêng phù hợp. Ở trong ô Degrees sẽ hiển thị độ 

nghiêng của văn bản. 

- Nhấn vào nút OK để hoàn thành. 

 

        

 

 

Hình 22. Hòa nhập ô 

Hình 23. Thay đổi hướng viết dữ liệu 
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3.4 Thêm đường viền cho ô, vùng ô 

Cách 1: Sử dụng nút Borders trên thanh công cụ 

- Chọn vùng ô muốn vẽ đường viền 

- Trên thanh công cụ Formatting, nhắp chuột vào tam giác 

nhỏ  làm xuất hiện bảng lựa chọn đường viền. 

 

 

 

 Cách 2: Sử dụng hộp thoại Format Cells 

 Cách này dùng để tạo đường viền ô hay vùng ô theo yêu cầu phức tạp 

hơn. Ta thực hiện như sau: 

 - Chọn ô, vùng ô cần kẻ đường viền 

 - Nhắp chọn thực đơn lệnh Format -> Cells -> chọn thẻ Border  

 - Trong thẻ Border, nhắp chọn kiểu dáng đường viền ở phần Line Style 

(đường viền mảnh, đậm, đường viền đôi, đứt quãng…), chọn màu đường viền ở 

phần Line Color. 

 - Trong phần Presets có 3 kiểu tạo đường viền 

 None: Không tạo đường viền 

 Outline: Kẻ nhanh đường viền ngoài 

 Inside: Kẻ nhanh đường viền trong vùng ô 

- Trong thẻ Border, Excel còn cho phép người dùng tự vẽ đường viền 

bằng cách nhấn vào một trong 8 nút (ngang, dọc, chéo) nằm xung quanh mẫu ô. 

Đây cũng là công cụ dùng để xóa bỏ đường viền đã có trước. 

 

Hình 24. Tạo đường viền cho bảng 
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BÀI 4: CÔNG THỨC VÀ HÀM 

1. Tạo công thức cơ bản 

1.1 Tạo công thức số học cơ bản 

- Công thức được tạo ra để tính toán và trả lại giá trị cho ô bảng tính. Phải 

nhập kí tự “=” trước khi nhập nội dung công thức. Kí tự này giúp Excel nhận 

biết và thực hiện công thức. 

Ví dụ: Muốn tính tổng giá trị có trên ô C5, C6 và kết quả đặt ở trên ô D6, 

chúng ta nhập công thức “=C5 + C6” vào ô D6. 

 

 

 

 

 

 

 

 

 

 

 
 

- Kết quả tính toán sẽ hiển thị tại ô, còn nội dung công thức (gồm cả kí tự 

=) có thể nhìn thấy trên thanh công thức Formula Bar. 

- Chúng ta có thể chỉnh sửa nội dung công thức và cuối cùng là nhấn phím 

Enter để công thức được tính toán lại và trả về giá trị cho ô. 

1.1.1 Phép toán trong công thức số học 

Danh sách các phép toán và các kí tự khác dùng trong công thức số học 

được liệt kê trong bảng sau: 

Kí tự Diễn giải 

+  (cộng) Phép cộng 

-   (trừ) Phép trừ 

*   (sao) Phép nhân 

/    (gạch chéo) Phép chia 

( )  (cặp dấu ngoặc đơn) Toán tử trong dấu ngoặc luôn được tính toán trước 

^   (dấu mũ) Phép mũ (VD: 2^3 tương đương 2*2*2) 
 

 1.1.2 Phép so sánh trong công thức LOGIC 

 Công thức logic có kết quả trả về chỉ là TRUE (đúng) hoặc FALSE (sai). 

Danh sách các phép so sánh dùng trong công thức logic được liệt kê trong bảng 

sau: 

 

Thanh công thức 

Formula Bar 

Hình 25. Tạo đường viền cho bảng 
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Toán tử Diễn giải (Ví dụ) 

= Bằng (A1=B1) 

> Lớn hơn (A1>B1) 

< Nhỏ hơn (A1<B1) 

>= Lớn hơn hoặc bằng (A1>=B1) 

<= Nhỏ hơn hoặc bằng (A1<=B1) 

<> Không băng (A1<>B1) 
 

1.1.3 Thứ tự tính toán 

Khi tính toán, Excel sẽ ưu tiên các phép toán logic trước rồi mới đến phép 

toán số học. Thứ tự thực hiện các phép toán số học trong Excel có mức ưu tiên 

như sau: 

Thứ tự Phép toán Chức năng 

1 - Đảo dấu 

2 % Lấy phần trăm 

3 ^ Phép lũy thừa 

4 * và / Phép nhân và chia 

5 + và - Phép cộng và trừ 

6 & Phép nối chuỗi, ví dụ =“Viet”&“Nam” sẽ 

cho chuỗi kí tự VietNam 

7 Các phép toán so sánh  
 

Để làm thay đổi trật tự tính toán, chúng ta chỉ được dùng cặp dấu ngoặc 

đơn để nhóm các biểu thức ưu tiên tính trước. 

VD: =10+5*2 kết quả được 20. 

        =(10+5)*2 kết quả được 30. 

1.1.4 Cách nhập công thức vào ô 

- Nhắp đúp chuột chọn ô 

- Trước tiên nhập kí tự “=” sau đó nhập nội dung công thức 

- Nhấn phím Enter để kết thúc và thực hiện tính toán công thức. 

1.2 Nhận biết và sửa lỗi 

- Lỗi ##### 

Lỗi xảy ra khi chiều rộng cột không đủ để hiển thị kết quả tính toán. Sửa 

lỗi bằng cách tăng chiều rộng cột đó hoặc thu nhỏ kích thước phông chữ. 

- Lỗi #VALUE! 

Lỗi xảy ra do người sử dụng dữ liệu hoặc toán tử tham gia vào công thức 

không đúng yêu cầu của công thức. 

 Công thức toán học song lại tính toán trên ô chứa dữ liệu kiểu văn 

bản. Sửa lỗi bằng cách nhập lại địa chỉ hoặc định dạng lại ô chứa 

dữ liệu. 

 Công thức sử dụng dữ liệu là địa chỉ ô chứa công thức khác. Sửa lỗi 

bằng cách thay đổi công thức. 
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- Lỗi #DIV/0! 

Lỗi xảy ra khi chia một số cho 0 hoặc mẫu số của phép tính là một ô 

không có dữ liệu. Sửa lỗi bằng cách nhập công thức khác. 

- Lỗi #NAME? 

Lỗi xảy ra khi Excel không xác định được các kí tự trong công thức. Ví dụ 

sử dụng một tên vùng ô chưa được định nghĩa. 

- Lỗi #N/A 

Lỗi xảy ra do không có dữ liệu để tính toán 

- Lỗi #NUM! 

Lỗi xảy ra do sử dụng dữ liệu không đúng kiểu số. Cần định dạng lại dữ 

liệu tham gia vào công thức. 

2. Địa chỉ tuyệt đối và địa chỉ tương đối 

2.1 Địa chỉ tương đối và tuyệt đối 

Các ô là thành phần cơ sở của một bảng tính Excel. Ô có thể chứa các kết 

quả tính toán theo một công thức nào đó với sự tham gia của nhiều ô khác, 

chẳng hạn chứa tổng số của các ô trong cùng cột hay cùng dòng. 

Địa chỉ ô được phép có mặt trong công thức và tự động điều chỉnh theo 

thao tác sao chép công thức nên chúng ta có khái niệm địa chỉ tham chiếu tuyệt 

đối, địa chỉ tham chiếu tương đối, địa chỉ tham chiếu hỗn hợp. 

- Địa chỉ tham chiếu tuyệt đối: Chỉ đến một ô hay các ô cụ thể. 

- Địa chỉ tham chiếu tương đối: Chỉ đến một ô hay các ô trong sự so sánh 

với một vị trí nào đó. 

- Địa chỉ tham chiếu hỗn hợp: Có một thành phần là tuyệt đối, phần còn 

lại là tương đối. 

2.2 Địa chỉ tham chiếu tương đối 

Địa chỉ tham chiếu tương đối gọi tắt là địa chỉ tương đối có trong công 

thức sẽ thay đổi theo vị trí ô khi chúng ta thực hiện sao chép công thức từ một ô 

đến các ô khác. 

Ví dụ: Chúng ta nhập công thức trong ô C1 là =(A1+B1)/2 

Khi sao chép công thức này đến ô C2 thì nó tự động thay đổi địa chỉ để 

trở thành công thức là =(A2+B2)/2. Khi sao chép công thức này đến ô C3 thì nó 

sẽ tự động thay đổi địa chỉ để trở thành công thức là =(A3+B3)/2 

2.3 Địa chỉ tham chiếu tuyệt đối 

Địa chỉ tham chiếu tuyệt đối gọi tắt là địa chỉ tuyệt đối. Dấu (đô la) $ 

thêm vào trước chữ cái chỉ cột hoặc trước số thứ tự dòng khi viết địa chỉ tuyệt 

đối trong công thức. Lúc này, địa chỉ ô ghi trong công thức sẽ cố định không 

thay đổi theo thao tác sao chép công thức từ giữa các ô.    

Nếu có công thức F2=$C$4+$D$4/5 thì khi sao chép sang ô F3 nó vẫn là 

=$C$4+$D$4/5, khi sao chép sang bất kỳ ô nào công thức vẫn là 

=$C$4+$D$4/5. 
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3. Thao tác với hàm 

3.1 Giới thiệu về hàm 

- Hàm có thể tham gia như một phép toán trong công thức. Hàm sẽ trả về 

một giá trị (kiểu số, kiểu ngày tháng, kiểu xâu kí tự…) hay một thông báo lỗi. 

- Dạng thức chung của hàm như sau: 

<Tên hàm> (Đối số 1, Đối số 2,…, Đối số n) 

- Danh sách đối số: Phần lớn các hàm trong Excel đều có một hoặc nhiều 

đối số. Đối số có thể là một giá trị kiểu số, một xâu kí tự, địa chỉ ô hay vùng ô, 

tên vùng, công thức, hay những hàm khác.  

Ví dụ: Hình dưới minh họa một công thức có sử dụng hàm. Ô D9 chứa 

giá trị trung bình cộng của các số từ ô C5 đến C9. Hàm EVERAGE sẽ tính giá 

trị trung bình các ô trong danh sách đối số. 

 

 

* Các bước để nhập một hàm: 

Khi con trỏ nhập văn bản đang ở tại vị 

trí cần nhập hàm thì nhấn chuột vào menu 

Insert -> chọn x Function. 

 

 

 

 

 

Hình 26. Các bước nhập tham số vào hàm AVERAGE 
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Hộp thoại Insert Function xuất hiện 

 Trong hộp Or select a category: chọn All để hiện thị tất cả các 

hàm. 

 Trong mục Select a function: lựa chọn hàm cần thực hiện ở khung 

bên dưới. 

 Nhấn OK để kết thúc. 

 

 

Nếu biết chính xác tên hàm và cách điền các tham số chúng ta có thể gõ 

trực tiếp trên thanh công thức. 

- Thông thường Excel ngầm định dấu phẩy “;” để ngăn cách các đối số 

trong hàm. 

- Tiêu chuẩn nhận hai giá trị :  

0 - xếp hạng giảm dần (số lớn nhất xếp thứ nhất). 

   1 - xếp hạng tăng dần (số nhỏ nhất xếp thứ nhất). 

3.2 Các hàm thường dùng 

 Hàm ROUND: Làm tròn một số đến một số thập phân nhất định 

Dạng thức: ROUND(Đối số 1;Đối số 2) 

Đối số 1 là số muốn làm tròn; Đối số 2 là số thập phân muốn làm tròn. 

Ví dụ: =ROUND(9,98;1) – Kết quả là 10 

 Hàm MAX, MIN: Cho giá trị cao nhất và thấp nhất trong danh sách 

đối số. 

Dạng thức: MAX(Đối số 1;Đối số 2;…;Đối số n) 

Dạng thức: MIN(Đối số 1;Đối số 2;…;Đối số n) 

Hình 27. Làm việc với hàm 

Hình 28. Hộp thoại Insert Function 
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Ví dụ: =MIN(G4:G10) – Cho giá trị thấp nhất trong danh sách đối số. 

 Hàm AVERAGE: Tính trung bình cộng các giá trị của danh sách đối 

số. 

Dạng thức: = AVERAGE(Đối số 1;Đối số 2;…;Đối số n) 

Đối số có thể là giá trị số, địa chỉ ô, vùng ô… 

Ví dụ: =AVERAGE(A1;B5:B10) – Tính trung bình cộng các ô trong 

phạm vi từ B5 đến B10 và ô A1 

 Hàm COUNT: Đếm những ô chứa dữ liệu số trong vùng. 

Dạng thức: = COUNT(Đối số 1;Đối số 2;…;Đối số n) 

Ví dụ: =COUNT(H4:H20) – Đếm những ô chứa dữ liệu số, các ô kiểu 

khác không được đếm. 

 Hàm COUNTA: Đếm những ô chứa dữ liệu trong vùng. 

Dạng thức: = COUNTA(Đối số 1;Đối số 2;…;Đối số n) 

Ví dụ: =COUNTA(H4:H20) – Đếm những ô chứa dữ liệu cùng kiểu từ ô 

H4 đến H20 

 Hàm SUM: Tính tổng các giá trị của danh sách đối số. 

Dạng thức: SUM(Đối số 1;Đối số 2;…;Đối số n). 

Đối số có thể là giá trị số, địa chỉ ô, vùng ô… 

Ví dụ: =SUM(G4:G10) – Tính tổng số trong phạm vi từ G4 đến G10. 

 Hàm IF: Nếu biểu thức điều kiện đúng thì hàm nhận giá trị khi đúng, 

nếu không sẽ nhận giá trị khi sai. 

Dạng thức: =IF(Biểu thức điều kiện;giá trị nếu đúng;giá trị nếu sai) 

Biểu thức điều kiện là biểu thức logic bất kì, nhận giá trị đúng hoặc sai. 

 Hàm SUMIF: Tính tổng theo điều kiện đơn giản 

Dạng thức: =SUMIF(vùng ước lượng;điều kiện;vùng tính toán) 

- Vùng ước lượng: Là một vùng ô 

- Điều kiện: Có thể là hằng số, địa chỉ của một ô, hay dạng thức 

“>1500000” 

- Vùng tính toán: Các ô thật sự cần tính toán. Nếu bỏ qua tham số này thì 

vùng ước lượng được lấy làm vùng tính toán. 

 Hàm COUNTIF: Đếm theo điều kiện đơn giản. 

Dạng thức: =COUNTIF(vùng ước lượng;điều kiện) 

Điều kiện: Có thể là hằng sô, tọa độ của một ô, hay dạng thức 

“>1500000” 

 Hàm VLOOKUP:  

Dạng thức của hàm:  

=VLOOKUP(Giá trị tìm kiếm;vùng bảng đối chiếu;cột trả kết quả;sắp xếp 

vùng đối chiếu) 

Bài tập:  
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1. Mở bảng tính mới và nhập dữ liệu vào Sheet1 bao gồm các mục như 

hình. 

 

2. Bảng đối chiếu được nhập trên cùng trang bảng tính trong vùng ô 

D13:E18 gồm cột chức vụ và phụ cấp. 

3. Thực hiện điền phụ cấp vào bảng lương chính một cách tự động tại ô 

F6 theo công thức =VLOOKUP(D5;$D$13:$E$18;2;0). 

Giải thích công thức VLOOKUP(D5;$D$13:$E$18;2;0) như sau: 

- Vùng giá trị tìm kiếm là giá trị tại ô D5 

- Vùng bảng đối chiếu là $D$13:$E$18, với địa chỉ tuyệt đối. 

- Cột trả lại kết quả là cột thứ 2 trong bảng đối chiếu – cột phụ cấp. 

- Cuối cùng số 0 cho biết không cần sắp xếp cột đầu tiên trong bảng đối 

chiếu theo trật tự giá trị tăng dần. 

4. Cuối cùng là sao chép công thức tại ô F5 đến các ô dưới. 
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BÀI 5: BIỂU ĐỒ, ĐỒ THỊ 

 Tự động vẽ biểu đồ là một chức năng được ưa thích nhất của bảng tính 

Excel. Các biểu đồ, đồ thị là những hình ảnh minh họa rất trực quan, đầy tính 

thuyết phục. Người xem rút ra ngay được những kết luận cần thiết từ các biểu 

đồ, đồ thị mà không cần giải thích. Ngoài ra chúng ta dễ dàng tạo ra nhiều kiểu 

biểu đồ, đồ thị khác nhau dựa vào những số liệu trên bảng tính hiện hành. Excel 

còn cho phép thay đổi cách trình bày, điều chỉnh đường trục, đường biểu diễn, 

thêm ghi chú… 

1. Tạo các kiểu biểu đồ, đồ thị khác nhau 

Bôi đen vùng dữ liệu cần lập biểu đồ 

Cách 1: Nháy vào biểu tượng Chart Wizard  trên thanh công cụ. 

Cách 2: Nhắp chuột vào menu Insert -> Chart -> xuất hiện hộp thoại 

Chart Wizard. 

 

 

Chọn kiểu biểu đồ (VD: Biểu đồ hình cột đứng) -> Next chuyển sang 

bước tiêp theo -> Next chuyển sang bước tiếp. 

Hình 29. Chọn kiểu biểu đồ hay đồ thị 
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- Gõ tiêu đề cho biểu đồ vào dòng Chart title. 

- Gõ tiêu đề trục Y vào trong ô Value (Y) axls. 

- Nhấn nút Next để chuyển sang bước chọn nơi đặt biểu đồ, đồ thị, chọn 

Sheet2 trong ô As object In. 

- Nhấn nút Finish để kết thúc. 

2. Sửa đổi biểu đồ, đồ thị  

2.1 Thêm tiêu đề, chú thích ý nghĩa các trục đồ thị 

 Thêm tiêu đề 

- Nhắp phải chuột vào vùng trống trong đồ thị làm xuất hiện hộp lệnh, 

chọn lệnh Chart Option. 

 

Hình 30. Thêm tiêu đề chung và tiêu đề trục ngang, dọc 

Hình 31. Phải chuột chọn Chart Options để chỉnh sửa đồ thị 
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- Trong hộp thoại Chart Option, chọn thẻ Titles sau đó đánh tiêu đề mới 

hoặc chỉnh sửa lại tiêu đề. 

- Nhấn OK để kết thúc. 

 Chú thích ý nghĩa các trục đồ thị 

- Nhắp phải chuột vào vùng trống trong đồ thị làm xuất hiện hộp lệnh, 

chọn lệnh Chart Option. 

- Trong hộp thoại Chart Option, chọn thẻ Legend sau đó tích vào ô 

Show Legend (hiển thị chú thích). 

- Trong mục Placement, chúng ta lựa chọn chế độ hiển thị chú thích (trên, 

dưới, trái, phải…) 

- Nhấn OK để kết thúc. 

 Xóa bỏ tiêu đề, chú thích 

- Nhắp chuột chọn tiêu đề hay chú thích. 

- Nhấn phím Delete để xóa bỏ. 

2.2 Hiển thị dữ liệu kèm đồ thị 

 Trong những trường hợp người dùng muốn dữ liệu cơ sở phải đi kèm 

cùng với biểu đồ thì thực hiện thao tác sau: 

 - Nhắp phải chuột vào vùng trống trong đồ thị làm xuất hiện hộp lệnh, 

chọn lệnh Chart Option. 

- Trong hộp thoại Chart Option, chọn thẻ Data Table sau đó đánh dấu 

chọn vào ô Show data table. 

- Nhấn OK để kết thúc. 

 

 Hình 32. Hiển thị dữ liệu kèm đồ thị 
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BÀI 6: HOÀN THIỆN TRANG BẢNG TÍNH VÀ IN ẤN 

1. Thay đổi lề của trang in 

- Để thay đổi lề của trang in ta nhắp chuột vào File -> Page Setup…-> 

Chọn thẻ Margin. 

 

 

Trong thẻ Margin có các hộp thoại sau: 

+ Top/Bottom/Left/Right: Để thiết lập khoảng cách lề trên/dưới/trái/phải 

của trang in. Thông thường, đơn vị đo là Inches. Có thể nhập giá trị trực tiếp 

vào ô hoặc sử dụng mũi tên lên xuống để tăng giảm khoảng cách. 

+ Header: Thiết lập khoảng cách dành cho vùng đầu trang. 

+ Footer: Thiết lập khoảng cách dành cho vùng chân trang. 

+ Center on page: Căn chỉnh dữ liệu vào giữa theo hai chiều. 

 Horizontally: Chiều ngang trang in. 

 Veritically: Chiều dọc trang in. 

Có thể nhấn vào nút Print Preview để xem các thiết đặt trên được áp 

dụng vào tài liệu như thế nào. Nhấn vào nút Print nếu muốn in ngay, nhấn vào 

nút Options nếu muốn thay đổi thông số của máy in. 

2. Thay đổi trang in 

- Nhắp chuột vào File -> Page Setup…-> Chọn thẻ Page. Thiết đặt các 

thông số sau: 

- Mục Orientation: Cho phép thay đổi hướng trang in 

 Portrait: In theo chiều dọc của trang giấy. 

 Landcape: In theo chiều ngang của trang giấy. 

Hình 33. Thẻ Margin – thiết đặt lề cho trang bảng tính 
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- Mục Scaling: Cho phép thay đổi tỷ lệ, kích thước nội dung trang in. 

 Adjust to: Có thể phóng to hoặc thu nhỏ nội dung theo tỉ lệ phần 

trăm so với kích thước chuẩn 100% ban đầu. 

- Mục Paper size: Cho phép chọn khổ giấy (A3, A4, Letter,…) 

- Nhấn OK để kết thúc. 

3. Chỉnh sửa để in vừa trong số trang định trước 

- Nếu muốn thu nhỏ nội dung để in trong một trang ta thực hiện như sau: 

+ Vào menu File -> Page Setup…-> Chọn thẻ Page. 

+ Trong hộp chọn Fit to, gõ số 1 và xóa bỏ giá trị trong ô bên phải. Khi 

đó, tất cả dữ liệu trong một bảng tính, dù nhiều hay ít, đều được sắp xếp để chỉ 

in ra một trang giấy. 

 

 

- Tương tự như vậy ta có thể căn chỉnh để cho in vừa số trang như mong 

muốn (VD: Muốn in tổng số là 5 trang, ta cũng chỉ việc gõ số 5 vào hộp chọn Fit 

to). 

4. In ấn 

Nhắp chọn thực đơn lệnh File -> Print hoặc bấm tổ hợp phím Ctrl + P 

làm xuất hiện hộp thoại. 

 

 

 Chọn máy in: Trong mục Printer, nhấn vào ô Name để chọn máy in. 

Hình 34. Đặt Fit to bằng 1 dể in nội dung trong 1 trang 

Hình 35. Hộp thoại Print 
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 In toàn bộ bảng tính: 

Một bảng tính gồm nhiều trang bảng tính, mỗi trang bảng tính lại chứa dữ 

liệu độc lập với nhau, vì vậy cần thận trọng khi thực hiện thao tác này, tránh 

lãng phí giấy. 

- Trong phần Print What, nhấn chọn Entire workbook. 

- Nhấn nút Preview để xem lại các trang sắp in. 

 In toàn bộ trang bảng tính hiện hành 

- Trong phần Print What, nhấn chọn Active sheet(s). 

- Trong phần Print Range, nhấn chọn vào All. 

- Nhấn vào nút Preview để xem lại các trang sắp in. 

 In một vùng ô định trước 

 Để in một phần trang bảng tính hiện hành (VD: Một dãy cột, vùng ô…), 

chọn vùng ô định in (sử dụng phím Shift và Ctrl hỗ trợ thao tác chọn) trước khi 

mở hộp thoại Print. 

 - Trong phần Print What, nhấn chọn Selection. 

 - Nhấn vào nút Preview để xem lại các trang sắp in. 

  In một phần trang bảng tính 

 Trong một trang bảng tính mà ta có 10 trang nhưng ta chỉ muốn in từ 

trang 2 đến trang 5 thì ta làm như sau: 

 - Trong phần Print Range, nhấn chọn vào Page(s). 

 Gõ số thứ tự trang muốn in đầu vào ô From, số thứ tự trang in cuối 

vào ô To 

 Trong trường hợp chỉ muốn in ra một trang thì gõ số thứ tự tờ đó 

vào cả hai ô From và To. 

 In bảng tính ra nhiều bản 

- Chúng ta có thể đặt số bản in sẽ in ra giấy trong phần Copies chọn ô 

Number of copies. 

- Thường là máy mặc định là in hết bản in này đến bản in khác (nhấn chọn 

Collate) 

- Nếu muốn in song song các trang giống nhau thì bỏ chọn trong ô 

Collate. 
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TRƯỜNG ĐẠI HỌC BÁCH KHOA HÀ NỘI

Bài giảng tin học cơ sở

Sử dụng MS Excel
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn  
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn  
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Làm quen với MS-Excel 2000 

• Những thao tác đầu tiên với MS-Excel

• Thao tác cơ bản trên bảng tính

• Bài tập tổng hợp  
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Những thao tác đầu tiên với MS-Excel

• Khởi động MS-Excel

• Tạo bảng tính mới theo mẫu mặc định

• Mở một tệp đã ghi trên ổ đĩa

• Ghi lưu bảng tính vào ổ đĩa

• Ghi lưu bảng tính dưới một tên khác

• Ghi bảng tính theo kiểu tệp tin khác

• Đóng bảng tính, đóng chương trình MS-
Excel
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• Khởi động MS-Excel

 Cách 1: Nhắp chuột vào nút Start Programs

Microsoft Excel

 Cách 2: Nhắp đúp chuột vào biểu tượng

Microsoft Excel có trên màn hình Desktop

Những thao tác đầu tiên với MS-Excel
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• Khởi động MS-Excel

 Giới thiệu bảng tính của Excel

Sổ bảng tính – workbook (*.xls)

Trang bảng tính – sheet (sheet1, sheet2, …)

Các cột – A, B, C,…Z, AA, AB …IV

Các hàng – 1, 2, 3, …65536

Các ô – A1, B1,… IV65536

Những thao tác đầu tiên với MS-Excel
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• Khởi động MS-Excel

 Cửa sổ bảng tính

Thanh tiêu đề

Thanh thực đơn lệnh

Thanh công cụ

Thanh công thức

Đường viền ngang, dọc

Thanh trượt

Thanh trạng thái

Những thao tác đầu tiên với MS-Excel
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• Tạo bảng tính mới theo mẫu mặc định

 Cách 1: Nhắp chuột vào biểu tượng       New

trên thanh công cụ

 Cách 2: Nhấn tổ hợp phím Ctrl + N

 Cách 3: Vào menu File/New…/Blank 

Workbook

Những thao tác đầu tiên với MS-Excel
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Những thao tác đầu tiên với MS-Excel

• Mở một tệp đã ghi trên ổ đĩa (Open)

 C1: Kích chuột vào biểu tượng Open trên Toolbar

 C2: Ấn tổ hợp phím Ctrl+O

 C3: Vào menu File/Open…



1. Chọn nơi chứa tệp

2. Chọn tệp cần mở

3. Bấm nút Open 

để mở tệp Bấm nút 

Cancel để hủy 

lệnh mở tệp
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Những thao tác đầu tiên với MS-Excel

• Ghi tệp vào ổ đĩa (Save)

 C1: Kích chuột vào biểu tượng Save trên

Toolbar.

 C2: Ấn tổ hợp phím Ctrl+S.

 C3: Vào menu File/Save.

 Nếu tệp đã được ghi trước từ trước thì lần ghi tệp hiện

tại sẽ ghi lại sự thay đổi kể từ lần ghi trước (có cảm

giác là Excel không thực hiện việc gì).

 Nếu tệp chưa được ghi lần nào sẽ xuất hiện hộp thoại

Save As, chọn nơi ghi tệp trong khung Save in, gõ tên

tệp cần ghi vào khung File name, ấn nút Save.
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• Ghi lưu bảng tính dưới một tên khác

 Nhắp chuột vào thực đơn lện File Save as

 Chọn thư mục chứa tệp tin trong hộp Save in

 Nhập tên mới vào hộp File name

 Nhấn nút Save để ghi

Những thao tác đầu tiên với MS-Excel

1. Chọn nơi ghi tệp

2. Gõ tên mới cho tệp

3. Bấm nút Save 

để ghi tệp Bấm nút 

Cancel để hủy 

lệnh ghi tệp
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• Ghi lưu bảng tính theo kiểu tệp tin khác

 Nhắp chuột vào thực đơn lệnh File Save as

 Chọn thư mục chứa tệp tin trong hộp Save in

 Nhập tên mới vào hộp File name

 Chọn kiểu tệp tin muốn ghi trong hộp Save as 

type

 Nhấn nút Save để ghi

Những thao tác đầu tiên với MS-Excel
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• Sử dụng bảng tính mẫu

 Nhắp chuột vào thực đơn lện FileNew

 Chọn thẻ Spreadsheet Solutions

 Nhắp đúp vào mẫu Purchase Order

 Bảng tính mới theo mẫu vừa chọn được mở

ra

Những thao tác đầu tiên với MS-Excel
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• Ghi bảng tính như một tệp tin mẫu

 Nhắp chuột vào thực đơn lện File Save as

 Trong hộp Save in chọn thư mục chứa tệp

 Nhập tên cho tên tệp tin mẫu vào hộp File 

name

 Trong hộp Save as type chọn 

Template(*.xlt)

 Nhấn nút Save để ghi

Những thao tác đầu tiên với MS-Excel
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• Ghi bảng tính để có thể đưa lên trang web

 Nhắp chuột vào thực đơn lện File Save as

 Trong hộp Save in chọn thư mục chứa tệp

 Nhập tên cho tên tệp tin mẫu vào hộp File 

name

 Trong hộp Save as type chọn WebPage 

(*.htm:*.html)

 Nhấn nút Save để ghi

Những thao tác đầu tiên với MS-Excel
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• Đóng bảng tính

 Nhắp chuột vào thực đơn lệnh File Close

• Đóng chương trình MS-Excel

 C1: Ấn tổ hợp phím Alt+F4

 C2: Kích chuột vào nút Close ở góc trên cùng bên

phải cửa sổ làm việc của PowerPoint.

 C3: Vào menu File/Exit

Những thao tác đầu tiên với MS-Excel

Nếu chưa ghi tệp vào ổ đĩa thì xuất hiện 1 
Message Box, chọn:

Yes: ghi tệp trước khi thoát,
No:  thoát không ghi tệp,
Cancel: huỷ lệnh thoát.
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Thao tác cơ bản trên bảng tính

• Mở một hoặc nhiều bảng tính

• Chuyển trạng thái hiện hành giữa các bảng

tính

• Trang hiện hành, ô hiện hành

• Sử dụng công cụ phóng to, thu nhỏ

• Che giấu / hiển thị các thanh công cụ

• Cố định dòng tiêu đề / cột tiêu đề 
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Thao tác cơ bản trên bảng tính

• Mở một bảng tính

 Nhắp chuột vào thực đơn lệnh File Open

hoặc nhắp chuột vào biểu tượng Open

 Di chuyển đến tệp tin muốn mở

 Nhắp đúp chuột vào tên tệp tin để mở

 Có thể thao tác để tìm tệp trong các thư mục 

khác tương tự như trong Windows 
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Thao tác cơ bản trên bảng tính

• Chọn và mở nhiều tệp tin kề nhau

 Nhắp chuột vào thực đơn lệnh File Open

hoặc nhắp chuột vào biểu tượng Open

 Chọn tệp tin đầu tiên trong danh sách, giữ 

phím Shift và nhắp chuột vào tên tệp tin cuối 

cùng

 Nhấn nút Open
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Thao tác cơ bản trên bảng tính

• Chọn và mở nhiều tệp tin không kề nhau

 Nhắp chuột vào thực đơn lệnh File Open

hoặc nhắp chuột vào biểu tượng Open

 Chọn tệp tin đầu tiên, giữ phím Ctrl và nhắp 

chuột vào tên các tệp tin khác

 Nhấn nút Open
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Thao tác cơ bản trên bảng tính

• Chuyển trạng thái hiện hành giữa các bảng

tính

 Cách 1: Nhắp chuột vào biểu tượng bảng tính

có trên thanh trạng thái của cửa sổ nền của

Windows

 Cách 2: Trong cửa sổ làm việc của MS-Excel,

nhắp chuột vào thực đơn lệnh Window 

chọn tên bảng tính muốn mở
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Thao tác cơ bản trên bảng tính

• Trang hiện hành

 Trang hiện hành: là bảng tính hiện tại đang 

được thao tác

 Thay đổi trang hiện hành: nhắp chuột vào 

phần chứa tên của trang bảng tính

• Ô hiện hành

 Ô hiện hành là ô đang được thao tác: A1,..

 Thay đổi ô hiện hành: nhấn chuột vào ô hoặc 

sử dụng các phím mũi tên
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Thao tác cơ bản trên bảng tính

• Nhận dạng con trỏ

 Con trỏ ô: xác định ô nào là ô hiện hành, có 

đường bao đậm xung quanh

 Con trỏ soạn thảo: hình thanh đứng mầu đen, 

nhấp nháy xác định vị trí nhập dữ liệu cho ô

 Con trỏ chuột: thay đổi hình dạng tùy thuộc 

vào vị trí của nó trên trang
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Thao tác cơ bản trên bảng tính

• Cách nhập, chỉnh sửa dữ liệu cơ bản

 Các phím thường dùng

Tab: di chuyển con trỏ ô sang phải một cột

Enter: di chuyển con trỏ ô xuống dòng dưới và kết 

thúc nhập dữ liệu

: chuyển sang ô phía trái, phải, trên, dưới 

ô hiện tại

Ctrl + home: chuyển con trỏ về ô A1
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Thao tác cơ bản trên bảng tính

• Cách nhập, chỉnh sửa dữ liệu cơ bản

 Nhập dữ liệu

Chuyển con trỏ ô đến ô cần nhập dữ liệu

Delete, Backspace để xóa ký tự

Home, End để di chuyển nhanh trên dòng nhập

Esc: kết thúc nhưng không lấy dữ liệu đã nhập

Enter:để chấp nhận dữ liệu vừa nhập và kết thúc 

việc nhập cho ô đó
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Thao tác cơ bản trên bảng tính

• Cách nhập, chỉnh sửa dữ liệu cơ bản

 Chỉnh sửa dữ liệu

Nhắp chuột vào ô có dữ liệu muốn chỉnh sửa

Thực hiện các thao tác chỉnh sửa

Nhấn phím Enter để chấp nhận và kết thúc chỉnh 

sửa
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Thao tác cơ bản trên bảng tính

• Sử dụng công cụ phóng to thu nhỏ

 Bảng tính được đặt hiển thị mặc định là 100%

 Thay đổi tỉ lệ hiển thị: nhắp chuột vào hình 

tam giác bên phải biểu tượng Zoom, chọn tỉ 

lệ tương ứng muốn hiển thị
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Thao tác cơ bản trên bảng tính

• Che giấu và hiển thị các thanh công cụ

 Các thao tác được thực hiện tương tự trong 

MS-Word

 Nhắp chuột vào thực đơn lệnh View, chọn 

Toolbars

 Chọn (hiển thị) hoặc bỏ chọn (che dấu) các 

thanh công cụ tương ứng
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Thao tác cơ bản trên bảng tính

• Cố định dòng tiêu đề, cột tiêu đề

 Là các dòng và các cột sẽ hiển thị cố định khi 

sử dụng thanh cuộn

 Nhắp chuột vào ô đầu tiên của vùng dữ liệu 

muốn thay đổi theo thanh cuộn

 Chọn thực đơn Window Freeze Panes

• Gỡ bỏ việc cố định tiêu đề

 Chọn thực đơn Window  UnFreeze Panes
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn  
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Soạn thảo nội dung bảng tính

• Nhập dữ liệu kiểu số, kiểu văn bản

• Biên tập dữ liệu

• Thao tác chọn/hủy chọn ô, dòng, cột

• Sử dụng công cụ điền nội dung tự động

• Thao tác sao chép, di chuyển, xóa, chèn 

các ô

• Thêm/bớt ô, dòng, cột

• Thao tác với các trang bảng tính

• Sử dụng tiện ích sẵp xếp và lọc dữ liệu
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Nhập dữ liệu

• Các kiểu dữ liệu chính

 Kiểu số - Number: 1, 2, …,-100..

 Kiểu văn bản – Text: “Cộng hòa”,…

 Kiểu logic: True, False

 Kiểu mã lỗi – Error: #DIV/0!, #VALUE!
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Nhập dữ liệu

• Nhập dữ liệu kiểu số

 Mặc định được căn theo lề phải của ô

 Dữ liệu kiểu số

Ví dụ: 789, -789, 7.89, 7.89E+08 

Số âm: gõ dấu “-” trước số hoặc đưa số đó vào 

cặp dấu ngoặc đơn - “( số )”

Dấu “.” để ngăn cách giữa phần nguyên và phần 

thập phân
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Nhập dữ liệu

• Nhập dữ liệu kiểu số

 Dữ liệu kiểu ngày tháng

Cách thức nhập được quy định trong mục 

Regional Settings trong cửa sổ Control Panel

Thứ tự nhập thông thường: tháng/ngày/năm

Chú ý: phải nhập giá trị ngày tháng theo đúng quy 

định được đặt trong mục Regional Settings
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Nhập dữ liệu

• Nhập dữ liệu kiểu văn bản

 Mặc định được căn theo lề trái của ô

 “10AA109”, “208 675”

 Sử dụng dấu nháy đơn “ ‘ ”, dấu nháy kép “ “

“ để ép kiểu

Ví dụ: ‘232323 được hiểu là một xâu ký tự có nội 

dung 232323
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Biên tập dữ liệu

• Sửa nội dung đã có trong ô

 Nhắp đúp chuột vào ô có dữ liệu muốn chỉnh 

sửa

 Di chuyển con trỏ chuột đến vị trí chỉnh sửa

 Thực hiện chỉnh sửa

 Ấn phím Enter để kết thúc chỉnh sửa
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Biên tập dữ liệu

• Thay thế nội dung đã tồn tại trong ô

 Nhắp chuột vào ô có dữ liệu muốn thay thế

 Nhập nội dung mới cho ô

 Ấn phím Enter để kết thúc
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Biên tập dữ liệu

• Lệnh Undo và Redo

 Undo: quay trở lại kết quả đã có trước khi sửa 

đổi hoặc hành động – Ctrl + z

 Redo: thực hiện lại hành động đã bị hủy bỏ 

bởi lệnh Undo – Ctrl + y
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Biên tập dữ liệu

• Thao tác chọn

 Chọn ô: nhắp chuột vào ô muốn chọn

 Chọn vùng ô liền nhau

Nhắp chuột vào ô trái trên cùng của vùng

Giữa phím Shift và nhắp chuột vào ô phải dưới 

dùng của vùng

Thả phím Shift để kết thúc việc chọn

Có thể sử dụng chuột để thay cho các thao tác ở 

trên
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Biên tập dữ liệu

• Thao tác chọn

 Chọn vùng ô rời rạc

Chọn một ô hoặc 1 vùng ô liên tục hình chữ nhật

Giữ phím Ctrl trong khi chọn các ô hoặc các vùng 

ô tiếp theo

Thả phím Ctrl để kết thúc việc chọn
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Biên tập dữ liệu

• Thao tác chọn

 Chọn một cột: nhắp chuột vào tên cột có trên 

trường viền ngang – A, B, …

 Chọn dãy cột kề nhau:

Nhắp chuột vào tên cột đầu tiên bên trái hoặc bên 

phải

Giữa phím Shift và nhắp vào tên cột cuối cùng

Thả phím Shift
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Biên tập dữ liệu

• Thao tác chọn

 Chọn dãy cột rời rạc

Chọn cột hoặc dãy cột liền nhau

Giữ phím Ctrl trong khi chọn cột hoặc dãy cột tiếp 

theo

Thả phím Ctrl

 Thực hiện các thao tác tương tự để chọn 

hàng
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Biên tập dữ liệu

• Thao tác chọn

 Chọn toàn bộ bảng tính

Nhắp vào ô giao nhau của đường viền ngang và 

đường viền dọc

Hoặc ấn tổ hợp phím Ctrl + A
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Biên tập dữ liệu

• Hủy chọn

Nhắp chuột vào một ô bất kỳ trên bảng tính
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Công cụ điền nội dung tự động

• Điền tự động số thứ tự

 Nhập số đầu tiên vào ô đầu tiên của vùng 

muốn điền số tự động, ví dụ: nhập vào ô A1 

số 1 

 Nhấn giữ phím Ctrl

 Chuyển con trỏ chuột vào hình vuông nhỏ ở 

góc phải dưới của ô, con trỏ chuyển thành 

hình dấu “+”cộng có mũ “+”

 Nhấn và kéo chuột theo chiều dọc, ngang 

như mong muốn
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Công cụ điền nội dung tự động

• Điền tự động theo chuỗi dữ liệu

 Nhập 2 chuỗi cho 2 ô đầu tiên theo quy luật, 

ví dụ: 05TC0001, 05TC0002

 Chọn 2 ô vừa nhập

 Đưa con trỏ chuột vào hình vuông ở góc phải 

dưới của vùng vừa chọn

 Nhấn vào kéo chuột theo chiều dọc, ngang 

như mong muốn
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Công cụ điền nội dung tự động

• Điền tự động theo cấp số cộng

 Nhập giá trị cho 2 ô đầu tiên theo quy luật cấp 

số cộng, ví dụ: 1, 4

 Chọn 2 ô vừa nhập

 Đưa con trỏ chuột vào hình vuông ở góc phải 

dưới của vùng vừa chọn

 Nhấn vào kéo chuột theo chiều dọc, ngang 

như mong muốn
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Công cụ điền nội dung tự động

• Điền tự động theo cấp số nhân

 Nhập giá trị cho 2 ô đầu tiên theo quy luật cấp 
số cộng, ví dụ: 1, 4

 Chọn 2 ô vừa nhập

 Đưa con trỏ chuột vào hình vuông ở góc phải 
dưới của vùng vừa chọn

 Nhấn phải chuột vào kéo chuột theo chiều 
dọc, ngang như mong muốn

 Đến ô cuối cùng nhả chuột phải

 Chọn Growth Trend
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• Các đối tượng hay dùng

Sao chép, di chuyển, xóa, chèn các ô
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Sao chép, di chuyển, xóa, chèn các ô

• Sao chép các ô

 Chọn các ô muốn sao chép

 Nhấp nút Copy hoặc bấm tổ hợp phím Ctrl+C

 Chuyển con trỏ ô đến ô trái trên của vùng 

định sao chép

 Nhấn nút Paste hoặc bấm tổ hợp phím 

Ctrl+V

 Thực hiện tương tự khi sao chép các ô sang 

trang bảng tính khác
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• Di chuyển các ô

 Chọn các ô muốn di chuyển

 Nhấp nút Cut hoặc bấm tổ hợp phím Ctrl+X

 Chuyển con trỏ ô đến ô trái trên của vùng 

định chuyển tới

 Nhấn nút Paste hoặc bấm tổ hợp phím 

Ctrl+V

 Thực hiện tương tự khi chuyển các ô sang 

trang bảng tính khác

Sao chép, di chuyển, xóa, chèn các ô
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• Xóa nội dung các ô

 Chọn các ô cần xóa

 Trên thanh thực đơn chọn Edit  Clear 

Contents

 Hoặc bấm phím Delete

Sao chép, di chuyển, xóa, chèn các ô
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Thêm/bớt ô, dòng, cột

• Thêm dòng

 Chọn dòng muốn chèn dòng mới lên trên nó

 Trên thanh thực đơn chọn Insert Rows

• Thêm cột

 Chọn cột muốn chèn cột mới bên trái nó

 Trên thanh thực đơn chọn Insert Column
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Thêm/bớt ô, dòng, cột

• Thêm ô

 Chọn ô muốn thêm ô mới bên cạnh nó

 Trên thanh thực đơn chọn Insert Cell

 Xuất hiện hộp thoại

Chọn Shift cells right: chèn ô trống và đẩy ô hiện 

tại sang phải

Chọn Shift cells down: chèn ô trống và đẩy ô 

hiện tại xuống dưới

Chọn Entire row: chèn một dòng mới lên trên

Chọn Entrire column: chèn cột mới sang trái
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Thêm/bớt ô, dòng, cột

• Xóa vùng ô

 Chọn vùng ô muốn xóa

 Trên thanh thực đơn chọn EditDelete

 Xuất hiện hộp thoại
Chọn Shift cells left: xóa các ô và đẩy ô bên 

trái sang

Chọn Shift cells up: xóa các ô và đẩy các ô 
bên phải sang

Chọn Entire row: xóa các dòng có ô đang 
chọn

Chọn Entrire column: xóa các cột có ô đang 
chọn
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Thêm/bớt ô, dòng, cột

• Thay đổi chiều rộng cột/ cao dòng

 Thay đổi chiều rộng cột

Chuyển con trỏ chuột vào cạnh phải của tiêu 

đề cột, biểu tượng chuột có dạng

Nhấn và kéo di chuột sang phải/ trái để 

tăng/giảm kích thước chiều rộng cột

Nếu muốn thay đổi chiều rộng của nhiều cột 

thì trước tiên chọn các cột muốn thay đổi có 

cùng kích thước và sau đó thực hiện các thao 

tác thay đổi
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Thêm/bớt ô, dòng, cột

• Thay đổi chiều rộng cột/ cao dòng

 Thay đổi chiều cao dòng

Chuyển con trỏ chuột vào cạnh dưới của tiêu 

đề dòng, biểu tượng chuột có dạng

Nhấn và kéo di chuột xuống dưới/lên trên để 

tăng/giảm độ cao dòng

Nếu muốn thay đổi chiều cao của nhiều dòng 

thì trước tiên chọn các dòng muốn thay đổi độ 

cao có cùng kích thước và sau đó thực hiện 

các thao tác thay đổi
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Thêm/bớt ô, dòng, cột

• Thay đổi chiều rộng cột/ cao dòng

 Điều chỉnh tự động độ rộng cột

Nhắp đúp chuột vào cạnh phải của cột

 Đặt độ rộng bằng nhau cho nhiều cột

Chọn các cột muốn đặt độ rộng bằng nhau

Trên thanh thực đơn chọn Format  Column 

Width

Nhập độ rộng cột vào hộp Column width

Nhấn nút OK
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Thêm/bớt ô, dòng, cột

• Thay đổi chiều rộng cột/ cao dòng

 Điều chỉnh tự động độ cao dòng

Nhắp đúp chuột vào cạnh dưới của dòng

 Đặt độ cao bằng nhau cho nhiều dòng

Chọn các dòng muốn đặt độ cao bằng nhau

Trên thanh thực đơn chọn Format  Row

Height 

Nhập độ cao hàng vào hộp Row Height

Nhấn nút OK
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Thêm/bớt ô, dòng, cột

• Ẩn/hiện cột

 Ẩn cột

Chọn các cột muốn ẩn

Trên thanh thực đơn chọn Format  Column 

 Hide

 Hiện cột

Chọn vùng cột chứa các cột đang bị ẩn

Trên thanh thực đơn chọn Format  Column 

 Unhide
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Thêm/bớt ô, dòng, cột

• Ẩn/hiện dòng

 Ẩn dòng

Chọn các dòng muốn ẩn

Trên thanh thực đơn chọn Format  Row

Hide

 Hiện dòng

Chọn vùng chưa các dòng đang bị ẩn

Trên thanh thực đơn chọn Format  Row

Unhide
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Thao tác với trang bảng tính

• Chèn một trang vào bảng tính

 Cách 1: Trên thanh thực đơn chọn Insert

Worksheet 

 Cách 2: Nhấp phải chuột vào tên trang bảng 

tính bất kỳ, chọn Insert

 Nhấn nút OK
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Thao tác với trang bảng tính

• Đổi tên trang bảng tính

 Nhấn phải chuột vào tên trang bảng tính 

muốn thay đổi

 Chọn Rename

 Nhập tên mới cho trang bảng tính

 Bấm phím Enter để kết thúc
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Thao tác với trang bảng tính

• Xóa một trang bảng tính

 Cách 1: trên thanh thực đơn chọn Edit

Delete Sheet, chọn OK

 Nhấn phải chuột vào tên trang bảng tính 

muốn xóa, chọn Delete, chọn OK
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Thao tác với trang bảng tính

• Sao chép trang bảng tính

 Chọn tên trang bảng tính cần sao chép

 Giữ phím Ctrl + nhấn phím chuột trái và kéo –

thả trang bảng tính sang vị trí mới
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Thao tác với trang bảng tính

• Sao chép nhiều trang bảng tính sang 
bảng tính khác

 Chọn các trang bảng tính cần sao chép

 Trên thanh thực đơn chọn Edit Move or 
Copy Sheet… 

 Chọn bảng tính nhận các trang sao chép 
trong hộp To book:

 Chọn vị trí đặt các trang bảng tính trong 
hộp Before Sheet

 Nhấn chọn ô Create a copy

 Nhấn OK để hoàn tất
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Thao tác với trang bảng tính

• Di chuyển trang bảng tính

 Nhắp chọn tên trang cần di chuyển

 Kéo – thả trang bảng tính sang vị trí mới
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Thao tác với trang bảng tính

• Di chuyển nhiều trang bảng tính

 Chọn các trang bảng tính cần di chuyển

 Trên thanh thực đơn chọn Edit Move or 

Copy Sheet… 

 Chọn bảng tính nhận các trang di chuyển 

tới trong hộp To book:

 Chọn vị trí đặt các trang bảng tính trong 

hộp Before Sheet

 Bỏ chọn ô Create a copy

 Nhấn OK để hoàn tất
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Sắp xếp và lọc dữ liệu

• Sắp xếp bảng tính theo các cột

 Chọn vùng dữ liệu cần sẵp xếp

 Trên thanh thực đơn chọn DataSort 
Short by: chọn tên cột làm chỉ số sắp xếp mức 

1, Ascending – tăng dần, Descending – giảm 
dần

Then by: chọn cột làm chỉ số sắp xếp mức 2

Then by: chọn cột làm chỉ số sắp xếp mức 3

Chọn Header row nếu vùng sắp xếp đã chọn 
chứa cả dòng tiêu đề, ngược lại chọn No 
header row

Nhấn OK để sắp xếp
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Sắp xếp và lọc dữ liệu

• Sử dụng tiện ích lọc dữ liệu

 Chuyển con trỏ ô về ô trong vùng dữ liệu 

muốn lọc

 Trên thanh thực đơn chọn Data  Filter 

 AutoFilter

 Nhắp chuột vào mũi tên bên cạnh các tiêu 

đề của vùng dữ liệu để lọc
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Sắp xếp và lọc dữ liệu

• Sử dụng tiện ích lọc dữ liệu

 Giải thích các điều kiện lọc

All: lấy tất cả

Top 10: lấy các dòng có giá trị là 1 trong 10 giá 

trị đầu tiên

Custom: lọc theo điều kiện chúng ta tự xác 

định

Có thể chọn một giá trị cụ thể để lọc chỉ theo 

giá trị đó
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Sắp xếp và lọc dữ liệu

• Sử dụng tiện ích lọc dữ liệu

 Nếu Custom xuất hiện hộp thoại Custom 

AutoFilter

 Ý nghĩa của các điều kiện lọc

Equals: bằng

Does not equals: không bằng

Is greater than: lớn hơn

Is greater than or equal to: lớn hơn hoặc bằng

…

 Bên cạnh là ô để nhập hoặc chọn giá trị cụ thể
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Sắp xếp và lọc dữ liệu

• Bỏ lọc tự động

 Trên thanh thực đơn chọn Data  Filter 

 AutoFilter (bỏ chọn bên cạnh 

AutoFilter)

Nếu chưa ở chế độ lọc thì về chế độ lọc 

và ngược lại
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Bài tập tổng hợp

• Học viên làm các bài tập thực hành sau 

mỗi phần

• Làm bài tập tổng hơp trong trang 47, 48 

của giáo trình
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn  
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Thao tác định dạng

• Tìm hiểu trước khi tiến hành định dạng

• Thao tác định dạng ô

• Định dạng ô chứa văn bản

• Căn lề, vẽ đường viền ô
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Tìm hiểu trước

• Các thao tác định dạng ô được thực hiện 

với các nút chức năng trên thanh công cụ 

Formating

• Hoặc hộp hội thoại Format Cells
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Thao tác định dạng ô

• Các dạng biểu diễn dữ liệu

 General: dạng chung

 Number: dạng số

 Currency: dạng tiền tệ

 Date: dạng ngày tháng

 Time: dạng thời gian

 Text: dạng văn bản

 Custom: dạng người dùng tự định nghĩa
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Thao tác định dạng ô

• Biểu diễn số thực

 Chọn một ô có chứa số thực

 Trên thanh thực đơn chọn FormatCells

 Chọn thẻ Number

 Chọn mục Number trong danh sách 

Category

 Nhắp chọn ô Use 1000 Separator(,)

 Nhấp OK để kết thúc
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Thao tác định dạng ô

• Biểu diễn số liệu dạng ngày tháng

 Khi mặc định là ngày/tháng/năm 
(mm/dd/yyyy hoặc mm/dd/yy)

 Chọn ô có dữ liệu ngày tháng muốn định 
dạng lại

 Trên thanh thực đơn chọn FormatCells

 Chọn thẻ Number

 Chọn mục Custom

 Nhập định dạng hiển thị mới trong hộp 
Type, ví dụ: dd/mm/yyyy

 Nhấp OK để kết thúc
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Thao tác định dạng ô

• Biểu diễn số liệu dạng tiền tệ

 Chọn ô có dữ liệu số muốn định dạng tiền 

tệ

 Trên thanh thực đơn chọn FormatCells

 Chọn thẻ Number

 Chọn mục Custom

 Nhập định dạng hiển thị mới trong hộp 

Type, ví dụ: #,##0.00[$VND] 

 Nhấp OK để kết thúc
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Thao tác định dạng ô

• Biểu diễn số liệu theo dạng phần trăm

 Nhấn nút % trên thanh công cụ

 Sử dụng nút Increase Decimal  để tăng số 

xuất hiện sau dấu thập phân

 Hoặc Decrease Decimal để giảm số xuất 

hiện sau dấu thập phân
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Định dạng ô chứa văn bản

• Thay đổi kiểu chữ, cỡ chữ, dạng chữ

 Chọn các vùng có dữ liệu muốn định dạng 

như nhau

 Sử dụng các nút trên thanh Formating

 Hoặc trên thanh thực đơn chọn Format 

Cells, chọn thẻ Font

 Các thao tác còn lại hoàn toàn tương tự 

trong MS-Word
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Định dạng ô chứa văn bản

• Thay đổi mầu chữ

 Chọn các vùng có dữ liệu muốn định dạng 

mầu chữ như nhau

 Sử dụng các nút trên thanh Formating

 Hoặc trên thanh thực đơn chọn Format 

Cells, chọn thẻ Font

 Thay đổi mầu trong mục Color

 Các thao tác còn lại hoàn toàn tương tự 

trong MS-Word
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Định dạng ô chứa văn bản

• Thay đổi mầu nền cho ô

 Chọn các vùng có dữ liệu muốn định dạng 

cùng mầu nền

 Sử dụng nút Fill color trên thanh Formating

 Hoặc trên thanh thực đơn chọn Format 

Cells, chọn thẻ Patterns

 Thay đổi mầu trong bảng Color

 Chọn mẫu hoa văn trong mục Pattern

 Nhấn OK để kết thúc
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Định dạng ô chứa văn bản

• Sao chép định dạng ô

 Chọn ô có định dạng muốn sao chép

 Nhấn nút Format Painter

 Con trỏ chuột chuyển thành biểu tượng 

chổi quét sơn

 Quét vào ô hoặc vùng ô muốn áp dụng 

sao chép định dạng này
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Định dạng ô chứa văn bản

• Đặt thuộc tính Wrap Text cho ô

 Cho phép hiển thị dữ liệu bằng nhiều dòng

 Chọn ô hoặc vùng ô muốn thiết đặt

 Trên thanh thực đơn chọn Format 

Cells, chọn thẻ Alignment

 Trong phần Text control, nhấp chọn ô 

Wrap Text

 Nhấn OK để hoàn tất
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Định dạng ô chứa văn bản

• Xóa bỏ định dạng ô

 Chọn ô hoặc vùng ô muốn xóa bỏ định 

dạng

 Trên thanh công cụ chọn Edit  Clear 

Format
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Căn lề, vẽ đường viền cho ô

• Căn vị trí chữ trong ô

 Chọn ô hoặc vùng ô muốn căn chỉnh

 Sử dụng các nút trên thanh Formating để căn 

theo chiều ngang của ô

 Hoặc trên thanh thực đơn chọn Format 

Cells, chọn thẻ Alignment

Căn chỉnh theo chiều ngang trong hộp Horizontal

Căn chỉnh theo chiều dọc trong hộp Vertical
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Căn lề, vẽ đường viền cho ô

• Hòa nhập dãy ô

 Hòa nhập dãy ô để tạo tiêu đề bảng biểu

 Chọn các ô liền nhau muốn hòa nhập

 Nhấn nút Merge and Center trên thanh 

Formating

 Hoặc

Hoặc trên thanh thực đơn chọn Format  Cells, 

chọn thẻ Alignment

Nhấp chọn ô Merge cells

Nhấn OK để hoàn tất
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Căn lề, vẽ đường viền cho ô

• Thay đổi hướng chữ trong ô

 Chọn ô hoặc vùng ô cần thay đổi

 Trên thanh thực đơn chọn Format 
Cells, chọn thẻ Alignment

 Thay đổi hướng chữ trong phần 
Orientation bằng cách
Chuyển chuột đến điểm vuông đỏ

Nhấn trái và di chuột đi một góc mong muốn

 Hoặc nhập một giá trị trực tiếp vào hộp 
Degrees, ví dụ: -45

 Nhấn OK để hoàn thành
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Căn lề, vẽ đường viền cho ô

• Thêm đường viền cho ô

 Chọn ô hoặc vùng ô muốn thêm đường viền

 Nhấp chuột vào hình tam giác trong nút 

Border trên thanh Formating

 Chọn một mẫu tương ứng
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Căn lề, vẽ đường viền cho ô

• Thêm đường viền bằng hộp thoại Format 

Cells

 Chọn ô hoặc vùng ô muốn thêm viền

 Trên thanh thực đơn chọn Format  Cells, 

chọn thẻ Border

Chọn kiểu nét trong hộp Style

Chọn mẫu đường trong hộp Color

Chọn một đường viền cụ thể để áp dụng trong hộp 

Border

 Nhấn OK để kết thúc
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn  
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Công thức và hàm

• Tạo lập công thức

• Địa chỉ tuyệt đối, địa chỉ tương đối

• Thao tác với các hàm

• Bài tập tổng hợp
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Tạo lập công thức

• Tạo công thức số học cơ bản

 Gõ dấu “=” trước công thức, ví dụ: =E1+F1

 Nhấn Enter để kết thúc

 Nội dung công thức được hiển thị trên 

thanh Formula bar

 Sử dụng cặp dấu “( )” để thay đổi độ ưu 

tiên của các phép toán trong công thức
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Tạo lập công thức

• Các phép toán trong công thức số học

 Cộng: +

 Trừ: -

 Nhân: *

 Chia: /

 Mũ: ^
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Tạo lập công thức

• Các phép toán so sánh

 Lớn hơn: >

 Nhỏ hơn: <

 Lớn hơn hoặc bằng: >=

 Nhỏ hơn hoặc bằng: <=

 Khác (không bằng): <>

• Mức độ ưu tiên của các phép toán giống 

như thứ tự đã học trước đây
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Tạo lập công thức

• Nhận biết và sửa lỗi

 ####: không đủ độ rộng của ô để hiển thị,

 #VALUE!: dữ liệu không đúng theo yêu cầu 

của công thức

 #DIV/0!: chia cho giá trị 0

 #NAME?: không xác định được ký tự trong 

công thức

 #N/A: không có dữ liệu để tính toán

 #NUM!: dữ liệu không đúng kiểu số

Sửa lại cho phù hợp với yêu cầu
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Địa chỉ tương đối, tuyệt đối

• Giới thiệu các loại địa chỉ

 Địa chỉ tham chiếu tuyệt đối

Gọi tắt là địa chỉ tuyệt đối

Chỉ đến một ô hay các ô cụ thể

Có thêm ký tự $ trước phần địa chỉ cột hoặc dòng

Không thay đổi khi sao chép hoặc di chuyển công 

thức
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Địa chỉ tương đối, tuyệt đối

• Giới thiệu các loại địa chỉ

 Địa chỉ tham chiếu tương đối

Gọi tắt là địa chỉ tương đối

Chỉ đến một ô hay các ô trong sự so sánh với vị trí 

nào đó

Thay đổi theo vị trí ô mà ta copy công thức tới
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Địa chỉ tương đối, tuyệt đối

• Giới thiệu các loại địa chỉ

 Địa chỉ tham chiếu hỗn hợp

Có một thành phần là tuyệt đối, thành phần còn lại 

là tương đối

 Thay đổi từ các loại địa chỉ bằng cách ấn 

phím F4 hoặc cho ký tự $ trực tiếp vào phần 

địa chỉ mong muốn
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Địa chỉ tương đối, tuyệt đối

• Sao chép công thức

 Nhắp chọn ô chứa công thức muốn sao chép

 Đặt con trỏ chuột vào góc phải dưới của ô

 Biểu tượng chuột chuyển thành hình dấu thập 

mầu đên nét đơn

 Nhấn phím trái, kéo và di chuyển chuột theo 

dòng hoặc theo cột đến các ô cần sao chép
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Thao tác với hàm

• Giới thiệu

 <Tên hàm>(đối số 1, đối số 2,…, đối số n)

 Đối số có thể là

Giá trị kiểu số, xâu,…

Địa chỉ ô hoặc vùng ô

Một hàm khác
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Thao tác với hàm

• Nhập hàm

 Cách 1: gõ trực tiếp vào ô theo dạng 
“=<Tên hàm>(đối số 1, đối số 2,…, đối số n)”

 Cách 2:
Chuyển con trỏ ô về ô muốn nhập công thức

Trên thanh thực đơn chọn Insert Function

Chọn loại hàm trong mục Function Category

Chọn hàm trong mục Function name

 Nhấn nút OK

Nhập các đối số cần thiết

Nhấn nút OK để hoàn tất
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Thao tác với hàm

• Các hàm tính toán nhanh

 Chọn vùng muốn xem kết quả tính toán 

nhanh

 Xem kết quả hiển thị trên thanh trạng thái

 Thay đổi lại hàm tính toán nhanh:

Kích phải chuột vào chữ NUM trên thanh trạng thái

Chọn một hàm khác trong danh sách xuất hiện
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Các hàm thường dùng

• ROUND

 Cú pháp: ROUND(đối số 1, đối số 2)

Đối số 1: số muốn làm tròn

Đối số 2: số thập phân muốn làm tròn

 Làm tròn đến một số thập phân nhất định

 Ví dụ: ROUND(2.578,2)=2.58
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Các hàm thường dùng

• MAX

 Cú pháp: MAX(đối số 1, đối số 2,…)

 Trả lại số lớn nhất trong danh sách

 Ví dụ: MAX(6,7,2,9,13)=13

• MIN

 Cú pháp: MIN(đối số 1, đối số 2,…)

 Trả lại số nhỏ nhất trong danh sách

 Ví dụ: MIN(6,7,2,9,13)=2
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Các hàm thường dùng

• AVERAGE

 Cú pháp: AVERAGE(đối số 1, đối số 2,…)

 Trả lại giá trị trung bình cộng của các số trong 

danh sách

 Ví dụ: AVERAGE(6,7,2,9,13)=7.4
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Các hàm thường dùng

• COUNTA

 Cú pháp: COUNTA(đối số 1, đối số 2,…)

 Đếm những ô chứa dữ liệu trong vùng

 Ví dụ: COUNTA(6,7,”Nữ”,2,9,13,”Nam”)=7

• SUM

 Cú pháp: SUM(đối số 1, đối số 2,…)

 Trả lại tổng các giá trị số trong danh sách

 Ví dụ: SUM(6,7,2,9,13)=37
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Các hàm thường dùng

• COUNT

 Cú pháp: COUNT(đối số 1, đối số 2,…)

 Đếm những ô chứa dữ liệu số

 Ví dụ: COUNT(6,7,”Nữ”,2,9,13,”Nam”)=5

Ví dụ 1 Ví dụ 2
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Các hàm thường dùng

• IF

 Cú pháp: IF(điều kiện, giá trị 1, giá trị 2)

 Biểu thức điều kiện đúng trả lại giá trị 1 nếu, 

ngược lại trả lại giá trị 2

 Ví dụ: ô A1=Nam khi đó

IF(A1=“Nam”,”Trai”,”Gái”)=Trai

 Có thể sử dụng các hàm IF lồng nhau
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Các hàm thường dùng

• VLOOKUP

 Cú pháp: VLOOKUP(giá trị tìm kiếm, vùng 

bảng đối chiếu, cột trả lại kết quả, sắp xếp 

vùng đối chiếu)

 Trả lại kết quả trên cùng hàng với giá trị tìm 

kiếm trong vùng bảng tham chiếu tại cột trả lại 

kết quả

 Chú ý:

Vùng bảng đối chiếu để ở địa chỉ tuyệt đối

Cột trả lại kết quả phải nhỏ hơn tổng số cột trong 

vùng bảng tham chiếu
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Các hàm thường dùng

• VLOOKUP

 Chú ý:

Sắp xếp vùng đối chiếu chỉ nhận giá trị logic 0 

hoặc 1, nếu bỏ qua thì nhận giá trị 1

Nếu để giá trị 0: tham chiếu chính xác và vùng 

bảng  tham chiếu không cần sắp xếp

Nếu để giá trị 1: tham chiếu tương đối và vùng 

bảng tham chiếu phải được sắp xếp theo thứ tự 

tăng dần của cột tham chiếu (cột trái ngoài 

cùng của vùng bảng tham chiếu)
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Các hàm thường dùng

• Ví dụ hàm VLOOKUP
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Các hàm thường dùng

• SUMIF

 Cú pháp: SUMIF(vùng ước lượng, điều kiện, 

vùng tính toán) :Tính tổng theo điều kiện

 Ví dụ : Giả sử miền B2:B5 chứa các g/t tiền nhập 4 mặt hàng tương 

ứng 100, 200, 300, 400. Miền C2:C5 chứa tiền lãi tương ứng 7, 14, 21, 

28 thì hàm SUMIF(B2:B5,“>160”,C2:C5) cho kết quả bằng 63 

(=14+21+28)
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Các hàm thường dùng

• COUNTIF

 Cú pháp: COUNTIF(vùng ước lượng, điều 

kiện)

 Đếm theo điều kiện
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn tiện trang bảng tính và in ấn  
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Biểu đồ, đồ thị

• Sử dụng biểu đồ, đồ thị

• Tạo các kiểu biểu đồ, đồ thị khác nhau

• Biên tập, sửa đổi biểu đồ, đồ thị

• Bài tập tổng hợp
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Sử dụng biểu đồ, đồ thị

• Là một chức năng được ưa thích nhất của 

MS-Excel

• Là hình những hình ảnh minh họa trực 

quan, đầy tính thuyết phục

• Hỗ trợ rất nhiều kiểu, phụ thuộc vào dữ 

liệu
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Tạo các kiểu biểu đồ, đồ thị

• Chọn vùng dữ liệu muốn vẽ biểu đồ (cả tiêu 

đề)

• Trên thanh thực đơn chọn Insert  Chart

• Xuất hiện hộp thoại Chart Wizard

 Chọn một kiểu biểu đồ cụ thể, nhấn Next, nhấn 

Next

 Nhập tiêu đề trong hộp Chart title

 Nhấn Next

 Chọn nơi đặt biểu đồ

 Nhấn Finish
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Biên tập, sửa đổi biểu đồ, đồ thị

• Thêm tiêu đề, chú thích, ý nghĩa các cột

 Nhắp chọn đồ thị

 Trên thanh thực đơn chọn Chart  Chart

Option

 Chọn thẻ Tittle

 Thực hiện chỉnh sửa

 Nhấn OK để hoàn tất
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Biên tập, sửa đổi biểu đồ, đồ thị

• Xóa bỏ tiêu đề, chú thích

 Nhắp chọn đồ thị

 Nhắp chọn vùng tiêu đề, chú thích muốn xóa 

bỏ

 Ấn phím Delete để xóa bỏ
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Biên tập, sửa đổi biểu đồ, đồ thị

• Hiển thị các đường kẻ ô

 Nhắp chuột vào đồ thị

 Trên thanh thực đơn chọn Chart  Chart

Option

 Chọn thẻ Gridlines

 Chọn-hiển thị hoặc bỏ chọn- không hiển thị 

các đường kẻ ô tương ứng

 Nhấn OK để hoàn tất
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Biên tập, sửa đổi biểu đồ, đồ thị

• Hiển thị dữ liệu kèm đồ thị

 Nhắp chuột vào đồ thị

 Trên thanh thực đơn chọn Chart  Chart

Option

 Chọn thẻ Data Table

 Chọn – hiển thị, bỏ chọn – không hiển thị vào 

ô Show data table

 Nhấn OK để hoàn tất
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Biên tập, sửa đổi biểu đồ, đồ thị

• Thay đổi dạng biểu đồ

 Chọn biểu đồ, thanh công cụ Chart xuất hiện

 Nhấn vào hình tam giác trong nút Chart type

 chọn dạng biểu đồ muốn áp dụng
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Biên tập, sửa đổi biểu đồ, đồ thị

• Co dãn và xóa biểu đồ

 Co dãn kích thước biểu đồ

Chọn biểu đồ

Xuất hiện các chấm vuông tại các cạnh

Giữa và kéo chuột để thay đổi kích thước

 Xóa biểu đồ

Nhấn chọn biểu đồ muốn xóa

Nhấn phím Delete trên bàn phím hoặc trên thanh 

thực đơn chọn Edit Clear All
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Biên tập, sửa đổi biểu đồ, đồ thị

• Di chuyển, sao chép biểu đồ

 Thao tác copy và sao chép được thực hiện 

như sao chép và di chuyển các đối tượng 

khác
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Biên tập, sửa đổi biểu đồ, đồ thị

• Thay đổi mầu nền biểu đồ, đồ thị

 Nhấn chọn thành phần cấn thay đổi mầu nền 

trong biểu đồ

 Thanh công cụ Chart được hiển thị

 Nhấn nút Format Chart Area

 Chọn mầu trong bảng Area

 Có thể nhấn nút Fill Effects để thiết đặt hiệu 

ứng nền

 Nhấn OK để kết thúc



Bài giảng Tin học cơ sở - Khoa Công nghệ thông tin - Trường Đại học Bách Khoa Hà Nội 131

Biên tập, sửa đổi biểu đồ, đồ thị

• Thay đổi mầu biểu đồ

 Nhấn chọn biểu đồ

 Nhắp đúp chuột vào cột đứng, ngang, tròn 

(tùy loại biểu đồ)

 Chọn thẻ Patterns

 Thiết đặt thay đổi viền trong vùng Border 

 Chọn mầu nền trong vùng Area

 Nhấn nút Fill Effects để đặt hiệu ứng

 Nhấn OK để kết thúc
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Nội dung

• Bài 1: Làm quen với MS-Excel 2000

• Bài 2: Soạn thảo nội dung bảng tính

• Bài 3: Thao tác định dạng

• Bài 4: Công thức và hàm 

• Bài 5: Biểu đồ và đồ thị

• Bài 6: Hoàn thiện trang bảng tính và in ấn
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Hoàn tiện trang bảng tính và in ấn

• Bài trí trang in

• Hoàn tất tài liệu

• In ấn

• Bài tập tổng hợp
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Bài trí trang in

• Để điều chỉnh trang in trên thanh thực đơn 

chọn File  Page Setup

• Xuất hiện hộp hội thoại Page Setup để 

tùy biến
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Bài trí trang in

• Thay đổi lề của trang in

 Trên thanh thực đơn chọn File Page Setup

 Chọn thẻ Margin đưa vào các giá trị (thông 

thường đơn vị đo là inches) cho

Top: lề trên

Bottom: lề dưới

Left: lề trái

Right: lề phải

Header: khoảng cách cho vùng đầu trang

Footer: khoảng cách cho vùng chân trang
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Bài trí trang in

• Thay đổi lề của trang in

Center on page: để căn chỉnh dữ liệu và giữa 2 

chiều của trang in

Horizontally: theo chiều ngang trang in

Vertically: theo chiều dọc trang in

Nhấn nút Print để in ngay

Nhấn nút Print Preview để xem trước

Nhấn nút Options để thiết đặt máy in

Nhấn nút OK để hoàn tất việc thiết đặt trang in
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Bài trí trang in

• Thay đổi trang in

 Trên thanh thực đơn chọn File Page Setup

 Chọn thẻ Page thiết lập các thông số

 Orientation: để thay đổi hướng trang in

Portrait: in theo chiều dài trang giấy

Landscape: in theo chiều ngang của trang giấy

 Scalling: thay đổi tỉ lệ, kích thước nội dung 

trang in

Adjust to: phóng to thu nhỏ theo tỉ lệ %
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Bài trí trang in

• Thay đổi trang in

 Paper size: chọn khổ giấy như A3, A4…

 Print Quality: chất lượng in

 First Page number: số trang đầu tiên, mặc 

định là 1

 Nhấn OK để hoàn tất
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Bài trí trang in

• Chỉnh sửa để in vừa trong số trang định trước

 Thu nhỏ nội dung để in trên 1 trang

Trên thanh thực đơn chọn File  Page Setup

Chọn thẻ Page

Trong phần Scalling nhấp chọn ô Fit to

Nhập số 1 vào ô bên cạnh

Xóa giá trị khỏi ô bên phải

Nhấn OK để hoàn tất
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Bài trí trang in

• Chỉnh sửa để in vừa trong số trang định trước

 Thu nhỏ nội dung để in trên một số trang

Trên thanh thực đơn chọn File  Page Setup

Chọn thẻ Page

Trong phần Scalling nhấp chọn ô Fit to

Nhập số trang vào ô bên cạnh

Xóa giá trị khỏi ô bên phải

Nhấn OK để hoàn tất
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Bài trí trang in

• Thêm đầu trang và chân trang

 Trên thanh thực đơn chọn File  Page 

Setup

 Chọn thẻ Header and Footer

Nhấp chuột vào mũi tên trong mục Header và 

Footer để chọn mẫu có sẵn

Nhấn nút Custom Header hoặc Custom Footer

để đưa vào nội dung tùy ý cho vùng đầu trang và 

chân trang

Nhấn OK để kết thúc 
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Bài trí trang in

• Thêm đầu trang và chân trang

 Trên thanh thực đơn chọn File  Page 

Setup

 Chọn thẻ Header and Footer

Nhấp chuột vào mũi tên trong mục Header và 

Footer để chọn mẫu có sẵn

Nhấn nút Custom Header hoặc Custom Footer

để đưa vào nội dung tùy ý cho vùng đầu trang và 

chân trang

Nhấn OK để kết thúc 
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Bài trí trang in

• Thêm đầu trang và chân trang

 Nhấn nút Custom Header hoặc Custom 

Footer

 Đầu trang và chân trang được chia làm 3 

vùng

Left Section: phần bên trái

Center Section: phần ở giữa

Right Section: phần bên phải

Nhắp chuột vào từng phần để đưa nội dung tùy ý
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Bài trí trang in

• Thêm đầu trang và chân trang

 Các nút hỗ trợ sẵn

Để chọn phông chữ

Thêm số thứ tự trang

Thêm số chỉ tổng số trang

Thêm ngày tháng hiện tại

Thêm giờ hiện tại

Thêm tên tệp bảng tính

Thêm tên trang bảng tính

 Nhấn OK để hoàn tất
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Hoàn tất các trang in

• Xem tài liệu trước khi in

 Trên thanh thực đơn chọn File  Print 

Preview

 Các nút chức năng hỗ trợ khi xem trước

Next: hiển thị trang kế tiếp

Previous: hiển thị trang in trước đó

Zoom: phóng to, thu nhỏ

Print: thực hiện lệnh in

Setup: mở hộp thoại Page Setup
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Hoàn tất các trang in

• Xem tài liệu trước khi in

 Các nút chức năng hỗ trợ khi xem trước
Margins: điều chỉnh lề và độ rộng các cột

Đưa con trỏ chuột vào các chấm vuông trê lề để 
điều chỉnh nhanh

Page Break Preview: đóng cửa sổ và trở về trang 
bảng tính, bảng tính được hiển thị theo các trang 
in

Close: đóng cửa sổ và trở về màn hình bảng tính

Help: xem trợ giúp
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Hoàn tất các trang in

• Bật/tắt việc in ra lưới của các đường kẻ 

ô, tiêu đề cột, tiêu đề dòng

 Trên thanh thực đơn chọn File  Page 

Setup

 Chọn thẻ Sheet

 Print Area: để chọn chỉ một vùng in ấn
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Hoàn tất các trang in

• Bật/tắt việc in ra lưới của các đường kẻ 

ô, tiêu đề cột, tiêu đề dòng

 Print title: để chọn vùng làm tiêu đề cho 

trang in

Rows to repeat at the top: chọn các dòng để 

làm tiêu đề, được lặp lại ở các trang sau

Columns to repeat at the left: chọn các cột làm 

tiêu đề, được lặp lại ở các trang sau
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Hoàn tất các trang in

• Bật/tắt việc in ra lưới của các đường kẻ 
ô, tiêu đề cột, tiêu đề dòng

 Mục Print
Row and Column heading: bật/tắt chế độ in 

cả tiêu đề cột (A, B,...) và số thứ tự dòng (1, 
2,…)

Comment: chọn cách in chú thích

Cells error as: bật tắt việc in ra các ô chứa 
thông báo lỗi

Gridlines: bật tắt việc in đường kẻ ngăn cách 
ô

Black & White: bật tắt việc in đen trắng, bỏ 
qua nền
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Hoàn tất các trang in

• Bật/tắt việc in ra lưới của các đường kẻ 

ô, tiêu đề cột, tiêu đề dòng

 Mục Page oder

Để chọn thứ tự in

Down, then over: in từ trên xuống, trái qua 

phải

Over, then down: in từ trái sang phải, trên 

xuống dưới

 Nhấn OK để hoàn tất
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In ấn

• Trên thanh thực đơn chọn File  Print

• Hoặc ấn tổ hợp phím Ctrl + P

• Chọn máy in trong hộp name

• Nhấn nút Properties để thiết đặt lại thông số 

cho máy in

• Chọn phạm vi in ấn trong vùng Print range

 All: in toàn bộ nội dung đã chọn

 Page(s)  From … To …: chỉ in từ trang nào đến 

trang nào

 Nếu muốn in chỉ một trang nào đó thì gõ số thứ tự 

trang cần in vào hộp From
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In ấn

• Chọn nội dung in ấn trong phần Print 

What

 Selection: chỉ in phần đã chọn

 Active Sheet(s): chỉ in các bảng tính đang 

kích hoạt

 Entire Workbook: in cả sổ bảng tính

• Preview: để xem trước các trang sắp in

• Number of Copies: chọn số bản in

• Nhấn OK để in ấn
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Hỏi - đáp
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Thông tin giảng viên

• Họ và tên: Nguyễn Hồng Phương

• ĐT: 0912 552 709

• Email: phuongnh@it-hut.edu.vn hoặc 

phuongnh@gmail.com

• Đơn vị: Bộ môn Các hệ thống thông tin -

Khoa CNTT, ĐHBKHN, P325-C1, số 1 Đại 

Cồ Việt, Hà Nội.
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Công tác văn phòng bao gồm rất nhiều các công việc và không thể thiếu được sự trợ giúp 

của máy tính. Môn học Tin văn phòng nhằm giúp cho người học sử dụng được các chức 

năng cơ bản của các chương trình ứng dụng trong bộ Office do hãng Microsoft cung cấp. Đó 

là, chương trình soạn thảo Word và bảng tính điện tử Excel. 

Hiện nay, đã có rất nhiều tài liệu, giáo trình viết về Tin văn phòng nhưng vẫn chưa 

tương ứng, phù hợp với yêu cầu, nội dung và thời gian cho học sinh, sinh viên trong trường. 

Sau một thời gian giảng dạy ở khoa Công nghệ thông tin, trường Đại học sư phạm kỹ thuật 

Hưng Yên, chúng tôi viết cuốn sách này nhằm cung cấp tài liệu học tập cho sinh viên phù 

hợp với chương trình môn học Tin văn phòng. Các đối tượng học môn tin văn phòng tại 

trường gồm: học sinh các lớp trung học thuộc khoa Công nghệ thông tin, sinh viên các lớp 

cao đằng và đại học thuộc khoa Sư phạm kỹ thuật. Chúng tôi đã cố gắng biên soạn  các tài 

liệu tương ứng cho các đối tượng. Tài liệu này giành cho sinh viên các lớp đại học - khoa Sư 

phạm kỹ thuật với thời lượng 4 đvht (2 đvht lý thuyết và 2đvht thực hành) 

Chúng tôi mong rằng tài liệu này đáp ứng được một phần nào nhu cầu của học sinh, 

sinh viên. 

 

Khoa Công nghệ thông tin 
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Chƣơng 1:  Hƣớng dẫn chung Về soạn thảo văn bản 

1.1. Khái niệm kỹ thuật soạn thảo văn bản, những yêu cầu, và những quy trình 

soạn thảo văn bản 

1.1.1. Khái niệm về kỹ thuật soạn thảo văn bản 

 Văn bản là phương tiện để ghi nhận những thông tin, truyền đạt các thông tin từ chủ 

thể này đến chủ thể khác bằng một ký hiệu hoặc bằng ngôn ngữ nhất định nào đó. 

 Kỹ thuật soạn thảo văn bản là những quy trình, những đòi hỏi trong các quá trình diễn 

ra một cách liên tục từ  khi chuẩn bị soạn thảo đến khi soạn thảo, và chuyển văn bản đến nơi 

thi hành. Gắn liền với quy trình và những đòi hỏi là những quy tắc về việc tổ chức biên soạn, 

thu thập tin tức, khởi thảo văn bản và cả ngôn ngữ thể hiện trong văn bản. 

 nghĩa của kỹ thuật soạn thảo văn bản 

 Kỹ thuật soạn thảo văn bản có rất nhiều ý nghĩa. Nhưng ý nghĩa có tính chất cơ bản nhất phải 

kể đến là làm  cho người nhận được văn bản dễ hiểu, và hiểu được một cách thống nhất. 

1.1.3. Những yêu cầu về việc soạn thảo văn bản 

 1. Để đảm bảo cho văn bản được ban hành đúng và có chất lượng là phải nắm vững 

nội dung của vấn đề cần văn bản hoá. 

 2. Các thông tin được sử dụng đưa vào văn bản phải cụ thể và đảm bảo chính xác. 

Không nên viết văn bản với những thông tin chung và lặp lại từ các văn bản khác.  

 3. Đảm bảo cho văn bản được ban hành đúng thể thức. Thể thức được nói ở đây là 

toàn bộ các thành phần cấu tạo nên văn bản. Chúng đảm bảo cho văn bản có hiệu lực pháp lý 

và được sử dụng thuận lợi trước mắt cũng như lâu dài trong hoạt động quản lý của các cơ 

quan. Một văn bản đầy đủ các thể thức yêu cầu phải có các thành phần: quốc hiệu; địa điểm, 

ngày, tháng ban hành văn bản; tên cơ quan, đơn vị ban hành; số và ký hiệu; tên loại và trích 

yếu nội dung; nội dung; chữ ký của người có thẩm quyền; con dấu hợp thức của cơ quan; địa 

điểm nơi văn bản được gửi đến (nơi nhận), v.v... 

 4. Sử dụng các thuật ngữ và văn phong thích hợp. Nếu thụât ngữ và văn phong không 

được lựa chọn thích hợp cho từng loại văn bản khi soạn thảo thì việc truyền đạt thông tin qua 

văn bản sẽ thiếu chính xác. Điều đó tất nhiên sẽ ảnh hưởng đến nội dung văn bản. 

 5. Văn bản phải thích hợp với mục đích sử dụng. Ví dụ, không dùng chỉ thị thay cho 

thông báo và ngược lại. Yêu cầu này đòi hỏi phải có sự phân biệt rõ ràng các loại văn bản 

trước khi lựa chọn. 

1.1.4. Tóm tắt các bƣớc soạn thảo văn bản 

1. Bƣớc chuẩn bị 

 1. Xác định mục tiêu  
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 2. Chọn loại văn bản 

 3. Sưu tầm tài liệu 

  - Hồ sơ nguyên tắc 

  - Hồ sơ nội vụ 

 4. Xin chỉ thị cấp lãnh đạo 

 5. Hỏi ý kiến các cơ quan, tổ chức liên quan 

 6. Suy luận ( các loại vi phạm mà văn bản có thể mắc) 

  - Thẩm quyền 

  - Hình thức 

  - Vi phạm pháp luật 

2. Bƣớc viết dự thảo 

 1. Lập dàn bài 

 2. Thảo bản văn theo dàn bài 

 3. Kiểm tra 

3. Các bƣớc in ấn và trình ký văn bản 

1.2. Thể thức và bố cục văn bản 

1.2.1. Thể thức văn bản 

  Thể thức văn bản là toàn bộ các bộ phận cấu thành văn bản, nhằm đảm bảo cho văn 

bản có hiệu lực pháp lý và sử dụng được thuận lợi trong quá trình hoạt động các cơ quan. 

Thể thức  là đối tượng chủ yếu của những nghiên cứu về tiêu chuẩn hoá văn bản. Theo quy 

định hiện nay, thể thức văn bản quản lý hành chính của ta bao gồm những yếu tố sau: 

 - Quốc hiệu; 

 - Địa danh và ngày tháng ban hành văn bản; 

 - Cơ quan (tác giả) ban hành; 

 - Số và ký hiệu của văn bản; 

 - Cơ quan ( cá nhân) nhận văn bản; 

 - Tên loại văn bản; 

 - Trích yếu nội dung; 

 - Nội dung văn bản; 

 - Chức vụ và chữ ký của người có thẩm quyền; 

 - Con dấu. 

Tóm lại, thể thức văn bản là toàn bộ các bộ phận cấu thành văn bản, nhằm đảm bảo 

hiệu lực pháp lý của văn bản. 
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1.2.2. Bố cục văn bản 

 Thứ văn bản thông dụng nhất, hay được sử dụng nhất là công văn hành chính. Ta hãy 

chọn loại này để phân tích các yếu tố tạo thành văn bản. 

 Văn thư hành chính ( Công văn hành chính thường có 4 phần cấu tạo nên: 

 - Tiên đề 

 - Thượng đề 

 - Chính đề 

- Hậu đề. 

 Tóm tắt bố cục văn bản thông thường 

1. Phần tiên đề 

 - Quốc hiệu 

 - Địa điểm thời gian 

 - Cơ quan ban hành 

2. Phần thượng đề 

 - Nơi nhận nếu là công văn không có tên gọi 

 - Tên gọi văn bản 

 - Số và ký hiệu 

 - Trích yếu 

 - Căn cứ ( tham chiếu) 

3. Phần nội dung (chính đề) 

 - Khai thư (mở đầu văn bản) 

 - Thân thư (các vấn đề cần đề cập trong văn bản) 

 - Kết thư (lời cảm, xã giao) 

4. Hậu đề 

 - Ký tên 

 - Văn bản đính kèm 

 - Nơi nhận, bản sao 

   Dưới đây là mẫu trình bày các thành phần trong văn bản quản lý Nhà nước: TCVN 5700-

1992: 

Chú thích:  

 - Ô số 1: ghi tác giả ban hành văn bản 

 - Ô số 2: ghi quốc hiệu 
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 - Ô số 3: ghi số và ký hiệu văn bản 

 - Ô số 4: Ghi địa danh và ngày tháng 

 - Ô số 5a: ghi nơi nhận văn bản (trường hợp văn bản là công văn thường) 

 - Ô số 5b: ghi nơi nhận văn bản (trường hợp là văn bản có tên gọi) 

 - Ô số 6a: ghi tên loại trích yếu nội dung (đối với văn bản có tên gọi) 

 - Ô số 6b: ghi tên loại trích yếu nội dung (đối với công văn) 

 - Ô số 7: ghi trình bày nội dung văn bản 

 - Ô số 8: ghi quyền hạn chức vụ của người ký 

 - Ô số 9: chữ ký của người có thẩm quyền 

 - Ô số 10: họ tên người ký văn bản 

 - Ô số 11: dấu của cơ quan 

 - Ô số 12: trình bày các yếu tố của một văn bản sao 

- Ô số 13: ghi dấu mật hoặc khẩn  - Ô số 14: ghi chữ "dự thảo" nếu cần. 
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Sơ đồ bố trí các bộ phận cấu thành văn bản 

 

 Cơ quan chủ quản quốc hiệu 

 Cơ quan ban hành văn bản Địa danh và ngày tháng ban hành văn bản 

 --------  

 Số và ký hiệu văn bản 

  Cơ quan (cá nhân) nhận văn bản 

 Trích yếu nội dung (Đối với công văn) 

 của văn bản 

 (Đối với công văn) 

  Tên loại và trích yếu nội dung 

  (Đối với văn bản có tên gọi) 

 

nội dung của văn bản 

1 . ......... 

2 . ......... 

3 . ......... 

 Cơ quan cá nhân nhận văn bản Chức vụ của người ký văn bản 

 1.Đối với văn bản có tên gọi: ghi  Chữ ký và dấu của cơ quan 

 đầy đủ tên các cơ quan cần giải  Họ và tên người ký 

 quyết và có liên quan đến văn bản 

 2. Đối với công văn: ghi tên các  

 cơ quan có liên quan 

1.3. Cách dùng các  chấm trong câu 

 Các dấu chấm câu là những dấu viết có mục đích chỉ rõ mạch lạc giữa những từ; 

những mệnh đề trong một câu văn, và giữa những những câu trong một đoạn văn. Khi 

nói, những mạch lạc này được biểu lộ bằng giọng nói, lúc nhanh lúc chậm, lúc to, lúc 

nhỏ. 

 a. Dấu phẩy 

   Dấu phẩy (,) thường có 3 công dụng sau: 

- Chia nhiều từ hay nhiều mệnh đề cùng thuộc về một loại, cùng đóng một vai trò 

giống nhau. 

Ví dụ: những ban hành mệnh lệnh gồm có: thông tư, huấn thị, công văn, sự vụ lệnh, 

công vụ lệnh, v.v... 

- Ngăn cách thành phần phụ đặt trước chủ từ và động từ, khi câu văn dùng mỹ từ pháp 

đảo ngữ. 
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Ví dụ: Dự án cất công thự nói trên, các nhà thầu phải cam kếtthực hiện xong trong 

thời gian dự liệu. 

- Đóng khung những chữ hay mệnh đề có mục đích giải nghĩa hay nhấn mạnh cần 

được lưu ý. 

Ví dụ:  Công điện là bản văn hành chính trong trường hợp nơi nhận gần nơi gửi, sẽ 

được mang tay và được gọi là công điện mang tay.  

 Trong văn bản hành chính, còn có trường hợp dùng dấu phẩy xuống hàng như sau: 

Tổng giám đốc trên trọng kính mời 

Ông Trần Văn Mỗ, 

Nghề nghiệp: ..., 

Cư  ngụ tại số...đường ... Hà nội,  

Đến văn phòng Tổng công ty về việc ... trong giờ làm việc. 

 b. Dấu chấm phẩy 

 Dấu chấm phẩy (;) có công dụng của một dấu phẩy, nhiều hơn công dụng của một dấu 

chấm, dùng để chia một câu dài thành nhiều thành phần câu, mỗi phần câu đã diễn hết một ý, 

nhưng những ý này có liên quan đến nhau. 

Ví dụ: Về phương diện tổ chức, cơ quan công quyền giống như một tổ chức tư nhân, 

người bàng quan không thấy có điểm gì khác biệt; về phương diện điều hành, cơ quan công 

quyền đã khác rất nhiều một tổ chức tư nhân. 

 Trong văn bản cũng có trường hợp dùng dấu chấm phẩy xuống hàng vừa có tác dụng 

ngăn cách các phần trong câu, đồng thời làm tăng tính trang trong của vấn đề. Cách thức này 

thường dùng trong phần thượng đề của văn bản quy phạm pháp luật cũng như văn bản hành 

chính. 

Ví dụ:  "Tổng Thanh tra Nhà nước 

- Căn cứ Pháp lệnh Thanh tra ngành 1-4-1991; 

- Căn cứ vào Nghị định 244-HĐBT, ngày 30-6-1990 của Hội đồng Bộ trưởng về tổ chức của 

hệ thống Thanh tra Nhà nước và biện pháp bảo đảm hoạt động thanh tra; 

- Căn cứ vào Nghị định 191-HĐBT ngày 18-6-1991 của Hội đồng Bộ trưởng ban hành quy 

chế thanh tra viên; 

- Sau khi thống nhất ý kiến với Bộ trưởng - Trưởng ban Tổ chức và Cán bộ của Chính phủ, 

Quyết định" 

c. Dấu chấm 

      Dấu chấm (.) dùng để chấm dứt một câu, cắt đoạn một ý. Dấu chấm chỉ dùng để phân 

cách giữa các câu, không được dùng đề phân cách các thành phần trong câu. Phải cân nhắc 
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trên cơ sở nội dung ý nghĩa, mục đích diễn đạt và kết cấu ngữ pháp của câu để quyết định 

việc dùng dấu chấm. 

      Có hai cơ sở lấy làm căn cứ để xét xem một dấu chấm đã đặt đúng vị trí hay sai vị trí: 

1) Nội dung thông báo trong câu văn đã trọn vẹn một ý.  Khi chưa trọn vẹn thì chưa đặt dấu 

chấm; 

2) Tƣơng ứng với nội dung thông báo trên câu đã đƣợc viết với đầy đủ thành phần. 

 d. Dấu chấm xuống hàng 

    Dấu chấm xuống hàng có kỹ thuật viết như dấu chấm, nhưng thường dùng để cách đoạn mạch văn. 

Khi đã diễn tả xong một ý lớn, chuyển sang ý lớn khác nên dùng dấu chấm xuống hàng, làm cho văn 

bản thêm sự rõ ràng mạch lạc. Ngược lại, trong văn bản hết sức tránh việc dùng dấu chấm xuống hàng 

bừa bãi, để làm văn bản rời rạc, lỏng lẻo. 

 e. Dấu hai chấm (:)  

     Dấu hai chấm dùng để báo hiệu lời trích dẫn, hoặc câu văn có tính liệt kê trong nội dung 

diễn đạt. 

Chú ý: Trong trường hợp dấu hai chấm được đặt ở cùng dòng với những câu văn có tính liệt 

kê thì không phải viết hoa chữ cái đầu đầu tiên của từ viết liền sau hai dấu chấm). 

 Trong trường hợp dấu hai chấm được đặt ở dòng trên, những lời trích dẫn đặt ở dòng 

dưới và viết hoa chữ cái của từ đầu tiên. 

Ví dụ:   

 Điều 1, Hiến pháp nước CHXHCN Việt nam quy định: 

  "Nươc cộng hoà XHCN Việt nam là một nước độc lập, có chủ quyền, thống nhất và toàn 

vẹn lãnh thổ, bao gồm đất liền, các hải đảo, vùng biển  và vùng trời." 

 e. Dấu gach ngang 

 - Trong văn đối thoại,  dấu gạch ngang (-) ở đầu dòng dùng đổi ngôi nói. Trong văn chương 

hành chính, dấu gạch ngang ở đầu dòng có công dụng chỉ rõ từng chi tiết được kể lể trong một đoạn 

văn. 

Ví dụ: Bản sao kính gửi: 

- Văn phòng Quốc hội; 

- Văn phòng Chính phủ; 

- Bộ Nội vụ. 

"để kính tường" 

 f. Dấu ngoặc đơn 

    Dấu ngoặc đơn () dùng để đóng khung một sự giải thích hay ghi cú pháp.  

Ví dụ: Yêu cầu Quý cơ quan (Vụ Tổ chức) biết chi tiết về vấn đề nói trên. 

 g. Dấu ngoặc kép 
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     Trong văn chương tổng quát dấu ngoặc kép thường dùng để đóng khung lời nói hay một 

đoạn trích nguyên văn một tác phẩm. Trong văn bản hành chính, ngoài công dụng nói trên, 

dấu ngoặc kép còn được dùng để đóng khung lời chú thích hay dẫn giải. 

Ví dụ: “ Để kính tường”, “Để thi hành”, v.v... 

 Ngoài ra, trong văn chương hành chính những dấu chấm câu sau đây rất ít được sử 

dụng vì lý do không thích hợp với đặc tính những văn bản hành chính. 

 - Dấu ba chấm (...) dùng để diễn tả ý tưỏng bỏ lửng không nói hết. 

 - Dấu chấm hỏi (?) dùng để chỉ một câu nghi vấn. 

 - Dấu chấm than (!) dùng để chỉ một câu than, chấm sau một tiếng than. 

 

1.4. Một số quy định lề, kiểu chữ  và cỡ chữ trong văn bản của các cơ quan Nhà 

nƣớc  

 - Tại công văn số: 1145/VPCP-HC ngày 1 tháng 4 năm 1998 của Văn phòng Chính 

phủ. Lề văn bản áp dụng mang tính chất tham khảo được quy định như sau: lề trên: 25mm, lề 

dưới: 20mm, lề trái: 35mm, lề phải: 20mm. 

   Nếu văn bản 2 mặt lề trên: 25mm,  lề dưới:, lề trái: 20mm, lề phải: 35mm, cỡ quy định: 

 

TT Thành phần thể thức Kiểu chữ Cỡ chữ Dáng chữ 

1 cộng hoà ... việt nam 

Độc lập - Tự do - Hạnh phúc 

VnTimeH 

VnTime 

13 

13 

Đậm 

Đậm 

2 Chính phủ (cq ban hành văn bản) VnTimeH 13 Đậm 

3 Số: 09/1998/QĐ-TTg VnTime 13 Đứng 

4 Hà nội, ngày    tháng   năm 1998 VnTime 13 Nghiêng 

5 Quyết định của ...  

về công tác phí 

VnTimeH 

VnTimeH 

14 

14 

Đậm 

Đậm 

6 .... Về công tác phí VNTime 14 Đứng 

7 Kính gửi: 

Bộ Tài chính 

VNTime 14 Đứng 

8 Trong công tác... (Nội dung) VnTime 14 Đứng 

9 Điều 1: VnTime  14 Đậm 

10 Đối với giáo viên (Các khoản) VnTime  14 Đứng 

11 TM.Chính phủ VnTimeH 13 Đậm 

12 Thủ tướng chính phủ VnTimeH 13 Đậm 

13 Nguyễn Văn A VnTime  14 Đậm 

14 Nơi nhận: 
- Thường vụ Bộ Chính trị 

 - Thủ tướng, các phó TTg 

VnTime  

VnTime  

12 

11 

Nghiêng(đ

ậm) 

Đứng 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 18 

15 Mật Khẩn VnTimeH  13 Đậm 

16 xong hội nghị xin trả lại VnTimeH  12 Đậm 

17 PL.300 (ký hiệu người đánh, số bản) VnTime  10 Đứng 

1.5. Một số quy định lề, cỡ, kiểu chữ trong văn bản của các cơ quan Đảng 

 - Tại hướng dẫn số: 01-HD/VPTW ngày 02 tháng 02 năm 1998 của Văn phòng 

Trung uơng quy định quy định : lề trên: 25mm, lề dưới: 25mm, lề trái: 35mm, lề phải: 

15mm. 

 

TT Thành phần thể thức Kiểu chữ Cỡ chữ Dáng chữ 

1 Đảng công sản việt nam VnTimeH 15 Đứng, 

đậm 

2 tỉnh uỷ lạng sơn (tác giả văn bản) VnTimeH 14 Đứng, 

đậm 

3 Huyện uỷ quỳnh phụ (cq cấp trên)  14 Đứng, 

đậm 

4 Số 127-QĐ/TW VnTimeH 14 Đứng 

5 Hạ long, ngày 20  tháng 1  năm 1998 VnTime 14 Nghiêng 

6 Thông báo VnTimeH  16 Đứng, 

đậm 

7 về công tác phí (trích yếu) VNTime 14 Đứng, 

đậm 

8 về chế độ công tác phí (trích yếu) VNTime 12 Nghiêng 

9 Trong công tác (Nội dung) VnTime  14 Đứng 

10 T/M ban thường vụ VnTimeH 14 Đứng, 

đậm 

11 Phó trưởng ban VnAvant

H 

12 Đứng 

12 Nguyễn Hồng Q VnTime 14 Đứng, 

đậm 

13 Nơi nhận VnTime  14 Đứng 

14 Ban tuyên giáo (nơi nhận cụ thể) VnTime 12 Đứng 

15 Mật Khẩn VnTimeH 14 Đứng, 

đậm 

16 Xong hội nghị xin trả lại VnTimeH 14 Đứng, 

đậm 

17 T.31 QQĐ/TW 320 (Ký hiệu người đánh, mã 

số, số lượng bản) 

VnTime 14 Đứng 

 

* Ví dụ về bố cục biên bản hội nghị: 
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biên bản hội nghị... 
 

( Thí dụ  Hội nghị công nhân viên chức cơ quan ) 

 

1. Khai mạc... giờ, ngày... tháng... năm... tại... 

2. Thành phần hội nghị 

   - Số người có mặt ( hội nghị quan trọng mà ít người thì cần ghi cả tên những 

người có mặt) 

   - Số người vắng mặt ( có thể ghi rõ tên và lý do ) 

   - Số đại biểu mời ( có thể ghi tên và lý do ) 

3.   Lý do hội nghị (ghi rõ tên người khai mạc, tuyên bố lý do ) 

4.   Chương trình hội nghị  (các vấn đề cần giải  quyết ) 

5.   Đoàn chủ tịch, đoàn thư ký (ghi tên người được hội nghị bầu) 

 

 Phần thứ hai: Tiến hành hội nghị 

 

1. Báo cáo (ghi rõ tên người trình bày, tóm tắt nội dung báo cáo ) 

2. Thảo luận 

   - Những vấn đề đoàn chủ tịch nêu ra để thảo luận. 

   - Những ý kiến thảo luận. 

   - ý kiến kết luận của đoàn chủ tịch 

3.   Quyết nghị 

   - Ghi rõ những vấn đề hội nghị thống nhất biểu quyết thông qua, tỷ lệ 

phiếu: chống, thuận, trắng. 

   - Phân công chịu trách nhiệm thực hiện 

 

Phần thứ ba: Ghi những sự việc kết thúc hội nghị 

        

  - ý kiến đóng góp phê bình 

  - Cảm tưởng đại biểu 

 

Phần kết thúc 

 

  - Ngày giờ kết thúc 

  - Chữ ký của thư ký và chủ tịch đoàn. 
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  Nếu biên bản có đọc trước để hội nghị thông qua cần ghi thêm cả phần 

cuối cùng: Biên bản đã được đọc trước hội nghị và được toàn thể hội nghị nhất 

trí thông qua. 

  Nếu có đính kèm những văn bản khác như nghị quyết, quyết tâm thư...  

cần ghi rõ vào phần chú thích. 
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Chƣơng 2:  Soạn thảo văn bản trên microsoft Winword 

2.1. Giới thiệu Winword 

 Winword là phần mềm soạn thảo văn bản cao cấp chạy trên môi trường Windows, 

chuyên dùng để soạn thảo các loại văn bản, sách vở, tạp chí,...phục vụ cho công tác văn 

phòng. Winword có các tính năng mạnh như sau: 

 - Giao diện đồ hoạ thông qua hệ thống thực đơn và các hộp hội thoại với hình thức 

thẩm mỹ rất cao. 

 - Có khả năng giao tiếp dữ liệu với các ứng dụng khác. 

 - Có các bộ chương trình tiện ích và phụ trợ giúp tạo các văn bản dạng đặc biệt. 

  - Có chương trình kiểm tra, sửa lỗi chính tả, gõ tắt, macro giúp người sử dụng soạn 

thảo các văn bản nước ngoài và tăng tốc độ xử lý văn bản. 

 - Chức năng tạo biểu bảng mạnh và dễ dùng. 

 - Word còn cung cấp nhiều khuôn mẫu, kiểu đã được định nghĩa sẵn, giúp bạn nhanh 

chóng và dễ dàng tạo được các tài liệu và trang Web hoàn hảo và hấp dẫn. 

2.1.1. Khởi động Winword 

 Nháy chuột vào nút Start   chọn program   chọn Microsoft Word hoặc nháy chuột 

vào biểu tượng    
 

2.1.2. Màn hình giao tiếp của Winword 

 Sau khi khởi động, màn hình chính của Winword xuất hiện như sau: 

 - Title bar ( Thanh tiêu đề): dòng chứa tên của tệp văn bản. 

 - Menu Bar ( Thực đơn hàng ngang): dòng chứa các lệnh của Winword, mỗi lệnh ứng 

với một thực đơn dọc ( Menu PopUp). 

Thao tác để mở một thực đơn dọc: 

 - Chỉ con trỏ chuột vào tên thực đơn dọc trên Menu Bar rồi nhấn nút trái chuột. 

- Hoặc gõ phím F10, rồi dùng phím mũi tên di chuyển vệt sáng đến thực đơn dọc cần 

mở và ấn nút trái chuột. 

 - Hoặc gõ Alt+ ký tự đại diện của tên thực đơn dọc ( ký tự có gạch dưới) trong các 

thực đơn dọc. 

 - Các lệnh được in màu rõ là có thể chọn và thực hiện được. 

 - Các lệnh có màu xám nhạt là lệnh tạm thời không thực hiện được. 

 - Các ký tự được gạch dưới thì có thể chọn lệnh tương ứng bằng cách nhấn ký tự đó 

(thay vì phải di vệt sáng đến lệnh và nhấn Enter). 
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 - Các lệnh có ghi kèm tổ hợp phím thì có thể chọn nhanh bằng cách nhấn tổ hợp phím 

đó ( ví dụ: có thể lưu văn bản lên đĩa bằng cách nhấn Ctrl+S) 

 - Các lệnh có dấu 3 chấm (...) phía sau cho biết sẽ có một hộp thoại xuất hiện khi lệnh 

được chọn. 

 
 

 - Tools Bar ( thanh công cụ): Chứa một số biểu tượng ( Icon) thể hiện một số lệnh 

thông dụng. Thay vì phải vào các hộp menu để chọn lệnh, chỉ cần nháy chuột lên biểu tượng 

của lệnh tượng ứng. Ví dụ: Muốn lưu văn bản lên đĩa thay vì vào menu File chọn Save, chỉ 

cần nháy chuột lên biểu tượng đĩa mềm. 

 Chú ý: 

- Các Tool Bar có thể tắt hay mở bằng lệnh View/ToolBar 

- Muốn biết ý nghĩa của một biểu tượng nào đó thì rà mũi tên chuột ( không nhấn nút chuột) 

lên biểu tượng đó và chờ vài giây. 

 - Formating Bar ( thanh định dạng): Chứa các hộp và biểu tượng dành cho việc định 

dạng văn bản như kiểu, loại font, cỡ font, căn lề ... 

 Ruler ( thước): Hiển thị thước theo chiều ngang, dọc văn bản. Ruler có thể tắt hay mở 

bằng View/Ruler. 

 - Text area ( vùng văn bản): đây là vùng lớn nhất dùng để nhập văn bản. 

Tools Bar Title 
Bar 

Formating Bar 

Font  Size
t  

Font 
Style 

Drawin
g 

Align 

Numbering 

Scroll bar 

Rule
r 

Drawing 
bar 

Status 
bar 
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 - Status Bar ( thanh trạng thái): hiển thị tình trạng của cửa sổ hiện tại như số thứ tự 

trang, thứ tự cửa sổ, tổng số trang, vị trí con trỏ ( dòng, cột), giờ, tình trạng của Capslock, 

Numlock,... thanh này nằm ở dòng cuối cùng màn hình. 

 - Shortcut Menu: Kích hoạt  bằng cách nháy nút phải của chuột. Thao tác nhanh theo 

từng đối tượng ( tùy theo vị trí con trỏ chuột mà kích hoạt Shortcut Menu tương ứng). 

 - Scroll bar (các thanh cuộn ngang, dọc) hay thanh trạng thái, để hiển thị hoặc che dấu, 

hãy chọn Option từ lệnh đơn Tools và mở khối View ra trong hộp hội thoại Option để chọn 

tuỳ chọn tương ứng 

2.1.3. Xử lý các cửa sổ 

Word cho phép làm việc đồng thời với nhiều văn bản trên các cửa sổ khác nhau. Khi 

vừa khởi động, Word mở một cửa sổ với tên mặc nhiên là Documentl. Để mở một cửa sổ 

mới có thể vào Menu File chọn New hoặc Open 

 - Chọn New: Mở một văn bản mới ( hoặc gõ Ctrl+N hoặc chọn biểu tượng ) 

 - Chọn Open: Mở văn bản đã có trên đĩa. ( Ctrl+O hoặc ) 

Tại một thời điểm chỉ có một cửa sổ được kích hoạt, muốn làm việc với một cửa sổ 

khác đã được mở: Gõ Alt+W, chọn số thứ tự tượng ứng với cửa sổ cần kích hoạt. 

 Để tiết kiệm bộ nhớ, nên đóng các cửa sổ không cần thiết, chỉ giữ lại các cửa sổ cần 

trao đổi dữ liệu với nhau. Muốn đóng một cửa sổ thì nó phải đang được kích hoạt, vào menu 

File, chọn Close (hoặc nháy đúp chuột vào hộp điều khiển trên thanh Menu Bar). 

 Chú ý: Khi thực đơn dọc File được kích hoạt, gần cuối hộp thực đơn dọc có danh sách 

4 tài liệu được soạn mới nhất, chỉ cần Click tên tài liệu hoặc nhấn số thứ tự tương ứng để mở 

tài liệu đó. Có thể không hiện hoặc thay đổi số tài liệu được hiển thị bằng cách vào thực đơn 

dọc Tools, chọn Options, Click mục General và thay đổi phần Recently user List File. 

2.1.4. Lƣu trữ tài liệu 

a. Để lưu trữ một tài liệu có thể chọn một trong các cách sau: 

 - Gõ Ctrl+S ( hoặc nháy chuột trên biểu tượng  

 - Vào Menu File, chọn Save. 

Lần đầu lưu trữ tài liệu,hộp đối thoại Save as xuất hiện, yêu cầu người sử dụng nhập vào: 

 - Tên tệp 

 - Thư mục để chứa tệp lưu trữ 

 - Kiểu loại tệp: ( Click vào hộp Save File as Type), cho phép lựa chọn một trong các 

kiểu văn bản để dùng cho WordPerfect, MS-DOS Text, Window Write... 

 - Hộp Options cho phép định các cấu hình khi lưu trữ, Password cho tệp... 

 - Cuối cùng chọn OK để lưu 
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Kể từ đó, mỗi khi thực hiện thao tác lưu trữ tệp thì văn bản sẽ được lưu vào tên tệp đã đặt 

theo dạng của lần ghi đầu tiên. 

b. Ghi vào đĩa với một tên khác: Vào menu File chọn Save as, sau đó các thao tác tiến 

hành tượng tự như lần ghi tệp đầu tiên. 

c. Đặt cấu hình cho tệp lưu trữ: Vào menu Tools, chọn Options, lựa mục Save. Hộp 

đối thoại Save Options xuất hiện. 

 Một số cấu hình hay sử dụng: 

- Always create Backup Copy: Luôn tạo tệp phòng hờ ( *.BAK) khi lưu tệp lên đĩa. 

- Allow Fast Save: Cho phép lưu tệp nhanh ( chỉ lưu những phần sửa đổi không tạo tệp 

*.BAK) 

    -  Save Autorecover info every: tự động lưu tệp tin sau từng khoảng thời gian nhất 

định, nếu hệ thống bị sự cố bất ngờ, thì khởi động lại word, bạn có thể cứu được một phần 

thông tin.  Muốn cấu hình nào có tác dụng, cần đánh dấu X bằng cách Click vào hộp trắng 

phía trước. 

d. Lưu trữ tài liệu dưới dạng HTML:  vào thực đơn dọc File, chọn Save as HTML... 

HTML là một định dạng chuẩn được sử dụng cho các trang WEB. 

Chú ý: các mục Save, Save as chỉ lưu tài liệu trên cửa sổ đang mở. 

2.1.5. Kết thúc Winword 

Có thể dùng một trong 3 cách sau 

 - Nháy đúp nút chuột vào Control Menu Box. 

 - Vào menu File, chọn exit ( hoặc Nhấn Alt+F,X) 

 - Dùng tổ hợp phím Alt+F4. 

Nếu có thực hiện bất kỳ sửa đổi nào trong các văn bản đang mở mà chưa lưu vào đĩa ( cho 

đến  

thời điểm thoát) thì Word sẽ hỏi lại: 

 

 
 

  Thoát không lưu lên đĩa   Trở lại soạn thảo 
 

 

2.2. Nhập và điều chỉnh văn bản 

2.2.1. Các phím thƣờng dùng trong Winword. 
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 - Di chuyển con trỏ: 

  : di chuyển con trỏ qua phải một ký tự 

   : di chuyển con trỏ xuống một dòng 

   : di chuyển con trỏ lên một dòng  

 : di chuyển con trỏ qua trái một ký tự 

Home : di chuyển con trỏ về đầu dòng văn bản 

End   : di chuyển con trỏ về cuối dòng văn bản 

PgUp: di chuyển con trỏ lên một trang màn hình 

PgDn: di chuyển con trỏ xuống một trang màn hình 

Ctrl-Home: di chuyển con trỏ về đầu văn bản 

Ctrl-End  : di chuyển con trỏ về cuối văn bản 

F5      : di chuyển con trỏ nhanh đến trang nào đó. Khi gõ phím này, hộp đối thoại sau 

hiện ra: 

 - Phím xoá ký tự: 

 Delete: Xoá ký tự đứng sau vị trí con trỏ 

 Backspace: Xoá ký tự đứng trước con trỏ 

 Ctrl + Delete: Xoá từ đứng sau con trỏ 

 Ctrl + Backspace: Xoá từ đứng trước con trỏ 

 - Phím Insert: Dùng để chọn các thực đơn dọc bằng bàn phím. 

 - Phím Esc   : Dùng để ngắt một công việc đang thực hiện. 

2.2.2. Nguyên tắc nhập một văn bản trong Winword 

 - Phím Enter dùng để ngắt một Paragraph. Không được gõ Enter để ngắt các dòng 

trong một đoạn ( Paragraph) (Tạo dòng mới trong đoạn văn bản, nhấn Shift + Enter) 

  - Gõ các dấu: ngay sát ký tự cuối cùng của từ trước và cách ký tự đầu tiên của từ sau 

một ký tự trống 

 - Với những Paragraph có tính chất điều khoản, phải dùng phím Tab sau tiêu đề của 

Paagraph đó. 

2.2.3. Thao tác trên một khối chọn 

Khối ( Block) là một đoạn văn bản liên tục. 

a. Chọn một khối: 

Đưa con trỏ đến đầu khối rồi dùng một trong các cách: 

 - Giữ phím Shift, nhấn các phím , , , , PgUp, PgDn, Home, End đến vị trí cuối. 

 - Rê chuột đến vị trí cuối. 

 - Giữ Shift, đưa con trỏ chuột đến vị trí cuối rồi nháy nút trái chuột. 
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Chú ý: 

 - Nếu chọn  một số dòng bằng chuột, có thể rê chuột ở bên lề trái các dòng. 

 - Chọn toàn bộ văn bản: gõ Ctrl+A 

 - Chọn từ vị trí con trỏ đến cuối văn bản: gõ Shift +Ctrl+End 

 - Chọn từ vị trí con trỏ đến đầu văn bản: gõ Shift+Ctrl+Home 

 - Chọn từ vị trí con trỏ đến đầu dòng    : gõ Shift+Home 

 - chọn từ vị trí con trỏ đến cuối dòng   : gõ Shift+End 

  Nhấn F8 nhiều lần để chọn một phần hay nguyên tài liệu. Trước tiên nhấn F8, sau 

đó nhấn F8 lần thứ hai để chọn từ hiện hành, lần thứ ba để chọn câu hiện hành, lần thứ tư để 

chọn đoạn văn bản hiện hành và lần thứ năm để chọn nguyên tài liệu 

b. Chép một khối: 

Chép khối bằng thực đơn dọc: 

- Chọn khối muốn chép 

- Thực hiện lệnh Edit-Copy trên thực đơn dọc ( hoặc gõ Ctrl+C) 

- Di chuyển con trỏ đến vị trí mới 

- Thực hiện lệnh Edit-Paste trên thực đơn dọc ( hoặc gõ  Ctrl+V) 

Chép khối bằng Tools Bar: 

- Chọn khối muốn chép 

- Nháy chuột trên biểu tượng  của Tools bar 

- Di chuyển con trỏ đến vị trí mới 

- Nháy chuột trên biểu tượng  của Tools Bar 

c. Chuyển một khối: 

Chuyển khối bằng thực dơn dọc: 

- Chọn khối muốn chép 

- thực hiện lệnh Edit-Cut trên thực đơn dọc ( hoặc gõ Ctrl+X) 

- Di chuyển con trỏ đến vị trí mới 

- Thực hiện lệnh Edit-Paste trên thực đơn dọc ( hoặc gõ Ctrl+V) 

 Word cung cấp hai tuỳ chọn tác động đến cách di chuyển và sao chép khối khi sử dụng 

ClipBoard. Để xác lập các tuỳ chọn này, hãy chọn Option từ lệnh đơn Tools, mở khối Edit: 

 + Tuỳ chọn Use the INS key for Paste được chọn, thì ta có thể dán bằng cách nhấn 

Insert thay cho Ctrl+V (Nếu không , phím Insert sẽ bật tắt hai chế độ Insert và Overtype) 

 + Tuỳ chọn User smart cut and paste được chọn, thì Word sẽ xoá bớt các khoảng 

trống còn dư lại sau khi cắt chữ 

Chuyển khối bằng Tools Bar: 
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- Chọn khối muốn chép 

- Nháy chuột trên biểu tượng  của Tools Bar 

- Di chuyển con trỏ đến vị trí mới 

- Nháy chuột trên biểu tượng  của Tools Bar 

 Lưu nhiều khối chữ trong Clipboard: sử dụng thanh công cụ Clipboard để cắt hay chép 

nhiều khối chữ (tối đa là mười hai) 

d. Xoá một khối 

- Chọn khối muốn xoá 

- Gõ phím Delete 

Ghi chú: 

 1. Chọn khối chữ 

 2. Nhấn Ctrl + F3 để xoá khối và đưa nó vào Spike 

 3. Lặp lại bước 1 và 2 cho các khối chữ khác muốn đưa vào Spike 

 4. Đặt điểm chèn vào vị trí đích sẽ chèn chữ rồi nhấn Ctrl+Shift+F3. Khi đó mọi khối 

chữ đã đưa vào Spike sẽ xuất hiện trên tài liệu và Spike trở thành rỗng. Các khối được dán 

theo thứ tự khi đưa vào Spike, và mỗi khối chữ là một đoạn văn bản riêng. 

2.2.4. Định dạng văn bản và các đoạn 

a. Định dạng ký tự ( character) 

 Thay đổi mẫu ký tự ( Font): nháy chuột vào mũi tên xuống trong hộp tên Font, một 

danh sách các tên Font hiện ra, từ đó chọn Font cần sử dụng.  

 Thay đổi cỡ ký tự ( Point Size): nháy chuột vào mũi tên xuống trong hộp Point Size, 

chọn số chỉ cỡ Font.  

Chú ý: nếu muốn tăng cỡ Font lên một đơn vị thì nhấn Ctrl+], nếu muốn giảm cỡ Font đi một 

đơn vị thì nhấn Ctrl+[ 

     Thay đổi kiểu ký tự ( Type Style) 

 - Có 3 kiểu thể hiện: Đậm ( Bold), nghiêng ( Italic), gạch dưới ( Underline) 

 - Có thể kết hợp nhiều kiểu chữ. Ví dụ: Đậm nghiêng, nghiêng gạch dưới... 

 - Muốn chọn kiểu nào thì Click vào một trong các ký tự B, I, U trên thanh công cụ  

  hoặc sử dụng tổ hợp phím Ctrl+B, Ctrl+I, Ctrl+U) 

Để  định dạng đầy đủ, chọn Font trong menu Format, hộp đối thoại xuất hiện: 

Gạch dưới ( Underline): 

 None:  Không gạch 

 Single: Gạch nét đơn     Double:  Gạch nét đôi 

  Words only: Chỉ gạch các từ   Dotted : Gạch nét đứt 
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Các hiệu ứng ( effects): 

  Strikethrough: Có đường kẻ ngang   Hidden:  Không hiện 

 Superscript:     Chỉ số trên     Small Caps: CHữ IN NHỏ 

  Subscript:  Chỉ số dưới     All Caps: Chữ in lớn 

Nếu chọn nút Default thì các thông số định dạng sẽ được lấy làm trị mặc nhiên cho mỗi lần 

khởi động Word hoặc mở một tài liệu mới. 

        

b. Định dạng Paragraph: cho phép thay đổi các hiển thị của một đoạn văn bản. 

 Vào menu Format, chọn Paragraph, hộp đối thoại sau xuất hiện: 

 - Trong Indentation: 

  Left ( Right)    : đặt lề trái ( phải) cho đoạn văn bản 

  Special f irst line : đặt lùi vào cho dòng đầu một đoạn 

 - Trong Spacing: 

  Before: Khoảng cách giữa đoạn được chọn và đoạn trước 

  After:  Khoảng cách giữa đoạn được chọn và đoạn sau 

  Line Spacing: Đặt khoảng cách giữa các dòng trong đoạn 

  Single: cách dòng đơn  Double: cách dòng đôi 

  1.5 lines: cách một dòng rưỡi  Aleast:  cách dòng nhỏ nhất 

  Exactly:  cách dòng chính xác theo giá trị của con số do người dùng nhập 

 - Trong Alignment: 

  Left ( Right): canh đều theo biên trái ( phải) phím nóng: Ctrl+L (R) 

  Center: canh vào giữa Ctrl+E                          

  Justified: canh đều hai bên trái và phải (Ctrl+J)     Left  Center Right     Justify 

2.2.5. Các loại định dạng khác 

a. Tao khung và làm nền ( Border) 

Để tạo khung và làm nền cho một đoạn văn bản, trước tiên: chọn đoạn văn bản cần 

tạo sau đó vào thực đơn dọc format, chọn Border and Shading. Một hộp thoại xuất hiện: 

- Nháy chuột tại các vị trí cạnh muốn làm khung ( Border) 

- Nháy chuột tại các dạng đường làm hkung ( Line) 

- Nháy chuột  hộp Shading và chọn dạng nền nếu muốn làm nền cho đoạn văn bản đó. 

Chú ý, có thể nháy chuột vào biểu tượng Border   xuất hiên thanh công cụ border như sau: 

 Vẽ các đường bên trong khối 

b. Sơn định dạng dùng để sao chép định dạng của một đoạn văn bản. 

 Cách thực hiện: 
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- Đưa con trỏ vào vùng văn bản mẫu 

- Nháy chuột lên biểu tượng Format Painter  

  ( xuất hiện chổi sơn bên cạnh con trỏ chuột) 

- Rê chuột lên vùng văn bản cần sao chép 

hoặc có thể sử dụng dùng phím:  Lựa chọn vùng văn bản cần sao chép định dạng, nhấn đồng 

thời các phím Ctrl+Shift+C,  sau đó lựa chọn vùng văn bản cần định dạng và nhấn phím 

Ctrl+Shift+V. 

c. Định khoảng cách Tab Stop ( Tab) 

Mỗi lần gõ phím Tab, con trỏ sẽ dừng tại một vị trí. Khoảng cách từ vị trí dừng của 

Tab này đến vị trí dừng của Tab khác gọi là chiều dài của Tab Stop. Khoảng cách ngầm định 

là 0,5 inch (1.27cm). 

Việc thay đổi chiều dài của Tab Stop có thể thực hiện như sau: 

- Vào thực đơn dọc Format chọn Tabs... 

 Một hộp thoại xuất hiện: 

- Gõ vào vị trí của một Tab Stop, có thể chọn ký tự trong Leader ( 2,3,4) nếu muốn những ký 

tự này trình bày giữa hai Tab Stop. 

- Chọn < OK> hay gõ Enter. 

d. Định số cột ( Column) 

Có thể trình bày văn bản trên nhiều cột như dạng bài báo bằng thao tác: 

- Chọn chế độ Layout ( thực hiện lệnh View/Page Layout) 

- Thực hiện lệnh Format - Columns. 

- Gõ số cột tương ứng trong hộp Number of Columns 

- Chọn <OK> hay gõ Enter. 

e. Bullets và Numbering 

 Có thể xác định các dấu chấm đen hình tròn ( Bulletes) hay đánh số ( Numbering) hay đánh 

ký tự Alphabe ở đầu các đoạn. 

 Cách 1: Dùng ký hiệu trên Tools Bar. 

 - Chọn các đoạn muốn định Bullets hay Numbering 

 - Nháy chuột lên biểu tượng  để định Bulletes hay biểu tượng  để định 

Numbering. 

 Cách 2: Dùng thực đơn dọc: 

 - Chọn các đoạn muốn định Bulletes hay Numbering 

 - Thực hiện lệnh Format - Bulletes and Numbering. 
 

 f. Định dạng nền (Background) 
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 g. Định dạng tự động (AutoFormat) 

 h. Định dạng kiểu bằng cách sử dụng hộp thoại  Style ... Từ thực đơn Format 

chọn Style, một hộp thoại Style xuất hiện, chọn New, trong mục Name bạn chọn tên kiểu mà 

bạn muốn. Sau đó, bạn định dạng kiểu đó bằng cách nháy chuột vào mục Format trong hộp 

Style để có thể định dạng Font, Paragrah, Tabs, Boder ...   Chọn ShortcutKey... để chọn  

phím gõ tắt cho kiểu   Assign  Close  OK. 
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Chương 3: Trình bày trang và màn hình 

3.1. Định dạng trang 

 Vào menu File, chọn page Setup, hhộp đối thoại sau hiện ra; 

a. Thiết lập cỡ giấy và hƣớng in: chọn Page size 

- Nháy chuột vào mũi tên xuống ở mục Page size để chọn cỡ giấy. Có thể lựa một trong các 

cỡ được định nghĩa sẵn. Muốn tạo trang in có kích thước tuỳ ý thì thay đổi các con số quy 

định chiều rộng (Width) và chiều cao ( Height). Khi đó cỡ giấy được gọi là Custome size (cỡ 

của người dùng tự định nghĩa) 

- Chọn nút tác dụng cho mục Portrait ( hướng in dọc) hoặc Landscape ( hướng in ngang) 

- Trong mục Apply To ( áp dụng cho) chọn một trong 3 khả năng: 

. This Section   - để áp dụng cho vùng hiện tại. 

. This point Forward  - áp dụng cho vùng từ vị trí hiện tại trở về sau 

. Whole Document - áp dụng cho toàn bộ tài liệu. 

- Chọn OK để xác nhận các thông số mới thiết lập. Có thể chọn Default để lưu các thông số 

vào tệp khuôn mẫu sử dụng cho nhiều tài liệu về sau. 

b. Đặt lề, chọn Page Margins. 

- Thay đổi khoảng cách từ mép giấy đến phần văn bản, gồm các phần Trên ( Top), Dưới 

(Bottom), Trái ( Left), Phải ( Right). Sau khi thay đổi một trong các thông số quy định lề, 

phần Preview sẽ cho thấy hình dạng tương đối của văn bản so với kích thước giấy. 

- Để in tài liệu theo mặt đối xứng của giấy, chọn tác dụng cho mục Mirror Margins (làm mép 

lề đối xứng). Khi đó, các mục Left, Right sẽ được đổi thành Inside ( chỉ mép lề trong), 

Outside ( chỉ mép lề ngoài) và chúng sẽ thay đổi tuỳ theo các trang chẵn, lẻ của tài liệu. 

- Con số trong hộp Gutter để chỉ khoảng cách chừa lề cho việc đóng tập tài liệu. 

- Mục Apply To và các bước tiếp theo thao tác tương tự như phần Page size. 

* Cách đặt lề bằng thước đo. 

  Phương pháp này thường kết hợp giữa các thao tác xử lý chuột và cây thước ngang 

trên màn hình ( việc sử dụng phím mất nhiều thời gian và phức tạp hơn). Việc đặt lề ảnh 

hưởng đến toàn bộ đoạn văn bản hiện tại. Trên thước sẽ có các mẫu hình tam giác quy định 

vị trí lề hiện tại. Muốn thay đổi chỉ cần rê chuột lên các mẫu tương ứng, di chuyển đến vị trí 

mới rồi thả chuột. Phía trái thước gồm 3 phần: hai mẫu hình tam giác phía trên và một mẫu 

hình vuông bên dưới. 

 - Mẫu tam giác trên: đặt lề trái cho dòng đầu tiên trong đoạn 

 - Mẫu tam giác dưới:  đặt lề trái cho các dòng còn lại 

 - Mẫu hình vuông:  đặt lề trái cho cả đoạn 
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    Để thay đổi lề trái cho toàn bộ văn bản, di con trỏ chuột đến phần tiếp giáp giũa hai mẫu 

tam giác cho đến khi xuất hiện mũi tên hai chiều      Rồi rê chuột để thay đổi. Mỗi khi rê 

chuột, sự thay đổi sẽ hiện ra ngay trên màn hình. 
 

 

3.2. Đặt tiêu đề 

 Tiêu đề đầu trang và cuối trang là văn bản được in trên đầu ( hoặc cuối) mỗi trang của 

tài liệu. Thường sử dụng mục này để thêm vào tài liệu tên tác giả, tên tài liệu, cơ quan phát 

hành...Có thể áp dụng các kiểu đặt tiêu đề sau: 

 - Tiêu đề giống nhau trên toàn bộ các trang của tài liệu. 

 - Tiêu đề của trang đầu tiên khác với các trang còn lại. 

 - Một tiêu đề dành cho các trang chẵn, tiêu đề kia dành cho các trang lẻ. 

Các bước tiến hành để đặt tiêu đề: 

- Vào thực đơn dọc View, chọn Header and Footer.  Phần trình bày tiêu đề sẽ xuất hiện cùng 

với thanh dụng cụ. 

- Gõ vào nội dung tiêu đề đầu trang ở khung Header, tiêu đề cuối trang ở khung Footer. 

  : chuyển đổi tiêu đề đầu/ cuối trang. 

  : xem Header ( hoặc Footer) kế trước 

  : xem Header ( hoặc Footer) kế sau 

  : thực hiện chế độ chọn Header và Footer như ở các trang trước. 

  : chèn vào số trang...chèn ngày hiện tại...chèn giờ hiện tại. 

  : cho/ không cho phép hiển thị văn bản của trang hiện tại 

  cuối cùng, Click nút Close để trở về chế độ soạn thảo văn bản thông thường. 

      Để kích hoạt chế độ sửa đổi tiêu đề, có thể nháy đúp chuột vào phần ghi tiêu đề ( phần 

chữ nhậtt trong chế độ Page Layout) 

3.3. Đánh số trang 

Vào thực đơn dọc Inert chọn Page Numbers. Hộp thoại Page Numbers xuất hiện: 

a. Chọn vị trí đánh số trang 

- Đầu trang - Top of Page ( Header) hoặc cuối trang - Bottom of Page ( Footer) 

- Bên trái, phải, giữa hoặc bên trong/ ngoài mép giấy đối với trường hợp in theo hai mặt đối 

xứng của trang giấy. 

b. Có/ không hiển thị số trang ở trang đầu tiên của tài liệu( Show Number on first 

Page)  

c. Nháy chuột nút Format để thiết lập các thông số: 
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- Bắt đầu đánh từ số mấy ( Start At) hoặc tiếp theo số trang của phần trước ( continue from 

previous section) 

- Kiểu cách số ( Number Format) 

chọn OK để xác nhậm các thiết lập hoặc Cancel để bỏ qua. 

3.4. Trình bày màn hình 

 a. Các kiểu xem trong tài liệu 

Có thể sử dụng bốn chế độ khác nhau để xem tại liệu trên cửa sổ màn hình. Từ thực đơn dọc 

View chọn một trong bốn kiểu sau: 

- Normal (chế độ bình thường): đây là chế độ mặc nhiên của Word, phần lớn các kiểu định 

dạng đặc biệt đều nhìn thấy được trên màn hình. Riêng một số trường hợp được đơn giản 

hoá để tăng tốc độ truy xuất ( ví dụ: trong chế độ này sẽ không thấy được các tiêu đề và số 

trang, không thực hiện được các thao tác vẽ đồ hoạ...) 

 Trong chế độ này, các trang ngăn cách nhau bởi đường chấm chấm nằm ngang. 

- Outline ( chế độ tổng quan): thường dùng để xem các mục tiêu đề lớn của tài liệu, giấu đi 

các chi tiết nhỏ hoặc chuyển chúng đến một vị trí mới. 

- Page Layout ( chế độ trình bày ngang): tài liệu sẽ được hiện lên giống như lúc được in ra. 

Các tiêu đề đầu và cuối trang, số trang đều được thể hiện. Muốn sử dụng các thao tác vẽ đồ 

hoạ phải chuyển qua chế độ này. 

- Master Document ( chế độ tổng quan tài liệu): tương tự như chế độ Outline nhưng ở mức 

cao hơn. ở chế độ này có thể thao tác thêm cả phần tài liệu con, kết hợp nhiều tệp vào một tài 

liệu lớn... 

 b. Xem toàn màn hình 

Có thể cho vùng làm việc của người sử dụng nhiều hơn bằng cách bỏ hết các thanh Menu, 

thanh công cụ,...Để thực hiện việc này, chọn View- Full Screen. Trở lại màn hình cũ bằng 

cách gõ Esc hay nháy chuột vào hộp Full Screen. 
 

 c. Phóng to thu nhỏ màn hình 

- Nháy chuột vào biểu tượng Zoom Control hoặc vào thực đơn dọc View, chọn Zoom. 

- Chọn một trong các con số quy định % văn bản được hiển thị hoặc tăng giảm con số tuỳ ý 

trong hộp Percent. 

 d. Hiển thị tài liệu trƣớc khi in 

 Để xem tổng quát toàn bộ tài liệu trước khi in, có thể thực hiện bằng hai cách: 

- Nháy chuột vào biểu tượng Pint Preview  trên thanh công cụ. 

- Vào menu File, chọn Print Preview. 
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Word sẽ thực hiện tách trang, đánh số trang... rồi hiển thị toàn bộ văn bản lên màn 

hình với vị trí và tỉ lệ của tài liệu so với trang giấy. 

Trên thanh công cụ của Print Preview, có thể thực hiện  xem một trang hiện tại hoặc nhiều 

trang. Đồng thời cũng có thể sửa chữa bằng cách: 

 - Định vị trí con trỏ văn bản tại nơi cần sửa. 

 - Nếu con trỏ chuột có hình dạng kính lúp ( phóng to/ thu nhỏ) thì nháy chuột vào biểu 

tượng Magnifier trên thanh công cụ để trở về chế độ bình thường. 

 - Thực hiện các thao tác sửa đổi như trong chế độ thường. 

Nháy chuột vào biểu tượng Close để thoát khỏi chế độ  Print Preview. 

 e. Bật tắt việc hiển thị thƣớc, các thanh công cụ: 

- Thước: vào thực đơn dọc View, chọn Ruler. 

- Các thanh công cụ: vào thực đơn dọc View, chọn Toolbars. Hộp lựa chọn hiện ra cho phép 

đặt/ bỏ dấu X vào ô tương ứng của thanh công cụ. 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 35 

Chƣơng 4:  Lập bảng biểu 

4.1. Sử dụng table 

4.1.1. Tạo một bảng mới 

Các bước tiến hành để tạo một bảng mới; 

- Đưa con trỏ đến nơi cần tạo bảng 

- Vào thực đơn dọc Table chọn Insert Table, hộp thoại Insert Table xuất hiện. 

 

 

 

- Nhập số cột vào mục Number of Columns, số dòng vào mục Number of Rows. 

Nhập chiều rộng mỗi cột vào mục Column Width. Nếu để Auto, chiều rộng mỗi cột tuỳ 

thuộc vào số lượng cột và chiều rộng trang in. 

- Click nút Wizard hoặc vào nút AutoFormat ... để chọn kiểu bảng mẫu. 

 - Cuối cùng, chọn OK 

Ta cũng có thể nháy chuột vào biểu tượng  rồi rê chuột để chọn số cột và số dòng . 

4.1.2. Các thao tác trong bảng 

 - Khi văn bản nằm trong một ô, nó sẽ tự động xuống dòng khi chiều rộng ô không đủ. 

 - Các thao tác để di chuyển con trỏ trong bảng: 

  Đến ô kế tiếp    Tab  

  Đến ô trước đó    Shift+Tab 

  Đến ô đầu tiên của dòng hiện tại Alt+Home 

  Đến ô cuối cùng của dòng hiện tại Alt+End 

  Đến ô đầu tiên trong cột  Alt+PgUp 

  Đến ô cuối của cột   Alt+PgDn 

- Muốn đánh dấu đoạn nào trong bảng, có thể rê chuột hoặc nhấn Shift kèm với các phím 

mũi tên. 

4.1.3. Sửa đổi trong bảng 

a. Chọn các ô, hàng hay cột. 
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- Chọn một ô: di chuyển con trỏ chuột đến mép trái ô đó cho đến khi thấy mũi tên 

trắng xuất hiện  thì nháy chuột. 

 - Chọn một hàng: rê chuột từ ô đầu đến ô cuối dòng ( hoặc vào thực đơn dọc Table, 

chọn Select Row). 

 - Chọn một cột: di chuyển con trỏ chuột lên mép trên của bảng đến khi thấy mũi tên 

đen chỉ xuống  thì Click chuột ( hoặc vào thực đơn dọc Table, chọn Select column). 

 - Muốn chọn nhiều ô trong bảng thì chọn một ô đầu tiên, sau đó di chuyển chuột đến ô 

cuối, giữ phím Shift đồng thời nháy chuột. 

 - Muốn chọn toàn bộ bảng: đưa con trỏ vào trong bảng, vào thực đơn dọc Table chọn 

Select Table (hoặc nhấn Alt và số 5 bên bàn phím số). 

b. Chèn thêm các ô, hàng, cột vào bảng: 

 - Chọn ô hoặc các ô muốn chèn thêm các ô mới vào kế sau đó 

 - Vào thực đơn dọc Table, chọn Insers Cells. Hộp hội thoại Insers Cells xuất hiện. 

Chọn một trong các chức năng sau: 

  Shift Cells Right: chèn các ô mới vào bên trái các ô được chọn 

  Shift Cells Down: chèn các ô mới vào bên trên các ô được chọn. 

  Insert Entire Row: chèn toàn bộ hàng hay các hàng 

  Insert Entire Column: chèn toàn bộ cột hay các cột. 

- Chọn OK. 

c. Xoá các ô, hàng hoặc cột trong bảng 

 - Trước hết chọn một ô bất kỳ trong hàng, cột cần xoá. 

 - Chọn Delete Cells từ thực đơn dọc Table. 

 - Chọn Delete Entire Row:  xoá toàn bộ dòng 

  Delete Entire Column:  xoá toàn bộ cột 

 - Chọn <OK> 

d. Di chuyển, sao chép các ô, hàng, cột trong bảng. 

 - Chọn các ô, hàng hay cột cần di chuyển hoặc sao chép. 

 - Đưa trỏ chuột đến phần được chọn, giũ nút bên trái, rồi thực hiện một trong các động 

tác sau: 

 . Rê chuột đến vị trí mới rồi thả nút trái chuột: di chuyển phần được chọn. 

 . Giữ phím Ctrl đồng thời rê chuột đến vị trí mới rồi thả nút trái: Copy phần được 

chọn. 

e. Thay đổi chiều rộng cột 
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Cách 1:  Di chuyển con trỏ chuột đến biên phải cột, khi trỏ chuột có dạng mũi tên hai chiều 

thì rê chuột để thay đổi chiều rông cột. 

Cách 2: 

 - Chọn cột cần thay đổi 

 - Vào thực đơn dọc Table, chọn Cell Heigh And Width 

 - Gõ con số chỉ chiều rộng cột vào mục Width of Column 

 - Gõ con số chỉ khoảng cách giữa các cột vào mục Space Between Column. 

 - Chọn < OK > 

g. Thay đổi độ cao của hàng. 

 - Chọn một hoặc nhiều hàng cần thay đổi 

 - Chọn Cell Heigh and Width từ thực đơn dọc Table. 

 - Chọn Row rồi thực hiện một trong các thao tác sau: 

  Chọn Auto trong mục Heigh of Rows: Điều chỉnh độ cao theo độ cao văn bản của 

hàng. 

  Chọn Al Least trong mục Heigh of Rows, rồi đưa vào giá trị số chỉ độ cao ít nhất của 

hàng. Nếu nội dung trong ô vượt quá con số đưa ra thì Word sẽ điều chỉnh lại. 

  Chọn Exactly trong mục Heigh of Rows, rồi đưa vào giá trị số chỉ độ cao chính xác 

của hàng. Nếu nội dung trong ô lớn hơn thì sẽ chỉ bị mất một phần. 

 - Chọn  <OK > 

* Chú ý: với Office 2000 các bạn thực hiện các bước thay đổi độ rộng cột như sau: 

 - Chọn cột cần thay đổi 

 - Vào thực đơn dọc Table, chọn Table Properties.... chọn mục Columns gõ con số vào 

mục Preferred Width ... Chọn < OK > 

và chiều cao dòng được tiến hành như sau: 

   - Chọn một hoặc nhiều hàng cần thay đổi 

 - Vào thực đơn Table, chọn Table Properties.... chọn mục Rows gõ con số vào mục 

Specify Height ... Chọn < OK > 

h. Gộp, tách các cột trong bảng. 

Gộp nhiều cột lại thành một: 

 - Chọn các ô cần gộp ( có thể gồm nhiều hàng) 

 - Vào thực đợn dọc Table, chọn Merge Cells. 

Khi đó, các đường ngăn cách giữa các ô sẽ mất đi, tạo thành một cột duy nhất. 

 Tách một cột thành nhiều cột nhỏ: 

  - Chọn cột cần tách ( có thể gồm nhiều hàng) 

  - Vào thực đơn dọc Table, chọn Split Cells. Hộp thoại Split Cells xuất hiện. 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 38 

  - Nhập vào con số chỉ số cột cần tách. 

  Chiều rộng mỗi cột được tạo ra bằng chiều rộng cột cũ chia cho số cột. 

4.1.4. Tạo các đƣờng kẻ cho bảng 

  Các đường phân cách trong bảng có dạng nét đứt trên màn hình, nhưng khi in ra sẽ 

không có. Nếu cần có thể thêm vào các đường kẻ  thay cho đường nét đứt. Trước hết cần cho 

hiển thị thanh công cụ kẻ khung trên màn hình bằng cách nháy chuột vào biểu tượng Borders 

 Thanh công cụ kẻ khung ( Borders) xuất hiện: 

 Chức năng của các hộp trên thanh công cụ: 

 -  Hộp đầu tiên chọn loại nét kẻ. 

 - Bốn họp tiêp theo dùng để kẻ các đường Trên, Dưới, Trái, Phải so với khối được 

chọn. 

 - Hộp kế tiếp ( Inside Borders) để kẻ các đường ngăn cách bên trong khối được chọn. 

 - Hộp Outside Borders để kẻ các đường bao quanh khối được chọn. 

 - Hộp No Borders để xoá các đường kẻ. 

 - Phần cuối cùng là hộp tạo bóng nền cho vùng văn bản được chọn. 
 

Để vẽ khung, tiến hành theo các bước: 

 - Chọn khối cần kẻ 

 - Chọn loại nét kẻ 

 - Nháy chuột vào hộp tương ứng để tạo dạng kẻ 

Muốn xoá một hoặc nhiều đường kẻ: 

 - Chọn khối 

 - Chọn loại nét kẻ là None 

 - Nháy chuột vào hộp tương ứng để xoá 

Xem quá trình xoá hoàn toàn tương tự quá trình kẻ, chỉ thay loại nét kẻ là None. 

4.1.5. Sắp xếp các dữ liệu trên một bảng 

 Có thể sắp xếp các hàng trong bảng theo một cột nào đó. Dữ liệu trong cột phải có 

cùng kiểu gồm một trong ba kiểu sau: Text ( văn bản) - Number ( kiểu số) - Date ( kiểu ngày 

tháng). Nếu dữ liệu ở các hàng trong một cột khác kiểu nhau thì chỉ được phép sắp xếp theo 

kiểu Text.  

Các bước sắp xếp trên bảng: 

 - Chọn các hàng cần sắp xếp. Nếu sắp xếp toàn bộ bảng thì chỉ cần đưa con trỏ vào 

một ô bất kỳ trong bảng. 

 - Vào menu Table, chọn Sort. Hộp thoại Sort xuất hiện 

 - Chọn các khoá sắp xếp trong hộp Sort By và Then By. 
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 - Chọn sắp xếp theo kiểu dữ liệu nào ( Type): kiểu ký tự ( Text), kiểu số ( Number) 

hay kiểu ngày ( Date). 

 - Chọn thứ tự sắp xếp: tăng dần ( Ascending) hoặc giảm dần ( Descending) 

 - Chọn <OK > hay gõ Enter. 

4.1.6. Tính tổng cuối cột số trong một bảng 

 - Di chuyển con trỏ đến ô dưới cùng của cột số. 

 - Thực hiện lệnh Table - Formula... Tại mục Formula ta gõ công thức hoặc hàm cần 

tính vào đó ( ví dụ: =SUM(ABOVE) hoặc =A2+B2-C2 

 - Chọn <OK >, kết quả tổng sẽ trình bày tại ô dưới cùng. 

Thông thường quy trình tạo bảng gồm các bước sau: 

 - Thực hiện lệnh Table - Insert Table hay nháy chuột tại biểu tượng 

 - Định số cột và định độ rộng cột 

 - Nhập dữ liệu cho bảng 

 - Làm khung, kẻ đường và định dạng nền cho bảng. 

4.1.7. Chuyển đổi từ bảng về chế độ văn bản &  ngƣợc lại 

 Muốn chuyển đổi từ chế độ bảng về chế độ văn bản, ta chọn toàn bộ phần bảng cần 

chuyển đổi và sử dụng lệnh convert table to text ...từ thực đơn Table. Hoặc ngược lại.  

 

4.2. Sử dụng draw table 

           Để vẽ bảng, hãy chọn Draw Table từ thực đơn Table hay nhắp lên nút nhấn  trên thanh công 

cụ chuẩn Standard. Lúc này con trỏ chuột trở thành cây bút chì và xuất hiện một thanh công cụ như 

sau: 

 

Thứ tự từ trái sang phải ta có: 

Draw Table : vẽ các ô lưới của bảng 

Eraser: xoá các ô lưới 

Line Style: chọn kiểu biên (hay không biên) 

Line Weight: chọn độ rộng biên 

Border Color: chọn màu biên 

Borders: áp dụng hay xoá biên khỏi bảng hienẹ hành 

Shading Color: áp dụng cho màu bóng 

Insert: chèn bảng, cột, dòng, ô hay áp dụng AutoFit 

Merge Cells: trộn các ô 

Align: chọn kiểu căn chỉnh cho chữ trong ô . 

Distribute Rows Evently: làm cho các dòng có độ cao bằng nhau 
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Table AutoFormat: áp dụng AutoFormat cho bảng. 

Changing Text Direction: xoay hướng chữ 

Sort Ascending; sắp xếp các dòng trong bảng theo thứ tự tăng dần. 

AutoSum: chèn công thức AutoSum vào ô trong bảng. 

Chú ý: việc thay đổi các xác lập trong các công cụ Line Style, Line Weight và Border Color chỉ có tác 

dụng nếu sau đó bạn vẽ các ô lưới, chứ nó không có tác dụng đến các ô lưới đã vẽ. (các công cụ này 

còn có tác động  nếu sau đó bạn sử dụng công cụ Border).  
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Chƣơng 5:  Các hiệu ứng đặc biệt 

5.1. Chèn thêm các ký tự đặc biệt 

Word cho phép người sử dụng có thể chèn thêm nhiều ký hiệu, font chữ đặc biệt mà trên bàn phím 

không có, như ký hiệu : , , , , ,  ... 

Để chèn thêm một ký tự đặc biệt, thực hiện theo trình tự sau: 

 - Đưa con trỏ văn bản đến nơi cần chèn 

 - Vào thực đơn dọc Insert, chọn Symbol,  hộp thoại Symbol xuất hiện:   

 - Nháy chuột vào hộp Font để chọn bộ Font chứa các ký hiệu. 

 - Nháy chuột vào ký hiệu cần chèn. 

 - Nháy nút Insert để chèn, nháy nút Close để đóng hộp thoại Symbol. 

Trường hợp thường xuyên sử dụng một số ký hiệu đặc biệt nào đó, nên định nghĩa 

cho nó một tổ hợp phím theo trình tự sau:  

- Vào thực đơn dọc Insert, chọn Symbol,  chọn ký hiệu cần định nghĩa. 

- Nháy nút Shortcut Key, hộp thoại Customize xuất hiện. 

- Con trỏ lúc này nằm ở hộp Press New Shortcut key, nhấn tổ hợp phím cần định 

nghĩa. 

- Nháy nút Assign, nháy nút Close để trở về hộp Symbol. 

- Chọn một ký hiệu khác để định nghĩa hoặc nháy nút Close để đóng hộp Symbol. 

Kể từ đó, chỉ cần nhấn tổ hợp phím đã định nghĩa thì ký hiệu tượng ứng sẽ xuất hiện 

tại vị trí con trỏ. Tất cả các định nghĩa được cất giữ trong tệp *. DOT khi đã thoát khỏi Word. 

5.2. Tạo các hiệu ứng đặc biệt nhờ WordArt 

 WordArt là phần chuyên dùng để tạo các hiệu ứng đặc biệt đối với văn bản trơn, ví 

dụ, muốn tạo chữ  " khoa tin học " theo dạng vòng cung như sau: 

 

Cách thực hiện: 

 - Định vị trí con trỏ tại nơi muốn chèn 

 - Vào thực đơn dọc Insert, chọn Object. Hộp thoại Object xuất hiện 

 - Chọn Creat New/ Object Type, chọn Microsoft WordArt 2.0. 

 - Màn hình WordArt xuất hiện cùng với thanh công cụ. 

 - Nhập dữ liệu vào chỗ YOUR TEXT HERE, rồi chọn Font và dạng trang trí trên 

ToolBar. 

 - Nháy chuột vào vị trí bất kỳ ngoài khung tạo hiệu ứng để trở về soạn thảo văn bản 

bình thường. 

 Mỗi khi muốn sửa đổi văn bản được tạo ra bằng WordArt 2.0 chỉ cần nháy đúp vào 

vùng văn bản đó. 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 42 

* Có thể thực hiện bằng cách  nháy chuột vào thanh công cụ chứa biểu tượng  

 

5.3. Tạo chữ cái lớn đầu dòng 

ó thể sử dụng khả năng Drop Cap để tạo chữ cái lớn đầu dòng như trong đoạn 

văn bản này. Để thực hiện tạo chữ cái lớn, tiến hành các bước sau: 

 

- Chọn chữ cái hoặc đoạn văn bản cần tạo 

 - Vào menu Format, chọn Drop Cap. Hộp thoại Drop Cap xuất hiện. 

 - Trong mục Position, chọn Dropped hoặc In Margin. 

 - Chọn kiểu, cỡ Font, số dòng văn bản cần chừa cho chữ cái ( Line to Drop) 

 - Chọn <OK> 

Để huỷ bỏ hiệu ứng này, các bước tiến hành tương tự như trong mục Position,chọn None. 

5.4. Tạo các cột báo 

 Để xây dựng các cột báo có độ rộng bằng nhau hay khác nhau trên toàn bộ tài liệu hay 

chỉ một phần của tài liệu, hãy làm như sau:  

 - Để chỉ tạo các cột báo trên một phần tài liệu, hãy chọn phần đó. Để tạo các cột báo 

trên toàn bộ tài liệu, hãy đặt điểm chèn đâu đó trong tài liệu. 

 - Nhắp lên nút nhấn Columns rồi kéo chuột để chọn số cột (từ 1 đến 6) hoặc sử dụng 

hộp thoại Columns. Word khi đó sẽ chia khối chữ được chọn, hay nguyên tài liệu, thành số 

cột đã chọn. Các cột mới đầu có độ rộng bằng nhau và cách nhau 0.5 inches. 

 Nếu trong danh sách Apply To, bạn chọn phần chọn trước khi mở hộp thoại Columns 

ra, hãy chọn Selected Text để chỉ chia cột cho phần chọn đó hay chọn Whole Document để 

chia cột cho nguyên tài liệu. Nếu không chọn phần chọn, hãy chọn Whole Document để chia 

cột cho nguyên tài liệu hay This Point Forward để chỉ chia cột kể từ vị trí hiện hành của điểm 

chèn đến cuối tài liệu. 

5.4. Chèn hình ảnh vào văn bản 

5.4.1. Chén hình ảnh vào văn bản 

 Để lấy hình ảnh từ một tập tin đồ hoạ, hãy làm như sau: 

- Đặt điểm chèn gần vị trí sẽ chèn hình ảnh vào tài liệu. 

- Chọn Picture từ lệnh đơn Insert rồi chọn From File. Khi đó hộp thoại Insert Picture xuất 

hiện, tương tự như hộp thoại Open để mở các tài liệu. 

- Trong hộp thoại Insert Picture, chọn tập tin hình ảnh sẽ sử dụng (*.BMP, *.GIF, *.JPG, 

*.WMF). Chú ý là nếu chọn tuỳ chọn Preview trong hộp thoại Insert Picture, thì bạn có thể 

xem trước được hình ảnh của tập tin trong hộp thoại đó. 

 C 
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- Nhắp lên nút Insert  

( có thể sử dụng chương trình Microsoft Clip Gallery. Chương trình này cùng với một tập 

hợp các tập tin hình ảnh khá đầy đủ luôn được kèm trong bộ Microsoft Office). 

  Bạn có thể chèn hình ảnh bằng cách chép hình từ chương trình khác (chẳng hạn như 

chương trình Office PhotoDraw hay chương trình Paint có trong Windows) như sau: 

- Chọn hình ảnh từ từ chương trình khác rồi chọn Copy từ lệnh đơn Edit của chương trình 

đó. 

- Đặt điểm chèn vào vị trí sẽ chèn hình ảnh trong tài liệu Word. 

- Chọn Paste từ lệnh đơn Edit của Word hay nhấn Ctrl+V. 

+ Khi đã chèn hình ảnh vào, bạn có thể dời nó đến một vị trí nào trong tài liệu.  

 + Bạn có thể điều chỉnh nội dung của hình ảnh bằng cách chọn Edit Picture trong lệnh 

đơn Edit.  

 + Để xoá hình ảnh, hãy chọn nó rồi nhấn phím Delete. 

5.5. Microsoft Equation 

 Chuyên để tạo các công thức toán và khoa học phức tạp. 

Cách thực hiện: 

 - Đặt con trỏ nơi muốn tạo công thức 

 - Vào thực đơn Insert, chọn Object, chọn Creat New rồi nháy đúp chuột vào mục 

Microsoft Equation 2.0 hoặc Microsoft Equation 3.0 

( hoặc nháy chuột vào biểu tượng  nếu có). Trên màn hình hiện ra: 

 

 

 

 - Tại vị trí nhấp nháy của điểm chèn ( nếu không thấy điểm chèn nhấp nháy, thì thực 

hiện lệnh View - Redraw). Tuỳ thuộc vào yêu cầu của bạn mà chọn các biểu tượng gõ công 

thức cho phù hợp.  

 - Nháy chuột lên hộp Control Box của cửa sổ Microsoft Equation để trở lại soạn thảo. 

 Nếu không có mục Microsoft Equation 2.0 hoặc Microsoft Equation 3.0 thì có thể chưa 

được cài đặt. Khi đó có thể bổ sung bằng cách chọn Tool/Customize và chọn thẻ Command, 

chọn và đưa biểu tượng Microsoft Equation ở mục Insert ra ngoài, sau đó nhấn đúp chuột để 

khởi động và cài đặt bổ sung. 
 

5.6. Các xử lý chi tiết 
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   1. Tìm kiếm và thay thế (Find & Replace) 

 a. Tìm kiếm :  

- Vào menu Edit, chọn Find (hoặc gõ Ctrl+F) 

 - Gõ vào chuỗi ký tự muốn tìm vào hộp Find What 

 - Chọn Search và chọn tiếp : 

    Up:  để tìm lên đầu văn bản 

   Down : để tìm xuống cuối văn bản 

   All : để tìm trong toàn bộ văn bản 

 b. Thay thế : 

 - Vào menu Edit, chọn Replace (hoặc gõ Ctrl-H) 

 - Gõ vào chuỗi ký tự cũ trong hộp Find what 

 - Gõ vào chuỗi ký tự mới trong hộp Replace with 

 - Nháy chuột tại <Find next> để tìm chuỗi cũ đầu tiên cần. 

 - Chọn <Replace> để thay tuần tự, chọn <Replace All> để thay hàng loạt tệp hay chọn 

<Cancel> để ngừng không thay thế. 

 Ngoài ra có thể chọn phần thay thế mở rộng khi nhấn vào nút More 

2. Kiểm tra lỗi chính tả (Spelling) 

 Công cụ này chỉ sử dụng cho đoạn văn bản tiếng Anh. Trong một đoạn văn bản, nhất 

là với các văn bản tương đối dài, người soạn thảo thường bị sai lỗi chính tả mà nhiều lúc khó 

phát hiện được. Trong Winword có cung cấp một chức năng kiểm tra lỗi chính tả trên các 

văn bản dựa vào bộ từ điển có trên máy. 

 Thực hiện kiểm tra lỗi chính tả bằng Spelling: 

 - Di chuyển con trỏ đến vị trí muốn bắt đầu muốn kiểm tra lỗi chính tả. 

 - Thực hiện lệnh Tools-Spelling. Những từ của văn bản không có trong từ điển sẽ 

được trình bày và người sử dụng có thể thay thế bằng tù khác hay không tuỳ ý. 

3. Định nghiã từ gõ tắt 

      a. Định nghĩa bằng Auto Text: 

 - Đánh dấu cụm từ cần gõ tắt, ví dụ gõ: Cộng hoà xã hội chủ nghĩa Việt nam 

 - Vào thực đơn dọc Edit, chọn Autotext, gõ vào cụm từu thay thế trong hộp Name, ví 

dụ gõ: cj. 

 - Click vào nút Add, trở lại soạn thảo. Từ đó về sau chỉ cần gõ: cj, rồi ấn phím F3 thì 

cụm từ  " Cộng hoà xã hội chủ nghĩa Việt nam " sẽ xuất hiện. 

      b. Định nghĩa bằng AutoCorrect: 

 - Vào thực đơn dọc Tools, chọn AutoCorrect, một hộp thoại xuất hiện : 
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 - Gõ từ thay thế vào mục Replace, nhấn phím Tab 

 - Gõ từ cần định nghĩa vào mục With 

 - Nháy nút Add 

 - Tiếp tục định nghĩa thêm các từ khác hoặc nháy OK để trở lại soạn thảo. Từ đó, chỉ 

cần gõ từ thay thế và một khoảng trắng thì từ đã định nghĩa xuất hiện. 

     c. Sử dụng tốc ký 
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Chƣơng 6:  Trộn văn bản 

6.1. Các khái niệm cơ bản 

 Chức năng trộn văn bản thường dùng khi cần gửi công văn, giấy mời, thư từ cho 

nhiều địa chỉ, người nhận khác nhau nhưng với nội dung giống nhau. Để tránh khỏi phải 

soạn thảo nhiều văn bản như vậy, Word có một chức năng đặc biệt gọi là Trộn văn bản 

(Merge Document) cho phép tự động tạo ra các văn bản "giống nhau "  như vậy từ một 

bản mẫu và các số liệu cần trộn tương ứng. 

 Main Document: văn bản chính (thư từ, công văn...) chứa nội dung, cách trình 

bày, hình ảnh giống hệt nhau trong các văn bản trộn. 

 Data File: văn bản số liệu bao gồm các số liệu sẽ được trộn với văn bản chính để 

tạo ra các văn bản theo ý muốn. Các số liệu này được chia thành nhiều loại được gọi là 

(Fields). Mỗi văn bản được sinh ra sẽ tương ứng với một dãy dữ liệu của trường trên. 

6.2. Soạn thảo Data File 

 Số liệu của Data File được ghi trong một văn bản riêng và được thể hiện trong 

một bảng. Số cột của bảng là số trường tương ứng của số liệu. Mỗi hàng là một bản ghi 

(trừ hàng đầu tiên). Tên  trường bắt buộc viết liền nhau 

Ví dụ: 

 

Hoten Tencoquan Diachi 

Nguyễn Văn A Trường ĐHBK  Hà nội 

Trần Văn B Trường CĐSPKT I Hưng yên 

Lê Tiến C Trường Tổng hợp Sài gòn 

 

Trong ví dụ trên Hoten, Tencoquan, Diachi là tên của các trường của Data File. 

 

6.3. Soạn thảo  Main Document 

 Ví dụ: 

    Giấy mời 

Kính gửi:  <<Hoten>> 

Cơ quan: <<Tencoquan>> 

Địa chỉ: <<Diachi>> 
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Kính mời đại diện của quý cơ quan tới địa điểm A vào lúc 8 giờ để họp mặt 

 Trong ví dụ trên, văn bản được soạn thảo sau khi đã gắn vơi Data File của ví dụ 

mục soạn thảo Data File. Các trường Hoten, Tencoquan, Diachi được chèn vào văn bản 

tại các vị trí tương ứng và được thể hiện trên màn hình giống như hình ảnh trên. 

6.4. Các bƣớc tiến hành 

  Tạo tệp nguồn lấy tên là NGUON   

   Tạo tệp mẫu lấy tên là MAU 

  Thực hiện lệnh Tools\Mail Merge ... 

  Chọn Create   chọn Form Letters ...  chọn Active Window 

  Tại hộp Get Data  chọn Create Data Source (nếu chưa có tệp nguồn), nếu đã 

có tệp NGUON thì chọn  Open Data Source (gõ tên tệp NGUON đã có) 

  Chọn Edit Main Document  

  Tiến hành công việc soạn thảo và chèn mã trộn từng vị trí cần thiết 

  Nháy chuột vào biểu tượng Mail Merge  

Với Office 2000 bạn tiến hành các bước sau: 

  Tools\Letters and Mailings\Mail Merge Wizard...\Letters\Next (Step 1 of 6)  

Next (Step 2 of 6)  Next (Step 3 of 6)chọn tệp nguon sau đó nháy chuột vào OK  

 Nháy chuột vào biểu tượng More item ... và chọn tên trường muốn chèn  

nháy vào nút Insert  nháy vào nút Close, tương tự như vậy cho đến hết  

 Nháy chuột vào Next (Step 4 of 6) Next(Step 5 of 6)  Edit inđiviual letters 

... chọn OK. 
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CHƢƠNG 7:  Giới thiệu công cụ  Drawing  

 

Tạo một đối tƣợng đồ hoạ 

7.1.  

 Nếu trên màn hình chưa có thanh công cụ vẽ đồ hoạ, thì nháy chuột vào biểu tượng Drawing 

 trên thanh công cụ chính để tạo thanh công cụ vẽ đồ hoạ (Office 95) như sau : 

 

 

     

1    2   3     4    5    6    7    8    9   10  11  12  13  14  15 16  17   18  19  20  21  22  23 

ý nghĩa các thành phần trên thanh công cụ đồ hoạ (từ trái sang phải) 

  1. Line (vẽ đoạn thẳng) 

 - Nháy chuột vào biểu tượng Line, con trỏ biến thành dấu + 

 - Di chuyển dấu + đến điểm đầu đoạn thẳng, nhấn và giữ nút chuột trái. 

  - Rê chuột đến điểm cuối của đoạn cần vẽ, thả nút chuột. 

2. Rectangle (vẽ hình chữ nhật) 

3. Ellipse (vẽ hình Elip) 

4. Arc (vẽ cung tròn) 

5. Freeform (vẽ đa tuyến tự do) 

6. Text Box ( tạo hộp văn bản) 

7. Callout (tạo hộp text có nhánh) : tương tự như hộp Text Box 

8. Format Callout (định dạng cho hộp Callout) 

9. Fill Color (đặt màu tô) : dành cho các đối tượng khép kín 

10. Line Color ( đặt màu vẽ) 

11. Line Style (loại nét vẽ) 

 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 49 

 

 

7.2.  Thay đổi các đối tƣợng vẽ 

 Trước khi thay đổi đối tượng đã vẽ cần chọn các đối tượng bằng nút thứ 12 trên 

thanh công cụ vẽ đồ hoạ (nút Select Drawing Objects). Cùng một lúc có thể chọn nhiều 

đối tượng đồ hoạ (nếu chọn một đối tượng chỉ cần Click vào đối tượng đó). 

 Các bước tiến hành: 

 - Nháy chuột vào biểu tượng Select Drawing Objects, dấu + xuất hiện 

 - Dùng thao tác rê chuột để xác định một hình chữ nhật 

 - Tất cả các đối tượng nằm trong phạm vi hình chữ nhật sẽ được chọn 

 Các đối tượng sau khi được chọn sẽ có các ô vuông nhỏ màu đen, khi đó có thể 

thực hiện một trong các phép biến đổi sau: 

  a. Thay đổi vị trí. Nhấn các phím mũi tên để di chuyển hoặc thực hiện các bước 

sau: 

 - Di trỏ chuột vào đối tượng cho đến khi có hình mũi tên bốn hướng xuất hiện. 

 - Rê chuột đến vị trí mới rồi thả nút chuột 

      b. Thay đổi hình dạng, kích thƣớc. 

 - Di trỏ chuột đến một trong các ô vuông nhỏ màu đen cho đến khi xuất hiện dấu 

+ hoặc mũi tên hai chiều. 

 - Rê chuột để thay đổi hình dạng, kích thước rồi mới nhả nút chuột. 

      c. Sao chép, cắt, xoá đối tƣợng 

 - Xoá: nhấn phím Delete 
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 - Sao chép vào bộ đệm: nháy biểu tượng Copy trên thanh công cụ  

 - Cắt vào bộ đệm: nháy biểu tượng Cut 

      d. Xoay, lật các đối tƣợng: 

 - Lật theo trục thẳng đứng: nháy biểu tượng Flip Horizontal : 

 - Lật theo trục nằm ngang: nháy biểu tượng Flip Vertical : 

 - Xoay một góc 90
0
 theo chiều kim đồng hồ: Rotate Right  

      e. Mang ra trƣớc/sau 

 Khi có hai đối tượng nằm gần nhau sẽ có một phần chồng lên nhau, việc quyết 

định đối tượng nào nằm trước tuỳ thuộc vào thao tác Click lên nút Bring to Front hoặc 

Send to back 

     f. Thay đổi tổng thể  

 Thao tác này cho phép xác định tất cả các yếu tố của đối tượng: loại nét vẽ, loại 

màu tô, kích thước và vị trí. 

 - Nháy đúp chuột lên đối tượng. Một hộp thoại xuất hiện: 

 - Vào mục Fill, Line, Size and Position để xác định các yếu tố của đối tượng 

 - Chọn OK để xác nhận các thay đổi, hoặc ESC để bỏ qua. 
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 và thiết lập các thông số trang in 

 

8.1. Hiển thị tài liệu trƣớc khi in 

 Word cho phép bạn hiển thị bản in ra cuối cùng bằng cách sử dụng Print Preview. Print 

Preview hiển thị bản xem trước của một trang hiện hành hoặc của tất cả các trang trong tài liệu tại một 

thời điểm. Bạn cũng xem được nhiều trang cùng một lúc. Có một số nút ở phần trên cùng của hộp 

thoại Print Preview, cung cấp cho bạn những mục chọn xem trước khi in, như hình 8.  

 

 

 

 

 

Hình 8 

 

Hình 9 

 

Bằng cách sử dụng Print Preview để xem tài liệu được in của bạn, bạn có thể thực hiện các thay 

đổi, nếu như những gì bạn thấy không phải là những gì bạn muốn. Để thực hiện các thay đổi trong lúc 

in, bạn có các mục chọn Print và hộp thoại Page Setup. Hình 9 hiển thị ra một trang trông giống như 

thế nào khi chọn mục xem trước. 

8.2. Thay đổi hƣớng và cỡ giấy 

Đôi khi trong lúc soạn thảo một tài liệu, bạn có vài trang thông tin tài chính có nhiều cột. Bạn 

nhận thấy rằng không thể đặt vừa tất cả các cột trong một trang có độ rộng là 8.5 inch và chiều dài là 

11 inch. Tuy nhiên, bạn biết rằng bạn có thể làm cho các cột nằm theo chiều dài của trang thay vì theo 

độ rộng trang, lúc đó thông tin tài chính sẽ vừa khít trong trang một cách hoàn hảo. Điều này có nghĩa 

là bạn phải thay đổi hướng của trang giấy. 

In 

Phúng to Xem nhiều trang 

Zoom Rút lại cho đầy trang Help 

Thƣớc đo Xem toàn màn 

hỡnh 

Xem 1 trang 
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Hình 10 

Hướng trang mặc định là theo chiều dọc (8.5x11). Nếu bạn muốn thay đổi chiều này thành 

chiều ngang (11x8.5), bạn có thể sử dụng các mục chọn Page Setup của thanh thực đơn File. Hình 10 

hiển thị cho bạn thấy hình dạng của trang theo chiều dọc và chiều ngang. 

Bạn cũng có thể chọn kích thước trang theo ý muốn. Word cung cấp cho bạn vài kích thước 

trang chuẩn để chọn, thậm chí còn đưa cho bạn thêm vào các dạng không chuẩn như là dạng danh 

thiếp hoặc dạng có nửa trang giấy. 

8.4. Đặt lề cho trang in 

 

Hình11 

Phần Margins của Page Setup cho phép bạn thay đổi các lề, thiết lập kích thước 

phần đầu và phần chân trang. Nếu bạn muốn in bản báo cáo của bạn và trình bày nó 

dưới dạng một quyển sách, bạn muốn có lề phía ngoài rộng hơn lề phía trong, để người 

đọc có thể ghi vài điểm ghi chú. Đối với mục đích này, Word cấp một mục chọn gọi là 

lề phản chiếu (Mirror Margins). 

Mirror Margins là các lề, mà lề trái của các trang được đánh số chẵn nằm cùng 

phía với lề phải của trang lẻ và lề phải của trang đánh số chẵn nằm cùng một phía với lề 

trái của trang lẻ. Điều này được gọi là các lề được phản chiếu. 

Word 2000 cung cấp mục chọn „2 pages per sheet‟, nếu mục này được chọn trong 

Page Setup, hai trang tài liệu sẽ hiển thị trong một trang giấy. Một trang theo chiều dọc 
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sẽ được chia theo chiều ngang, trong khi một trang chiều ngang thì được chia theo chiều 

dọc. 

ở chương trước, bạn đã thấy được cách thức chỉnh lề đoạn và văn bản trong tài 

liệu. Chúng ta cũng có thể canh lề văn bản theo chiều dọc. Điều này cũng hữu dụng khi 

bạn muốn tạo ra một trang tiêu đề cho tài liệu của bạn. Phần Layout của Page Setup hỗ 

trợ cho bạn bốn cách chỉnh lề văn bản trong phạm vi các lề trên và lề dưới. 

Các mục chọn cho việc canh lề dọc một văn bản: 

Top – Văn bản được canh với lề trên cùng, đây là canh lề mặc định 

Centre – Văn bản được canh giữa, giữa lề trên và lề dưới cùng. 

Bottom – Văn bản được chỉnh với lề dưới cùng 

Justify – Văn bản được trải rộng ra để cho các dòng có cùng khoảng cách từ dòng trên 

cùng ở lề trên và dòng cuối cùng ở lề dưới cùng. 

8.5. In tài liệu 

Bạn đã biết về những hỗ trợ quan trọng trong in do Word 2000 cung cấp. Còn có 

một vài mục chọn khác mà bạn có thể sử dụng trước khi bạn thật sự in. Các mục chọn 

này được tìm thấy trong hộp thoại Print như trong hình 12 dưới đây. 

 

Hình 12 

Các mục chọn trong việc in: 

 Nếu kết nối tới nhiều máy in, bạn có thể chọn máy in nào để in 

 Thiết lập các mục chọn máy in 

 Xác định một trang hoặc nhiều trang để in 

 Xác định số lượng bản in ra 
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Chương 9. Tự động hoá Word bằng cách sử dụng Macro 

9.1. Giới thiệu chung 

 Ta có thể tự động hoá một số tác vụ đơn giản hay phức tạp trong Microsoft Word 

bằng cách tạo các Macro. Một Macro bao gồm một loạt các tác vụ của Word và cho 

phép chúng ta thi hành các tác vụ đó bằng cách chỉ phát một lệnh. Bằng cách ghi lại 

Macro, ta có thể tiết kiệm được nhiều thời gian và làm cho Word dễ dùng hơn. Khi tạo 

Macro, điều đó có nghĩa là bạn đã tạo cho Word một chức năng mới. 

9.1. Ghi Macro 

 Khi ghi Macro, bạn sẽ lưu lại nhiều lệnh Word. Sau này bạn có thể thực hiện lại 

tất cả các lệnh đó bằng cách thi hành Macro 

 Để ghi macro, ta làm như sau: 

1. Chọn Tools => Macro => Record New Macro hay nháy đúp lên từ REC trên 

thanh trạng thái của Word 

Word sẽ mở hộp thoại Record Macro: 

 

 

2. Thực hiện một hay nhiều bước tuỳ chọn sau: 

a. Đặt tên cho macro trong mục Macro Name. Nên sử dụng tên macro dễ 

hiểu và ngắn gọn 

b. Ghi chú cho macro trong mục Description. Bạn ghi thêm các thông tin 

chi tiết hơn cho phần ghi chú đó 

c. Để gắn macro cho nút nhấn trên thanh công cụ hoặc lệnh đơn, ta chọn 

Toolbar. Để gắn macro cho phím tắt, chọn nút Keyboard. Nừu không làm 

như vậy, bạn thi hành macro bằng cách sử dụng hộp thoại Macros 

d. Theo ngầm định, macro mới sẽ được lưu trong khuôn mẫu Normal. Nừu 

không, bạn cõ thể chọn tên khuôn mẫu trong danh sách Store Macro để 

macro chỉ hoạt động trong loại tài liệu đó. 
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3. Nhắp lên nút OK để bắt đầu ghi lại macro. Khi Marco đang ghi, Word sẽ hiển 

thị biểu tượng máy cát xét bên cạnh con trỏ chuột và hiển thị thanh công cụ 

Stop Recording 

4. Thực hiện tất cả các tác vụ bạn muốn lưu trong Marco. Cú ý, macro không ghi 

lại những sự kiện chuột. Nếu muốn tạm dừng ghi các tác vụ chọn nút Pause 

Recording 

5. Nhấn nút Stop recording để kết thúc việc ghi các lệnh. 

9.3. Quản lý các Macro 

 -  ghi chú, xoá macro hay thay đổi nội dung macro: 

 1. Chọn Tools => Macro hay nhấn tổ hợp ALT + F8 

 2. Chọn macro từ danh sách Macro Name 

 3. Thực hiện các điều chỉnh tương ứng với các nút lệnh 

9.4. Thi hành Macro 

 - Nếu đã gắn macro cho thanh công cụ hay nút nhấn Toolbars thì thi hành maro 

bằng cách nháy đúp lên nút nhấn, chọn lệnh hoặc nhấn tổ hợp phím đã đặt 

 - Nếu  không ta thực hiện bằng cách: 

 1. Chọn Tools => Macro 

 2. Trong danh sách Macro In, chọn All Active Templates And Documents hay tên 

khuôn mẫu chứa Marco 

 3. Chọn macro từ danh sách Macro Name. 

 4. Chọn nút Run 

 Thận trọng khi sử dụng các macro nguồn gốc không rõ ràng, chúng có thể gây ra 

những hậu quả khôn lường, vì đó có thể là macro Virut. May thay, Word cũng có khả 

năng nhận biêt được các macro virut. 
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. Microsoft Excel 
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Excel là một phần mềm chuyên dùng cho công tác, kế toán, văn phòng trên môi trường 

Windows có các đặc tính và ứng dụng tiêu biểu sau: 

 - Thực hiện được nhiều phép tính từ đơn giản đến phức tạp. 

 - Tổ chức và lưu trữ thông tin dưới dạng bảng như bảng lương, bảng kế toán, bảng thanh toán, 

bảng thống kê, bảng dự toán ... 

 - Khi có thay đổi dữ liệu, bảng tính tự động tính toán lại theo số liệu mới. 

 Thao tác trên bảng tính có thể tạo ra các báo cáo tổng hợp hoặc phân tích có kèm theo các biểu 

đồ, hình vẽ minh hoạ ... 
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OFT EXCEL 

1.1. Giới thiệu màn hình giao diện của excel (Excel 97) 

1.1.1. Khởi động Excel 

 Để khởi động Excel, nhắp lên nút nhấn Start trên thanh công việc, trỏ vào thư mục 

Programs rồi nhắp lên biểu tượng chương trình .  

Hoặc Excel, nhắp lên nút nhấn Start trên thanh công việc, trỏ vào thư mục Programs rồi chọn  

Run  Browse  Program Files  chọn biểu tượng  

1.1.2. Thoát khỏi Excel 

 Khi cần thoát khỏi Excel, bạn chọn một trong những cách thực hiện sau: 

  * Chọn lệnh: [Menu] File chọn Exit. 

  * Nhấn phím Alt+F4. 

  * Double Click trên nút điều khiển cửa sổ MS - Excel. 

Lưu ý:  

*Khi dữ liệu trên những bảng tính trong Workbook chưa được lưu vào tập tin thì Excel 

sẽ xuất hiện thông báo: 

 

 Chọn nút: 

 Yes: Khi cần lưu dữ liệu trên bảng tính vào một tập tin Workbook.  

 No: Khi không cần lưu dữ liệu trên những bảng tính. 

 Cancel: huỷ bỏ lệnh thoát, đóng hộp thông báo và trở về màn hình bảng tính. 

 Help: Xem phần giúp đỡ về các nút lệnh trong hộp đối thoại. 

 

1.1.3. Giới thiệu màn hình giao diện của Excel (Excel 97) 
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1.1.4. Cửa sổ ứng dụng Excel. (Excel Windows) 
 

 Cửa số ứng dụng Excel gồm có những thành phần chính như sau: 

 a) Thanh tiêu đề (Title bar): Gồm nút điều khiển (Control), tiêu đề Microsoft 

Excel, và những nút: cực tiểu hoá(Minimize), cực đại hoá (Maximize), phục hồi 

(Restore). 

 b) Thanh menu lệnh (Menu bar): Gồm 9 nhóm mục lệnh chính của chương trình 

Excel. 

 c) Thanh nút lệnh (Toolbar): Hiển thị hai nút lệnh: Standard Toolbar và 

Formatting Toolbar. Trên mỗi thanh chứa một số nút lệnh tiêu biểu cho những nút lệnh 

thông dụng của Excel.  

d) Thanh công thức (Formula Bar): Hiển thị hộp tên, toạ độ ô, nút huỷ bỏ, nút lựa 

chọn, nút hàm, nội dung dữ liệu trong ô hiện hành (ô có khung viền bao quanh trong 

bảng tính). 

 e) Cửa sổ bảng tính(Worksheet Windows) 

 f) Thanh tình trạng (Status bar): hiển thị các chế độ hoạt động của excel. 

1.1.5. Cửa sổ bảng tính Excel  (Excel Worksheet Windows) 

 Là khu vực ở giữa thanh công thức và thanh tình trạng. Cửa sổ ứng dụng Excel 

gồm có những thành phần chính như sau: 

a) Thanh tiêu đề (Title bar): gồm Menu điều khiển (control Menu), tên tập tin 

workbook hiện hành và các nút Minimize, Maximize, Restore. 

b) Đƣờng viền ngang (Column Border): Ghi kí hiệu từng cột theo thứ tự chữ cái (từ 

trái sang phải bắt đầu từ A đến IV). Nút phía ngoài cùng bên trái là nút lựa chọn toàn bộ 

bảng tính (select All). 

c) Đƣờng viền dọc (Row border): Ghi số thứ tự của từng dòng (từ trên xuống dưới bắt 

đầu từ 1 đến 16384). 

Bar 
Menu Bar 

Title 
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d) Màn hình (khu vực) bảng tính (Windows): hiển thị một phạm vi nhỏ của bảng tính 

(thông thường là một cột 20 dòng) với những đường kẻ lưới (Gridlines) phân cách giữa 

các ô. 

e) Ô hiện hành (Active Cell) hoặc ô lựa chọn (Selected cell): là một ô trong bảng tính 

có khung sáng viền quanh và có một móc vuông nhỏ ở cạnh dưới bên phải dùng để chỉ 

ô hiện hành. Toạ độ của ô hiện hành  được hiển thị trong hộp tên trên thanh công cụ. 

f) Thanh cuốn dọc/ngang (Scroll bar): là hai thanh cạnh viền bên phải và phía dưới 

bên phải của cửa số Workbook. Trên thanh có chứa một hộp cuốn (Scroll box) và hai 

nút mũi tên (dùng để di chuyển đến những khu vực khác của bảng tính khi sử dụng thiết 

bị mouse). Phía trên và bên phải của hai thanh cuốn là khung phân tách (Split box) cửa 

sổ. 

g) Thanh thƣớc trên bảng tính(Sheet tabs): hiển thị một số tên của những bảng tính 

có trong Workbook khi chưa đặt tên bảng tính thì Excel sẽ tự đặt tên là Sheet #) bên trái 

là những nút di chuyển  

Tab (Tab Scrolling), bên phải là khung phân tách (Tab Split), 

Lưu ý:  Sau khi khởi động , Excel sẽ tự động mở một tập tin Workbook mới trong cửa 

số này và đặt  

tên là BOOK (  là những số thứ tự tương ứng với số lần mở bảng tính). 

1.2. Cấu trúc bảng tính 

 Sổ tay(Workbook): một Workbook gồm từ 1 đến 255 sheet riêng biệt (thường số 

mặc nhiên là 16 sheet). Tập tin Workbook thường dùng để tập hợp những loại bảng 

tính dữ liệu, đồ thị, macro, ... có liên hệ với nhau. Excel không giới hạn số lượng tập 

tin Workbook được mở nhưng phụ thuộc vào bộ nhớ của máy. 

 Bảng tính (Sheet): một bảng tính có trên 4 triệu ô dữ liệu, dùng để nhập dữ liệu và 

thực hiện những yêu cầu về tính toán , tạo biểu mẫu, quản lý và khai thác cơ sở dữ 

liệu...Mỗi bảng tính được đặt tên là Sheet  (  là số thứ tự) hoặc một tên gọi cụ thể. 

 Cột (columns): Cột là một tập hợp của những ô trong bảng tính theo chiều dọc. Độ 

rộng cột mặc nhiên là 9 ký tự (có thể thay đổi trị số này từ 0 đến 255 ký tự ). Có tổng 

cộng 256 cột trong một bảng tính, mỗi cột được gán ký hiệu theo thứ tự chữ cái ( bắt 

đầu từ A đến Z, AA đến AZ, BA đến BZ, .... và kết thúc là IV). 

 Dòng (Rows): Dòng là một tập hợp của những ô theo bảng tính theo chiều ngang, 

chiều cao dòng mặc nhiên là 12.75 chấm điểm (có thể thay đổi trị số này từ 0 đến 

409). Có tổng cộng ít nhất 16384 dòng trong 1 bảng tính, mỗi dòng được gán một số 

thứ tự (bắt đầu từ 1 đến 16384...). 

 Ô (cell): Ô là giao điểm của một cột và một dòng. Ô được xác định bởi một toạ độ 

(địa chỉ) dựa theo ký hiệu của cột và số thứ tự của dòng. ( Thí dụ: toạ độ A1 là ô đầu 

tiên trên bảng tính, toạ độ D5 là ô ở trên cột D và dòng 5). Ngoài ra, Excel còn xác 
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định ô theo số thứ tự cột và dòng (C#R# khi chọn thông số R1C1 ở trên hộp thoại 

TAB VIEW trong lệnh [MENU] TOOLS >OPTIONS. 

 Vùng (Range): Vùng là một tập hợp của những ô kế cận nhau và được xác định bởi 

toạ độ ô đầu (thường là ở góc trên bên trái ) và toạ độ ô cuối (thường là ở góc dưới bên 

phải) của vùng đó. Ngoài ra bạn có thể sử dụng tên vùng (xem cách đặt và sử dụng tên 

vùng ở phần sau) để thay thế cho phạm vi khai báo trong lệnh thực hiện. Vùng có khi là 

một ô, một nhóm ô hoặc toàn bộ bảng tính. Trong Excel bạn có thể lựa chọn và làm việc 

với nhiều vùng khác nhau cùng lúc. 

1.3. Các khái niệm cơ bản 

1.3.1. Di chuyển con trỏ 

 a. ô hiện thời : Tại một thời điểm luôn tồn tại con trỏ trong một ô trong 

bảng tính. Tất cảc các lệnh như nhập dữ liệu, giá trị sau khi tính toán... đều 

được đưa vào ô này.  ô này được gọi là ô hiện thời của bảng tính. Để di 

chuyển từ ô này sang ô bên kia trên bảng tính, các bạn thực hiện như sau: 

 b. Các phím di chuyển con trỏ 

Phím Chức năng 

 Lên trên một dòng 

 Xuống dưới một dòng 

 Sang phải một cột 

 Sang trái một cột 

PgDn Xuống dưới một trang  

PgUp Lên trên một trang màn hình 

Alt+PgUp Sang trái một trang màn hình 

Alt+PgDn Sang phải một trang màn hình 

Ctrl+Home Về ô A1 

 c. Di chuyển con trỏ với lệnh Go To 

     Để di chuyển nhanh chóng tới một ô trên bảng tính, bạn có thể sử dụng mục chọn Go 

To trong bảng chọn Edit hoặc ấn phím F5. Khi này hộp thoại Go To xuất hiện, trong 

khung Go To luôn ghi lại đến một ô đã được liệt kê trong danh sách này, bạn chỉ cần 

nhấn chuột chọn nó. Nếu bạn cần dịch chuyển đến một ô khác, bạn hãy đưa vào toạ độ 

trong khung Reference. Ví dụ như B6. 

1.3.2. Các kiểu dữ liệu trong bảng tính 

1. Dữ liệu dạng chuỗi (Text) 
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 a) Quy ước: Phải được bắt đầu bởi: 

  * Các kí tự chữ từ A đến Z. 

  * Các kí tự canh biên như sau: ',",^,\ 

 b) Dạng thể hiện: Phụ thuộc vào chiều dài của chuỗi dữ liệu nhập vào trong ô 

  * Khi chiều dài của chuỗi dữ liệu nhỏ hơn hoặc bằng với độ rộng của ô 

 - Chuỗi dữ liệu nhập vào sẽ được hiển thị đầy đủ và vị trí phụ thuộc vào kí tự 

canh biên phía trước dữ liệu ( xem công dụng của những kí tự canh biên ở phần 

lưu ý ). 

             - Dạng mặc nhiên của Excel là canh chuỗi dữ liệu về bên trái của ô (Với kí tự 

canh biên định sẵn là dấu' ). 

  *Khi chiều dài của chuỗi dữ liệu lớn hơn độ rộng của ô và  

 - Nếu những ô lân cận bên phải của ô dữ liệu còn trống thì chuỗi dữ liệu nhập vào 

sẽ được hiển thị đầy đủ . 

- Nếu những ô lân cận bên phải của ô dữ liệu đang chứa trị thì chuỗi dữ liệu nhập 

vào được hiển thị cho đến phạm vi của ô chứa trị kế cận . 

2. Dữ liệu dạng số (Number) 

a) Qui ước: Phải được bắt đầu bởi: 

    * Các ký tự số từ 0 đến 9 

    * Các dấu: +, -, (, .,$ 

b) Dạng thể hiện:  Phụ thuộc vào chiều dài của chuỗi số nhập vào trong ô 

   * Khi chiều dài của chuỗi số nhỏ hơn độ rộng của ô thì dạng thức số mặc nhiên 

sẽ là dạng bình thường (General) và được canh về bên phải của ô. 

   * Khi chiều dài của chuỗi số lớn hơn hoặc bằng độ rộng của ô thì dạng Excel sẽ 

tự động chuyển sang dạng KHKT (Scientific) hoặc hiển thị các dấu # # # trong ô. 

 Lưu ý: 

  Từ dạng thức số bình thường (General) nhập vào ô, bạn có thể thay đổi thành 

nhiều dạng thức số khác nhau bởi lệnh: [Menu] Format >Cells, chọn Tab Number và 

lựa chọn dạng thức trên khung Format Codes. 

  Để có thể hiển thị đầy đủ chuỗi số bị che khuất, bạn chỉ cần thay đổi độ rộng cột. 

Bạn có thể nhập trực tiếp những dấu phân cách số hàng ngàn hoặc dấu chấm thập 

phân. 

  Khi trong chuỗi số nhập vào có chứa các kí tự dấu như :+, -, /, hoặc có nhiều 

hơn một dấu chấm thập phân thì Excel sẽ tự động chuyển sang dạng chuỗi. 

 * Bạn có thể thay đổi dạng thấp và vị trí của chuỗi số bới những nút lệnh trong 

Formatting Toolbar. 

 * Khi nhập dữ liệu dạng số vào bảng tính, bạn nên sử dụng hộp phím số bên 

phải. 
 

3. Dữ liệu dạng công thức (Formulas) 
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 a) Quy ước: Phải được bắt đầu bởi các dấu:  = hoặc + . 

 b) Dạng thể hiện: Trị số kết quả của công thức trong ô (công thức nhập vào chỉ 

được hiển thị trên thanh công thức). 

Lưu ý: 

 * Trong thành phần của một công thức có thể gồm có số, chuỗi (phải được trong 

cặp nháy kép),  

toạ độ ô tên vùng, các toán tử, các loại hàng (xem trong chương về hàm). 

 * Các loại toán tử sử dụng trong công thức: 

 - Toán tử tính toán: + (cộng),- (Trừ), *(Nhân), / (Chia), ^(Luỹ thừa), % (Phần 

trăm). 

  Ví dụ  Công thức    Kết quả 

    = 10+5*2      20.0 

 - Toán tử liên kết: & (Liên kết chuỗi). 

  Ví dụ:  Công thức   Kết quả 

    = "Hà nội"&"là thủ đô"  Hà nộilà thủ đô 

    = "Hà nội"&" "&"là thủ đô"  Hà nội là thủ đô 

 - Toán tử so sánh: = (Bằng), <> (Không bằng), > (Lớn hơn), >= (Lớn hơn hoặc 

bằng), <= (Nhỏ hơn hoặc bằng). 

  Ví dụ:  Công thức   Kết quả 

    = A1>=25   TRUE   (Khi A1>=125). 

    =A2<=65   FALSE  (Khi A2>=65). 

 * Độ ưu tiên của toán tử như sau: trong biểu thức (  ), Luỹ thừa Nhân/ Chia, 

Cộng/ Trừ,... 

 * Khi trong phạm vi các ô ghi trên công thức cần tính toán có chứa các dữ liệu 

dạng chuỗi, thì Excel sẽ hiển thị thông báo lỗi #VALUE!. 
 

4. Dữ liệu dạng ngày (Date), Giờ (Time) 

 * Quy ước và dạng thể hiện. 

 Nhập theo những dạng thức sau: 

 

Dạng thức Dạng thể hiện 

m/d/y 1/1/94 

d-mmm-yy 1-Jan-94 

d-mmm 1-Jan 

mmm-yy Jan-94 

m/d/y h: mm 1/1/94 13:00 

h: mm AM/PM 1: 00 PM 

h:mm:ss AM/PM 1: 00: 00 PM 

h: mm 13: 00 
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H: mm: ss 13: 00:01 

 

Lưu ý: 

 * Phải được nhập theo dạng thức MM/DD/YY (Theo thông số lựa chọn trong 

Control panel của Windows). 

 * Khi nhập không đúng theo những dạng thức trên thì Excel tự động chuyển sang 

dạng chuỗi. 

 * Ngoài ra, bạn có thể nhập ngày, giờ với những cách thực hiện sau: 

            * Nhấn phím: Ctrl-;(Nhập ngày hệ thống hiện hành). 

            * Nhấn phím: Ctrl-Shift -; (Nhập giờ hệ thống vào ô hiện hành). 

 * Nhập hàm = Date (YY,MM,DD) hay hàm = time (hh, mm, ss), sau đó chọn 

lệnh: [menu] format > cells, chọn Tab number; và lựa chọn dạng hiển thị ngày. 

 * Nhập trị số tương ứng với thời gian (Excel bắt đầu tính từ 01/01/1901 tương 

ứng với số 1) sau đó lựa chọn dạng thể hiện số bới lệnh: [Menu] format > cells chọn 

Tab number. 

 * Bạn có thể thực hiện tính toán với những dữ liệu dạng ngày, giờ. 

1.3.3. Các loại địa chỉ: Có ba loại ô địa chỉ nhƣ sau : 

a) Địa chỉ tƣơng đối (Relative address): Địa chỉ tham chiếu có dạng (<cột><dòng>). 

Khi chép đến vùng đích, địa chỉ tham chiếu của vùng đíchn sẽ thay đổi theo nghĩa 

phương, chiều và khoảng cách. Ví dụ: A1 

b) Địa chỉ tuyệt đối (Absolute address): Địa chỉ tham chiếu có dạng 

$<cột>$<dòng>. Khi chép đến vùng đích, địa chỉ tham chiếu của vùng đích sẽ giữ 

nguyên giống như vùng nguồn. Ví dụ: $A$1 

c) Địa chỉ hỗn hợp ($A1 hoặc A$1): kết hợp cả hai loại địa chỉ trên, có dạng 

$<cột><dòng> hoặc <cột>$<dòng>. 

Lưu ý: Toạ độ ô ghi trong công  thức được cố định không thay đổi khi sao chép đến vị 

trí mới . 

Thí dụ: công  thức trong ô C5 là  : $A$5+$B$5  

       khi sao chép đến ô C6 là : $A$5+$B$5  

 Cách tạo địa chỉ tuyệt đối:  Chọn một trong hai cách thực hiện sau: 

a) Nhập trực tiếp từ bàn phím dấu $ phía trước kí hiệu cột hay số thứ tự dòng của 

toạ độ ô cần thực hiện. 

b) Nhập  (hoặc di chuyển điểm nháy) vào toạ độ ô cần thực hiện trên thanh công 

thức, sau đó nhấn phím F4 để Excel tự động thêm dấu $ vào toạ độ ô. 

 F4 F4 F4 F4 

Ví dụ: A1  $A$1  A$1  $A1  A1 
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2.1. Lƣu trữ tệp trên đĩa 

2.1.1. Mở tệp đã có tên trên đĩa, tạo tệp, bảo vệ tệp 

 a. Mở tệp: Vào thực đơn File\Open hoặc biểu tượng trên thanh Standard Toolbar 

và chọn tệp cần mở. 

 b. Tạo một tệp mới: Vào thực đơn File\New hoặc biểu tượng trên thanh 

Standard Toolbar 

 c. Đóng một tệp: Vào thực đơn File\Close hoặc chọn biểu tượng  trên màn 

hình. 

 d. Bảo vệ tệp:  

  - Bảo vệ hoàn toàn: trong trường hợp này, bạn chỉ có thể mở bảng tính khi 

bạn trả lời đúng mật khẩu đã đưa ra. 

  - Bảo vệ hạn chế: Khi thiết lập chế độ này, bất kỳ ai cũng có thể mở bảng 

tính nhưng chỉ trong chế độ chỉ đọc. Để thiết lập chế độ bảo vệ cho một bảng tính hiện 

thời (đang làm việc), bạn vào bảng chọn File, chọn Save As...  chọn mục chọn 

Options, một hộp thoại xuất hiện. ý nghĩa của các mục như sau: 

 (-)  Protection Password: khung này để đưa mật khẩu vào bảng tính. Đây là chế 

độ bảo vệ hoàn toàn. Mật khẩu có thể dài 15 ký tự có phân biệt chữ hoa, chữ thường, 

khi bạn đã đưa mật khẩu vào khung trên, Excel còn cho xuất hiện tiếp hội thoại Confirm 

Password, yêu cầu bạn khẳng định một lần nữa mật khẩu của mình 

 (-) Write Revervation Password: khung này để bạn đưa mật khẩu cho chế độ bảo 

vệ hạn chế,  hội thoại Confirm Password tiếp tục xuất hiện để yêu cầu bạn khẳng định 

một lần nữa mật khẩu như trường hợp trên. 

 (-) Nút Read-Only Recommended: Nếu chọn nút này thì ngay cả trong truờng hợp 

bạn trả lời đúng mật khẩu cho chế độ bảo vệ hoàn toàn thì bảng tính mà bạn đã mở được 

cũng chỉ trong chế độ chỉ đọc. 

c. Đặt mật khẩu bảo vệ cho một trang bảng tính 

Để bảo vệ trang bảng tính hiện hành, từ thực đơn Tools chọn  Protection  

Protect Sheet. Sau khi đã kích hoạt chế độ bảo vệ, bạn không thể thay đổi một khoản 

mục đã “khoá”. Muốn xoá trạng thái bảo vệ, bạn chỉ cần chọn lệnh Unpotect Sheet từ 

thực đơn Tools\Protect. 
 

d. Đặt mật khẩu cho một WorkBook 

Muốn đặt mật khẩu bảo vệ cho một tệp WorkBook , từ thực đơn Tools bạn chọn 

Protect  Protect WorkBook. Lúc này các trang bảng tính không thể copy, dịch chuyển 
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hay đổi tên được. Để xoá bỏ trạng thái đó, bạn chỉ cần chọn lệnh Unpotect WorkBook từ 

thực đơn Tools\Protect. 

2.2. Các thao tác cơ bản 

2.2.1. Nhập dữ liệu vào bảng tính 

 1. Nhập dữ liệu vào một ô trên bảng tính 

 Các bước thực hiện. 

    1. Lựa chọn ô cần nhập dữ liệu. 

    2. Nhập dữ liệu tuỳ theo loại dạng thức. 

    3. Để kết thúc việc nhập dữ liệu bạn chọn một trong những cách sau: 

 * Nhấn phím Enter hay nút Enter trên thanh công thức. 

 * Click vào ô khác (Hay dùng những phím di chuyển để kết thúc việc nhập dữ 

liệu và di chuyển ô hiện hành theo hướng phím ). 

 * Để huỷ bỏ việc nhập dữ liệu đang thực hiện bạn nhấn phím Esc hoặc nút Cancel 

trên thanh công thức. 

 * Bạn có thể lựa chọn trước phạm vi các ô cần thực hiện, sau đó nhập dữ liệu và 

nhấn phím Enter, Excel sẽ tự động chuyển ô hiện hành đến những ô kế cận trong phạm 

vi lựa chọn. 

 * Khi nhập dữ liệu mới vào ô đang chứa trị thì Excel sẽ tự động ghi đè lên dữ liệu 

cũ. 

 2. Cách nhập cùng một dữ liệu vào các nhóm ô trên bảng tính 

 Các bước thực hiện: 

    1. Lựa chọn phạm vi các nhóm ô cần nhập dữ liệu. 

    2. Nhập dữ liệu tuỳ theo loại dạng thức. 

    3. Nhấn phím CTRL-Enter để kết thúc việc nhập dữ liệu. 

Lưu ý: 

 * Trong Excel, bạn có thể nhập dữ liệu vào một nhóm bảng tính cùng lúc. 

2.2.2. Chỉnh sửa dữ liệu (xoá, điều chỉnh, khôi phục) 

 1. Xoá dữ liệu 

 Chọn một trong những cách thực hiện sau: 

      a. Sử dụng lệnh Clear trên Menu để ấn định hình thức xoá dữ liệu 

 1. Lựa chọn ô (hoặc phạm vi ô) cần xoá. 

 2.Chọn lệnh [Menu] Edit>clear. 

   Xuất hiện Menu phụ 

 3. Chọn lệnh: 

    * All: Xoá toàn bộ nội dung, dạng thức ghi chú có trong ô. 
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   * Formats: Chỉ xoá dạng thức (không xoá nội dung ghi chủ và trở về dạng thức 

bình thường). 

    *Notes: Chỉ xoá ghi chú (không xoá nội dung, dạng thức). 

 4. Nhấn phím Enter (hoặc chọn nút OK). 

      b. Sử dụng thao tác Drag Mouse để xoá nội dung trong ô 

 1. Lựa chọn ô (hoặc phạm vi ô) cần xoá. 

 2. Di chuyển con trỏ Mouse vào mốc vuông nhỏ ở cạnh dưới bên phải (Fill 

Handle) của phạm vi lựa chọn. 

     Con trỏ Mouse sẽ đổi thành hình dấu + 

 3. Drag vào trong phạm vi lựa chọn (phía trên hoặc bên trái). 

     Khi Drag đến đâu thì Excel sẽ làm đảo màu để phân biệt. 

         c. Sử dụng phím (hoặc Right-Click) để xoá nội dung trong ô 

 1. Lựa chọn ô (hoặc phạm vi ô) cần xoá. 

 2. Nhấn phím DEL (tương đương lệnh [Shortcut] Clear > Contents). 

 2. Điều chỉnh dữ liệu 

 1. Lựa chọn ô cần thực hiện. 

 2. Nhấn phím F2 (hoặc Double click) để chuyển đổi vào chế độ chỉnh sửa dữ liệu. 

     Xuất hiện chỉ bảo Edit trên dòng tình trạng. 

 3. Thực hiện việc thay đổi dữ liệu trên thanh công thức hoặc ngay trong ô thực 

hiện. 

 4. Để kết thúc việc điều chỉnh dữ liệu trong ô, bạn chọn một trong những cách 

sau: 

    * Nhấn phím Enter (hay nút Enter trên thanh công thức). 

    * Click vào ô khác (hay dùng những phím di chuyển để kết thúc việc điều chỉnh 

dữ liệu và di chuyển ô hiện hành theo hướng phím). 

 3. Khôi phục dữ liệu 

 Để huỷ bỏ một hành động vừa thực hiện, bạn chọn lệnh [Menu] Edit > Undo... 

(hoặc chọn nút) Undo trên Standard Toolbar hay nhấn phím Ctrl-Z hoặc phím Alt-

Backspace). 

2.2.3. Di chuyển dữ liệu 

 Khi cần di chuyển dữ liệu đến một vị trí khác trong bảng tính (hoặc đến các bảng 

tính khác), tương tự như Word ngoài ra dùng nút phải của mouse để di chuyển trên 

những đường viền của phạm vi lựa chọn 

 1. Lựa chọn phạm vi ô (hoặc khối ô) chứa dữ liệu cần thực hiện. 

 2. Di chuyển con trỏ Mouse đến những cạnh viền của phạm vi lựa chọn (cho đến 

khi con trỏ Mouse chuyển thành hình mũi tên). 
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 3. Nhấn nút phải Mouse trong khi Drag phạm vi lựa chọn đến vị trí cần di chuyển 

đến. 

 4. Chọn lệnh: 

   * Move: di chuyển dữ liệu. 

   * Shift Down and Move: di chuyển và chèn dữ liệu hiện hành xuống dưới. 

   * Shift Right and Move: di chuyển và chèn dữ liệu hiện hành qua phải 

 Lưu ý: 

 * Khi bạn Drag vào trong phạm vi ô đang chứa dữ liệu thì Excel sẽ xuất hiện hộp 

thông báo: 

  - Chọn OK: để xác nhận việc thay thế dữ liệu cũ. 

  - Chọn Cancel : để huỷ bỏ việc di chuyển dữ liệu. 

 * Toạ độ ô ghi trong công thức của phạm vi nguồn vẫn được giữ nguyên khi di 

chuyển đến vị trí mới. 

 * Bạn chỉ thực hiện cách Drag dữ liệu trong phạm vi của một bảng tính. 

2.3.4. Sao chép dữ  kiện  

 Khi cần sao chép dữ liệu đến những vị trí khác trong cùng một bảng tính (hoặc 

vào các bảng tính khác), bạn chọn một trong những cách thực hiện sau: 

 1. Sao chép dữ liệu bình thường: tương tự như Word 

 2. Sao chép dữ liệu với những thông số ấn định 

 1. Lựa chọn phạm vi ô ( hoặc nhóm ô) chứa dữ liệu cần sao chép: 

2. Chọn lệnh [ Menu] Edit> copy(hoặc [ Shortcut] copy). 

* Excel xuất hiện đường viền chuyển động xoay quanh ô, khối ô lựa chọn và thông báo 

trên dòng tình trạng: Select destination and press Enter or choose Paste. 

3. Di chuyển ô hiện hành vào phạm vi cần sao chép đến. 

4. Chọn lệnh [Menu] Edit > Paste - Special (hoặc [ Shortcut] Paste - special). 

* Xuất hiện hộp đối thoại Paste Special . 

5. Lựa chọn nút lệnh, thông số các toán tử cần thực hiện trong hộp đối thoại : 

PASTE: 

- ALL: sao chép toàn bộ (với đầy đủ các thuộc tính trong ô). 

- Formulas: chỉ sao chép nội dung (như phần hiển thị trên thanh công thức) 

- Values: chỉ sao chép giá trị (đúng theo dạng hiển thị trên ô). 

- Formats: chỉ sao chép dạng thức ấn định trong ô. 

- Notes: chỉ sao chép các ghi chú trong ô. 

OPERATION: 

- None: sao chép và thay thế giá trị trong ô nguồn. 

- add: sao chép và cộng thêm với giá trị trong ô nguồn. 

- Subtract: sao chép và trừ bớt với giá trị trong ô nguồn. 

- Multiply:  sao chép và nhân với giá trị trong ô nguồn 
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- Divide:  sao chép và chia với giá trị trong ô nguồn 

SKIP BLANKS: 

- Không sao chép các ô trống có trong phạm vi nguồn. 

TRANSPOSE: 

- Sao chép và hoán chuyển vị trí cột, dòng của phạm nguồn thành dòng, cột trên phạm 

vi sao chép đến. 

PASTE LINK: 

- Sao chép và liên kết với dữ liệu trong phạm vi nguồn. 

6. Chọn nút OK. 

 3. Sao chép và chèn dữ liệu tại phạm vi thực hiện 

 1. Lựa chọn ô hoặc nhóm ô cần sao chép . 

 2. Di chuyển con trỏ Mouse đến các đường viền của khối ô lựa chọn ( cho đến khi 

con trỏ Mouse chuyển thành hình mũi tên). 

 3. Nhấn phím Ctrl trong khi Drag khối ô lựa chọn vào cạnh dưới hoặc bên phải 

của vị trí cần sao chép đến. 

  Excel xuất hiện thêm khung đường viền bao quanh khối ô lựa chọn trong khi di 

chuyển. 

 4. Tại vị trí cần sao chép đến, nhấn tiếp phím Shift (xuất hiện hình tượng    

hoặc   ) và thả nút Mouse. 

 Excel sẽ sao chép dữ liệu trên khối ô nguồn và chuyển dữ liệu trên phạm vi hiện 

hành xuống dưới hoặc qua phải. 

 4. Drag Mouse bằng nút phải Mouse trên những đường viền của phạm vi lựa 

chọn để sao chép dữ liệu với những thông số ấn định 

 1. Lựa chọn phạm vi ô (hoặc khối ô) chứa dữ liệu cần thực hiện. 

 2. Di chuyển con trỏ Mouse đến những cạnh viền của phạm vi lựa chọn (cho đến 

khi con trỏ Mouse chuyển thành hình mũi tên). 

3. Nhấn nút phải Mouse trong khi Drag phạm vi lựa chọn đến vị trí cần sao chép 

đến. 

 4. Chọn lệnh:  

 * Copy :sao chép toàn bộ ( với đầy đủ các thuộc tính có trong ô) . 

 * Copy formats: chỉ sao chép dạng thức ấn định trong ô. 

 * Copy values: chỉ sao chép giá trị ( đúng theo dạng hiển thị trên ô). 

 * Shift down and copy: sao chép và chèn dữ liệu hiện hành xuống dưới. 

 Shift right and copy: sao chép và chèn dữ liệu hiện hành qua phải. 

2.3.5. Điền dữ liệu vào trong phạm vi  
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 Việc điền dữ liệu vào những ô trên bảng tính cũng tương tự như việc sao chép. 

Trong phạm vi những ô cần điền sẽ gõ cùng một dữ liệu hoặc sẽ có giá trị tăng hay giảm 

dần so với ô bắt đầu . 

 1. Điền dữ liệu có cùng nội dung vào trong phạm vi lựa chọn  

 1. Lựa chọn phạm vi thực hiện ô đầu phải là ô chứa dữ liệu và có những ô cần 

điền ở kế cận . 

 2. Chọn lệnh [ Menu] Edit. 

 3. Chọn:  

 * Fill right: khi cần điền ô dữ liệu ở cột đầu tiên vào bên phải của phạm vi lựa 

chọn. 

 * Fill left: khi cần điền ô dữ liệu ở cột đầu tiên bên trái của phạm vi lựa chọn. 

 * Fill down: khi cần điền ô dữ liệu ở dòng đầu tiên xuống phía dưới của phạm vi 

lựa chọn. 

 * Fill Up: khi cần điền ô dữ liệu ở dòng đầu tiên lên phía trên của phạm vi lựa 

chọn. 

Lưu ý: 

* Bạn có thể thực hiện việc điền dữ liệu cho nhiều phạm vi lựa chọn cùng lúc 

(thực hiện việc lựa chọn nhóm ô không liên lạc nhau khi chọn lệnh). 

* Chọn: 

- Undo Fill...: để huỷ bỏ việc điền dữ liệu vừa thực hiện. 

- Repeat Fill..: khi cần lặp lại lệnh điền dữ liệu vừa thực hiện. 

 2. Điền dữ liệu có nội dung tăng /giảm vào trong phạm vi lựa chọn 

a. Nhấn nút trái Mouse khi Drag trên mốc điền của khối ô lựa chọn 

 1. Lựa chọn phạm vi ô chứa dữ liệu dạng ngày, dạng chuỗi có chứa chỉ số (nếu là 

dữ liệu số thì bạn phải lựa chọn ít nhất là hai ô: ô đầu chứa trị số bắt đầu, trị số trong ô 

thứ hai dùng để tính trị số bước nhảy, nếu trị số lớn hơn thì bước nhảy tăng và ngược 

lại). 

 2. Drag trên mốc điền của phạm vi ô lựa chọn đến những vị trí cần điền ở phạm 

vi lân cận. 

 * Khi drag, Excel xuất hiện thêm một khung viền bao quanh phạm vi lựa chọn và 

thông báo: Drag Outside selection to extend series or fill; drag inside to clear trên dòng 

tình trạng. 

 3. Thả phím Mouse. 

  Excel sẽ tuỳ thuộc vào dữ liệu trong ô bắt đầu mà thực hiện việc điền dữ liệu 

thích hợp vào các ô trên phạm vi lựa chọn. 

b. Nhấn nút phải Mouse khi Drag trên mốc điền của khối ô lựa chọn 

 1. Lựa chọn phạm vi ô chứa dữ liệu dạng ngày, dạng chuỗi có chứa trị số hay 

dạng số. 
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 2. Nhấn nút phải Mouse khi Drag trên mốc điền của phạm vi ô lựa chọn đến 

những vị trí cần điền ở phạm vi lân cận. 

  Khi Drag, Excel xuất hiện thêm một khung viền bao quanh phạm vi lựa chọn, 

và thông báo: Drag Outside selection to extend series or fill; drag inside to clear trên 

dòng tình trạng. 

   Khi đến vị trí mới, Excel xuất hiện thông báo: Copy from selection trên dòng 

tình trạng và Shortcut menu( thay đổi tuỳ theo dữ liệu có trong phạm vi lựa chọn). 

 3. Chọn lệnh: 

 * Fill Series: khi cần điền theo giá trị tuần tự ( tăng hoặc giảm). 

 * Fill Formats: khi cần điền dạng thức. 

 * Fill Values: khi cần điền giá trị. 

 * Fill day(hoặc Month, Year, Weekdays): khi cần điền theo giá trị thời gian. 

 3. Sử dụng lệnh fill Series 

 1. Nhập giá trị bắt đầu ( số, ngày ) vào trong 1 ô. 

 2. Lựa chọn phạm vi thực hiện (bắt đầu từ ô chứa giá trị đến các ô cần điền ở phía 

dưới hoặc bên phải ). 

 3. Chọn lệnh [ Menu ] Edit  > Fill > Series. 

 * Xuất hiện hộp đối thoại Series    

 4. Lựa chọn những thông số cần thay đổi: 

 * Series in: chuỗi số tuần tự trên cột /dong. 

 - Rows: dòng 

 - Columns : cột 

 * Type : Kiểu điền dữ liệu 

 -  Linear: cộng với trị số bước nhảy. 

 - Growth: nhân với trị số bước nhảy. 

 - Date : theo dạng ngày. 

 - Auto fill: theo chế độ điền tự động. 

 * Date: điền dữ liệu ngày theo: 

 - Day  : ngày. 

 - Weekday: tuần. 

 - Month: tháng. 

 - Year: năm. 

 * Trend : hướng tăng. 

 * Step value: trị số bước nhảy. 

 * Stop value: trị số kết thúc. 

 5. Chọn nút OK. 

 4. Sử dụng tính năng AutoFill theo trật tự do bạn ấn định 

    Điền giá trị vào phạm vi lựa chọn theo trật tự ấn định 
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 1. Di chuyển ô hiện hành vào phạm vi cần điền dữ liệu. 

 2. Nhập dữ liệu (đã có khai báo trong danh sách những trật tự ấn định sẵn). 

 3. Drag trên móc điền của phạm vi ô lựa chọn đến những vị trí cần điền ở phạm 

vi lân cận. 

 Excel sẽ thực hiện việc điền dữ liệu vào phạm vi lựa chọn theo những trật tự đã được 

ấn định. 

2.3.6. Xứ lý ô, cột, dòng trong bảng tính 

 1. Chèn thêm các ô, cột, dòng trống 

 Khi cần chèn thêm ô, cột, dòng trống trên bảng tính, bạn chọn một trong những 

cách thực hiện sau: 

a. Nhấn Shift khi Drag khối ô lựa chọn. 

 1. Lựa chọn phạm vi (ô, cột, dòng) cần thực hiện. 

 2.  Nhấn Shift khi Drag trên mốc vuông của phạm vi lựa chọn đến vị trí cần chèn 

ở phía dưới hoặc bên phải. 

 3. Thả phím Mouse. 

            Excel sẽ chèn thêm các ô, cột, dòng trống ở vị trí thực hiện và tự động điều 

chỉnh các toạ độ ô. 

b. Dùng lệnh Insert hoặc các nút lệnh Insert 

 1. Lựa chọn phạm vi (ô, cột, dòng) cần thực hiện ở phía dưới hoặc bên phải vị trí 

cần chèn. 

 2. Chọn lệnh [Menu] Edit > Insert (hoặc [Shortcut] Insert hay các lệnh Insert). 

 * Khi phạm vi thực hiện là các ô : Thì Excel sẽ xuất hiện thêm hộp đối thoại 

Insert. 

 * Chọn: 

 - Shift Cells Right: Để đẩy khối ô hiện hành sang phải khi chèn. 

 - Shift Cells Down: Để đấy ô hiện hành xuống dưới khi chèn. 

 - Entire Row: Để chèn các dòng trống phía trên phạm vi lựa chọn. 

 - Entire Column: Để chèn các cột trống bên trái phạm vi lựa chọn. 

 * Khi phạm vi thực hiện là các cột, dòng: thì Excel sẽ tự động chèn các dòng 

trống phía trên hoặc các cột trống bên trái. 

 2. Xoá các ô, cột, dòng 

 Khi cần xoá các ô, cột, dòng trên bảng tính, bạn chọn một trong những cách thực 

hiện sau: 

a. Nhấn phím Shift khi Drag khối ô lựa chọn 

 1. Lựa chọn phạm vi, ô, cột, dòng cần xoá. 

 2. Nhấn phím Shift trong khi Drag trên mốc điền của phạm vi lựa chọn lên phía 

trên hoặc bên trái. 
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3. Thả phím Mouse. 

  Excel sẽ xoá các ô, cột, dòng ở vị trí thực hiện và tự động dồn các dòng phía dưới 

hoặc cột bên phải. 

b. Dùng lệnh Delete trên Menu (hoặc nút lệnh Delete) 

1. Lựa chọn phạm vi (ô, cột, dòng) cần xoá. 

2. Chọn lệnh [Menu] Edit > Delete (hoặc [Shortcut] Delete ). 

 * Khi phạm vi thực hiện các ô thì Excel sẽ xuất hiện thêm hộp thoại Delete. 

* Chọn: 

- Shift Cells Left: để xoá khối ô lựa chọn và dồn các ô bên phải sang trái. 

- Shift Cells up: Để xoá khối ô lựa chọn và dồn các phím dưới lên. 

- Entire Row: để xoá những dòng trong phạm vi lựa chọn. 

- Entire Column: Để xoá những cột trong phạm vi lựa chọn. 

* Khi phạm vi thực hiện là các cột, dòng: thì Excel sẽ xoá các cột, dòng ở vị trí 

thực hiện và tự động dồn các dòng phía dưới hoặc các cột bên phải. 

2.3.7. Sử dụng tên vùng 

Trong Excel, bạn nên sử dụng tên vùng để dễ dàng gợi nhớ mỗi khi khai báo 

phạm vi cho các toạ độ ô, phạm vi khối ô, công thức trong các lệnh. Ngoài ra tên vùng 

còn được dùng với phím Goto để di chuyển nhanh ô hiện hành đến những phạm vi này 

trong bảng tính. 

 1. Quy ƣớc đặt tên vùng 

 + Ký tự đầu phải là ký tự chữ, những ký tự còn lại có thể là ký tự chữ, ký số, dấu 

chấm, dấu gạch nối... 

 + Tên vùng không nên đặt trùng với các toạ độ ô như (A$1 hoặc R1C1) hoặc có 

chứa các ký tự trống. 

 + Chiều dài tối đa của tên vùng là 255 ký tự, tuy nhiên ban nên đặt ngắn gọn và 

gợi nhớ đê dễ sử dụng. 

 + Excel không phân biệt chữ in hoa hay thường trong tên vùng. 

 2. Đặt tên vùng 

 Dùng lệnh định dạng tên cho từng vùng 

1. Lựa chọn ô, phạm vi khối ô mà bạn cần đặt tên. 

2. Lệnh [Menu] Insert > Name > Define (hoặc nhấn phím Ctrl-F3). 

 Xuất hiện hộp đối thoại Define Name. 

3. Nhập tên cần đặt cho phạm vi vừa lựa chọn trên khung Name in Workbook 

(hoặc chấp nhận tên lựa chọn sẵn của Excel dựa vào các chuỗi kí tự ở phía trên hoặc 

bên trái của phạm vi lựa chọn). 

4. Thay đổi (Hoặc có thể khai báo lại) phạm vi cần đặt tên, bởi một trong những 

cách thực hiện như sau: 

* Drag Mouse trên phạm vi lựa chọn trong bảng tính. 
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* Nhập toạ độ trên khung Refers to (phải bắt đầu bởi dấu = như dạng công thức). 

* Chấp nhận toạ độ gán sẵn (theo sự lựa chọn trên bước 1) trong khung Refers To. 

5. Khi cần thực hiện tiếp việc đặt tên khối, bạn chọn nút Add và lập lại các bước 

3 và 4. 

6. Lựa chọn nút OK để đòng hộp đối thoại và chấm dứt lệnh. 

 3. Xoá tên vùng 

1. Chọn lệnh [Menu] Insert > Name > Define (hoặc nhấn phím Ctrl-F3). 

 Xuất hiện hộp đối thoại Define Name. 

2. Lựa chọn tên vùng cần xoá trên khung Name in Workbook. 

3. Chọn nút Delete. 

4. Lặp lại các bước 2,3 cho những tên vùng cần xoá khác. 

5. Chọn nút close để đóng hộp đối thoại. 
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C 

 

Dạng thức là một tập hợp của những dạng thể hiện liên quan đến hình 

thức trình bày của dữ liệu trên bảng tính như: Font chữ, màu sắc, các mẫu 

nền, đường kẻ, kích thước cuả cột/dòng, vị trí của dữ liệu trong ô hay trong 

một phạm vi. 

Ngoài những định dạng mặc nhiên Excel, bạn có thể thay đổi dạng thức 

dữ liệu trên toàn bộ bảng tính hay có giới hạn trong phạm vi lựa chọn hoặc 

chỉ cho một vài kí tự trong ô. 

3.1. Hƣớng dẫn tổng quát việc thay đổi dạng thức (Format) 

 Để thay đổi dạng thức dữ liệu trong phạm vi lựa chọn, bạn chỉ cần chọn 

một trong những cách thực hiện như sau: 

* Sử dụng những  Menu lệnh. 

* Sử dụng Toolbar Formatting. 

* Sử dụng các phím gán sẵn. 

* Sử dụng Format Painter. 

* Sử dụng Styles. 

* Sử dụng dạng thức tự động (Auto Format) của Excel. 

 1. Lựa chọn phạm vi cần thực hiện. 

 2. Chọn lệnh [Menu] Formats > Cells (hoặc [Shortcut] Formats Cells 

.hay phím Ctrl-1). 

 Xuất hiện hộp thoại Formats cells. 

 

 3. Chọn nhóm Tab cần thực hiện. 
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3.2. Thay đổi dạng thể hiện của dữ liệu dạng số, thời gian  ( Number):  

 Dạng thể hiện số là những mã dạng thức dùng để thể hiện các giá trị số, 

ngày, giờ trong bảng tính. Dạng thức số mặc nhiên là dạng bình thường 

(category). 

Excel  có tạo sẵn 11 nhóm (Category) dạng thức số khác nhau như sau: 

 

Nhóm liệt kê những loại dạng thức 

All Toàn bộ các loại dạng thức 

Custom tự tạo 

Number Số 

Accounting kế toán 

Date ngày 

Time Giờ 

Percentage phần trăm 

Fraction phân số 

Scientific Khoa học kỹ thuật 

Text Chuỗi 

Currency tiền tệ 

Muốn thay đổi dạng thể hiện của dữ liệu dạng số, thời gian trên thanh 

công cụ, bạn thực hiện các bước: 

 1. Lựa chọn phạm vi cần thực hiện. 

 2. Chọn trong Toolbar Formatting (hay trong những toolbar khác) như sau: 

  * Click vào những nút Tools để lựa chọn. 

  nút   Cộng dụng 

     Dạng tiền tệ. 

     Dạng phần trăm 

     Dạng phân cách(,)số nguyên và hai số lẻ 

     Thêm một số lẻ. 

     Giảm một số lẻ. 
 

3.3. Canh biên dữ liệu trong ô Alignment  

3.4. Lựa chọn Font chữ Font 

3.5. Trang trí các đƣờng viền Border 
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3.6. Tạo các mẫu nền trong ô Patterns 

3.7. Bật/tắt các thông số bảo vệ dữ liệu và che dấu dữ liệu trên thanh công thức 

Protection 

 

3.8. sao chép/huỷ bỏ dạng thức 

3.8.1. Sao chép dạng thức 

 Sử dụng nút Format Painter trên Standard Toolbar 

 1. Lựa chọn phạm vi chứa dạng thức cần sao chép (phạm vi nguồn). 

 2. Chọn nút Format Painter trên Standard Toolbar. 

  Xuất hiện hình tượng cây cọ vẽ. 

  3. Lựa chọn phạm vi cần tiếp nhận dạng thức (phạm vi đích). 

 Excel sẽ thực hiện việc sao chép dạng thức của phạm vi nguồn. 

Lưu ý: 

 * Trong bước hai khi bạn chọn nút Format Painter bởi thao tác: 

  - Click Chỉ thực hiện việc sao chép dạng thức cho một phạm vi (một lần). 

  - Double Click: Thực hiện việc sao chép dạng thức cho nhiều phạm vi  (nhiều 

lần) cho đến khi bạn Click lại nút Format Painter hoặc nhấn phím Esc. 

 * Khi phạm vi nguồn là một khối ô liên lạc thì trong bước 3 bạn chỉ cần lựa chọn ô đầu 

tiên trong phạm vi đích. 

3.8.2. Huỷ bỏ dạng thức 

Sử dụng lệnh Clear 

  1. Lựa chọn phạm vi chứa dạng thức cần xoá (phạm vi nguồn). 

  2. Chọn lệnh [Menu] Edit > Clear. 

  3. Chọn nút Format. 

 

3.9. Thay đổi định dạng cột dòng trong bảng tính 

3.9.1. Che dấu hiện lại các cột trong bảng tính. 

  1. Di chuyển ô hiện hành vào cột cần thực hiện ( hoặc lựa chọn phạm vi chứa các 

cột cần thực hiện. 

  2. Chọn lệnh [Menu] Format > Column. 

 Xuất hiện Menu phụ. 

  3. Chọn lệnh. 

* Hide: Khi cần thực hiện việc che dấu cột. 

* Unhide: Khi cần hiển thị lại các cột bị dấu. 

3.9.2. Thay đổi độ rộng cột 
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  Khi cần thay đổi độ rộng cột hiện hành hoặc của các cột trong phạm vi lựa chọn 

trong bảng tính ban chọn một trong những cách thực hiện sau. 

a. Nhập trị số ấn định trong lệnh [Menu] Format 

  1. Di chuyển ô hiện hành vào cột cần thực hiện ( hoặc lựa chọn phạm vi chứa các 

cột cần thực hiện. 

  2. Chọn lệnh [Menu] Format > Column > Width. 

 Xuất hiện hộp đối thoại Column Width. 

  3. Nhập trị số trên khung column Width (từ 0 đến 255). 

4. Chọn nút OK (hoặc nhấn phím Enter). 

b. Drag Mouse (ở bên phải kí hiệu cột trên đường viền ngang): tương tự Word 

3.9.3. Thay đổi chiều cao dòng 

a. Nhập trị số ấn định trong lệnh [Menu] Format 

  1. Di chuyển ô hiện hành vào dòng cần thực hiện ( hoặc lựa chọn phạm vi chứa 

các dòng cần thực hiện. 

  2. Chọn lệnh [Menu] Format > Row > Height. 

 Xuất hiện hộp đối thoại Row Height. 

  3. Nhập trị số trên khung Row Height (từ 0 đến 409). 

4. Chọn nút OK (hoặc nhấn phím Enter). 

b. Drag Mouse (ở  phía dưới số thứ tự của dòng trên đường viền dọc) 

  1. Lựa chọn dòng (hoặc phạm vi các dòng) cần thực hiện. 

  2. Di chuyển con trỏ Mouse vào đường viền dọc và ở đường phân cách  phía dưới 

của số thứ tự dòng cần thực hiện. 

 Hình tượng con trỏ Mouse sẽ đổi thành hai đường viền ngang. 

3. Chọn. 

 * Drag lên phía trên : Khi cần thu hẹp chiều cao dòng. 

   * Drag xuống phía dưới: Khi cần gia tăng chiều cao dòng. 

   * Double Click: để excel tự động điều chỉnh chiều cao dòng (dựa vào chiêu 

cao chuỗi dữ liệu  hiện có trong dòng). 

3.10.  Tập tin khuôn mẫu (template) 

 Tập tin Template là mô hình có thể làm nền cho nhiều trang bảng tính. Một 

Template có thể bao gồm cả dữ liệu lẫn thông tin định dạng. Tập tin Template là công 

cụ tiết kiệm thời gian lý tưởng. Tập tin Template là cách đảm bảo tuyệt đối hình thức 

nhất quán giữa những báo biểu, hoá đơn, cùng nhiều tài liệu khác do bạn tạo. Bất kỳ 

một tập tin nào cũng có thể trở thành Template. 

3.10.1. Cách tạo một tập tin Template 

 1. Tạo một bảng tính chứa nội dung, hình thức cần sử dụng làm khuôn mẫu. 
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 2. Chọn lệnh [Menu] File > Save As để lưu tập tin. 

 3. Chọn Template trên khung Save File as Type. 

 4. Lựa chọn ô đĩa, thư mục cần lưu trứ trên các khung Drivers, Directories). 

 Excel sẽ tự động đặt tên mở rộng cho loại tập tin Template là XLT. 

3.10.2. Cách sử dụng một tập tin Template 

 1. Chọn lệnh [Menu] File > Open. 

 2.Chọn tập tin Template cần thực hiện  

 Excel sẽ tự động thay đổi tên  tập tin Template thành tên tập tin bảng tính bình 

thường với số thứ tự phía sau (tương ứng với số lần được vào). 

3. Điền dữ liệu vào bảng tính vừa tạo. 

4. Lưu tập tin. 

 

Lưu ý: 

 * Khi cần đọc lại tập tin Template để chỉnh sửa, bạn phải nhấn thêm phím Shift 

khi lựa chọn tên tập tin trong hộp đối thoại Open. 
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(FUNCTION)  

 

 Hàm (Function) được xem như là những công thức định sẵn nhằm thực hiện các 

yêu cầu tính toán chuyên biệt. Trên ô thực hiện, hàm sẽ cho kết quả là một giá trị hay 

một chuỗi hoặc một thông báo lỗi. Excel  có trên 300 hàm định sẵn và được phân loại 

thành từng nhóm. 

Với tính năng Function Wizard và có bổ sung thêm nhiều ví dụ trong cửa sổ 

Help, Excel sẽ giúp bạn sử dụng và khai thác hàm trong bảng tính trở nên dễ dàng và 

nhanh chóng hơn. 

4.1. Dạng thức tổng quát của hàm 

 =<TÊN HàM>(đối số 1, đối số 2,...,đối số n). 

  Tên hàm: Sử dụng tên theo quy ước của Excel.  

  Đối số: Phần lớn hàm trong Excel đều có đối số. Đối số có thể là các trị số, 

chuỗi, toạ độ ô, tên vùng công thức, những hàm khác. 

 

Lưu ý: 

 * Hàm phải được bắt đầu bởi dấu = (hoặc dấu @). 

 * Tên hàm nhập bằng chữ thương hay chữ in hoa đều có giá trị như nhau, nhưng 

không được viết tắt. 

 * Đối số của hàm có thể có hoặc không tuỳ theo hàm, nhưng phải được đặt trong 

hai dấu() và giữa các đối số được phân cách nhau bới dấu phẩy. 

 * Trong một hàm có thể chứa tối đa 30 đối số (nhưng không được vượt quá 255 

ký tự). 

 * Trong hàm không được chứa ký tự blank (khoảng trống). 

 * Có thể sử dụng hàm để làm đối số cho một hàm khác nhưng không cần phải 

nhập dấu = phía trước tên hàm đó. 

4.2. Cách nhập hàm vào bảng tính 

 Bạn có thể nhập vào bảng tính từng hàm riêng biệt (hoặc sử dụng hàm trong 

những công thức hay với các hàm khác) với những cách thực hiện như sau: 

 * Nhập từ bàn phím. 

 * Lựa chọn trong bảng liệt kê tên hàm. 

 * Sử dụng tính năng Function Wizard. 

a. Nhập hàm từ bàn phím 

 1. Di chuyển ô hiện hành đến ô cần nhập. 

  2. Nhập dấu = (hoặc dấu @). 

 3. Nhập hàm từ bàn phím (tên, đối số phải theo đúng dạng thức quy định). 

b. Lựa chọn trong bảng liệt kê tên hàm 
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 1. Di chuyển ô hiện hành đến ô cần nhập. 

 2. Chọn lệnh [Menu] Insert > Function (hay nhấn phím Shift-F3 hoặc chọn nút 

hàm trên Standard Toolbar). 

  Xuất hiện hộp đối thoại Function wizard - Step 1 of 2. 

 3. Chọn nhóm hàm cần thực hiện trên khung Function Category. 

  Khi di chuyển thanh sáng đến nhóm hàm nào trên khung Function Category, 

Excel sẽ liệt kê danh sách các hàm có trong nhóm hàm đó theo thứ tự chữ cái trên 

khung Function Name. 

 4. Chọn tên hàm cần thực hiện trên khung Function Name. 

 5. Chọn nút OK 

  Excel sẽ tắt hộp đối thoại và chuyển tên hàm lựa chọn và thanh công thức. 

 6. Nhập (hoặc lựa chọn) phạm vi cho các đối số theo yêu cầu của từng hàm. 

Lưu ý: 

 * Trong bước 4 bạn có thể di chuyển nhanh thanh sáng đến tên hàm lựa chọn 

trên khung Function Name bằng cách ấn ký tự đầu của tên hàm cần chọn. 

 * Khi cần xem thành phần đối số của một hàm trên thanh công thức bạn nhấn 

phím CTRL+A. 
 

Các giá trị lỗi hay gặp trong Excel 

 

Giá trị lỗi ý nghĩa 

#DIV/0 Bạn đã chia một cho giá trị không. Lỗi này thường xuất hiện khi công 

thức có số chia chỉ đến một ô trống 

#N/A Không có thông tin cho phép tính toán của bạn. Khi xây dựng mô hình, 

bạn có thể gõ vào #N/A trong một ô để cho biết bạn đang chờ dữ liệu. 

Mọi công thức sử dụng ô chứa #N/A đều trả về #N/A. 

#NAME? Bạn có thể sử dụng trong công thức nhưng tên đó không có trong hộp 

thoại Define Name. Có thể bạn gõ sai tên đó hay tên đó đã bị xoá lỗi. Lỗi 

đó cũng xuất hiện khi bạn quên đặt chuỗi trong nháy kép đôi. 

#NULL! Bạn có sử dụng khoảng trống giữa hai vùng để cho biết đó là giao điểm, 

nhưng các vùng không có ô nào. 

#NUM! Lỗi này thường xuất hiện khi bạn sử dụng sai đối số trong hàm. Lỗi này 

còn mang ý nghĩa rằng kết quả trả về quá lớn hay quá nhỏ để có thể trình 

bày trên Worksheet. 

#VALUE

! 

Bạn đã xây dựng một công thức toán học nhưng sử dụng các ô chữ. 

#REF! Bạn đã xoá một vùng ô vốn được sử dụng trong công thức. 
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###### Kết quả trả về quá lớn so với độ rộng cột hiện hành. Hãy mở rộng độ 

rộng cột ra. 

 

4.3. Một số hàm cơ bản  

4.3.1. Hàm thời gian và một số hàm đơn giản thông dụng 

4.3.1.1. Hàm thời gian 

1. Hàm DAY() 

+ Chức năng: cho giá trị ngày trong dữ liệu dạng ngày. 

+ Cú pháp: = DAY (<dữ liệu kiểu ngày>) 

Ví dụ: 

 = DAY(32501)   = 24 

 = DAY("24- Dec-94")= 24 

 = DAY (B11)  =24 (khi B11 chứa trị 24-dec-94). 

  2. Hàm MONTH() 

+ Chức năng: cho giá trị tháng trong dữ liệu dạng ngày. 

+ Cú pháp: = MONTH (<dữ liệu kiểu ngày>) 

Ví dụ: 

= MONTH (32501)   = 12 

= MONTH("24-Dec-94")  = 12 

= MONTH (B11)   =  12 (Khi B11 chứa trị 24-Dec-94) 

3. Hàm YEAR() 

+ Chức năng: cho giá trị năm trong dữ liệu dạng ngày. 

+ Cú pháp: = YEAR (<dữ liệu kiểu ngày>) 

Ví dụ: 

= YEAR (32501)  = 94 

= YEAR ("24-Dec-94")= 94  

= YEAR (B11)  = 94 (khi B11 chứa trị 24-Dec-94). 

4. Hàm Today() 

+ Chức năng: cho kết quả là ngày hiện tại từ hệ thống ngày trong máy tính 

5. Hàm DAYS360() 

+ Chức năng: cho kết quả là số ngày giữa <biểu thức1 > và <biểu thức 2>, trong đó 

<biểu thức 1> và <biểu thức 2> là các giá trị ngày tháng. 

+ Cú pháp: = days360(<biểu thức 1>,<biểu thức 2>) 

Ví dụ:  ô A1 là 1/4/98 ô A2 là 1/5/98, để tính khoảng thời gian giữa ô A1 và ô A2, bạn 

viết: 

 =Days360(A1,A2) có kết quả là 30 

Hàm trên tương đương đương với bạn nhập công thức: 
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 =A2-A1 

6. Hàm NOW() 

+ Chức năng: cho giá trị ngày, tháng và thời gian hiện thời. 

Ví dụ: 

 Nhập = NOW() trên ô A5 =   7/25/94  15:10 

 7. Các hàm HOUR(), MINUTE() và SECOND() 

 Các hàm Hour(), minute() và second() cho phép bạn lấy ra giá trị của giờ, phút và 

giây của dữ liệu là ngày tháng hoặc thời gian 

4.3.1.2. Một số hàm  thông dụng 

1. Hàm SUM() 

 + Chức năng: Tính tổng các giá trị số trong phạm vi. 

 + Cú pháp: = SUM(danh sách các giá trị). 

Ví dụ: 

 = SUM(A1:A5)   (Tính tổng số trong phạm vi từ A1 đến A5). 

 = SUM(A1:A5,C6:C18)(tính tổng số trong phạm vi từ A1 đến A5 và từ C6 đến 

C8). 

Lưu ý: 

* Khi ở trong phạm vi chỉ định có ô chứa giá trị #VALUE! thì hàm sum sẽ cho trị 

#VALUE! 

* Ô chứa dữ liệu trong phạm vi không được tính. 

* Số lượng phạm vi trong hàm từ 1 đến 30. 

2. Hàm AVERAGE() 

 + Chức năng: Tính trung bình cộng trong phạm vi. 

 + Cú pháp: = AVERAGE(danh sách các giá trị). 

Ví dụ: 

 = AVERAGE (B1:B5)     (tính trung bình cộng trong phạm vi từ B1 đến 

B5). 

 = AVERAGE (A1:A5,C6:C18) (tính TB cộng trong phạm vi từ A1 đến A5 và từ 

C6 đến C8). 

Lưu ý: 

* Khi ở trong phạm vi chỉ định có ô chứa giá trị #VALUE! thì hàm AVERAGE sẽ cho trị 

#VALUE! 

* Ô chứa dữ liệu chuỗi hoặc ô trống trong phạm vi không được tính. 

* Số lượng phạm vi trong hàm từ 1 đến 30. 

 3. Hàm MAX(), MIN() 

+ Công dung:  Hàm Max: cho giá trị cao nhất trong phạm vi khối ô, hàm MIN cho 

giá trị thấp nhất trong phạm vi khối ô. 
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= MAX (danh sách các giá trị) 

= MIN (danh sách các giá trị) 

Lưu ý: 

* Những dữ liệu chuỗi và ký tự trống (blank) có trong phạm vi sẽ không được tính. 

* Đối với những dữ liệu dạng ngày trong phạm vi cũng được tính dựa vào trị số tuần tự 

của các ngày đó. 

* Có thể liên kết nhiều thành phần vào trong một hàm, nhưng phải được phân cách với 

nhau bởi dấu phẩy. 

4.3.2. Hàm văn bản 

 1. Hàm LEFT và RIGHT 

 + Chức năng:  

 = LEFT : Trích số ký tự bên trái chuỗi dữ liệu hoặc trong toạ độ ô chứa dữ liệu. 

 = RIGHT : Trích số ký tự bên phải chuỗi dữ liệu hoặc trong toạ độ ô chứa dữ 

liệu. 

  +  Cú pháp: 

 = LEFT ( <chuỗi ký tự>, <số ký tự tách>) 

 = RIGHT (<chuỗi ký tự>, <số ký tự tách>) 

Ví dụ: 

= LEFT ( "Hà nội", 2) = Hà 

= RIGHT ( "Hà nội", 2) = ội 

Lưu ý: 

* Chuỗi ký tự ghi trực tiếp trên hàm phải được đặt trong hai dấu nháy kép. 

* Nếu số ký tự cần trích ghi lớn hơn chiều dài của chuỗi dữ liệu thì Excel chỉ ghi lại 

đúng độ dài của chuỗi. 

* Trị số chiều dài của chuỗi dữ liệu được tính kể cả các khoảng trống trong ô. 

 2. Hàm MID() 

 + Chức năng: Cho kết quả là một chuỗi ký tự được lấy ra trong <bt ký tự> theo 

nguyên tắc sau: 

- Lấy ra bắt đầu từ ký tự thứ nhất <bt số 1> 

- Lấy ra bắt đầu từ ký tự thứ nhất <bt số 2> 

 + Cú pháp:  = Mid(<bt số 1>, <bt số 2>)  

 3. Hàm LEN() 

 + Chức năng: cho kết quả là một số biểu thị độ dài của <biểu thức ký tự>. 

 + Cú pháp:   

  = Len(<biểu thức ký tự>)  

 4. Hàm LOWER() 

  + Chức năng: chuyển đổi từ <biểu thức ký tự> thành một chuỗi ký tự là 

chữ thường 

  + Cú pháp: 
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   = Lower(<biểu thức ký tự>) 

 5. Hàm UPPER() 

  + Chức năng: chuyển đổi từ <biểu thức ký tự> thành một chuỗi ký tự là 

chữ hoa 

  + Cú pháp: 

   = Upper(<biểu thức ký tự>) 

 6. Hàm PROPER() 

  + Chức năng: chuyển đổi từ <biểu thức ký tự> thành một chuỗi ký tự mà 

ký tự đầu là chữ hoa 

  + Cú pháp: 

   = Proper(<biểu thức ký tự>) 

 7. Hàm REPLACE() 

  + Chức năng: để lấy ra trong chuỗi ký tự <bt ký tự 1> từ ký tự số <bt số 1> 

và lấy ra <bt số 2> ký tự. Thay vào đó là <bt ký tự 2> 

  + Cú pháp: 

   = Replace(<bt ký tự 1>, <bt số 1>, <bt số 2>,<bt ký tự 2>) 

 8. Hàm REPT() 

  + Chức năng: cho kết quả là một chuỗi ký tự được lặp lại <bt số> lần <bt 

ký tự. 

  + Cú pháp: 

   = Rept()<bt ký tự >, <bt số >) 

 9. Hàm SEARD() 

  + Chức năng: dùng để tìm chuỗi <bt ký tự 1> trong chuỗi <bt ký tự 2>. Kết 

quả nhận được là vị trí bắt đầu xuất hiện của <bt ký tự 1> trong chuỗi <bt ký tự 2>. Nếu 

bạn có chỉ thị <bt số> thì việc tìm kiếm được tiến hành bắt đầu từ ký tự thứ (bt số>. Nếu 

không có chỉ thị này thì ngầm định bắt đầu từ ký tự thứ nhất. 

  + Cú pháp: 

   = Search(<bt ký tự 1>,<bt ký tự 2>,<bt số>) 

 Ví dụ: 

   = Search(“Hồng”,”Ngọc Hồng Hồng”) kết quả nhận đuợc là 6 

 Nếu bạn chỉ thị : 

  = Search(“Hồng”,”Ngọc Hồng Hồng”,7) kết quả nhận đuợc là 11 vì bắt 

đầu tìm ký tự thứ 7. 

 10. Hàm SUBSTITUTE() 

  + Chức năng: dùng để lấy ra trong chuỗi <bt ký tự 1> một chuỗi ký tự là 

<bt ký tự 2> và thay  

vào đó là <bt ký tự 3>. 

  + Cú pháp: 
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   = Substitute (<bt ký tự 1>,<bt ký tự 2>,<bt ký tự 3>) 

 Ví dụ:  = Substitute(“Nguyễn Khánh Ngọc”,”Ngọc”,”Linh”) kết quả nhận được 

là: 

   Nguyễn Khánh Linh  

 11. Hàm TRIM () 

  + Chức năng: cho kết quả là một chuỗi ký tự được lấy từ <bt ký tự > sau 

khi đã bỏ các ký tự trống ở đầu và cuối chuỗi ký tự. Hàm Trim() còn bỏ bớt các vị trí 

trống giữa hai từ và chỉ để lại một ký tự trống. 

  + Cú pháp: 

   = Trim(<bt ký tự>) 

 Ví dụ: 

   = Trim(“Trung  tâm  Tư  vấn”) cho kết quả là:   Trung tâm Tư vấn 

 12. Toán tử & 

  + Chức năng: dùng để nối hai chuỗi ký tự. 

  + Cú pháp: 

   = “text 1” & “text 2 

 Ví dụ: ở tại ô A1 chứa “Nguyễn Khánh”, tại ô A2 chứa “ Ngọc” , tại A3 nhập 

công thức 

   = A1&A2 , bạn nhận được kết quả là: Nguyễn Khánh Ngọc 

 13. Hàm CONCATENATE 

  + Chức năng: nối kết các chuỗi văn bản thành một chuỗi văn bản đơn 

  + Cú pháp:   =Concatenate(<chuỗi ký tự 1>, <chuỗi ký tự 2>, ... ) 

 14. Hàm VALUE() 

  + Chức năng: đổi một văn bản sang một số 

  + Cú pháp: Value(<chuỗi ký tự>)(có thể chuỗi ký tự hoặc là tham chiếu 

một có chứa ký tự) 

 

 15. Hàm CHAR() 

  + Chức năng: cho một ký tự tương ứng với mã của nó. 

  + Cú pháp: Char(<mã ASCII>) 

 16. Hàm CODE() 

  + Chức năng: cho mã tương ứng với ký tự đầu tiên trong văn bản. 

  + Cú pháp:  =Code(<chuỗi ký tự>) 

4.3.3. Hàm số học 

 1. Hàm ABS() 

 + Chức năng: cho kết quả là giá trị tuyệt đối của biểu thức số 

 + Cú pháp:   =ABS(<biểu thức số>) 
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 2. Hàm SQRT() 

  + Chức năng: cho kết quả là căn bậc 2 của <biểu thức số> với điều kiện 

<biểu thức số> phải lớn hơn hoặc bằng 0.  

  + Cú pháp:   =SQRT(<biểu thức số>) 

 3. Hàm MOD() 

  + Chức năng: cho kết quả là số dư của <biểu thức số> chia cho số n. 

  + Cú pháp:   =Mod (<biểu thức số>,n) 

 4. Các hàm làm tròn số 

  a. Hàm ROUND() 

  + Chức năng: làm tròn một số là <giá trị số> với <biểu thức số> giá trị thập 

phân.  

  + Cú pháp:   =Round(<giá trị số>, <biểu thức số>) 

 Nếu <biểu thức số> là dương thì làm tròn <giá trị số> theo các số lẻ (bên phải 

của giá trị số)   

 Nếu <biểu thức số> là âm thì làm tròn <giá trị số> theo các số nguyên (bên trái 

của giá trị số)   

 

  b. Hàm EVEN() 

  + Chức năng: làm tròn một số tới số nguyên chẵn gần nhất các số nguyên 

tương ứng được làm tròn xuống.  

  + Cú pháp:   =Even (<biểu thức số>) 

  Ví dụ:   bạn có số 23.4  nếu sử dụng hàm Even(23.4) ta có kết quả là 24 

  c. Hàm ODD()  

  + Chức năng: làm tròn một số tới số nguyên lẻ nhất. Các số nguyên tương 

ứng được làm tròn xuống. 

  + Cú pháp:   =Odd(<biểu thức số>) 

 Ví dụ:   bạn có số 23.4  nếu sử dụng hàm Odd(23.4) ta có kết quả là 25 

  d. Hàm FLORR() 

  + Chức năng: cho giá trị là bội số của <biểu thức số 2> gần với <biểu thức 

số 1> nhất. Giá trị này được tính nhỏ hơn <biểu thức số 1>  

  + Cú pháp:   =Floor(<biểu thức số 1>, <biểu thức số 2> ) 

 Ví dụ:   =Floor(23.4,5) ta có kết quả là 20 

  e. Hàm CEILING() 

  + Chức năng: cho giá trị là bội số của <biểu thức số 2> gần với <biểu thức 

số 1> nhất. Giá trị này được tính lớn hơn <biểu thức số 1>  

  + Cú pháp:   =Ceiling(<biểu thức số 1>, <biểu thức số 2> ) 

 Ví dụ:   =Ceiling(23.4,5) ta có kết quả là 25 

  f. Hàm INT() 
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  + Chức năng: cho kết quả là phần nguyên của <biểu thức số>  

  + Cú pháp:   =Int (<biểu thức số>) 

 Ví dụ:   =Int(23.46) ta có kết quả là 23 

  g. Hàm TRUNC() 

  + Chức năng: loại bỏ các giá trị sau dấu chấm thập phân 

  + Cú pháp:   =Trunc (<biểu thức số>) 

 Ví dụ:   =Trunc(23.46) ta có kết quả là 23 

 Lưu ý:  Điểm khác biệt cơ bản giữa INT() và TRUNC() là khi xử lý các giá trị âm. 

 Ví dụ:   =Int(-100.99), cho kết quả là -101 

   Nhưng kết quả hàm: 

    = Trunc(-100.99) cho kết quả là -100 

 5. Hàm FACT() 

  + Chức năng: cho kết quả là giai thừa của <biểu thức số>  

  + Cú pháp:   =Fact (<biểu thức số>) 

 Ví dụ:   =Fact(3)  có kết quả là 6 (tương ứng với công thức =1*2*3) 

 6. Hàm COMBIN() 

  + Chức năng: cho giá trị là tổ hợp của <biểu thức số 2> trong <biểu thức số 

1>   

  + Cú pháp:   =Trunc (<biểu thức số>) 

 Ví dụ:   Giả sử có 6 đội bóng được tổ chức theo thể thức thi đấu vòng tròn, mỗi 

đội đều thi đấu một trận với đội khác. Các bạn có thể sử dụng hàm Combin() để tính 

xem có bao nhiêu trận bóng đá cần tổ chức, bạn nhập công thức như sau: 

 =Combin(6,2), cho kết qủa là 15 

4.3.4. Hàm logic  

 1. Hàm AND() 

  + Chức năng: hàm cho kết quả là đúng khi tất cả các điều kiện trong danh 

sách đều đúng.   

  + Cú pháp:   =And(điều kiện 1, điều kiện 2) 

 2. Hàm OR() 

  + Chức năng: hàm cho kết quả là đúng khi ít nhất một điều kiện trong danh 

sách đều đúng.   

  + Cú pháp:   =Or(điều kiện 1, điều kiện 2) 

 3. Hàm NOT() 

  + Chức năng: hàm cho kết quả là đúng khi điều kiện sai.  Ngược lại, làm 

cho giá trị sai khi điều kiện là đúng. 

  + Cú pháp:   =Not(điều kiện) 

 4. Hàm IF() 
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  + Chức năng: hàm cho kết quả là <giá trị 1> nếu <biểu thức logic> là đúng, 

ngược lại kết quả 

nhận được là <giá trị 2>.   

  + Cú pháp:  =IF(<biểu thức logic>,<giá trị 1>,<giá trị 2> ) 

  Ví dụ:         =IF(diem>=5,”Đỗ”,”Truợt”)  

4.3.5. Hàm thống kê 

 1. Hàm COUNT() 

  + Chức năng: đếm tất các ô chứa giá trị là số trong danh sách.   

  + Cú pháp:   =COUNT(danh sách các giá trị) 

 2. Hàm COUNTA() 

  + Chức năng: đếm tất các ô trong danh sách chứa dữ liệu 

  + Cú pháp:   =COUNTA(danh sách các trị) 

 2. Hàm COUNTIF() 

  + Chức năng: đếm từng ô không trống thoả mãn tiêu chuẩn đã định. 

  + Cú pháp:   =COUNTIF(<Phạm vi chứa tiêu chuẩn>,<tiêu chuẩn>) 

 Ví dụ:  COUNTIF( B1:B6,”>=7”) đếm tất các ô từ B1:B7 có điểm >=7  

 3. Hàm RANK() 

+ Chức năng: tìm thứ bậc của trị số trong một phạm vi. 

+ Cú pháp:  = RANK(<giá trị số>, <phạm vi dãy số>,<0,1> ) 

- số 0 ( hoặc không ghi): thứ bậc được tính theo giá trị số giảm dần. 

- số 1: thứ bậc được tính theo giá trị số tăng dần. 

 4. Hàm SUMIF() 

+ Chức năng: cộng những ô thoả mãn điều kiện nào đó.  

+ Cú pháp:  = SUMIF(<cột 1>,<điều kiện>,<cột 2>)  

Trong đó:  <cột 1> là tham chiếu tới một dãy ô được kiểm tra theo một <điều kiện> nào 

đó đã cho trước,  <cột 2> là tham chiếu tới một dãy ô chứa giá trị tổng, <điều kiện> có 

thể là một số, một biểu thức, hay một chuỗi văn bản xác định ô nào đó cần tính tổng 

nhưng phải đặt trong nháy kép và cùng kiểu dữ liệu với kiểu dữ liệu trong, <cột 1>.  

Ví dụ:  Giả sử, bạn có bảng tính sau, sau đó bạn hãy tính tiền thưởng của đơn vị 

A. Tại ô E6, bạn nhập công thức =SumIf(C2:C5,”=A”,E2:E5), tương tự như vậy ta tính 

được cho đơn vị B, C. 

 

 A B C D E 

1 TT Họ tên Đơn vị Số công Tiền 

thưởng 

2 1 Lê Tuấn Đông A 28 560000 

3 2 Trần Anh Toàn C 25 125000 
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4 3 Trần Thị Lan A 17 85000 

5 4 Nguyễn Thanh 

Tú 

B 27 270000 

6      

 

4.3.6. Hàm tìm kiếm & tham chiếu 

 1. Hàm VLOOKUP() 

 + Chức năng: Thực hiện việc tìm kiếm trị x trên cột chỉ mục (cột đầu tiên) của 

bảng tham chiếu và cho kết quả tương ứng trong cột tham chiếu chỉ định. 

 + Cú pháp: 

VLOOKUP( x, Bảng t/c, cột tham chiếu, cách dò) 

 x : giá trị tìm kiếm có thể là một chuỗi hoặc một số hoặc toạ độ ô chứa dữ liệu số 

hay chuỗi hoặc biểu thức có kết quả là một giá trị hay chuỗi. 

 Bảng: Là một khối các ô, thường gồm nhiều hàng và nhiều cột. Cột bên trái luôn 

luôn chứa các trị để dò tìm, các cột khác chứa các trị tương ứng để tham chiếu.  

Cột tham chiếu: Là thứ tự của cột ( tính từ trái của bảng trở qua), cột đầu tiên của 

bảng là cột 1. 

 Cách dò: Là số 0 hoặc số 1, ngầm định là 1. 

 - Nếu cách dò là 1:   

   . Danh sách ở cột bên trái của bảng phải xếp theo thứ tự tăng dần. 

   . Nếu trị dò x nhỏ hơn phần tử đầu tiên trong danh sách, làm cho trị là #N/A ( 

bất khả thi ) 

   . Nếu trị dò lớn hơn phần tử cuối cùng trong danh sách, xem như tìm thấy ở 

phần tử cuối cùng. 

   . Nếu trị dò x đúng khớp với một phần tử trong danh sách ( không phân biệt chữ 

hoa hay thường nếu là chuỗi ), đương nhiên tìm thấy ở tại phần tử đó và cho trị là trị của 

ô nằm trong cột tham chiếu cùng hàng với phần tử này. 

 - Nếu cách dò là 0: 

   . Danh sách ở cột bên trái của bảng không cần thiết phải xếp theo thứ tự. 

   . Nếu trị dò x không đúng khớp với bất kỳ phần tử nào trong danh sách ( không 

phân biệt chữ hoa hay thường nếu là chuỗi ) hàm cho trị là #N/A ( bất khả thi ) 

   . Chỉ khi nào trị dò x đúng khớp với một phần tử trong danh sách ( không phân 

biệt chữ hoa hay chữ thường nếu là chuỗi ), mới cho trị là trị của ô nằm trong cột tham 

chiếu cùng hàng với phần tử này. 

 Ví dụ: Tính lương cho ba loại công lao động khác nhau, biết rằng, số tiền cho 

từng loại công lao động là: loại A: 20000 đồng/ công, loại B: 10000 đồng/công, loại C: 

5000đồng/công. Tiền lương được tính theo công thức: Tiền lương = số công  số tiền 

một công. 
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  Ta thực hiện như sau: 

 - Tạo bảng gồm 2 cột, cột A chỉ các loại công lao động (A,B,C) và cột B chỉ số 

tiền công tương ứng. 

 - Chọn ô E6, lập công thức: = VLOOKUP(C6,$A$1:$B$3,2,1)*D6 

Copy công thức này xuống các ô E7, E8,... 

 Ta có kết quả: 

 

 A B C D E 

1 A 20000    

2 B 10000    

3 C 5000    

4      

5 TT Họ tên Loại Số công Tiền 

6 1 Lê Tuấn Đông A 28 560000 

7 2 Trần Anh Toàn C 25 125000 

8 3 Trần Thị Lan D 17 85000 

9 4 Nguyễn Thanh 

Tú 

B 27 270000 

 

 Chú ý,  trong công thức ta dùng địa chỉ tuyệt đối $A$1:$B$3 để đảm bảo địa chỉ này 

không bị thay đổi trong quá trình Copy. 

 2. Hàm HLOOKUP() 

+ Chức năng:  Thực hiện việc tìm kiếm x trên dòng chỉ mục (dòng đầu tiên) của bảng 

tham chiếu và cho kết quả tương ứng trong dòng tham chiếu chỉ định. 

   + Hlookup(x, Bảng t/c, Hàng tham chiếu, Cách dò) 

 Mọi nguyên tắc hoạt động của hàm HLOOKUP này giống như hàm  VLOOKUP, 

chỉ khác là hàm VLOOKUP dò tìm ở cột bên trái, tham chiếu số liệu ở các cột bên phải, 

còn hàm HLOOKUP dò tìm ở hàng trên cùng, tham chiếu số liệu ở các hàng phía dưới.. 

3. Hàm ADDRESS()  

 + Cú pháp:  =Address(<dòng>,<cột>,<bt logic 1>,<bt logic 2>,<tên bảng tính>) 

 + Chức năng: dùng để tham chiếu tới một địa chỉ theo các số, trong đó <dòng>, 

<cột> là các số chỉ thứ tự của dòng và cột của ô cần tham chiếu. 

 - Nếu <bt logic 1> là True (đúng) thì ô tham chiếu sử dụng theo địa chỉ tuyệt đối. 

 - Nếu <bt logic 2> là True  thì địa chỉ là tuyệt đối theo dòng và cột. 

 - Nếu <bt logic 2> là False  thì địa chỉ là tuyệt đối theo địa chỉ R1C1 
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Bạn có thể chỉ định thêm tên bảng tính nếu cần tham chiếu sang một bảng tính 

khác. Nếu chỉ cần tham chiếu tới các ô trong bảng tính hiện thời thì không cần 

tham số này. 

Ví dụ:   =Address(3,2,True,True) kết quả là: $B$3, nếu bạn chỉ thị  

   =Address(3,2,True,False) thì kết quả nhận được là R3C2 

4. Hàm CHOOSE() 

  + Chức năng: dùng để lấy ra một giá trị trong danh sách các giá trị được chỉ định 

  + Cú pháp:  = Choose(<bt số>,<danh sách giá trị>) 

Trong đó: <bt số> là vị trí cần lấy giá trị trong danh sách các giá trị. 

Ví dụ: giả sử bạn có bảng tính: nếu trong ô C5, bạn nhập công thức: 

 

 

 A B  = Choose(2,B1,B2,B3,B4) 

1  Bàn Bạn sẽ nhận được giá trị là: Ghế 

2  Ghế Bạn cũng cần lưu ý rằng, nếu bạn thay danh 

sách  

3  Tủ các giá trị sẽ bị báo lỗi. Cụ thể là bạn đưa vào 

công 

4  Bàn là Thức =Choose(2,B1:B4) thì không hợp lệ. 

 

5. Hàm MATCH() 

  + Chức năng: đưa ra vị trí tìm thấy (hoặc gần đúng nếu không tìm thấy) của giá 

trị cần tìm thấy trong <vùng tìm kiếm>. 

   + Cú pháp:   = MATCH(<giá trị tìm kiếm>,<vùng tìm kiếm>,<dạng>) 

Trong đó:  

  <giá trị tìm kiếm> là giá trị dạng số hoặc ký tự được dùng để tìm kiếm trong 

<vùng tìm kiếm> 

 <dạng> xác định cách thức tìm kiếm và phải là một trong 3 giá trị 1, 0 và -1 (đay 

là giá trị ngầm định nếu bạn không chỉ thị tham số này). 

6. Hàm INDEX() 

 a. Dạng tìm kiếm theo tham chiếu 

  + Cú pháp:  =INDEX(<vùng tìm kiếm>,<dòng>,<cột>) 

  + Chức năng: đưa ra giá trị của một ô trong <vùng tìm kiếm> được xác định  bởi 

<dòng> và <cột> 

 b. Dạng tìm kiếm theo dãy 

  + Cú pháp:  =INDEX(<dãy>,<dòng>,<cột>) 

  + Chức năng: đưa ra giá trị của một ô trong <vùng tìm kiếm> được xác định  bởi 

<dòng> và <cột> 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 94 

Ví dụ: giả sử ta có bảng tính sau:  nếu bạn nhập công thức   

 =INDEX(A2:E5,1,1) sẽ cho kết quả:    Lê Tuấn Đông 

 

 A B C D E 

1 TT Họ tên Loại Số công Tiền 

2 1 Lê Tuấn Đông A 28 560000 

3 2 Trần Anh Toàn C 25 125000 

4 3 Trần Thị Lan D 17 85000 

5 4 Nguyễn Thanh 

Tú 

B 27 270000 

 

 =INDEX({10,20,30,40,50,60}) sẽ cho kết quả:   20   

Ví dụ áp dụng các hàm Match() và Index(): giả sử ta có bảng tính như trang sau: 

 

 A B C D E F G 

1  Danh mục vật tư   

2  Mã VT Tên VT ĐV tính Đơn giá   

3  V001 Cassette Chiếc 300,000   

4  V002 Bia Hà nội  6,000   

5  V003 Bàn là  100,000   

6 Danh sách vật tư 

7 Ngày Mã VT Tên VT ĐV tính Đơn giá   

8 1/8/98 V001      

9 2/8/98 V002      

        

 

Dựa vào Mã vật tư, bạn hãy đưa các thông tin tương ứng của từng loại vật tư như: 

Tên vật tư, Đơn vị tính, Đơn giá; trong Danh mục vật tư vào Danh sách nhập vật tư. 

Tại ô C8 (trong cột Tên vật tư), các bạn nhập công thức: 

=INDEX(B3:E5,Match(B8,B3:E5,0),2). Bạn sẽ nhận được kết quả là: Cassette. Trong 

đó hàm Match(B8,B3:E5,0) cho kết quả là 1, bởi vì tìm thấy giá trị của ô B8 (V001) 

nằm ở trong dòng 1 của vùng B3:B5 và như vậy, công thức trở thành: 

 = Index(B3:B5,1,2); kết quả nhận được là ô trên dòng 1 cột 2 của vùng B3:B5, 

đây chính là ô C3 như nói ở trên. Tương tự như vậy, bạn sao chép công thức này sang 
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các ô còn lại của cột Tên vật tư. Đối với cột Đơn vị tính, bạn nhập công thức:  

=Index(B3:E5,Match(B8,B3:E5,0),3). 

 Trong công thức trên, số 3 để chỉ việc xác định ô cần lấy giá trị trên ô thứ ba của 

vùng B3:B5, đây chính là cột ĐV tính. 

4.3.7. Một số hàm để phân tích tài chính  

 Excel cung cấp rất nhiều hàm nhưng chỉ đề cập đến ba hàm tài chính hay được sử 

dụng nhất là PMT, FV và RATE. Sử dụng các hàm này bạn có thể tính được số nợ phải 

trả, giá trị đầu tư trong tương lai và lãi suất của đầu tư. 

 1. Hàm PMT() 

   + Chức năng: Hàm PMT tính thanh toán định kỳ cần thiết để trả dần nợ vay sau số kỳ 

hạn đã định.  

   + Cú pháp: =PMT(rate, number of periods, present value, future value, type) 

Trong đó:  rate: mức lãi suất, number of periods: thời hạn phải trả, present value: 

giá trị hiện tại, future value: giá trị tương lai, type: thanh toán đầu kỳ nếu type=1, nếu 

type=0 thanh toán cuối kỳ). 

   + Ví dụ:  bạn vay một khoản nợ là 10000$ trong 3 năm với lãi suất là 9% năm. Số nợ 

phải trả hàng tháng là bao nhiêu? 

Đưa con trỏ chuột vào ô bảng tính và gõ: = PMT(9%/12,36,10000) kết quả sẽ trả về 

(-318.00$)  

 2. Hàm FV() 

   + Chức năng : tính giá trị tại thời điểm thanh toán trong tương lai. 

   + Cú pháp:  =FV(rate, number of periods, payment, present value,type) 

Trong đó:  rate: mức lãi suất, number of periods: thời hạn đầu tư, payment: mức 

đầu tư cho mỗi khoảng thời gian (cho 1 năm, hoặc 1 tháng), present value: giá trị hiện 

tại,type: thanh toán đầu kỳ nếu type=1, nếu type=0 thanh toán cuối kỳ). 

    + Ví dụ: bạn gửi số tiền ban đầu là 2000$  với lãi suất 10% năm. Sau 30 năm bạn sẽ 

có một số tiền là bao nhiêu? 

 3. Hàm NPER()  

   + Chức năng : tính số kỳ cần thiết tương lai. 

   + Cú pháp:  =NPER(rate, pmt, pv, fv,type) 

Trong đó:  rate: mức lãi suất, pmt: sô tiền trả cho mỗi kỳ, pv: giá trị hiện tại, fv: 

giá trị tương lai, type: thanh toán đầu kỳ nếu type=1, nếu type=0 thanh toán cuối kỳ). 

    + Ví dụ: giả sử bạn vay một khoản tiền là 100000 với lãi suất 8% năm. Bạn có thể trả 

dần 1000 trong một tháng và bạn muốn biết trong thời gian bao nhiêu tháng?  

Đưa con trỏ chuột vào ô bảng tính và gõ: = Nper((8/12)%,-1000,100000) kết quả sẽ 

trả về 165.34 
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 4. Rate()  

   + Chức năng : Hàm rate() cho phép bạn xác định mức lợi nhuận của một khoản đầu tư 

phát sinh thanh toán định kỳ hoặc thanh toán gộp. 

   + Cú pháp:  =RATE(number of periods, payment, present value, future value, type, 

guess) 

Trong đó:  number of periods: thời hạn đầu tư, payment: mức thanh toán cho 

hàng năm hoặc hàng tháng), present value: mức đầu tư ban đầu, guess: đối số tuỳ ý cho 

Excel điểm khởi đầu để tính toán lãi suất, nếu bạn bỏ qua Excel bắt đầu ở 0.1 (10%)). 

   + Ví dụ: Giả sử bạn đang xem xét khoản đầu tư sẽ mang lại cho bạn món thanh toán 

hàng năm là 1000$ trong 5 năm, khoản đầu tư này tốn 3000$. Để xác định mức lợi 

nhuận hàng năm trên khoản đầu tư, bạn gõ vào công thức:    =RATE(5,1000,-3000) trả 

về giá trị 20% mức lợi nhuận trên khoản đầu tư này. 

5. Sử dụng lệnh Goal Seek để dự báo: lệnh Goal Seek tìm một giá trị nào đó 

nhằm tạo ra một kết quả mong muốn, ví dụ như lượng đĩa CD phải bán được để đạt 

được một doanh số 1000000$. Để sử dụng Goal Seek, hãy xác lập worksheet chứa: 

- Một công thức để tính toán giá trị đích 

- Một ô trống chứa giá trị cần tìm 

- Các giá trị cần thiết khác cho công thức 

Ô trống được tham chiếu đến trong công thức và hoạt động như một biến để Excel thay 

đổi. Để dự đoán bằng cách sử dụng lệnh Goal Seek, cách làm như sau: 

1. Xây dựng worksheet chứa một công thức, một ô biến trống sẽ chứa giải pháp và các 

dữ liệu cần thiết cho phép tính toán. Ví dụ: để xác định số lượng li cà phê phải bán giá 

1.75$ nhằm đạt được doanh số 30000$. 

2. Trong worksheet, chọn một chứa công thức (trong hộp thoại Goal Seek ô đó được gọi 

là Set Cell) 

3. Chọn Goal Seek từ lệnh đơn Tools, hộp thoại xuất hiện. 

4. Nhấn Tab rồi gõ vào giá trị đích muốn đạt được trong mục To Value (gõ vào giá trị 

30000). 

5. Nhấn Tab để chọn mục By Changing Cell, bạn có thể dời hộp thoại Goal Seek đi nơi 

khác nếu cần thiết để chọn ô biến . 

6. Chọn OK để tìm giải pháp doanh số. Lúc này, hộp thoại sẽ hiển thị thông báo sau khi 

đã kết thúc quá trình lặp, và kết quả của dự đoán sẽ được hiển thị trên worksheet. Như 

vậy, lệnh Goal Seek cho biết cần bán 17.143 ly cà phê với giá trị 1.75$ để đạt doanh số 

30000$. 

7. Chọn OK để đóng hộp thoại Goal Seek lại. 

6. Sử dụng Solver để cân đối giữa số lượng và giá cả 

 Khi vấn đề cần dự đoán cần sử dụng nhiều biến, bạn nên sử dụng trình bổ sung 

Solver để phân tích kịch bản. Để  minh hoạ cách sử dụng Solver, lấy ví dụ một tiệm cà 

phê có bán 3 loại thức uống: cà phê thường, cà phê latte và cà phê mocha. Giá mỗi li 
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của chúng là 1.25$, 2$ và 2.25$. Hiện bạn chưa biết được loại cà phê nào đưa lại lợi 

nhuận nhiều hơn. Muốn làm được điều này, trước hết phải xây dựng được ô đích cho 

mục đích của vấn đề (ví dụ một công thức tính doanh thu lớn nhất ) - và gán một hay 

nhiều ô biến để Solver thay đổi nhằm đạt được mục đích của bạn. Bảng tính còn có thể 

chứa các giá trị và công thức khác sử dụng ô đích và các ô biến. Mỗi ô biến đều được ô 

đích sử dụng thì Solver mới có thể làm được (ô đích phải phụ thuộc vào các ô biến). 

Bảng dưới đây, ô G4 là ô đích để tính tổng lợi nhuận của 3 loại cà phê trên. Cả 3 dòng 

đều quy về ô G4, chúng cho biết công thức trong ô G4 phụ thuộc như thế nào đối với 3 

phép tính toán kia. 3 ô biến D5, D9, D13 - đó là 3 giá trị bạn muốn Solver cho biết khi 

nó tìm giải pháp tối ưu nhằm thu được lợi nhuận tối đa hàng tuần. Từ G11:G13 là danh 

sách các hằng sẽ sử dụng nhằm dự đoán. Ví dụ như chỉ có thể bán 500 li cà phê mỗi 

tuần, trong đó số li cà phê mocha tối đa là 125 (vì còn phụ thuộc vào sô cô la để chế 

biến thêm vào cà phê mocha), tức 2 loại cà phê kia tối đa là 350 li. Bảng tính phải chứa 

các ô để chứa các giá trị hằng (trong ví dụ này là các ô g6:g8).  

 Muốn chạy Solver , bạn nhấn chuột vào ô đích - là ô chứa công thức dựa trên các 

ô biến muốn Solver giải quyết ( ô G4). Từ thực đơn Tools, chọn Solver, một hộp thoại 

xuất hiện. Vì ô đích đã chọn nên mục Set Cell Target sẽ chứa địa chỉ này. Chọn Max 

vào mục Equal to  chọn mục By Changing Cells  chọn từng ô biến, 3 ô trống D5, 

D9, D13 có nhiệm vụ hiển thị số li cà phê cho từng loại  nhấn lên nút Add để đưa 

hằng thứ nhất vào hộp thoại Constraint , nhấn lên ô G8 chọn  G11  nhấn lên nút Add 

để đưa hằng thứ 2, nhấn lên ô G7 chọn  G12  nhấn lên nút Add để đưa hằng thứ 3 , 

nhấn lên ô D13 chọn  G13  chọn OK để đưa cả 3 hằng vào hộp thoại Solver  nhấn 

Solver để tính toán kết quả. 

 A B C D E F G 

1        

2        

3        

4   Giá mỗi li cà phê 

thường là 

1.25$  Tổng lợi 

nhuận  

=D6+D10+D1

4 

5   Số li sẽ bán được là   Cà phê 

thường 

=D5 

6   Tổng =D4*D5  Mocha+Latt

e 

=D19+D13 

7      Tổng 3 loại =D5+D9+D13 

8   Giá mỗi li cà phê latte 2.00$    

9   Số li sẽ bán được là     

10   Tổng =D8*D9    

11      Tối đa cả 3 500 
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loại 

12   Giá mỗi li cà phê 

mocha 

2.25$  Tối đa 

M+La 

350 

13   Số li sẽ bán được là   Tối đa 

Mocha 

125 

14   Tổng =D12*D1

3 

   

15        

 

 Một số ví dụ ứng dụng để giải hệ phương trình 3 ẩn số 
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5.1. Làm việc với các bảng tính trong tập tin workbook 

     Tập tin Workbook trong Excel là một tập hợp của những loại bảng tính (có thể chứa 

từ 1 đến 255 bảng tính) khác nhau như: dữ liệu, đồ thị, Macro,... và thường có liên quan 

với nhau. 

     Theo thông số định sẵn của Excel thì trong một Workbook có 16 bảng tính dữ liệu 

(Worksheet) và được đặt tên là Sheet 1 cho đến Sheet 16. Tên bảng tính được biểu thị 

trên những Tab ở cạnh dưới, bên trái cửa sổ Excel. 

     Khi cần làm việc đến bảng tính nào, bạn chỉ cần di chuyển vào Click vào Tab chứa 

tên bảng tính đó(Tab chứa tên bảng tính hiện hành sẽ được làm đậm màu để phân biệt). 

     Để di chuyển đến những bảng tính khác trong Workbook, bạn chọn các nút: (bảng 

tính đầu), (bảng tính cuối), (bảng tính kế cận). 

 Trong tập tin Workbook, bạn có thể: 

 * Chèn thêm hoặc xoá bớt những bảng tính. 

 * Đổi tên bảng tính (chiều dài tối đa là 31 ký tự). 

 * Sao chép hoặc di chuyển những bảng tính trong phạm vi Workbook hoặc  

đến những tập tin Workbook khác 

* Che giấu những bảng tính. 

  Mở nhiều cửa sổ cho một tập bảng tính 

Bạn muốn hiển thị nhiều cửa sổ bảng tính cần thực hiện trên cùng một màn hình 

để dễ quan sát: 

 + Chọn lệnh [Menu] Windows > New Windows. 

 + Lựa chọn bảng tính cần hiển thị trên Tab Sheet. 

 + Chọn lệnh [Menu] Windows > Arrange, chọn nút Tiled và OK. 

3. Nhập chỉnh sửa dữ liệu trong bảng tính hiện hành. 

4. Để gỡ bỏ việc liên kết nhóm bạn chỉ cần Click vào một bảng tính khác ngoài nhóm. 

  Phân trang thành các khung cửa sổ 

Từ menu Window chọn lệnh Split. Sau khi bạn đã tách cửa sổ, lệnh Split trên menu 

Window biến thành Remove Split, trả cả hai vạch phân chia về vị trí mặc định. Muốn di 

chuyển từ khung cửa sổ này sang cửa sổ khác bằng bàn phím, bạn nhấn F6. Sau khi bạn 

tách cửa sổ thành những khung cửa sổ, bạn có thể giữ cố định khung trái, khung trên 

hoặc cả hai bằng lệnh Freeze Panes trên menu Window.  

5.1.1. Chèn thêm bảng tính vào Workbook 

a. Chèn bảng tính chứa dữ liệu 
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 1. Lựa chọn một (hoặc nhóm) bảng tính trong Workbook. 

 * 1 bảng tính: Click vào Tab chứa tên bảng tính cần lựa chọn. 

 * 1 nhóm bảng tính kế cận: Click vào Tab chứa tên bảng tính cần lựa chọn  đầu 

tiên, nhấn phím Shift Click vào Tab chứa tên bảng tính cần lựa chọn cuối cùng. 

 * 1 nhóm bảng tính không liền lạc: nhấn Ctrl trong khi Click vào Tab chứa trên 

bảng tính cần lựa chọn. 

  * Toàn bộ bảng tính: [Shortcut] Select All Sheets. 

 2. Chọn lệnh [Menu] Insert > Worksheet hoặc nhấn phím Shift-F11. 

 Excel sẽ chèn thêm những bảng tinh mới ở bên trái của phạm vi lựa chọn 

b. Chèn bảng tính đồ thị 

 1. Lựa chọn phạm vi dữ liệu cần minh hoạ trên bảng tính. 

 * Click vào trên bảng tính và Drag trên phạm vi chứa dữ liệu cần minh  

 hoạ. 

 2. Chọn lệnh [Menu] Insert >chart và chọn As New Sheet (Hoặc nhấn phím F11). 

  Excel sẽ chèn thêm bảng tính đồ thị ở bên trái của bảng tính dữ liệu. 

Lưu ý: 

 * Khi cần chèn thêm những loại bảng tính khác, bạn thực hiện như sau: 

 1. Chọn lệnh [Shortcut] Insert. 

 2. Chọn loại bảng tính cần chèn trên khung New. 

 3. Chọn nút OK. 

5.1.2. Sao chép hoặc di chuyển những bảng tính trong Workbook 

 1. Sử dụng Mouse 

 1. Lựa chọn 1 (hoặc nhóm) bảng tính Workbook. 

 2. Chọn: 

 * Drag đến vị trí mới: để di chuyển bảng tính lựa chọn vào vị trí mới: 

 * Nhấn Ctrl trong khi Drag vào vị trí mới: để sao chép bảng tính lựa chọn đến vị trí 

ấn định. 

 Excel sẽ xuất hiện hình tương trang bảng tính và một hình tam giác nhỏ phía 

trên Tab để chỉ bảo vị trí thực hiện. 

 2. Sử dụng Menu lệnh 

 1. Lựa chọn một (hoặc nhóm) bảng tính trong Workbook. 

 2. Chọn lệnh [Menu] Edit > Move or Copy Sheet (hoặc [Shortcut] Move or Copy 

Sheet). 

 Xuất hiện hộp đối thoại Move or Copy 

3. Lựa chọn vị trí mới trong khung Before Sheet. 

4. Chọn: 

 * Nút OK: để di chuyển bảng tính lựa chọn vào vị trí mới. 

 * Bật thông số Create A Copy và chọn nút OK: để sao chép bảng tính lựa 

chọn đến vị trí ấn định. 
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5.1.3. Sao chép (hoặc di chuyển) những bảng tính từ Workbook hiện hành vào tập 

tin Workbook khác 

     a. Sao chép hoặc di chuyển những bảng tính từ Workbook hiện hành vào tập tin 

Workbook đã tạo 

 +) Sử dụng Mouse: 

 1. Đọc và hiện thị những tập tin Workbook cần thực hiện (tập tin nguồn và tập tin 

đích) trên cùng một màn hình. 

 2. Lựa chọn 1 (hoặc nhóm) bảng tính trong tập tin Workbook nguồn. 

 3. Chọn: 

 * Drag đến vị trí mới: để di chuyển bảng tính lựa chọn vào vị trí mới: 

 * Nhấn Ctrl trong khi Drag vào vị trí mới: để sao chép bảng tính lựa chọn đến vị trí 

ấn định. 

 Excel sẽ xuất hiện  hình tương trang bảng tính và một hình tam giác nhỏ phía 

trên Tab để chỉ bảo vị trí thực hiện. 

b) Sử dụng Menu lệnh. 

 1. Đọc lại tập tin Workbook cần thực hiện (tập tin nguồn và tập tin đích). 

 2. Lựa chọn một (hoặc nhóm) bảng tính trong tập tin Workbook nguồn. 

 3. Chọn lệnh [Menu] Edit > Move or Copy Sheet (hoặc [Shortcut] Move or Copy 

Sheet). 

 Xuất hiện hộp đối thoại Move or Copy. 

4. Lựa chọn tập tin Workbook đích trên khung To Book. 

5. Lựa chọn vị trí mới trong khung before sheet: 

6. Chọn: 

 * Nút OK: để di chuyển bảng tính lựa chọn vào vị trí mới. 

 * Bật thông số Create A Copy và chọn nút OK: để sao chép bảng tính lựa 

chọn đến vị trí ấn định. 

b. Sao chép hoặc di chuyển những bảng tính từ Workbook hiện hành vào tập tin 

Workbook mới: 

 1. Lựa chọn một (hoặc nhóm) bảng tính trong tập tin Workbook nguồn. 

 2. Chọn lệnh [Menu] Edit > Move or Copy Sheet (hoặc [Shortcut] Move or Copy 

Sheet). 

 Xuất hiện hộp đối thoại Move or Copy. 

3. Chọn [New book] (tập tin đích) trên khung To book. 

4. Chọn: 

 * Nút OK: để di chuyển bảng tính lựa chọn vào vị trí mới. 

 * Bật thông số Create A Copy và chọn nút OK: để sao chép bảng tính lựa 

chọn đến vị trí ấn định. 

Lưu ý: 
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 Khi sử dụng Mouse bạn chỉ cần Drag tên bảng tính lựa chọn ra khỏi Workbook 

hiện hành. 

5.1.4. Đổi tên bảng tính trong Workbook 

 1. Lựa chọn bảng tính cần thực hiện. 

 2. Chọn lệnh [Menu] Format > Sheet > Rename  (hoặc [Shortcut] Rename hay 

Double Click  trên Tab chứa tên bảng tính). 

 Xuất hiện hộp đối thoại Rename Sheet. 

3. Nhập tên bảng tính mới (có giới hạn 31 kí tự). 

4. Chọn nút OK. 

5.1.5. Xoá những bảng tính trong Workbook 

 1. Lựa chọn một (hoặc nhóm) bảng tính cần thực hiện. 

 2. Chọn lệnh [Menu] Edit > Delete Sheet (hoặc [Shortcut] Delete). 

 Xuất hiện hộp thông báo. 

3. Chọn: 

 * Nút OK: để xác nhận việc xoá những bảng tính lựa chọn. 

 * Nút Cancel: để huỷ bỏ lệnh xoá bảng tính. 

 

5.1.6. Che giấu/hiện lại bảng tính trong Workbook 

  a. Che giấu những bảng tính trong Workbook 

 1. Lựa chọn một (hoặc nhóm) bảng tính cần thực hiện. 

 2. Chọn lệnh [Menu] Edit > Format > Sheet > Hide. 

  b. Hiện lại những bảng tính trong Workbook 

 1. Chọn lệnh [Menu] Edit > Format > Sheet > Unhide. 

 Xuất hiện hộp đối thoại Unhide. 

2. Chọn tên bảng tính cần hiển thị trên khung Unhide Sheet. 

3. Chọn nút OK. 

5.2. Các tính năng tiện ích 

 1. Thêm chú giải cho ô 

 Excel cho phép bạn gán những chú giải vào ô lựa chọn trên bảng tính. Nội dung 

chú giải này có thể là chuỗi dữ liệu (dùng để mô tả hay giả thích về dữ liệu trong ô) 

 Trong bảng tính những chú giải này không xuất hiện chung với giữ kiện trong ô, 

nhưng bạn có thể xem lại trên hộp đối thoại. Khi cần thiết, bạn có thể in chung với 

những dữ liệu trên bảng tính. Ô chú giải được đánh dấu bằng điểm nhỏ màu đỏ ở góc 

phải trên của ô. Để hiển thị trong worksheet, hãy dừng chuột trên ô cho đến khi chú giải 

được xuất hiện. 
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 Nhớ là chú giải tồn tại độc lập với nội dung trong ô, không có sự chung đụng ở 

đây. Để xoá ghi chú, hãy chọn ô chứa chú giải trên worksheet, chọn clear từ lệnh đơn 

Edit rồi chọn Comments từ lệnh đơn con clear. 

 2. Kiểm tra lỗi (spell checking) 

 Trước khi in hoặc lưu dữ liệu trên bảng tính vào đĩa, bạn nên sử dụng lệnh 

Spelling của Excel để kiểm tra lỗi nhằm phát hiện các sai sót (nếu có) trong quá trình 

nhập liệu Excel sẽ kiểm tra toàn bộ dữ liệu (các từ, chữ) trong bảng tính hiện hành kể cả 

những dữ liệu trong hộp Text box và biểu đồ của trang in, hoặc đồ thị hay chỉ trên một 

phạm vi chỉ định như một khối, một từ. 

 Excel sẽ phát hiện lỗi ở những từ có trên phạm vi kiểm tra nhưng không có trong 

phạm vi đối chiếu (là những từ có trong tập tin tự điều chỉnh hay bộ nhớ). 

 3. Gõ tắt (tương tự như Word). 

  Ngoài chức năng gõ tắt, Excel còn có AutoComplete để giúp bạn đỡ được công 

đánh máy cũng như tăng độ chính xác của mục nhập. Bạn kích hoạt AutoComplete như 

sau: chọn Options từ menu Tools, nhấp tab EDIT, và nếu như đặc tính này chưa hoạt 

động, hãy chọn tuỳ chọn Enable AutoComplete For Cell Values (theo mặc định là được 

kích hoạt). 
 

 4. Kiểm toán và giải thích bảng tính 

 Excel có một số đặc tính mạnh mẽ và linh hoạt, giúp bạn kiểm toán, gỡ rối bảng 

tính và giúp bạn giải thích công việc của mình. Muốn làm được việc này, bạn chọn 

Auditing trên menu Tools, nhấp lệnh Show Auditing Toolbar, lúc này thanh công cụ 

Auditing xuất hiện chứa các nút kiểm soát công cụ truy nguyên ô (cell tracer) và chú 

giải ô. 

 Khi sử dụng tính năng Auditing Excel sẽ tự động đặt những đường mũi tên và các 

khung mũi tên và các khung bao quanh các ô phụ thuộc để dễ dàng theo dõi mỗi quan 

hệ của những ô chứa công thức hay những ô bị lỗi với những ô phụ thuộc trong bảng 

tính. 

 

a. Theo dõi những ô phụ thuộc vào công thức trong ô hiện hành 

1.  Di chuyển ô hiện hành vào ô chứa công thức cần theo dõi. 

 Nếu ô hiện hành không phải là công thức thì Excel sẽ xuất hiện thông báo lỗi. 

2.  Chọn lệnh [Menu] Tools > Auditing. 

3.  Chọn lệnh Trace Precedents (hoặc nút trên Toolbar Auditing). 

 Xuất hiện đường mũi tên (bắt đầu từ ô phụ thuộc đầu tiên, với đầu tên hướng 

về ô chứa công thức) và một khung bao quanh các ô phụ thuộc. 

b. Theo dõi vè sự phụ thuộc của ô hiện hành với những ô công thức 

1.  Di chuyển ô hiện hành vào ô cần theo dõi . 
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2.  Chọn lệnh [Menu] Tools > Auditing 

3.  Chọn lệnh Trace Precedents (hoặc nút trên Toolbar Auditing). 

 Xuất hiện những đường mũi tên (bắt đầu từ ô hiện hành với đầu tên, với đầu 

tên hướng về những  ô chứa công thức). 

c. Theo dõi ô bị lỗi 

1.  Di chuyển ô hiện hành vào ô cần theo dõi . 

 Nếu ô hiện hành không phải là ô bị lỗi thì Excel sẽ xuất hiện ô bị lỗi. 

2.  Chọn lệnh [Menu] Tools > Auditing. 

3.  Chọn lệnh Trace Error (hoặc nút trên Toolbar Auditing). 

 Xuất hiện đường mũi tên (bắt đầu từ ô phụ thuộc  đầu tiên, với đầu tên hướng 

về những  ô bị lỗi). 

d. Xoá các đường mũi tên và khung bao quanh 

1.  Lựa chọn ô cần thực hiện. 

2.  Chọn lệnh [Menu] Tools > Auditing. 

3.  Chọn lệnh Remove All  Arrow (hoặc nút trên Toolbar Auditing): 

Lưu ý: 

 Khi chọn thông số Hide All trong Tab View của lệnh Tools > Options thì 

những đường mũi tên và khung bao quanh sẽ không xuất hiện. 

 Double Click vào đầu hoặc cuối mũi tên để lựa chọn ô hiện hành hoặc những 

ô phụ thuộc. 

Khi đóng Workbook, Excel sẽ không lưu lại các đường mũi tên và khung bao quanh. 

 5. Thanh nút lệnh (thanh công cụ Toolbar) 

 Toolbar (thanh công cụ hoặc thanh nút lệnh) là thanh chứa các nút hình tượng 

thay thế cho những lệnh macro cần thực hiện thường xuyên theo từng nhóm lệnh 

(nhưng chỉ có thể sử dụng khi có thiết bị mouse). Khi di chuyển con trỏ Mouse đến nút 

Tool nào trên Toolbar thì Excel sẽ hiển thị một mô tả ngắn gọn về công dụng của nút đó 

(Tool Tip) và một dòng thông báo trên dòng tình trạng. 

 Bạn có thể di chuyển Toolbar đến những cạnh của bảng tính như các thanh Menu 

lệnh hoặc vào một vị trí bất kỳ trên bảng tính. 

 Ngoài thanh công cụ chuẩn (Standard Toolbar) và Formatting Toolbar đang hiển 

thị trên màn hình Excel còn tạo thêm một số Toolbar khác như: Query and Pivot. Chart. 

Drawing. Tip Wizard, Form Stop Recording, Visual Basic... 

 Bạn dễ dang thực hiện việc tạo mới các Toolbar khác hoặc chỉnh sửa thay đổi 

những nút Tool trên những Toolbar sẵn có. 

 a. Bật/Tắt hiển thị, di chuyển những Toolbar trên màn hình 

  + Hiển thị những Toolbar trên màn hình 
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1. Chọn lệnh [Menu] Views > Toolbar... (hoặc di chuyển vào một Toolbar đang 

có trên màn hình và Click nút Phải Mouse). 

 Excel xuất hiện hộp đối thoại Toolbar (hoặc khung liệt  kê các Toolbar). 

Những Tool bar đang hiển thị trên màn hình sẽ được đánh dấu để phân biệt. 

2. Click trên những Toolbar cần hiển thị trên màn hình. 

3. Chọn những thông số khi cần thiết. 

* Color Toolbar: Khi cần có những màu sắc trên những nút Tool. 

* Large Buttons: Làm lớn các nút Tool. 

* Show ToolTips: Hiển thị mô tả ngắn về công dụng của nút Tool. 

4. Chọn nút OK. 

+ Đóng (tắt)Toolbar trên màn hình 

Chọn một trong những cách thực hiện sau: 

* Click trên Control box của Toolbar cần tắt. 

* Thực hiện lại các bước lệnh 1,2,3  

* Right- Click trên Toolbar bất kỳ sau đó click trên Toolbar cần tắt. 

+. Di chuyển Toolbar 

 Drag trên thanh tiêu đề (hoặc ở những khoảng trống)của Toolbar cần thực hiện 

đến vị trí mới  

hoặc Double click trong Toolbar để tự động chuyển Toolbar về vị trí ban đầu). Bạn có 

thẻ di chuyển Toolbar đến vị trí bất kỳ (hoặc vào các cạnh) của bảng tính. 

b. Tạo mới xoá, thay đổi Toolbar 

+. Tạo mới Toolbar 

 1. Chọn lệnh :[Menu] Views > Toolbar...(hoặc di chuyển vào một Toolbar đang 

có trên màn hình và click nút phải Mouse). 

 Excel xuất hiện hộp đối thoại Toolbars (hoặc khung liệt kê các Toolbar). 

2. Nhập tên cho Toolbar cần tạo trên khung Toolbar Name. 

3. Chọn nút Customize. 

 Xuất hiện hộp đối thoại Customize và Toolbar vừa đặt tên. 

4. Chọn nhóm Toolbar trên khung Categories. 

 Xuất hiện toàn bộ những nút lệnh có trong nhóm Tool lựa chọn trên khung 

Buttons. 

5. Chọn: 

* Xem công dụng của nút Tool trên dòng tình trạng: 

- Click vào nút Tool cần xem trên khung Buttons. 

* Bổ sung nút lệnh vào Toolbar (hoặc tạo Toolbar mới theo số thứ tự thực hiện). 

- Drag những nút Tool lựa chọn trên khung Buttons vào trong những Toolbar 

đang hiển thị hoặc vào ô bất kỳ trên bảng tính. 

* Xoá những nút Tool không cần thiết trong Toolbar 
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- Drag những nút lệnh không cần thiết ra ngoài những Toolbar đang hiển thị hoặc 

vào ô bất kỳ trên bảng tính. 

6. Chọn nút Close 

+. Xoá những Toolbar tự tạo hoặc trở về định dạng ban đầu với những Toolbar 

tạo sẵn của Excel. 

 1. Chọn lệnh: [Menu] Views > Toolbar...(hoặc di chuyển vào một Toolbar đang 

có trên màn hình và click nút phải Mouse) 

 Excel xuất hiện hộp đối thoại Toolbars (hoặc khung liệt kê các Toolbar). 

2. Click vào Toolbar cần xoá. 

3. Chọn nút . 

* Delete: Để xoá những Toolbar tự tạo. 

* Reset: Để khôi phục lại định dạng mặc nhiên ban đầu với những Toolbar da 

excel tạo ra. 

4. Chọn  nút OK. 

 c. Chỉnh sửa / thay đổi các nút Tool  trên Toolbar 

 1. Hiển thị Toolbar cần thực hiện trên màn hình. 

 2. Chọn lệnh :[Menu] Views > Toolbar và chọn nút Customize (hoặc Right-Click 

trên một Toolbar  bất kỳ và chọn Customize). 

 Xuất hiện hộp đối thoại Customize 

3. Di chuyển và Right- Click vào nút Tool trên Toolbar cần thực hiện. 

 Xuất hiện Menu phụ. 

4. Chọn. 

* Copy Button Image: sao chép hình ảnh nút Tool hiện hành vào Clipboard. 

 * Paste Button Image :sao chép vật thể trong Clipboard vào nút Tool hiện hành. 

* Reset Button Image : trở về hình dạng nút Tool nguyên thuỷ. 

* Edit Tool Face: chỉnh sửa hình ảnh nút Tool. 

* Assign Macro: gán macro vào nút lệnh. 

5. Chọn nút Close. 

Lưu ý: 

 * Khi xuất hiện hộp đối thoại Customize, bạn có thể dùng Mouse để thay đổi các 

nút Tool  trên Toolbar như sau                                     : 

 Xoá nút Tool: Drag nút Tool ra khỏi Toolbar. 

 Di chuyển nút Tool: Drag nút tool đến vị trí mới trong Toolbar. 

Sao chép nút Tool: Nhấn phím Ctrl trong khi Drag nút Tool đến vị trí cần sao chép trên 

Toolba 

 6. Macro 

a. Khái niệm 
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 Macro là một tập hợp các lệnh tự động hoá các thao tác phải lặp đi lặp lại. Macro 

giống như chương trình máy tính, nhưng chúng chạy hoàn toàn trong Excel.  

Có 2 cách tạo macro: ghi macro hoặc xây dựng macro bằng cách nhập các câu 

lệnh vào một trang có tên là Modul. muốn nhập các câu lệnh vào Modul, bạn vận dụng 

ngôn ngữ lập trình Microsoft Visual Basic là một ngôn ngữ mạnh và ngày càng trở nên 

phổ biến trong chương trình ứng dụng Microsoft Windows và Macintosh, nó có những 

ưu thế hơn hẳn ngôn ngữ lập trình Macro khác. 

b. Cách ghi một macro 

 Thay vì gõ một ký tự, bạn có thể yêu cầu Excel tạo Macro bằng cách ghi lệnh 

menu, phím gõ và các hoạt động cần thiết khác, để hoàn thành tác vụ. 

 Sau khi xong chuỗi hoạt động, bạn chạy Macro thi hành lại tác vụ. Đúng như bạn 

mong đợi, khả năng “phát lại” rất hữu ích với những Macro tự động hoá tiến trình dài 

lặp đi lặp lại như nhập và định dạng bảng, hoặc in mục nào đó trong trang bảng tính. 

 Về tổng thể, tiến trình Macro bao gồm 3 bước: bước thứ nhất bạn khởi động 

Macro recorder và đặt tên Macro, bước kế tiếp là thực hiện các hoạt động muốn ghi lại, 

chẳng hạn như chọn lệnh menu, chọn ô và nhập liệu. Sau cùng là bạn tắt Macro 

recorder. 

c. Chạy Macro 

 Muốn thi hành một Macro, trước hết bạn phải chọn vùng mà bạn muốn thực hiện 

tác vụ, sau đó bạn chọn m Macro từ thực đơn Tools  chọn tên Macro trong danh sách, 

rồi nhấn RUN. Lập tức Macro sẽ thi hành như yêu cầu của bạn. 

d. Gán một lệnh tắt ( ShortCut Key ) cho Macro 

 Từ menu Tools chọn Macro  chọn Macro trong danh sách, rồi chọn Options  

gõ phím tắt vào mục ShortCut Key  Chọn OK để trở về hộp thoại Macro, rồi nhấn 

Close để trở về bảng tính. Muốn thi hành Macro, bạn chỉ việc gõ phím tắt mà bạn vừa 

định nghĩa.   

e. Xem Macro 

 Khi tạo Macro xong, Excel đã ghi lại các hoạt động của bạn và chèn mã Visual 

Base tương ứng vào module trong tập bảng tính. Muốn xem module này, bạn chọn 

Tools  Macro  sau đó chọn tên Macro vừa tạo và nhấn nút Edit. Visual Base Editor 

xuất hiện - chương trình độc lập với Excel - khởi động. 

7. Biểu đồ bảng tính 

a. Các bước tạo biểu đồ 

 

 Bước 1: Nháy chuột vào biểu tượng Chart Wizard: trên Standard Toolbar. 
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Khi đó con trỏ chuột biến thành hình dấu ( +). Hãy vẽ phác hoạ một vùng trên bảng tính 

để đặt biểu đồ vào đó bằng cách rê chuột từ góc trên bên trái đến góc dưới bên phải của 

vùng. Hộp đối thoại sau xuất hiện: Nháy chuột tại nút Next> để tiếp tục bước 2. 

 Bước 2: Chọn kiểu đồ thị. Excel có nhiều kiểu khác nhau, muốn chọn kiểu nào thì 

nháy chuột vào hình kiểu đó để chọn. Nháy chuột tại nút Next> để tiếp tục bước 3. 

 Bước 3. Chọn kiểu chi tiết cho kiểu vừa chọn ở bước 2. 

 Nháy chuột tại nút Next> để tiếp tục bước 4. 

 Bước 4: Đồ thị "nháp ", dựa vào các thao tác ở 3 bước trước, Chart Wizard phác 

hoạ một đồ thị như sau với các thông số có thể thay đổi được: 

 - Data Series in: Chọn Rows (hàng) nếu muốn phân tích dữ liệu theo hàng, chọn 

Columns (cột) nếu muốn phân tích dữ liệu theo cột. 

 - use First Row(s) for Category (X) Axis Labels: Sử dụng hàng đầu tiên ( trong 

khối dữ liệu đã chọn ) gán nhãn trục X.  

 - Use First Column(s) for Legend Text: Sử dụng cột đầu tiên ( trong khối dữ liệu 

đã chọn ) gán giá trị  phân tỷ lệ trục Z . 

 Sau cùng nháy chuột tại nút Next> để tiếp tục bước 5. 

 Bước 5. Bước cuối cùng, Chart Wizard hỏi thêm: 

 - Add a Legend?: Có thêm phần chú giải không? Chọn yes sẽ có khung bên cạnh 

cho biết các cột màu gì. Chọn No thì không có khung này. 

 - Chart Title: đặt tiêu đề cho biểu đồ. 

 - Axis Title: Đặt tiêu đề cho trục X và Z 

 Hộp Category (X): Gõ tiêu đề trục X 

 Hộp Value (Z)     : Gõ tiêu đề trục Z 

Sau cùng chọn Finish. Kết quả ta có một biểu đồ. 

Chú ý:  trong mục Chart Options. Trong Gridlines để chỉ định có hay không có các lằn 

phân chia ngang dọc. Nếu muốn dùng lằn phân chia ngang ta chỉ cần Major Gridlines ở 

mục Value Axis. 

b. Hiệu chỉnh biểu đồ 

 - Chọn: Nháy chuột vào biểu đồ muốn hiệu chỉnh, khung viền biểu đồ sẽ hiện 8 

núm ở 4 góc và điểm giữa các cạnh. 

 - Di chuyển: Dùng chuột kéo phạm vi biểu đồ đến vị trí mới. 

 - Thay đổi kích thước: Dùng chuột rê các nút trên khung viền. 

 - Để hiệu chỉnh các thành phần bên trong biểu đồ, nháy đôi chuột trong phạm vi, 

lúc đó excel sẽ cho phép can thiệp vào từng phần của biểu đồ. 

 . Muốn chọn thành phần nào, nháy chuột vào thành phần đó. 

 . Thay đổi kích thước, vị trí của từng thành phần được thao tác như trên. 

 .  Muốn định dạng phần nào, nháy đôi chuột vào thành phần đó. 

 . Thay đổi kiểu biểu diễn đồ thị: Thực hiện lệnh Format/Autoformat 

  Mục Galleries: Chọn nhóm đồ thị  
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  Mục Formats: Chọn kiểu đồ thị trong nhóm 

 . Xoá tiêu đề của biểu đồ: Nháy chuột vào tiêu đề, bấm phím Del. Thực hiện 

tương tự để xoá tiêu đề của X, Z và chú giải. 

 . Để hiệu chỉnh tiêu đề của biểu đồ và các trục ta cần làm xuất hiện tiêu đề biểu 

đồ và các trục: Thực hiện lệnh Insert/Title rồi đánh dấu chọn mục tiêu cần để hiệu 

chỉnh. Sau đó nháy đúp chuột vào tiêu đề cần điều chỉnh rồi tiến hành hiệu chỉnh 
 

c. Vẽ đồ thị các hàm toán học 

 Để vẽ đồ thị cho các hàm toán học, bạn chỉ cần cho một đoạn số liệu trên miền 

xác định của đồ thị đó. Sau đó vẽ đồ thị dựa trên đoạn số liệu mới tạo. 

Ví dụ vẽ đồ thị hàm số: Y=2x2-3x+5. 

Cách tạo số liệu mẫu:  nếu tại ô A1 bạn gõ vào -10, ô A2 là -9 ... và ô A21 là 10 (bạn 

có thể dễ dàng làm điều đó) thì ở ô B1 bạn hãy gõ vào công thức=2*A1*A1-3*A1+5 và 

kéo công thức đó xuống đến ô B21.  
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Chương 6:     Kết nối các bảng tính và tệp bảng tính 

6.1. Kết nối các bảng tính trong cùng một tệp bảng tính 

  Cú pháp :   =<Tên bảng tính>!<địa chỉ ô> 

  Ví dụ:  giả sử ta đang ở bảng tính "DMTK", bạn muốn đưa giá trị của ô 

A3 trong bảng tính "Kế toán", hãy đưa con trỏ về vị trí cần nhận dữ liệu và đưa 

công thức : 

  =Kế toán!A3 

6.2. Kết nối các bảng tính trong các tệp bảng tính khác nhau 

  Cú pháp :   =[Tên tệp]<Tên bảng tính>!<địa chỉ ô> 

  Ví dụ:  giả sử bạn có một tệp bảng tính là LUONG.XLS nằm trong thư 

mục Excel thuộc ổ đĩa C. Trong tệp bảng tính này có bảng tính THANG1, 

THANG2,... Bạn lấy dữ liệu của ô A3 của bảng tính THANG1, bạn chỉ thị: 

    ='C:\EXCEL\[LUONG.XLS]THANG1'!$B$3 

Chú ý:   Có một dấu nháy ở đầu và cuối tệp bảng tính. Nếu có đường dẫn thì dấu 

nháy mở đầu ở đầu đường dẫn. 

6.3. Các ví dụ ứng dụng 

6.4. Tính năng group và outline 

 Liên kết dòng hoặc cột dữ liệu chi tiết trên bảng tính vào trong các nhóm 

chính theo từng cấp (như những đề mục của một dàn bài ). Khi cần thiết, bạn có 

thể thực hiện  việc liên kê dữ liệu trên bảng tính theo từng nhóm ấn định . 

 1. Lựa chọn những cột /dòng trong bảng tính cần liên kết vào  nhóm 

 1. Lựa chọn những cột (hoặc những dòng ) cần liên kết vào nhóm 

 2. Chọn lệnh [menu] Data >  Group  And Outline> group. 

 Excel sẽ liên kết cột /dòng trong phạm vi lựa chọn vào nhóm và xuất 

hiện  

- Các nút số  thứ tự ở bên trái đường viền dọc ( hoặc ở phía trên đường viền 

ngang) tương ứng với từng cấp . 

 - Những dấu chấm (.) phía trên ( hoặc bên trái ) cột /dòng thực hiện và một 

nút dấu trừ. 

Lưu ý: 

 * Phạm vi lựa chọn có thể là những cột /dòng  trống. 

 * Trong bước1 khi phạm vi lựa chọn không phải là những cột /dòng thì 

Excel sẽ hộp đối thại group .Chọn columns( hoặc Rows) và nút ok để xác định cột 

/dòng thực hiện  
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 Khi bạn thực hiện việc tào nhóm trên cột /dòng đã được tạo nhóm thì excel 

sẽ chuyên phạm vi trên vào nhóm cấp thấp. 

 2. Tự động tạo nhóm dựa vào cột /dòng chứa công thức trong bảng tính 

a. Di chuyển ô hiện hành vào bảng tính chứa dữ liệu cần thực hiện (ô chứa 

công thức)  

b. Chọn lệnh [Menu] Data > Group And Outline > Auto OutLine 

 3. Cách gỡ bỏ nhóm trên bảng tính 

 Khi cần gỡ bỏ việc liên kết nhóm trên bảng tính bạn chọn một trong hai 

cách thực hiện sau: 

a. Gỡ bỏ từng nhóm 

1.  Lựa chọn những cột (hoặc những dòng cần gỡ khỏi nhóm). 

 Khi phạm vi lựa chọn không phải là những cột dòng thì excel sẽ hiện hộp 

đối thoại Ungroup. Chọn Columns (hoặc Row)và nút OK để xác định cột 

dòng thực hiện. 

2.  chọn lệnh [Menu] Data > Group And Outline> Ungroup. 

 Excel sẽ gỡ bỏ những dong cột trong phạm vi lựa chọn ra khỏi nhóm. 

b. Gỡ bỏ toàn bộ  nhóm 

1.  Lựa chọn bảng tính có chứa nhóm cần gỡ bỏ. 

2.  chọn lệnh [Menu] Data > Group And Outline> Clear Outline. 

 Excel sẽ gỡ bỏ toàn bộ nhóm có trong bảng tính. 

Lưu ý: 

 Tên của vùng tin phải là dữ liệu dạng chuỗi (không được dùng số, công thức 

toạ độ ô...) 

  * Nên đặt tên ngắn gọn (kích thước tối đa 255 ký tự).và riêng biệt 

(không trùng lặp). 



Tin học văn phòng            Biên soạn: Khoa Công nghệ thông tin  

Trang 112 

Chương 7:  Cơ sở dữ liệu ( DATABASE) 

7.1 . Giới thiệu chung 

 Cơ sở dữ liệu là tập hợp thông tin, dữ liệu được tổ chức theo cấu trúc dòng và cột để có 

thể  

liệt kê, truy tìm, xoá, rút trích những dòng dữ liệu thoả mãn một tiêu chuẩn nào đó nhanh 

chóng. Để thực hiện các thao tác này ta phải tạo ra các vùng Database, Criteria và Extract. 

 Vùng Database là vùng cơ sở dữ liệu gồm ít nhất hai dòng. Dòng đầu tiên chứa các tiêu 

đề cột, gọi là tên vùng tin ( Field Name ) của CSDL. Tên các vùng tin phải là dữ liệu kiểu 

chuỗi và không được trùng lặp. Các dòng còn lại lứa dữ liệu, mỗi dòng gọi là mẫu tin CSDL 

(Record). 

 Vùng Criteria là vùng tiêu chuẩn chứa điều kiện để tìm kiếm, xoá, rút trích, ... Vùng 

này gồm ít nhất hai dòng. Dòng đầu chứa tiêu đề, các dòng còn lại chứa điều kiện . 

 Vùng Extract là vùng trích dữ liệu chứa các mẫu tin của vùng Database thoả mãn điều 

kiện của vùng tiêu chuẩn. Vùng Extract cũng có dòng đầu tiên chứa các tiêu đề  muốn trích rút. 

Chỉ cần vùng này trong trường hợp thực hiện thao tác rút trích, còn thao tác tìm, kiếm, xoá, ... 

không cần đến vùng này. 

 

7.2. Sử dụng hộp đối thoại Data Form 

 Để giúp bạn dễ dàng quản lý dữ liệu trong danh sách, Excel cho phép bạn thêm, bớt và 

tìm kiếm các bản ghi bằng cách sử dụng Form trong lệnh đơn Data. Khi chọn Form, một hộp 

thoại xuất hiện trình bày các trường trong danh sách và một số nút nhấn lệnh quản lý danh 

sách. Tên của WorkSheet hiện hành sẽ xuất hiện trên thanh tiêu đề của hộp hội thoại. Theo 

ngầm định bản ghi đầu tiên trong danh sách sẽ xuất hiện, và bạn có thể cuộn đến các bản ghi 

khác bằng cách sử dụng thanh cuộn dọc. Excel sẽ thêm các bản ghi mới vào cuối danh sách. 

Để hiện thị bản ghi trống, bạn có thể cuộn đến cuối danh sách rồi nhắp lên nút nhấn New. Mặc 

dù bạn có thể thêm các bản ghi bằng cách gõ trực tiếp vào WorkSheet, nhưng sử dụng lệnh 

Form sẽ dễ dàng hơn, và trong một số trường hợp sẽ nhanh hơn.  Muốn sử dụng hộp thoại Data 

Form, bạn sẽ tiến hành các bước sau: 

  Đặt con trỏ ô nằm trong phạm vi vùng Database. 

  Thực hiện lệnh: Data/Form. Một hộp thoại xuất hiện. Trong đó hiện nội dung CSDL 

theo từng mẫu tin. Có thể sử dụng các phím sau:  

   : đến mẫu tin trước/sau mẫu tin hiện hành. 

  Enter : đến mẫu tin sau mẫu tin hiện hành 

  PageUP/PgDn : đến mẫu tin đầu/cuối 

  Tab/Shift-Tab: di chuyển qua lại giữa các khung dữ liệu  

 Công dụng của những nút trong hộp thoại :   

 New: nhập mẫu tin mới 

 Delete: xoá mẫu tin hiện hành 

 Restore : khôi phục dữ liệu vừa nhập/xoá 

 Find Prev : đến mẫu tin trước mẫu tin hiện hành 

 Find Next: đến mẫu tin sau mẫu tin hiện hành 

 Criteria : nhập điều kiện truy tìm 
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 Close : đóng cửa sổ Data Form 

 A B C D E F G 

1 TT Họ và tên Chức vụ Số con Lương  Chức vụ 

2 1 Lê Thị Thu TP 2 840000  TP 

3 2 Nguyễn Bá Khánh NV 1 460000  GĐ 

4 3 Trần Tiến Tùng NV 2 360000   

5 4 Nguyễn Thái Hoà GĐ 1 900000   

6 5 Lê Thị Mai Anh NV 1 500000   

7        

8 TT Họ tên Chức vụ     

9 1 Lê Thị Thu 840000     

10 4 Nguyễn Thái Hoà 900000     

ở đây: vùng A1:E6 là vùng Database, vùng G2:G4 là vùng Criteria, vùng A9:C10 là vùng 

Extract. 

7.3. Các dạng vùng tiêu chuẩn 

       a. Tiêu chuẩn số : ô điều kiện có kiểu số. Ví dụ:  tiêu chuẩn Số con bằng 2 

       b. Tiêu chuẩn chuỗi: ô điều kiện có kiểu chuỗi. Ví dụ: tiêu chuẩn Chức vụ là "GD": trong 

ô điều kiện có thể chứa ký tự đại diện ? hoặc *. Ví dụ : tiêu chuẩn Tên bắt đầu bằng "H". 

 c. Tiêu chuẩn so sánh: ô điều kiện chứa toán tử so sánh kèm với giá trị so sánh. Ví dụ: tiêu 

chuẩn Số con lớn hơn 2. 

       d. Tiêu chuẩn công thức: ô điều kiện có kiểu công thức. Trong trường hợp này cần chú ý: 

 - Ô tiêu đề của vùng tiêu chuẩn phải là một tiêu đề khác với tất cả các tiêu đề của vùng 

Database. 

 - Trong ô điều kiện phải lấy địa chỉ của ô trong mẫu tin đầu tiên để so sánh. Ví dụ: tiêu 

chuẩn ký tự đầu tiên của tên khác  "H". Công thức trong ô điều kiện là:  =LEFT(C2,1)<>"H". 

       e. Liên kết tiêu chuẩn: Có thể tìm, kiếm, xoá hay rút trích các mẫu tin trong vùng Database 

bằng cách giao (AND) hay hội (OR) của nhiều điều kiện khác nhau. 

 - Ví dụ: Số con bằng 1 và Chức vụ là NV hay Số con lớn hơn 2 và Chức vụ là GD. 

7.4. Thao tác tìm, kiếm, rút trích và xoá (sử dụng AutoFilter và advanced Filter) 

       1. Tìm kiếm:  thao tác này chỉ cần tạo trước vùng Database và vùng Criteria, không cần 

tạo vùng Extract. 

 - Di chuyển con trỏ ô vào vùng Database. 

 - Thực hiện lệnh : Data/Filter/Advanced Filter. Một hộp thoại xuất hiện 

 - Chọn:  Filter the list, in place ở mục Action (hiển thị những mẫu tin thoả mãn điều 

kiện ngay trên vùng CSDL) 

 - Xác định địa chỉ vùng Database vào hộp :  List Range 

 - Xác định địa chỉ vùng Criteria vào hộp: Criteria Range 

 - Gõ Enter hay chọn OK, các mẫu tin không thoả mãn điều kiện trong vùng Criteria sẽ 

bị dấu đi, chỉ trình bày các mẫu tin thoả mãn điều kiện. 
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 Chú ý: sau đó muốn liệt kê lại toàn bộ nội dung các mẫu tin CSDL, dùng lệnh: 

Data/Filter/Show All. 
 

       2. Rút trích  

 - Trong thao tác này cần tạo trước vùng Database, vùng Criteria và vùng Extract. 

 - Di chuyển con trỏ ô vào vùng Database 

 - Thực hiện lệnh: Data/Filter/Advanced Filter. Hộp thoại như chức năng tìm kiếm hiện 

ra. 

 - Chọn Copy to Another Location ở mục Action. 

 - Xác định địa chỉ vùng Database vào hộp List Range 

 - Xác định địa chỉ vùng Criteria vào hộp: Criteria Range 

 - Xác định địa chỉ các tiêu đề của vùng Extract vào hộp: Copy to 

 - Gõ Enter hay chọn OK, các mẫu tin thoả mãn điều kiện trong vùng Criteria sẽ được 

chép vào vùng Extract 

  Nếu chọn Unique Records Only: các mẫu tin giống nhau trong vùng trích chỉ tồn tại 

một mẫu tin 

  Nếu không chọn Unique Records Only: trích đầy đủ các mẫu tin thoả mãn điều kiện 

của vùng tiêu chuẩn. 

       3. Xoá: thực hiện các bước như thao tác tìm kiếm 

 - Sau khi trong vùng CSDL liệt kê các mẫu tin thoả mãn điều kiện trong vùng Criteria, 

chọn các dòng này và thực hiện lệnh Edit/Delete Row 

 - Thực hiện lệnh Data/Filter/Show All để trình bày trở lại các mẫu tin bị dấu.  
 

 

7.5. Các Hàm cơ sở dữ liệu  

Hàm DSUM, DAVERAGE, DCOUNT, DCOUNTA, DMAX, DMIN. 

+ Cộng dụng: 

= DSUM: Tính tổng số của những mẫu tin thoả điều kiện trên cột khai thác trong CSDL. 

=DAVERAGE: Tính trung bình cộng của những mẫu tin thoả điều kiện trên cột khai thác 

trong CSDL. 

= DCOUNT: Đếm tổng số những ô chứa dữ liệu số của những mẫu tin thoả điều kiện trên cột 

khai thác trong CSDL. 

= DCOUNTA: Đếm tổng số những ô chứa dữ liệu của những mẫu tin thoả điều kiện trên 

cột khai thác trong CSDL. 

= DMAX: Tìm trị số cao nhất của những mẫu tin thoả điều kiện trên cột khai thác trong 

CSDL. 

= DMIN: Tìm trị số nhỏ nhất của những mẫu tin thoả điều kiện trên cột khai thác trong 

CSDL. 

+ Cú pháp: 

 = DSUM (Vùng CSDL, cột n, vùng tiêu chuẩn). 

 = DAVEGE(Vùng CSDL, cột n, vùng tiêu chuẩn) 

 = DCOUNT (Vùng CSDL, cột n, vùng tiêu chuẩn).   
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 = DCOUNTA(Vùng CSDL, cột n, vùng tiêu chuẩn). 

= DMAX (Vùng CSDL, cột n, vùng tiêu chuẩn).   

= DMIN (Vùng CSDL, cột n, vùng tiêu chuẩn). 

Lưu ý: 

 * Số cột khai thác phải là trị số lớn hơn hay bằng 1, và không được lớn hơn số cột có 

trong khối khai thác. 

 * Xem cách khai báo phạm vi và ghi điều kiện trong chương CSDL. 

 * Khi trong CSDL không có trị thoả điều kiện thì các hàm trên sẽ cho trị 0. 

 Kiểm tra dữ liệu ngay khi nhập. Nếu có nhiều người dùng đồng thời sử dụng một danh sách, 

thì bạn có thể kiểm tra thông tin được học nhập vào xem có sai sót gì không. Để sử dụng tính 

năng kiểm tra dữ liệu, hãy làm như sau: 

1. Chọn các ô trong cột muốn bảo vệ dữ liệu theo kiểu kiểm tra. Các ô đó có thể là ô đã chứa 

dữ liệu hay ô trống, là nơi bạn sẽ thêm mới các bản ghi. 

2. Chọn Validation từ lệnh đơn Data, một hộp thoại xuất hiện và mở khối settings ra. 

3. Trong danh sách đổ xuống Allow, chỉ định dạng bạn muốn cho dữ liệu sẽ nhập vào. Các tuỳ 

chọn của bạn có thể là Any value, Whole Number, Date ... 

 Khi chọn xong danh sách đổ xuống Allow, một số ô nhập khác sẽ xuất hiện để bạn chỉ 

định điều kiện, chẳng hạn như các số nhỏ và số lớn nhất để Excel có thể chấp nhận. 

4. Mở khối Input Message ra rồi chọn Show Input Message When Cell is Selected để chấp 

nhận vào thông tin hướng dẫn sẽ xuất hiện khi ô được chọn. 

5. Trong mục Input Message, nhập vào các thông tin hướng dẫn nhập (bước này là tuỳ chọn). 

6. Mở khối  Error Alert ra rồi chọn Show Error Alert After Invalid Data Is Entered để Excel sẽ 

thông báo lỗi khi người dùng nhập liệu sai. 

7. Trong danh sách đổ xuống Style, chọn một trong những tuỳ chọn sau: Stop (để ngưng nhập 

liệu), Warning (để nhắc nhở người dùng nhưng vẫn cho nhập liệu) và Information để thông 

báo cho người dùng). 

8. Trong mục Error Message, gõ vào nội dung nhập thông báo lỗi khi dữ liệu bị nhập sai. 

9. Chọn OK để hoàn tất hộp hội thoại Data Validation. Nếu bạn đã chọn lựa trong bước 7, bạn 

có thể nhận được thông báo lỗi khi nhập dữ liệu sai. 

7.6. kết hợp số liệu trong bảng tính (Consolidate worksheet) 

Công dụng: Tạo mỗi quan hệ nối kết giữa các dữ liệu dạng số của những bảng tính lựa chọn 

vào  

trong một bảng tính tổng hợp. Bạn có thể kết hợp số liệu của các bảng tính lựa chọn trong cùng 
1 tập tin Workbook hoặc của những tập tin Workbook khác với nhau. 

 1. Đọc lại tập tin Workbook chứa những bảng tính cần kết hợp và hiển thị các cửa sổ 
bảng tính trên cùng một màn hình(để dễ dàng xác định phạm vi cần thích hợp). 

 2. Lựa chọn bảng tính và phạm vi dùng để chứa những dữ liệu kết hợp (chỉ cần chọn toạ 
độ ô đầu trong một bảng tính bất kỳ). 

 3. Chọn lệnh  [Menu] Data > Consolidate. 
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Xuất hiện hộp đối thoại Consolidate. 

4. Lựa chọn phạm vi chứa dữ liệu trong bảng tính cần kết hợp:  

Chọn một trong hai cách thực hiện sau: 

* Di chuyển vào bảng tính cần thực hiện và Drag trên phạm vi lựa chọn. 

* Nhập toạ độ ô trên khung Reference (xem dạng thức trên phần lưu ý). 

 5. Chọn nút Add. 

Xuất hiện phạm vi vừa khai báo trong khung All References. 

6. Lập lại các bước 4,5 cho những bảng tính cần kết hợp khác. 

7. Chọn những thông số trên khung Use Labels In: 

 * Left Column: Khi cần dùng cột dữ liệu đầu tiên ở bên trái những cột số liệu trong 
phạm vi lựa chọn làm cột tiêu đề. 

 * Top Row: Khi cần dùng dòng dữ liệu đầu tiên ở phía trên những dong số liệu trong 
phạm vi lựa chọn làm cột tiêu đề. 

8. Thay đổi loại hàm cần tính toán trong việc kết hợp trên khung Function khi cần thiết (định 

dạng mặc nhiên của Excel là hàm Sum). 

9. Chọn nút OK. 

Excel sẽ gới kết xuất vào phạm vi lựa chọn trong bước 2. 

Lưu ý: 

 * Phạm vi vùng chứa dữ liệu cần kết hợp có thể là: 

 - Những vùng khác nhau trong cùng một bảng tính. 

 - Giữa những bảng tính trong cùng tập tin Workbook. 

 - Giữa những tập tin Workbook  đang hiển thị trên màn hình  hoặc trong đĩa. 

* Có thể kết hợp tối đa 255 khu vực. 

* Vùng chứa dữ liệu cần kết hợp có thể chứa cột dòng tiêu đề hoặc không. 

* Nhập phạm vi vùng chứa dữ liệu kết hợp trên khung Reference: 

 - Tên hoặc toạ độ của vùng: khi thực hiện việc kết hợp trong cùng một bảng tính. 

 - Tên bảng tính! Tên hoặc toạ độ của vùng: khi thực hiện việc kết hợp giữa các bảng 
tính trong cùng một tập tin Workbook. 

 - [Tên tập tin]tên bảng tính tên hoặc toạ độ của vùng khi thực hiện việc kết hợp giữa 

các tập tin trong thư mục. 

 - Tên đường dẫn [Tên tập tin] tên bảng tính hoặc toạ độ của vùng khi thực hiện việc kết 
hợp giữa các tập tin Workbook khác thư mục. 

* Chỉ có dữ liệu loại giá trị mới được tổng hợp (chuỗi dạng thức không có giá trị thực hiện). 

* Có 11 hàm tương thích với tính năng này là : Sum; Average; Count; Max; Min... 

* Chọn nút Browse khi cần lựa chọn các tạp tin Workbook chứa bảng tính cần kết hợp khác trê 
đĩa. 

* Bạn có thể sử dụng các kí tự đại diện (*,?) trong phần tên tập tin khi khai báo trên khung 
Reference. 

* Chọn thông số  Create Links to Source Data khi cần tạo thêm sự liên két với những dữ liệu 
nguồn trên các bảng tính. 
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7.6. Sắp xếp và tính tổng các nhóm số liệu 

Thực hiện việc thống kê, tính toán ở mỗi nhóm dữ liệu trên những cột lựa chọn trong phạm 

vi vùng CSDL. Excel sẽ tự động phân tách các nhóm dữ liệu đồng thời chèn vào cuối mỗi 

nhóm những dòng thống kê tính toán và một dòng tổng kết ở cuối phạm vi vùng CSDL. 

 Các bước thực hiện: 

 Sắp xếp lại phạm vi vùng CSDL theo thứ tự của vùng tin cần thực hiện việc thống kê 

hay tính toán. 

 + Di chuyển ô hiện hành vào vùng tin cần sắp xếp. 

 + Chọn nút trên Standard Toolbar. 

1. Di chuyển ô hiện hành vào trong phạm vi vùng CSDL. 

2. Chọn lệnh [Menu] Data > Subtotals. 

 Xuất hiện hộp đối thoại Subtotals. 

3. Lựa chọn vùng tin chứa dữ liệu cần phân tách theo nhóm trên khung At Each Change in: 

 + Click vào Menu drop-down. 

 + Click vào tên vùng tin lựa chọn. 

4. Lựa chọn hàm sử dụng trong việc thống kê hay tính toán trên khung Use Function: 

 + Click vào Menu drop-down. 

 + Click vào hàm lựa chọn. 

5. Lựa chọn những vùng tin chứa dữ liệu cần thực hiện việc thống kê hay tính toán trên khung 

Add Subtotal to: 

 + Click vào Menu drop-down. 

 + Click vào những tên vùng tin lựa chọn. 

6. Lựa chọn những thông số khác trong hộp đối thoại khi cần thiết. 

7. Chọn nút OK. 

Lưu ý: 

 Khi cần huỷ bỏ việc thống kê tính toán vừa thực hiện bạn chọn lệnh [Menu] Edit > 

Undo Subtotals (hoặc chọn lại lệnh [Menu] Data Subtotals và chọn nút Remove All). 

 Các lựa chọn khác trong hộp đối thoại Subtotals: 

 Replace Current Subtotals: bật tắt việc thay thế cho phạm vi dữ liệu hiện hành. 

 Page Break Between Groups: Bật tắt việc tự động tạo dấu ngắt trang giữa các nhóm 

dữ liệu. 

Summary Below Data: bật tắt việc tự động tạo các dòng thống kê tính toán phía dưới 

các nhóm dữ liệu. 

7.7. Tính năng Pivot table 

CSDL là một tập hợp của những mẫu tin CSDL được trình bày theo cấu trúc cột/dòng 

(mỗi vùng tin tương ứng với một cột và mỗi mẫu tin tương ứng với 1 dòng của bảng tính). Tuy 

nhiên với cấu trúc này, bạn sẽ gặp khó khăn khi cần phân tích hay tổng hợp dữ liệu theo từng 

đề mục. Nay với tính năng Pivot Table của Excel, bạn có thể dễ dàng sắp xếp và trình bày 

những vùng tin  trong CSDL, để có thể nhanh chóng phân tích hay thống kê dữ liệu theo nhiều 
hướng khác nhau. 

*  Mỗi Pivot Table gồm có bốn thành phần như sau: 
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- Page:  hiển thị một mục tin trong vùng tin lựa chọn làm đề mục chính cho Pivot Table ( có 

thể có hoặc không). 

- Row:  hiển thị những mục tin trong vùng tin lựa chọn như những dòng tiêu đề (có thể có 

hoặc không). 

- Column:  hiển thị những mục tin trong vùng tin lựa chọn như những cột tiêu đề (có thể có 

hoặc không). 

- Data : vùng dữ liệu cần tính toán hay thống kê tương ứng với cột/dòng tiêu đề (bắt buộc 

phải có). 

 

 

7.1. Tạo Pivot Table  

 Để tạo một Pivot Table trên bảng tính, bạn phải thực hiện từng bước theo sự hướng dẫn 

của tính năng Pivot Table Wizard như sau: 

Bước 1: Xác định loại dữ liệu của CSDL cần thực hiện  

Bước 2: Lựa chọn phạm vi vùng chứa CSDL trên bảng tính  

Bước 3: Tạo cấu trúc cho Pivot Table  

Bước 4: Khai báo vị trí của Pivot Table trên bảng tính và ấn định những thông số cho Pivot 

Table . 

* Các bước thực hiện : 

   1. Chọn lệnh [Menu] Data > Pivot Table  

 Xuất hiện hộp đối thoại Pivot Table Wizard Step 1 of 4: 

   2. Xác định loại dữ liệu để tạo Pivot Table : 

      + Click vào một trong những thông số sau: 

 Microsoft Excel List or Database: CSDL (hoặc danh sách hay bảng kê có dòng đầu 

chứa tiêu đề cột). 

 External Data Source: sử dụng CSDL của những chương trình khác hay trong tính 

năng Microsoft Query. 

 Multiple Consolidation Ranges: từ nhiều vùng CSDL kết hợp lại. 

 Another Pivot Table : từ Pivot Table khác. 

        + Chọn nút Next >. 

Xuất hiện hộp đối thoại Pivot Table Wizard step 2 of 4 

     3. Lựa chọn phạm vi vùng chứa CSDL trên bảng tính: 

          + Drag trên phạm vi vùng CSDL (hoặc nhập toạ độ của phạm vi trên khung Range) 

 Excel xuất hiện đường viền chuyển động xoay quanh khối ô lựa chọn . 

          + Chọn nút Next > 

 Xuất hiện hộp đối thoại Pivot Table Wizard step 3 of 4 

      4. Tạo cấu trúc cho Pivot Table : 

           + Drag các nút tên vùng tin (bên trái của hộp đối thoại vào trong những thành phần của 

Pivot Table . 

 + Chọn nút Next >. 

 Xuất hiện hộp đối thoại Pivot Table Wizard step 4 of 4 
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       5.  Khai báo vị trí của Pivot Table trên bảng tính và ấn định những thông số cho Pivot 

Table : 

 + Khai báo vị trí của Pivot Table trên bảng tính: Click vào một ô trống trên bảng tính 

(hoặc nhập toạ độ ô trên khung Pivot Table Starting Cell. 

 + Đặt tên cho Pivot Table trên khung Pivot Table Name 

 + Lựa chọn (bật/tắt) các thông số cho Pivot Table : 

     - Grand Totals For Columns: hiển thị dòng tổng cộng của các dữ liệu ở phía dưới 

bảng.  

     - Grand Totals For Rows: hiển thị cột tổng cộng của các dữ liệu ở bên phải bảng.

  

     - Save Data With Table Layout: lưu dữ liệu với những định dạng của bảng. 

     - AutoFormat Table: sử dụng với tính năng AutoFormat. 

 + Chọn nút Finish. 

 Excel sẽ tạo một Pivot Table trên phạm vi ấn định. 

Lưu ý: 

 Trong bước 3, khi ô hiện hành đang nằm trong vùng CSDL thì Excel sẽ tự động lựa 

chọn phạm vi của vùng trên . 

 Trong bước 5, nếu bạn không khai báo phạm vi chứa Pivot Table thì Excel sẽ tự động 

chèn một bảng tính mới bên trái bảng tính hiện hành ) để chứa Pivot Table. 

 Khi ô hiện hành đang ở trong một Pivot Table mà chọn lệnh [Menu] Data > Pivot Table 

thì Excel chuyển thẳng vào hộp đối thoại Pivot Table step 3 of 4 

7.2. Khai thác và chỉnh sửa Pivot Table  

 1. Di chuyển ô hiện hành vào trong Pivot Table cần thực hiện. 

 2. Chọn một trong những cách thực hiện sau: 

 * Chọn lệnh  [Menu] Data > Pivot Table ( Excel chuyển thẳng vào hộp đối thoại Pivot 

Table Wizard step 3 of 4), sau đó thực hiện tiếp việc chỉnh sửa hoặc khai báo thông số trên 

những hộp đối thoại. 

 * Double Click trên những tên vùng tin (Excel sẽ xuất hộp đối thoại Pivot Table Field), 

sau đó lựa chọn những thông số cần thực hiện trong hộp đối thoại. 

 * Drag trực tiếp tên các vùng tin đến các phạm vi khác của Pivot Table  khi cần thay đổi 

cấu trúc của Pivot Table . 

 * Double Click trên những mục tin, Excel sẽ tự động sao chép dữ liệu liên quan đến 

vùng tin và mẫu tin của ô hiện hành vào trong bảng tính mới phía trước bảng tính chứa Pivot 

Table.  

7.3. Làm việc với những vùng tin trong Pivot Table  

1. Chọn một trong hai cách thực hiện sau: 

* Di chuyển ô hiện hành vào tên vùng cần thực hiện trong Pivot Table và chọn lệnh  

[Menu] Data > Pivot Table Field. 

* Double Click trên tên vùng tin cần thực hiện  

Excel xuất hiện hộp thoại Pivot Table Field 

2. Lựa chọn những thông số cần thực hiện  

* Nhập tên vùng tin cần thay đổi trên khung Name 
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* Thay đổi thành phần của vùng tin trên Pivot Table : 

- Click vào các nút: Row, Column, Page trên khung Orientation. 

* Lựa chọn việc thống kê, tính toán của vùng tin trên khung Subtotals 

* Chọn nút Delete để xoá vùng tin trên Pivot Table  

* Bật/tắt việc hiển thị các mục tin có trong vùng tin trên khung Hide Items 

3. Chọn nút OK 

 

Ví dụ về tạo Pivot Table  

 

Month Region Category Amount 1

/ 

Di chuyển ô hiện hành vào ô bất kỳ 

Jan North Hardware 18500  Trong phạm vi: A1:D28 

Jan North Software 975 2/ Chọn lệnh [Menu] Data>Pivot Table  

Jan North Other 530 3/ Chọn nút Next trên HĐT Pivot Table  

Jan South Hardware 21554  Wizard Step 1 of 4 

Jan South Software 1125 4/ Chọn nút Next trên HĐT Pivot Table  

Jan South Other 850  Wizard Step 2 of 4 

Jan West Hardware 29750 5/ Khai báo cấu trúc cho Pivot Table : 

Jan West Software 1290  - Drag vùng tin Month vào khung 

Page 

Jan West Other 1500  - Drag vùng tin Categary vào khung 

Row 

Feb North Hardware 15350  - Drag vùng tin Region vào khung 

Column 

Feb North Software 500  - Drag vùng tin Amount vào khung 

Data 

Feb North Other 1100  - Chọn nút Next 

Feb South Hardware 15690 6/ - Chọn nút Finish 

Feb South Software 1800    

Feb South Other 1400    

Feb West Hardware 15400    

Feb West Software 900    

Feb West Other 150    

Mar North Hardware 23500    

Mar North Software 1190    

Mar North Other 1356    

Mar South Hardware 22500    

Mar South Software 2500    

Mar South Other 590    

Mar West Hardware 18650    

Mar West Software 1050    

Mar West Other 275    
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Month Jan 

 

Sum of 

Amount 

Region  

Category North South West Grand Total 

Hardware 

Other 

Software 

18500 

530 

975 

21554 

850 

1125 

29750 

1500 

1290 

69804 

2880 

3990 

Grand Total 20005 23529 32540 76074 
 

 

 

 

 

Region (All) 

 

Sum of 

Amount 

Month  

Category North South West Grand Total 

Hardware 

Other 

Software 

69804 

2880 

3390 

46440 

2650 

3200 

64650 

2221 

4740 

180894 

7751 

11330 

Grand Total 76074 52290 71611 199975 

 

Region (All) 

 

Sum of 

Amount 

Category Amount  

Month Hardware Other Software Grand Total 

Jan 

Feb 

Mar 

69804 

46440 

64650 

2880 

2650 

2221 

3390 

3200 

4740 

76074 

52290 

71611 

Grand Total 180894 7751 71611 199975 
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Category (All) 

Month Jan 

Sum of 

Amount 

Region  

 North South West Grand Total 

Total 20005 23529 32540 76074 
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Chương 8:  Một số bài tập ứng dụng – in ấn 

8.1.  In toàn bộ dữ liệu trên bảng tính hiện hành 

 Để in nhanh toàn bộ dữ liệu có trên bảng tính hiện hành ra máy in (với những thông số 

mặc nhiên của Excel), bạn chọn một trong hững cách sau: 

1. Sử  dụng nút Print, Print Preview trên Standard Toolbar 

 1. Tạo mới (hoặc đọc lại) tập tin chứ dữ liệu cần in vào màn hình bảng tính hiện hành. 

 2. Chọn một trong hai nút sau:  

 * Print Preview: để xem trang in trên màn hình. 

 *Print : để in bảng tính hiện hành. 

2. Sử dụng lệnh Print trên Menu 

 1. Tạo mới (hoặc đọc lại) tập tin chứ dữ liệu cần in vào màn hình bảng tính hiện hành. 

 2. Chọn lệnh [Menu] File > Print. 

 Xuất hiện hộp đối thoại Print. 

 3. Lựa chọn và thay đổ các thông số khi cần thiết (xem phần hướng dẫn chi tiết ở những 

mục sau.) 

 4. Chọn nút OK. 

 Excel xuất hiện thông báo về tình trạng in hiện hành, và tự động chuyển toàn bộ dữ liệu có 

trong bảng tính ra máy in. 

 Lưu ý:  

 * Để huỷ bỏ việc in đang thực hiện, bạn cần nhấn phím Esc (hoặc nút Cancel). 

 * Khi sử dụng nút Print, bạn không thể lựa chọn các thông số in cần thiết. 

8.2. Lựa chọn phạm vi khối in 

 Trong Excel, bạn có thể ấn định phạm vi khối dữ liệu cần in. phạm vi lựa chọn có thể 

là: 

 * Một hoặc những khối dữ liệu trong bảng tính hiện hành. 

 * Một hoặc những trang in trong bảng tính hiện hành. 

 * Một số những bảng tính trong Workbook. 

1. In một khối hoặc những khối dữ liệu trong bảng tính hiện hành 

 - Lựa chọn phạm vi khối (hoặc những khối) dữ liệu cần in. 

 - Chọn lệnh [Menu] File > Print (hoặc nhấn phím CTRL-P). 

 Xuất hiện hộp đói thoại Print. 

  - Chọn thông số (o) Selection trên khung Print What. 

  - Chọn nút OK. 

Lưu ý: 

 * Khi lựa chọn phạm vi khối in không liên lạc với nhau thì Excel sẽ in mỗi khối trên 

những trang in riêng biệt (theo thứ tự được lựa chọn). 

2. Lựa chọn một hoặc những trang in trong bảng tính hiện hành 

 - Chọn lệnh [Menu] File > Print (hoặc nhấn phím CTRL-P). 

 Xuất hiện hộp đối thoại Print. 

  - Chọn thông số (o) Selection trên khung Print What. 

  - Chọn thông số (o) Page (s) trên khung Page Range. 
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  - Nhập số trang bắt đầu (hoặc dùng các nút tăng .giảm trị số)trên khung Form, nhập số 

trang kết thúc (hoặc dùng các nút tăng. giảm trị số) trên khung To. 

  - Chọn nút OK. 

Lưu ý: 

*Bạn nên chọn nút Print Preview để xem trang in trên màn hình trước và sau khi thực hiện 

bước 5 để kiểm soát số trang cần in. 

3. Lựa chọn một số bảng tính cần in trong tập tin Workbook 

  - Lựa chọn những bảng tính cần in. 

  - Chọn lệnh [Menu] File > Print (hoặc nhấn phím CTRL-P). 

 Xuất hiện hộp đối thoại Print. 

   - Chọn thông số (o) Selected sheet (s) trên khung Print What. 

   - Chọn nút OK. 

Lưu ý: 

*Bạn nên chọn nút Print Preview để xem trang in trên màn hình trước và sau khi thực hiện 

bước 4 để kiểm soát việc in. 

4. In toàn bộ những bảng tính có chứa dữ liệu trong tập tin Workbook 

 - Chọn lệnh [Menu] File > Print (hoặc nhấn phím CTRL-P). 

 Xuất hiện hộp đối thoại Print. 

  - Chọn thông số: Entire workbook  trên khung Print What. 

  - Chọn nút OK. 

Lưu ý: 

* Chỉ có những bảng tính chửa dữ liệu mới được in. 

* Mỗi bảng tính sẽ được in trên những trang riêng biệt. 

8.3. Làm việc với màn hình trang in 

 Trước khi thực hiện việc in dữ liệu trong bảng tính hiện hành ra giấy, bạn nên kiểm tra 

lại nội dung và hình thức của dữ liệu trên màn hình trang in dể tránh những sai sót. 

 Trong màn hình trang in, bạn có thể: 

 * Phóng to/thu nhỏ tỉ lệ hiện thị trang in. 

 * Điều chỉnh kích thước các lề trái, phải, trên, dưới của trang in và của vùng 

 HEADER/FOOTER. 

 * Thay đổi độ rộng của các cột. 

1. Hiển thị màn hình trang in 

 1. Tạo mới (hoặc đọc lại) tập tin workbook chứa dữ liệu cần in vào màn hình bảng tính 

hiện hành. 

 2. Chọn một trong những cách thực hiện sau: 

 * Chọn nút Print Preview trên Standard Toolbar. 

 * Chọn lệnh [Menu] File > Print Preview . 

 * Chọn nút Print Preview trong những hộp đối thoại: Print hoặc Page Setup. 

Xuất hiện màn hình hiển thị toàn bộ trang in hiện hành. 

Lưu ý: 

* Bạn cần phóng to/thu nhỏ màn hình trang in, bạn chọn nút Zoom hoặc di chuyển con trỏ 

Mouse (có hình kính lúp )vào vị trí cần hiển thị và Click Mouse. 
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2. Giới thiệu các nút lệnh trong màn hình trang in 

 + Next: hiện thị những trang in (nếu có). 

 + Previous: hiện thị những trang in trước đó (nếu có). 

 + Zoom: phóng to/thu nhỏ tỉ lệ của màn hình trang in. 

 + Print: Thực hiện lệnh in, chuyển vào họp đối thoại Prin. 

 + Setup: Chuyển vào hộp đối thoại Page setup. 

 + Margins: điều chỉnh các lề và độ rộng cột. 

 + Close: đóng màn hình trang in và trở về bảng tính(không thực hiện lệnh in). 

 

 + Help: xem giúp đỡ về các nút lệnh trong màn hình trang in. 

Lưu ý: 

 * Khi không có những trang in kế tiếp hoặc trước đó thị những nút lệnh 

next, Previous sẽ bị mờ. 

 * Nhấn phím Enter (hoặc nhấn phím mũi tên xuống) thay cho phím Next. 

 * Nhấn phím mũi tên lên thay cho phím Previous. 

 * Nhấn phím Home/End để hiển thị trang in đầu/cuối. 

3. Điều chỉnh kích thước của các lề trang in, vùng Header/Footer và độ rộng cột 

trên màn hình trạng in 

 1. Chọn nút Margins (trong màn hình trang in). 

 Excel xuất hiện các mốc vuông ở các lề trái, phải trên, dưới của trang in, vùng 

Header/Footer và ở hai bên cột dữ liệu. 

 2. Drag trên những mốc vuông của lề hoặc cột cần điều chỉnh kích thước. 

 Trên dòng cuối của màn hình trang in sẽ xuất hiện kích cỡ hiện hành mỗi khi 

Drag trên những mốc vuông. excel sẽ tự động điều chỉnh lề và độ rộng cột trên 

trang in và trong bảng tính theo kích thước mới. 

 

8.4. Lựa chọn/ thay đổi các dạng thức của trang in 

1. Thay đổi các dạng thức của trang in. 

 1. Chọn lệnh [Menu] File > Page Setup (hoặc chọn nút Setup trong hộp đối 

thoại Print). 

 Xuất hiện hộp đối thoại Page Setup. 

 2. Lựa chọn và ấn định các thông số cần thực hiện trên các Tab 

 Page Tab: 

+ Orientation: để  thay đổi chiều in. 

 - Portrait: in theo chiều dài của trang giấy. 

 - Landscape: in theo chiều ngang của trang giấy. 
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+ Scaling: thay đổi tỉ lệ kích cỡ dữ liệu trong trang in. Tỷ lệ mặc nhiên là 100% 

(có giá trị thay đổi từ 10 đến 400%). 

+ Paper: để thay đổi kích cỡ trang in. 

+ Print Quality: để thay đổi chất lượng (số chấm điểm trên một inch). 

+ First Page Number: ấn định số trang in bắt đầu. 

 Margins Tab: 

+ Top/Bottom/Left/Right: để thay đổi khoảng cách giữa các lề của trang giấy và 

vùng Header/Footer. 

+ Center on Page: canh dữ liệu theo: 

  - Horizontally: chiều ngang trang in. 

  - Vertically: chiều dọc trang in. 

 Header/Footer Tab: Tiêu đề đầu và cuối trang in (xem phần chi tiết trên mục 

Header/Footer). 

 Sheet Tab: 

3. Chọn nút: 

 * OK: chấm dứt việc khai báo, lựa chọn những thông số cần thực hiện và 

đóng hộp đối thoại Page setup. 

 * Cancel: huỷ bỏ lệnh và đóng hộp thoại Page setup. 

 *Print Preview: xem trang in trên màn hình. 

2. In tiêu đề dầu (Header), tiêu đề của (Footer) trên trang in 

 Dùng để in những dòng dữ liệu trên đầu và cuối của các trang in. 

a. Tạo tiêu đề đầu, cuối trên trang in 

 1. Chọn lệnh [Menu] File > Page Setup, chọn Tab Header/Footer. 

 Xuất hiện hộp đối thoại Page Setup. 

 2. Chọn: 

 * Những tiêu đề sẵn có trên khung Header hoặc Footer (Click vào drop 

down, sau đó click trên tiêu đề lựa chọn).. 

 Xuất hiện hộp đối thoại Header hoặc Footer. 

 3. Di chuyển vào các khung dữ liệu cần nhập (trái, giữa, phải) tương ứng 

với những vị trí trên trang in. 

 4. Chọn: 

 * Nhập/chỉnh sửa nội dung dữ liệu. 

 * Nhập/ xoá các mã cần thực hiện (chọn các nút hình tượng trong hộp đối 

thoại hoặc nhập trực tiếp các mã từ bàn phím ). 

 5. Chọn nút OK (đóng hộp đối thoại Header hoặc Footer). 

 6. Chọn nút OK (đóng hộp đối thoại Page setup). 

b. ấn định những cột/dòng tiêu đề dữ liệu của bảng tính trên các trang in 
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 Dùng trong trường hợp bảng tính có nhiều trang in và cần phải xuất hiện lại 

những cột/dòng tiêu đề ở phía trên hoặc bên phải của khối in. 

 * Các bước thực hiện: 

 1. Chọn lệnh [Menu] File > Page Setup (hoặc chọn nút setup trong hộp đối 

thoại Print). 

 Xuất hiện hộp đối thoại Page setup. 

 2. Chọn Sheet Tab. 

 3. Chọn: 

 * Row to Repeat at Top: để lựa chọn dòng làm tiêu đề ở phía trên khối in 

(nhập phạm vi của khối thứ tự của dòng trên khung hoặc Drag trên những dòng 

lựa chọn trong bảng tính hiện hành).. 

 * Columns to Repeat at Left: để lựa chọn cột làm tiêu đề ở bên trái khối in 

(nhập phạm vi theo kí hiệu của cột trên khung hoặc Drag trên những cột lựa chọn 

trong bảng tính hiện hành). 

 4. Chọn nút OK. 

Lưu ý: 

 * Phạm vi dùng làm những cột/dòng tiêu đề bắt buộc phải liên lạc. 

 * Để huỷ bỏ phạm vi dùng làm cột/dòng tiêu đề bạn chỉ cần xoá toạ độ hiển 

thị trên khung Print Titles. 

3. ấn định/huỷ bỏ việc phân trang trên bảng tính 

 Trong Excel việc phân trang được thực hiện tự động dựa vào kích thước của 

trang in. Tuy nhiên bạn có thể ấn định việc phân trang ở những vị trí cần thiết trên 

bảng tính theo chiều ngang, chiều dọc hoặc cả hai. 

a. Thực hiện việc phân trang ở vị trí chỉ định trong bảng tính  

 1. Chọn vị trí cần thực hiện như sau: 

 * Dòng phía dưới của vị trí cần phân trang theo chiều ngang. 

 * Cột bên phải của vị trí cần phân trang theo chiều dọc. 

 * Dòng phía dưới và cột bên phải của vị trí cần phân trang theo chiều ngang 

và chiều dọc. 

 2. Chọn lệnh [Menu] insert > Page Break. 

 Tại vị trí vào lệnh xuất hiện các đường phần trang. 

b. Huỷ bỏ việc phân trang trên bảng tính 

1. Lựa chọn toàn bộ bảng tính hoặc di chuyển ô hiện hành vào phía dưới hay bên 

phải của ngắt trang cần huỷ bỏ. 

3. Chọn lệnh [Menu] Insert > Remove Page Break. 

 



GIÁO TRÌNH MS EXCEL 

 
 

khoavp@gmail.com 

1 

GIÁO TRÌNH MS EXCEL 

 
I. §¹i c−¬ng vÒ b¶ng tÝnh 

1.Kh¸i niÖm b¶ng tÝnh 

a.VÝ dô: LËp 1 danh s¸ch ®iÓm thi häc kú cña líp gåm c¸c cét: Hä, tªn, 

Ngµy sinh, M1, M2, M3, Tæng ®iÓm, XÕp Lo¹i. 

§©y lµ 1 danh s¸ch ®−îc lËp d−íi d¹ng 1 b¶ng. ë ®ã: 

+Mçi dßng ( trõ dßng ®Çu lÊy lµm tiªu ®Ò cét ) lµ c¸c th«ng tin vÒ mét 

häc sinh;  Mçi cét lµ mét th«ng tin vÒ c¸c häc sinh. 

+ D÷ liÖu ®éc lËp (b¾t buéc ®−a vµo ) gåm: Hä, Tªn, Ngµy sinh,M1, 

M2, M3 

+D÷ liÖu phô thuéc (sÏ tÝnh to¸n nhê d÷ liÖu ®éc lËp): Tæng ®iÓm, xÕp 

lo¹i. 

b.Kh¸i niÖm b¶ng tÝnh 

- Dïng qu¶n lý d÷ liÖu d−íi d¹ng b¶ng 

- B¶ng tÝnh lµ 1 b¶ng h×nh ch÷ nhËt ®−îc chia thµnh c¸c « bëi c¸c l−íi 

®−êng song song  víi c¹nh cña b¶ng h×nh ch÷ nhËt 

- C¸c « theo vÖt ngang lµ dßng, c¸c dßng ®−îc ®¸nh sè: 1,2,3...65536 

- C¸c « theo vÖt däc lµ cét, c¸c cét ®−îc ®¸nh sè: A, B, ...IV (256 cét) 

- ¤: Giao cña dßng víi cét lµ «, tªn « :ghÐp tªn cét, dßng; vÝ dô: A1, 

F10, ... 

2. Khëi ®éng EXCEL 

 
Trong WIN95, 98, 2000 ... cã dïng mét trong 3 c¸ch sau: 

C¸ch 1: KÝch chuét lÇn l−ît vµo Start/Program/Microsoft excel 

C¸ch 2: KÝch chuét  vµo ch÷  X  trong  biÓu t−îng                                         

n»m gãc ph¶i bªn trªn mµn h×nh.  
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C¸ch 3: KÝch ®óp chuét vµo biÓu t−îng           trªn mµn h×nh nÒn.  

3. CÊu tróc b¶ng tÝnh excel 
 

 
 

- Mçi sæ tay (WorkBook)  gåm 1 ®Õn 256  sheet (ngÇm ®Þnh 3 sheet) ,  
- Mçi b¶ng tÝnh (sheet) lµ 1 trang b¶ng tÝnh  nh− trªn, nã gåm 254 

cét,  65536 dßng, h¬n 16 triÖu «. 
- Mçi  Workbook  sÏ ®−îc ghi vµo 1 tÖp; sè l−¬ng tÖp  Workbook 

®−îc më kh«ng giíi h¹n, chØ phô thuéc vµo bé nhí cña m¸y. 
- Cét (columns) cã ®é réng ngÇm ®Þnh 9 kÝ tù (cã thÓ thay ®æi tõ 0 - 

255 kÝ tù) 
- Dßng (Rows) cã ®é cao ngÇm ®Þnh 12.75 chÊm ®iÓm  (cã thÓ thay 

®æi tõ 0 - 409) 
- ¤ (Cell)    lµ giao cña mét cét vµ mét dßng; ®−îc x¸c ®Þnh bëi ®Þa 

chØ ghÐp tªn cét, tªn dßng. Cã 3 lo¹i ®Þa chØ «: 
  + §Þa chØ t−¬ng ®èi: A1 

+ §Þa chØ tuyÖt ®èi: $A$1 
+ §Þa chØ hçn hîp: $A1, A$1 

4. Di chuyÓn con trá vµ nhËp d÷ liÖu 

- Con trá «: lµ con trá lµm viÖc, cã mµu sÉm h¬n, chØ tån t¹i duy nhÊt 
1 con trá lµm viÖc 

- Con trá so¹n th¶o: lµ 1 vach | nhÊp nh¸y trong « lµm viÖc, dïng ®Ó 
nhËp d÷ liÖu  

- Di chuyÓn con trá «: 
  +Dïng 4 phÝm mòi tªn: di chuyÓn ®Õn c¸c « gÇn 

+ Dïng Page UP, Page Down: chuyÓn trang mµn h×nh 
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+ Dïng CTRL+Home: VÒ A1 
+ Dïng chuét: kÝch chuét vµo « nµo « ®ã trë thµnh « lµm viÖc 

 

5. Khèi « (vïng - Range) , chän khèi «, viÕt ®Þa chØ khèi « 

- Khèi «: lµ tËp hîp nh÷ng « liÒn kÒ nhau t¹o thµnh h×nh ch÷ nhËt, 
khèi « cã thÓ lµ 1 «, 1 cét, 1 dßng, mét nhãm « hoÆc toµn bé b¶ng tÝnh.  

- §Þa chØ khèi «  ®−îc x¸c ®Þnh bëi to¹ ®é « ®Çu hcn( gãc trªn bªn tr¸i) 
vµ to¹ ®é « cuèi hcn ( gãc d−íi bªn ph¶i) ; C¸ch viÕt A1:B10 

- Chän khèi « : 
  +Chän 1 khèi «: §Æt chuét ë « ®Çu khèi, kÝch rª ®Õn « cuèi khèi 

 +Chän nhiÒu khèi « ®ång thêi: Chän khèi « thø 1, Ên gi÷ CTRL 
®ång thêi kÝch rª chuét ®Ó chän khèi thø 2,... ( th−êng dïng khi vÏ ®å thÞ).  

6. Thay ®æi ®é réng cét, ®é cao dßng  

Di trá chuét ë ®−êng biªn bªn ph¶i tªn cét, hoÆc phÝa d−íi tªn dßng, khi 
chuét thµnh ↔ th× kÝch rª. 

7. Ra khái b¶ng tÝnh 

KÝch chuét vµo menu File/exit 

II. LËp b¶ng tÝnh vµ cÊt b¶ng tÝnh vµo ®Üa 

1. C¸c kiÓu d÷ liÖu vµ c¸ch nhËp 

VÝ dô: B¶ng tÝnh gåm c¸c cét Hä, Tªn, Ngµy sinh, M1, M2, M3, Tæng, XÕp 
lo¹i,.. 
ë vÝ dô trªn d÷ liÖu cña c¸c cét Hä, Tªn lµ kiÓu v¨n b¶n, Ngµy sinh lµ kiÓu 
Ngµy th¸ng, M1, M2, M3 lµ kiÓu sè, Tæng, XÕp lo¹i lµ kiÓu c«ng thøc. 
a. KiÓu v¨n b¶n ( Text) 

- §−îc gâ c¸c kÝ tù cã trªn bµn phÝm 
- Tèi ®a ®−îc 255 kÝ tù, ngÇm ®Þnh thÊy 9 kÝ tù, nÕu « bªn c¹nh kh«ng cã 

d÷ liÖu th× c¸c kÝ tù “trµn” sang vµ vÉn nh×n thÊy. 
- D÷ liÖu sau khi nhËp vµo « sÏ s¸t tr¸i (ngÇm ®Þnh)  

b. D÷ liÖu sè (Number ) 

- ChØ gâ c¸c sè tõ 0 - 9 , +, -, . 
- D÷ liÖu sau khi nhËp vµo « sÏ s¸t ph¶i 

c.  D÷ liÖu kiÓu ngµy ( date ) 

- Gâ ngµy th¸ng hîp lÖ, theo qui ®Þnh: mm/dd/yyyy hoÆc dd/mm/yyyy 
- D÷ liÖu sau khi nhËp vµo « sÏ s¸t ph¶i 

d.  D÷ liÖu c«ng thøc (Formula) 



GIÁO TRÌNH MS EXCEL 

 
 

khoavp@gmail.com 

4 

- B¾t ®Çu lµ dÊu =, sau ®Õn biÓu thøc tÝnh to¸n viÕt theo qui ®Þnh cña 
excel 

- D÷ liÖu nhËp vµo « sÏ s¸t ph¶i nÕu kÕt qu¶ tÝnh lµ sè, s¸t tr¸i nÕu kÕt qu¶ 
lµ v¨n b¶n. 

- Néi dung « c«ng thøc chøa biÓu thøc tÝnh to¸n mµ ta gâ vµo, nh−ng h×nh 
thøc hiÖn ra lµ kÕt qu¶ tÝnh to¸n cña biÓu thøc ®ã. 

- Khi c¸c « d÷ liÖu trong c«ng thøc thay ®æi, th× gi¸ trÞ tÝnh to¸n trong « 
c«ng thøc còng thay ®æi theo. 

2. HiÖu chØnh d÷ liÖu 

- NÕu d÷ liÖu ng¾n: muèn söa « nµo ®−a con trá vµo « gâ ®Ì lªn 
- NÕu d÷ liÖu dµi: ®Ó con trá vµo « Ên F2 råi nh×n vµ söa d÷ liÖu trªn 

thanh c«ng thøc, xong Ên Enter. 

3. C¸c phÐp to¸n vµ c¸ch viÕt biÓu thøc trong EXCEL 

- C¸c phÐp tÝnh sè  häc: +, -, *, / 
- C¸c phÐp so s¸nh: =,>,>=,<,<=, <> 
- C¸c hµm tÝnh to¸n  (sÏ xÐt cô thÓ sau) 

 VÝ dô: SUM(C2,D2), AVERAGE(C2,D2) 
- BiÓu thøc: Lµ sù kÕt hîp gi÷a c¸c h»ng, ®Þa chØ «, c¸c hµm víi c¸c 

phÐp to¸n vµ dÊu (, ). 
Cã 2 lo¹i biÓu thøc: BiÓu thøc tÝnh to¸n vµ biÓu thøc logic (®iÒu kiÖn) 

VÝ dô: =(C2+D2)/2 
 =D2>9  

4. Ghi b¶ng tÝnh vµo tÖp, ®äc b¶ng tÝnh tõ tÖp ra 

- Ghi vµo: File/Save   ( ®u«i ngÇm ®Þnh cña tÖp lµ XLS) 
- §äc ra: File/Open 

III. Mét sè thao t¸c trªn b¶ng tÝnh 

ë trªn ta ®· xÐt kh¸i niÖm khèi «, c¸ch chän( ®¸nh dÊu) khèi «, viÕt ®Þa chØ 
khèi «, b©y giê ta h·y thùc hiÖn c¸c thao t¸c víi c¸c khèi « ®ã. 

1. C¸c thao t¸c sao chÐp, di chuyÓn, xo¸ d÷ liÖu cña khèi « 

a. Xo¸ d÷ liÖu khèi « 
- §¸nh dÊu khèi « 
- Ên phÝm Delete 

b. Di chuyÓn d÷ liÖu khèi « 
- §¸nh dÊu khèi « 
- KÝch Edit/Cut 
- §Æt con trá « ë n¬i cÇn chuyÓn ®Õn 
- KÝch vµo Edit/Paste 
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c. Sao chÐp d÷ liÖu khèi « 
- §¸nh dÊu khèi « 
- KÝch Edit/Copy 
- §Æt con trá « ë n¬i cÇn sao chÐp ®Õn 
- KÝch vµo Edit/Paste 

2. Sao chÐp « c«ng thøc víi ®Þa chØ t−¬ng ®èi, tuyÖt ®èi 

a. VÝ dô  
 
VÝ dô 1: 

 A B C D E F 
1 Hä Tªn Ngµy sinh L−¬ng PC Tæng 
2 Lª Hµ 1/2/67 390 120 510 
3  §ç  Tó 2/3/56 425 220 645 
4 NguyÔn  An 3/4/78 520 320 840 

  ¤ F2 sÏ viÕt c«ng thøc tÝnh Tæng: =D2 + E2 
 Sau ®ã ta copy « F2 cho c¸c « F3, F4,...-->C«ng thøc ë c¸c « nµy sÏ 

®óng 
 VÝ dô 2: 

 A B C D E F 
1    HÖ sè  1.40  
2 Hä Tªn Ngµy sinh L−¬ng PC Tæng 
3 Lª Hµ 1/2/67 390 120 510 
4  §ç  Tó 2/3/56 425 220 645 
5 NguyÔn  An 3/4/78 520 320 840 

¤ F3 sÏ viÕt c«ng thøc tÝnh Tæng: =D3*$E$1 + E3 
 Sau ®ã ta copy « F3 cho c¸c « F4, F5,...-->C«ng thøc ë c¸c « nµy sÏ ®óng 

do ta  ®· tuyÖt ®èi « $E$1 
b. NhËn xÐt:  

   Khi sao chÐp « c«ng thøc: ®Þa chØ t−¬ng ®èi trong c«ng thøc sÏ biÕn ®æi ®Ó 
phï hîp víi vÞ trÝ t−¬ng ®èi cña « ®−îc sao chÐp ®Õn, cßn ®Þa chØ tuyÖt ®èi 
th× gi÷ nguyªn. 
c. C¸ch sao chÐp: 

C¸ch 1: Copy b×nh th−êng nh− c¸ch ë trªn 
C¸ch 2: (do th−êng sao chÐp 1 « tíi c¸c « liÒn kÒ) 
   + §Æt con trá « vµo « c«ng thøc 
 + Di chuét ë gãc ph¶i d−íi « c«ng thøc, khi chuét thµnh + th× kÝch rª 
®i c¸c « liÒn kÒ 

3. Sao chÐp ®Æc biÖt (sao chÐp gi¸ trÞ cña khèi d÷ liÖu lµ c«ng thøc) 
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VÝ dô: ë b¶ng d÷ liÖu trªn cÇn sao chÐp sang 1 b¶ng míi gåm c¸c cét Hä, 
Tªn, Tæng. C¸ch lµm: 
 +Sao chÐp cét Hä, Tªn sang b¶ng míi: lµm sao chÐp b×nh th−êng 
 +Sao chÐp cét Tæng ®Æt bªn c¹nh, b»ng c¸ch: 

- §¸nh dÊu cét Tæng 
- Chän Edit/Copy 
- §Æt con trá « ë n¬i cÇn ®Õn (bªn canh cét Tªn) 
- Chän Edit/Paste Special/Values 

4. §iÒn d·y sè cã quy luËt 

- Gâ gi¸ trÞ ®Çu vµo « thø 1 
- Gâ gi¸ trÞ thø 2 vµo « thø 2 
- §¸nh dÊu 2 « 
- Di chuét ë gãc ph¶i d−íi cña khèi «, khi chuét thµnh + th× kÝch rª 

®i c¸c « tiÕp theo 

IV. Mét sè hµm th«ng dông trong tÝnh to¸n 

1. D¹ng tæng qu¸t cña hµm vµ c¸ch dïng 

+ D¹ng tæng qu¸t: Tªn hµm (®èi sè)  
  §èi sè cã thÓ lµ: h»ng sè, ®Þa chØ «, khèi «, biÓu thøc, tªn 1 hµm kh¸c 
 VÝ dô: Sum(A2,B2) 
+ C¸ch dïng: hµm th−êng ®−îc dïng trong biÓu thøc tÝnh to¸n. Hµm 
®−îc chÌn vµo vÞ trÝ trong biÓu thøc b»ng c¸ch: 
  C¸ch 1: T¹i vÞ trÝ con trá trong biÓu thøc gâ trùc tiÕp hµm cÇn nhËp vµo 
  C¸ch 2: T¹i vÞ trÝ con trá trong biÓu thøc cÇn nhËp hµm, h·y vµo lÇn 
l−ît: 
                Insert/  Function/ Chän tªn hµm cÇn nhËp 

2. C¸c nhãm hµm th«ng dông 

a. Nhãm hµm sè häc vµ thèng kª 
  - Max(n1, n2,...ni): Cho gi¸ trÞ lín nhÊt trong c¸c ni 
 ë ®ã c¸c ni cã thÓ lµ: h»ng sè, ®Þa chØ «, khèi « cã chøa sè 
  - Min(n1, n2,...ni): Cho gi¸ trÞ nhá nhÊt trong c¸c ni 
  - SUM(n1, n2,...ni): Cho tæng c¸c ni 
  - AVERAGE(n1, n2,...ni): Cho trung b×nh céng cña c¸c ni 
  - PRODUCT(n1, n2,...ni): Cho tÝch c¸c ni 
  - COUNT(n1, n2,...ni): §Õm c¸c d÷ liÖu sè trong danh s¸ch 
  - COUNTA(n1, n2,...ni): §Õm c¸c d÷ liÖu c¶ sè lÉn kÝ tù trong danh s¸ch 
VÝ dô: COUNT(1,ha,4) cho kÕt qu¶ 2 
  COUNTA(1,ha,4) cho kÕt qu¶ 3 
  - ABS(x) =|x| 
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  - INT(x) = phÇn nguyªn cña x 
  - MOD(x,y)= sè d− cña x/y 
  - SQRT(x) = c¨n bËc hai cña x 
  - EXP(x) = ex 
b. Nhãm hµm thêi gian 
  - TODAY() cho ngµy th¸ng hÖ thèng 
  - YEAR(dl kiÓu ngµy) cho n¨m (4 sè) 
  - MONTH(dl kiÓu ngµy) cho th¸ng 
  - DAY(dl kiÓu ngµy) cho ngµy 
  - DATE(yyyy,mm,dd): cho gi¸ trÞ kiÓu ngµy   
  - WEEKDAY(dl kiÓu ngµy,kiÓu) cho thø trong tuÇn; 

ë ®ã: kiÓu = 1 th× trong tuÇn sÏ tÝnh thø Hai:2,...thø B¶y:7, chñ nhËt:1  
         kiÓu = 2 th× trong tuÇn sÏ tÝnh thø Hai:1,...thø B¶y:6, chñ nhËt:7 

     kiÓu = 3 th× trong tuÇn sÏ tÝnh thø Hai:0,...thø B¶y:5, chñ nhËt:6 
 
VÝ dô: Xem tõ ngµy sinh ra ®Õn nay lµ bao nhiªu ngµy 
 = TODAY()-DATE(1984,02,25) 
 
c.Nhãm hµm v¨n b¶n 
  - UPPER(x): ®æi x©u kÝ tù X thµnh ch÷ in hoa 
  - LEFT(X,m):  §−a ra 1 x©u con tõ x©u X gåm m kÝ tù kÓ tõ bªn tr¸i 
  - RIGHT(X,n):  §−a ra 1 x©u con tõ x©u X gåm n kÝ tù kÓ tõ bªn ph¶i 
  - LEN(X): cho ®é dµi x©u kÝ tù X 
 
d. Nhãm hµm Logic 

a b  a∩b a ∪ b 
0 0 0 0 
0 1 0 1 
1 0 0 1 
1 1 1 1 

  - AND(®k1,®k2,...): cho giao cña c¸c ®k.  
VÝ dô: + ®tb>9 vµ §t>8 th× xÕp Giái: AND(®tb>9,§t>8) 

  + §−a ra nh÷ng ng−êi sinh nhËt vao ngay h«m nay: 
 AND(day(Today()=Day(d2),Month(today()=Month(d2)) 
  - OR(®k1,®k2,...): cho hîp cña c¸c ®k 
VÝ dô: §−a ra ng−êi cã §T hoÆc §L>=9: OR(§T>=9,§L>=9) 

      Gi¸ trÞ 1 nÕu BT§K ®óng 
   - IF(BT§K,gi¸ trÞ 1, gi¸ trÞ 2) =     
          Gi¸ trÞ 2 nÕu BT§K sai 
VÝ dô: 1. XÕp lo¹i häc sinh lªn líp, ë l¹i dùa vµo §TB 

= IF(§TB>=5,”lªn líp”, “ë l¹i” ) 
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 2. XÕp lo¹i häc sinh vµo 4 lo¹i: YÕu, TB, Kh¸, Giái dùa vµo §TB 
=IF(§TB<5,”YÕu”,IF(§TB<7,”TB”,IF(§TB<9,”Kh¸”,”Giái”))) 

Qua 2 vÝ dô trªn, nhËn xÐt: sè hµm IF lång nhau cña mçi tr−êng hîp. 
 3. XL lªn líp: §TB>=5 hoÆc §TB>=4 vµ §T>7; cßn l¹i lµ ë l¹i 
           =IF(OR(DTB>=5,AND(DTB>=4,DT>7)),”lªn líp”, “ë l¹i”) 
 

V. §Þnh d¹ng d÷ liÖu (tr×nh bµy) b¶ng tÝnh 

1. Thay ®æi cÊu tróc b¶ng 

a. ChÌn thªm «, cét, dßng 

- §¸nh dÊu « (cét, dßng) ë phÝa d−íi  
     hoÆc bªn ph¶i vÞ trÝ cÇn chÌn 
-  Chän Insert/Cell, xuÊt hiÖn hép tho¹i: 
 
 
 
NÕu chän: +Shift cell Right: ®Èy khèi « ®¸nh dÊu sang ph¶i khi chÌn 
        + Shift cell Down: ®Èy khèi « ®¸nh dÊu xuèng d−íi khi 

chÌn         + Entire Row: chÌn dßng trèng phÝa trªn khèi « ®¸nh dÊu 
        + Entire Colum: chÌn cét trèng phÝa bªn tr¸i khèi « ®¸nh 

dÊu 
b. Xo¸ «, cét, dßng 
 - §¸nh dÊu « (cét, dßng)  cÇn xo¸ 

-  Chän Edit/Delete, xuÊt hiÖn hép tho¹i: 
 
 
 
 
 
NÕu chän: +Shift cell Left: xo¸ « vµ dån sang tr¸i 
        + Shift cell Up: Xo¸ « vµ dån lªn trªn 
        + Entire Row: Xo¸ dßng ®¸nh dÊu 
        + Entire Colum: Xo¸ cét ®¸nh dÊu 

2. §Þnh d¹ng d÷ liÖu kiÓu sè, ngµy 

- Chän (®¸nh dÊu) vïng d÷ liÖu kiÓu sè hoÆc ngµy 
- Chän Format/Cell, xuÊt hiÖn b¶ng: 
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 -  Trong b¶ng nµy chän nót Number 

 + Trong Category: Chän Number nÕu ®Þnh d¹ng sè 
                               Chän Date nÕu ®Þnh dang ngµy 
   Gi¶ sö chän Date, ta cã hép tho¹i: 

                          
    
  + Chän kiÓu ®−a ra cho kiÓu ngµy th¸ng ë b¶ng bªn ph¶i, nÕu 
kh«ng cã th× chän Custom  ®Ó tù ®Þnh nghÜa kiÓu ®−a ra. 

 +Chän OK 

3. §Þnh d¹ng d÷ liÖu kÝ tù 

- §¸nh dÊu vïng d÷ liÖu 
- Chän Format/Cell, xuÊt hiÖn b¶ng nh− trªn,  
- Trong b¶ng nµy chän nót Font 
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  + Chän ph«ng, kiÓu, cì ch÷,...  (gièng ë Word) 

 + KÕt thóc kÝch OK 

4. §iÒu chØnh d÷ liÖu trong « 

- §¸nh dÊu vïng d÷ liÖu 
- Chän Format/Cell, xuÊt hiÖn b¶ng nh− trªn,  
- Trong b¶ng nµy chän nót Alignment, cã hép tho¹i tiÕp: 

 

                              
ë ®ã, nÕu chän: 

+Horizontal: §Ó c¨n d÷ liÖu ngang « nh− sau: 
 General: gi÷ nguyªn d÷ liÖu nh− khi ®−a vµo 
 Left: C¨n th¼ng mÐp tr¸i 
 Center: C¨n vµo gi÷a 
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 Right: C¨n th¼ng mÐp ph¶i 
 Justify: C¨n ®Òu 2 bªn 
 Fill: Lµm ®Çy « c¸c kÝ tù ®· cã 
 Center acrosse Selection: §−a vµo gi÷a khèi « 
+ Vertical: §Ó c¨n d÷ liÖu däc « 

   Top: S¸t trªn; Bottom: S¸t d−íi 
   Center: Vµo gi÷a Justify: ®Òu trªn d−íi 

+ Orientation: Chän h×nh thøc tr¶i d÷ liÖu 
+ Wrap Text: Cuèn d÷ liÖu xuèng dßng khi ®Õn lÒ bªn ph¶i «.

   

5. T¹o ®−êng kÎ cho khèi « 

- §¸nh dÊu khèi « 
- Chän Format/Cell xuÊt hiÖn hép tho¹i trªn 
- Chän nót Border, cã hép tho¹i tiÕp: 

                      
+ Chän ®−êng viÒn xung quang hoÆc ë gi÷a c¸c « ë môc Preset 
+ Chän ®−êng viÒn tõng phÝa trong môc Border 
+ Chän kiÓu ®−êng viÒn trong môc Line - Style 
+ Chän OK 

* Cã thÓ dïng thanh c«ng cô ®Ó t¹o ®−êng viÒn nhanh h¬n  

VI. VÏ biÓu ®å 

1. C¸c b−íc vÏ biÓu ®å 

B−íc 1: Chän d÷ liÖu ®Ó vÏ vµ  chän kiÓu biÓu ®å  
- §¸nh dÊu c¸c vïng d÷ liÖu cho trôc OX, OY 

 - KÝch nót lÖnh trªn thanh c«ng cô  hoÆc chän Insert/chart -> ra b¶ng 
1 
 - Chän kiÓu biÓu ®å ë b¶ng 1(Step 1) 
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- Chän Next  -- > ra b¶ng 2 (Step 2) 

B−íc 2:  X¸c ®Þnh l¹i miÒn d÷ liÖu ®Ó vÏ biÓu ®å ë b¶ng 2(Step 2) 

               
- Chän Next -> ra b¶ng 3 (Step 3) 

 
B−íc 3:  Chän c¸c tuú chän cña biÓu ®å ë b¶ng 3 (Step 3) 
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- §iÒn tªn ®å thÞ ë « Chart title 
- §iÒn tªn trôc OX ë « Category (X) Axis 
- §iÒn tªn trôc OY ë « Value (Y) Axis 
- Chän Next -> ra b¶ng 4(Step 4) 

 
B−íc 4: X¸c  ®Þnh vÞ trÝ ®Æt biÓu ®å ë b¶ng 4(Step 4) 
                 

 
  

- NÕu kÝch chuét vµo As new sheet : §Æt biÓu ®å trªn trang tÝnh míi, 
cã tªn lµ Chart n ( n lµ 1 sè) 

- NÕu kÝch chuét vµo As object in : §Æt biÓu ®å trong trang tÝnh, trang 
tÝnh ®−îc x¸c ®Þnh bëi Sheet n 
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- KÝch vµo Finish -> ra biÓu ®å nh− sau: 
 

 
 

2. HiÖu chØnh biÓu ®å 

a. Di chuyÓn, thay ®æi kÝch cì biÓu ®å 
- §¸nh dÊu biÓu ®å 
- KÝch rª chuét trªn biÓu ®å ®Ó thay ®æi vÞ trÝ 
- KÝch rª chuét ë mét trong c¸c nót ®en bao quanh biÓu ®å ®Ó thay 

®æi kÝch cì 
b. Thay ®æi Font ch÷, kiÓu, cì ch÷, mµu ch÷  trong biÓu ®å 

- §¸nh dÊu biÓu ®å 
- Chän Font, kiÓu, cì ch÷, mµu ch÷ trªn thanh c«ng cô hoÆc trong menu 

c. Thay ®æi kiÓu, vïng d÷ liÖu, c¸c tiªu ®Ò,.. biÓu ®å  

  §¸nh dÊu BiÓu ®å/KÝch vµo Chart/ sau ®ã chän: 
- Chart type : Thay ®æi kiÓu  biÓu ®å  
- Source data: Thay ®æi vïng d÷ liÖu ®Ó vÏ 
- Chart Option: Thay ®æi c¸c tiªu ®Ò cho biÓu ®å vµ c¸c trôc 
- Location: Thay ®æi n¬i ®Æt biÓu ®å 

•••• Chó ý: Khi l−u b¶ng tÝnh vµo tÖp sÏ ®ång thêi l−u lu«n c¶ biÓu ®å. 
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VII. C¬ së d÷ liÖu trªn b¶ng tÝnh 

1. Kh¸i niÖm c¬ së d÷ liÖu trong b¶ng tÝnh 

VÝ dô:  
stt Hä vµ tªn 15phót 1 tiÕt TBKT häc kú TB 

m«nk×1 
1 T¹ Quang C−êng 9 9 9.0 9 9.0 
2 NguyÔn Anh Dòng 7 7 7.0 8 7.3 
3 Chu Thuú D−¬ng 8 6 6.7 8 7.1 
4 NguyÔn Hïng Dòng 10 10 10.0 10 10.0 
5 NguyÔn H÷u §¹i 10 10 10.0 8 9.3 
Mét b¶ng  d÷ liÖu trªn trang tÝnh ®−îc tæ chøc thµnh c¸c hµng vµ c¸c cét. 
Theo thuËt ng÷ cña CSDL th× mçi hµng (trõ hµng ®Çu) sÏ lµ mét b¶n ghi, 
mçi cét lµ mét tr−êng. 
Hµng ®Çu ghi tiªu ®Ò cña mçi cét sÏ lµ tªn mçi tr−êng. 

2. S¾p xÕp d÷ liÖu 

- §¸nh dÊu khèi d÷ liÖu cÇn SX (gåm dßng tªn tr−êng (tªn cét ®Çu 
biÓu) vµ c¸c b¶n ghi (c¸c dßng d÷ liÖu)) 

 - Chän Data/Sort      
 Trong hép tho¹i trªn chän: 
  +KÝch vµo Header Row 
  + Chän kho¸ SX thø 1 ë hép SORT BY (lµ tiªu ®Ò cét cÇn sx), 
vµ chiÒu SX cña nã (A : t¨ng,  D: gi¶m) 
  + NÕu cã kho¸ SX thø 2, 3 th× chän t−¬ng tù ë hép THEN BY 
  + KÕt thóc kÝch vµo  OK 

3. T×m kiÕm d÷ liÖu (läc) 

a. B»ng Autofilter 
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B−íc 1: §¸nh dÊu vïng d÷ liÖu (gåm dßng tiªu ®Ò cét vµ c¸c dßng d÷ 
liÖu) 
B−íc 2: Vµo DATA/FILTER/AUTO FILTER  

B¶ng tÝnh xuÊt hiÖn c¸c « mòi tªn c¹nh tiªu ®Ò 
cét:

  

B−íc 3: Läc tõng ®iÒu kiÖn: 
KÝch chuét  vµo « mòi tªn bªn c¹nh tªn cét dïng lµm ®iÒu kiÖn  läc, 

®−a ra b¶ng chän:   
   
 
 
 
 
 
 

+ NÕu chän CUSTOM, ®−a ra b¶ng tiÕp: 
 

      
 
      + Chän møc so s¸nh ë  Show rows where: 

Equals = is less than or equal to <= 
Does not equal <> Begins  with B¾t ®Çu b»ng ch÷ c¸i 
is greater   than > Does not begin with Kh«ng b¾t ®Çu b»ng.. 
is greater   than or equal to >=  Ends with KÕt thóc b»ng 
is less than <  Does not End with  Kh«ng kÕt thóc b»ng 

 
     Gâ (víi  sè) hoÆc chän (víi ch÷) gi¸ trÞ so s¸nh ë « bªn c¹nh 
VÝ dô: - §−a ra nh÷ng ng−êi cã  TBKT>=9 
           - §−a ra nh÷ng ng−êi c¬ TBKH>=8, 1 tiÕt>9  
       - §−a ra nh÷ng ng−êi cã TBKT tõ 7 ®Õn 9 (dïng AND ) 
b. B»ng Advanced Filter 
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B−íc 1: T¹o vïng ®iÒu kiÖn nh− sau: 
- Dßng 1: chøa tªn c¸c tiªu ®Ò cét gièng ë vïng d÷ liÖu (nªn copy 
sang) 
-  Dßng 2 (hoÆc c¸c dßng sau n÷a dïng ®Ó ghi nh÷ng ®iÒu kiÖn theo 

yªu cÇu): NhËp c¸c ®iÒu kiÖn ë ngay phÝa d−íi tªn tiªu ®Ò cét ë vïng ®iÒu 
kiÖn 

B−íc 2:  §Æt con trá « vµo vïng d÷ liÖu vµ chän lªnh: Data/filter/Advantced 
Filter -> XuÊt hiÖn hép tho¹i: 

                   
B−íc 3: Lùa chän yªu cÇu thùc hiÖn trªn khung Action: 

 -  Filter the List, in – place: §Ó hiÓn thÞ kÕt qu¶ läc ngay trªn 
vïng d÷ liÖu khai th¸c. 

- Copy to another location: §Ó sao chÐp kÕt qu¶ läc vµo vïng sÏ 
®−îc chØ ra trªn b¶ng tÝnh ë Copy to. 

B−íc 4: Khai b¸o ph¹m vi c¸c vïng trong hép tho¹i: 
- List range: nhËp ®Þa chØ (hay kÝch rª ph¹m vi) vïng d÷ liÖu khai th¸c 
- Criteria range: NhËp ®Þa chØ (hoÆc kÝch rª)  vïng ®iÒu kiÖn. 
- Copy to: NhËp ®Þa chØ (hoÆc kÝch rª)  vïng chøa kÕt qu¶. 

B−íc 5: Chän OK trong hép tho¹i. 
VÝ dô 
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Ghi chó: C¸ch viÕt c¸c ®iÒu kiÖn trong vïng ®iÒu kiÖn: 
 
Gi¶ sö cã b¶ng d÷ liÖu: 
 
stt Hä vµ tªn 15phót 1 tiÕt TBKT 
1 T¹ Quang C−êng 9 9 9.0 
2 NguyÔn Anh Dòng 7 7 7.0 
3 Chu Thuú D−¬ng 8 6 6.7 
4 NguyÔn Hïng Dòng 10 10 10.0 
Vïng ®iÒu kiÖn: 
 
stt Hä vµ tªn 15phót 1 tiÕt TBKT 
 NguyÔn 7   
   >=9  
Vïng kÕt qu¶: 
 
stt Hä vµ tªn 15phót 1 tiÕt TBKT 
1 T¹ Quang C−êng 9 9 9.0 
2 NguyÔn Anh Dòng 7 7 7.0 
4 NguyÔn Hïng Dòng 10 10 10.0 
 

4. Mét sè hµm dïng víi CSDL 

Qui −íc:     VDL: Vïng d÷ liÖu cÇn xÐt 
  C: Cét cÇn xÐt 
  VDK: Vïng ®iÒu kiÖn 
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- DSUM(VDL,C,VDK): TÝnh tæng c¸c «  ë cét cÇn xÐt tho¶ m·n ®iÒu kiÖn 
 
- DAVERAGE(VDL,C,VDK): TÝnh  trung b×nh céng c¸c « trªn cét cÇn xÐt 
tho¶ m·n ®iÒu kiÖn 
 
- DCOUNT(VDL,C,VDK): §Õm c¸c « trªn cét cÇn xÐt tho¶ m·n ®iÒu kiÖn 
(NÕu cét cÇn xÐt lµ sè ) 
 
- DCOUNTA(VDL,C,VDK): §Õm c¸c « trªn cét cÇn xÐt tho¶ m·n ®iÒu kiÖn  
(NÕu cét cÇn xÐt lµ v¨n b¶n ) 
 
- DMAX(VDL,C,VDK): §−a ra sè lín nhÊt trong c¸c « trªn cét cÇn xÐt tho¶ 
m·n ®iÒu kiÖn 
 
- DMIN(VDL,C,VDK): §−a ra sè nhá nhÊt trong c¸c « trªn cét cÇn xÐt tho¶ 
m·n ®iÒu kiÖn 
 
 
 
 
VÝ dô: 

  
 
* L−u ý khi t¹o vïng ®iÒu kiÖn 
- NÕu ®iÒu kiÖn lµ h»ng sè th× tiªu ®Ò ®iÒu kiÖn trïng víi tiªu ®Ò cét d÷ liÖu 
lµm ®iÒu kiÖn ( nªn copy tªn cña cét lÊy lµm ®iÒu kiÖn xuèng). 
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-  NÕu ®iÒu kiÖn lµ  biÓu thøc (hµm,..) th× tiªu ®Ò ®iÒu kiÖn ph¶i kh¸c víi tiªu 
®Ò cét d÷ liÖu lÊy lµm ®iÒu kiÖn (kh«ng nªn copy tªn cña cét lÊy lµm ®iÒu 
kiÖn xuèng). 
 VÝ dô: §Õm nh÷ng ng−êi cã ch÷ c¸i ®Çu cña Hä vµ tªn lµ N, vïng ®iÒu kiÖn 
ta lËp nh− sau: 

®Çuhä 
=Left(B2,1)=”N” 

 

5. T×m kiÕm b»ng VLOOKUP, HLOOKUP 

a. Hµm VLOOKUP 

VLOOKUP(Gi¸ trÞ  t×m, Vïng cÇn t×m,Cét cÇn lÊy): Thùc hiÖn viÖc t×m 
kiÕm mét gi¸ trÞ trong cét ®Çu tiªn cña vïng cÇn t×m vµ cho kÕt qu¶ t−¬ng 
øng trong cét cÇn lÊy (cét chØ ®Þnh). 
 

 
 
b. Hµm HLOOKUP 

 HLOOKUP(Gi¸ trÞ  t×m, Vïng cÇn t×m, Dßng cÇn lÊy): Thùc hiÖn viÖc t×m 
kiÕm mét gi¸ trÞ trong dßng ®Çu tiªn cña vïng cÇn t×m vµ cho kÕt qu¶ t−¬ng 
øng trong dßng cÇn lÊy (dßng chØ ®Þnh). 
 
* Chó ý khi dïng 2 hµm Vlookup, Hlookup:  

ë hµm Vlookup: Vïng cÇn t×m cã cét thø nhÊt ®−îc s¾p xÕp t¨ng dÇn (tõ 
trªn xuèng d−íi) 
ë hµm Hlookup: Vïng cÇn t×m cã dßng thø nhÊt ®−îc s¾p xÕp t¨ng dÇn (tõ 
tr¸i sang ph¶i). 
 

§©y lµ vïng d÷ 
liÖu 

Vïng cÇn t×m 

Cét thø 2 
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VÝ dô: 
 

 
 
 
 
 
 
6. Tæng hîp d÷ liÖu theo nhãm 
 
VÝ dô: Danh s¸ch SV gåm c¸c tr−êng: Hä tªn, Ngµy sinh, Líp, Khèi, §iÓm 
TB, Häc bæng ->TÝnh tiÒn häc bæng cho tõng khèi, tõng líp ®Æt d−íi tõng 
líp, khèi 
a. C¸c b−íc thùc hiÖn    
b1. S¾p xÕp d÷ liÖu cña b¶ng víi khãa lµ c¸c tr−êngcã thÓ tæng hîp theo 
nhãm 
b2. §Æt con trá vµo vïng CSDL 
b3. Vµo menu Data / Subtotal -> xuÊt hiÖn hép tho¹i 
 

 
 

®©y lµ vïng 
d÷ liÖu 

Vïng cÇn lÊy 

 dßng thø 2 
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  - Chän cét c¨n cø t¹o nhãm trong At each change in 
  - Chän hµm tÝnh tãan trong môc Use Function 
  - Chän c¸c cét sÏ thªm Subtotal vµo trong Add Subtotal to 

b4. KÝch OK 
 
b. VÝ dô    

 
 
c. Chó ý    

- C¸c nót        cho phÐp chän c¸c cÊp cña c¸c nhãm 
 

- NhÊn nót         :®Ó thu nhá nhãm, chØ hiÖn dßng tæng hîp cña nhãm 

- NhÊn nót          më réng ®Ó xem c¸c dßng chi tiÕt trong nhãm 
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Trong hép tho¹i Subtotal, c¸c nót chän cã ý nghÜa: 
����  Replace  current  subtotal: bËt / t¾t viÖc thay thÕ d÷ liÖu trong thao t¸c 
Subtotal míi cho d÷ liÖu cña Subtotal cò 
���� Page break between groups: bËt / t¾t viÖc tù ®éng chÌn ng¾t trang vµo 
gi÷a c¸c nhãm 
���� Summary below data: bËt / t¾t viÖc t¹o dßng tæng hîp ®Æt ngay d−íi tõng 
nhãm d÷ liÖu 
 

VIII. In b¶ng tÝnh 
Ta th−êng gÆp hai tr−êng hîp: 
- Ph©n trang tù ®éng  (nÕu c¶ trang tÝnh lµ 1 danh s¸ch) 
- Ph©n trang b»ng tay (nÕu trang tÝnh gåm nhiÒu danh s¸ch) 
 

1. §Æt trang in tù ®éng 

- §¸nh dÊu toµn danh s¸ch 
- Vµo File/Page setup 

 

                    
 
+ KÝch chän nót Page: §Ó chän kÝch cì, h−íng trang in 
 - Portrait: in däc  - Landscape: in ngang 
 - Paper size: chän cì giÊy 
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+ KÝch chän nót  Margin: ®Ó ®Æt lÒ trang in 
+KÝch chän nót Header/footer: ®Ó t¹o tiªu ®Ò ®Çu, cuèi trang in 

 
- MÉu tiªu ®Ò ®Çu, cuèi ®−îc chän ë b¶ng sau: 

                                                                                      

 
 

+ KÝch chän nót  Sheet: ®Ó t¹o cét/dßng ®Çu cho mäi trang in: 
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- Trong Print area: gâ ®Þa chØ tuyÖt ®èi cña b¶ng d÷ liÖu, 
VÝ dô: $A$1:$E$10 

-Trong Rows To repeat at top: gâ c¸c dßng mµ ta muèn 
in trong mäi trang in theo qui c¸ch:  $tªn dßng:$tªn dßng 
 VÝ dô: $1:$2. NghÜa lµ mäi trang in ®Òu in 2 dßng 1, 2 ë ®Çu 

b¶ng. 
- Trong Colums To repeat at left: gâ c¸c cét mµ ta muèn 

in trong mäi trang in theo qui c¸ch:  $ tªn cét:$tªn cét, VÝ dô: 
$A:$A. NghÜa lµ mäi trang in ®Òu in cét A ë cét ®Çu .(It dïng 
nÕu sè cét kh«ng qu¸ nhiÒu qu¸ khæ giÊy) 

 

2. §Æt trang in b»ng tay 

a. §Æt trang 
- §Æt con trá « ë gãc ph¶i d−íi cña trang dù ®Þnh,  
- Vµo Insert/Page Break 

 
b. Huû ®Æt trang 

- §Æt con trá « ë gãc ph¶i d−íi cña trang 
- Vµo Insert/ Remove Page Break 

3. In trang tÝnh 
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 Sau khi ®· ®Æt trang in (tù ®éng hoÆc b»ng tay) vµ t¹o c¸c tiªu ®Ò, 
®¸nh sè trang (nÕu cÇn) xong ta bËt m¸y in, l¾p giÊy vµ thùc hiÖn viÖc in, 
b»ng c¸ch chän menu: File / Print -> xuÊt hiÖn hép tho¹i: 
 

                       
 Trong hép tho¹i trªn ta chän: 
  + All: ®Ó in ra tÊt c¶ c¸c trang 
  + Pages: ®Ó in ra trang cô thÓ, b»ng c¸ch gâ sè trang vµo  From 
(in tõ trang), vµo To (®Õn trang)   

+ Cuèi cïng kÝch vµo OK. 

 
 

BÀI TẬP   EXCEL 
 
Bµi 1. 
§Ó qu¶n lý ®iÓm cña 1 líp, mçi häc sinh cã c¸c yÕu tè sau: hä vµ tªn, ngµy sinh, 
®iÓm cña c¸c m«n nh− To¸n, Lý, Ho¸, Sinh, V¨n, Sö, §Þa,... §iÓm cña mçi m«n 
®−îc tÝnh víi hÖ sè nµo ®ã. Tõng häc kú thÇy gi¸o ph¶i tÝnh ®iÓm trung b×nh cho 
tõng häc sinh (gi¶ sö víi 1 sè m«n) nh− sau: 
                         Danh s¸ch ®iÓm c¸c m«n cña líp 12A 
Stt Hä vµ tªn NS To¸n Lý Ho¸ V¨n Tb 
1 Lª V¨n An 20/3/84 8 8 9 9 8.5 
... ...       
1. X¸c ®Þnh kiÓu d÷ liÖu cña c¸c cét, c¸c th«ng tin ®éc lËp vµ th«ng tin phô thuéc  
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2. LËp biÓu b¶ng gåm c¸c cét, tr×nh bµy nh− trªn vµ vµo d÷ liÖu (vµo c¸c d÷ liÖu 
®éc lËp) cho 10 häc sinh. Ghi vµo tÖp. 

3. TÝnh ®iÓm TB cho mçi häc sinh. Ghi l¹i 
 Bµi 2.  
Hµng th¸ng, tõng häc kú thµy gi¸o cÇn thèng kª sè l−îng vµ tØ lÖ phÇn tr¨m häc 
sinh cña 1 líp thuéc c¸c lo¹i d−íi trung b×nh (DTB), trung b×nh (TB), kh¸ (KH) vµ 
giái (G).  Tr−íc hÕt thµy gi¸o ph¶i kÎ mét b¶ng   nh− h×nh sau vµ ®Õm sè l−îng 
(SL) ®èi víi tõng lo¹i ®Ó ghi vµo:                            

  Häc kú I 

  DTB TB KH G 
Th¸ng TS SL TL SL TL SL TL SL TL 

09 50 4  15  20  11  
10 50 3  16  17  14  
11 50 5  12  18  15  
12 50 6  10  19  15  

1. H·y lËp 1 b¶ng nh− trªn, ghi vµo tÖp 
2. TÝnh tØ lÖ (TL) cña mçi lo¹i trong tõng th¸ng (TL = SL/TS). Ghi l¹i tÖp 
 
Bµi 3. 
Mét kÕ to¸n ph¶i tÝnh l−¬ng cho c¸c c¸n bé, hä lËp mét b¶ng gåm c¸c cét: Stt, Hä 
vµ tªn, Ngµy c«ng (NC), L−¬ng chÝnh (LC) tÝnh theo ®¬n vÞ ngµn ®ång, TiÒn 
th−ëng (TT), trî cÊp (TC), Tæng sè (TS). Theo mÉu sau: 
Stt Hä vµ tªn NC LC TT TC TS 
1 TrÇn An B×nh 24 450    
2 . . .      
1. LËp mét b¶ng nh− trªn vµ vµo d÷ liÖu cho kho¶ng 5 ng−êi. Ghi vµo tÖp 
2. TÝnh tiÒn th−ëng theo sè ngµy c«ng: TT=NC*5      (5 ngµn ®ång) 
3. TÝnh trî cÊp theo møc phÇn tr¨m l−¬ng chÝnh ®−îc h−ëng, gi¶ sö lµ 30% 

l−¬ng chÝnh. 
4. TÝnh tæng sè tiÒn ®−îc lÜnh cña mçi ng−êi. Ghi l¹i tÖp 
Bµi 4. 
Mét HTX giao ruéng cho x· viªn canh t¸c. Hä lËp mét b¶ng ®Ó n¾m t×nh h×nh thu 
thuÕ. B¶ng nµy cã c¸c cét sau: Sè thø tù, Hä vµ tªn chñ hé, diÖn tÝch ®Êt h¹ng 1, 
diÖn tÝch ®Êt h¹ng 2, diÖn tÝch ®Êt h¹ng 3, møc thuÕ hµng n¨m cho mçi h¹ng ®Êt. 
Tæng céng thuÕ ph¶i ®ãng hµng n¨m ®èi víi mçi hé vµ ®èi víi c¶ HTX trªn mçi 
h¹ng ®Êt vµ toµn bé. (Møc thu thuÕ tÝnh trªn mét ®¬n vÞ diÖn tÝch chØ phô thuéc 
vµo h¹ng ®Êt) 
1. LËp b¶ng tÝnh ®Ó tÝnh thuÕ cho 5 x· viªn, ghi vµo tÖp 
2. TÝnh tæng céng thuÕ ph¶i ®ãng cña mçi x· viªn 
3. TÝnh tæng thuÕ cña mçi  h¹ng ®Êt vµ cña toµn bé (®Ó ë hµng cuèi) 

(L−u ý:Møc thuÕ cña 3 h¹ng ®Êt ®Ó ë 3 « cè ®Þnh, khi tÝnh thuÕ cña c¸c h¹ng ®Êt 
dïng ®Þa chØ tuyÖt ®èi) 
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Bµi 5. 
Mét danh s¸ch líp gåm c¸c cét: Hä vµ tªn, ngµy sinh, ®iÓmTo¸n, ®iÓm V¨n, ®iÓm 
Ngo¹i ng÷, ®iÓm TB (§TB), xÕp lo¹i, ghi chó. 
1. LËp b¶ng vµ  vµo d÷ liÖu cho kho¶ng 5 häc sinh (c¸c cét d÷ liÖu phô thuéc: 

§TB, xÕp lo¹i, ghi chó sÏ tÝnh to¸n vµ ®iÒn bëi c¸c c©u hái sau) 
2. TÝnh ®iÓm trung b×nh cho mçi häc sinh 
3. XÕp lo¹i cho mçi häc sinh dùa vµo ®iÓm trung b×nh :  

NÕu §TB<5 xÕp lo¹i Kh«ng ®¹t; NÕu §TB>=5 xÕp lo¹i §¹t 
4.  H·y lËp c«ng thøc tÝnh ®Ó cét Ghi chó sÏ ®−îc tù ®éng ghi dÊu * ®èi víi c¸c 

häc sinh cã §TB cao nhÊt (cã thÓ cã nhiÒu häc sinh cïng cã §TB cao nhÊt), cßn 
c¸c häc sinh kh¸c ghi dÊu - . (Gîi ý: t¹o ra mét « phô ghi §TB cao nhÊt ®Ó so 
s¸nh) 

*5. Thªm cét  Sinh chñ nhËt ®Ó ghi nh÷ng ng−êi sinh vµo Chñ nhËt. BiÕt r»ng  
ngµy 31/12/1996 lµ ngµy thø Ba. Sö dông c¸c hµm thÝch hîp ®Ó tù ®éng viÕt vµo 
cét nµy  ch÷ CN ®èi víi nh÷ng ng−êi sinh ®óng vµo chñ nhËt. (Gîi ý: Do ngµy 
31/12/1996 lµ ngµy thø ba nªn ngµy 5/1/1997 lµ Chñ nhËt, vËy tÊt c¶ c¸c ngµy 
chªnh víi ngµy 5/1/1997 mét sè ngµy chia hÕt cho 7 ®Òu lµ Chñ nhËt (dïng hµm 
ABS, hµm MOD vµ hµm IF ®Ó viÕt c«ng thøc cÇn thiÕt) . 

 
Bµi 6. 
LËp mét b¶ng tÝnh gåm nh÷ng th«ng tin sau: Hä, Tªn, Ngµy sinh, sè con, L−¬ng 
chÝnh, phô cÊp, Thu nhËp, Ghi chó. 
  1. Vµo d÷ liÖu cho 5 ng−êi 
  2. TÝnh thu nhËp cho mçi c¸n bé (Thu nhËp = L−¬ng chÝnh + phô cÊp) 
  3. Ghi chó sÏ ghi víi ®iÒu kiÖn nh− sau: 
      - Nh÷ng ng−êi sinh tõ 1936 trë vÒ tr−íc th× ghi VÒ H−u 
      - Nh÷ng ng−êi sinh sau 1936 th×  ghi Lµm ViÖc. 
4. VÏ ®å thÞ thÓ hiÖn sù t−¬ng quan  møc thu nhËp gi÷a c¸c c¸n bé  
5. S¾p xÕp b¶ng tÝnh sao cho cét Thu nhËp theo chiÒu gi¶m dÇn. 
6. §Õm sè ng−êi cã sè con tõ 2 trë xuèng, kÕt qu¶ ®Ó ë « A10 
7. ChØ ra møc thu nhËp cao nhÊt trong c¬ quan , kÕt qu¶ ®Ó ë « B10. Sau ®ã ®Õm 

tæng sè nh÷ng ng−êi cã møc thu nhËp cao nhÊt, kÕt qu¶ ®Ó ë «  B12. 
8. TÝnh tæng l−¬ng cña nh÷ng ng−êi VÒ h−u ®Ó ë « C14; tæng l−¬ng  cña nh÷ng 

ng−êi Lµm viÖc ®Ó ë « D14. 
9.  Läc vµ ®−a ra  danh s¸ch gåm nh÷ng ng−êi cã l−¬ng chÝnh >=425 

vµ sè con <=2. 
10. Läc vµ ®−a ra 1 danh s¸ch gåm nh÷ng ng−êi VÒ h−u,  1 danh s¸ch gåm nh÷ng 

ng−êi Lµm viÖc. 
 
Bµi 7. 
1. LËp mét b¶ng theo mÉu sau: 

Danh s¸ch kh¸ch hµng vay tiÒn tiÕt kiÖm 
     Ngµy tr¶: 12/6/97  
    % l·i qu¸ h¹n/ngµy: 0.0002  

Tªn kh¸ch §èi Ngµy Ngµy TiÒn vay TiÒn l·i TiÒn l·i Tæng céng 
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t−îng vay ®Õn h¹n qu¸ h¹n 
Thanh Hµ 1 12/6/96 12/6/97 2000000    
Anh Xu©n 2 20/2/94 15/6/96 1500000    
Hµ An 2 15/3/95 20/6/96 3000000    

Anh TuÊn 1 30/6/95 10/4/96 2500000    
Xu©n Thao 3 12/6/96 12/6/97 1000000    

        

 
2. TÝnh cét tiÒn l·i nh− sau: 
 - NÕu ®èi t−îng 1 th×  tiÒn l·i = TiÒn vay *(Ngµy ®Õn h¹n - ngµy vay) * 
0.001 
 - C¸c ®èi t−îng kh¸c  tiÒn l·i = TiÒn vay *(Ngµy ®Õn h¹n - ngµy vay) * 
0.002 
3. TÝnh tiÒn l·i qu¸ h¹n nh− sau:  
         TiÒn l·i qu¸ h¹n=TiÒn vay*(Ngµy tr¶-Ngµy ®Õn h¹n) * % L·i  qu¸ h¹n. 
4. TÝnh tiÒn tæng céng = TiÒn vay + tiÒn l·i + tiÒn l·i qu¸ h¹n. 
5. S¾p xÕp  tiÒn vay  theo chiÒu  gi¶m dÇn. 
6. §Õm sè ng−êi thuéc ®èi t−îng 1, kÕt qu¶ ®Ó ë « A14. 
7. TÝnh tæng tiÒn vay cña c¸c ®èi t−îng  lo¹i 2 hoÆc lo¹i 1, kÕt qu¶ ®Ó ë « B15. 
8. TÝnh tæng tiÒn Tæng céng cña nh÷ng ng−êi cã ngµy vay vµo n¨m 1995, kÕt qu¶ 
®Ó ë « C15 
8. VÏ ®å thÞ  so s¸nh tiÒn Tæng céng vµ TiÒn l·i cña tõng  kh¸ch hµng. 
9. §−a ra sè tiÒn vay cao nhÊt, Ýt nhÊt trong c¸c kh¸ch hµng 
10.  Läc ra mét danh s¸ch gåm c¸c ®èi t−îng lo¹i 1 cã ngµy vay sau 1/1/1996. 
 
Bµi 10. 
1. LËp mét b¶ng tÝnh vµ tr×nh bµy nh− mÉu sau: 

 
 
2) X¸c ®Þnh ®iÓm −u tiªn cho mçi ng−êi nh− sau: 
XLHTËp §iÓm

UT 
Cã thÓ dïng hµm IF hoÆc 
VLOOOKUP ®Ó x¸c ®Þnh ®iÓm 
−u tiªn cho mçi ng−êi 
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A 1 
B 0.5 
C 0 

3) TÝnh §iÓm TB nh− sau: §iÓm TB=(To¸n*2+V¨n*2+Lý+Sinh+Ngo¹i 
Ng÷+§iÓmUT)/7 
 
4) KÕt qu¶ xÕp nh− sau: 
    NÕu §iÓmTB<5 xÕp lo¹i YÕu; 5<=§iÓmTB<6.5 xÕp lo¹i TB; 6.5<=§iÓm TB<8 

xÕp lo¹i Kh¸; §iÓmTB>=8 xÕp lo¹i Giái. 
5) S¾p xÕp danh s¸ch sao cho §iÓm TB theo chiÒu gi¶m dÇn 
6) §iÒn sè thø tù tù ®éng vµo môc STT 
7) §Õm sè ng−êi ë líp 12A2, kÕt qu¶ ®Ó ë « B12 
8)  §−a ra 1 d¸nh s¸ch gåm nh÷ng ng−êi xÕp lo¹i häc tËp lµ A vµ  cã §iÓm TB>=7 
9) VÏ biÓu ®å so s¸nh ®iÓm TB cña mçi häc sinh 
Bµi 11.  

Danh s¸ch SV ®−îc cÊp häc bæng n¨m häc 200... –200 ... 
 
 Ngµy hiÖn t¹i: (cho ngµy cô thÓ h«m nay) 
Stt Hä vµ tªn Ngµy 

sinh 
M·
UT 

M«n 
1 

M«n 
2 

§iÓm  
TB 

TiÒn 
HB 

Ghi 
chó 

 NguyÔn  L©m  A1 8 9    
 Lª Tó Nam  A2 7 9    
 §oµn ThuThuû  B2 8 7    
 L©m Tó Trinh  B1 7 9    
 Ph¹m ThÞ Hoa  C2 9 8    
 L· BÝch Ngäc  C1 8 8    
 Hoµng  TiÕn  A2 9 7    
 Lª ThÞ Lan  B1 6 5    

1. NhËp d÷ liÖu theo b¶ng trªn (tù cho ngµy th¸ng n¨m sinh cho phï hîp ®é 
tuæi hiÖn nay ®ang häc §¹i häc) 
2. §iÒn sè thø tù cho cét STT 
3. TÝnh ®iÓm TB nh− sau: §iÓm TB= (M«n 1 + M«n 2 )+§iÓm UT 

ë ®ã  §iÓm UT cho mçi ng−êi ®−îc tÝnh nh− sau: 
NÕu M· UT=”A” th× §iÓm UT lµ 1; M· UT = “B” th× §iÓm UT=0.5; M· 

UT=”C” th× §iÓm UT=0. 
4. TiÒn HB (tiÒn häc bæng) tÝnh nh− sau: 
 NÕu §iÓm TB >=9 vµ tuæi <=20 th× häc bæng lµ  500000 
 NÕu 9>§iÓm TB>=8 vµ 22>=tuæi >20 th× häc bæng lµ 300000 
 Cßn l¹i kh«ng cÊp häc bæng. 
L−u ý: Tuæi = N¨m hiÖn t¹i – N¨m sinh 
5. TÝnh tæng häc bæng cña c¸c häc sinh cã M· UT víi c¸c ch÷ c¸i ®Çu lµ 
”A”; ”B”;”C” ®Ó kÕt qu¶ vµo 3 «: A12, B12, C12. 
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6. §Õm xem cã bao nhiªu häc sinh cã ®iÓm TB tõ 9 trë lªn vµ cã m«n 1>=8 
7. TrÝch ra 1 vïng kh¸c trªn b¶ng tÝnh: Nh÷ng häc sinh cã tiÒn häc bæng 
=500000 vµ m«n 1>=9. 
8. §iÒn vµo cét Ghi chó:  Nh÷ng ai sinh nhËt vµo ngµy h«m nay th× ghi 
“SN”, nÕu kh«ng ghi “-“. (Sau ®ã thö 1 vµi ng−êi trong danh s¸ch cã  sinh 
nhËt vµo  h«m nay) 
9. S¾p xÕp  danh s¸ch trªn sao cho cét TiÒn HB gi¶m dÇn nÕu TiÒn HB  trïng 
nhau th× s¾p xÕp §iÓm TB t¨ng dÇn. 
10. VÏ ®å thÞ so s¸nh ®iÓm 2 m«n cña mçi häc sinh. 
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BÀI 1 

TỔNG QUAN VỀ EXCEL 

1.1. Giới thiệu - Các chức năng chính của Excel 

1. Giới thiệu 

Excel là trình ứng dụng bảng tính trong Windows, thuộc bộ công cụ văn phòng 

Microsoft Office (MsOffice). Excel là ứng dụng đa văn bản – nghĩa là có thể mở đồng 

thời nhiều hơn một cửa sổ văn bản. Các thao tác trong Excel tuân theo tiêu chuẩn của 

Windows, nhƣ: làm việc với cửa sổ, các hộp đối thoại, hệ thống menu, sử dụng mouse, 

các biểu tƣợng lệnh... 

Excel có thể đƣợc cài đặt một cách độc lập, nhƣng thông thƣờng là qua bộ cài đặt 

MsOffice. Đƣờng dẫn đến chƣơng trình EXCEL.EXE thƣờng là ...Programs\Microsoft 

Office\ 

2. Các chức năng chính của Excel 

Là một ứng dụng bảng tính, mỗi cửa sổ văn bản của Excel là một WorkBook, 

trong đó gồm nhiều Sheet – mỗi Sheet có thể là bảng tính, biểu đồ hoặc macro bảng 

tính. Các Sheet có thể độc lập hoặc phụ thuộc nhau tùy vào sự tổ chức của ngƣời sử 

dụng. Khi lƣu (save) WorkBook, Excel tự động thêm phần mở rộng là XLS. 

Chức năng chính của Excel bao gồm: 

- tính toán, phân tích, tạo biểu đồ, lập báo cáo...  trên các dữ liệu đƣợc tổ chức 

theo dạng bảng 2 chiều (mô hình quan hệ). 

- chia sẻ dữ liệu với các ứng dụng khác 

Các chức năng này một phần đƣợc thực hiện thông qua các hàm đã đƣợc thiết kế 

sẵn hoặc hàm do ngƣời sử dụng tự tạo; phần khác thông qua các công cụ đƣợc tổ chức 

trong hệ thống menu hoặc biểu tƣợng lệnh. 

Là ứng dụng trong bộ MsOffice nên Excel đƣợc tối ƣu hóa để sử dụng các tính 

năng bổ sung, nhƣ nhập văn bản từ Word, tạo chữ nghệ thuật từ WordArt, chèn văn 

bản toán học từ Equation, bổ sung hình ảnh từ ClipArt Gallery... Ngƣợc lại, Excel 

cũng cung cấp các phƣơng thức để các ứng dụng khác có thể sử dụng đƣợc các chức 

năng mạnh của nó. 

Ngoài ra, Excel còn đƣợc thiết kế để có thể sử dụng các nguồn dữ liệu từ các ứng 

dụng khác, nhƣ dữ liệu từ FoxPro, từ Lotus 1-2-3... 

1.2. Khởi động và kết thúc Excel 

1. Khởi động 

Có nhiều cách khởi động chƣơng trình Excel, dƣới đây là một số cách thông dụng: 

+ Chọn biểu tƣợng Excel từ thanh Shortcut Bar hoặc thanh Quick Launch (nếu 

có) 
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   thanh Quick Launch 

+ Từ nút Start : [START]\Programs\(Microsoft Office)\Microsoft Office Excel 

  
+ Hoặc khởi động từ biểu tƣợng Excel trong cửa sổ Windows Explorer 

 

2. Kết thúc 

Sau khi hoàn tất phiên làm việc trong Excel, ta kết thúc nó bằng một trong các 

cách sau: 

+ Chọn lệnh từ menu: [FILE]\Exit 

+ Nhấn vào nút đóng cửa sổ  [] ở góc trên phải, hoặc nhấn Alt–F4... 

F Nếu các WorkBook có sửa đổi và chƣa ghi lại sự thay đổi, thì Excel sẽ yêu cầu ta 

xác nhận việc có ghi hay không trƣớc khi kết thúc. Chọn [Yes] để ghi, [No] để kết 

thúc và không ghi, nhấn [Cancel] để hủy lệnh và tiếp tục làm việc với Excel. 

 
- Cần phải hoàn tất thao tác nhập dữ liệu trong 1 ô (nếu đang nhập dở dang) trƣớc 

khi kết thúc cửa sổ WorkBook. 
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1.3. Các thành phần và khái niệm cơ bản 

1. Cửa sổ ứng dụng 

 
Cửa sổ chính của Excel là vùng màn hình chứa chƣơng trình Excel khi nó đƣợc 

khởi động, tƣơng tự nhƣ các cửa sổ ứng dụng khác trong Windows. Gồm các thành 

phần nhƣ: các đƣờng viền giới hạn kích thƣớc cửa sổ; thanh tiêu đề chứa tiêu đề 

chƣơng trình và tên WorkBook đang làm việc; thanh menu ngang, các thanh công cụ 

(Toolbar) chứa các biểu tƣợng lệnh; các nút lệnh của cửa sổ (hộp điều khiển, nút 

Minimize, Maximize/Restore, Close); vùng làm việc (desktop) và cuối cùng là dòng 

trạng thái chứa thông báo và trạng thái làm việc. 

2. Cửa sổ workbook (văn bản) 

Ngay sau khi khởi động, thông thƣờng Excel đƣa ra một workbook mới để ngƣời 

sử dụng có thể bắt đầu làm việc. WorkBook này đƣợc đặt trong một cửa sổ văn bản 

nằm trong vùng desktop của cửa sổ ứng dụng.  

Khi đƣợc maximize (cực đại hóa), tiêu đề của cửa sổ workbook nằm chung với 

tiêu đề của chƣơng trình. Mỗi Workbook bao gồm nhiều Sheet. Mỗi Sheet là một lƣới 

các ô (cell) đƣợc tổ chức thành hàng (row) và cột (column). 

     Row 

 WorkBook ® Sheet    Cell 

     Column 

Ngay phía trên vùng bảng tính có 2 thành phần: một là hộp tên (Name Box) chứa 

tên của ô (hoặc dãy các ô) hiện thời đang đƣợc chọn; hai là thanh công thức (Formula 
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Bar) chứa nội dung hoặc cho phép nhập nội dung của ô đang chọn. Phía dƣới là thanh 

chứa tên các sheet trong workbook và thanh cuốn ngang, bên phải là thanh cuốn dọc. 

3. Tổ chức bảng tính (sheet) trong Excel 

a. Đánh địa chỉ hàng, cột và ô 

Trong Excel, hàng đƣợc đánh số (gán nhãn) từ 1, 2,.. đến 16384 (hoặc 65536); cột 

đƣợc đánh thứ tự từ A, B, ..., Z, AA, ..., IV (256 cột). Giao của cột và hàng là ô (cell) 

với địa chỉ xác định là: [nhãn cột][nhãn dòng], ví dụ: ô F15 là giao của cột F và dòng 

15, hoặc đƣợc xác định theo cách R[số hiệu dòng]C[số hiệu cột], nhƣ R5C8 là ô tại 

dòng 5 cột 8 (tức cột H). 

Đối với ô trong một sheet của một workbook nào đó, thì địa chỉ dạng đầy đủ là: 

‘Path\[Tên_workbook]Tên_Sheet’!Tham_chiếu_ô 

Trong đó: 

+ Path là đƣờng dẫn đầy đủ của workbook sẽ tham chiếu; 

+ Tham_chiếu_ô hoặc là tên 1 ô, hoặc một khoảng các ô. 

Khoảng các ô là tập hợp các ô có dạng:  một dãy liên tục các ô (giới hạn trong 

một khung hình chữ nhật) và/hoặc các ô rời rạc. Trong đó các ô liên tục (khoảng các ô) 

đƣợc viết theo dạng ô_đầu_tiên_trên_trái:ô_cuối_cùng_dưới_phải, ví dụ: A4:C7 là 

khoảng liên tục 12 ô giới hạn bởi 3 cột (A, B, C) và 4 hàng (4, 5, 6, 7); các ô rời rạc 

cách nhau bởi dấu phân cách (thông thƣờng là dấu phẩy), ví dụ: C5, E9, F12 là dãy 3 ô 

rời nhau. 

b. Nội dung của các ô 

Mỗi ô có thể chứa dữ liệu hoặc công thức tính toán. 

Ÿ Dữ liệu có thể là : 

- chuỗi ký tự (character/string) ví dụ Họ và tên 

-  số  (numeric)   125 

-  ngày  (date)    08/12/1998 

-  giờ  (time)    8:15:25 

Ÿ Công thức tính toán có dạng: ký tự đầu tiên là dấu bằng (=) tiếp theo là một biểu 

thức. Ví dụ: tại ô A3 nếu ta nhập =5+3 thì sau khi nhấn Enter, nội dung của A3 sẽ 

là 8. 

+ Biểu thức tính toán đƣợc định nghĩa là một tập hợp các toán tử và toán hạng 

đƣợc viết theo quy tắc (cú pháp) do Excel quy định. Trong đó: 

. Toán tử là các phép toán số học: + (cộng), - (trừ), * (nhân), / (chia), % (phần 

trăm), ^ (lũy thừa); hoặc các toán tử so sánh: < (nhỏ hơn: less than), > (lớn hơn: 

greater than), = (bằng: equal to), <= (nhỏ hơn hoặc bằng: less than or equal to), >= 

(lớn hơn hoặc bằng: greater than or equal to), <> (không bằng: not equal to), và 

toán tử nối chuỗi & (ví dụ: “HO”&“TEN” ® “HOTEN”). 

. Toán hạng có thể là giá trị hằng (constant), một tham chiếu ô, một nhãn (label), 

tên (name) hoặc là một hàm (function) của workbook. Các hằng chuỗi đƣợc bao 

trong cặp nháy kép “ ”. 

Ÿ Hàm (function) có dạng: Tên_hàm(danh sách đối số – nếu có), trong đó cặp ngoặt 

đơn là bắt buột. Do hàm thực hiện một quá trình xử lý hay tính toán và trả về một 
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kết quả nên nó có thể xuất hiện bất kỳ ở đâu trong một biểu thức mà ở đó có thể có 

một toán hạng. Ngoài ra, Excel còn cho phép khả năng các hàm lồng nhau, nghĩa 

là một hàm có thể xuất hiện trong danh sách đối số của một hàm khác. Ví dụ: 

SUM(A1, SUM(C5:F7)) 

F Ví dụ về công thức: = 15 + (4 * A6) – SUM(B2:B4) 

 Trong đó: 5, 4 là các hằng; A6, B2:B4 là các tham chiếu ô; SUM là tên hàm; 

+ * – là các toán tử. 

F Giá trị của công thức đƣợc Excel tự động cập nhật khi có sự thay đổi liên quan đến 

mỗi một giá trị của toán hạng trong đó. 

c. Tham chiếu tƣơng đối và tuyệt đối 

Để tham chiếu đến các ô, có hai cách: tham chiếu tƣơng đối và tham chiếu tuyệt đối. 

Ÿ Tham chiếu tƣơng đối xác định vị trí tƣơng đối từ ô chứa tham chiếu đến ô đƣợc 

tham chiếu. Ví dụ: trong công thức tại ô C3 có chứa tham chiếu đến ô A2 đƣợc 

hiểu nhƣ là: xuất phát tại ô hiện thời (C3) sang trái 2 cột (từ C sang A) và di 

chuyển lên 1 hàng (từ hàng thứ 3 lên 2) để lấy dữ liệu tại đó. 

- Với tham chiếu tƣơng đối, khi ngƣời sử dụng sao chép công thức từ ô này sang ô 

khác thì giá trị tham chiếu tự động thay đổi. Ví dụ, nếu sao chép công thức trong 

C3 ở trên sang K5 thì tham chiếu đến A2 sẽ đổi lại là I4 (giữ nguyên sự tƣơng đối 

từ K5 đến I4: sang trái 2 và lên 1). 

- Từ đây suy ra, nếu sao chép công thức theo chiều dọc thì số hiệu hàng sẽ bị thay 

đổi, số hiệu cột đƣợc giữ nguyên. Tƣơng tự, nếu sao chép theo chiều ngang thì gía 

trị cột bị thay đổi, giữ lại số hiệu dòng. 

- Ví dụ: xét bảng sau: 

 C D F 

12 5 7 =SUM(C12:D12) 

13 6 8 =SUM(C13:D13) 

14 4 9 ? 

15 =SUM(C12:C14) =SUM(D12:D14)  

Tại ô F12 nhập công thức tính tổng các ô từ C12 đến D12, khi đó nếu sao chép 

công thức đến ô F13 thì tham chiếu sẽ thay đổi thành tổng các ô từ C13 đến D13, sao 

chép đến F14 thì sẽ thành =SUM(C14:D14). Tƣơng tự, khi chép ngang từ C15 sang 

D15 thì số hiệu 12 và 14 không đổi, mà đổi giá trị cột từ C sang D. 

Ÿ Tham chiếu tuyệt đối xác định sự tuyệt đối trong cách tham chiếu, nghĩa là luôn 

hƣớng đến các vị trí cố định (theo hàng và/hoặc theo cột) nào đó của bảng tính khi 

sao chép công thức. Vì ô đƣợc xác định bởi hàng và cột, nên sự tuyệt đối ở đây có 

thể chỉ tác động đến hàng, đến cột hoặc cả hai. Excel dùng ký tự $ đặt trƣớc tên 

hàng hoặc tên cột để chỉ sự tuyệt đối. Ví dụ, E1 chứa công thức = $A$1 + $B1 + 

C$1 + D1, bao gồm tuyệt đối ở A1, tuyệt đối theo hàng ở B1, theo cột ở C1 và 

tƣơng đối ở D1. Khi đó nếu sao chép công thức này đến ô H5 thì sẽ tự động đổi lại 

là: = $A$1 + $B5 + F$1 + G5. 

F Tên của một khoảng các ô đƣợc xem là một tham chiếu tuyệt đối. 

F Trong thực hành, sau khi nhập tham chiếu ô ta dùng phím F4 để chuyển đổi giữa 

các loại tham chiếu 
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d. Đặt tên cho một khoảng ô 

Một khoảng các ô có thể đƣợc gán bởi một tên để dễ sử dụng. Ví dụ, thay cho việc 

viết công thức: = SUM(E7:E9) với E7 đến E9 chứa dữ liệu về doanh số bán của 3 

tháng 7, 8 và 9 ta có thể viết: = SUM(Quy3), trong đó Quy3 đại diện cho các khoảng 

các ô E7:E9. Để thực hiện điều này ta tiến hành nhƣ sau: 

1. Chọn các ô E7 đến E9 (drag ngang qua các ô E7, E8 và E9) 

2. Click mouse vào hộp tên (Name Box) và nhập vào đó tên: Quy3 

3. Nhấn Enter để xác nhận việc đặt tên cho các ô đang chọn. 

F Hoặc có thể sử dụng menu [INSERT]\Name\Define  nhƣ sau: 

 
- Lƣu ý đến dòng cuối, tham chiếu đến khoảng ô E7:E9 đã đƣợc Excel tự động 

chuyển thành tham chiếu tuyệt đối. Nếu muốn xóa một tên đã định nghĩa ta chọn 

tên cần xóa và dùng nút [Delete]. 

 Sau khi đã gán tên cho một khoảng ô, ta có thể kiểm tra lại tên bằng cách chọn lại 

khoảng ô đó, nếu thấy xuất hiện tên trong hộp tên thì đã gán đúng, ngƣợc lại cần 

xóa tên đã gán sai và tiến hành gán lại. 

 Hộp tên còn cho phép ta chọn hoặc chuyển nhanh đến một khoảng ô: Chỉ cần nhập 

tên, hoặc tham chiếu ô vào hộp tên thì Excel sẽ tự động chọn và chuyển vị trí màn 

hình đến vùng đƣợc chọn. 

- Hƣớng dẫn đặt tên: 

   
(b1. Chọn các ô cần đặt tên  b2. Click vào hộp tên và nhập tên  b3. Nhấn Enter) 

Kiểm tra lại tên đã đặt: click vào nút [


] ta nhìn thấy tên đã đặt trong hộp rơi xuống. 
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- Xóa tên đã gán sai: dùng menu [Insert]\Name\Define... 

 

 Trong hộp [Define Name], ta chọn tên cần xóa và chọn nút [Delete]. 
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BÀI 2 

LÀM VIÊC VỚI BẢNG TÍNH 

2.1. Các thao các cơ bản 

1. Chọn các ô, hàng, cột 

- Chọn 1 ô: click vào ô muốn chọn 

- Chọn nhiều ô liên tục: chọn ô đầu tiên (góc trên trái) của khoảng cần chọn, sau đó 

drag (kéo lê) mouse (hoặc shift-click) đến vị trí cuối (góc dƣới phải) . 

- Để chọn thêm các ô rời rạc nhấn giữ phím Ctrl trong khi click vào các ô. 

F Ngoài ra, còn có thể chọn nhanh bằng cách nhập khoảng cần chọn vào hộp tên. 

- Việc chọn hàng hoặc cột tƣơng tự nhƣ chọn ô. Thay cho click vào ô, ta click vào 

nhãn cột hoặc số hiệu hàng để chọn 1 cột hoặc 1 hàng. Chọn nhiều liên tục bằng 

kỹ thuật drag hoặc shift-click. Chọn rời rạc bằng Ctrl-click. 

  
(Drag ở đầu dòng, đầu cột để chọn một hoặc nhiều dòng và chọn một hoặc nhiều cột) 

2. Các cách thực hiện lệnh 

- Dùng menu hoặc shortcut menu (dùng Right-click) 

 
- Dùng biểu tƣợng lệnh trong thanh công cụ 
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- Dùng phím tắt 

 

3. Chèn, xóa các ô, hàng, cột 

1- Chọn các ô, hàng, cột cần tác động 

2- Click mouse phải (Right-click) làm xuất hiện shortcut menu 

3- Chọn lệnh thích hợp từ shortcut menu: 

Insert  để chèn thêm 

Delete  để xóa 

Clear contents để xóa nội dung các ô (hoặc nhấn phím Del) 

F Có thể dùng menu thay cho việc nhấn R-click. Menu [Edit]\Del hoặc [Edit]\Clear 

để xóa. Menu [Insert]\Cells, Rows hoặc Columns để chèn thêm. 

F Số đối tƣợng chèn thêm vào hoặc xóa đi bằng với số đối tƣợng đã chọn (ví dụ, nếu 

đang chọn 3 hàng thì lệnh Insert sẽ chèn 3 hàng) 

4. Nhập và sửa chữa nội dung của ô 

Ÿ Nhập: Chọn ô, sau đó nhập nội dung. Lƣu ý đến cách thức Excel chỉnh lề tùy 

thuộc vào dạng dữ liệu sẽ nhập. Nếu là chuỗi ® chỉnh trái; ngày, giờ hoặc số ® chỉnh 

phải. Để nhập chuỗi các số nhƣ 2356 ta thêm dấu nháy đơn („) phía trƣớc chuỗi số 

này: „2356. Kết thúc việc nhập nội dung bằng phía Enter. Nếu không muốn thay đổi 

nội dung đã có trƣớc đó thì nhấn Esc. 

Ÿ Sửa: Nhấn Double-click (D-click) hoặc F2 vào một ô đang chọn để sửa chữa 

nội dung, nếu chỉ click vào ô thì dữ liệu nhập vào sẽ thay dữ liệu đã có trƣớc đó. Trong 

chế độ sửa chữa có thể dùng các phím ¬, ®, Home, End để di chuyển. 

Dùng dấu bằng (=) để bắt đầu nhập công thức. Nếu trong công thức cần tham 

chiếu ô thì hoặc là tự nhập tên các ô cần tham chiếu, hoặc là dùng mouse để chọn. 

Ví dụ: tại ô D7 cần nhập công thức tính: = B7 + C7, đầu tiên nhập dấu =, sau đó 

dùng mouse click vào ô B7, nhập dấu + và click vào C7 và nhấn Enter để hoàn tất. 

Tiến hành tƣơng tự đối với khoảng liên tục các ô (dùng drag thay cho click). 

 

  nhấn enter ta đƣợc   

 Tạo dạng ô (Format Cells): Excel cung cấp nhiều khả năng trong việc thay đổi 

dạng thức của một ô. Ví dụ: đối với 1 con số có thể đƣợc biểu diễn bằng nhiều dạng: 

nó có thể là số, là ngày, giờ, biểu diễn phần trăm, tiền tệ với ký hiệu $, đ... 
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 Để tạo dạng một hoặc nhiều ô, đầu tiên ta chọn chúng, sau đó dùng menu 

[Format]Cells hoặc nhấn phím phải và chọn Format Cells 

  
Trong hộp thoại có chứa nhiều mục phục vụ cho việc tạo dạng. Chúng bao gồm: 

- Mục [Number] dùng để tạo dạng số, gồm: Number tạo dạng các con số, Currency 

dạng tiền tệ; Date, Time dạng ngày giờ; Percentage dạng phần trăm; Fraction dạng 

phân số; Text dạng văn bản... 

 Custom là dạng đặc biệt, nó cho phép ngƣời sử dụng tự điều chỉnh việc tạo dạng. 

Một số mã tạo dạng hay dùng là: 

* Mã tạo dạng số: (ví dụ số cần tạo dạng: 3149.457) 

Mã Kết quả Ý nghĩa 

0 3149 Làm tròn đến hàng đơn vị (không có số lẻ) 

0.00 3149.46 Lấy 2 chữ số lẻ 

#,##0 3,149 Có ký tự phân cách nhóm 3 số và làm tròn 

0.00% 314945.70% Theo dạng % có hai số lẻ 

0.00 “đ” 3149.46 đ Thêm chuỗi vào kết quả (trong cặp “ ”) 

* Mã tạo dạng ngày (ví dụ: ngày 15 tháng 7 năm 1999) 

Mã Kết quả Ý nghĩa 

dd/mm/yy 15/07/99 ngày/tháng/năm, mỗi vị trí có 2 số 

mm/dd/yy 07/15/99 tháng/ngày/năm, mỗi vị trí có 2 số 

mm/dd/yyyy 07/15/1999 năm có 4 chữ số 

dd-mmm-yy 15-Jul-99 tên tháng có 3 ký tự viết tắt 

- Mục [Alignment] dùng để chỉnh sắp dữ liệu theo 2 hƣớng: ngang (Horizontal), 

đứng (Vertical); và điều khiển việc cho phép văn bản xuống dòng (Wrap text) hay 
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trải lấp sang các ô bên cạnh. Ngoài ra còn cho phép quay văn bản theo các góc 

quay khác nhau. 

- Mục [Font] dùng để tạo dạng về font chữ. 

- Mục [Border] dùng cho việc thiết lập đƣờng viền của các ô với rất nhiều lựa chọn: 

 

5. Tạo dãy tự động 

Một dãy số liệu liên tục (ví dụ: a1, a2,...) có thể đƣợc tạo ra một cách tự động bằng 

cách nhập số liệu đầu (a1), sau đó chọn nó sẽ làm xuất hiện một nút vuông nhỏ ở góc 

dƣới phải, di chuyển mouse đến vị trí này (mouse có hình dấu cộng) kéo lê nút vuông 

đến ô cuối của dãy số liệu sẽ tạo ra một dãy liên tục. Nếu dãy là dãy số (ví dụ: 1, 2, ...) 

thì phải nhấn thêm phím Ctrl để tạo dãy liên tục. Nếu ô đầu tiên là công thức thì việc 

kéo nút điều khiển sẽ sao chép công thức đến các ô, khi đó các tham chiếu sẽ đƣợc 

điều chỉnh tự động. 

  Drag   

2.2. Sử dụng menu FILE 

Menu File chứa các lệnh tác động lên tổng thể workbook, bao gồm: 

+ New Bắt đầu tạo mới một workbook. 

+ Open Mở một workbook đã ghi trƣớc đó. 

+ Close Đóng cửa sổ workbook đang làm việc. 
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+ Save Ghi workbook đang làm việc ra file. Toàn bộ Sheet có trong 

workbook sẽ cùng đƣợc lƣu trữ trong một file có phần mở rộng 

là XLS. 

+ Save as Ghi ra dƣới một tên mới. Nếu là lần đầu tiên ghi file thì chức 

năng này sẽ tự động đƣợc chọn thay cho Save. 

+ Print preview Xem tổng thể workbook trƣớc khi in chính thức. 

+ Print In toàn bộ workbook, hoặc chỉ in Sheet đang làm việc hiện thời. 

+ Exit Kết thúc phiên làm việc với Excel. 

2.3. Sử dụng hàm (function) trong công thức 

Hàm có thể đƣợc nhập trực tiếp trong công thức hoặc sử dụng công cụ chèn hàm 

của Excel. Để chèn hàm vào công thức, dùng menu [Insert]Function hoặc click vào 

biểu tƣợng Function Wizard [fx]. 

  
Trong hộp thoại Function Wizard có hai bảng, bên trái là chủ đề các hàm, bên phải 

là hàm sẽ chọn. Các hàm đƣợc tổ chức theo chủ đề để dễ sử dụng. Sau khi chọn đƣợc 

hàm thích hợp, sẽ thực hiện tiếp các bƣớc còn lại để nhập nội dung cho các đối số của 

hàm. Ví dụ, đối với hàm SUM cần chỉ ra khoảng các ô sẽ lấy tổng... 

 
Trong quá trình nhập nội dung, để tham chiếu đến các ô ta có thể dùng mouse để 

chỉ định các ô cần tham chiếu mà không cần phải nhập trực tiếp. Cũng có thể sử dụng 

việc đặt tên để đơn giản hóa việc quản lý các ô. Sau khi hoàn tất nhấn [Finish] hoặc 

[OK] để kết thúc. 

 Lƣu ý: nếu tiến trình nhập công thức ở một ô chƣa xong thì không thể kết thúc 

Excel, khi đó sẽ có thông báo lỗi về việc chƣa hoàn tất công thức (hoặc trong công 

thức có lỗi) 

Chủ đề: 

Các hàm thƣờng dùng 

Liệt kê tất cả các hàm 

Các hàm tài chính 

Ngày và giờ 

Toán và lƣợng giác 

Thống kê 

Tìm kiếm và tham chiếu 

Hàm cơ sở dữ liệu 

Hàm văn bản 

Hàm lôgic 

Hàm thông tin 
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- Và tiếp đó là thông báo không thể kết thúc Excel: 

 
 Để giải quyết lỗi này, ta nhấn OK để quay về ô chứa công thức đang nhập và nhấn 

ESC để hủy công thức, sau đó sẽ có thể kết thúc Excel bình thƣờng. 
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BÀI 3 

CÁC HÀM THƢỜNG DÙNG TRONG EXCEL 

3.1. Các hàm tính toán và thống kê (Statistical) 

1. Hàm Sum 

* Cú pháp: SUM(danh sách đối số) 

 Hàm Sum tính tổng các số có mặt trong danh sách đối số của nó. 

* Trong đó: danh sách đối số có thể là hằng (số hoặc chuỗi số), khoảng các ô  

chứa số hoặc một hàm trả về giá trị kiểu số. 

* Ví dụ: Sum(2, “4”, True) = 7, 

     vì “4” đƣợc chuyển thành số 4;  True=1 (False=0) 

   Nếu C2 chứa 7; C3 là 4; C4 là 10 thì Sum(C2:C4) = 21 

2. Hàm Max 

* Cú pháp: MAX(danh sách đối số) 

 Hàm Max trả lại giá trị số lớn nhất trong danh sách đối số. 

* Ví dụ: Max(2, 5, 7) = 7 

   Nếu C2 chứa 7; C3 là 4; C4 là 10 thì Max(C2:C4) = 10 

3. Hàm Min 

* Cú pháp: MIN(danh sách đối số) 

 Hàm Min trả lại giá trị số nhỏ nhất trong danh sách đối số. 

4. Hàm Average 

* Cú pháp: AVERAGE(danh sách đối số) 

 Hàm Average trả lại giá trị trung bình cộng của các số trong danh sách đối số. 

* Ví dụ: Average(2, 5, 7) = 4.66(6) 

 Nếu C2 chứa 7; C3 là 4; C4 là 10 thì Average(C2:C4) = (7+4+10)/3 = 7 

5. Hàm Round 

* Cú pháp: ROUND(số, số_chữ_số) 

 Hàm Round trả lại giá trị số (kiểu số thực) đã đƣợc làm tròn đến độ chính xác tùy 

thuộc vào số_chữ _số. Nếu: 

- số chữ số > 0 làm tròn phần lẻ  ví dụ: Round(21.546, 2) = 21.55 

- số chữ số = 0 lấy số nguyên gần nhất ví dụ: Round(21.546, 0) = 22 

- số chữ số < 0 làm tròn phần nguyên ví dụ: Round(21.546, -1) = 20 

6. Hàm Int 

* Cú pháp: INT(số) 

 Hàm Int trả lại phần nguyên của số (làm tròn số đến số nguyên gần bằng nhất) 

 So sánh với hàm Round(n, 0) là hàm làm tròn trên, Int là hàm làm tròn dƣới. 
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* Ví dụ: Int(2.57) = 2; Int(7/4) = 1; Int(-3.49) = -4 

7. Hàm Mod 

* Cú pháp: MOD(số, số chia) 

Hàm Mod tính phần dƣ trong phép chia nguyên của số với số chia 

* Ví dụ: Mod(13, 4) = 1 vì 13 chia 4 đƣợc 3, dƣ 1 

 Giả sử tại ô C3 chứa số ngày làm việc, khi đó công thức = Int(C3/7) sẽ cho số 

tuần; và công thức = Mod(C3, 7) cho lại số ngày lẻ. 

8. Hàm Count 

* Cú pháp: COUNT(danh sách đối số) 

Danh sách đối số có thể là các giá trị số, ngày, logic, chuỗi... hoặc một danh sách 

tham chiếu. Hàm Count đếm các giá trị kiểu số (hoặc giá trị có thể chuyển tự động 

thành kiểu số, nhƣ: kiểu ngày, chuỗi số, lôgic...) có mặt trong danh sách đối số. Hàm 

này có thể kết hợp với hàm Sum để thay cho Average khi cần đảm bảo tính chính xác 

của phép lấy trung bình một khoảng giá trị mà không chắc các giá trị này là số. 

* Ví dụ: Count(13, “432”, “abc”) = 2   vì chuỗi 432 được chuyển thành giá trị số 

   Count(12/8/98, TRUE) = 2     các kiểu ngày, lôgic được chuyển thành số 

9. Hàm CountA 

* Cú pháp: COUNTA(danh sách đối số) 

Hàm CountA đếm số các giá trị có mặt trong danh sách đối số và chỉ bỏ qua không 

đếm các ô rỗng trong khoảng tham chiếu. 

* Ví dụ: Xét 4 ô A1:D1 nhƣ sau: 

 A B C D 

1 xy  25 True 

 Khi đó: CountA(A1:D1) = 3 vì B1 rỗng 

10. Hàm Rank 

* Cú pháp: RANK(số cần xếp hạng, danh sách số, phương pháp sắp) 

Hàm Rank trả lại thứ hạng của số cần xếp hạng theo các giá trị của danh sách số. 

Nếu phương pháp sắp bằng 0 (hoặc bỏ qua) thì danh sách số đƣợc sắp theo thứ tự 

giảm dần, ngƣợc lại là thứ tự tăng dần trƣớc khi so sánh giá trị. Ví dụ nếu cần sắp thứ 

hạng học lực thì phương pháp sắp sẽ là 0, nếu cần sắp thứ hạng thành tích vận động 

viên theo thời gian thì phương pháp sắp sẽ khác 0 (bằng 1 chẳng hạn). Đối với các giá 

trị bằng nhau trong danh sách số thì thứ hạng tƣơng ứng của chúng sẽ bằng nhau. 

* Ví dụ: 

 Giả sử các ô từ A1 đến A5 chứa giá trị tƣơng ứng là 5, 6, 9, 4, 8 

 Khi đó: Rank(A1, A1:A5, 1) = 2 (thứ tự tăng: 4, 5, 6, 8, 9) 

 nhƣng:  Rank(A1, A1:A5, 0) = 4 (thứ tự giảm: 9, 8, 6, 5, 4) 

 Ví dụ tổng hợp về các hàm tính toán, thống kê: 

 A B C D E F G 

1 5 7 6 =SUM(A1:C1) =MAX(A1:C1) =MIN(A1:C1) =AVERAGE(A1:C1) 

2 3 9 8 =SUM(A2:C2) 2 2.57 21.546 

3 2 4 7 =SUM(A3:C3) =MOD(B2,E2) =INT(F2) =ROUND(G2,2) 
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4 6 9 5 =SUM(A4:C4) =RANK(A1,A1:A4,0)  =ROUND(G2,0) 

5 a  x =COUNT(A4:C5) =COUNTA(A4:C5)  =ROUND(G2,-1) 

Từ các công thức và số liệu cho ở trên, ta có các kết quả sau: 

 

3.2. Các hàm lôgic 

Các hàm logic thƣờng sử dụng, hoặc tạo ra - các biểu thức logic. Biểu thức logic là 

một biểu thức đƣợc lƣợng giá bởi hai giá trị: đúng (True = 1) và sai (False = 0). Trong 

đó các toán hạng có thể là hằng, tham chiếu ô, kết quả của một hàm... nhƣng chúng 

đƣợc liên kết với nhau bởi các toán tử so sánh (<, >, =, <=, >=, <>) và có thể là đối số 

của các hàm logic (And, Or, Not...) 

Ví dụ: Các biểu thức sau cho giá trị True: 

   5 > 4;  “A” < “C” (so sánh chuỗi) 

  Các biểu thức sau cho giá trị False: 

   (3+5) <> 8; (2*10) = ((5-2)*9) 

1. Hàm And 

* Cú pháp: AND(danh sách biểu thức logic) 

 Hàm And trả lại giá trị True nếu tất cả các biểu thức logic trong danh sách là True; 

ngƣợc lại nếu có ít nhất một biểu thức logic trong danh sách nhận giá trị False thì 

hàm trả lại giá trị False. 

* Ví dụ: And(3>2, “Toi” >= “Ta”, C3=0) sẽ là True nếu ô C3 chứa giá trị 0 vì khi 

đó 3 biểu thức trong danh sách đều nhận giá trị True; ngƣợc lại sẽ có giá trị False. 

2. Hàm Or 

* Cú pháp: OR(danh sách biểu thức logic) 

 Hàm OR trả lại giá trị False nếu tất cả các biểu thức logic trong danh sách là False; 

ngƣợc lại nếu có ít nhất một biểu thức logic trong danh sách nhận giá trị True thì 

hàm trả lại giá trị True. 

* Ví dụ: OR(3<=2, “Anh” = “Em”, C3=0) sẽ là False nếu ô C3 chứa giá trị khác 0 

vì khi đó cả 3 biểu thức trong danh sách đều nhận giá trị False; ngƣợc lại sẽ có giá 

trị True. 

3. Hàm Not 

* Cú pháp: NOT(biểu thức logic) 

 Hàm Not đổi ngƣợc giá trị của biểu thức logic. (Not(True) = False và 

Not(False)=True) 

* Ví dụ: Not(3<5) = True vì 3<5 là False 
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4. Hàm If 

* Cú pháp: IF(bt_logic, giá trị nếu bt_logic đúng, giá trị nếu bt_logic sai) 

 Hàm If căn cứ vào sự lƣợng giá của bt_logic để trả về một trong hai giá trị: giá trị 

nếu bt_logic đúng và giá trị nếu bt_logic sai. Giá trị trả lại có thể lại đƣợc nhận 

thông qua kết quả của một hàm khác. Điều này chính là khả năng lồng nhau của 

các hàm trong Excel. 

* Ví dụ: Giả sử tại ô A3 chứa thông tin về trình độ văn hóa. Khi đó công thức: 

If(A3 = “ĐH”, “Đại học”, If(A3 = “CĐ”, “Cao đẳng”, “Trung cấp”)) 

sẽ trả về một trong 3 chuỗi ký tự “Đại học”, “Cao đẳng” hoặc “Trung cấp” tùy 

thuộc vào nội dung của A3 là “ĐH”, “CĐ” hay “TC” 

3.3. Các hàm chuỗi (string), văn bản (text) 

Các hàm loại này thƣờng yêu cầu đối số có kiểu ký tự, hoặc kết quả của hàm trả lại 

là một kiểu ký tự. Nếu kết quả của các hàm là một chuỗi số thì có thể đƣợc sử dụng 

trong các phép tính toán vì Excel tự động chuyển chuỗi số thành giá trị số khi cần 

thiết. Trong các trƣờng hợp khác cần lƣu ý đến kiểu của giá trị để xử lý đúng.  

1. Hàm Len 

* Cú pháp: LEN(text) 

 Hàm Len lấy đối số text có kiểu ký tự và trả lại độ dài của text. Các ký tự trống 

(khoảng cách) trong text cũng đƣợc đếm nhƣ các ký tự khác. 

* Ví dụ: Len(“Đây là một chuỗi”) = 16 

   Len(“”) = 0  (chuỗi rỗng) 

   Nếu ở ô G2 có chứa chuỗi “MASO 125” thì Len(G2) = 8 

2. Hàm Left 

* Cú pháp: LEFT(text, num) 

 Hàm Left trả lại num ký tự bên trái nhất của text. Nếu bỏ qua đối số num thì xem 

nhƣ lấy ký tự đầu tiên của text. Nếu num lớn hơn độ dài của text thì lấy toàn bộ text. 

* Ví dụ: Left(“AC035”, 2) = “AC” (lấy 2 ký tự bên trái) 

   Left(“AC35”) = “A”  (bỏ qua đối số num) 

3. Hàm Right 

* Cú pháp: RIGHT(text, num) 

 Hàm Right trả lại num ký tự bên phải nhất của text. Nếu bỏ qua đối số num thì 

xem nhƣ lấy ký tự cuối cùng của text. Nếu num lớn hơn độ dài của text thì lấy toàn 

bộ text. 

* Ví dụ: Right(“AC035”, 2) = “35” (lấy 2 ký tự bên phải) 

 Right(“AC035”) = “5” (bỏ qua đối số num xem nhƣ lấy 1 ký tự) 

 Right(“A035”, 2)*20 = 700 (tự động chuyển kiểu khi tính toán) 

4. Hàm Mid 

* Cú pháp: MID(text, pos, num) 

 Hàm Mid trả lại num ký tự của text, tính từ vị trí pos. Ký tự đầu tiên của text đƣợc 

đếm là 1. Nếu pos lớn hơn độ dài của text thì trả lại chuỗi rỗng. 
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* Ví dụ: Mid(“AC035”, 2, 3) = “C03” 

    (tính từ vị trí thứ 2, lấy 3 ký tự)  

   Mid(“AC035”, 6, 1) = “” 

    (vị trí pos vƣợt quá độ dài của text) 

5. Nối hai chuỗi & 

* Cú pháp: text1 & text2 

 Toán tử nối chuỗi & lấy hai đối số kiểu ký tự text1 và text2 để tạo thành chuỗi mới 

là hợp của hai chuỗi này. 

* Ví dụ:  “MASO là ” & Left(“A124”) ® “MASO là A” 

3.4. Các hàm ngày, giờ (Date & Time) 

Dữ liệu kiểu ngày trong Excel đƣợc tính từ ngày 01/01/1900 đến 31/12/2078 (hoặc 

31/12/9999 trong Excel 97) tƣơng ứng với giá trị từ 1 đến 65380. Kiểu ngày có thể 

đƣợc chuyển thành một số và ngƣợc lại; ví dụ: ngày 05/01/1900 đƣợc tính nhƣ là giá 

trị 5, và giá trị 1245 đƣợc xem nhƣ ngày 29/05/1903. 

Tùy theo mã định dạng ngày của Windows mà Excel có thể tạo định dạng mặc 

định là mm-dd-yy (tháng-ngày-năm) hay dd-mm-yy (ngày-tháng-năm). Khi nhập ngày 

trong một ô cần lƣu ý đến điều này, và nếu ngày hợp lệ thì Excel thƣờng tự động chỉnh 

phải ngƣợc lại là chỉnh trái. Trong thực hành, thƣờng nhập thử ngày 13 tháng 01 để 

kiểm tra (13/01/98), nếu sau khi nhập, giá trị đƣợc chỉnh lề phải, thì dạng ngày là 

dd/mm/yy, ngƣợc lại là dạng ngày mm/dd/yy. Để nhập năm lớn hơn 2000 cần phải 

nhập đủ 4 chữ số chỉ năm, nếu nhập 2 chữ số thì Excel tự động hiểu là thuộc năm 

19xx. 

Dạng giờ trong Excel là hh:mm:ss (giờ:phút:giây), giờ có thể theo dạng 12 giờ 

(dùng ký tự AM và PM để biểu thị buổi sáng, chiều) hoặc dạng 24 giờ. 

Trên các kiểu dữ liệu này có thể thực hiện các phép tính số học thông thƣờng nhƣ 

+, - giữa các đối số kiểu ngày (tính toán sự chênh lệch giữa hai ngày) hoặc giữa một 

đối số kiểu ngày với một số nguyên (tăng hoặc giảm ngày). 

1. Hàm Day 

* Cú pháp: DAY(dãy số kiểu ngày) 

 Hàm Day trả lại giá trị ngày (từ 1 đến 31) từ dãy số kiểu ngày. 

 Dãy số kiểu ngày có thể là một chuỗi ngày (“03/01/98”) hoặc tham chiếu đến ô 

chứa giá trị ngày. 

* Ví dụ: Day(“07/21/98”) = 21 

   (ngày 21 tháng 7 – dạng mm/dd/yy) 

2. Hàm Month 

* Cú pháp: MONTH(dãy số kiểu ngày) 

 Hàm Month trả lại giá trị tháng (từ 1 đến 12) từ dãy số kiểu ngày. 

* Ví dụ: Month(“07/21/98”) = 7 

   (ngày 21 tháng 7 – dạng mm/dd/yy) 
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3. Hàm Year 

* Cú pháp: YEAR(dãy số kiểu ngày) 

 Hàm Year trả lại giá trị năm (từ 1900 đến năm lớn nhất có thể) từ dãy số kiểu ngày. 

* Ví dụ: Year(“07/21/98”) = 1998 (năm nhập 2 chữ số đƣợc xem nhƣ 19xx) 

4. Hàm Now 

* Cú pháp: NOW() 

 Hàm Now không có đối số, trả lại giá trị là một dãy số gồm ngày, tháng, năm và 

giờ hiện tại đang đƣợc lƣu trong đồng hồ của máy tính. 

* Ví dụ: Year(Now()) trả lại năm hiện tại (là 2005) 

 Giả sử ô C7 chứa ngày sinh, khi đó công thức: 

 Year(Now()) - Year(C7) sẽ cho giá trị là tuổi của đối tƣợng. 

5. Các hàm về thời gian 

* Hour  ® trả lại giá trị giờ (1 – 24) 

* Minute ® trả lại giá trị phút (1 – 60) 

* Second ® trả lại giá trị giây (1 – 60) 

3.5. Các hàm tìm kiếm và tham chiếu (Lookup & Reference) 

Các hàm trong nhóm này thƣờng sử dụng một bảng chứa các giá trị sẽ trả lại qua 

một quá trình tìm kiếm theo khóa tìm. Bảng này thƣờng đƣợc gọi là bảng dò hay bảng 

tìm và để dễ xử lý ta nên đặt tên cho bảng. Có hai loại bảng: bảng ngang và bảng dọc. 

a) Bảng ngang (chứa giá trị cần tìm theo hàng ngang), ví dụ: 

LPH A B C 

TTUAN x1 x2 x3 

TNGAY y1 y2 y3 

Ở bảng trên, các giá trị cần tìm A, B, C trải ra theo phƣơng ngang ở hàng số 1; các 

giá trị x1, x2, x3 (ở hàng 2) và y1, y2, y3 (ở hàng 3) là các giá trị sẽ trả lại sau quá 

trình tìm. Các ô LPH, TTUAN, TNGAY chỉ có tính chất tham khảo, làm rõ ý nghĩa 

của bảng, chứ không tham gia vào quá trình tìm kiếm. Thực chất bảng trên chỉ có 9 ô 

(từ ô chứa A đến ô chứa y3.  

b) Bảng dọc (chứa giá trị cần tìm theo hàng dọc), ví dụ: 

LPH TTUAN TNGAY 

A x1 y1 

B x2 y2 

C x3 y3 

Các ô chứa A, B, C ở cột 1, các giá trị còn lại ở cột 2 và cột 3. 

Tƣơng ứng với hai loại bảng ở trên là hai loại hàm tìm kiếm: HLOOKUP và 

VLOOKUP. 
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1. Hàm VLookup 

* Cú pháp: VLOOKUP(gt_tìm, bảng_tìm, cột_trả_gt, cách_tìm) 

 Nếu cách_tìm = 1 (True) thì cột đầu tiên của bảng_tìm đƣợc sắp thứ tự tăng dần. 

 Ngƣợc lại, nếu cách_tìm = 0 (False) thì bảng_tìm không yêu cầu sắp. 

 Hàm VLOOKUP tìm trong cột đầu tiên của bảng_tìm một giá trị hợp lệ so với 

gt_tìm, sau đó nếu tìm thấy thì sẽ trả lại giá trị tƣơng ứng theo hàng ở cột_trả_gt. 

 Bảng_tìm là một bảng, trong đó cột đầu tiên (đánh số 1) của bảng này chứa các giá 

trị tƣơng hợp với các giá trị sẽ tìm. Các cột còn lại chứa các giá trị trả lại tƣơng 

ứng với hàng của giá trị tìm thấy. 

* Ví dụ: VLookUp(“B”, [Bảng_tìm], 2, 0) = x2 

2. Hàm HLookup 

* Cú pháp: HLOOKUP(gt_tìm, bảng_tìm, hàng_trả_gt, cách_tìm) 

 Nếu cách_tìm = 1 (True) thì hàng đầu tiên của bảng_tìm đƣợc sắp thứ tự tăng dần. 

 Ngƣợc lại, nếu cách_tìm=0 (False) thì bảng_tìm không yêu cầu sắp. 

 Hàm HLOOKUP tìm trong hàng đầu tiên của bảng_tìm một giá trị hợp lệ so với 

gt_tìm, sau đó nếu tìm thấy thì sẽ trả lại giá trị tƣơng ứng theo cột ở hàng_trả_gt. 

 Bảng_tìm là một bảng, trong đó hàng đầu tiên (đánh số 1) của bảng này chứa các 

giá trị tƣơng hợp với các giá trị sẽ tìm. Các hàng còn lại chứa các giá trị trả lại 

tƣơng ứng với cột của giá trị tìm thấy. 

* Ví dụ: HLookUp(“C”, [Bảng_tìm], 3, 0) = y3 

3. Hàm Columns 

* Cú pháp: COLUMNS(khoảng tham chiếu) 

 Hàm Columns trả lại số cột trong khoảng tham chiếu. 

* Ví dụ: Columns(A5:C10) = 3 (từ A ® C là 3 cột) 

4. Hàm Rows 

* Cú pháp: ROWS(khoảng tham chiếu) 

 Hàm Rows trả lại số hàng trong khoảng tham chiếu. 

* Ví dụ: Rows(A5:C10) = 6  (từ 5 ® 10 là 6 hàng) 
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BÀI 4  

TẠO BIỂU ĐỒ - CHART WIZARD 

Ngoài việc sử dụng mảng hai chiều để tổ chức dữ liệu, trong Excel để thể hiện mối 

tƣơng quan giữa các dãy số liệu ta có thể biểu diễn chúng bởi biểu đồ (chart). Biểu đồ 

có dạng đồ hình, đƣợc phân thành nhiều kiểu: Area (kiểu vùng); Bar (thanh); Column 

(cột); Line (đƣờng); Pie (cung tròn chứa góc); XY-Scatter (điểm rời rạc)... Những kiểu 

này có thể đƣợc biểu diễn theo dạng 2 chiều (2-D) hoặc 3 chiều (3-D). 

4.1. Các thành phần của biểu đồ 

+ Vùng dữ liệu: một khoảng liên tục hoặc rời rạc các ô bảng tính đƣợc chọn để dùng 

làm dữ liệu cho biểu đồ, có thể tổ chức theo hàng hay cột gọi là dãy (series) dữ 

liệu. Mỗi ô tạo thành một điểm dữ liệu trên biểu đồ và đƣợc đánh dấu (markers) 

bởi các kí hiệu khác nhau. Vùng dữ liệu có thể bao gồm một hàng (hoặc cột) chứa 

các nhãn (label). 

+ Trục tọa độ: hệ thống các đƣờng thẳng đứng hoặc ngang xác định tỉ lệ biểu diễn 

các điểm dữ liệu, trên các trục có chứa các vạch đánh dấu tỉ lệ (tick mark). Các 

trục thƣờng có hai loại: trục chủ đề (category) và trục giá trị (value). 

+ Hộp ghi chú (legend): chứa các dấu hiệu biểu diễn các dãy số liệu có mặt trong 

biểu đồ. Có thể đặt legend tại một vị trí tùy ý trong biểu đồ. 

+ Tiêu đề (title): dòng văn bản tạo nhãn cho biểu đồ (chart title) và các trục. 

Biểu đồ mẫu 
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4.2. Sử dụng Chart Wizard 

Ÿ Bƣớc 1: Chọn vùng dữ liệu chứa số liệu của biểu đồ. Có thể chọn liên tục hoặc 

rời rạc nhóm các ô theo hàng hoặc cột. 
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Ÿ Bƣớc 2: Click vào biểu tƣợng Chart Wizard hoặc chọn [Insert]\Chart. Khi con trỏ 

có dạng dấu cộng (+), ta vẽ một khung chữ nhật xác định kích thƣớc và vị trí ban 

đầu của biểu đồ. Lƣu ý: có thể chọn vẽ tại sheet đang chứa số liệu hoặc tại một 

sheet khác. 

Ÿ Bƣớc 3: Xuất hiện hộp chọn vùng dữ liệu: 

 
 Vì vùng dữ liệu đã chọn ở bƣớc 1, nên ta chọn [Next] để sang bƣớc kế tiếp (chọn 

kiểu biểu đồ), hoặc chọn [Finish] để kết thúc (dùng dạng mặc định của biểu đồ), 

sau này có thể tạo dạng lại. Nếu vùng dữ liệu xuất hiện ở đây chƣa đúng thì có thể 

dùng mouse để chọn lại vùng khác. 

Ÿ Bƣớc 4: Chọn kiểu biểu đồ và chọn một dạng con của nó 

 

 Ví dụ, kiểu Column có các dạng nhƣ: 

 
Ÿ Bƣớc 5: Cung cấp các thông tin bổ sung, nhƣ: 

- Dữ liệu đƣợc tổ chức theo hàng hay cột (Data Series in Rows/Columns) 

- Trong vùng dữ liệu nếu có chứa nhãn thì chỉ ra số thứ tự của hàng hay cột để tạo 

nhãn cho các trục ở các giá trị [x] và [y], nếu không thì nhập số 0 cho các giá trị 

này: 

 Use First [x] Row(s) for Category (X) Axis Labels 

 Use First [y] Column(s) for Series(Y) Axis Labels 

- Tùy chọn việc bổ sung một Legend vào biểu đồ 
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- Nhập tiêu đề cho biểu đồ và tiêu đề cho các trục. 

4.3. Hiệu chỉnh, tạo dạng biểu đồ 

Sau khi chọn [Finish], một biểu đồ sẽ xuất hiện trong vùng chữ nhật mà ta đã xác 

định ở bƣớc 2. Ta có thể tiếp tục điều chỉnh, tạo dạng, thêm/loại bỏ các thành phần của 

biểu đồ. Để thực hiện, chỉ cần nhấn D-click vào các vùng thích hợp và điều chỉnh 

thông tin trong các hộp thoại tƣơng ứng. Ví dụ, có thể thay đổi các thành phần nhƣ: 

kích thƣớc, màu sắc, font chữ, loại bỏ các đƣờng lƣới, sửa đổi hoặc bổ sung dữ liệu; 

thay đổi kiểu biểu đồ theo dạng phù hợp... 

 Riêng trong Excel-97 (hoặc 2k3), công cụ tạo biểu đồ đơn giản hơn. Ngƣời sử 

dụng không cần thiết phải vẽ trƣớc vùng sẽ chứa biểu đồ (ở Bƣớc 2) vì Excel sẽ tự 

động tạo ra. Ngoài ra, Excel-97 còn bổ sung thêm nhiều dạng biểu đồ. Dƣới đây 

giới thiệu các hộp thoại của Chart Wizard trong Excel-97: 

* Bƣớc 1 (của 4 bƣớc): chọn kiểu Chart 

- Trong bƣớc này, ta chọn một kiểu chart chính và sau đó chọn trong tập các kiểu 

con của nó một kiểu thích hợp. Hình dƣới minh họa kiểu Column và các kiểu con 

của nó. 

 
* Bƣớc 2: Chỉ định nguồn dữ liệu sẽ sử dụng trong Chart 

- Ở đây lƣu ý rằng, nếu trƣớc khi thực hiện lệnh tạo biểu đồ ta đã chọn hoặc đứng 

trong vùng dữ liệu thì Excel sẽ tự động đánh dấu xác định vùng dữ liệu. 

- Thƣờng thì Excel phân tích đúng về dãy giá trị của dữ liệu theo cột (Series in 

Columns) hay theo dòng (Series in Rows), trong trƣờng hợp cần thiết ta có thể chỉ 

định lại giá trị này. 
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* Bƣớc 3: Bổ sung các tùy chọn 

- Ở bƣớc này có nhiều tùy chọn để ta có thể thay đổi, bổ sung vào biểu đồ những 

thành phần theo yêu cầu. 

 
* Bƣớc 4: Tùy chọn vị trí đặt biểu đồ 

- Ở đây ta có thể chỉ định vị trí của biểu đồ trong các Sheet đã có hay là tạo một 

Sheet khác để chứa biểu đồ. 

 

 Sau khi nhấn Finish ta có kết quả sau: 
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BIÏ ÍU  À Ö Ì LÛ Ú N G

0

1 0 0 0 0 0

2 0 0 0 0 0

3 0 0 0 0 0

4 0 0 0 0 0

5 0 0 0 0 0

An Th u ãy Sú n Hû ú n g Hu ân g

 
* Ta có thể dễ dàng hiệu chỉnh các phần tử trong biểu đồ bằng cách nhấn D-click 

vào vị trí cần tác động. 

* Giới thiệu công cụ tạo dạng biểu đồ: 
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BÀI 5 

CƠ SỞ DỮ LIÊU TRONG EXCEL 

5.1. Khái niệm về cơ sở dữ liệu (Data Base) 

CSDL (còn gọi là bảng dữ liệu) là tập hợp có cấu trúc các thông tin có liên hệ với 

nhau, đƣợc tổ chức theo một nguyên tắc nhất định nhằm phản ánh thuộc tính của một 

lớp đối tƣợng. Có các mô hình tổ chức CSDL nhƣ: mô hình phân cấp; mô hình mạng; 

mô hình quan hệ... 

Trong đó, mô hình quan hệ có thể đƣợc biểu diễn bởi mảng 2 chiều, tổ chức thành 

hàng và cột. Mỗi hàng chứa thông tin về một đối tƣợng đƣợc gọi là một mẫu tin 

(record), mỗi cột chứa thông tin phản ánh thuộc tính chung của các đối tƣợng, đƣợc 

gọi là trƣờng dữ liệu (field). 

Trong Excel, CSDL đƣợc tổ chức theo mô hình quan hệ dƣới dạng danh sách 

(list). Danh sách là một dạng đặc biệt của bảng tính, bao gồm một khoảng liên tục các 

ô. Trong danh sách, hàng đầu tiên chứa tên của các cột, các hàng còn lại chứa dữ liệu 

về các đối tƣợng trong danh sách. 

5.2. Hƣớng dẫn tạo danh sách trong Excel 

Microsoft Excel cung cấp nhiều chức năng thuận tiện trong việc quản lý và phân 

tích dữ liệu trong một danh sách. Để tận dụng những chức năng này, hãy nhập dữ liệu 

trong danh sách theo những gợi ý sau:  

Ÿ Về kích thƣớc và vị trí 

- Không nên có nhiều hơn một danh sách trong một worksheet. 

- Nên để tối thiểu là một hàng và cột trống phân cách danh sách với các dữ liệu của 

bảng tính. Điều này làm cho Excel dễ dàng nhận biết một cách tự động danh sách 

sẽ làm việc. 

- Không nên để các hàng không có dữ liệu trong danh sách. 

- Tránh đặt dữ liệu quan trọng bên trái hoặc phải của danh sách, vì dữ liệu có thể bị 

che dấu khi tiến hành lọc danh sách. 

Ÿ Về các nhãn cột: 

- Nên tạo nhãn cột trong hàng đầu tiên của danh sách. Excel dùng các nhãn để tạo 

báo cáo, tìm kiếm và tổ chức dữ liệu. 

- Sử dụng tạo dạng font chữ, chỉnh sắp... cho các nhãn cột khác với dữ liệu trong 

danh sách. Dùng đƣờng viền quanh các ô của nhãn trong hàng đầu tiên để phân 

cách với vùng dữ liệu. 

Ÿ Về nội dung: 

- Thiết kế danh sách sao cho tất cả các hàng có các đề mục tƣơng tự trong cùng một 

cột. 
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- Tránh thêm vào các khoảng trống ở đầu các ô, vì điều này có ảnh hƣởng đến quá 

trình sắp xếp và tìm kiếm. 

- Không dùng các hàng trắng để phân cách nhãn cột với dữ liệu. 

Ÿ Đặt tên: 

- Nên đặt tên cho danh sách để thuận tiện trong việc tác động lên danh sách (nhƣ 

tính toán, lọc thông tin...) 

- Khi chọn vùng dữ liệu của danh sách để đặt tên cần chú ý phải chọn cả dòng đầu 

tiên trong danh sách có chứa nhãn cột. 

5.3. Các hàm CSDL 

Excel cung cấp nhiều hàm để làm việc với cơ sở dữ liệu dạng danh sách. Các hàm 

này đều có chung một cấu trúc cú pháp, chỉ khác nhau về chức năng. 

1. Cấu trúc tổng quát của hàm CSDL 

Dfunction(database,field,criteria) 

- Tên hàm bắt đầu bằng ký tự D, tiếp đó là các tên nhƣ SUM, MIN,... (ví dụ: 

DSUM) 

- database là một CSDL dạng danh sách của Excel, thông thƣờng là một tên đã định 

nghĩa trƣớc của danh sách cần tác động. 

- field là tên nhãn cột đóng trong cặp nháy kép hoặc số thứ tự của cột trong danh 

sách (tính từ cột 1) hoặc là tên tham chiếu của nhãn cột sẽ bị tác động bởi hàm (ví 

dụ: tính toán trên một cột của danh sách). 

- criteria là vùng điều kiện xác định các điều kiện cần thiết mà hàm phải thỏa mãn 

để tác động lên trƣờng dữ liệu đã chỉ ra bởi field. 

Ÿ Chức năng: Hàm CSDL tác động lên trƣờng dữ liệu (filed) của danh sách 

(database) theo các điều kiện xác định bởi vùng điều kiện (criteria). 

2. Tạo vùng điều kiện để sử dụng với các hàm CSDL 

Criteria là một tham chiếu đến một khoảng các ô có chứa các điều kiện đặc biệt 

cho hàm. Hàm CSDL sẽ trả lại kết quả tính toán trên một cột của danh sách phù hợp 

với những ràng buộc đƣợc chỉ ra bởi vùng điều kiện. Ở vùng điều kiện thƣờng chứa 

một nhãn cột đại diện các giá trị trong cột tham gia vào điều kiện. Tham chiếu đến 

vùng điều kiện có thể đƣợc nhập vào hàm nhƣ một khoảng ô hoặc thông qua tên đã gán 

cho khoảng ô này. 

 Ÿ Dạng tổng quát của vùng điều kiện: 

Tên trường (nhãn cột) ví dụ: LƢƠNG 

điều kiện  >= 525000 

Trong ô chứa điều kiện có thể sử dụng các toán tử quan hệ: >, <, >=, <=, <>, = 

hoặc các ký tự thay thế ?, * tƣơng tự nhƣ trong hệ điều hành MS-DOS (ví dụ: điều 

kiện X* nghĩa là dữ liệu dạng chuỗi bắt đầu bởi X, các ký tự còn lại tùy ý). Để tìm 

chính xác các giá trị kiểu chuỗi, ta sử dụng dạng: = “=giá trị_chuỗi”. Lƣu ý rằng, kết 

quả của các hàm chuỗi (Left, Right, Mid) là kiểu chuỗi. 
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Vùng điều kiện có thể chứa nhiều ô Tên trường và nhiều điều kiện khác nhau có 

thể đặt cùng hàng hoặc khác hàng. Các điều kiện bố trí cùng hàng mang nghĩa của toán 

tử AND; các điều kiện bố trí trên nhiều hàng mang nghĩa OR. 

Ví dụ: 

LƢƠNG LƢƠNG 

>= 350000 <= 500000 

Có nghĩa là LƢƠNG >= 350000 và (AND) LƢƠNG <= 500000 

LƢƠNG TĐVH 

>= 350000 Đại học 

<=250000  

Có nghĩa là LƢƠNG >=350000 và (AND) TĐVH là Đại học hoặc (OR) LƢƠNG 

<= 250000 và TĐVH là bất kỳ (vì ô tƣơng ứng không chứa giá trị điều kiện). 

F Lƣu ý: Vùng điều kiện có thể đƣợc tổ chức ở những hàng đầu tiên của bảng tính, 

sau này có thể dấu (hide) chúng đi mà không làm ảnh hƣởng đến dữ liệu trong 

bảng tính. Hoặc có thể tổ chức chúng ở một sheet khác với sheet chứa danh sách. 

3. Giới thiệu một số hàm CSDL thông dụng của Excel 

1. DSUM(database, field, criteria) 

Hàm DSUM tính tổng cột field trong database theo điều kiện đƣợc chỉ ra bởi 

criteria. 

Ví dụ: Trong một danh sách lƣơng, có thể tính tổng của cột Tổng Lương theo điều 

kiện Lương Cơ Bản hoặc theo Trình Độ Văn Hóa... 

2. DMAX, DMIN, DAVERAGE 

Các hàm này trả lại giá trị lớn nhất (max), nhỏ nhất (min), trung bình (average) của 

một cột dữ liệu (field) trong một danh sách theo điều kiện (criteria) xác định. 

3. DCOUNT(database, [field,] criteria) 

 DCOUNTA(database, [field,] criteria) 

Hàm DCOUNT đếm số các ô có chứa giá trị số; DCOUNTA dùng để đếm các ô 

khác trống (nghĩa là đếm các ô có chứa dữ liệu) trong một cột của danh sách hợp với 

điều kiện chỉ định bởi vùng điều kiện. Điểm đặc biệt ở đây là: đối số [filed,] có thể bị 

bỏ qua, khi đó hai hàm này sẽ tiến hành đếm trong tất cả các record (hàng) của danh 

sách. 

4. Ví dụ về hàm CSDL 

Giả sử có danh sách dữ liệu sau (từ B2 đến D7 - xem bảng minh họa) 

Ta có thể tính tổng cộng của cột TONG theo điều kiện mặt hàng là loại GAO, nhƣ 

sau: 

 = DSUM(B2:D7, “TONG”, B25:B26) (nhập tên trƣờng) 

hoặc = DSUM(DATA10, 3, B25:B26) (số thứ tự cột) 

hoặc = DSUM(DATA10, D2, CRT10) (số hiệu ô) 

(Trong đó DATA10 là tên của danh sách dữ liệu; CRT10 là tên của vùng điều kiện 

B25:B26) 

 A B C D 
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1     

2  TEN SLUONG TONG 

3  BOT 324 1145340 

4  GAO 454 6878100 

5  BOT 656 3312800 

6  GAO 431 1318860 

7  GAO 455 4641000 

... 

    

25  TEN SLUONG  

26  GAO >450  

27  BOT   

Hoặc bổ sung điều kiện SLUONG > 450, khi đó sử dụng vùng điều kiện là 

B25:C26. Để tính với điều kiện mặt hàng là GAO hoặc BOT, ta dùng vùng B25:B27. 

Để tính số lƣợng trung bình của mặt hàng GAO, ta dùng công thức: 

 = DAVERAGE(BANG10, “SLUONG”, CRT10) 

và = DMAX(BANG10, “TONG”, CRT10) tính tổng lớn nhất theo GAO. 

5. Ví dụ về thiết lập vùng điều kiện 

- Điều kiện ngày ở trong một tháng nào đó: 

NGAY NGAY 

>=01/05/99 <01/06/99 

nghĩa là ngày thuộc phạm vi tháng 5/1999 

- Giả sử mã số Xij có ký tự đầu đại diện cho khu vực (với X là A, B, C...), i, j là hai 

số tùy ý. Khi đó điều kiện thuộc khu vực A là: 

MSO 

A* 

- Nếu điều kiện không thuộc vào một trƣờng, ví dụ chỉ có trƣờng NgSinh (ngày 

sinh), nhƣng yêu cầu tính theo tuổi thì thƣờng chúng ta phải tạo thêm một cột 

trung gian (ví dụ cột Tuoi) và lập điều kiện theo cột mới tạo này. Nhƣng cần chú ý 

khi chọn danh sách dữ liệu để tính thì phải bao gồm luôn cả cột mới bổ sung này, 

nếu không Excel sẽ báo lỗi là tên chƣa đƣợc định nghĩa. 

 Trong Excel còn có một dạng đặc biệt có thể chứa công thức ngay trong vùng điều 

kiện. 
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BÀI 6  

CÁC THAO TÁC TRÊN DANH SÁCH DỮ LIÊU 

Hầu hết các thao tác trên danh sách dữ liệu của Excel đƣợc thực hiện thông qua 

menu DATA. Bao gồm các chức năng nhƣ: 

- Sort Sắp xếp dữ liệu trong danh sách 

- Filter Lọc thông tin trong danh sách và có thể trích ra một danh sách con với 

những điều kiện xác định 

- Subtotal Tạo một cách tự động các dòng tính sum, min, max, avarage... trên dữ 

liệu thỏa điều kiện chỉ định. 

- Form Chuyển danh sách dữ liệu thành một dạng khác, cho phép thao tác 

nhanh hơn trong một số tình huống. 

- Pivot table Tạo bảng phân tích số liệu tự động từ danh sách. 

6.1. Sắp xếp dữ liệu ([DATA]\SORT) 

Chức năng sắp xếp nhằm mục đích tổ chức lại bảng dữ liệu theo một thứ tự nào 

đó. Khi thực hiện chức năng này, bảng dữ liệu sẽ bị thay đổi nhƣng các công thức bên 

trong sẽ đƣợc tự động thay đổi cho phù hợp. Có hai loại thứ tự: theo chiều tăng 

(Ascending) và theo chiều giảm (Descending). Việc sắp xếp thƣờng tiến hành theo một 

tiêu chuẩn của một cột nào đó (đƣợc gọi là trƣờng khóa) và có thể chọn nhiều khóa để 

sắp đồng thời. Các bƣớc tiến hành trong Excel nhƣ sau: 

1. Đặt con trỏ trong vùng dữ liệu của danh sách, hoặc chọn vùng dữ liệu cần sắp 

2. Gọi menu [Data] và chọn chức năng Sort. Xuất hiện bảng sắp xếp nhƣ sau: 

            
- Để sắp dữ liệu trong danh sách ta chọn một tên cột, nếu trong mục My list has 

(Trong danh sách có) có đánh dấu (Ÿ) Header row (dòng tiêu đề của cột) làm khóa 

sơ cấp để sắp xếp (nhập tên vào hộp [Sort by], hoặc chọn từ danh sách rơi xuống); 

sau đó có thể tùy chọn 1 hoặc 2 cột làm khóa thứ cấp [Then by]. Trong các khóa, 

đánh dấu vào ô Ascending để sắp dữ liệu theo chiều tăng dần; Descending để sắp 

giảm dần. Nếu cần, có thể thêm thông tin bằng cách chọn [Options]: đánh dấu vào 
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ô [Case sensitive] để phân biệt chữ hoa–thƣờng; và chọn hƣớng sắp: từ trên xuống 

(Sort top to bottom) hoặc từ trái sang phải (Sort left to right). 

- Dữ liệu trƣớc khi sắp: 

BẢNG THANH TOÁN TIỀN CÔNG 

         

STT MSO CVIEC D-MUC TH-HIEN TIEN-CONG THUONG TONG GCHU 

1 XA Sửa chữa 3 3 360000 36000 396000   

2 YA Bảo trì 2 3 300000 0 300000   

3 XB Sửa chữa 6 5 800000 80000 880000 X 

4 ZA Thay thế 4 7 1050000 0 1050000 X 

5 ZB Thay thế 2 4 800000 0 800000   

6 YB Bảo trì 8 7 910000 91000 1001000 X 

7 XA Sửa chữa 5 5 600000 60000 660000   

8 YA Bảo trì 3 2 200000 20000 220000 X 

9 XA Sửa chữa 4 6 720000 0 720000   

- Dữ liệu sau khi sắp theo cột CVIEC tăng dần và TONG giảm dần 

BẢNG THANH TOÁN TIỀN CÔNG 

         

STT MSO CVIEC D-MUC TH-HIEN TIEN-CONG THUONG TONG GCHU 

6 YB Bảo trì 8 7 910000 91000 1001000 X 

2 YA Bảo trì 2 3 300000 0 300000   

8 YA Bảo trì 3 2 200000 20000 220000 X 

3 XB Sửa chữa 6 5 800000 80000 880000 X 

9 XA Sửa chữa 4 6 720000 0 720000   

7 XA Sửa chữa 5 5 600000 60000 660000   

1 XA Sửa chữa 3 3 360000 36000 396000   

4 ZA Thay thế 4 7 1050000 0 1050000 X 

5 ZB Thay thế 2 4 800000 0 800000   

6.2. Lọc dữ liệu ([DATA]\FILTER) 

Lọc dữ liệu nhằm mục đích cho phép xem hoặc lấy các thông tin từ bảng dữ liệu 

mà thỏa mãn các điều kiện nào đó. Trong Excel có hai phƣơng pháp, đó là lọc tự động 

và lọc nâng cao. Tùy vào mục đích sử dụng ta có thể chọn một trong hai phƣơng pháp 

này. Nhƣng tại một thời điểm, chỉ có một danh sách đƣợc phép lọc tự động. 

Đầu tiên, chọn vùng dữ liệu cần lọc thông tin ra; sau đó chọn menu [Data]\Filter.  

   
Chức năng này có các tùy chọn sau: 

1. Bật/tắt lọc tự động (AutoFilter) 

Khi chọn mục này, bên phải các ô trong danh sách sẽ xuất hiện một dấu drop-

down [].  



36 Hoàng Vũ Luân 

 

Trong mỗi dấu là một danh sách các nhãn dữ liệu có mặt trong cột dữ liệu và 

các từ khóa: All (chọn toàn bộ), Top 10 (hiện 10 dòng đầu), Custom (tự điều chỉnh 

điều kiện lọc)... Ví dụ, click vào ô [CVIEC] ở trên, và chọn giá trị Bảo trì thì dữ liệu 

sẽ đƣợc lọc và chỉ hiện ra các hàng thỏa điều kiện lọc CVIEC = “Bảo trì”. Tiến hành 

tƣơng tự với các cột khác ta sẽ kết hợp đƣợc các điều kiện cần thiết để lấy thông tin 

theo yêu cầu. 

Trong trƣờng hợp điều kiện lọc phức tạp (không đúng với một giá trị trong các 

nhãn dữ liệu), khi đó ta có thể tùy biến điều kiện bằng cách chọn Custom sau khi nhấn 

vào  và nhập điều kiện vào hộp sau: 

 
Trong ô đầu tiên, ta chọn các toán tử quan hệ nhƣ <, >, <=. >= ..., ở ô tiếp theo 

bên phải ta nhập (hoặc chọn) giá trị theo yêu cầu. Khi điều kiện có dạng nhƣ >= một 

giá trị và <= một giá trị khác thì ta tiếp tục chọn toán tử logic: And hoặc Or để tạo điều 

kiện dạng kết hợp và nhập thông tin vào 2 ô dƣới. Lƣu ý, tƣơng tự khi sử dụng điều 

kiện của các hàm cơ sở dữ liệu, ở đây ta có thể nhập thêm các dấu thay thế ? (đại diện 

1 ký tự) và * (đại diện một dãy ký tự tùy ý). 

Ÿ Sau khi đã lọc, có thể hủy bỏ sự lọc bằng cách chọn lại [Data]\Filter\AutoFilter 

(chức năng bật/tắt) hoặc chọn [Data]\Filter\Show All (hiển thị tất cả) để cho hiện 

lại toàn bộ danh sách và tiến hành lọc theo hƣớng khác. 
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Ÿ Đặc điểm của lọc tự động là: 

- Tiến hành lọc ngay trong danh sách dữ liệu. Kết quả sau lọc có thể đƣợc copy 

sang một vùng khác. Tốc độ lọc nhanh, dễ thay đổi điều kiện lọc. 

- Vùng điều kiện lọc hạn chế, không tiến hành đƣợc với một số loại điều kiện 

phức tạp. Đặc biệt chỉ cung cấp tối đa 2 biểu thức đối với một trƣờng dữ liệu. 

Để khắc phục điều này, Excel cung cấp một khả năng bổ sung, đó là lọc nâng cao. 

2. Lọc nâng cao (Advanced Filter) 

Khi chọn chức năng này, sẽ xuất hiện hộp đối thoại sau: 

 
* Ở mục Action (hành động) ta có 2 tùy chọn: 

() Filter the list, in-place ® lọc danh sách và đặt tại chỗ (tƣơng tự AutoFilter) 

() Copy to another location  ® cho phép copy dữ liệu sau khi lọc sang một vùng khác 

* Trong hộp [List range] (vùng danh sách), ta chọn vùng dữ liệu sẽ lọc, hoặc nhập 

tên của danh sách dữ liệu đã đặt trƣớc đó. 

* Hộp [Criteria range] yêu cầu nhập vào đó vùng điều kiện để điều khiển quá trình 

lọc. Vùng điều kiện này tƣơng tự vùng điều kiện trong đối số của các hàm 

database. 

* Nếu mục Copy to another location đƣợc đánh dấu, thì hộp [Copy to] sẽ có hiệu lực để 

ta nhập vào đó tham chiếu đến ô đầu tiên của một vùng bảng tính sẽ chứa dữ liệu 

sau khi lọc. 

* Đánh dấu vào hộp kiểm tra [ ] Unique records only để điều khiển việc lọc sẽ chỉ tác 

động lên những record hay mẫu tin đơn nhất, không trùng nhau. Trong trƣờng hợp hộp 

này để trống thì trong kết quả lọc đƣợc phép chứa các record có dữ liệu trùng nhau. 

Ÿ Lƣu ý: 

- Khi sử dụng chức năng lọc dữ liệu để trích thông tin sang một vùng bảng tính khác 

với vùng chứa dữ liệu (thông thƣờng là khác sheet) thì trƣớc khi gọi menu 

Advanced Filter cần di chuyển đến đứng tại Sheet dự định sẽ chứa thông tin kết 

quả. Khi đó nếu danh sách dữ liệu và vùng điều kiện chƣa đƣợc đặt tên và cần chỉ 

ra trực tiếp, ta trƣớc hết click mouse vào tên sheet chứa danh sách, sau đó mới 

dùng mouse để chọn vùng. 

- Khi chọn vị trí (Copy to) sẽ chứa dữ liệu, lƣu ý rằng vùng phía dƣới và bên phải 

của vị trí này cần có đủ chỗ trống tối thiếu chứa đủ dữ liệu kết quả, trong trƣờng 

hợp không đủ vùng trống cần thiết thì có thể sẽ ghi đè lên thông tin đã có trƣớc đó. 
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- Thông tin sau khi lọc và copy đến một vị trí mới chỉ chứa các kết quả của các công 

thức tính toán, do đó không thể tự động thay đổi đƣợc. Khi dữ liệu trong bản gốc 

có thay đổi thì phải tiến hành lọc lấy kết quả mới để cập nhật số liệu. Do đó, việc 

trích (lọc) thông tin chỉ có tác dụng tại thời điểm cần lập báo cáo. 

- Đối với việc lọc và đặt tại chỗ (in-place) thƣờng sử dụng để kiểm tra, so sánh 

thông tin trong danh sách... Khi này, các hàng không thỏa điều kiện lọc sẽ bị che 

dấu (hidden), để tái hiện lại danh sách đầy đủ, ta chọn [Data]\Filter\Show All. 

6.3. Thống kê theo nhóm ([DATA]\SUBTOTALS) 

Trong một danh sách, ta có thể thống kê số liệu trên các cột dựa trên giá trị cùng 

loại (cùng chủ đề) của một cột dữ liệu làm khóa thống kê. Ví dụ, trong danh sách giáo 

viên cần thống kê tổng lƣơng, tổng thƣởng theo các nhóm giáo viên; hoặc trong danh 

sách bán hàng cần thống kê lƣợng hàng bán đƣợc của từng mặt hàng... Để thực hiện 

những yêu cầu này, Excel cung cấp một công cụ khá mạnh, đó là chức năng SubTotal 

trong menu DATA. 

F Do phải thống kê theo chủ đề, nên trƣớc khi sử dụng chức năng này danh sách cần 

phải đƣợc sắp thứ tự theo chủ đề. 

Ÿ Ví dụ với danh sách BẢNG THANH TOÁN TIỀN CÔNG: (đã sắp thứ tự theo 

CVIEC) 

STT MSO CVIEC D-MUC TH-HIEN TIEN-CONG THUONG TONG GCHU 

6 YB Bảo trì 8 7 910000 91000 1001000 X 

2 YA Bảo trì 2 3 300000 0 300000   

8 YA Bảo trì 3 2 200000 20000 220000 X 

3 XB Sửa chữa 6 5 800000 80000 880000 X 

9 XA Sửa chữa 4 6 720000 0 720000   

7 XA Sửa chữa 5 5 600000 60000 660000   

1 XA Sửa chữa 3 3 360000 36000 396000   

4 ZA Thay thế 4 7 1050000 0 1050000 X 

5 ZB Thay thế 2 4 800000 0 800000   

Để tính tổng tiền thƣởng và tổng tiền theo tên công việc ta tiến hành các bƣớc sau: 

Bƣớc 1: Sắp thứ tự danh sách theo cột CVIEC 

  (kết quả thể hiện ở hình trên) 

Bƣớc 2: Chọn chức năng [DATA]\SUBTOTALS 
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- Ở mục [At each change in:] ta chọn giá trị của cột sẽ dùng làm chủ đề khi thống kê 

- Ở mục [Use function:] ta chọn loại hàm sẽ thực hiện chức năng thống kê. 

- Ở mục [Add subtotal to:] ta đánh dấu vào các cột sẽ thực hiện sự thống kê 

Trong các hộp kiểm tra ta đánh dấu vào chức năng phù hợp. 

Trong ví dụ này, ta chọn hàm SUM làm hàm thống kê, các cột cần thống kê là 

THUE và TONG, chủ đề là TEN; cho phép thay thế subtotal đã tạo trƣớc đó và giá trị 

thống kê đƣợc đặt bên dƣới dữ liệu. Chọn [OK] ta có kết quả sau: 

 

Bên dƣới các nhóm hàng là các nhãn do Excel tự động tạo ra, ta có thể sửa đổi tùy 

ý. Chú ý ở bên trái có xuất hiện các dấu hiệu đặc biệt - đó chính là khả năng tự động 

lập nhóm (outline) của Excel. Để mở rộng hoặc thu hẹp các nhóm, ta click vào các dấu 

[+],  [-] hoặc chọn các mức 1, 2, 3 ở phía trên của chúng. Giả sử nếu ta chỉ cần số liệu 

tổng quát về doanh số bán của các mặt hàng và số liệu tổng toàn bộ, ta sẽ chọn số 2, 

khi đó danh sách thu hẹp lại chỉ còn 4 hàng (3 hàng Total và 1 hàng Grand Total). 

Sau khi thống kê, ta có thể điều chỉnh hoặc xóa bỏ bằng cách chọn lại chức năng 

này và chọn phƣơng pháp phù hợp (ví dụ: chọn [Remove All] để xóa subtotal). 

*  Thay thế các subtotals hiện thời 

(nếu trƣớc đó đã thực hiện lệnh 

này) 

*  Ngắt trang giữa các nhóm 

*  Đặt giá trị thống kê bên dƣới dữ 

liệu (nếu chọn) hoặc đặt bên trên dữ 

liệu (nếu không đánh dấu) 

* Xóa các thống kê đã tạo trƣớc đó. 
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6.4. Sử dụng [Data]Forms 

Danh sách dữ liệu đƣợc tổ chức theo hàng và cột, bình thƣờng ta làm việc với toàn 

bộ danh sách. Trong trƣờng hợp cần làm việc với từng hàng (record) ta sẽ gặp khó 

khăn nếu danh sách có nhiều trƣờng. Excel cung cấp một dạng thức đặc biệt - đó là 

Data Forms, chuyên dùng để nhập hoặc xem thông tin theo từng hàng, trong đó các 

trƣờng (nhãn cột) đƣợc bố trí theo chiều dọc. Trƣớc khi dùng chức năng Data Forms, 

dữ liệu của bạn cần đƣợc tổ chức theo kiểu danh sách với hàng đầu tiên chứa các nhãn 

mà Excel sẽ sử dụng làm tên trƣờng (field) trong forms. Tối đa Excel có thể hiển thị 

đồng thời 32 trƣờng. 

 

Các chức năng trong khi dùng 

Forms gồm: 

a. [New] thêm một record vào 

cuối danh sách (chèn thêm một 

hàng) 

b. [Delete] xóa một record 

c. [Restore] phục hồi nội dung đã 

bị sửa đổi 

d. [Find] tìm kiếm 

e. [Criteria] lập điều kiện 

Đối với các trƣờng công thức, Excel chỉ hiển thị nhƣng không cho phép thay đổi. 

Khi thêm một record vào cuối danh sách, Excel sẽ tự động sao chép công thức ở các 

trƣờng của record phía trên vào các trƣờng này; các trƣờng chứa dữ liệu đƣợc nhập 

bình thƣờng. Dùng phím Tab và Shift-Tab để di chuyển giữa các trƣờng. 

Để tìm kiếm thông tin theo một tiêu chuẩn nào đó, trƣớc hết ta dùng nút Criteria để 

nhập điều kiện vào các trƣờng, sau đó sử dụng các nút tìm trƣớc (Find Prev) và kế tiếp 

(Find Next) để di chuyển đến vị trí mong muốn. Điều kiện tìm kiếm ở đây đơn giản 

hơn điều kiện ở chức năng Filter, mỗi biểu thức trƣờng chỉ chứa một giá trị để so sánh, 

ta nhập giá trị với các toán tử so sánh vào các ô để tạo biểu thức tìm. 

6.5. Phân tích bảng dữ liệu [Data]Pivot Table 

Pivot Table là một chức năng mạnh của Excel, nó cho phép ngƣời sử dụng phân 

tích với một số lƣợng lớn các dữ liệu một cách nhanh chóng. Ta có thể xoay các hàng 

và cột để xem các phân tích khác nhau của nguồn dữ liệu, lọc dữ liệu bằng cách hiển 

thị các trang hoặc xem chi tiết các vùng cần thiết. Ta có thể tạo bảng phân tích từ danh 

sách dữ liệu của Excel hoặc từ một nguồn dữ liệu bên ngoài Excel. 

Ta sẽ minh họa chức năng này bằng bảng dữ liệu làm ví dụ sau: 

STT NBAN TEN SLUONG TGIA THUE TONG 

1 05/06/99 BAP 324 1134000 11340 1145340 

2 07/06/99 BIA 454 6810000 68100 6878100 
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3 09/06/99 BOT 656 3280000 32800 3312800 

4 05/06/99 GAO 431 1293000 25860 1318860 

5 07/06/99 KEO 455 4550000 91000 4641000 

6 05/06/99 BAP 564 1974000 19740 1993740 

7 07/06/99 BIA 657 9855000 98550 9953550 

8 09/06/99 BOT 432 2160000 21600 2181600 

9 05/06/99 KEO 544 5440000 108800 5548800 

10 09/06/99 GAO 767 2301000 46020 2347020 

 Bƣớc 1: Khai báo nguồn dữ liệu 

Sau khi thực hiện lệnh Pivot Table... ta sẽ khai báo nguồn dữ liệu sử dụng để phân 

tích, có nhiều tùy chọn nhƣng thƣờng thì ta chọn mục đầu: () Microsoft Excel list or 

database. Sau đó nhấn Next để sang bƣớc 2. 

 
 Bƣớc 2: Chỉ định bảng dữ liệu 

Nếu trƣớc đó chƣa chọn bảng thì sau khi xuất hiện hộp thoại, dùng mouse chọn 

danh sách dữ liệu cần phân tích. Nhấn [Next] để sang bƣớc 3 của Wizard. 

 
 Bƣớc 3: Chọn vị trí cho các trƣờng cần phân tích 

Bƣớc này quyết định kiểu phân tích sẽ tiến hành trên bảng dữ liệu. Tùy theo ý đồ, 

ta sẽ thiết lập các vị trí thích hợp cho các trƣờng, bao gồm 4 vị trí: 
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[PAGE] dữ liệu đặt ở đây thƣờng là loại có phân nhóm, ở danh sách dữ liệu làm ví 

dụ ta sẽ chọn trƣờng TEN để đƣa vào đây. Khi phân tích ta có thể chọn All để xem toàn bộ 

hoặc chỉ chọn từng nhóm để xem. 

[COLUMN] và [ROW] chọn các trƣờng sẽ cung cấp thông tin và tùy ý bố trí theo 

cột (column) hay hàng (row). 

[DATA] là vùng chính của bảng, ở đó số liệu cần quan tâm nhất sẽ hiển thị và 

đƣợc tính toán tự động theo tùy chọn (bao gồm tính tổng sum, min, max, average...) 

tƣơng tự chức năng subtotal. 

 
Sau khi hoàn tất chọn Next để chuyển sang bƣớc 4. 

 Bƣớc 4: Chọn vị trí đặt bảng phân tích 

Ở bƣớc này có 2 tùy chọn, hoặc ta sẽ lƣu bảng phân tích trong một worksheet mới, 

hoặc là sẽ đặt chung với danh sách dữ liệu. Nếu chọn mục 2: Existing worksheet, ta 

cần nhập vào vị trí sẽ lƣu (tƣơng tự chức năng Copy to trong khi lọc nâng cao) 

 
Đến đây ta có thể chọn [Finish] để hoàn tất việc tạo bảng phân tích hoặc chọn 

[Options...] để bổ sung các tùy chọn trƣớc khi kết thúc. Với danh sách dữ liệu ở trên, 

ta có thể tạo bảng phân tích nhƣ sau: 
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 Các tùy chọn của bảng phân tích: 

 
 Thêm các mục tóm tắt dữ liệu (sử dụng các hàm trong subtotal: sum, min, max, 

average...) ở cuối các cột hoặc cuối hàng dữ liệu và tự động tạo dạng bảng 
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 Điều chỉnh bảng phân tích 

- Sau khi tạo xong, ta có thể điều 

chỉnh, định lại dạng của bảng phân 

tích bởi các thao tác nhƣ: thiết lập 

lại các tùy chọn nhƣ ở trên; hoặc bổ 

sung, điều chỉnh vị trí các mục, xóa 

các mục không cần thiết... 

- Nhấn D-click vào tên một trƣờng 

sẽ làm xuất hiện hộp thay đổi các 

thuộc tính của nó, nhƣ thay đổi vị 

trí của trƣờng... 
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BÀI 7 

CÁC CHỨC NĂNG BỔ SUNG 

Phần này nhằm mục đích giới thiệu một số tính năng bổ sung nhằm nâng cao hiệu 

quả khi sử dụng Excel. Một số mục chỉ có tính giới thiệu làm cơ sở để tiếp tục tự tìm 

hiểu. 

7.1. Định dạng trang: [File] Page Setup 

Trong mục này có các chức năng giống với Word nhƣ khai báo giấy (Page), thiết 

lập các lề (Margins), tạo các dòng tiêu đề đầu và chân trang (Header/Footer). 

Ngoài ra, trong Excel có bổ sung một tính năng đặc thù của bảng biểu, đó là cho 

phép tạo ra các hàng lặp lại ở đỉnh (Rows to repeat at top) và các cột lặp lại ở bên trái 

(Columns to repeat at left) khi sang trang mới. Nghĩa là có thể tạo các hàng/cột thống 

nhất trên các trang. 

 
Để chọn các hàng/cột sẽ lặp lại khi sang trang, ta chọn hộp thích hợp sau đó dùng 

mouse chọn các hàng trong bảng tính. 

Trong một số tình huống có thể thiết lập nút [´] Gridlines để in các đƣờng lƣới của 

bảng, ngƣợc lại tắt chức năng này để không in. Nếu muốn Excel tự động chuyển màu 

sắc của bảng sang dạng đen trắng thì chọn nút [´] Black and white. Ngoài ra, nếu bảng 

tính có nhiều trang thì ta có thể chỉ định hƣớng in: in xuống rồi sang phải (Down, then 

over) hay ngƣợc lại (Over, then down). 
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7.2. Xem trƣớc khi in: [File]Print Preview 

 
Chức năng này cho phép kiểm tra bảng tính một cách tổng thể trƣớc khi quyết định 

in chính thức. Ở đây, ta có thể tiến hành nhiều phép hiệu chỉnh, nhƣ: thay đổi lề, cột 

để bảng tính có thể vừa khít trên một trang... Nhấn ESC hoặc [Close] để kết thúc xem. 

7.3. Chức năng in: [File]Print 

 
Các thông số in trong Excel hầu hết đều sử dụng theo chuẩn của Windows, nhƣ 

chọn loại máy in, có muốn in ra file để sau đó đƣa đi in ở một máy khác hay không ([] 

Print to file), chọn khoảng trang sẽ in (All: in toàn bộ, From..To để chỉ định các trang 

sẽ in)... Các mục trong vùng Print what (In cái gì?) có chứa một số mục riêng của 

Excel. Nếu muốn in chỉ một vùng bảng tính thì chọn vùng này trƣớc khi thực hiện lệnh 

in, sau đó đánh dấu vào mục Selection. Để in bảng tính ở Sheet đang làm việc thì chọn 

Click vào nút 

Margins để 

bật/tắt các dấu 

hiệu đặt lề và 

chỉnh cột 
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mục Active sheet(s) và chọn mục Entire workbook để in toàn bộ file (gồm tất cả các 

sheet). 

Ngoài ra có thể chọn số bản sao trên một trang (Number of copies) và cách sắp khi 

in (Collate). 

7.4. Sử dụng tính năng [Data]Group and Outline 

Chức năng này cho phép quản lý các hàng và cột theo nhóm và có thể tạo subtotal 

một cách tự động. Đầu tiên chọn các hàng/cột, sau đó thực hiện lệnh group sẽ nhóm 

các hàng/cột này lại với nhau. Muốn hủy nhóm, chọn lệnh Ungroup. Việc group làm 

cho quá trình xử lý bảng tính đơn giản hơn, đồng thời tạo ra khả năng dấu các số liệu 

quan trọng... 

7.5. Quản lý vùng màn hình làm việc 

Chức năng [Window]Split nhằm chia màn hình thành các vùng khác nhau, giúp 

cho việc xem xét, nhập dữ liệu đơn giản hơn, vì nó cho phép di chuyển trong các vùng 

khác nhau một cách độc lập. Sau khi đã phân chia, chọn lệnh Remove split để xóa việc 

phân chia này. 

 
Chức năng [Window]Freeze panes cho phép tạo một vùng cố định trong khi di 

chuyển trong vùng khác, thƣờng sử dụng đối với các bảng có nhiều hàng hoặc nhiều cột. 

Lệnh Unfreeze panes để hủy lệnh trƣớc đó. 

7.6. Dấu các hàng/cột 

Khi chọn một nhóm các hàng/cột và nhấn phím phải ta có thể thực hiện nhanh lệnh 

Hide để dấu các hàng/cột này; ngƣợc lại, lệnh Unhide dùng để hiện lại các vùng đã che 

dấu. 

  cột B đã đƣợc dấu   

7.7. Định dạng có điều kiện 

Ngoài những định dạng thông thƣờng, Excel còn cung cấp một khả năng định dạng 

nâng cao. Đó tùy theo những điều kiện xác định mà hình thức các ô sẽ đƣợc biến đổi 

phù hợp. 
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Menu sử dụng là: 

 

 
- Ví dụ: định dạng các ô trong cột TTHU với điều kiện giá trị lớn hơn 100000 thì 

khung viền bằng nét đứt và chữ trắng, nền đen: 

 

+ Từ hộp thoại định dạng có điều kiện, ta chọn kiểu điều kiện là: Cell Value Is, 

trong hộp phép toán, ta chọn so sánh lớn hơn: greater than, trong hộp giá trị ta 

nhập số 100000. Chọn nút lệnh  để thực hiện định dạng, nhấn OK ta 

đƣợc: 

  

 Lệnh này cho phép kết hợp đồng thời 3 điều kiện (chọn nút  để thêm 

điều kiện) 

 Ngoài kiểu xét điều kiện theo giá trị , còn có kiểu cao cấp hơn: xét 

điều kiện theo công thức  

7.8. Kiểm tra dữ liệu khi nhập 

Với những dữ liệu quan trọng, khâu kiểm tra dữ liệu trong khi nhập rất là cần thiết. 

Hầu hết các chƣơng trình làm việc với dữ liệu đều có trang bị tính năng này. 

Trong Excel, điều này đƣợc thực hiện qua menu [Data]\Validation 
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Trong minh họa trên, điều kiện là: nhập giá trị số (Decimal) trong khoảng 

(between) nhỏ nhất (Minimum) là 0, lớn nhất (Maximum) là 100. 

- Nếu có lỗi khi nhập, nội dung và kiểu thông báo lỗi đƣợc chọn ở mục  

 
Kiểu (style) báo lỗi là thông báo (Information); tiêu đề (Title) thông báo là "Dữ 

liệu sai", nội dung thông báo (Error message): "Cần nhập số trong khoảng 0..100". 

Với khai báo trên, khi nhập giá trị sai, sẽ xuất hiện thông báo sau: 

 

- Hộp [Allow] cho phép 

chọn kiểu dữ liệu, giá trị 

Any value cho phép nhập 

tùy ý nhƣ khi chƣa đặt. 

- Hộp [Data] chọn phép 

toán. 
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7.9. Bảo vệ dữ liệu 

Ngoài việc kiểm tra dữ liệu, Excel còn cung cấp các tính năng bảo mật dữ liệu. Có 

nhiều cấp độ bảo mật: từ bảo vệ workbook đến sheet và cả nội dung từng ô (cell). 

   
Tùy theo mục đích, ta chọn kiểu bảo vệ (Protection) phù hợp. Trong các kiểu, 

ngƣời sử dụng đều nhập một mật khẩu bảo vệ và thiết lập các tùy chọn về quyền của 

ngƣời dùng trên các đối tƣợng đƣợc bảo vệ. 
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HƢỚNG DẪN THỰC HÀNH MS-EXCEL 

BÀI MỞ ĐẦU HƢỚNG DẪN THỰC HÀNH EXCEL 

1. Khởi động Excel, quan sát màn hình, ghi nhận các thành phần của chƣơng trình, 

vùng làm việc... 

2. Thực hiện các thao tác cơ bản nhƣ: 

- Nhập và chỉnh sửa dữ liệu ở các ô tùy ý 

- Di chuyển giữa các ô. 

- Chọn ô, cột, hàng (một và nhiều). 

- Cắt dán dữ liệu. 

- Chọn toàn bộ và xóa. 

3. Kỹ thuật điền dãy số tự động: 

- Tại ô A4 nhập số 1, chọn ô A4 ® làm xuất hiện nút vuông điều khiển, nhấn Ctrl 

và kéo nút điều khiển sang phải đến ô G4 thả mouse, thả Ctrl để tạo ra dãy số từ 

1 đến 7. Sau đó lần lƣợt kéo các ô từ A4 đến C4 (kéo 3 lần) xuống đến các hàng 

A13, B13, C13 để tạo ra một bảng các số. Nhấn D-click vào nút điều khiển của 

ô D4, E4 và quan sát kết quả. 

4. Điền công thức tự động: 

- Tại ô F5 nhập công thức tính tổng các ô B5:E5 nhƣ sau: đầu tiên nhập dấu =, 

dùng mouse chỉ vào ô B5, nhập dấu +, chỉ vào ô C5... cho đến khi đƣợc: 

= B5+C5+D5+E5, nhấn Enter để hoàn tất. 

- Chọn ô F5, kéo nút điều khiển xuống đến F13; sau đó chọn lại F5 và kéo sang 

G5, nhấn D-click ở nút điều khiển của G5. 

- So sánh 2 thao tác ở trên. Lần lƣợt chọn các ô F5, F6, F7... và quan sát ở thanh 

công thức để nhận thấy sự thay đổi tự động của công thức tính. Tƣơng tự đối 

với các ô ở cột G. 

5. Kẻ khung viền, tô bóng 

- Chọn các ô từ A4 đến G13 tạo khung viền hai nét bên ngoài và 1 nét bên trong. 

- Chọn A4:G4 (hàng đầu của bảng) và tô màu tùy ý. 

 Cuối cùng ta có kết quả nhƣ sau: 
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 Ngoài ra, ta có thể thực hành thêm các lệnh nhƣ: chỉnh sắp các cột (theo các vị trí 

trái, giữa, phải) và chỉnh nội dung của một ô ra giữa của khoảng các ô  (chọn 

khoảng sẽ chỉnh giữa, click vào biểu tƣợng  ) 

 Đóng bảng tính (nhấn Ctrl-F4, hoặc chọn [File]Close) và mở một bảng tính mới 

(New) để thực hành bài số 1. 

BÀI SỐ 1 


 

Khởi động Excel, từ một Workbook mới hãy tạo bảng dữ liệu sau và thực hiện 

tuần tự các yêu cầu của bài thực hành. 

STT HỌ TÊN PHÁI NGÀY SINH LCB LƢƠNG CÒN LẠI 

1 An Nam 05/02/65 3.26   

2 Thủy Nữ 23/12/64 2.14   

3 Hƣơng Nữ 17/03/66 3.12   

4 Hùng Nam 09/04/64 2.46   

Câu 1 Nhập dữ liệu (cột STT dùng kỹ thuật điền dãy số tự động) 

Câu 2 Chèn một dòng trƣớc ngƣời tên Hƣơng và nhập thêm dữ liệu nhƣ sau (điều chỉnh 

cột STT cho đúng): 

3 Sơn Nam 02/11/65 2.56   

Câu 3 Chèn một cột trƣớc cột Còn lại và nhập vào tên ô là Tạm ứng 

 Thực hiện tính toán ở các cột nhƣ sau: 

Câu 4 Lƣơng bằng LCB nhân với 144000  

Câu 5 Tạm ứng bằng 25% Lƣơng 

Câu 6 Còn lại bằng Lƣơng trừ Tạm ứng 

Câu 7 Trang hoàng và lƣu bảng tính với tên là BTAP1.XLS 

Câu 8 Sau khi lƣu, đóng và mở lại bảng tính để kiểm tra, đồng thời sử dụng các lệnh 

tạo dạng nhƣ: đổi font, tạo khung viền, màu, chỉnh dạng...; các lệnh sao chép, 

cắt dán dữ liệu... 

 Kiểm tra lại các khái niệm “tham chiếu tƣơng đối”, “tham chiếu tuyệt đối” và 

dùng phƣơng pháp đặt tên cho khoảng các ô để đặt tên cho vùng bảng tính ở trên. 
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 Hƣớng dẫn thực hành: 

1. Thƣờng bắt đầu tạo bảng dữ liệu từ ô A3 trở đi. Trong khi nhập ngày cần lƣu ý, 

nếu nhập ngày đúng dạng thì sẽ tự động chỉnh phải, ngƣợc lại cần kiểm tra xem 

ngày có dạng mm/dd/yy hay dạng dd/mm/yy để nhập cho đúng. 

2. Đặt con trỏ ở ô có STT là 3, nhấn Mouse phải và chọn Insert trong menu rơi xuống 

sau đó chọn tiếp Entire Row để chèn 1 hàng (hoặc chọn hàng bằng cách click vào 

số hiệu hàng sau đó dùng lệnh Insert để chèn). 

3. Tƣơng tự câu 2, đặt con trỏ ở ô Tạm ứng, nhấn mouse phải và chọn Insert, sau đó 

chọn Entire Column để chèn 1 cột. 

4. Nhập công thức: = [LCB] * 144000, trong đó [LCB] là tham chiếu đến ô chứa 

LCB (dùng Mouse chỉ vào ô chứa giá trị LCB tƣơng ứng với hàng đang lập công 

thức, không phải chỉ vào ô có tên là LCB) 

5. Nhập công thức: = [Lƣơng] * 25% 

6. Nhập công thức: = [Lƣơng] - [Tạm ứng] 

 Sau khi tạo đƣợc công thức trong ô đầu tiên, dùng mouse kéo nút điều khiển của ô 

này xuống các ô phía dƣới để tự động điền công thức trong các ô còn lại (hoặc 

nhấn D-click nếu có thể). Ta có kết quả nhƣ sau: 

STT HỌ TÊN PHÁI NGÀY SINH LCB LƢƠNG TẠM ỨNG CÒN LẠI 

1 An Nam 05/02/65 3.26 469440 117360 352080 

2 Thủy Nữ 23/12/64 2.14 308160 77040 231120 

3 Sơn Nam 02/11/65 2.56 368640 92160 276480 

4 Hƣơng Nữ 17/03/66 3.12 449280 112320 336960 

5 Hùng Nam 09/04/64 2.46 354240 88560 265680 

BÀI SỐ 2a 

 Sử dụng các hàm IF, SUM, MAX, MIN, AVERAGE, ROUND... 

Bảng tính lƣơng Tháng 6 năm 2005 

STT Họ tên Cvu Lƣơng CB Ngày công Lƣơng Tạm ứng Thực nhận 

1 Linh TP 3.16 23 436080 145000 291080 (đ) 

2 Vuong NV 2.44 25 366000 122000 244000 (đ) 

3 Thuy PP 3.12 26 505440 150000 355440 (đ) 

4 Yen GD 5.46 29 1081080 150000 931080 (đ) 

5 Tien DV 2.56 30 537600 150000 387600 (đ) 

6 Loi PGD 3.92 15 352800 118000 234800 (đ) 

7 Hung NV 1.92 18 207360 69000 138360 (đ) 

8 Tri NV 3.24 19 369360 123000 246360 (đ) 

9 Loan TK 2.92 22 385440 128000 257440 (đ) 

10 Nhung DV 3.14 26 508680 150000 358680 (đ) 

        

    Tổng cộng 4749840 1305000 3444840 (đ) 

  Max = 931080 Min = 138360 Average = 344484 

Câu 1 Nhập dữ liệu (cột STT dùng kỹ thuật điền dãy số tự động) 

Câu 2 Tính Lƣơng = 6000 * Lƣơng CB * Ngày công 

 (Trong đó, nếu ngày công > 25 thì từ ngày 26 trở đi mỗi ngày đƣợc tính thành 2 
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ngày, ví dụ: nếu ngày công là 27 thì số dƣ ra là 2 ngày đƣợc tính thành 4 ngày, 

do đó tổng ngày sẽ là 25+4) 

Câu 3 Tạm ứng = 1/3 Lƣơng (nhƣng tối đa chỉ cho tạm ứng 150000đ) 

Câu 4 Thực nhận = Lƣơng - Tạm ứng 

Câu 5 Tính tổng cộng các cột Lƣơng, Tạm ứng, Thực nhận 

Câu 6 Cho biết giá trị cao nhất, thấp nhất, trung bình của Thực nhận 

Câu 7 Làm tròn cột Tạm ứng  đến ngàn đồng 

Câu 8 Định dạng các cột tiền theo dạng tiền (đ) đồng Việt Nam 

Câu 9 Trang trí, lƣu bảng tính với tên là BTAP2.XLS 

 Hƣớng dẫn thực hành: 

1. Lƣu ý các vùng tô xám là kết quả sau khi tính toán, dùng để kiểm tra. 

2. [Lƣơng] = 6000 * [Lƣơng CB] * IF([Ngày công]<=25, [Ngày công], 25 + ([Ngày 

công]-25)*2) 

 Công thức trên đƣợc hiểu là: Nếu ngày công không lớn hơn 25 thì trả lại Ngày 

công, ngƣợc lại thì lấy 25 cộng với số Ngày công đƣợc tính gấp đôi. 

3. [Tạm ứng] = IF([Lƣơng]/3 >150000, 150000, [Lƣơng]/3) 

 Nếu một phần ba số lƣơng không vƣợt quá 150000 thì cho tạm ứng đúng bằn một 

phần ba lƣơng, ngƣợc lại chỉ cho tạm ứng 150000. 

5. Sử dụng hàm SUM, nhập công thức “= SUM(” và dùng mouse để chọn vùng cần 

tính tổng. Sau đó kéo sang các ô bên cạnh để tạo công thức tự động cho các tổng 

kế tiếp. 

6. Dùng các hàm MAX, MIN và AVERAGE 

7. Sửa công thức trong cột Tạm ứng thành = ROUND([IF(....)], -3). Lƣu ý giá trị -3 

dùng để làm tròn đến hàng ngàn (3 số 0). Sau khi sửa xong, kéo xuống phía dƣới 

để thay thế. 

8. Chọn ô, dùng menu [Format]\Cells và sử dụng định dạng: 0 “(đ)”, hoặc dùng định 

dạng #.##0 “(đ)” để tạo thêm dấu phân cách nhóm 3 số. 

9. Tạo khung viền, tô bóng. Dòng tiêu đề nhập ở cột A, sau đó dùng mouse chọn một 

vùng ngang qua các ô để chỉnh tiêu đề ra giữa các ô. 

 Chọn Sheet2 và hoàn tất bài tập tƣơng tự số 2b (không có phần hƣớng dẫn). 
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BÀI SỐ 2b 

STT TÊN LOẠI SLƢỢNG ĐGIÁ1 ĐGIÁ2 THTIỀN THUẾ TCỘNG 

1 Toán 1 20 3000 3200 60000 6000 66000 

2 Lý 1 15 2500 2800 37500 3750 41250 

3 Hóa 2 10 4000 4500 45000 4500 49500 

4 Sinh 1 5 2000 2300 10000 1000 11000 

5 Sử 1 10 3500 3800 35000 3500 38500 

6 Địa 2 25 2500 2600 65000 6500 71500 

7 Văn 1 15 4500 4700 67500 6750 74250 

8 Tiếng Việt 1 10 3000 3300 30000 3000 33000 

9 Anh Văn 2 20 5000 5200 104000 10400 114400 

10 Giáo dục 1 15 4000 4300 60000 6000 66000 

         

     SUM 514000 51400 565400 

     MIN 10000 1000 11000 

     MAX 104000 10400 114400 

     AVERAGE 51400 5140 56540 

Câu 1 Tính thành tiền bằng số lƣợng nhân đơn giá tùy thuộc vào loại (nếu loại 1 thì 

đơn giá 1, ngƣợc lại nếu là loại 2 thì tính theo đơn giá 2) 

Câu 2 Tính Thuế bằng 10% của Thành tiền 

Câu 3 Tính tổng cộng bằng tổng của thành tiền với thuế 

Câu 4 Tính tổng, giá trị lớn nhất, nhỏ nhất, trung bình của các cột THTIỀN, THUẾ và 

TCỘNG. 

BÀI SỐ 3 

 Sử dụng hàm IF, rèn luyện việc lập các mệnh đề logic làm điều kiện; khả năng 

lồng nhau của các hàm IF. Dùng hàm RANK để sắp thứ tự (cách dùng tham chiếu 

tuyệt đối). 

BẢNG ĐIỂM 

SAP HOTEN KHOI TOAN VAN NNGU TONG KQUA XLOAI 

1 THONG A 9 10 8 36 DAU GIOI 

10 SI D 3 2 5 15 ROT X 

5 SANG C 7 6 7 26 DAU KHA 

7 DAN D 2 9 6 23 ROT X 

3 TRI C 6 8 8 30 DAU KHA 

4 KHA A 7 7 8 29 DAU KHA 

8 TAM A 5 6 4 20 DAU TBINH 

2 GIOI D 9 8 8 33 DAU GIOI 

6 DAT C 5 6 8 25 DAU TBINH 

8 YEU C 1 8 3 20 ROT X 

Câu 1 Nhập dữ liệu 

Câu 2 Cột tổng đƣợc tính căn cứ vào KHOI: nếu KHOI A thì điểm TOAN nhân 2; KHOI D 

điểm NNGU nhân 2; KHOI C điểm VAN nhân 2. 
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Câu 3 Cột KQUA đƣợc tính nhƣ sau: là ĐẬU đối với TONG lớn hơn hoặc bằng 20, nhƣng 

không có điểm môn nào dƣới 3; ngƣợc lại KQUA sẽ là RỚT 

Câu 4 Cột XLOAI đƣợc tính nếu KQUA là ĐẬU và căn cứ vào TONG: 

- Loại GIOI nếu TONG >= 32 

- Loại KHA nếu TONG từ 26 đến dƣới 32 

- Loại TRBINH đối với trƣờng hợp còn lại 

+ Nếu KQUA là RỚT thì đánh dấu X vào vị trí XLOAI 

Câu 5 Cột SAP xếp thứ tự theo cột TONG với điểm cao nhất là 1. 

Câu 6 Trang trí và lƣu bảng tính với tên BTAP3.XLS 

 Hƣớng dẫn thực hành: 

2. Sử dụng hàm IF, ta có công thức sau: 

 IF([KHOI]="A",[TOAN]*2+[VAN]+[NNGU],IF([KHOI]=D,[TOAN]+[VAN]+[N

NGU]*2, [TOAN]+[VAN]*2+[NNGU])) 

 Lƣu ý rằng, tùy thuộc vào KHOI để quyết định sẽ nhân hệ số 2 đối với môn thích 

hợp. Có 3 điều kiện (A, B, C) nên có 2 hàm IF lồng nhau; nếu có n điều kiện thì sẽ 

có n-1 hàm IF lồng nhau. Các bài tập ở sau sẽ sử dụng các hàm tìm kiếm 

HLOOKUP và VLOOKUP thay cho việc dùng nhiều hàm IF lồng nhau. 

3. Điều kiện để Đậu là: Tổng điểm >= 20, và điểm của từng môn > 2. Ta sử dụng IF 

với hàm AND để tạo biểu thức điều kiện: 

 IF(AND([TONG]>=20, [TOAN]>2, [VAN]>2, [NNGU]>2), "ĐẬU", "RỚT") 

4. Vì KQUA phải ĐẬU, nên đầu tiên cần kiểm tra KQUA, sau đó mới xét điểm để 

xếp loại: 

 IF([KQUA]="ĐẬU", IF([TONG]>=32, "GIOI", IF([TONG]>=26, 

"KHA","TRBINH")),"X") 

 Trong công thức trên lƣu ý cách tính cận của các giá trị. 

5. Dùng hàm RANK để sắp thứ tự. Theo yêu cầu sắp theo thứ tự giảm (điểm cao nhất 

có thứ hạng 1) nên phƣơng thức sắp bằng 0, ta có: 

 [SAP] = RANK([TONG], danh_sách_điểm, 0) 

 Trong đó danh_sách_điểm là cột (gồm 10 ô) chứa tổng điểm (trong bài là từ ô có điểm 

36 đến ô cuối có điểm 20; sau khi dùng mouse chọn các ô xong, nhấn F4 để tạo tham 

chiếu tuyệt đối, nếu không thì khi sao chép công thức xuống dƣới sẽ gây ra lỗi). 

 Trong câu này, ngoài việc sử dụng hàm RANK ta còn lƣu ý đến cách dùng của 

tham chiếu tuyệt đối mà hàm RANK là một trong số những hàm thƣờng dùng kiểu 

tham chiếu này. 

BÀI SỐ 4a 

 Các hàm INT, MOD xử lý số nguyên; các phép toán trên dữ liệu kiểu ngày (hiệu 

của 2 ngày), định dạng kiểu ngày. Vận dụng hàm tìm kiếm HLOOKUP để tìm một 

giá trị tham gia vào quá trình tính toán. 

KHÁCH SẠN BẠCH LIÊN 

MS LPH NDEN NDI STU SNG TTUAN TNGAY THTIEN 

a1 A 06/12/95 06/15/95 0 3 0 đ 330,000 đ 330,000 đ 
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a2 C 06/12/95 06/15/95 0 3 0 đ 225,000 đ 225,000 đ 

a3 C 06/12/95 06/21/95 1 2 500,000 đ 150,000 đ 650,000 đ 

a4 B 06/12/95 06/25/95 1 6 600,000 đ 540,000 đ 1,140,000 đ 

a5 B 06/12/95 06/28/95 2 2 1,200,000 đ 180,000 đ 1,380,000 đ 

a6 C 06/17/95 06/29/95 1 5 500,000 đ 375,000 đ 875,000 đ 

a7 A 07/01/95 07/03/95 0 2 0 đ 220,000 đ 220,000 đ 

a8 A 07/02/95 07/09/95 1 0 700,000 đ 0 đ 700,000 đ 

a9 C 07/25/95 08/10/95 2 2 1,000,000 đ 150,000 đ 1,150,000 đ 

a10 B 07/26/95 08/12/95 2 3 1,200,000 đ 270,000 đ 1,470,000 đ 

         

    Tổng cộng: 5,700,000 đ 2,440,000 đ 8,140,000 đ 

         

   Loại phòng A B C 

   Đơn giá tiền tuần 700000 600000 500000 

   Đơn giá tiền ngày 110000 90000 75000 

 Lƣu ý: Trong bảng dữ liệu trên, STU, SNG là số tuần và số ngày lƣu trú của 

khách. TTUAN, TNGAY là tiền trọ theo tuần và theo ngày (vì khách sạn giảm giá 

đối với khách thuê phòng đăng ký theo tuần). 

Câu 1 Từ giá trị ngày đến và ngày đi hãy tính số tuần (STU) và số ngày (SNG) lƣu trú 

(ví dụ: 12 ngày thì tính là 1 tuần và 5 ngày). 

Câu 2 Dựa vào bảng giá tiền theo từng loại A, B, C cho trên, hãy tính số tiền theo tuần 

và theo ngày của các khách trọ 

Câu 3 Tính TTIEN bằng tổng của tiền tuần và tiền ngày; tính tổng cộng cho các cột 

TTUAN, TNGAY và TTIEN 

Câu 4 Định dạng cho các cột ngày đi và ngày đến theo dạng năm có 4 chữ số (ví dụ 

1995) và định dạng cho các cột tiền có dạng #,## đ. 

Câu 5 Trang trí và lƣu với tên BTAP4.XLS 

 Hƣớng dẫn thực hành: 

1. Một tuần gồm 7 ngày; do đó số tuần bằng phần nguyên của số ngày lƣu trú chia 

cho 7. Số ngày sau khi tính tuần sẽ là phần dƣ của phép chia 7. Ta có công thức 

tính nhƣ sau: 

 [STU] = INT(([NDI]-[NDEN])/7) 

 [SNG] = MOD([NDI]-[NDEN], 7) 

2. Để biết đơn giá (theo loại phòng) ta dò tìm trong bảng giá, và vì bảng giá bố trí số 

liệu theo chiều ngang nên ta dùng hàm HLOOKUP. Khi đó đơn giá tiền tuần ở 

hàng thứ 2 và đơn giá tiền ngày ở hàng thứ 3 của bảng tìm. Ta có: 

 [TTUAN] = [STU] * HLOOKUP([LPH], bảng_tìm, 2, 0) 

 [TNGAY] = [SNG] * HLOOKUP([LPH], bảng_tìm, 3, 0) 

- Trong đó, bảng_tìm là khoảng gồm 9 ô (có khung tô đậm) từ ô có giá trị A đến ô 

có chứa 75000. Dùng mouse để chọn 9 ô này, sau đó nhấn F4 để tạo tham chiếu 

tuyệt đối. 

- Có thể đặt tên cho vùng 9 ô của bảng đơn giá (ví dụ Table4) khi đó trong công 

thức ta chỉ cần nhập tên Table4 ở vị trí của bảng_tìm. 
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 Sau khi ghi xong, copy nội dung Sheet1 sang Sheet2 và sửa lại dữ liệu ở bảng tìm 

thành bảng dọc và dùng VLOOKUP để làm lại câu 2. (để copy sheet, có thể chọn 

tên Sheet ở dòng chứa tên các Sheet và nhấn Ctrl+Drag kéo sang bên cạnh để 

copy). 

BÀI SỐ 4b 

 Sử dụng hàm tìm kiếm VLOOKUP 

MSO TEN SLUONG TTIEN GCHU 

A DOS 40 4800000 X 

B WORD 20 2800000  

C EXCEL 35 4550000 X 

A DOS 25 3000000  

C EXCEL 35 4550000 X 

B WORD 15 2100000  

C EXCEL 40 5200000 X 

B WORD 25 3500000  

A DOS 45 5400000 X 

     

  Mã số Tên Đơn giá 

  A DOS 120000 

  B WORD 140000 

  C EXCEL 130000 

Câu 1 Chọn Sheet3 của BTAP4 để nhập dữ liệu. 

Câu 2 Căn cứ vào bảng chứa tên và đơn giá của mã số để điền thông tin vào cột TEN 

Câu 3 Tính TTIEN bằng số lƣợng nhân đơn giá tùy thuộc vào loại, và tạo dạng với 

đơn vị tiền là $ (dạng #,##0 “$”) 

Câu 4 Cột GCHU đánh dấu X nếu TTIEN lớn hơn 4000000, ngƣợc lại để trống 

 (Lƣu ý chuỗi trống là chuỗi có dạng “” ) 

Câu 5 Trang trí và ghi lại những thay đổi vừa tạo ra ở Sheet3. 
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BÀI SỐ 5a 

 Sử dụng các hàm chuỗi (LEFT, RIGHT, MID...) để trích ra các ký tự dùng trong 

các hàm tìm kiếm. 

BÁO CÁO DOANH THU 

STT MAH TEN SLG TTIEN VCHUYEN TONG 

1 XL0 Xăng 50 225,000 đ 0 đ 225,000 đ 

2 DS1 Dầu 35 105,000 đ 630 đ 105,630 đ 

3 NS3 Nhớt 60 600,000 đ 12,600 đ 612,600 đ 

4 DL0 Dầu 35 122,500 đ 0 đ 122,500 đ 

5 XS2 Xăng 70 280,000 đ 2,800 đ 282,800 đ 

6 XL1 Xăng 50 225,000 đ 1,125 đ 226,125 đ 

7 DL3 Dầu 40 140,000 đ 2,520 đ 142,520 đ 

8 NL2 Nhớt 30 330,000 đ 4,620 đ 334,620 đ 

9 NS0 Nhớt 70 700,000 đ 0 đ 700,000 đ 

10 XS3 Xăng 65 260,000 đ 3,900 đ 263,900 đ 

       

  TONG CONG  2,987,500 đ 28,195 đ 3,015,695 đ 

Þ Trong đó, ký tự đầu của mã hàng (MAH) đại diện cho mặt hàng (TEN); ký tự thứ 

hai đại diện cho giá sỉ (S) hay lẻ (L); ký tự cuối là khu vực. (0, 1, 2 và 3). Mối 

quan hệ đƣợc cho trong bảng sau: 

Mã Tên Giá sỉ Giá lẻ Khu vực 1 Khu vực 2 Khu vực 3 

X Xăng 4000 4500 0.50% 1.00% 1.50% 

D Dầu 3000 3500 0.60% 1.20% 1.80% 

N Nhớt 10000 11000 0.70% 1.40% 2.10% 

Câu 1 Căn cứ vào ký tự đầu của MAH và bảng dữ liệu ở trên để điền tên thích hợp vào 

cột TEN. 

Câu 2 Tính thành tiền (TTIEN) bằng số lƣợng (SLG) nhân đơn giá; trong đó đơn giá tùy 

thuộc vào giá sỉ hay lẻ. 

Câu 3 Tính tiền vận chuyển (VCHUYEN) với điều kiện: nếu khu vực 0 thì miễn tiền vận 

chuyển, các khu vực khác tính theo giá trị % của cột thành tiền tƣơng ứng với 

từng khu vực cho trong bảng. 

Câu 4 Tính tổng (TONG) bằng thành tiền cộng chuyên chở và tính tổng cộng các cột 

TTIEN, VCHUYEN, TONG. Sau đó định dạng cho các cột biểu diễn giá tiền theo dạng 

#,##0 đ. 

Câu 5 Trang trí và lƣu với tên BTAP5.XLS 

 Hƣớng dẫn thực hành: 

 Đối với các bảng dữ liệu dùng để tìm thông tin ta nên gán tên để dễ thao tác và xử 

lý. Giả sử ta đặt tên cho bảng tìm là Table5. 

1. Để lấy ký tự đầu của MAH, ta dùng hàm LEFT. Vì bảng tìm bố trí theo cột nên ta 

dùng hàm VLOOKUP, cột 2 chứa giá trị tên loại hàng. Ta có: 

VLOOKUP(LEFT([MAH]), TABLE5, 2, 0) 
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2. Vì có hai loại giá tùy thuộc vào ký tự thứ hai của MAH, nên ta phải dùng IF để xác 

định vị trí cột chứa giá thích hợp, nếu giá sỉ thì cột 3 chứa đơn giá, ngƣợc lại sẽ là 

cột 4. Dùng hàm MID để lấy các ký tự ở giữa chuỗi. Ta có công thức tính nhƣ sau: 

 [TTIEN] = [SLG] * VLOOKUP(LEFT([MAH), TABLE5, 

     IF(MID([MAH),2,1) = "S", 3, 4), 0) 

3. Dùng hàm IF kiểm tra điều kiện khu vực là 0 hay <> 0; sau đó dùng VLOOKUP 

để tính % tƣơng ứng với từng khu vực và nhân với TTIEN. Lƣu ý , nếu KV=1 thì cột 

trả lại là 5, KV=2 thì cột là 6, KV=3 thì cột là 7 Þ KV+4 = số hiệu cột sẽ trả lại. 

Do đó ta có công thức: 

 IF(RIGHT[MAH]="0", 0, VLOOKUP(LEFT([MAH]), TABLE5, 

      RIGHT([MAH])+4, 0) * [TTIEN]) 

 Biểu thức: RIGHT([MAH])+4 xác định giá trị của cột trả lại tƣơng ứng với từng khu 

vực. Nếu không nhận xét nhƣ trên, ta phải dùng 2 hàm IF lồng nhau để xác định vị 

trí của cột cần lấy: If(kv=1, 5, if(kv=2, 6, 7)) 

 Sau khi hoàn tất và ghi file, chọn Sheet2 và thực hành bài tƣơng tự 5b: 

BÀI SỐ 5b 

BÁO CÁO DOANH THU 

SAP MSO VATTU NGNHAP SLNHAP TGNHAP SLXUAT TGXUAT GHICHU 

 A1  02/06/99 15  15   

 C2  04/06/99 20  15   

 B1  05/06/99 30  25   

 C1  08/06/99 10  10   

 A2  15/06/99 25  20   

 A1  17/06/99 30  25   

 C2  25/06/99 35  30   

 B1  27/06/99 20  20   

 B2  30/06/99 25  20   

 Trong đó, MSO gồm 2 ký tự, ký tự đầu chỉ tên vật tƣ (A, B, C) ký tự cuối chỉ loại 

(1, 2). Bảng dƣới đây cho biết đơn giá nhập, xuất của từng vật tƣ ứng với các loại 

1 và 2: 

MSO VATTU GNHAP1 GNHAP2 GXUAT1 GXUAT2 

A XANG 3000 3500 4000 4500 

B DAU 2000 2500 3000 3500 

C NHOT 10000 10500 11000 15000 

Câu 1 Căn cứ vào MSO điền tên vật tƣ vào cột VATTU 

Câu 2 Tính tổng tiền nhập (TGNHAP) của các loại bằng số lƣợng nhân đơn giá nhập tùy 

thuộc vào loại. Tƣơng tự hãy tính tổng tiền xuất (TGXUAT) 

Câu 3 Ở cột ghi chú đánh dấu X nếu đã xuất hết số lƣợng nhập. 

Câu 4 Cột SAP ghi thứ tự của các hàng tƣơng ứng theo TGXUAT với giá trị cao là 1 (sắp 

theo chiều giảm). 
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BÀI SỐ 6 

 Tạo biểu đồ bằng Chart Wizard. Tham chiếu tuyệt đối. 

PHIẾU THEO DÕI TIỀN GỞI TIẾT KIÊM 

    Lai suat 1.10% 

 

 So tien   Them bot Cong tien 

Thang Dau thang Lai Cuoi thang cuoi thang cuoi thang 

1 20000000 220000 20220000 500000 20720000 

2 20720000   2000000  

3    -300000  

4    -500000  

5    200000  

6    1000000  

7    600000  

8    -200000  

9    -500000  

10    1000000  

   

Tổng số tiền có đƣợc sau 12 tháng   

 

Câu 1 Tính tiền Lãi = Số tiền đầu tháng * Lãi suất 

Câu 2 Số tiền cuối tháng = Số tiền đầu tháng + Lãi 

Câu 3 Cộng tiền cuối tháng = Cuối tháng + Thêm bớt cuối tháng 

Câu 4 Số tiền đầu tháng sau = Cộng tiền cuối tháng của tháng trƣớc đó 

Câu 5 Tính số tiền sẽ có đƣợc sau 12 tháng 

Câu 6 Lập biểu đồ minh họa số tiền có đƣợc của đầu các tháng 

Câu 7 Trang trí và lƣu với tên BTAP6.XLS 

 

 Hƣớng dẫn thực hành: 

1. Lƣu ý rằng, để sao chép công thức đúng thì tham chiếu đến ô Lai suat cần phải đặt 

là tham chiếu tuyệt đối. 

 Sau khi tính xong ở các ô đầu tiên, sao chép công thức xuống phía dƣới và lƣu ý 

chỉ khi sao chép ở ô cuối của bảng thì số liệu mới đƣợc điền vào đầy đủ. 

5. Trong bài chỉ có dữ liệu của 10 tháng. Để tính đến 12 tháng, ta xem phần thêm bớt 

cuối tháng bằng 0, và tính theo công thức: 

 Giả sử tổng sau 10 tháng là x. Khi đó ta có 

 Tổng sau 12 tháng = (x + x*Lai suat) + (x + x*Lai suat)*Lai suat 

 Với Lai suat ở đây là ô chứa giá trị 1,1%. 

6. Vẽ biểu đồ 

Bƣớc 1 Chọn vùng dữ liệu: bao gồm cột Tháng và cột Dau thang 

Bƣớc 2 Chọn biểu tƣợng ChartWizard, con trỏ có dạng dấu + 

  (Vẽ một vùng trên bảng tính để đặt biểu đồ) 
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Bƣớc 3 Cung cấp thông tin cần thiết sau đó chọn [Finish] để kết thúc. 

  Tiến hành theo các bƣớc hƣớng dẫn trong phần lý thuyết 

 Biểu đồ có dạng: 

0

5 0 0 0 0 0 0

1 0 0 0 0 0 0 0

1 5 0 0 0 0 0 0

2 0 0 0 0 0 0 0

2 5 0 0 0 0 0 0

3 0 0 0 0 0 0 0

1 2 3 4 5 6 7 8 9 1 0

 
 Sau khi tạo đƣợc biểu đồ, chọn từng phần tử trong biểu đồ để chỉnh sửa và xem kết 

quả để hiểu thêm về các thành phần trong một biểu đồ. 

BÀI SỐ 7a 

 Tạo bảng dữ liệu, sử dụng các hàm cơ sở dữ liệu (DSUM, DAVERAGE...), tổ 

chức các vùng điều kiện. 

NHÀ MÁY NƢỚC HUẾ 

STT KHHANG KVUC METK TTIEN PTHU TTHU 

1 VAN A 45 58500 0 58500 

2 HOANG B 65 91000 6500 97500 

3 VO C 23 34500 3450 37950 

4 TRAN B 14 19600 1400 21000 

5 LE C 78 117000 11700 128700 

6 BUI A 93 120900 0 120900 

7 VU A 90 117000 0 117000 

8 NGUYEN C 24 36000 3600 39600 

9 BUI B 56 78400 5600 84000 

10 LE B 78 109200 7800 117000 

       

  Khu vực Phụ thu Đơn giá   

  A 0 1300   

  B 100 1400 [bảng_tìm]  

  C 150 1500   

Câu 1 Tính Thành tiền = Mét khối * Đơn giá (tùy thuộc khu vực) 

Câu 2 Tính Tổng thu = Thành tiền + Phụ thu (theo khu vực) 

Câu 3 Tính tổng tiêu thụ lớn nhất, nhỏ nhất và trung bình của số mét khối đã tiêu thụ 

của từng khu vực và ghi kết quả vào bảng sau: 

Khu Vực A B C 

Tổng 296400 319500 206250 

Lớn nhất 120900 117000 128700 

Bé nhất 58500 21000 37950 

Trung bình 98800 79875 68750 

Câu 4 Vẽ đồ thị minh họa cho bảng ở câu 3 

Câu 5 Trang trí và lƣu file với tên BTAP7.XLS 
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 Hƣớng dẫn thực hành: 

1. Dùng Vlookup để tính đơn giá của từng khu vực sau đó nhân với số mét khối, ta 

có: (cột 3 của bảng tìm chứa đơn giá) 

 [TTIEN]=[METK] * VLOOKUP([KVUC], [Bang_Tìm], 3, 0) 

2. Tƣơng tự trên, với cột 2 của bảng tìm chứa phụ thu ta có: 

 [TTHU]=[TTIEN] + VLOOKUP([KVUC], [Bang_Tìm], 2, 0) 

3. Dùng các hàm cơ sở dữ liệu DSUM, DMIN, DMAX, DAVERAGE với các điều 

kiện về khu vực đƣợc tổ chức nhƣ sau: 

KVUC KVUC KVUC 

A B C 

 Lƣu ý rằng, các nhãn tham gia trong điều kiện phải chính xác nhƣ nhãn cột trong bảng 

dữ liệu, thƣờng ta dùng chức năng copy để sao chép các nhãn cột để tránh sai sót. 

 Giả sử bảng dữ liệu đƣợc gán tên là DATA7a, ta có công thức để tính tổng tiêu thụ 

của khu vực A là: DSUM(DATA7a, “TTHU”, [đkA]), với [đkA] là hai ô KVUC 

và A ở vùng điều kiện trên. Tƣơng tự đối với công thức ở các ô còn lại. 

- Trong thực hành, ta sao chép các công thức sang các ô bên cạnh, sau đó sửa lại 

cho chính xác. 

4. Đồ thị: 

0

100000

200000

300000

400000

Tong Lon nhat Be nhat Trung binh

A

B

C
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BÀI TẬP 7b 

 Vận dụng các hàm cơ sở dữ liệu có kết hợp các hàm chuỗi. Ôn tập các hàm tìm 

kiếm (Thực hành tiếp trong Sheet2 của bài 7a) 

DANH SÁCH LƢƠNG THÁNG 06 NĂM 2005 

SO MASO HOTEN PHAI CHVU TĐOVH LGCB PHCAP NGCONG THUONG CGLUONG 

 AFD8 Hồng    460  23   

 CFC1 Thanh    310  24   

 CMT5 Sơn    330  23   

 BMC7 Hoàng    430  25   

 CMT3 Tâm    320  24   

 CFT3 Lan    320  22   

 CFC6 Mai    360  26   

 CFT4 Thúy    350  23   

 CMD2 Hùng    310  20   

 CMC9 Tình    380  23   

 

 MaxL= ?   MinL= ?   AveL= ? 

 MASO cho trên gồm 4 ký tự MS1, MS2, MS3 và MS4, ký tự đầu là chức vụ, thứ hai là 

phái, thứ ba là trình độ văn hóa và ký tự cuối là số năm công tác, với các giá trị 

nhƣ sau: 

MS1 Chức vụ  MS2 Phái  MS3 Trình độ văn hóa  MS4 Năm công tác 

A TP  F Nữ  D Đại học    

B PP  M Nam  C Cao đẳng    

C NV     T Trung cấp    

Câu 1 Căn cứ vào MASO chèn thông tin vào các cột PHAI, CHVU, TĐOVH 

Câu 2 Tính PHCAP = PCCV+THNIEM, với THNIEM = NAMCT * 6000 và PCCV đƣợc tính nhƣ sau: 

CHVU PCCV 

TP 40000 

PP 25000 

NV 10000 

Câu 3 Tính THUONG. Biết: Nếu NGCONG>=25, THUONG = 120.000; nếu 23<=NGCONG<25, 

THUONG=70.000; còn lại THUONG=20.000 

Câu 4 Tính CGLUONG = LGCB*1200 + PHCAP + THUONG 

Câu 5 Tính Lƣơng cao nhất  MaxL 

   Lƣơng thấp nhất MinL 

   Lƣơng trung bình AveL 

Câu 6 Cột SO đƣợc đánh số theo CGLUONG với mức cao nhất là 1  

Câu 7 Tính tổng PHCAP, THUONG và CGLUONG theo PHAI và lƣu vào Sheet3, theo mẫu sau: 

 

Phái Phụ cấp Thưởng Cộng lương 

Nam ? ? ? 

Nữ ? ? ? 
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Câu 8  Trang trí và ghi lại các thay đổi 

 Hƣớng dẫn thực hành: 

1. Dùng Vlookup và các hàm chuỗi để lấy thông tin. 

2. Dùng Vlookup để lấy phụ cấp chức vụ tƣơng ứng với chức vụ. 

3. Dùng 2 hàm IF lồng nhau. 

5. Dùng các hàm Max, Min và Average 

7. Tạo vùng điều kiện theo phái, tạo bảng báo cáo trong Sheet3 và dùng DSUM để tính. 

BÀI SỐ 8 

 Các thao tác cơ bản trên danh sách dữ liệu: SORT, FILTER 

Danh sách học viên đƣợc cấp học bổng - Năm học 2004-2005 

STT HOTEN NGSINH NOISINH TRBINH HBONG MADIEM Tuoi 

1 TUAN 05/15/80 HUE 4.2 0 A01 19 

2 VIET 02/13/75 Q.BINH 7.5 50000 B03 24 

3 ANH 11/11/78 HUE 6.7 50000 C04 21 

4 HUNG 10/12/76 DA NANG 8.3 50000 A03 23 

5 HOA 04/01/82 HA TINH 8.7 150000 C02 17 

6 THUAN 12/18/78 NGHE AN 4.0 0 B01 21 

7 VAN 01/01/81 DA NANG 4.2 0 B05 18 

8 SON 09/09/77 HUE 5.5 50000 A02 22 

9 BINH 10/10/79 HA TINH 8.3 100000 C01 20 

Câu 1 Nhập bảng dữ liệu trong Sheet1 và nhập danh sách điểm sau trong Sheet2: 

Mã điểm Điểm cơ sở Chuyên môn Ngoại ngữ 

C01 9.0 8.0 8.0 

B05 7.0 2.5 3.0 

B01 2.0 4.5 5.5 

A02 5.5 6.5 4.5 

C02 9.0 8.5 8.5 

A03 8.5 9.0 7.5 

C04 9.0 2.5 8.5 

B03 6.0 7.5 9.0 

A01 4.5 6.0 2.0 

Câu 2 Căn cứ vào MADIEM và bảng mã điểm trên để tính điểm trung bình (TRBINH) 

Câu 3 Tính học bổng (HBONG) theo các điều kiện sau: 

 - nếu TRBINH >=8.5 và tuổi <=18 thì học bổng là: 150000 đ 

 - nếu TRBINH >=8.0 và tuổi <=20 thì học bổng là: 100000 đ 

 - nếu 5.0 <=TRBINH < 8.0 và tuổi >20 thì học bổng là: 50000 đ 

 - ngoài ra không có học bổng. 

Câu 4 Trích ra những bảng tính khác (lƣu vào Sheet3): 

 - những học viên có mức học bổng 150000 đ 

 - những học viên có mức học bổng 100000 đ 

 - những học viên có mức học bổng   50000 đ 
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 - những học viên không có học bổng. 

Câu 5 Trích ra những bảng tính khác (lƣu vào Sheet3) những học viên trong các độ 

tuổi sau: 

 - từ 16 đến 18  - 19 hoặc 20  - trên 20 tuổi. 

Câu 6 Trang trí và lƣu với tên BTAP8.XLS 

Câu 7 Thực hiện các thao tác sắp thứ tự theo HOTEN, NGSINH, TRBINH... sau mỗi lần sắp 
hãy quan sát sự thay đổi (có thể nhấn Undo và Redo) 

 Hƣớng dẫn thực hành: 

2. Để tính điểm trung bình cần phải biết 3 cột điểm, do đó dùng hàm AVERAGE với 

3 lần dùng VLOOKUP, mỗi lần chỉ thay đổi cột trả lại giá trị: 

 Average(Vlookup(...,...,2,0), Vlookup(...,...,3,0), Vlookup(...,...,4,0)) 

 Ngoài ra, Excel còn có 2 hàm cho phép lấy một khoảng các ô mà không phải dùng 

nhiều lần các hàm VLOOKUP; đó là hàm OFFSET và MATCH. Hàm OFFSET có 

5 đối số nhƣ sau: 

- OFFSET(vị trí gốc, độ dời đứng, độ dời ngang, số hàng, số cột kết quả) 

 Với ý nghĩa: tính từ vị trí gốc, dời lên trên (âm)/dời xuống dƣới (dƣơng), dời sang 

trái (âm)/dời sang phải (dƣơng) bao nhiêu ô; và khoảng cần trả lại sẽ chứa bao 

nhiêu hàng, bao nhiêu cột. 

- Hàm MATCH gần giống các hàm tìm kiếm nhƣng không trả lại giá trị tìm mà chỉ 

trả lại vị trí (thứ tự) của giá trị tìm thấy trong khoảng tìm. 

 MATCH(giá trị tìm, khoảng tìm, phƣơng thức) 

 Từ hai hàm trên ta có cách giải khác để tính điểm trung bình nhƣ sau: 

 = AVERAGE(OFFSET(vị trí gốc, MATCH(mã điểm, bảng mã, 0), 0, 1, 3)) 

 trong đó: vị trí gốc đƣợc chọn là ô chứa giá trị [Điểm cơ sở]; mã điểm là số hiệu 

mã điểm của từng ngƣời; bảng mã là danh sách toàn bộ mã điểm cần tìm. Hàm 

Match có nhiệm vụ tính độ dời xuống khi tìm thấy mã điểm trong danh sách; độ 

dời ngang là 0 (vì các ô sẽ lấy có ô đầu tiên cùng cột với vị trí gốc); số ô cần lấy là 

1 hàng và 3 cột. 

3. Trong điều kiện tính học bổng có sử dụng giá trị tuổi, nhƣng trong bảng dữ liệu 

không có giá trị này, do đó ta sẽ tạo thêm một cột trung gian để tính tuổi (nhằm 

đơn giản hóa điều kiện) và tuổi đƣợc tính bởi hiệu của năm hiện thời với năm sinh, 

ta có: 

  [TUOI] = YEAR(NOW())-YEAR([NGSINH]) 

 khi đó, giả sử E6 là ô chứa điểm trung bình, ta có công thức sau: 

  IF(AND(E6>=8.5, [TUOI]<=18), 150000, 

  IF(AND(E6>=8, [TUOI]<=20, 10000, 

   IF(AND(E6>=5, [TUOI]>20), 50000, 0))) 

4. Để lọc và ghi kết quả ta dùng chức năng lọc nâng cao (Advanced Filter) với các 

vùng điều kiện về học bổng nhƣ sau: 

HBONG  HBONG  HBONG  HBONG 

150000  100000  50000  0 

 Lƣu ý, sau khi tạo vùng điều kiện ở Sheet3, ta đặt con trỏ ở một ô trống trƣớc khi 

sử dụng lệnh lọc. 
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5. Tƣơng tự, sử dụng lọc nâng cao với các điều kiện lọc nhƣ sau: 

Tuoi Tuoi  Tuoi  Tuoi 

>=16 <=18  19  >20 

   20   

7. Trƣớc hết chọn tên trƣờng cần sắp (ví dụ, chọn trƣờng HOTEN), sau đó mới sử dụng 

lệnh [DATA]SORT. Sau mỗi lần sắp, nên thay đổi một số yếu tố để hiểu rõ về 

chức năng này. 

BÀI SỐ 9 

 Các thao tác cơ bản trên danh sách dữ liệu: SORT, FILTER, SUBTOTAL... 

BẢNG BÁN HÀNG 

MAH NBAN TEN SLUONG TGIA THUE TONG 

1 12/12/97 BAP 324    

2 12/12/97 BIA 454    

3 14/12/97 BOT 656    

4 11/01/98 GAO 431    

5 20/01/98 KEO 455    

6 25/01/98 BAP 564    

7 01/02/98 BIA 657    

8 11/02/98 BOT 432    

9 05/02/98 KEO 544    

10 12/03/98 GAO 767    

       

 Tổng trị giá các mặt hàng bán trong tháng 2/1998 ??? 

Câu 1 Tính trị giá (TGIA) bằng số lƣợng (SLUONG) nhân đơn giá (DGIA), với đơn giá và 

thuế đƣợc cho ở bảng sau: 

Tên Đơn giá Thuế 

BAP 3500 1% 

BIA 15000 1% 

GAO 3000 2% 

KEO 10000 2% 

BOT 5000 1% 

Câu 2 Tính thuế (THUE) theo số liệu trên và chú ý rằng nếu trị giá dƣới 100000 đồng thì  

không thu thuế. Sau đó tính tổng cộng (TONG) bằng trị giá cộng với thuế 

Câu 3 Trích ra danh sách các mặt hàng BAP, GAO, BOT và lƣu vào Sheet2. 

Câu 4 Tính tổng các cột TGIA, THUE và tổng số lần bán theo từng loại mặt hàng và lƣu 

vào bảng sau ở Sheet3: 

Tên Số lần bán Tổng trị giá Tổng thuế 

BAP    

BIA    

GAO    

KEO    

BOT    

Câu 5 Dùng kết quả ở câu 4 để vẽ đồ thị so sánh tổng trị giá của từng loại mặt hàng 
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Câu 6 Trích ra hai bảng tính bán hàng ứng với 2 năm: 1997 và 1998 

Câu 7 Tính tổng trị giá các mặt hàng bán trong tháng 2/1998 

Câu 8 Sắp thứ tự (Sort) bảng theo cột TEN với chiều giảm dần (Descending) 

Câu 9 Dùng SubTotal để tính tổng các cột SLUONG, TGIA, TONG. Sau đó thay tổng bằng 

các hàm khác nhƣ Min, Max, Average... 

 Trang trí và lƣu với tên BTAP9.XLS 

 Hƣớng dẫn thực hành: 

2. Vì có điều kiện nên khi tính thuế ta cần phải xét xem trị giá lớn hơn hay nhỏ hơn 

100000, do đó có công thức sau: 

 IF([TGIA]<100000, 0, [TGIA]*VLOOKUP(...)) 

3. Lập vùng điều kiện dạng hoặc (OR) để lọc. 

4. Để tính tổng số lần bán ta dùng DCOUNTA, các giá trị khác thì dùng DSUM. 

 Đối với phép tính tổng theo điều kiện, ngoài hàm DSUM Excel còn cung cấp một 

hàm tƣơng đƣơng, đó là SUMIF 

 Cú pháp: SUMIF(khoảng_sẽ_tính, điều_kiện, khoảng thật sự sẽ tính) 

 Trong đó, khoảng_sẽ_tính tham chiếu đến khoảng các ô sẽ tham gia tính tổng; 

điều_kiện thƣờng có dạng “biểu thức so sánh”; riêng khoảng thật sự sẽ tính là tùy 

chọn, nhƣng nếu đƣa vào thì tổng kết quả sẽ tính trong vùng này. 

* Ví dụ: xét bảng số liệu sau: 
 A B C D E F 

1 BAP 5 BAP BIA BAP BAP 

2 BIA 8 7 9 5 4 

3 BAP 7     

4 GAO 9     

5 BIA 6     

- Khi đó công thức: SUMIF(A1:A5,"BAP",B1:B5) sẽ có giá trị là 12; tƣơng đƣơng 

với việc dùng hàm DSUM với điều kiện tên hàng là BAP. 

- Tƣơng tự ta có: SUMIF(C1:F1,"BAP",C2:F2) = 16 

 Thử dùng SUMIF để giải lại câu 4 ở trên. 

 Cùng dạng với SUMIF là hàm COUNTIF(khoảng ô, điều kiện) dùng để đếm số 

các ô trong khoảng ô hợp với điều kiện. 

6. Lập vùng điều kiện từ ngày 01/01/1997 đến 31/12/1997 (năm 1997) và tƣơng tự để 

tính năm 1998. 

7. Lập vùng điều kiện có dạng ngày bán lớn hơn hoặc bằng ngày 01/02/1998 và nhỏ 

hơn ngày 01/03/1998 (trong khoảng tháng 2) 

 Ngoài phƣơng pháp dùng một khoảng ngày nhƣ trên, ta còn có thể sử dụng dạng 

công thức trong vùng điều kiện để tính. Ví dụ, đối với câu 6 có thể lập điều kiện 

dạng =YEAR(ô đầu tiên chứa dữ liệu ngày)=1997 (lƣu ý trong công thức trên có 

hai dấu =) và nhãn tên trƣờng cần phải bỏ trống. 

Þ Tƣơng tự, điều kiện trong câu 7 sẽ là =MONTH(ô chứa ngày)=2. 
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BÀI SỐ 10 

 Bài tập tổng hợp - dạng đề thi 

BẢNG GHI TÊN, GHI ĐIỂM 

      Điểm chuẩn = 17 

         

TT SBD HOTEN TEN TRUONG BAN DVAN DTOAN TONG KETQUA 

 A00 AI  C     

 A11 BINH  A     

 A20 CHAU  B     

 B31 ANH  A     

 B42 BAO  C     

 C50 DUNG  B     

 C61 HANH  B     

 C71 HUONG  A     

 D82 DUONG  A     

 D90 PHUOC  C     

 

Mã trƣờng Tên trƣờng Ký tự đầu của SBD là mã trƣờng 

A QUOC HOC ký tự cuối của SBD là điểm ƣu tiên. 

B HAI BA TRUNG    

C NGUYEN HUE    

D GIA HOI    

 

Câu 1 Căn cứ vào ký tự đầu của SBD điền thông tin vào TEN TRUONG 

Câu 2 Căn cứ vào SBD điền DVAN và DTOAN (theo bảng điểm ở Sheet2) 

Câu 3 Tính TONG theo các yêu cầu sau: 

 * Nếu ban A hoặc B thì điểm Toán hệ số 2 

 * Nếu ban C thì điểm Văn hệ số 2 

 * Cộng thêm điểm ƣu tiên 

Câu 4 Tính KETQUA: Đậu nếu TONG lớn hơn hoặc bằng Điểm chuẩn ngƣợc lại là Rớt 

Câu 5 Lọc ra các danh sách và ghi vào Sheet3 những ngƣời: 

 a) Có kết quả Rớt 

 b) Có kết quả Đậu và tổng điểm lớn hơn 23 

Câu 6 Lập báo cáo theo mẫu sau: 

Học sinh trƣờng Điểm trung bình Số học sinh Đậu 

QUOC HOC ? ? 

HAI BA TRUNG ? ? 

NGUYEN HUE ? ? 

GIA HOI ? ? 

Câu 7 Cột TT đánh số theo cột TONG với giá trị cao nhất là 1 

Bảng điểm (Lƣu trong Sheet2) 
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SBD DTOAN DVAN 

D90 4 7 

D82 5 4 

C71 8 7 

C61 9 8 

C50 5 5 

B42 3 7 

B31 5 4 

A20 4 5 

A11 7 9 

A00 6 8 

 Ghi bài thực hành với tên BTAP10.XLS 

BÀI SỐ 11 

 Các bài tập bổ sung. Sử dụng hàm SumProduct để giải bài toán tính điểm trung 

bình các môn theo các hệ số tùy ý. 

 SUMPRODUCT(mảng_1, mảng_2, ...) 

- Hàm SumProduct tính tổng các tích một cách tƣơng ứng từ các phần tử của mảng 

1 với mảng 2... cho đến tối đa 32 mảng đƣợc phép sử dụng - các mảng này phải có 

cùng số chiều. 

 Lƣu ý: hàm PRODUCT(so1, so2,...) thực hiện phép nhân liên tiếp các so1, so2, ... 

với nhau. Ví dụ: Product(2,4,5) = 2*4*5 = 40. 
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BẢNG GHI ĐIỂM 

TT HTEN M1 M2 M3 M4 M5 TRBINH 

1 AN 5 7 6 8 7 6.8 

2 BINH 8 7 9 6 8 7.5 

3 SON 9 9 8  7 8.1 

4 VAN 8 7 6 9 5 7.3 

5 TUAN  8 4 5 8 5.5 

6 LAN 3 5 4 5 8 4.9 

7 HOA 4 7 6 7 5 5.9 

8 QUANG 5 4 3 5 4 4.3 

9 VINH 9 9  9 8 8.8 

10 THANH 9 7 9 8 9 8.5 

* Với hệ số các môn M1 đến M5 đƣợc cho trong bảng sau: 

Môn M1 M2 M3 M4 M5 

Hệ số 2 1 3 4 2 

Câu 1 Căn cứ vào hệ số, tính điểm trung bình (TRBINH). 

Gợi ý Điểm trung bình đƣợc tính bằng cách lấy tổng điểm các môn có nhân hệ số sau đó 

chia cho tổng số các hệ số (ở trên là bằng 2+1+3+4+2=12). Công thức có dạng: 

 SUMPRODUCT(điểm, he_so)/SUM(he_so) 

 Trong đó điểm tham chiếu đến các ô chứa điểm của từng học sinh; he_so là 

vùng chứa thông tin về hệ số. 

 Hãy để ý tình huống có một số học sinh đƣợc miễn một số môn học (ô điểm để 

trống) thì công thức có còn đúng không? Rõ ràng trong tình huống này, phép 

chia cho toàn bộ tổng của các hệ số sẽ làm cho điểm trung bình bị thấp xuống. 

Thay vào đó ta phải xét xem môn nào đƣợc miễn để giảm đi hệ số của môn đó. 

Sử dụng hàm SumIf ta có thể khắc phục tình huống này: 

 SUMPRODUCT(điểm, he_so)/SUMIF(điểm, “>=0”,  he_so) 

 Hàm SumIf lúc này có nhiệm vụ tính tổng các hệ số tƣơng ứng với các môn học 

có điểm lớn hơn hoặc bằng 0, do đó sẽ không tính những môn miễn học (có giá 

trị rỗng) 

Câu 2 Sử dụng hàm SumProduct với các giá trị bố trí theo cột 

Tên hàng Số lƣợng Giá_1 Giá_2 

A12 20 3000 4000 

C21 30 1000 3000 

E23 25 2000 4000 

D32 50 4000 5000 

Tổng cộng (số_lƣợng  ́giá) = ? ? 

 Giả sử cần tính tổng cộng toàn bộ các mặt hàng trên theo đơn giá loại 1 mà 

không phải tính tổng từng mặt hàng, ta sử dụng hàm SumProduct nhƣ sau: 

SumProduct(so_luong, don_gia_1) sẽ cho kết quả: 340000. Tƣơng tự tính tổng 

theo đơn giá loại 2. 

BÀI SỐ 12 

 Sử dụng công cụ Solver để giải các bài toán đặc biệt. 
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Trong Excel có bổ sung một số công cụ mạnh để giải các bài toán nhƣ: tìm nghiệm 

của hệ phƣơng trình, giải bài toán tối ƣu... đó là Solver (trong menu Tools). Trong 

phần này chỉ giới thiệu một số ví dụ minh họa chức năng này. 

Bài 1. Giải hệ phƣơng trình sau: 

3x + 4y - 3z = 5 

4x - 2y + 6z = 40 

x + 4y + 8z = 78 

Bƣớc 1. Lập mô hình bài toán (theo mẫu dƣới đây) 

  A B C D 

1 Biến x y z 

2 Nghiệm (tạm) 1 1 1 

3     

4 Hệ số a b c 

5 phƣơng trình 1 3 4 -3 

6 phƣơng trình 2 4 -2 6 

7 phƣơng trình 3 1 4 8 

8     

9 Giá trị tạm 4 8 13 

10 Mục tiêu 5 40 78 

- Các ô B2:D2 sẽ chứa nghiệm của hệ, đầu tiên ta cho tất cả bằng 1 (và gọi là 

nghiệm tạm) và sẽ dùng Solver để yêu cầu tính ra nghiệm thật sự. 

- Các ô B5:D7 chứa hệ số của các phƣơng trình 

- Các ô B10:D10 chứa giá trị vế phải của các phƣơng trình 

- Các ô B9:D9 là các giá trị trung gian tƣơng ứng với các nghiệm tạm của hệ; đƣợc 

tính bằng cách thay bộ nghiệm tạm vào vế trái của các phƣơng trình (tổng các 

tích), do đó ở đây ta dùng hàm SumProduct để tính. Công thức ô B9 sẽ là: 

   [B9] = SumProduct(B5:D5, $B$2:$D$2) = 4 

 (tƣơng tự với các ô [C9] và [D9]) 

Bƣớc 2. Cung cấp thông tin cho Solver 

Sau khi lập xong mô hình, chọn ô [B9] làm mục tiêu, và gọi lệnh [Tools]Solver, ta 

có: 
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- Trong hộp [By Changing Cells] ta dùng mouse để chọn vùng lƣu kết quả (nghiệm) 

là B2:D2 (Excel sẽ tự động thêm kiểu tham chiếu tuyệt đối) 

- Trong vùng [Subjects to the Constraints] ta nhập các ràng buộc dùng làm mục tiêu 

của lời giải. Đối với việc giải hệ phƣơng trình, mục tiêu cần đạt đƣợc là các giá trị 

tạm phải bằng với các giá trị thực có (vế phải của các phƣơng trình). Ở trƣớc ta đã 

dùng ô B9 làm đích, vậy còn lại 2 giá trị phải đạt đƣợc. Ta chọn Add và khai báo 

đẳng thức còn lại làm mục tiêu trong hộp: 

 
 Sử dụng nút Add để thêm các ràng buộc, sau khi hoàn tất chọn [OK] để quay về 

hộp Solver Parameters 

Bƣớc 3. Thực hiện lệnh và kết thúc 

Sau khi hoàn tất các khai báo, ta chọn nút [Solve] để Excel tự động tính và thông 

báo kết quả; 

 
 Nếu đồng ý với lời giải thì chọn nút Keep Solver Solution, nếu không thì phục hồi 

các giá trị gốc Restore Orginal Values và chọn OK để hoàn tất. 

 Cuối cùng, ta có kết quả nhƣ sau: 

 

  A B C D 

1 Biến x y z 

2 Nghiệm 2 5 7 

3 ... ... ... ... 

8     

9 Giá trị 5 40 78 

10 Mục tiêu 5 40 78 

 Lƣu ý rằng giá trị ở các ô B2:D2 và B9:D9 đã thay đổi. 

 Tóm lại, để sử dụng Solver đòi hỏi các yêu cầu sau: 

- Phải cung cấp đầy đủ các tham số trong hộp thoại. Đặc biệt cần lƣu ý rằng ô đích (Set 

Target Cell) cần phải chứa công thức có liên quan đến vùng nghiệm, nếu không Excel sẽ 

báo lỗi. 

- Chỉ ra vùng mà Excel sẽ tác động và lƣu kết quả, ở đây thƣờng bắt đầu với các giá trị 1 là 

giá trị tạm thời để Excel có khởi điểm tính toán. 



74 Hoàng Vũ Luân 

- Cung cấp đầy đủ các ràng buộc dùng làm mục tiêu để tính toán. 

 Bài tập tƣơng tự. Giải hệ phƣơng trình sau 

3x + 4y - 3z - t = 26 

4x - 2y + 6z - 7t = 10  {nghiệm là: 

x + 4y + 8z - 6t = 12  (x=8; y=3; z=2; t=4) } 

2x - 9y + 5z + 3t = 11 

Bài 2. Xét bài toán tìm cực đại lợi nhuận nhƣ sau: “Một nhà máy sản xuất 3 sản phẩm 

(sph_a, sph_b và sph_c) với tiền lãi tƣơng ứng trên 1 đơn vị sản phẩm là 75, 35 

và 50. Các sản phẩm này đòi hỏi một số linh kiện (6 loại) với tƣơng quan giữa 

chúng đƣợc cho bởi bảng và trong bảng còn cho biết số lƣợng các linh kiện tồn 

kho. Hãy lập kế hoạch sản xuất sao cho lợi nhuận thu đƣợc là lớn nhất. 

 Dùng Solver, ta lập mô hình bài toán nhƣ sau: 

 A B C D E F 

1    SPh_a SPh_b SPh_c 

2  Mục tiêu sản xuất -> 100 100 100 

3 Linh kiện Tồn kho Yêu cầu    

4 Lk_1 700 400 2 0 2 

5 Lk_2 850 500 3 0 2 

6 Lk_3 380 300 0 3 0 

7 Lk_4 500 400 2 1 1 

8 Lk_5 650 400 1 0 3 

9 Lk_6 450 200 0 1 1 

10   Tiền lãi/sp 75 35 50 

11  Lợi nhuận 7500 3500 5000 

12  Tổng lợi nhuận 16000   

 Trong mô hình trên, có các ô chứa công thức nhƣ sau: 

- Các ô từ C4 đến C9 chứa hàm SumProduct($D$2:$F$2,D4:F4)... 

- Tính lợi nhuận bằng tiền lãi một sản phẩm nhân với số sản phẩm 

- Tổng lợi nhuận bằng tổng cộng các lợi nhuận của các sản phẩm. 

 Trong hộp thoại Solver Parameters ta khai báo nhƣ sau: 

- Chọn ô D12 làm ô đích và giá trị mục tiêu là Max; các ô lƣu kết quả là D2:F2 (với các 

giá trị khởi đầu là 100) và các ràng buộc nhƣ sau: 

 
 Sau khi chọn Solve, ta đƣợc nghiệm là 107, 105 và 181 với Tổng lợi nhuận là 

20750. 

 Bài tập tƣơng tự. Hãy thay đổi các tham số và giải lại bài toán trên. Hãy tìm một 

bài toán tƣơng tự, (ví dụ lập lịch sản xuất sao cho chi phí thấp nhất) sau đó lập mô 

hình và giải. 

 

 


